CASSINI ATE SYSTEM
REFERENCE GUIDE

ROOS INSTRUMENTS

ABOUT THIS MANUAL
This section provides
information about:
• How this manual is
organized
• Revision history
• The notational
conventions used in this
manual
• How to interpret Notes,
Cautions, and Warnings

DEDICATION

About this Manual | Dedication

This book is dedicated to the engineers, technicians, and
operators who have devoted themselves to the noble
profession of semiconductor test. Often overlooked and
seldom recognized, those in our field make possible the
dreams and aspirations of countless others. We are the last
stop in the arduous proving grounds of tomorrow’s
technology. We are the driving force that tests the boundary
of what is possible. We are the silent reassurance that the
next generation of technology will deliver on its promise of
performance, innovation, and ingenuity. It is because we
have devoted our life’s work to the pursuit of quality,
precision, accuracy, and reliability that greater technological
achievements are possible. Though our tireless contributions
may never be seen, they are imbued in every chip we test.
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SECTION 1

REVISION HISTORY

Version 1.4 — November 2014
Initial release of the Reference Guide.
Version 2 — March 2016
About This Manual | Section 2 - Using This Book
• Descriptions for scrolling view feature and font size adjustment
features were added for iPads running iOS 9.0 or later.
Chapter 2 - Graphical Programming | Section 1 - Introduction
• General descriptions and user information added for the
graphical programming environment: Synapse - Test Program
Optimizer, Conditional Statements, Measure and Measure
Sequence groups, Lock Step groups, Pre Measure and Post
Measure groups, and Combined groups.
Chapter 2 - Graphical Programming | Section 11 - RI8574: System
Controller (EPC)
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• Edit button descriptions were added for button and blocks
found in the Data Saves, Flow Control, State, Input Output
State, and General Calculation panels. These include Calc
buttons as well as program flow control, conditional
statements, user-defined flags, and compiler directive buttons.
Chapter 2 - Graphical Programming | Section 15 - RI8581: 100kHZ to
20GHz Receiver & Section 16 - RI8587: 100kHZ to 20GHz DSP
Receiver
• Edit button block diagrams updated to include the LO outputs
(LO Out A,LO Out B,LO Out C) and IF inputs (IF In A, IF In B,
IF In C) button controls via the source Input button.
• Edit button description for the source Input button updated to
include description for controlling the tandem switch routing of
the LO outputs (LO Out A,LO Out B,LO Out C) and IF inputs
(IF In A, IF In B, IF In C).
Chapter 2 - Graphical Programming | Section 8 - RI8564: 71GHz to
83GHz TestSet
• Updated instrument description and block diagram to the
latest version to reflect new performance specifications.
Chapter 5 - Diagnostics
• Chapter completely updated with an introduction to
diagnostics on the Cassini ATE, including factory
recommended practices for instrument validation and test
system release procedures.
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• Provide details and description of the diagnostic software UI:
Diagnostic Executive including menu options, user controls,
and data export.
• The Diagnostic Kit and associated diagnostic hardware are
described with included examples.
• Updated procedures for running diagnostics, self tests, and
supplemental diagnostics for the Cassini ATE system.
Chapter 7 - Troubleshooting
• Export Simulation section added. Section describes how to
create a test setup capture of the Cassini test software
environment for RI support assistance.
• Minor updates and corrections.
Chapter 8 - Appendix | Section 9 - RI8564: 71GHz to 83GHz TestSet
• Updated instrument description, block diagram, and
performance specifications.
Chapter 8 - Appendix | Section 13 - RI8574: System Controller
• Minor corrections throughout chapter.
• Additional description and information about the RIFL Master
topology were added.
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Version 2.1 — August 2016
Chapter 1 - System Information | Section 5 - Installation
• Minor updates to clarify installation procedure.
Chapter 1 - System Information | Section 9 - Handler and Prober
Interfacing
• Procedure added including steps to attach grounding cable and
Handler/Prober control pod.
Chapter 3 - Care & Maintenance | Section 6 - RF Connector Care
• Steps and recommendations for SMA connector tightening.
Chapter 5 - Diagnostics
• Update to procedure for selecting an alternate diagnostic list.
Chapter 8 - Appendix
• Minor corrections throughout chapter.
Version 2.2 — October 2016
Chapter 8 - Appendix
• Minor correction to Ri8535: Universal Digital
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Version 2.3 — December 2017
Chapter 1 - System Information
Section 11: Guru
• New section with content moved from Section 10:
Software Environment and Tools
• Added information on user access control.
Section 12: Device Connection Editor
• New section covering the UI and user features.
Section 13: Device Control Editor
• New section covering the UI and user features.

About this Manual | Revision History
Section 7 - RI8563: 4GHz - 40GHz TestSet
• Updated edit button diagram
• Updates and corrections to edit button descriptions
Section 8 - RI8564: 71GHz - 86GHz TestSet
• Added edit button diagram for RI8564C Version
Section 9 - RI8567: 0.01 to 12GHz TestSet
• Updated edit button block diagram and updates/
corrections to edit button descriptions
Section 17 - RI8589: High Power Supply/Pulser
• New instrument added
Section 19 - RI8595: 700MHz to 6GHz Power Amplifier

Chapter 2 - Graphical Programming
Section 1 - Introduction
• Added information about symbol tables, setting buttons
from symbols, and setting buttons from local variables.
Section 4 - RI8535: Universal Digital
• Updates and corrections to edit button descriptions
Section 6 - RI8546: Device Power/Measure
• Minor corrections to StaticDigital edit button descriptions
© Roos Instruments Inc.

• New instrument added
Section 20 - RI8604: 71GHz - 86GHz TestSet
• New instrument added

Chapter 8 - Appendix
Section 9 - RI8564: 71GHz - 86GHz TestSet
• Added block diagram and performance specifications for
RI8564C version
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Section 10 - RI8567: 0.01 to 12GHz TestSet
• Updated block diagram
Section 19 - RI8589: High Power Supply/Pulser
• New instrument added
Section 21 - RI8595: 700MHz to 6GHz Power Amplifier
• New instrument added
Section 22 - RI8604: 71GHz - 86GHz TestSet
• New instrument added
Version 2.4 — March 2018
Fix for a bug that prevented sections from being displayed in the
Table of Contents on iOS devices.

About this Manual | Revision History
Section 6 - RI8546: Device Power/Measure
• Updates to StaticDigital edit button descriptions for I2C
communication.
Section 17 - RI8589: High Power Supply/Pulser
• Added button descriptions for high-speed profiler available
on RI8589B model
• Correction to example test plans
Section 18 - RI8594: High Perf. Waveform Generator & Measure
• Added measurement datatypes
Section 11 - RI8574: System Controller (EPC)
• Updated button descriptions for Measure Ref, Trigger
Ref, Trigger Spacing.

Version 2.5 —May 2018
Fixed a bug that displayed the page numbers incorrectly.

Version 2.7 — December 2019

Fixed hyperlinks throughout the Reference Guide.

Removed sections added in Version 2.5 for a fixed bug that
prevented sections from being displayed in the Table of Contents
on iOS devices.

Version 2.6 — April 2019
Chapter 2 - Graphical Programming

Chapter 1 - System Information

Section 5 - RI8545: 0.1 to 20GHz TestSet
Section 7 - Test Instrument Modules
• Updates to Pulse Width, Src 1 Seq, and Measure Mode
button descriptions.
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• Updated blind-mate interface figures and descriptions.
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Chapter 2 - Graphical Programming
Section 17 - RI8589: High Power Supply/Pulser
• Correction to button description of Output Range: ‘hi
current’ mode.
• Correction to button description of HV1/HV2/HV3 Current
Range
Chapter 5 - Diagnostics
• Added information about the RI8589 FetPulser-specific
diagnostic hardware and procedure.

About this Manual | Revision History
• Additional information for serial communication with two
and three wire bus emulation
Section 9 - RI8567: 0.01 to 12GHz TestSet
• Added additional information for Mix Side button
settings.
Section 15 - RI8581: 100kHz to 20GHz Receiver
• Added additional information for Mix Side button
settings.
Section 16 - 100kHz to 20GHz DSP Receiver
• Added additional information for Mix Side button setting.

Version 2.8 — August 2021
Chapter 2 - Graphical Programming

Section 17 - RI8589: High Power Supply/Pulser
• Correction to button description of Power Enable.

Section 3 - RI8508: RF Modulated Source
• Added Src Mode and Src Seq buttons information.
Section 4 - RI8535: Universal Digital
• Correction to precision voltage measure range.
Section 6 - RI8546: Device Power/Measure
• Voltage Meas Mode “HiRes” settings use a dedicated
24-bit DAC vs the “precision measure” settings.

© Roos Instruments Inc.
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SECTION 2

USING THIS BOOK

The Cassini Reference Guide is a collection of basic resources for
using and maintaining the Cassini ATE system’s software resources
and hardware components. Here the user will find safety practices,
system references and diagrams as well as general care,
maintenance, diagnostic, calibration, and troubleshooting information.
This book is an actively updated resource that will receive ongoing
updates. We encourage our users to provide feedback on the
experience and future content requests through support@roos.com to
help us improve and enhance this guide.

About this Manual | Using This Book

The reference guide was designed to take full advantage of the
features provided in the interactive book. Throughout the manual, the
user has access to multiple types of interactive figures, integrated
notes, and multimedia to provide a rich resource for understanding
and using the Cassini ATE system. The following pages provide a
summary of the available content, explanation of the various
resources used throughout this book, and some basic instruction on
how to get the most out of the eManual.

This section provides a general overview of the tools and features of
both this interactive book and the iPad to help maximize the benefits
of the guide.

© Roos Instruments Inc.
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About this Manual | Using This Book

GESTURES

Tap

The book design and layout were optimized for an iPad in both
portrait and landscape modes to provide the best user experience.
The following pages illustrate some common gesture conventions that
will help the user interact with the books features. Most gestures are
also supported by PDF readers on devices with a touch interface.

The entire screen acts like a button.
Tapping a single finger anywhere will
register as a ‘click.’

TAP
A one-finger tap can be used throughout the book to enable multiple
features. When a single tap is used on a figure, the image or diagram
will be rendered in a full screen view. A single tap within an interactive
image, review question, or multimedia window in the book will provide
interaction control. A single tap on text or the background of the book
will show the menu bar at the top of the screen. Two taps in quick
succession over text will select the word tapped. A menu will appear
above the selected text allowing the user to choose an action.

© Roos Instruments Inc.
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Hold

Swipe

Pressing one finger down on the
screen and holding it in the same
position on the screen.

Sliding a finger or multiple fingers
across the surface of the screen in a
swiping motion.

HOLD

SWIPE

The hold gesture is a useful shortcut for using the highlighter feature in
the text areas of the book. Pressing and holding one finger over text
activates a highlighter that can be used to indicate important
information. Once started, simply move the finger along the text of
interest to highlight the text. The borders of the selection area can be
enlarged by holding and dragging the demarcation boundaries.

A finger swipe or multi-finger swipe can be used for many functions
throughout the eManual. A single finger swipe is used to move from
page to page, much like swiping the pages of a physical book.
Swiping a single finger from right to left across the screen, will
progress the book to the next page. Swiping from left to right will
progress to the previous page. Within an interactive figure or
illustration, a finger swipe will control the focal view on a zoomed
image, progress to the next view, or can be used to manipulate a 3dimensional object. Swiping up or down on lists will scroll the
contents of the lists correspondingly.
NOTE: For iPads running iOS 9.0 or later, setting the book to Scrolling View will
display the pages of the book in one contiguous view that can scrolled by swiping up or
down on the text.

© Roos Instruments Inc.
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Pinch

Rotate

Pressing the thumb and forefinger on
the screen and swiping them toward
or away from each other in a pinching
motion.

Placing the thumb in a fixed position
on the screen and simultaneously
moving the index finger around the
thumb in a circular motion.

PINCH

ROTATE

The pinch gesture has multiple functions in the book. Within a chapter
or section of the book, pinching the thumb and forefinger together
over text or the background will exit from the current page back to the
chapter view. Pinching the thumb and forefinger away from each
other over an interactive figure or gallery will expand the figure to fill
the entire screen. Pinching the thumb and forefinger together over a
figure in full screen mode will return it to its original size. Pinching can
also be used for controlling the zoom view throughout the book.
Pinching the fingers away from or towards each other over the books
text or background will zoom-in or zoom-out the view on the screen
temporarily. Lifting one or both fingers off of the screen during the
pinch will release the temporary zoom and the text and/or image will
return to the original view size.

The rotation gesture is used for temporarily rotating the view of the
entire screen or the orientation of an interactive image. By placing one
finger on the screen in a fixed position and placing another finger on
the screen and then rotating around the fixed position clockwise or
counterclockwise will rotate the text and images of the page as a
single image correspondingly. This rotational view is temporary.
Removing one or both fingers from the screen will return the page or
image to its original orientation.

© Roos Instruments Inc.
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MENU CONTROLS

GALLERY 1 INTERACTIVE BOOK MENU BAR

The interactive book employs many features and controls available in
the menu control. These features are illustrated in Gallery 1.
NOTE: The PDF version of this book will only show the first illustration in a gallery. A
gallery supplement PDF can be made available upon request.

For iPads running iOS 7.0:
When in portrait mode, the font size can be increased or decreased to
improve readability. To adjust the font size, tap on the screen when in
portrait mode to bring up the menu controls. Select the font menu
icon ‘AA’ and then tap on the corresponding font button to increase or
decrease the size. The book will automatically save this setting for
viewing in portrait mode.
NOTE: The font size cannot be adjusted in landscape mode.

A single tap anywhere on the background will display the menu
controls at the top of the book.
Swipe to the left to view more menu bar tools.

For iPads running iOS 9.0 or later:
The book defaults to a portrait mode display when the iPad is held
vertically or horizontal. The font size cannot be adjusted in this mode.
The font size can be adjusted by switching to “Scrolling View” found
under the ‘AA‘ menu icon. Once scrolling mode has been activated,
the font size can be increased or decreased to improve readability. by
© Roos Instruments Inc.

tapping on the corresponding font button to increase or decrease the
size. The book will automatically save this setting for viewing in
Scrolling View.
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NOTES

GALLERY 2 NOTES

Notes allow the reader to supplement text and figures with their own
notes and emphasize important texts with highlights. The notes
features are illustrated in Gallery 2.
CAUTION: Updates to the Reference Guide can affect the user’s notes from version to
version of the book. User notes are not deleted after an update, but the listed location of
a note and hyperlink tab in the notes panel may be incorrect.
To correct a page mismatch:
1. If the page hyperlink is incorrect, select and copy the note of the
highlighted phrase or text with the incorrect page link
2. Select and search the highlighted text or phrase in the notes panel
for matches in the book. (Reference Gallery 2 for instructions on
selecting and searching text)
3. Once the highlighted text or phrase is located in the book, tap on
the highlighted text and delete the note or highlight by selecting
the trash icon.
4. Create a new highlight and add a note.

Double-tapping selects texts and provides menu options of: copying,
searching, highlighting and more. The selection area can be expanded
by holding and dragging the selection handles at each end.

5. Tap the note space to paste the previous note information into the
new note.
6. Return to the notes panel and verify that the new note and page
number are correct, and the old note is no longer present by
verifying the creation date.
© Roos Instruments Inc.
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BOOKMARKS & RECENTLY VISITED PAGES
The bookmark feature allows the creation of a user-specified record of
pages. These pages are compiled into a list that can be viewed by
tapping on the bookmark icon located on the far right side of the
book menu bar (see screenshot 7 of Gallery 1). Tapping on the
bookmarks within the list provides quick access to content.
Beneath the list of bookmarks are buttons for accessing previously
visited pages. These buttons allow the user to move forward and
backward through the previously visited page of the book. This
feature can be useful for more efficiently jumping between content
that has been bookmarked or hyperlinked resources that are located
on different pages.

HYPERLINKS
Hyperlinks are used throughout the text to allow quick access to
referenced or associated material in the book or on the web by
tapping on the hyperlink. Hyperlink text is designated by underlined
blue text.
NOTE: The recently visited pages feature, found under the bookmark tool of the menu
bar, is useful for moving between hyperlinked information.

© Roos Instruments Inc.
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About this Manual | Organization

ORGANIZATION

INTERACTIVE About this Manual.1 TABLE OF CONTENTS &
CHAPTER NAVIGATION

Chapter Title

Sections

The Reference Guide contains a preface, instrument references, and
an appendix. The table of contents, shown in Interactive
About this Manual.1, displays the chapters and their associated
sections in a graphical UI view. The title of the chapter is shown on
the top left of the page, sections within the chapter when available are
shown as a scrollable list on the right side of the page, and
thumbnails of all the pages within the chapter are shown across the
bottom. The reader can swipe left or right on the thumbnails to
navigate to a page and tap on the thumbnail or section list to jump
directly to that page or section. The number of chapters in the book
are displayed along the bottom of the table of contents page as dots.
Swiping left or right on the chapter title background will move from
chapter to chapter.
The Instrument Reference chapter provides comprehensive
information for every Test Instrument Module available on the Cassini
ATE platform. The chapter provides an introductory section with
general hardware information:
• TIM form factor
• Design and dimension specifications

Chapter Pages

• Input/Output types
Chapters

• Docking to the test head as well as general information about
software interaction tools:
• Configuration panel

© Roos Instruments Inc.
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• Edit panels
• Control panels
Each individual TIM is listed in subsequent sections of the chapter in
ascending order of model number. The TIM sections follow a standard
organization:
• Description page that includes a picture of the TIM and lists the
general functionality and key features
• A functional block diagram
• Abbreviated performance specifications (comprehensive
specification sheets are available upon request at:
support@roos.com)
• List of instruments provided by the TIM as shown in the Tester
Configuration Panel
• List and descriptions of the graphical programming buttons and
blocks found in the Edit Panel for each subsystem instrument
• Descriptions of the graphical control buttons found in the Control
Panel for each subsystem instrument
• Some example tests/test plans using the editor button/blocks

About this Manual | Organization

AUDIENCE
The guide accompanies the 5-day Cassini Basic Training Course,
covering several topics about the operation, maintenance, and
general use of the Cassini Test System. This guide assumes the
reader is familiar with Cassini’s modular system design, graphical test
plan development process, and software environment. For more
information about our products and services, visit roos.com.
The Reference Guide sections are divided into the following subject
areas:
• Chapter 1: System Information -- provides safety and operator
guidelines, system shipping or unpacking, and site preparation
information, as well as introductory material for the Cassini
Infrastructure, Test Instrument Modules (TIMs), Fixtures, and
Software Environment/Tools.
• Chapter 2: Graphical Programming -- provides an overview of
the test design environment on Cassini. It includes an
introductory chapter covering the basics of the test plan
development environment, As well, the chapter includes
individual sections for each of the test instrument modules, with
descriptions, uses, and examples of instrument state buttons
and measurement blocks.
• Chapter 3: Care & Maintenance -- provides general system and
instrument maintenance cycles, safe ESD practices, and system
care recommendations.

© Roos Instruments Inc.
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• Chapter 4: Service -- provides information about the service and
support options offered for the Cassini ATE system as well as
instruction for submitting support requests and TIM exchanges.
• Chapter 5: Diagnostics -- includes factory recommended
practices for running diagnostics, self tests, and supplemental
diagnostics for the Cassini ATE system to validate instrument
and test system operation and release procedures. A detailed
description of the diagnostic software UI (the Diagnostic
Executive) is included along with menu options, user controls,
and data export processes. The Diagnostic Kit and associated
diagnostic hardware are described with included examples.
• Chapter 6: Calibration -- includes general practice calibration
procedures as well as information on the associated hardware
and software.
• Chapter 7: Troubleshooting -- provides software and hardware
tips, tricks, and techniques for troubleshooting various parts of
the Cassini’s DC, digital, and RF instrumentation.
• Appendix -- contains reference material for the infrastructure
(Mechanical diagrams with dimensions, specifications, etc.), all
currently available Test Instrument Modules (descriptions, subinstruments, functional block diagrams, and abbreviated
specifications), user notes section, copyright information, and
user agreement legal copy.

© Roos Instruments Inc.
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SECTION 4

About this Manual | Notational Conventions

NOTATIONAL CONVENTIONS
Pinch Point Hazards
This symbol indicates pinch point hazards. Pinch points can cause
serious injury including contusions, crushing of tissues and bones, and
broken bones. Always keep hands, fingers, loose clothing, and persons
free of areas designated as pinch points.
This manual uses the following notational conventions:
Control-C
Hold down the Control key, then press the C key.
LMB click
Press and release the Left Mouse Button.
RMB click
Press and release the Right Mouse Button.
LMB hold
Press and hold down the Left Mouse Button.

Hazardous Voltages
This symbol indicates a voltage, either AC or DC, above 60 volts may be
present. These voltages can cause bodily injury such as electrical shock
or burns. A black flash signifies 60 to 999 volts. A red flash indicates the
voltage exceeds 1000 volts.

RMB hold
Press and hold down the Right Mouse Button.
DMB click
(Double Mouse Button) Press and release the left and right mouse
button simultaneously.
RI7100C or Cassini
Refers to the family of modular ATE systems.
© Roos Instruments Inc.
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About this Manual | Notes, Cautions, & Warnings

NOTES, CAUTIONS, &
WARNINGS
This manual uses notes, cautions, and warnings to highlight critical
information. To bring these to the reader’s attention, these messages
have special formats denoted below:

NOTE: Notes provide important information, useful hints, and/or tips.

CAUTION: Cautions have a higher level of severity. They caution the user to not
perform an action or actions that may damage the tester.

WARNING: Warnings have the highest severity. They warn the
user to not perform some action or actions that will damage the test
system and may result in personal injury.

© Roos Instruments Inc.

19

SECTION 6

ADDITIONAL HELP

About this Manual | Additional Help

ROOS INSTRUMENTS CONTACT INFORMATION:
Roos Instruments
2285 Martin Avenue
Santa Clara, California 95050
United States of America

Online material and reference information are available through the
Roos Instruments website at www.roos.com/support.html. Access to
the material requires a user name and password that can be obtained
by registering at roos.com/newFullUser or contacting support at
support@roos.com.

Phone: +1.408.748.8589
support@roos.com
www.roos.com

To report hardware or software problems, suggest improvements to
the test system, or request system features, contact support at
support@roos.com.
For technical assistance beyond the scope of the manual and the
online help system, contact Roos Instruments support at
1.408.748.8589 between 9:00 a.m. to 6:00 p.m. (U.S. Pacific
Standard Time) or email support at support@roos.com.

© Roos Instruments Inc.
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SYSTEM
INFORMATION

1

General information about
Cassini ATE System:
• Operator & Safety
Information
• Site Preparations
• Shipping & Packing
• System Installation
• Infrastructure
• Test Instrument Modules
• Fixtures
• Software Environment &
Tools

SECTION 1

System Information | Safety Information

SAFETY INFORMATION
CE MARK
This section provides general safety information, describes hazard
warnings for personnel using or near the test system, and
recommended procedures to avoid injury.
Cassini test systems are designed with an emphasis on safety and are
exempt from hazards included in the OSHA compliant safety program
during normal operation of the test system. If the system is used in a
manner not specified in the instructions, the protection provided by
the equipment may be impaired. The following safety information is
based on a standard operating air temperature from 10° to 35°C
(50°to 95°F) and humidity from 8% to 80%.
The following symbols are provided with their meanings along with
their application to the test system.

© Roos Instruments Inc.

The Cassini 16 test system conforms with the essential requirements
of the EMC Directive 2004/108/EC and LVD Directive 2006/95/EC,
based on the following specifications applied: EU Harmonized
Standards: EN 61326-1:2006, EN
61000-3-2:2006+A1:2009+A2:2009, EN 61000-3-3:2008, EN
61010-1:2001CE. Certificate available upon request. (Obtained June
16, 2011)

PINCH POINT HAZARDS
Pinch points can cause serious injury including contusions, crushing
of tissues and bones, and broken bones. Pinch point hazards for the
various Cassini test system models are provided.
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CASSINI 16 (RI8568)

System Information | Safety Information

FIGURE 1.1 CASSINI 16 PINCH POINTS

Do not obstruct the manipulator arm channel when raising and
lowering the test head. Keep it clear of objects at all times to prevent
accidental damage.
WARNING: Keep hands and fingers clear of the manipulator when
raising and lowering the test head.
Always use caution when docking a fixture to the test head. Insure
that the pneumatic fixture lock switch is set to the ‘unlatched’ position
when a fixture is not present on the test head. Keep hands, fingers,
and loose clothing clear of open slots and around the perimeter of
fixture and diagnostic/calibration plates.

1

2

WARNING: Keep fingers and loose clothing clear of the fixture
docking ports when latching or unlatching fixtures or calibration/
diagnostic plates. Never insert fingers into the docking ports.
Serious injury can occur.

The pinch points are shown for the elevator lift’s maximal positions at
reference 1 and the pinch points on the test head at the fixture docking
pin ports at reference 2.

© Roos Instruments Inc.
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SMALL CASSINI (RI8556)

System Information | Safety Information

FIGURE 1.2 SMALL CASSINI PINCH POINTS

Do not obstruct the manipulator arm channel when raising and
lowering the test head. Keep it clear of objects at all times to prevent
accidental damage.

1

The pinch points are shown for the elevator lift’s maximal positions at
reference 1.

© Roos Instruments Inc.

24

Cassini ATE System Reference Guide

LARGE CASSINI (RI8557)

System Information | Safety Information

FIGURE 1.3 LARGE CASSINI PINCH POINTS

Do not obstruct the manipulator tool-balancer when raising and
lowering the test head. Keep it clear of objects at all times to prevent
accidental damage.

1

The pinch points are shown for the elevator lift’s maximal positions at
reference 1.

© Roos Instruments Inc.
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WARNING: Depending upon system configuration options and test
programs used, HAZARDOUS VOLTAGES may be present at the
device interface during testing.

Hazardous Voltages
Cassini test systems include 120/220 AC to DC conversion supplies
to distribute 48V instrument power to the test head instrument slots
and auxiliary test head connectors. Improper safety practices when
working with these voltage and power levels can cause electrical
shock, injury, and/or damage to the test system equipment. Caution
should be exercised when accessing and servicing the test system
infrastructure or test head. Always power down the test system
before servicing the infrastructure or test head. The Cassini 16 and
Small Cassini chassis and test head are electrically connected to
earth ground when properly installed to provide safety grounding. The
Large Cassini provides electrical grounding for the test head to
provide safety grounding.

WARNING: The RI8589 High Power Supply/Pulser instrument
can produce DC and pulse voltages in excess of 170V. Always power
down and remove this instrument before performing any service to
the instrument, fixture, device interface board, or test system.

CAUTION: Powder coated and anodized surfaces do not provide adequate grounding
paths to the chassis’ safety ground. Always exercise safe grounding techniques and ESD
practices.
CAUTION: Insure common electrical grounding between the test system chassis,
auxiliary rack, and handlers using the Roos Instruments supplied green grounding wire
and alligator clip. Inadequate grounding can cause poor clock and or signal conditions
on the communication line between the tester and 3rd party devices like handlers or
probers.

© Roos Instruments Inc.
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RoHS exempt
RoHS Exemption
Roos Instruments is exempt from RoHS standards for lead free
components due to the performance characteristics of lead free
components and the class of hardware (EEE Cat. 6: Large-scale
stationary industrial tools).
WARNING: Service and maintenance personnel should always
exercise safe work practices to prevent exposure to lead-based solder
when working with internal electrical components of the test
system and equipment.
To prevent the accidental ingestion of lead-based solder, hands
should be washed with soap and water before and after working with
the internals of the test system and equipment. Work areas should be
kept clean and wiped with a damp paper towel to minimize the
potential of residual lead in the work area.

System Information | Safety Information

SAFETY PRECAUTIONS
Users should always adhere to the safety guidelines provided below:
• Read all of these instructions.
• Save this manual for later use.
• Do not use this test system unless it has been installed and
maintained as specified in the appropriate Site Preparation and
Installation and Maintenance manuals.
• Shut off all power before cleaning or servicing the test system.
Shut down and remove test instrument modules, fixtures, and/or
auxiliary equipment from the system before cleaning or
servicing.
• Do not drop any part of the test system.
• Always remove fixtures or diagnostic/calibration plates from the
test head when the pneumatic locks are disengaged.
CAUTION: Rotating the test head with an unlatched fixture or plate can result in
accidental drops and potential damage to instrumentation and fixtures.
• Do not obstruct or cover the slots and openings in the system
controller, test instrument modules, or test system. These
openings provide cooling and ventilation for the computer and
test equipment.
• Never obstruct openings of the auxiliary rack with other objects.

© Roos Instruments Inc.
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• Do not stack anything on top of the test system or auxiliary racks
with the except of workstation equipment: monitors, keyboard,
mouse.

System Information | Safety Information
• Any kind of liquid has been spilled on any part of the system
controller, computer peripheral, or test system.

• Do not cover openings at the bottom of the test system.

• The system controller, computer peripheral or any part of the
test system has been dropped.

• Do not place anything next to the test system that can block or
impede proper airflow to or from the test system.

• The system controller, the computer peripherals, or any part
of the infrastructure has been damaged.

• Operate the test system only from the type of power source
indicated on the labels and in the manuals.

• Contact Roos Instruments support for service or repair under any
of the following conditions:

• Keep power cords away from areas where people stand or walk.
Avoid stepping on power cables.

• The controller, computer peripherals, or test system show
any change in performance.

• Follow all warnings and instructions marked on the labels.

• Test programs does not run properly.

• Never spill liquids of any kind on the system controller, test
system, test instrument modules, fixtures or related equipment.

• The test head or any part of the test system cannot be
adjusted for a test program.

• Do not attempt to service the system controller, the computer
peripherals, or the test system without consulting a Roos
Instrument’s service or support engineer. See the maintenance
manuals for servicing procedures before opening any of
equipment on the test system. Repair and maintenance should
be done only by qualified service or repair persons.
• Shut off the entire test system under any of the following
conditions:
• Smoke or an odor is present.
• Any of the infrastructure cooling fans fail to operate.
© Roos Instruments Inc.
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EMERGENCY OFF (EMO)

System Information | Safety Information

FIGURE 1.4 EMERGENCY OFF (EMO) SWITCH

SWITCH
The emergency off (EMO) switch shown in Figure 1.4, are kill switches
that immediately disconnect power from the test system as quickly as
possible even if this damages equipment. The EMO switch should
only be used in cases of serious, unexpected, and/or dangerous
situations requiring the immediate deactivation of the test system.
CAUTION: The abrupt loss of power from an emergency shutdown can cause disk
crashes, corrupted files, and lost test program edits and data.

The above figure shows the Emergency Off or
EMO switch found on the Cassini16 and Large
Cassini test systems.

© Roos Instruments Inc.
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EMERGENCY SHUTDOWN
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FIGURE 1.5 LARGE CASSINI EMERGENCY OFF SWITCH

PROCEDURE
The Cassini 16 and Large Cassini test systems are all equipped with
readily accessible emergency off switches. These kill switches
immediately disconnect power from the test system completely and
as quickly as possible even if this damages equipment. The location
of EMO switches for the Cassini 16 system and Large Cassini test
systems are provided in Figure 1.6 and Figure 1.5.

1

NOTE: The Small Cassini test system is not equipped with an EMO switch. The OFF/
ON/START switch, shown in Figure 1.7, serves as the emergency off function.

To activate the EMO switch, depress the red button fully. The EMO
switch will remain in the recessed, engaged position after it has been
activated. The switch must be deactivated to restore the test system
to operation. The switch is deactivated by turning the knob in a
clockwise motion. This will release the button, returning it to its armed
or ready position.
CAUTION: After an emergency shutdown, set all switches, knobs, and breaker switches
on the test system, auxiliary rack, and auxiliary equipment to their ‘OFF’ positions.
Remove all test instrument modules and fixtures from the test system.

© Roos Instruments Inc.
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FIGURE 1.6 CASSINI 16 EMERGENCY OFF SWITCH

System Information | Safety Information

FIGURE 1.7 CASSINI 8 OFF/ON/START SWITCH

1

1

© Roos Instruments Inc.

31

SECTION 2

OPERATOR INFORMATION
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Below are hyperlinks to the associated procedures and guidelines:
• Safety Information
• Emergency Off Switch/ Emergency Shut Down
• Start Up Procedure

This section provides links to guidelines and recommended best
practices for operators on the Cassini test system.

• Docking to Handler or Prober
• Docking a Fixture or Diagnostic Plate
• Standard Shut Down Procedure
• Electrostatic Discharge (ESD) Practices
• RF Connector Care

© Roos Instruments Inc.
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SECTION 3

SITE PREPARATION FOR
CASSINI SYSTEMS
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RI8568B "CASSINI 16" INFRASTRUCTURE
DIMENSIONS:
• Max Height: 1,847 mm (73.1 in)

Cassini ATE systems can operate in a wide range of environmental
conditions. Depending on the system configuration, some
specifications may not apply or have individual requirements. The
spatial dimensions and shipping weight of the various Cassini ATE
systems and associated equipment is provided in the following
section for site preparation compliance. Mechanical diagrams of the
infrastructure footprints are available in the Appendix for reference.

• Depth: 1,208 mm (47.6 in)
• Width: 844 mm (33.2 in)

WEIGHT:
• Max Shipping Weight: 250 Kg (550 lbs.)

NOTE: All values are subject to change without notice.

ENVIRONMENT SPECIFICATIONS:
• Operating Air Temperature: 10°C to 35°C (50°F to 95°F)
For best calibration performance, a consistent ambient room
temperature of ± 5°C is recommended.
• Humidity: 8% to 80%
• Electrical Specifications:
• 120/220 AC (50 or 60 Hz) Single Phase
• Plug type: IEC C19
© Roos Instruments Inc.
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• Power Requirements
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PNEUMATIC/COMPRESSED AIR SPECIFICATIONS:

• Minimum: 0.15 kVA

• Input Pressure Range: 65-120 PSI (regulated to 90 psi)

• Maximum: 0.75 kVA

• System Connector Type: Quick-Disconnect US Industrial/Milton
MIL-C-4109 Male (preferred), shown in Figure 1.8

• Aux Rack Maximum: 1.2 kVA (300 VA per Source)
• Networking: System Controller requires a standard CAT-5
RJ45 ethernet network cable to integrate with a Guru Server.

• Adapters support alternative compressed air hose systems.
These adapters are included with system:

ELECTRICAL GROUND:

• OPTION 1: Thread NPT 0.25 in Female Adapter onto air hose at
facility and attach to quick disconnect on tester.

It is essential to maintain a consistent electrical ground between the
handler and the Cassini test system infrastructure and auxiliary rack.
This prevents Device Under Test (DUT), test system, and or handler
interface damage.

• OPTION 2: If the hose is 8 mm or 0.3125 in, use the barbed hose
adapter with 0.25 in NPT male thread, shown in Figure 1.11.
Thread onto NPT 0.25 in Female Adapter shown in Figure 1.9.
Clamp the air hose to the adapter as shown in Figure 1.10

• The green ground wire must be connected between the
infrastructure (and auxiliary rack if necessary) and the handler’s
ground.

FIXTURE:
• Height: 195.6 mm (7.7 in) - includes clearance for alignment pins
• Depth: 266.7 mm (10.5 in)
• Width - 16 slot test head: 558.8 mm (22 in)
NOTE: Always consider the fixture height when determining the minimum clearance of
the test head when working with a handler or prober.

© Roos Instruments Inc.
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HANDLER/PROBER:
• Docking and adapter plates are available based on Handler/
Prober Type.

System Information | Site Preparation for Cassini Systems

FIGURE 1.8 QUICK DISCONNECT MIL-C-4109
MALE

• A single GPIB/Parallel/Handler Pod is required for every handler/
prober interface with a Cassini test system. Pods require factory
configuration and programming. Handler/prober control logic
documentation must be sent to support@roos.com at least one
month prior to system installation date.
• Handler Pod Interfaces: Parallel 25 Pin Female D-Sub, Serial
Female RS232, or GBIP cable.

WORKSTATION:
• An auxiliary rack is required for monitor, keyboard and mouse
workspaces.
• Workspace must be located adjacent to the system within
network cable reach of the System Controller
• The System Controller and Touch UI (RI8583A) option uses the
power supply from the tester. Depending on the monitor type, it
may use the AUX rack power supply or need an additional outlet.

This quick connect/disconnect adapter is preattached to the Cassini 16 system at the factory.

© Roos Instruments Inc.
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FIGURE 1.9 NPT 0.25 IN FEMALE ADAPTER
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FIGURE 1.10 CORRECTLY INSTALLED NPT 0.25

IN FEMALE

ADAPTER

The female adapter shown above attached to an
input air hose supply compressed air.

© Roos Instruments Inc.

36

Cassini ATE System Reference Guide

System Information | Site Preparation for Cassini Systems

FIGURE 1.11 NPT 0.25” MALE THREAD BARBED HOSE ADAPTER
AND

CLAMP

© Roos Instruments Inc.
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RI8557A "LARGE CASSINI" INFRASTRUCTURE:
DIMENSIONS:
• Height: 1700 mm (66.9 in)

System Information | Site Preparation for Cassini Systems
• Large Cassini Input kilovolt-amperes (kVA) approximately:
• Minimum: 0.15 kVA
• Maximum: 1.5 kVA
• System Controller requires a standard CAT-5 RJ45 ethernet
network cable to integrate with a Guru Server.

• Depth: 900 mm (35.4 in)
• Width: 600 mm (23.6 in)

WEIGHT:
• Maximum Shipping Weight: 300 Kg (660 lbs)

ENVIRONMENT SPECIFICATIONS:

ELECTRICAL GROUND:
It is essential to maintain a consistent electrical ground between the
handler and the Cassini test system infrastructure and auxiliary rack.
This prevents Device Under Test (DUT), test system, and or handler
interface damage.
• The green ground wire should be connected between the
infrastructure (and auxiliary rack if necessary) and the handler’s
ground.

• Operating Air Temperature: 10°C to 35°C (50°F to 95°F)
For best calibration performance, a consistent ambient room
temperature of ± 5°C is recommended.
• Humidity: 8% to 80%
• Electrical Specifications:
• 115V AC ±10% (or 230V ±10% with option 30A)
• System controller and monitor each require a separate 120V
AC power supply outlets.
© Roos Instruments Inc.
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FIXTURE:

WORKSTATION:

• Height: 195.6 mm (7.7 in) - includes clearance for alignment pins

• A workspace cart is needed to hold monitor, keyboard, and
mouse.

• Depth: 266.7 mm (10.5 in)
• Width - 8 slot test head: 266.7 mm (10.5 in)

• Workspace must be located adjacent to the test system within
network cable reach of the System Controller.

NOTE: Always consider the fixture height when determining the minimum clearance of
the test head when working with a handler or prober.

• System Controller requires a standard CAT-5 RJ45 ethernet
network cable to integrate with a Guru Server.

HANDLER/PROBER:
• Docking options based on Handler/Prober Type.
• Only one (1) Handler Pod per handler/prober per system.
Requires factory RI configuration and programming.
Use Serial, Parallel or GPIB standard cable and communication
interfaces. Provide detailed handler control logic documentation
to support@roos.com prior to ship date.
• Handler Pod Interface Cable: Parallel 25 Pin Female D-Sub,
Serial Female RS232, or GBIP cable.

© Roos Instruments Inc.
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RI8556A "SMALL CASSINI" INFRASTRUCTURE:
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• Power Requirements (kVA=KiloVolt-Amperes)
• Minimum: 0.15 kVA
• Maximum: 0.75 kVA

DIMENSIONS:
• Height: 1,590 mm (62.6 in)
• Depth: 733 mm (28.9 in)
• Width: 853 mm (33.6 in)

WEIGHT:
• Maximum Shipping Weight: 250 Kg (550 lbs)

• System Controller requires a standard CAT-5 RJ45 ethernet
network cable to integrate with a Guru Server.

ELECTRICAL GROUND:
It is essential to maintain a consistent electrical ground between the
handler and the Cassini test system infrastructure and auxiliary rack.
This prevents Device Under Test (DUT), test system, and or handler
interface damage.
• The green ground wire should be connected between the
infrastructure (and auxiliary rack if necessary) and the handler’s
ground.

ENVIRONMENT SPECIFICATIONS:
• Operating Air Temperature: 10°C to 35°C (50°F to 95°F)
For best calibration performance, a consistent ambient room
temperature of ± 5°C is recommended.
• Humidity: 8% to 80%
• Electrical Specifications:
• 120/220 AC (50 or 60 Hz) Single Phase
• Plug type: NEMA 20
© Roos Instruments Inc.
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FIXTURE:
• Height: 195.6 mm (7.7 in) - includes clearance for alignment pins
• Depth: 266.7 mm (10.5 in)
• Width - 8 slot test head: 266.7 mm (10.5 in)
NOTE: Always consider the fixture height when determining the minimum clearance of
the test head when working with a handler or prober.

• Handler/Prober:
• Docking and adapter plates are available based on Handler/
Prober Type.
• A GPIB/Parallel/Handler pod is required for every handler/
prober interface with a Cassini test system. Pods require
factory configuration and programming. Handler/prober
control logic documentation must be sent to
support@roos.com at least one month prior to system
installation date.
• Handler Pod Interfaces: Parallel 25 Pin Female D-Sub, Serial
Female RS232, or GBIP cable.

WORKSTATION:
• The workstation is integrated into the Small Cassini infrastructure.
• The System Controller and Touch UI (RI8583A) option uses the
power supply from the tester.
© Roos Instruments Inc.
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SECTION 4

SHIPPING AND UNPACKING
A CASSINI SYSTEM
Cassini test systems should always be packaged and shipped using
the Roos Instrument’s provided shipping crates. These are designed
specifically for the test system with adequate sizing, anti-static
material, and conformal padding to protect the test systems during
transport. If this crate and shipping material are not available, contact
Roos Instruments for further instructions.

System Information | Shipping and Unpacking a Cassini System

SERVICE INFORMATION
If a test system item is being returned to Roos Instruments for service,
it must include a Return Merchandise Authorization (RMA) number. To
obtain an RMA number, please email support@roos.com or contact
Roos Instruments at 1.408.748.8589 between the hours of 9:00 a.m.
to 6:00 p.m. (U.S. Pacific Standard Time)
An RMA must be requested within 15 calendar days of the invoice
date (ship date for credit card orders). NO returns of any type will be
accepted without an RMA number and ALL returns must be shipped
prepaid and insured via any common carrier (i.e. UPS, FedEx).
NOTE: Tracking information is required.

NOTE: Always store test systems and shipping crates in an ESD safe, temperature
controlled environment at all times.

NOTE: Damage to test systems, TIMs, instruments, and/or equipment during shipping
is the responsibility of the shipping party. Roos Instruments is not liability for shipping
damage of equipment shipped to Roos Instruments for service, repair, or otherwise.

© Roos Instruments Inc.
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UNPACKING CASSINI TEST SYSTEMS
Always unpack a Cassini test system on a clean, flat surface in an
ESD-safe, temperature controlled environment.
Before unpacking a Cassini test system, inspect the exterior of the
crate. Shipping crates may include anti-tampering metal straps
around the exterior of the crate. Insure shipping documentation is
attached to the exterior of the crate, and that the crate has been
delivered and stored according to the orientation arrows. Inspect the
exterior of the crate for signs of improper handling, storage, shipping
damage, tampering, or otherwise. If any signs of visible damage,
suspected mishandling or evidence of possible tampering is present,
contact Roos Instruments before opening and unpacking the crate.

TO REMOVE A CASSINI ATE SYSTEM FROM THE

System Information | Shipping and Unpacking a Cassini System
4. Unlock the six tension latches located along the sides of the
crate’s fold down door/ramp.
5. Carefully open the fold-down crate door/ramp to access the
interior.
6. Inspect the interior of the shipping crate for signs of shipping
damage or improper storage during transport. Contact Roos
Instruments if visible damage or moisture is present in the interior
of the shipping crate.
7. The test system shipping contains other shipping containers for
test instrument modules or other equipment. Remove these
boxes before removing the test system infrastructure and/or
auxiliary racks.
8. Loosen the wing nuts that secure the wooden cross brace in
place and remove the brace as shown in Figure 1.13.

SHIPPING CRATE:

9. Remove the dust cover bag.

1. Insure the crate is oriented in accordance with the shipping
arrows and directions on the exterior.

10. Remove the test head support foam block located on the rear,
right side of the ATE System.

2. Remove and retain the shipping documentation affixed to the
exterior of the crate for manifest reference and record keeping.

11. Loosen the test system’s stabilizer feet as shown in Figure 1.14 by
turning the adjustment knobs in a counter clockwise direction until
they are as far above the floor as they can adjusted. This will allow
the system to roll freely on the system casters.

3. (If applicable) Remove the anti-tampering metal shipping straps
from the exterior with an appropriate metal shearing tool.

12. Pull the Cassini ATE System out of the crate using the two large
handles located along the top of the infrastructure chassis.
© Roos Instruments Inc.
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13. The system should roll easily down the ramp created by the open
crate door.

UNPACKING OPTIONAL SHORT AUXILIARY RACK
Once the test system is removed from the crate, the auxiliary rack can
be removed.
1. Begin by removing the two foam blocks at the bottom of the rack
as shown in Figure 1.15.

FIGURE 1.12 UNPACKING CASSINI 16: EXTERIOR

Shipping
Documents

2. Loosen the auxiliary rack’s stabilizer foot by turning the knob in a
counterclockwise direction until the stabilizer is as far above the
floor as possible.
3. Roll the auxiliary rack out of the crate by pulling on the extended
shelf so that rack can move out of the crate door and down the
ramp

Anti-Tampering
Straps

Tension Latch

The image above shows the test system shipping crate oriented
correctly with the door/ramp facing forward.
© Roos Instruments Inc.
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FIGURE 1.13 UNPACKING CASSINI 16: INTERIOR 1

FIGURE 1.14 UNPACKING CASSINI 16: INTERIOR 2
1. Remove Test Head
Support Foam

1. Remove
Wing Nuts
& Block

2. Loosen
Stabilizer
Feet

1. Remove
Wing Nuts
& Block

2. Loosen
Stabilizer
Feet

2. Remove
Protective Cover

© Roos Instruments Inc.

45

System Information | Shipping and Unpacking a Cassini System

Cassini ATE System Reference Guide

FIGURE 1.15 UNPACKING CASSINI 16: REMOVING AUXILIARY RACK

1. Remove
Foam Block

1. Remove
Foam Block

2. Loosen
Stabilizer
Foot
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SECTION 5

INSTALLATION
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TO INSTALL A CASSINI 16 TEST SYSTEM:
Reference the Cassini 16 Infrastructure Diagram for component
names and locations.
1. Before connecting AC power to the infrastructure, verify that both
the main breaker switch and secondary breaker switches are in the
OFF position.

This section provides step-by-step procedures for installing a new or
re-located Cassini test system. Reference the Site Preparation for
Cassini Test Systems section in the System Information chapter for
test floor compliance of environmental, electrical, and equipment
requirements. If the system is a new, factory provided Cassini system,
adhere to the unpacking guidelines outlined in the Shipping and
Unpacking a Cassini Test System section in the System Information
chapter. Users should always adhere to the safety guidelines provided
in the Operator and Safety Information section in the System
Information chapter.
WARNING: Before installing and powering up a Cassini test
system, inspect the surfaces, connectors, and mechanical
components of the chassis, TIMs, fixtures, and auxiliary equipment
for damage. If there is any damage, do not attempt to power on the
test system. Contact Roos Instruments support for recommended
service, repair, and/or replacement of suspected equipment.

© Roos Instruments Inc.

2. Verify that the Fixture Docking Switch is in the UNLATCH position.
NOTE: A fixture or calibration/diagnostic plate should not be docked to the test head
while installing ore removing TIMs.

3. Insure the manipulator locking pin is in the 'Maintenance Lock'
position and the test head is fixed in place. This prevents the test
head from moving horizontally during set up.
NOTE: The manipulator lock should be in the ‘Maintenance Position’ when the tester is
not attached to a handler/prober or when the system is not in use.

4. Inspect the test head RIFL contact pads located on the underside
of the test head. To access the contact pads, unlock and rotate the
test head 180 degrees so that hub PCBs are visible and facing
upwards.
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WARNING: If any damage to the test head RIFL PCB or contacts is
visible, do not attach TIMs to the test head. Contact Roos
Instruments support for service recommendations.

System Information | Installation
10. Plug in the IEC C19 AC line cord to the infrastructure main AC
input.
NOTE: System supports 220 V/120 V AC.

5. If counterweights are to be installed, lock the test head rotation lock
and install the counterweights in accordance with the included
counterweight installation instructions.
6. Rotate the test head to the upright position and lock the rotation
pin.
7. If the System Controller is not already installed in the infrastructure,
insert the System Controller TIM. Reference the System Controller
Installation instructions.
8. If the system is equipped with an auxiliary rack and auxiliary test
equipment, position and lock the rack to the infrastructure chassis
using the docking guides and pull lock. Reference the auxiliary rack
position configurations shown in the Appendix for the RI8568
Cassini 16 infrastructure. Plug in the AC line cord from the auxiliary
rack’s AC power distribution input.
9. Install TIMs into their appropriate slot locations. If the system is
equipped with an auxiliary rack and auxiliary test equipment, also
install the remote TIMs into their appropriate slot locations.
NOTE: Reference the provided Test Head Resources or Test Head Configuration
diagram for the TIM locations on a Cassini test system.

© Roos Instruments Inc.

11. Connect the compressed air source to the test systems air input
port located on the chassis adjacent to the secondary breakers.
Reference the Cassini Site Preparation section for the specifications
and setup of the pneumatic air system.
12. Check that the Emergency Off (EMO) switch is not engaged.
Reference the EMO switch information in the Operator & Safety
Information section.
13. Verify that the System Controller’s ethernet port, located adjacent
to the latch, is connected to a minimum standard ethernet CAT-5e
RJ45 network cable connected to 10/100/1000BASE-T (Gigabit
Ethernet) network switch or hub to connect the test system with a
Guru Server and/or other network resources.
14. The test system can now be powered-on following the
instructions provided in the System Startup Procedures.
To install or setup a Small Cassini or Large Cassini test system,
contact Roos Instruments at support@roos.com for instructions and
procedures.
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INFRASTRUCTURE
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TOPICS

Introduction
Chassis
Test Head & Hubs
Fixture Docking System
Fixture Resources
System Controller
Installation
Start Up Procedure
Shut Down Procedure

© Roos Instruments Inc.

49

Cassini ATE System Reference Guide

INTRODUCTION
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The Cassini test system infrastructure is designed to deliver a lowcost, high-throughput ATE solution platforms to support mixed signal,
RF and microwave ICs. The three main elements to the Cassini
architecture are:

RIFL was expanded to include precision 48V instrument power,
transitioning from fiber to shielded copper. The bus is designed to
support distributed compute packets across Cassini's instruments.
The reduced data payloads boost overall system performance and by
decoupling operation execution from the bus speed, Cassini can
achieve much faster test times.

• RF-based architecture designed for high accuracy, precisions,
and test performance

The following text provides a basic overview of the various Cassini
ATE infrastructures and components.

• Modular test head that supports a high-speed data bus and
precision power bus
• Small footprint, energy-efficient, system infrastructure and
instruments
Cassini provides a completely configurable, modular architecture,
making every part of the test system configurable. The test system
design has partitioned all the measurement hardware into swappable
instruments that can be inserted into universal slots on the test head
to build a targeted production test solution. The modular test head
design fuses a flexible microwave instrument architecture with 25
years of test system integration to deliver seamless multifunctional
and multi-instrument test performance. With this versatile framework,
the system can be adapted and scaled efficiently across a frequency
range of DC to over 100 GHz. Instrument modularity is enabled by the
Roos Instruments Fast Link(RIFL) instrument data and communication
bus. It is the first open-standard bus designed specifically for
production test. First introduced as a high-speed optical fiber bus,
© Roos Instruments Inc.
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CHASSIS
CASSINI 16
The following numbered components reference Figure 1.16.
1. Controller Power Indicator - blue indicator light that signifies
the AC/DC switching power supply/system controller power
status.

6. Infrastructure Stabilizer - provides test system stabilization and
leveling of the test system with the floor.
7. Test Head Counterweight - Optional test head counterweight
attachment to compensate for test instrument module loading.
8. RIFL Hub Ports (H-Ports) - Four RIFL (Roos Instruments Fast
Link) communication ports, typically used to connect auxiliary or
peripheral test equipment to the test head communication hub.

FIGURE 1.16 CASSINI 16 REAR VIEW

2. OFF/ON/START Switch - rotary switch used to power on or
power off the test system controller.
3. System Controller - embedded user interface, multi-instrument
control, and graphical test programming environment for the
Cassini ATE system. Supplies the RIFL (Roos Instruments Fast
Link) communication bus as well as distributing 48V instrument
power and a shared 10 MHz reference clock across the
instrument test head.
4. Main Breaker - primary test system circuit breaker that interrupts
the power to the AC/DC power supply in the test system in the
event of an excess current fault condition. The switch can be
manually operated to de-energize the test system power.
5. Infrastructure Stabilizer - provides test system stabilization and
leveling of the test system with the floor.
© Roos Instruments Inc.
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9. Test Head Rotation Lock - Rotational knob that locks and
unlocks the test head rotation.
10. Fixture Docking Indicators - Two multi-color LEDs (ALIGN/
DOCK) that indicate the docking status of fixtures or diagnostic/
calibration plates.

6. Secondary Breakers - multiple circuit breakers that interrupt
power to the test head power supply in the test system in the
event of an excess current fault condition. The switch can be
manually operated to de-energize the test head and infrastructure
power.

11. Serial Number - Infrastructure identification and Guru ID.

The following numbered components reference Figure 1.17.

FIGURE 1.17 CASSINI 16 FRONT VIEW

1. Fixture Docking Switch - rotary switch for controlling the
pneumatic fixture docking system. The ‘Latch’ setting locks a
fixture to the test head. The ‘Unlatch’ setting unlocks a fixture
from the test head.

1
12

2

13

11

2. Test Head Elevation Control - two push button switches ‘UP/
DOWN’ for raising and lowering the test head and manipulator
arm.

3
10

3. Emergency Oﬀ (EMO) Button - emergency off button for the
test system.

4

4. AC/DC Power Supply Access Panel - access panel to the
infrastructure AC to DC switching power supply.
5. Compressed Air Intake - compressed air input for the
pneumatic fixture docking system.

© Roos Instruments Inc.
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7. Green Handler/Prober Grounding Cable with Alligator Clip attach this green ground cable directly to the Handler/Prober’s
ground. Optionally, connect AUX Rack Ground to this location.
8. Infrastructure Access Panel - aluminum panel can be removed
to provide access to the infrastructure AC/DC power supply and
supporting circuitry.

System Information | Infrastructure
13. Docking Position Indicator - provides a blue dot indicator for
position reference of the test head in either the locked
‘Maintenance Position’ or with planar movement freedom when in
the ‘Docking Position’ setting.

9. Test Head Access Panel - aluminum panel that can be removed
to provide access to the test head RIFL hub and supporting
circuitry.
10. Test Head (T-Slots) - Anodized aluminum plate with 16 universal
Test Instrument Module slots and fixture (FIX) interface.
11. Manipulator Arm - armature with 6 degrees of freedom for
positioning and supporting the test head.
12. Manipulator Lock - Locking pin for fixing the manipulator arm
into the ‘Maintenance Position’ during service or repair and
allowing planar movement of the test head in the ‘Docking
Position.’ Pulling the locking pin upwards and rotating the head
180 degrees, unlocks the manipulator arm for fine planar
positioning of the test head. To lock lock the manipulator arm in
the maintenance position, rotate the locking pin head until the pin
recesses into the locking position. Using blue dot of the docking
position indicator, move the test head into the ‘Maintenance
Position’ until the locking pin engages with an audible click.

© Roos Instruments Inc.
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SMALL CASSINI

FIGURE 1.18 CASSINI 8 FRONT VIEW

The following numbered components reference Figure 1.18.
6
1

1. OFF/ON/START Switch - rotary switch used to power on or
power off the test system controller.
2. Main Breaker - primary test system circuit breaker that interrupts
the power to the AC/DC power supply in the test system in the
event of an excess current fault condition. The switch can be
manually operated to de-energize the test system.

2

3. Instrument Rack - test system equipment rack for storing
RI7725/7710 Sources, 7000 series instruments, and test controller.
5

4. Cable Feed Port - an opening in the workstation infrastructure for
routing DC and RF cables to the test head within a flexible cable
accordion boot.

4

3

5. Test Head Access Panel - aluminum panel that can be removed
to provide access to the test head RIFL hub and supporting
circuitry.
6. Test Head - Anodized aluminum plate with 8 universal test
instrument module slots and fixture RIFL interface block.

© Roos Instruments Inc.
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The following numbered components reference Figure 1.19.
1. Workstation - integrated operator workstation for monitors,
keyboard, etc.

FIGURE 1.19 CASSINI 8 REAR VIEW
3

1
2

2. Fixture Docking Switch - solenoid switch control for docking/
undocking a fixture to the test head. Depressing the bottom
allows the lock to be manually actuated for locking a fixture to the
test head or unlocking a fixture for removal from the test head.
NOTE: Depressing the solenoid release switch for an extended period of time (> 5-10
seconds) results in excess current through the switch. To prevent damage, the button has
a built-in, cool down mode before reuse. The button will flash indicating the solenoid
release is temporarily disabled during this cool-off period.

4

3. Test Head Rotation Lock - the sliding handle on the manipulator
arm locks or unlocks the test head rotation position.
4. Test Head Elevation Control - pull button knob that releases
the test head elevation lock to manually raise or lower the test
head and manipulator arm.
5. Tool Balancer - the lift-assist mechanism for raising and lowering
the test head.

© Roos Instruments Inc.

5
6 (Interior)

6. 48V Distribution Breakers - circuit breakers that interrupt 48V
power to the test head and controller in the test system in the
event of an excess current fault condition. The switch can be
manually operated to de-energize the test head and system
controller.
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LARGE CASSINI
The following numbered components reference Figure 1.20.
1. Tool Balancer - the lift-assist mechanism for raising and lowering
the test head.
2. Test Head - anodized aluminum plate with 8 universal test
instrument module slots and fixture RIFL interface block.
3. Fixture Docking Switch - solenoid switch control for docking/
undocking a fixture to the test head. Depressing the bottom
allows the lock to be manually actuated for locking a fixture to the
test head or unlocking a fixture for removal from the test head.
NOTE: Depressing the solenoid release switch for an extended period of time (> 5-10
seconds) results in excess current through the switch. To prevent damage, the button has
a built-in cool down period before reuse. The button will flash indicating the solenoid
release is temporarily disabled during this cool-off period.

6. Workstation Surface - an optional workstation table for placing
computer/controller monitor, keyboard, and/or mouse.
7. OFF/ON/START Switch - rotary switch used to power on or
power off the test system controller.
8. Emergency Oﬀ (EMO) Button - emergency off button for the
test system.

FIGURE 1.20 LARGE CASSINI (BIG CASSINI) FRONT VIEW
8

7

2

6

4. 48V Distribution Breakers - circuit breakers that interrupt 48V
power to the test head and controller in the test system in the
event of an excess current fault condition. The switch can be
manually operated to de-energize the test head and system
controller.
5. Rack Access Lock - rotational knob for accessing the
instrument rack and equipment.

© Roos Instruments Inc.

1 (Interior)

3 (Reverse Side)
5
4 (Interior)
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TEST HEAD
Cassini test systems include a manipulator arm and configurable test
heads that are designed for Roos Instruments test instrument
modules (TIMs). The test heads support eight (Cassini8 or Large
Cassini) or 16 TIM slots to allow a completely configurable test head
for different applications, test floors, sites, or customers. TIMs are
designed with quick release latches and blind mate connectors that
are designed to allow multiple features:

System Information | Infrastructure
hub provides RIFL connection for TIMs in slots 5 through 8 and 13
through 16. The ‘Rear Test Head’ hub provides RIFL connection for
TIMs in slots 1 through 4 and 9 through 12.

• System is easy add, remove, and configure test head resources
• Unified test head plane with easy access to TIM resources
• Simplified fixture docking and instrument resource interfacing
• 48V-supplied TIM power and RIFL data bus connections
The manipulator arm allows movement of the test head with
compliance for various handler and prober setups. Small Cassini and
Large Cassini models allow 2-axis of movement: vertical lift and 225
degrees of test head rotation. Cassini 16 allows for 6 axes of test
head movement: vertical lift, 2-axis fine planar movement, 2-axis of
gimbal movement, and 225 degrees of rotation (see Figure 1.22). All
Cassini test systems contain a RIFL test head hub that connects TIMs
to the RIFL hub. The RIFL hub of Small Cassini and Large Cassini
have eight instrument nodes with 12 contact pads that connect the
TIMs RIFL pogo pins to the controller bus as shown in Figure 1.23
and Figure 1.25. The Cassini 16 test system contains two, eight slot
nodes as shown in Figure 1.21 and Figure 1.24. The ‘Front Test Head’
© Roos Instruments Inc.
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FIXTURE POWER
DC power is provided for active devices inside the fixture. Additionally,
open-collector drivers are provided for controlling switches inside the
fixture.

FIGURE 1.21 CASSINI 16 TEST HEAD LAYOUT

FIXTURE DC POWER
Fixture Control Lines (cbits)

Rear Test
Head Hub

Open-collector lines, available for controlling switches or other devices
inside the fixture.

TIM Slot

• Quantity: 8
• Low Voltage (typical): 0.5V
• Maximum current, per line: 0.1A

Fixture
RIFL

Front Test
Head Hub

• Maximum combined current, all 8 lines: 0.5A
NOTE: A smart fixture uses approximately 0.13 amps from the fixture +5V. If a smart
fixture is used, the maximum available current from the fixture +5V is 1.37A.
The illustration above shows a top-down view of the Cassini16 test head
(shown transparent) with the locations of the Front and Rear test head
RIFL hubs, and the fixture RIFL blind-mate interface.

© Roos Instruments Inc.

58

System Information | Infrastructure

Cassini ATE System Reference Guide

FIGURE 1.22 CASSINI 16 TEST HEAD ARTICULATION

FIGURE 1.23 CASSINI8/RI7100C TEST HEAD LAYOUT

Instrument Rack
Resources
Test Head
Hub

TIM Slot
Fixture
(FIX)
interface

The illustration above shows a top-down view of the Cassini 8/
RI7100C test head (shown transparent) with the location of the test
head RIFL hub, fixture FIX blind-mate interface, and instrument rack
resources(DC/RF) blind-mate interface.
The manipulator arm can be elevated (blue) and the test head allows
gimbal movement (green), 2 axes of fine planar movement (blue) and
225 degrees of rotation (orange).
© Roos Instruments Inc.

59

Cassini ATE System Reference Guide

System Information | Infrastructure

FIGURE 1.24 CASSINI 16 TEST HEAD RIFL HUB (1 OF 2)

FIGURE 1.25 8 SLOT TEST HEAD RIFL HUB

The picture above shows the bottom or TIM view(top) and the top or

The picture above shows the bottom or TIM view(top) and the top or

test head plate view(bottom) of one of the two 8 slot RIFL hubs used in

test head plate view(bottom) of the 8 slot hubs used in the Cassini 8

the Cassini 16 test heads. Two of these hubs located on the underside

and RI7100C test heads. The hub is located on the underside of the

of the test head to connect up to 16 TIMs to the RIFL data bus. The tabs

test head to connect up to 8 TIMs to the RIFL data bus. The tabs on the

on the PCB provide 12-pad RIFL interface pressure contacts with the

PCB provide 12-pad RIFL interface pressure contacts with the 12-pin

12-pin pogo blocks found on the test instrument modules.

pogo blocks found on the test instrument modules..

© Roos Instruments Inc.
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FIXTURE DOCKING SYSTEM
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FIGURE 1.26 CASSINI 16 PNEUMATIC FIXTURE DOCKING SYSTEM

Cassini test heads include a specialized, blind-mate TIM interface
system for fixtures. Four receive ports on the test head connect fixture
docking pins to a mechanical lock system. The system uses two
canoe-shaped slide locks to engage the docking pins. The Small
Cassini and Large Cassini systems provide a solenoid release switch
to manual actuate the fixture lock system. The Cassini 16 test system
uses a pneumatic (forced air system) to lock the fixture docking pins
with mechanical canoe locks, securing the fixture to the test head as
shown in Figure 1.26. Alignment and keyed-guide pins between the
fixture mating blocks and the TIM blind-mate interface, insures proper
alignment and compliance.
See Inserting and Removing Fixtures for the detailed docking
procedure.

The diagram above shows the various components of the fixture
locking system. Forced air from the air hookup (green) is regulated to
provide consistent locking force of approximately +100 lbs. between
the blind-mate fixture blocks and the TIM interfaces. Fixture docking
pins engage the u-bars (red arrows) at four locations on the test head
for uniform force distribution. The u-bar locks move horizontally to
engage the fixture docking pins and secure the fixture.

© Roos Instruments Inc.
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SYSTEM CONTROLLER
The System Controller provides the embedded user interface, multiinstrument control, and graphical test programming environment for
the Cassini ATE system. Instrument control and management are
provided via the RIFL (Roos Instruments Fast Link) bus. RIFL provides
the communication bus as well as distributing 48V instrument power
and a shared 10 MHz reference clock across the instrument test
head. The controller provides networked data storage and
communication capabilities (Guru™) via a standard CAT-5
connections with local storage for online and offline development and
USB ports for non-network data transfer. Guru™ provides tools for
organizing files, data, and software test resources along with built-in
file versioning, automated backups, data and test distribution control,
access control and more.
On Cassini 16 test systems, the system controller is a TIM that is
connected to the rear side of the infrastructure chassis as shown in
Figure 1.16. On Small Cassini and Large Cassini infrastructures, the
system controller is an instrument module located in the workstation/
instrument rack.

INSTALLATION
CASSINI 16
Before installing a System Controller:
• Exercise proper ESD procedures with the Cassini test system
and System Controller TIM.
• Verify that the system is powered down: OFF/ON/START knob is
in the OFF position, the main breaker switch is in the OFF
position and the secondary breakers are in their OFF positions.
• Inspect the TIM to insure that no damage has occurred to the
chassis or RIFL block interface and check that air exhaust
channels are free of debris. Verify that mechanical components
such as the bottom and top latch releases and locks are
operating correctly and that the computer ports and pins: VGA,
serial, parallel, USB, and PS/2 are not damaged.

TO INSTALL A CASSINI 16 SYSTEM CONTROLLER:
1. Hold the TIM using the top and bottom latch releases in the
unlocked position with the blind-mate interface facing down.
2. Guide the system controller into place in the infrastructure
controller slot located on the backside of the test system chassis.

© Roos Instruments Inc.
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3. Verify that the RIFL block and pogo pins of the system controller
align properly and make good contact with the chassis RIFL
master pads.
4. Release the bottom latch handle to engage the detent lock and
engage the top-latch by pressing the knob inwards toward the
TIM to lock the system controller into place.
5. Verify that the controller is seated and secured firmly in place
before proceeding.

START UP PROCEDURE
To perform a standard start up, use the procedures outlined below for
the appropriate Cassini system.
NOTE: There is a recommended 2 hour minimum warm up time for test systems before
calibrations should be run on test systems with RF test instrument modules (TIMs). RF
TIMs contain temperature control systems designed to maintain a pre-defined
temperature for internal instruments and components to insure consistent measurement
accuracy.

NOTE: The system controller must be installed in order to control the pneumatic fixture
docking system and to supply 48V to the front and rear test head RIFL hubs.

CASSINI 16
6. Connect the computer peripherals: keyboard, monitor, mouse or
touch screen, to their associated IO port on the system controller.
7. Connect the System Controller’s ethernet port located adjacent to
the bottom latch to a standard CAT-5 RJ45 ethernet network
cable to connect the test system with a Guru Server.

SMALL CASSINI AND LARGE CASSINI
The system controllers are pre-installed into the instrument racks. To
remove, service, or replace system controllers for the Large Cassini or
Small Cassini test systems, contact Roos Instruments at
support@roos.com.

© Roos Instruments Inc.

Insure that the test system has been installed correctly and in
accordance with the requirements listed in the Site Preparation,
Shipping and Unpacking, and System Installation instructions.
1. Move the system into final operating position, ready for docking
with a Handler or Prober (if applicable).
2. If a fixture is attached, undock the fixture from the test head.
WARNING: The DUT, DIB or Fixture could be damaged if the
Fixture is latched while the system is starting up. Never add or
remove TIMs while the Fixture is latched to the test head.
3. Verify that AC power has been connected to the infrastructure and
the rotary OFF/ON/START knob is in the OFF position.
63

Cassini ATE System Reference Guide
4. Insure the pneumatic air hose is connected to a compressed air
source with required pressure specified in the site preparations
information.
5. Insure the system controller is installed and locked into the
infrastructure and that all computer peripherals (CAT-5 Ethernet,
monitor, keyboard, mouse, touch screen, etc.) are connected to
the controller before powering up the system.
6. Confirm the Main Breaker switch located on the rear, lower left
side of the infrastructure chassis is in the ON position. Also
confirm the secondary breakers, located adjacent to the forced-air
hookup, are in the ON position.
NOTE: Depending on the model year, the number and naming of secondary breakers
may vary. For newer models -- switch ON the ‘MAINFRAME’ switch followed by the
‘HEAD’ switch. For early models -- switch ON the ‘Test Head’ followed by the ‘TIM
FRONT’ and then the ‘TIM REAR’ switch.

7. If not already attached, TIMs and auxiliary equipment (Handler
Pod) may be connected to the test head with the system powered
off adhering to the Installing a TIM procedure. Do not connect a
Fixture until after the system software is running.

System Information | Infrastructure
8. Turn the OFF/ON/START rotary knob located on the rear side of
the chassis (see Figure 1.27) from the OFF position to the ON
position, and then rotate and hold it in the START position for 1-2
seconds to start up the test system. The system can take up to 3
minutes before the Guru control bar appears and the user can
logon.
9. If an external monitor is used, turn on the monitor power and
allow the system OS to complete start up process. If a touch
screen monitor is used, the monitor power will automatically
power on.
10. The user should select Logon, enter the username and password
and press Log On. Then press Short Cuts or User Apps to
continue loading the system software.
11. If a hander is being used, dock the Fixture to the handler and
connect the handler Pod while the RI system software is loading.
Once the Cassini main window appears, dock the Fixture or
Diagnostic/Calibration plate. Always choose System > Check
after docking to activate the Fixture.
The system is now ready to begin testing.

NOTE: If a handler or prober will be used, connect the ground cable from the
infrastructure to a ground plug on the handler or prober.

© Roos Instruments Inc.
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FIGURE 1.27 CASSINI 16 OFF/ON/START SWITCH

1

LARGE CASSINI
Insure that the test system has been installed correctly and in
accordance with the requirements listed in the Site Preparation,
Shipping and Unpacking, and System Installation instructions.
1. Remove all fixtures, calibration/diagnostic plates, and auxiliary
equipment from the test head.
2. Verify that AC power has been connected to the test system and
that all breakers on the 48V distribution panel, located inside and
at the bottom of the instrument rack, are in the OFF position.
3. Insure the system controller is installed in the instrument rack and
locked into a rack position.
4. Verify that all computer peripherals (CAT-5 Ethernet, monitor,
keyboard, mouse, touch screen, etc.) are connected to the
controller before attempting to power up the system.
5. Insure all RF cables routing from the instrument rack to the test
head are connected.
6. Turn on the 48V Distribution breaker switches from the OFF
position to the ON position in the following sequence: 1 RACK, 3
FANS, and then 5 HEAD. Reference Figure 1.20 for location.
7. Turn the OFF/ON/START rotary knob located on the front exterior
of the instrument rack (see Figure 1.28) from the OFF position to
the ON position, and then hold it in the START position for 2-3
seconds to start up the test system.

© Roos Instruments Inc.
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8. If an external monitor is used, turn on the monitor power and
allow the system software to complete start up. If a touch screen
monitor is used, the monitor power will automatically power on.
9.

Once the system software has successfully booted, a user has
logged in, and a System Check has been performed, TIMs and
auxiliary equipment may be connected to the test head followed
by fixtures or diagnostic/calibration plates, adhering to the
procedures outlined in Section 5: Test Instrument Modules and
Section 6: Fixtures.

© Roos Instruments Inc.

FIGURE 1.28 LARGE CASSINI OFF/ON/START SWITCH

1
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SMALL CASSINI
Insure that the test system has been installed correctly and in
accordance with the requirements listed in the Site Preparation,
Shipping and Unpacking, and System Installation instructions.
1. Remove all fixtures, calibration/diagnostic plates and auxiliary
equipment from the test head.
2. Verify that AC power has been connected to the test system and
that main breaker, located on the front lower right side of the
workstation rack, and the 48V Distribution breakers, located in the
rear of the workstation rack, are in the OFF position. Reference
Figure 1.18 and Figure 1.19 for locations.
3. Insure the system controller is installed in the workstation rack and
locked into a rack position.

System Information | Infrastructure
8. Turn the OFF/ON/START rotary knob located on the front lower
right exterior of the workstation rack (see Figure 1.29) from the
OFF position to the ON position, and then hold it in the START
position for 2-3 seconds to start up the test system.
9. If an external monitor is used, turn on the monitor power and
allow the system software to complete start up. If a touch screen
monitor is used, the monitor power will automatically power on.
10. Once the system software has successfully booted, a user has
logged in, and a System Check has been performed, TIMs and
auxiliary equipment may be connected to the test head followed
by fixtures or diagnostic/calibration plates, adhering to the
procedures outlined in Section 5: Test Instrument Modules and
Section 6: Fixtures.

4. Verify that all computer peripherals (CAT-5 Ethernet, monitor,
keyboard, mouse, touch screen, etc.) are connected to the
controller before attempting to power up the system.
5. Insure all RF cables routing from the instrument rack to the test
head are connected.
6. Place the Main breaker switch from the OFF position to the ON
position. Reference Figure 1.18 for location.
7. Place the 48V Distribution breaker switches from the OFF position
to the ON position in the following sequence: RACK, and then
HEAD. Reference Figure 1.19 for location.
© Roos Instruments Inc.
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FIGURE 1.29 CASSINI 8 OFF/ON/START SWITCH

1

SHUT DOWN PROCEDURE
To shut down a test system for routine service or maintenance, use
the procedures outlined below for the appropriate Cassini system.

CASSINI 16
1. Stop all test programs and other user programs.
2. Save edits and data from user programs in progress (if desired).
3. If a shortcut is active, close the system shortcut by selecting the
System > Quit… menu options from the main system window or
RMB click the main system window ‘x’ button at the top right
corner.
4. The test system will prompt the user to confirm the closure of the
Cassini main system window.
5. Shutdown the operating system by selecting the OS shutdown
shortcut or selecting the Shutdown… option from the eCS Start
menu located at the bottom of the screen.
6. The operating system will prompt the user to confirm the
shutdown.
7. A shutdown screen animation (blink screen) followed by an
audible series of beeps will prompt the user when it is safe to
deactivate power.

© Roos Instruments Inc.
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8. After the screen animation has completed, the screen is blank,
and the audible beeps begin, the user has 3-5 seconds to
deactivate the controller before the test system initializes an auto
start sequence.

LARGE CASSINI

NOTE: If the auto start sequence has begun, let the system complete the restart before
attempting to shut down.

3. If the Cassini main system window is open, close the system
shortcut by selecting the System > Quit… menu options from
the main system window or RMB click the main system window
‘x’ button at the top right corner.

9. Shut down the controller power by turning the ‘Main System’
knob found on the controller side of the chassis (as shown in
Figure 1.27) from the ‘ON’ position to the ‘OFF’ position.

4. The test system will prompt the user to confirm the shortcut
closure.

1. Stop all test programs and other user programs.
2. Save edits and data from user programs in progress (if desired).

10. Before performing service or maintenance to the system test
head, switch the test head breakers (located next to the
pneumatic hose hookup) to the ‘OFF’ position.

5. Shutdown the operating system by selecting the OS shutdown
shortcut or selecting the Shutdown… option from the eCS Start
menu located at the bottom of the screen. The operating system
will prompt the user to confirm the shutdown.

11. Before performing service to equipment in the auxiliary rack,
switch the auxiliary rack breakers (located at the top interior of the
rack) to the ‘OFF’ position.

6. A shutdown screen animation (blink screen) will prompt the user
when it is safe to deactivate power.

12. Before performing service or maintenance to the infrastructure or
AC/DC power supplies, switch the main breaker (located near the
pneumatic hose hookup on the controller side of the tester) to the
‘OFF’ position.

© Roos Instruments Inc.

7. After the screen animation has completed and the screen is blank,
the user has 3-5 seconds to deactivate the controller before the
test system initializes an auto start sequence.
NOTE: If the auto start sequence has begun, let the system complete the restart before
attempting to shut down.
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8. Shut down the controller power by turning the ‘OFF/ON/START’
knob found on the front side of the system rack adjacent to the
EMO switch (as shown in Figure 1.28) from the ‘ON’ position to
the ‘OFF’ position.
9. Before performing service or maintenance to the system, switch
the 48V breakers (located at the bottom interior of the system
rack) to the ‘OFF’ position.

System Information | Infrastructure
7. A shutdown screen animation (blink screen) will prompt the user
when it is safe to deactivate power.
8. After the screen animation has completed and the screen is blank,
the user has 3-5 seconds to deactivate the controller before the
test system initializes an auto start sequence.
NOTE: If the auto start sequence has begun, let the system complete the restart before
attempting to shut down.

SMALL CASSINI
1. Stop all test programs and other user programs.
2. Save edits and data from user programs in progress (if desired).
3. If the Cassini main system window is open, close the system
shortcut by selecting the System > Quit… menu options from
the main system window or RMB click the main system window
‘x’ button at the top right corner.
4. The test system will prompt the user to confirm the shortcut
closure.

9. Shut down the controller power by turning the ‘OFF/ON/START’
knob found on the front-right side of the system rack (as shown in
Figure 1.29) from the ‘ON’ position to the ‘OFF’ position.
10. Before performing service or maintenance to the system, switch
the test head and main breakers (located on the front-right side of
the system rack beneath the OFF/ON/START switch) to the ‘OFF’
position.

5. Shutdown the operating system by selecting the OS shutdown
shortcut or selecting the Shutdown… option from the eCS Start
menu located at the bottom of the screen. The operating system
will prompt the user to confirm the shutdown.
6. The operating system will prompt the user to confirm the
shutdown.

© Roos Instruments Inc.
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TEST INSTRUMENT
MODULES
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TOPICS

Form Factor
Dual Latch System
Signal & Communication Interfaces
Inserting & Removing
Shipping & Receiving Requirements

© Roos Instruments Inc.
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INTRODUCTION
At the heart of Cassini's configurable architecture are Test Instrument
Modules (TIMs). These self-contained, swappable instruments provide
all the source, receive, measure, and signal processing capabilities for
a broad range of DC, digital, mixed-signal, RF, and millimeter-wave
applications. Each TIM contains an instrument or multiple instruments
with a targeted feature sets specific to a test application.

System Information | Test Instrument Modules
operating temperature. TIM dimensions of a standard can be found in
Figure 1.30.

FIGURE 1.30 STANDARD TIM DIMENSIONS

As the entire test system is modular, RF TIMs were designed to
integrate with each other to provide enhanced feature capability such
as multi-path switching, resource sharing, signal combination, multiinstrument measurement, frequency translation, and more. In this
section the user will find introductory information about the TIM
hardware, capability, and software control.

FORM FACTOR
Test Instrument Modules use a standardized design to support
Cassini’s modular test head slots. This allows for completely
configurable instrument layouts on the test head. An aluminum frame
and panel covers protect instrumentation while keeping TIMs both
light and portable for swapping and repairing. The ruggedized exterior
provides a durable enclosure on the production floor with enhanced
microwave shielding. Thermal exhaust ports are incorporated into the
panel covers with a built-in, air-cooling system to provide stable
© Roos Instruments Inc.

Standard TIM design and dimension. Examples of the different
available types are shown in this gallery.
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DUAL LATCH SYSTEM

ROOS INSTRUMENTS FAST LINK (RIFL)

Standard TIMs, except for remote TIMs, incorporate a 2-lock system
for securing the instrument to the test head. The top latch, found next
to the blind-mate interface, secures the TIM to the underside of the
test head by way of a preload latch. The bottom latch is then released
while being pulled away from the test head.

RIFL is an open-standard communication and instrument power bus.
The 12-pin RIFL connector block can be found next to the blind-mate
TIM interface (see Figure 1.32). The block contains pogo pin contacts
that interface with Cassini’s RIFL hub on the underside of the test
head. This bus is responsible for communication and control of the
instruments from the EPC System Controller.

FIGURE 1.31 DIAGRAM OF A TIM
Blind-Mate Interface

Top Latch Release

Bottom Latch Release

Bottom Latch

© Roos Instruments Inc.
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BLIND-MATE INTERFACE

System Information | Test Instrument Modules

FIGURE 1.32 RIFL BLOCK

The resources of a TIM are accessible by way of a blind-mate
connector. This system provides instrument layout flexibility and a
unified test head with access to tester resources for calibration and
debug purposes. DC, digital, RF and millimeter-wave ports are
standardized within the test head block and are designed to mate
directly with resource blocks in the device interface environment. This
provides configurable cross-instrument connections and signal
routing. Two alignment pins found on the top portion of the blind-mate
block ensure mechanical alignment and tolerance when docking to
the test head. On the sides of the block, keyed guide pins prevent
accidental mismatch docking between different types of fixture blocks
and TIMs. Figure 1.33, Figure 1.34, Figure 1.35, Figure -.-, and Figure
1.36 provide examples of the different types of TIM interfaces.
A black 12-pin RIFL connector block shown above, (just left of the
blind-mate interface), carries instrument’s DC power, communications,
and the system’s reference clock.

© Roos Instruments Inc.
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FIGURE 1.33 DC INTERFACE

FIGURE 1.34 DIGITAL INTERFACE

FIGURE 1.35 RF INTERFACE

TIMs with DC resources use a precision

The high-speed digital TIM uses a High

RF TIMs utilize a specialized, military-grade

Hypertronics pin interface. The Hypertronics

Density Shielded Interconnect (HDSI). These

#12 PKZ connector. This blind-mate

connectors are designed for low-mating

low profile, micro-miniature, ribbon coaxial

interface provides an inner and outer

force requirements and high-reliability.

cable assemblies are designed for optimal

conductor separated by an air dielectric for

signal integrity and impedance matching up

constant impedance up to 40 GHz. The

to 1 GHz.

high-performance design functions across
the widest mating tolerance available in
any microwave blind-mate connector.

© Roos Instruments Inc.
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FIGURE 1.36 WAVEGUIDE INTERFACE

Millimeter wave resources are routed
through a minituarized blind-mate
waveguide interface as shown above.
Precision alignment pins and guides on the
waveguide connector face ensure planarity
and safeguard against misalignment. The
frequency range of the waveguide is defined
by the geometry of the center port (Typically
WR-15 for 55-65 GHz range and WR-12 for
75-85 GHz).

© Roos Instruments Inc.
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INSTALLING & REMOVING TIMS
TIMs were designed to be inserted and removed quickly to support
the reconfigurable nature of Cassini’s modular test head as well as
service requirement needs. The universal test head slots and standard
TIMs allow Cassini to be reconfigured in support of different
applications, site, and/or customer requirements. Included in the
following text are instructions for inserting and removing standard
TIMs on the Cassini test head.

INSTALLING A TIM
Before installing a TIM from Cassini’s Test Head, always:
• Exercise proper ESD procedures with the Cassini test system,
fixtures, and TIMs.
• Remove any fixtures or diagnostic/calibration plates from the test
head to prevent damage to blind-mate interfaces.
• Perform a system check to update the system configuration
before installing the TIM.
• Inspect the TIM to insure that no damage has occurred to the
chassis or blind-mate interface and check that air exhaust
channels are free of debris. As well, verify that mechanical
components such as the bottom and top latch releases and
locks are operating correctly.
• Rotate and lock the test head into the upright position as shown
in Figure 1.37 and set the manipulator arm in the locked
‘Maintenance Lock’ position.
© Roos Instruments Inc.
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To install a TIM to the Test Head:
1. Hold the TIM using the top and bottom latch releases in the
unlocked position with the blind-mate interface facing up as
shown in .
2. Bring the TIM up to the test head from underneath, using the
alignment pins and blind-mate interface to guide the TIM into the
test head slot.
3. When the alignment pins are visibly through the test head, the
TIM’s top-latch should be resting against the underneath of the
test head and the clasps of the top latch should extend past the
top of the test head.
4. Continuing to hold the TIM in this position, insure the bottom latch
insert is aligned with the slot’s associated detent receiving port.
5. Release the bottom latch handle to engage the bottom lock and
continue to hold the bottom of the TIM up against the bottom side
of the test head. The engaged bottom latch will prevent the TIM
from accidental drops while the top latch is not engaged.
6. Engage the top latch by pressing the knob inwards toward the
test head (early model versions) or by pressing the lever arm down
the against the side of the TIM (late model versions).
7. Inspect the top latch clasps to insure they have engaged the top
of the test head and that the TIM is securely in place.
8. Perform a software System > Check to activate the TIM
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FIGURE 1.37 ADDING TIMS TO THE TEST HEAD
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If the TIM was successfully installed, verify that the TIM’s instrument
resources appear in the Tester Configuration and/or equipment pool
window in the appropriate test head slot.
NOTE: Power to the TIM from the test head can be verified by checking that the
instrument fan on the bottom of the TIM has powered on after the System Check.

REMOVING A TIM
Before removing a TIM from Cassini’s test head, always:
• Exercise proper ESD procedures with the Cassini test system,
fixtures, and TIMs
• Remove any fixtures or diagnostic/calibration plates from the test
head to prevent damage to blind-mate interfaces
• Rotate and lock the test head into the upright position, as shown
in Figure 1.38, and set the manipulator arm in the locked
‘Maintenance Lock’ position.
• It is recommended but not required to power down the TIM
before removing it from the test head.
To remove a TIM from the test head:

Holding the top and bottom latch releases as shown, the TIM can be
aligned and inserted into the Cassini test head.
© Roos Instruments Inc.

1. Grasp the top-latch release and pull the knob directly away from
the blind-mate interface in a motion parallel to the test head
plate(older model versions) or pull the top-latch handle upwards
and away from the side of the TIM. This will release the TIM’s top78
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latch clasps from the test head and the TIM will rest on the
engaged bottom latch approximately 0.25in or ~6.4mm below the
test head.
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FIGURE 1.38 REMOVING TIMS FROM THE TEST HEAD

2. The distance between the TIMs top latch and the test head plate
will disengage the RIFL block from the 48V instrument supply and
the communication bus.
3. Verify that instrument power has been removed from the TIM by
performing a software System Check to confirm the TIM
instruments are no longer in the Tester Configuration or
Equipment Pool list. This can also be confirmed by checking that
the fan on the bottom of the TIM is no longer running.
4. Holding the top latch release handle firmly, pull the bottom latch
release tab directly away from the center of the test head in a
motion parallel to the test head plate to release the TIM
completely from the test head.
5. Move the TIM away from the test head in downward motion to
prevent contacting the TIM slot RIFL pins underneath the test
head and adjacent TIMs.
Always store removed or inactive TIMs in a ESD safe, temperature
controlled environment.

Holding the top and bottom latch releases as shown, the TIM can be
aligned and inserted into the Cassini test head.
© Roos Instruments Inc.
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SHIPPING & RECEIVING
REQUIREMENTS
Test instruments and TIMs should always be packaged and shipped
using the Roos Instrument’s provided container. DO NOT discard
these containers. They are designed specifically for the instruments
and TIMs with adequate sizing, anti-static material, and conformal
padding to protect them during transport. If this container and
shipping material are not available, contact Roos Instruments for
further instructions.
Damage to TIMs, instruments, and/or equipment during shipping is
the responsibility of the shipping party. Roos Instruments assumes
liability for damage of equipment shipped from the factory. Roos
Instruments is not liability for shipping damage of equipment shipped
to Roos Instruments for service, repair, or otherwise.

SERVICE INFORMATION
If a product is being returned to Roos Instruments for service, please
provide enough information to help expedite repair and return of the
product. For best service results, include as much information as
possible: symptoms, date of failure, the current status of the
instrument, etc.

© Roos Instruments Inc.
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Items for return must include a Return Merchandise Authorization
(RMA) number. To obtain an RMA number, please email
support@roos.com or contact Roos Instruments at 1.408.748.8589
between the hours of 9:00 a.m. to 6:00 p.m. (U.S. Pacific Standard
Time)
An RMA must be requested within 15 calendar days of the invoice
date (ship date for credit card orders). NO returns of any type will be
accepted without an RMA number and ALL returns must be shipped
prepaid and insured via any common carrier (i.e. UPS, FedEx).
Tracking information is required.

PACKAGING A TIM
Proper packaging of TIMs prevents damage and improves response
time for repair and replacement. Every TIM should be individually
boxed with the supplied shipping container and packaging provided
by Roos Instruments following the instructions below:
• Wrap the instrument in heavy paper or plastic. If the instrument is
a circuit board, wrap it in anti-static material first, then add
additional wrapping material. (If shipping to Roos Instruments for
service, attach a tag indicating the service required, return
address, model number, and full serial number).
• Use the provided shipping container as shown in Figure 1.39.
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• Insert the layer of shock-absorbing foam over the open side of
the sides of the instrument as shown in Figure 1.41, to provide
firm cushioning and prevent movement inside the container.
• Seal shipping container securely. To close securely, DO NOT use
masking tape, cellophane tape, duct tape, string, or paper overwrap. Instead, use a strong tape such as pressure-sensitive
plastic -- two inches (5.08 cm) or more in width, or
nylon reinforced filament tape -- 60 lbs. (27 kg) grade tape at
least three inches (7.62 cm) wide.
• Apply three strips to seal the open flaps of the box, where they
meet in the center. If necessary, apply three strips of tape to the
bottom of the box, so the middle and two edge seams are
sealed.
• Mark shipping container “FRAGILE” to ensure careful handling.
• In any correspondence, refer to instrument by model number,
serial number, and/or RMA number.

PACKAGING AN RI7710/7725 SOURCE
The RI7710/7725 Source is considerably larger and more fragile than
other Cassini instrument. As such, special care must be used when
packaging for shipment.If at all possible, the source should be
packaged in a Roos approved, Anritsu (OEM) shipping box. If
shipping from North America, Roos Instruments will provide a box at
request. When properly packaged in the appropriated Anritsu box, the
© Roos Instruments Inc.
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instrument is sandwiched between two plastic sheets, suspending it
in the center of the box and provide adequate cushion against shock.
To package an Anritsu source, follow the instructions provided below:
• Wrap the instrument chassis in the conductive foam packing
material provided. Be sure to complete encase the instrument,
covering sharp edges and corners of the instrument chassis.
• Wrap the encased instrument with the provided plastic cover
and tape the bag closed with standard clear packing tape.
• Place the wrapped instrument in the Anritsu box on top of the
plasticized insert as seen in Figure 1.42.
• Place the second plasticized insert on top of the wrapped
source, and press it down firmly to sandwich the instrument
between the inserts.
• Seal shipping container securely. To close securely, DO NOT use
masking tape, cellophane tape, duct tape, string, or paper overwrap. Instead, use a strong tape such as pressure-sensitive
plastic -- two inches (5.08 cm) or more in width, or
nylon reinforced filament tape -- 60 lbs. (27 kg) grade tape at
least three inches (7.62 cm) wide.
• Apply three strips to seal the open flaps of the box, where they
meet in the center. If necessary, apply three strips of tape to the
bottom of the box, so the middle and two edge seams are
sealed.
• Mark shipping container “FRAGILE” to ensure careful handling.
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• In any correspondence, refer to instrument by model number,
serial number, and/or RMA number.
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data. The following steps provide the recommended actions for
receiving a TIM:
1. Verify the RMA number and information on the shipping container
match the service documentation.

RECEIVING TIMS
Once a TIM is returned from a factory or service repair, a visual
inspection and validation of instrument functionality should be
performed as soon as possible to insure that no shipping damage has
occurred. If the TIM is not to be utilized immediately, it should be
stored in the provided shipping packing and kept in a temperature
controlled, static-free environment.
If the TIM has been upgraded or utilizes calibration data, there are
several software resources that must be updated in Guru. Installing
these software resources first will allow the TIM to download and
utilize the updated resources automatically when inserted and
powered up in the test system. A .gzp file containing the appropriate
TIM firmware and cal data is provided by Roos Instruments via email.
This .gzp file must be imported into the Cassini test system’s Guru.
This can be accomplished by using the Importer feature of Guru
Browser on the local test system, or by importing the file into the
networked Guru Server (via a Cassini VirtualBox simulator or Guru
Client application) that services the associated Cassini test systems.
Once this has been imported and is available on the test system, the
TIM can be installed. If the TIM is installed before the software
resources are updated, a system startup is required to force the
installed TIM to download and recognize the updates and calibration
© Roos Instruments Inc.

2. Inspect the cardboard TIM container for visible signs of shipping
damage such as holes, cracks, and/or dents. If the shipping
container appears to be significantly damaged, inform Roos
Instruments immediately.
3. Remove the TIM from shipping container and visually inspect the
chassis, latches, and instrument interface for any signs of
shipping damage. If the TIM appears damaged or internal
components appear loose, inform Roos Instruments immediately.
DO NOT install a TIM that is suspected to be damaged into the
test system. Contact a Roos Instruments service or support
engineer.
4. If the TIM has been re-calibrated or upgraded at the factory, the
TIM software resources must be updated in Guru. Reference the
text above for more information.
5. If the TIM appears to be in good working order and software
resources are up to date, it can be installed in the test system and
powered up. Be sure to remove any fixture or diagnostic/
calibration plates before installing the TIM.
6. Allow 20 minutes of warm-up time before performing TIM
validations, calibration, or using the instrument.
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FIGURE 1.39 RI PROVIDED TIM SHIPPING

FIGURE 1.40 TIM PLACEMENT IN

FIGURE 1.41 FOAM PLACEMENT IN

The Roos Instruments TIM shipping shown

The TIM should be placed inside the

Place the included packing foam over the

above is designed for standard TIM

shipping container as shown, orienting the

top of the TIM to encase the instrument

transport. The container’s dimensions are

instrument with its’ associated conformal

within the container as shown.

26in x 20in x 8in (66cm x 51cm x 20cm).

foam shape.

CONTAINER

SHIPPING CONTAINER

SHIPPING CONTAINER

Conductive foam is shaped to conform to
the TIM shape, providing ESD and impact
shock protection.

© Roos Instruments Inc.
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FIGURE 1.42 RI7710/7725 SHIPPING

FIGURE 1.43 RI7710/7725 SHIPPING

The shipping container for an Anritsu

After placing the Anritsu instrument in the

sources suspends the source between within

shipping container, it is sandwiched by the

the container using a plasticized insert.

plasticized insert shown above, suspending

CONTAINER

INSERT

the instrument within the container and
securing it in place.

© Roos Instruments Inc.
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TOPICS

General Information
Diagnostic & Calibration Interface Plates
Inserting & Removing
Shipping Requirements

© Roos Instruments Inc.
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OVERVIEW

FIGURE 1.44 ANATOMY OF A MATRIX FIXTURE

Cassini fixtures carry the modular architecture of Cassini into the
device interface environment. Housed in a rugged aluminum
enclosure is a completely configurable test resource environment. The
form factor and discrete design layers support an application range
from DC to 90GHz. Integration with Cassini's software allow fixtures
to extend and enhance the capabilities of test instruments with an
integrated calibration layer that delivers signal accuracy right to the
device pin.

COMPONENTS
All of the functionality and capability of traditional load boards have
been re-engineered to take advantage of the configurable instrument
framework of Cassini. The discrete layers shown in Figure 1.44,
enable design and development flexibility for high-performance RF
devices that can be optimized independently to suite application
needs. Listed below are the component names and definitions:
1. Device Interface Board (DIB) Clamp - One of three
components comprising the Quick-Lock™ system, the DIB clamp
aligns and protects the Device Interface PCB by sandwiching it
between electrically shielded aluminum with a pliable conductive
elastomer liner. The clamp frame design coupled with the pedestal
support enhances multi-site RF signal isolation.
2. Device Interface Board (DIB) - With most of the application
specific resources moved inside the fixture, the DIB consists of a
© Roos Instruments Inc.
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2-layer PCB of interconnect with passive RF matching
components. With a solid ground plane on top and strip line
microwave signal paths, the DIB delivers unmatched performance
up to 20GHz, providing a low-cost solution for a high-wear
component.
3. Pedestal Support & Pedestals - The Pedestals and Pedestal
Support completes the Quick-Lock™ system. Aluminum
pedestals and pedestal support provide reinforcement of the
socket sites from underneath the PCB during handler insertion.
The support housing doubles as both protection of the PCB as
well as providing RF shielding and enhancing site isolation for the
socket sites with a pliable, conductive elastomer liner.
4. Top Plate - The aluminum top plate frame incorporates a hinge
top design for easy access to resources within the enclosure in
addition to over 30 signal launch locations to support custom site
topologies.
5. Signal Launches - Standardized and interchangeable DC, highspeed digital, RF, and millimeter wave inserts provide high
performance, precision signal launching around the perimeter of
the device interface board. The launches incorporate spring
loaded pogo pins for DC and digital signal interfaces with the
PCB. RF signal launches utilize a unique pressure contact and RF
launch tab design on the PCB. Several RF launch designs offer
differential pair, enhanced matching, and frequency range options.

© Roos Instruments Inc.
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6. Fixture Carrier - the matrix fixture carrier PCB, as shown in
Figure 1.44, provides 13 standard fixture module locations in
addition to static control bits and ±5V, ±15V, and +28V supply
power distribution. The pod fixture PCB, as shown in Figure 1.45,
supports up to 8 pods with two module locations on each.
Fixtures can be equipped with up to two pod carriers for a total of
16 pods/32 module locations. The carrier includes interfaces with
Cassini's RIFL test head data bus to bring integrated software
identification, control, and RF path calibration into the device
interface environment.
7. Fixture Modules - Standardized instrument resources to extend
and enhance TIM capabilities such as: RF switches, DC/RF relays,
signal conditioning, parametric measure, and more. These
connect
8. Docking Ears - part of the mechanical handler docking system
with built-in mechanical dampening and compliance for a variety
of handler setups.
9. Fixture Body - The rugged aluminum enclosure provides
protection of sensitive microwave components in addition to
providing thermal and electrical shielding. The frame supports an
integrated, precision handler docking system.
10. Bottom Plate - an aluminum plate with 16 universal TIM interface
slots and standard docking pins for interfacing with Cassini's test
head. Each TIM slot accommodates standard TIM interface
blocks with precision mechanical compliance.
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11. TIM Interface Blocks - standard, blind-mate signal interface
blocks for all of Cassini's test instrument modules. The blocks
bring all of the TIM resources into the fixture’s device interface
environment.

FIGURE 1.45 ANATOMY OF A POD FIXTURE
1
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DIAGNOSTIC/CALIBRATION
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FIGURE 1.46 CASSINI16 CALIBRATION PLATE EXAMPLE

INTERFACE PLATES
Diagnostic and calibration plates are fixture design bottom plates,
inserts and interconnect that are designed specifically for a test
system configuration. The TIM interface blocks provide access to the
various signal/path resources of microwave TIMs. Resources from
different microwave TIMs are connected to other TIMs for routing
signals for calibration or mimicking connections in an application
fixture for custom or application specific calibration/diagnostic
purposes. DC TIMs are connected specialized interface blocks for
calibration and/or diagnostic purposes.
CAUTION: Always verify the test head TIM configuration matches the calibration/
diagnostic plate interface block layout before docking to the test head. Keyed pins are
designed to prevent mismatched TIM and interface block mating but unintentional
damage can occur.

The image above shows a Cassini16 system and calibration plate with an RF power sensor/meter
inserted to calibrate a microwave TIM.

Every calibration/diagnostic plate is fitted with a serial ID chip located
on the Fixture RIFL interface block. This serial ID matches the serial
bar code sticker on the plate. The system software uses this ID chip
to identify the plate when installed and automatically load the
microwave signal path/interconnections. These software-defined
interconnections and plate resources are needed to compile and
execute diagnostics and calibrations of individual TIMs as well as the
overall system.
© Roos Instruments Inc.
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INSERTING AND REMOVING
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FIGURE 1.47 FIXTURE DOCKING INDICATOR LIGHTS

FIXTURES
Fixtures and calibration/diagnostic plates are designed with test head
docking fasteners, blind-mate TIM interface blocks, and alignment
pins to make them easy to add and remove from the test system.
These components provide easy access to test resources and require
no teardown of the test setup when performing maintenance
procedures on the tester. The methods for docking and undocking a
fixture from the Cassini test systems are detailed in the following text.

CASSINI 16
NOTE: Always use a TIM-compatible 16 slot or 8 slot bottom plate/fixture when
docking to a Cassini 16 test system.

TO DOCK A FIXTURE OR DIAGNOSTIC PLATE,
FOLLOW THE STEPS BELOW:
1. Rotate the test head into the upright position and secure the
rotation lock by putting it into the LOCKED position.
2. Position the manipulator arm into the MAINTENANCE POSITION
using the locking latch found on top of the manipulator armature.
© Roos Instruments Inc.

The docking indicator lights are located on the side of the test head nearest the infrastructure chassis.
When the test head is powered up and active but no fixture or calibration/diagnostic plate is present
both LEDs are red.

3. Insure that the TIM locations on the test head match the TIM
interface blocks on the bottom plate of the fixture or calibration/
diagnostic plate.
CAUTION: Keyed pins on the TIMs and keyed receive openings on the TIM interface
blocks are designed to prevent mismatched TIM/interface block mating but
unintentional damage can occur if the layouts do not match when docking.
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4. Insure the docking rotary knob on the infrastructure is in the
UNLATCHED position.
5. Verify that the test head is active and the docking system is
operational by checking that both fixture docking LEDs (ALIGN
and LOCK) on the side of the test head nearest the chassis are
both red as shown in image 1 of Figure 1.47.
6. Holding the fixture or calibration/diagnostic plate along the short
edges of the fixture or bottom plate with the docking pins facing
downward, orient the alignment arrow (found on the fixture top
plate or the sticker on a calibration/diagnostic plate) to point at the
infrastructure chassis. Bring the fixture or calibration/diagnostic
plate straight down onto the test head, checking that the docking
pins move freely into position within their receive ports and
interface blocks comply with their corresponding TIM alignment
pins. Verify that the fixture orientation and alignment is correct by
checking that the ALIGNMENT LED is now green and the LOCK
LED is red (as shown in image 2 of Figure 1.47).
NOTE: The alignment must be correct, and ALIGN LED must be green to activate the
pneumatic locking drive system.
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8. Turn the docking rotary knob to the LATCH position. The
pneumatic drive force will engage the docking canoes underneath
the test head with the bottom plate docking pins, pulling the
bottom plate down and flush across the finger guard.
9. Verify that the fixture has been successfully docked checking that
the ALIGNMENT LED and the LOCK LED are now green (as
shown in image 3 of Figure 1.47).
10. Perform a System Check to activate the fixture or calibration/
diagnostic plate resources in the test system software.
CAUTION: Always verify that both docking indicator lights are green before moving or
rotating the test head to prevent accidental drop of the fixture or calibration/diagnostic
plate.
When docking the test system to a handler, typically the fixture is
docked to the handler first, and then the test system is positioned
underneath or adjacent to the handler/fixture by rotating the test head
accordingly and using the rolling castors. Fine adjustment is achieved
through the electromechanical lift and 2-axis planar/gimbal movement
to dock the system to the fixture/handler. The docking indicator lights
are used to visually verify alignment and successful dock.

7. The bottom plate or fixture should sit level on the test head and
be slightly above flush relative to the finger guard on the test head
that surrounds the bottom plate.

© Roos Instruments Inc.
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TO UNDOCK A FIXTURE OR DIAGNOSTIC PLATE:

FIGURE 1.48 CASSINI 8/RI7100C FIXTURE DOCKING HANDLES

1. Rotate the test head into the upright position and secure the
rotation lock by putting it into the LOCKED position.
2. Position the manipulator arm into the MAINTENANCE POSITION
using the locking latch found on top of the manipulator armature.
3. Turn the docking rotary knob on the infrastructure from the LATCH
to the UNLATCH position.
4. Verify that the pneumatic lock disengages the docking canoes
underneath the test head from the bottom plate docking pins by
checking that the LOCK indicator light is now red. (The bottom
plate should move away from the test head and slightly above
flush across the finger guard on the test head.)
5. Remove the fixture or calibration/diagnostic plate from the test
head by lifting upwards and away from the test head.
6. Perform a System Check to remove the fixture or calibration/
diagnostic plate resources from the test system software.

© Roos Instruments Inc.

Actuation movement for locking a fixture to the test head.

7. When undocking the test system from a handler, turn the rotary
latching knob from the LATCH position to the UNLATCH position.
The test system can be moved away from the handler/fixture
using the fine adjustment electromechanical lift and 2-axis planar/
gimbal movement to undock. The test head can then be rotated
back to upright and the system can be moved away using the
rolling castors. The docking indicator lights can be used to visually
verify undocking. The fixture can then be undocked from the
handler.
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LARGE CASSINI
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their receive ports and interface blocks comply with their
corresponding TIM alignment pins.

NOTE: Always use an 8 slot bottom plate/fixture when docking to a Large Cassini test
system.

5. The bottom plate or fixture should sit level on the test head and
be slightly above flush relative to the finger guard on the test head
that surrounds the bottom plate.

TO DOCK A FIXTURE OR DIAGNOSTIC PLATE:

6. Depress the fixture lock release switch located on the side of the
test head nearest to the instrument rack(reference Figure 1.20 for
location) and manually actuate the canoe locks using the hand
grips on the test head as shown in image 1 of Figure 1.48.

1. Rotate the test head into the upright position and secure the
rotation lock using the slide handle.
2. Position the manipulator arm for ease of access to the fixture and
lock into place using the two rotary knobs on the armature.
3. Insure that the TIM locations on the test head match the TIM
interface blocks on the bottom plate of the fixture or calibration/
diagnostic plate.
CAUTION: Keyed pins on the TIMs and keyed receive openings on the TIM interface
blocks are designed to prevent mismatched TIM/interface block mating but
unintentional damage can occur if the layouts do not match when docking.
4. Holding the fixture or calibration/diagnostic plate along the
perimeter of the fixture or perimeter of the bottom plate with the
docking pins facing downward, orient the alignment arrow (found
on the fixture top plate or the sticker on a calibration/diagnostic
plate) to point at the instrument rack. Bring the fixture or
calibration/diagnostic plate straight down onto the test head,
checking that the docking pins move freely into position within
© Roos Instruments Inc.

NOTE: Depressing the solenoid release switch for an extended period of time (> 5-10
seconds) results in excess current through the switch. To prevent damage, the button has
a built-in, cool down mode before reuse. The button will flash indicating the solenoid
release is temporarily disabled during this cool-off period.

7. The locking canoes will engage the fixture docking pins, pulling
the bottom plate down and flush across the finger guard.
8. Perform a System Check to activate the fixture or calibration/
diagnostic plate in the test system software.

TO UNDOCK A FIXTURE OR DIAGNOSTIC PLATE:
1. Rotate the test head into the upright position and secure the
rotation lock by putting it into the LOCKED position.
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2. Position the manipulator arm for ease of access to the fixture and
lock into place using the two rotary knobs on the armature.
3. Depress the fixture lock release switch located on the side of the
test head nearest to the instrument rack(reference Figure 1.20 for
location) and manually actuate the canoe locks using the hand
grips on the test head as shown in image 2 of Figure 1.48.
NOTE: Depressing the solenoid release switch for an extended period of time (> 5-10
seconds) results in excess current through the switch. To prevent damage, the button has
a built-in, cool down mode before reuse. The button will flash indicating the solenoid
release is temporarily disabled during this cool-off period.

4. The locking canoes will engage the fixture docking pins, pulling
the bottom plate down and flush across the finger guard.
5. Perform a System Check to remove the fixture or calibration/
diagnostic plate resources from the test system software.

SMALL CASSINI
NOTE: Always use an 8 slot bottom plate/fixture when docking to a Small Cassini test
system.

TO DOCK A FIXTURE OR DIAGNOSTIC PLATE:
1. Rotate the test head into the upright position and secure the
rotation lock using the slide handle.
2. Position the manipulator arm for ease of access to the fixture and
lock into place using the two rotary knobs on the armature.
3. Insure that the TIM locations on the test head match the TIM
interface blocks on the bottom plate of the fixture or calibration/
diagnostic plate.
CAUTION: Keyed pins on the TIMs and keyed receive openings on the TIM interface
blocks are designed to prevent mismatched TIM/interface block mating but
unintentional damage can occur if the layouts do not match when docking.
4. Holding the fixture or calibration/diagnostic plate along the
perimeter of the fixture or perimeter of the bottom plate with the
docking pins facing downward, orient the alignment arrow (found
on the fixture top plate or the sticker on a calibration/diagnostic
plate) to point at the instrument rack. Bring the fixture or
calibration/diagnostic plate straight down onto the test head,
checking that the docking pins move freely into position within

© Roos Instruments Inc.

94

Cassini ATE System Reference Guide
their receive ports and interface blocks comply with their
corresponding TIM alignment pins.
5. The bottom plate or fixture should sit level on the test head and
be slightly above flush relative to the finger guard on the test head
that surrounds the bottom plate.
6. Depress the fixture lock release switch located on the side of the
test head nearest to the instrument rack(reference Figure 1.19 for
location) and manually actuate the canoe locks using the hand
grips on the test head as shown in image 1 of Figure 1.48.
NOTE: Depressing the solenoid release switch for an extended period of time (> 5-10
seconds) results in excess current through the switch. To prevent damage, the button has
a built-in, cool down mode before reuse. The button will flash indicating the solenoid
release is temporarily disabled during this cool-off period.

7. The locking canoes will engage the fixture docking pins, pulling
the bottom plate down and flush across the finger guard.
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2. Position the manipulator arm for ease of access to the fixture and
lock into place using the two rotary knobs on the armature.
3. Depress the fixture lock release switch located on the side of the
test head nearest to the instrument rack(reference Figure 1.19 for
location) and manually actuate the canoe locks using the hand
grips on the test head as shown in image 2 of Figure 1.48.
NOTE: Depressing the solenoid release switch for an extended period of time (> 5-10
seconds) results in excess current through the switch. To prevent damage, the button has
a built-in, cool down mode before reuse. The button will flash indicating the solenoid
release is temporarily disabled during this cool-off period.

4. The locking canoes will engage the fixture docking pins, pulling
the bottom plate down and flush across the finger guard.
5. Perform a System Check to remove the fixture or calibration/
diagnostic plate resources from the test system software.

8. Perform a System Check to activate the fixture or calibration/
diagnostic plate in the test system software.

TO UNDOCK A FIXTURE OR DIAGNOSTIC PLATE:
1. Rotate the test head into the upright position and secure the
rotation lock by putting it into the LOCKED position.
© Roos Instruments Inc.
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SHIPPING REQUIREMENTS
Factory assembled fixtures are shipped inside a shipping container
with a specially designed fixture storage crate. Fixtures should always
be packaged and shipped using the Roos Instrument’s provided
container and storage crate. DO NOT discard these containers. They
are designed specifically for the instruments and TIMs with adequate
sizing, anti-static material, and conformal padding to protect them
during transport. If this container and shipping material are not
available, contact Roos Instruments for further instructions.
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support@roos.com or contact Roos Instruments at 1.408.748.8589
between the hours of 9:00 a.m. to 6:00 p.m. (U.S. Pacific Standard
Time)
An RMA must be requested within 15 calendar days of the invoice
date (ship date for credit card orders). NO returns of any type will be
accepted without an RMA number and ALL returns must be shipped
prepaid and insured via any common carrier (i.e. UPS, FedEx).
Tracking information is required.

Damage to fixtures during shipping is the responsibility of the shipping
party. Roos Instruments assumes liability for damage of equipment
shipped from the factory. Roos Instruments is not liability for shipping
damage of equipment shipped to Roos Instruments for service, repair,
or otherwise.

SERVICE INFORMATION
If a product is being returned to Roos Instruments for service, please
provide enough information to help expedite repair and return of the
product. For best service results, include as much information as
possible: symptoms, date of failure, the current status of the
instrument, etc.
Items for return must include a Return Merchandise Authorization
(RMA) number. To obtain an RMA number, please email
© Roos Instruments Inc.
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PACKAGING A FIXTURE
Proper packaging of fixtures prevents damage and improves
response time for repair and replacement. Every fixture should be
individually boxed with the supplied shipping container, storage crate,
and packaging provided by Roos Instruments following the
instructions below:
The fixture should be placed inside the provided shipping containers.
If not available, the fixture should be shipped in a container with the
following specifications:
• Single Wall Corrugated
• Bursting Test: 200 lb./sq. inch
• Min Comb WT Facings: 84 lbs per m sq. ft
• Size Limit: 75 inches
• Gross Weight Limit: 65 pounds
• Min Dimensions: 20"x20"x12"
The box used should allow for at least 3 inches of isolation between
the fixture and box walls (not including the thickness of the bubble
wrap).
Avoid placing styrofoam or packaging material in and around interface
pins and ports as well as the interior of the fixture as this may damage
connectors, cables, etc.
© Roos Instruments Inc.
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SECTION 9

HANDLER AND PROBER
INTERFACING
This section provides the procedures and recommended best
practices for interfacing a Cassini 16 test system with a Handler or
Prober. Reference the Site Preparation for Cassini Test Systems
section in the System Information chapter for test floor compliance of
environmental, electrical, and equipment requirements. Users should
always adhere to the safety guidelines provided in the Operator and
Safety Information section in the System Information chapter.
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4. Connect the communication pod from the test system to the
handler/prober.
The components necessary to mount the test fixture to a handler are
provided in Interactive 1.1. The handler’s backplane is outfitted with
an adapter that provides the thru mount threaded holes for mounting
the adapter plate to the backplane and the docking plate to the
adapter plate. The docking plate provides a manual actuating lever
that docks the Cassini fixture to the handler. Four shoulder rails on the
docking plate engage the 4 cams on the fixture’s docking ears. These
cams provide ~128 pounds of z-force pressure to align and secure
the fixture to the handler with a high degree of z-height precision.
NOTE: The z-height can be adjusted to comply with handler manufacturer
specifications. Contact support@roos.com for more information.

OVERVIEW
The Cassini test system was designed to enable a single user to
interface and dock the tester to a handler or prober. The process
breaks down into four main steps:
1. Connect the common or ground between the test system and
handler or prober.
2. Mount the fixture to the handler or prober.
3. Position and dock the test system to the mounted fixture.

© Roos Instruments Inc.

With the fixture attached to the handler, the test system can be
positioned and docked to the fixture using the rolling castors on the
infrastructure, see Figure 1.49. This method enables the use of the
blind-mate TIM interfacing system on Cassini for more consistent and
reliable docking compliance as shown in Figure 1.50. Reference the
Infrastructure Section for more information on the test head
manipulator and the Cassini 16 infrastructure diagrams in the
appendix for mechanical compliance. After the test system is docked
to the handler, the handler/prober communication pod can be
connected. The handler or prober pod is pre-programmed for a
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specific model and configuration of Handler or Prober. Additional
Configuration Instructions are available online.

CONNECTING TO HANDLER OR PROBER:

INTERACTIVE 1.1 HANDLER DOCKING COMPONENTS (TOP VIEW)

1. The system should be installed following the instructions provided
in the Installation section and powered-on following the instructions
provided in the System Startup Procedures.

Handler

Adapter Plate

Reference the Cassini 16 Infrastructure Diagram for component
names and locations. The test system can be powered on with TIMs
installed when connecting to a handler or prober.

2. Position the Cassini test system adjacent to the Handler or Prober
in preparation for attaching the grounding cable.
3. Attach the green grounding cable with alligator clip from the
Infrastructure (see Figure 1.51) to a grounding point on the
Handler/Prober indicated by a post or mounting point with the ISO
ground symbol ⏚. If an auxiliary rack is present, an additional

Docking Plate

Fixture w/ Docking Ears

green grounding wire should be connected from the auxiliary rack
to either the test system’s infrastructure ground or the Handler/
Prober ground.
A grounding cable is required to maintain a common voltage
ground between the handler or prober and the test system to
prevent ESD. Handler communication issues and/or DUT failures
can occur if the green ground cable is not properly connected.
NOTE: The alligator clip can be removed from the ring connector when attaching the
grounding cable with a fastening screw.

© Roos Instruments Inc.
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4. Dock the fixture (equipped with docking ears) to the handler or
prober using the manually actuating docking plate.
5. Rotate and lock the test head into the docking orientation (test
head facing the handler/prober with the attached fixture). Verify that
the orientation of the fixture matches with the test head, checking
that corresponding TIM block inserts in the fixture match the test
head TIM layout before continuing. See the Infrastructure section
and/or Appendix for more on the test head articulation operation
and mechanical compliance.
WARNING: Always lock the test head rotation pin after any test
head positioning to prevent accidental rotation that could cause
injury to persons or damage to the test head manipulator’s internal
components.
6. Attach the GPIB, parallel, or serial cable from the Handler or Prober
to the communication pod (see Figure 1.52).
NOTE: This cable must be provided by the facility and should be assembled according to
Handler or Prober manufacturer’s specifications.

7. Attach the RIFL3-RIFL2 cable to any of the Infrastructure’s available
RIFL H-Ports and to the Handler Pod or Prober Pod (See Figure 1.
53).
NOTE: The Handler Pod or Prober Pod is pre-programmed for the intended Handler
or Prober manufacturer model and interface type.
© Roos Instruments Inc.
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8. Perform a System Check. This will identify the connected pod and
add it to the system configuration.
NOTE: The pod will not appear in the instrument list of the Configuration Window.
The pod can be viewed from the Equipment Pool window at the attached H-Port
location.

9. Release the test head manipulator lock pin (reference Figure 1.17)
and move the test head so that the test head indicator dot is in the
‘Docking Position,’ allowing for fine planar adjustment of the test
head.
10.Use the manipulator arm elevation control buttons to align the
fixture docking ports with the fixture docking feet.
WARNING: Insure that the fixture docking switch on the
infrastructure is in the ‘UNLATCH’ position before continuing to
the next steps. Failure to do so could result in injury to personnel or
damage to the TIMs, test head, and/or fixture.
11.Position the test system using either the elevation control (vertical
docking) or the rolling castors (horizontal docking) so that the
fixture docking feet slide into the test head fixture docking ports.
12.Verify that the ‘ALIGN’ LED on the test head is green, indicating
that the fixture is properly aligned with test head before proceeding.
Reference the fixture docking section for more information.
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13.Engage the fixture docking pins by turning the fixture docking
switch to the ‘LATCH’ position.
14.Verify that the ‘LOCK’ LED on the test head now is green,
indicating that the test system has successfully docked to the
fixture. Reference the Inserting and Removing Fixture section.
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DISCONNECTING FROM HANDLER OR PROBER:
It is recommended to permanently secure the Handler Pod, RIFL3RIFL2 cable, and the GPIB, parallel, or serial cable directly to the
Handler or Prober.
1. Undock the test head from the fixture following the instructions
provided in the Inserting and Removing Fixture section.
2. Rotate and lock the test head into the upright orientation and
lower the manipulator arm elevation so that the test head TIM
interface can be viewed/accessed.
3. Place the test head manipulator lock pin into the lock position and
using the test head position indicator into ‘Maintenance Position’
to lock the planar test head movement.
4. Detach the RIFL3 cable from the test head RIFL H-Port and
secure the Pod and cables to the Handler or Prober.
5. Perform a System Check to remove the handler/prober pod from
the test system configuration. Verify that the pod is no longer in
the configuration by checking that the resource has been
removed from the Equipment Pool.

© Roos Instruments Inc.
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FIGURE 1.49 INFRASTRUCTURE POSITIONING

Six rolling castors on the underside of the infrastructure allow for
positioning of the test system using the two hand bars located on the
top of the chassis.

© Roos Instruments Inc.
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FIGURE 1.50 DOCKING CASSINI 16 TO A HANDLER (TOP VIEW)

With the fixture secured by the docking plate to the handler, the
Cassini test system can be positioned with the rolling castors and
docked using the fine planar movement of the test head and the blind
mate TIM interface.
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FIGURE 1.51 GROUNDING CABLE
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FIGURE 1.52 GPIB HANDLER OR PROBER POD (RI8552B)

Handler D Sub Connector

RIFL2 Connector

The Handler/Prober Pod provides a GPIB, Parallel, or Serial connector
conversion to RIFL2 and pre-programmed communication translation
The green grounding cable from the Infrastructure must be connected

from the Handler or Prober type to Cassini. The RIFL2 connector

to a grounding mount on the Handler or Prober.

attaches to Cassini with the included RIFL3-RIFL2 cable.

© Roos Instruments Inc.
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FIGURE 1.53 RIFL3 TO RIFL2 CABLE

RIFL2 Connector

RIFL3 Connector

The cable provides a conversion from a RIFL2 connecter (Shielded
RJ45) that plugs into the Handler/Prober Pod and a RIFL3 plug that
connects to the RIFL H-Ports on the side of the Cassini test head.

© Roos Instruments Inc.
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SOFTWARE ENVIRONMENT
& TOOLS
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TOPICS

Operating System
User Interface Control
Shortcuts & Software Patches
Main System Window
Message Window
Tester Configuration
Edit Panel
Control Panel
Equipment Pool

© Roos Instruments Inc.
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OPERATING SYSTEM

operations are executed through the Cassini test system environment,
some useful features of the OS are shown below for reference.

Cassini’s software is uses the an OS/2 based operating system, either
ArcaOS or eComStation (eCS). With its’ combination of stability,
reliable performance, and relatively small memory footprint, ArcaOS
provides features and controls in parity with operating systems such
as Linux, UNIX, and Windows based systems. While majority of test

In Figure 1.54, several useful shortcuts and features are depicted:

FIGURE 1.54 FEATURES OF THE ECS OPERATING SYSTEM

• Processor Usage Graph - displays a real-time line graph and
percentage value of the current system processor usage. This
tool is useful for determining the usage of current and
background applications running on the test system.
• OS Shutdown Shortcut - provides a single button function for
accessing the shutdown window of the operating system. This is
typically used for a complete system shutdown after the Cassini
test system software has been shutdown.
• Start Menu - provides a central launching point for OS utilities
and third party applications. Applications such as the screenshot
capture tool PMCamera can be accessed through the Start
Menu.
• Local & Network Drives - provides a pop-up list of local and
network attached drives. A left-button click on a drive in the list
shows subdirectories and files. A right-button click opens a
subdirectory view within a window with various file and directory
hierarchical views.
• System Setup - provides single button access to the various
operating system setups and preferences in a pop-up list view. A
left click on the list opens the selected setup applications, and a
right-button click opens the applications within a window.

© Roos Instruments Inc.
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• Open Applications - open application windows are displayed
along the operating system task bar along the bottom of the
screen. Left-clicking on a tab will make the selected application
window active and highlight it’s associated tab along the bottom.
Background applications are displayed in the order they were
launched. Right-clicking a tab provides an options pop-up list.
Open applications can be browsed quickly by using the
keyboard shortcut of holding down the Shift key and pressing the
Tab key to switch between them. As well, clicking both the left
and right mouse button anywhere on the background will open a
list view of all open windows.
• Local Date/Time - the local date and time of the system is
displayed in the lower right-hand corner of the screen. This date
and time are used by the test system for local timestamp of files
and data created and managed in Guru.

© Roos Instruments Inc.
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CASSINI TEST SYSTEM
ENVIRONMENT
The Cassini test system software is accessible through the login
sidebar button found on the right side of the screen. This environment
is designed specifically for managing the various resources of the
Cassini ATE system.

NETWORK CONNECTIVITY
The Cassini system uses a networked file management system called
Guru (more information provided in the Guru section). The Logon/
System button is color-coded to represent the test system’s Guru
network connection status. This color-coding updates in real-time to
provide the user with a visual cue of the test system’s network status.
See Guru section for more information.

USER INTERFACE CONTROL
The log-in environment enables access control and provides specific
software user-interface environments tailored for engineers, service
and support technicians, and test operators. User interface, software
application, and file directory access control can be customized for
individual users, groups of users, and customer sites.
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SERVICE & SUPPORT TECHNICIANS
Service and support technicians have user-defined access to tester
features and functionality that can be tailored to customer
specifications. Typically these users have access to essential software
tools, functions, and files to perform tester general maintenance and
diagnostic procedures in support of the test equipment. The tools
typically include:
• Equipment Pool
• System Configuration Window & Control Panel
• Guru Applications: Importer/Exporter/Browser/Address Book
• Diagnostic Plans & Data
• Calibration Plans & Data

ENGINEERS & TEST DEVELOPERS
Engineers and test developers have wide access to all the design and
development tools for device, device interface, and test plan
development tools as well as the file database directory on the Cassini
ATE system.

TEST FLOOR OPERATORS
A simplified touch screen user interface is deployed for test floor
operators that can be customized to sites and users. An example of
the UI for operators is provided below. The touch screen user controls

© Roos Instruments Inc.
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are limited to pre-approved test plan execution and essential tester
functionality, i.e - test start/stop/pause/re-test, etc. Access to the
underlying files, file directories and test development environment is
prohibited by the UI.

SHORTCUTS & SOFTWARE PATCHES
Shortcuts are predefined test environment packages that define the
Cassini test system environmental and operational software update
versions. These settings are typically customized to company
parameters and/or site and include:

System Information | Software Environment & Tools
Shortcuts can be accessed by the Short Cuts button found on the
right side of the screen after logging into the tester, see Figure 1.55.
Scroll the list by Left-clicking on the PgUp/Up or Down/PgDn buttons
to move up or down the list. To launch the shortcut, left click on the
button of choice from the list. Once a shortcut is selected, the main
system window will launch and appear at the top portion of the
screen. The name of the launched shortcut is displayed across the
top of the main system window’s menu bar.

FIGURE 1.55 OPENING A SHORTCUT

• User interface versions and settings
• Test software and instrument updates, drivers, and firmware
patches
Shortcuts are typically provided by Roos Instruments as locked
shortcuts. Locking a shortcut sets the current environment settings
and software patches into a fixed set that cannot be altered. A system
running a locked shortcut configuration will not receive software
updates or patches. Updates and features are provided in new/
released shortcuts.
NOTE: Only one shortcut can be active at time. To launch a different shortcut, the user
must first close Cassini application before launching a new shortcut.

© Roos Instruments Inc.
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CLOSING A SHORTCUT
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FIGURE 1.56 VIEWING SOFTWARE PATCHES: OPTION 1

Before closing a shortcut, always save and close all other applications
and windows. To close the shortcut, left-click on the ‘x’ button found
at the top right corner of the main system window menu bar. A popup window will prompt the user to confirm closing the shortcut.
Selecting “Yes” will close the shortcut. Another option is to select the
System menu option, and then select ‘Quit’ from the drop-down
menu list. A pop-up window will prompt the user to confirm closing
the shortcut.
NOTE: To launch a different shortcut, the user must logoff of the currently active
shortcut.

SOFTWARE UPDATES
Software patches provide updates, improvements, new features, and
software updates for the Cassini test system. Roos Instruments
releases software patches on a regularly basis, and there are several
ways to view them.
To view the list of patches that are currently loaded, select the
‘Options’ menu from the main system window, and then select the
‘Show patches...’ option from the list. This opens a ‘Loaded Patches’
window as shown in Figure 1.56. Loaded software patches are listed
in the top pane of this window with the bottom pane providing a
description of the patch. Patches are listed from oldest to latest from
top to bottom. The patches in the top pane show an alphanumeric ID
© Roos Instruments Inc.

The Loaded Patches window is accessed through the Options >
Show patches... menu selections in the main system window. The
selected patch belongs to ‘GF10RC2A,' which is the ID of the
application that will be updated, with patch designation 055,
subversion 0. It was created on April 10, 2009 and includes a
description of the patch features in the lower pane.
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that matches the patch with the application it updates. Following the
decimal point is a three unit patch number. This designator number is
the commonly referenced name of the patch. Following the patch
number and ‘-’ character is the patch subversion. Newer versions of
the patch/update are defined by an increment of subversion number.
Another option for viewing software updates is accessed by selecting
the ‘Program’ menu of the main system window, and then selecting
‘Guru Patch...’ from the drop-down list. This option, shown in Figure
1.57, opens a ‘Loaded Guru Patches’ window with several more
options. Loaded updates/patches are displayed in the top pane of the
window in order of descending patch number beginning with the
highest patch number at the top of the list. As with the other patch
viewing option, the alphanumeric designator of the patch’s application
is listed, followed by the three digit patch number. This is followed by
the release version and a brief description of the patch. To view a list
of all loaded patches in a text view, the user can select the View
button below the list pane. This is useful for saving, emailing, or
printing the list of loaded patches on the tester. Additional patches
can be loaded by selecting the Load button and choosing from the
available list in the pop-up window. The other button selections are
reserved for Roos Instruments internal purposes only.
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FIGURE 1.57 VIEWING SOFTWARE PATCHES: OPTION 2

The Loaded Guru Patches window is accessed through the
Program > Guru Patch... menu selections in the main system
window. This option offers additional features such as browsing and
loading additional patches, and viewing all patches in a text list for
saving, email, or printing.

© Roos Instruments Inc.
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MAIN SYSTEM WINDOW
The main system window is the central point for control and
configuration information of the Cassini test system. The window
launches automatically once a shortcut is selected and can be used
as a quick visual verification that the tester is logged into a user and is
running a software shortcut. The main system window provides

FIGURE 1.58 MAIN SYSTEM WINDOW
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access to the Equipment Pool window, Tester Configuration window
and System Messages window along with providing instant
instrument control features through the Controller window and
performing system checks and system startup functions.

SYSTEM CHECK
The system check function is used to update the status of the Cassini
test head configuration. Performing a system check requests the
tester to refresh the status of connected instruments, fixtures, and
peripheral hardware on the test head by way of the Roos Instruments
Fast Link (RIFL) bus. In the case of added TIMs, the system check will
verify the instruments identity, its location on the test head, provide
48V power to activate it, assign a serial number and RIFL address,
and then add its’ instrument functions to the list of available controls
in the Control and Edit Panels. In the case of a TIM or fixture being
removed from the tester, the system check will relinquish the test
head slot, serial number, and RIFL address back to the software as an
open slot and remove that instrument’s function from the list of
available instrument functions in the Control and Edit panels. In the
case of an instrument that has remained in the system before and
after the system check, the software does not make any changes.
Whenever a test instrument module (TIM), fixture or diagnostic/
calibration plate, or auxiliary instrument (by way of a RIFL/GPIB pod) is
added or removed from the test head, a system check function
should be performed.
This function is performed by selecting the System button located on
the left side of the main system window, and then selecting Check

© Roos Instruments Inc.
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from the pop-up window of button choices. Once the Check button
has been selected, the UI will not respond to user selections until the
pop-up window closes. The user can verify that the tester is
performing the system check function by observing the processor
activity meter located at the bottom of the OS screen and notice
changes to any open Tester Configuration or Equipment Pool
windows.
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FIGURE 1.59 SYSTEM CHECK

Step 1

Step 2

CAUTION: Attempting to execute other tester commands or functions while an active
‘System Check’ request is being processed can result in erroneous instrument
configuration information and/or system walk back errors. Always wait for the pop-up
window to close before continuing.

A system check is performed by selecting the ‘System’ button from the
main system window, and then selecting the ‘Check’ button from the
pop-up window.

© Roos Instruments Inc.
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SYSTEM STARTUP
The system startup function serves a similar function as the system
check function. A system startup sends a software request to the
Cassini controller to rebuild the entire RIFL node tree, hub, and
attached instruments and equipment on the test head. This function
will remove power from all instruments and equipment attached,
rebuild the RIFL node-tree topology and recheck in all instruments
connected to RIFL back into the system configuration. The system
startup is a more thorough and exhaustive method for checking
equipment and TIMs into the tester, and therefore more time
consuming than a system check. Typically, startups are used as a soft
restart of the test system if there is an unknown loss in
communication with a test instrument module or modules.
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FIGURE 1.60 SYSTEM STARTUP

Step 1

Step 2

Step 3

NOTE: Always remove fixtures and or diagnostic plates from the test head before
performing a system startup. If the startup was successful, system checks are adequate for
subsequent equipment additions to the test head.

A system startup is performed by selecting the ‘System’ button from
the main system window, then selecting the ‘Equip’ button and then
‘Startup’ button progression from the pop-up window options.

© Roos Instruments Inc.
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MESSAGE WINDOW
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FIGURE 1.61 MESSAGE WINDOW

The message window provides a console for system message
information from the Cassini test software environment. Information
such as system status, responses from applications, system
warnings, and errors are displayed in the message window. Messages
follows a common convention of general information and warnings in
black text, and errors displayed in red text. It will display the date and
time of system checks and instrument self calibrations as they occur.
The window is also useful during test development, diagnostics or
calibration, displaying compile warnings for instrument settings in
black text, with compile errors in red. System errors such as RIFL
communication loss to an instrument are also displayed in the
messages window in red text. The console provides feedback
confirmation of RIFL loopback tests conducted from the equipment
pool. Figure 1.61 shows an example of the messages window.
The message window can be accessed through the main system
panel by selecting System > Messages.
The message window is shown at the bottom left. The displayed
messages reflect a loaded Shortcut and two subsequent system checks
completions.

© Roos Instruments Inc.
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TESTER CONFIGURATION
The tester configuration window provides a comprehensive summary
of the current system configuration. All instruments and equipment
connected to the test system are displayed in this window such as:
the system controller, test instrument modules, fixtures and
diagnostic/calibration plates, and calibration kits. As well, softwarecreated instruments and resources or “virtual instruments” as they are
commonly referred to, are also displayed in this window. Examples of
these virtual instruments include the ‘vna’ (combination of the Testset,
Source, and Receiver TIM resources), ‘noise figure’ Device Control
Definitions (register definitions), and calibration kits (data for calibration
standards). Figure 1.62 shows an example of the tester configuration.
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Ri7421B Dut Control; PowerVI, RI7431A High Current Supplies;
StaticDigital, Ri74311A 16-bit Device Digital Controller. If the
instrument is part of a TIM, the test head slot location is displayed at
the end of the of the instrument name in the top pane. Multiple
instruments of the same type will be represented with the subinstrument name followed by an enumeration number. Depending on

FIGURE 1.62 TESTER CONFIGURATION VIEW

The configuration window can be accessed through the main system
panel by selecting the System > Tester buttons.
NOTE: Handler/GPIB Pods can only be viewed in the Equipment Pool window.
Handler pods are factory programmed, but require onsite configuration to the handler
type and local settings before use.

Performing a System > Check or System > Startup will refresh this
list. The tester configuration window is divided into three panes. The
pane at the top of the window displays the connected equipment
resources. Test instrument modules are represented by their individual
sub-instrument model numbers in alphabetical order, i.e. - an RI8546
Device Power TIM is shown as three instruments: DUTControl,
© Roos Instruments Inc.

The tester configuration or tester view displays all installed
instruments.
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the configuration settings and/or instrument type, instruments may or
may not contain an enumeration value for the first instrument
instance, but subsequent instruments of the same type will have an
enumeration of value of ‘2,' i.e - RFSource1, RFSource2 versus
DUTControl, DUTControl2. Selecting an instrument from this list
displays instrument-specific information in the lower left pane that
varies by instrument. Typically, this information displays waveform
pattern information and management on a source instrument or RF
instrument’s Input/Output port path definitions. Input/Output port
names are displayed at the top of a box, with the path definition
displayed internally. Green boxes denote path definitions for an I/O
port that must be defined in software by a device connection
definition or fixture definition. These software device connection
definitions represent a fixture interconnect path in the device interface
environment. Along with providing configuration information, several
tester features can be accessed through the tester configuration
window.

ADDING INSTRUMENTS
Selecting an instrument from the list and then selecting the
Instrument menu option at the top of the window will provide a drop
down menu for: adding instruments, GPIB instruments, calibration
kits, fixture definitions, and device interface board definitions to the
system by choosing the corresponding menu selection.
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RENAMING INSTRUMENTS
Instruments can be removed by selecting an instrument from the list
and then selecting the Instrument > Rename menu options. This
provides a pop-up window to rename the selected instrument.
CAUTION: Changing an instrument name can affect test plans. Buttons and
measurement blocks within test plans must match the button owner name to the
instrument name listed in the tester configuration window. Conflicts between the owner
name and the instrument name will result in test plan compile errors and failure to
compile. This can only be resolved by changing the owner name to match the instrument
name or renaming the instrument to match the owner. Always exercise caution when
changing instrument names in a configuration.

SAVING A TESTER CONFIGURATION
The tester configuration can be saved to preserve user-defined
instrument naming conventions and their associated instruments. This
is useful for system setup that use custom naming conventions and/
or defining a numbering convention of a multiple instrument setup to
specific slot locations. It is also required to use the tester configuration
from a Virtual Workstation simulator. To save a tester configuration
select the Tester menu at the top of the window, and then select
Save from the drop-down menu list.

REMOVING INSTRUMENTS
Instruments can be removed by selecting an instrument from the list
and then selecting the Instrument > Remove menu options.
© Roos Instruments Inc.
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CALIBRATION & DIAGNOSTIC INFORMATION
Calibration information for an instrument can be viewed by selecting
the Instrument > Calibration menu list options. This opens a submenu list with several options for viewing selected instrument
calibration data, or launching the calibration and diagnostic tools for
the specified instrument.
NOTE: To calibrate or diagnose a TIM, always select the “System” instrument from the
tester configuration list. Then select the Instrument > Calibration > Calibrate or
Instrument > Calibration > Diagnose menu options. This will provide the list of
calibrations or diagnostic plans for sub-instruments grouped by their TIM and organized
in the order they should be executed in the system.

These buttons and blocks are placed within test plan panels to design
multi-instrument measurements, algorithms, and test state-flow. The
library of blocks and buttons are dynamically built from the system’s
TIM configuration. The Editor is accessed by selecting Tester > View
from the menu options of either the Configuration Window or from an
open test plan.

FIGURE 1.63 EDIT PANEL EXAMPLE

EDIT PANEL
The Edit Panel or Editor, shown in Figure 1.63, provides instrument
buttons and measurement blocks used in the graphical test
programming environment. The Editor window is divided into four
panes. The three panes from left to right across the top display the list
of available instruments in the current system configuration, a
selected instrument’s subsystems, and a help dialog of a selected
button from the bottom pane. The bottom pane of the window is
populated by instrument setting buttons and measurement blocks
from the selected instrument and subsystem selections.
NOTE: The button values displayed in the Editor are the default settings of the
instrument and can be changed before or after placing them in a test panel by left
clicking on them.
© Roos Instruments Inc.
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NOTE: Multiple edit panels can be open at the same time.
For more information on using Edit Panel buttons in test plans,
reference the Introduction section of the Graphical Programming
chapter.

System Information | Software Environment & Tools
WARNING: Always return instrument controls to their default idle
state settings by manually resetting the button values in the control
panel or performing a System Check when finished with Control
Panel use.

CONTROL PANEL
The Control Panel or Controller, shown in Figure 1.64, provides
interactive buttons much like the view and controls of bench-top
equipment for live control of the instruments. The Controller window is
divided into four panes. The three panes from left to right across the
top display the list of available instruments in the current system
configuration, a selected instrument’s subsystems, and a help dialog
much like the edit panel. The bottom pane of the window is populated
by interactive buttons from the selected instrument and subsystem
selections and display the current instrument settings. Left clicking on
the button allows the user to change the corresponding instrument’s
setting or captures data in a measurement display. This tool can also
be accessed at breakpoints in test plans for in-situ instrument
debugging. The control panel is accessed by selecting the Tester >
Control menu selections. At a test plan breakpoint, the control panel
can be accessed by selecting Control from the Breakpoint pop-up
window options.

FIGURE 1.64 CONTROL PANEL EXAMPLE

NOTE: Multiple control panels can be opened simultaneously.

© Roos Instruments Inc.
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EQUIPMENT POOL
The equipment pool window provides a hierarchical view of the
Cassini test head configuration as expressed through the RIFL node
tree. This window allows the user to view, test, and verify the status of
the various RIFL nodes and hubs. When the test head is configured
with TIMs, the user can view TIM information such as: their slot
location on the test head, sub-instrument names, serial numbers,
node ID, and base instrument information.
NOTE: Handler/GPIB Pods can only be viewed in the Equipment Pool window.
Handler pods are factory programmed, but require onsite configuration to the handler
type and local settings before use.

The diagram above illustrates the communication topology for
Cassini’s instrument communication system called RIFL(Roos
Instruments Fast Link). RIFL provides instrument communication to
various instruments and peripheral equipment on Cassini as well as
serving as the data bus. The design is a hybrid topology consisting of
a tree-star structure. The RIFL Master is located in the RI8574 System
Controller and serves as the central hub which all data and
communication are relayed for processing and analysis. Control

FIGURE 1.65 ACCESSING THE EQUIPMENT POOL

Step 1

RIFL NODE TREE

Step 2
RIFL Master

Test Head Hub

Auxiliary RIFL Ports

Fixture

Rear Test Head Hub
Tslots 1-4 & 9-12

Front Test Head Hub
Tslots 5-8 & 13-16
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commands originating from the system controller are sent
downstream to the Test Head Hub, located inside the Cassini test
head. This hub provides the central point for communication with
nodes on the Cassini test head. It supplies 4 auxiliary RIFL ports or
nodes on the side of the test head closest to the infrastructure
chassis as well as a dedicated node for fixture communication and
two additional downstream hubs. The fixture RIFL port communicates
with diagnostic/calibration plates and fixtures by way of an interface
block on the top of the test head. The Front Test Head Hub and the
Rear Test Head Hub make up two additional star topologies,
providing communication nodes to each of the 16 TIM slots on the
test head.
The equipment pool can be accessed through the main system panel,
shown in Figure 1.65, by selecting the System > Equip > Nodes
options from the successive button windows launches the Equipment
Pool.
The equipment pool window is divided into two panels. The top panel
displays the hierarchical view of the RIFL nodes, hubs, and connected
hardware. The panel updates with System Checks and instrument
adds to the Tester Configuration window to show the current tester
configuration. Selecting a node in the top panel highlights the node
and displays more information in the lower panel of the equipment
pool window as shown in Figure 1.66. When a node with a TIM or
instrument is selected the instrument name, serial number, node ID,
and more are displayed in a scrollable list in the lower panel. Selecting
and then right clicking on a node provides the user with several
options as shown in Figure 1.67.
© Roos Instruments Inc.
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The ‘power off’ command is an optional method for deactivating a
TIM without removing it from the test head. A subsequent System
Check command will bring the TIM back into the tester configuration.
A System Startup command will rebuild the entire node tree from the
RIFL Master and recheck in all attached TIMs in the Equipment Pool.
The ‘Flash Led’ command is used to intermittently blink the status
indicator LED on the front panel of a RI7725 Source corresponding to

FIGURE 1.66 EQUIPMENT POOL FEATURES

Hierarchical
View of RIFL
Nodes

Selected Node
Information
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the user’s selection. This is useful for identifying individual sources in a
multiple source system.
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FIGURE 1.67 EQUIPMENT POOL RIGHT-CLICK OPTIONS

The ‘RIFL Test’ command will perform a RIFL loopback test on TIMs
or instruments for the selected node or multiple nodes under a
selected hub. This is useful for verifying the functionality of RIFL
communication on hubs and TIMs. Loopback verification information
is displayed in the System Messages Window.
CAUTION: The ‘Power on,' ‘Enumerate,' and ‘Inspect’ commands are for RI internal
purposes only. These functions should only be used with supervision from a Roos
Instrument’s service or support engineer.

© Roos Instruments Inc.
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GURU

TOPICS

Guru Introduction & Concepts
Guru Browser
FIGURE 1.68 GURU BROWSER

Viewing Objects in Guru Browser

Key-Value Filters

Importing Objects with Guru Browser
Objects View

Exporting Objects with Guru Browser
Selected Object
Information

Function Tabs

Object Revision History

System ID
Attribute
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INTRODUCTION
The Cassini test system manages all test system files, software
resources, and test data using an interplanetary file system called
Guru. Files are saved to and distributed from a central Guru server or
multiple linked Guru servers through a peer-to-peer distributed
database. This allows multiple Cassini ATE and Cassini simulators to
access the same system of files. In addition to file sharing, Guru
provides file management controls such as the ability to lock a tester
configuration and file resources and limit user access control in the UI
environment or files through permissions on individual testers and/or
across test facilities. The Guru client on each system also selfmanages its’ connection to the Guru server to allow continuous
operation of the test system in the event of network connectivity
issues and to automatically reconnect. This streamlines the sharing
and backup of resources across multiple Cassini testers, simulators,
and servers providing many advanced features for production test
including:

System Information | Guru
Included in the following section are key concepts of the
implementation and basic terminology to build a fundamental
understanding of Guru. Also included are commonly used Guru
applications, their functions, and their role in day-to-day workflow.

• Test resource distribution and management tools
• Software sandboxes and release control
• Local & network resource management
• Automated backup and restore
• Built-in file revision

© Roos Instruments Inc.
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GURU TERMINOLOGY

GURU CONCEPTS

OBJECT
A guru object is a file that is unique and immutable in the system. No
two objects in guru are alike, including copies of an object or revisions
to an object.

ATTRIBUTE
An attribute of an object provides additional information about the
object. Attributes form a key-value pair associated with their object
that is used both for database-like indexing and queries as well for
linking objects to their associated application functionality. The ‘key’ is
the name of the attribute and the ‘value’ is the information. In other
words, attributes provide information to the system and applications,
telling them what the object contains and how to interact with it. While
the number of attributes associated with a specific object depends on
the object class, there are over 100 total combined attributes across
all objects used for various file and resource management purposes.

ATTRIBUTE KEY-VALUE PAIRS EXAMPLE
Key

Value

Description

ri.sys.Cid

G9MG7DYAAL78EI01

Creation Identifier (Global UID)

ri.sys.Owner

G9MG7DYA

Guru Identity that Created the Object

ri.sys.CreationDate

2010-04-16-06:06:18.0000

Object Creation Date/Time in UTC

ri.sys.Name

Sample Lot 45739

Name of the Object

© Roos Instruments Inc.

Guru blends database-like properties with a modern file system to
provide advanced file and application features specific to
semiconductor production. To enable this integration, the system
uses an object-oriented data paradigm. This means that every file and
application resource on the test system is an object. Every object on
the system contains attributes in key-value pairs. This relationship
provides two main functions: 1.) It allows database-like indexing,
queries, versioning, of objects and 2.) It links objects to their
associated application.

OBJECT/FILE SYSTEM
Like a traditional “file” on a file system, a Guru object stores data.
Unlike a traditional file, Guru objects are immutable in that they can
never change. When a Guru object’s data is changed, a new copy of
that object is created, generating a new creation identifier attribute
(Cid) with the same revision identifier attribute (Rid). Cassini
applications use these objects to store and retrieve changes to the
content, such as when saving changes to a Test Plan.
Object attributes are most commonly created and managed by Guru
automatically. The object type, creation date, revision date, etc. is
generated by the application that the software resource was created.
Other attributes can be created by the user such as the name of the
file or version, typically entered during data save prompts. Access to
user-created objects or definitions can only be accessed through the
appropriate system application. For example, to view or edit Device
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Connection definitions, the user must launch the Device Connection
Editor application. To access DUT Control definitions, the user must
launch the Device Control Editor application. To browse and view all of
these objects and their attributes, similar to a file directory viewer, the
user can use the Guru Browser application.

USER ACCESS CONTROL
All applications and objects are subject to user access control system
that is enforced by Guru throughout the Cassini software
environment, see Figure 1.69. The user login credentials can be
assigned role-based access control (e.g., engineering, maintenance,
administrator roles, etc.) through user-defined permission attributes
that restrict access to applications, file resources, and aspects of the
user interface that perform operations in the software environment.

System Information | Guru
coding. A green Logon/System button denotes the Cassini’s Guru is
successfully connected to an update Guru server. A yellow button
Logon/System button denotes the Cassini’s Guru has lost connection
to an update Guru or is not connected to a Guru server. When the
Cassini test system’s local Guru is not connected to the network, the
Guru server is offline and operates in local only mode. All files,

FIGURE 1.69 GURU USER LOGIN

These permissions and the scope of their access can be defined by a
system administrator to tailor roles through application and software
resource access in the Guru Permission Admin application.
Permissions are linked to specific user groups to assign appropriate
roles to a user's account and simplifies common operations, such as
adding a user, or changing a user's role/access. As well, Permissions
can be combined in a hierarchy where higher-level roles include
permissions used by sub-roles.

NETWORK CONNECTIVITY
A Cassini test system’s Guru automatically manages network
connection to Guru servers. The Logon/Status button provides a
visual cue to the user of the network status through real-time color© Roos Instruments Inc.

Guru’s access control system requires the user to login with a user
name and password. Permissions can be assigned to users to restrict
access to applications, file resources and/or components of the UI.
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resources, and data created will only be stored locally on the test
system. Similarly, resources and data available on the Guru Server will
not be available to Cassini. When a network connection is available
again, the button will change color from yellow to green signifying that
the Cassini’s local Guru will automatically backup all local files to and
get remote updates from the Guru server.
NOTE: If there is a loss of network connection, Guru will automatically attempt to
reconnect to the Guru server. If the Log-In/System button changes from green to yellow,
check your network connection, then notify Roos Instruments support.

FILE LOCALITY & DISTRIBUTION
In the background, Guru manages the local/networked storage and
backup of files, test resources, and test data. Because of Guru’s
database-like file structure, a Cassini test system when connected to
a Guru server automatically backs-up its resources and data to the
server. This creates a local version of files and resources on the tester,
and a networked copy on the server. Special key-value pairs allow
Guru to manage multi-system file saves, versions, and restorations
without loss of data or data collisions. This allows multiple Cassini test
systems to be connected to a Guru server for shared resource
distribution, back-ups, and data storage. This feature also allows new
or replacement Cassini controllers (EPC TIM) to automatically
download and recover test resources from a Guru server
automatically upon installation.

© Roos Instruments Inc.
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FILE VERSIONING
Guru provides automatic file versioning when saving files. This means
users have a comprehensive revision history of files created, edited,
and saved on a Cassini test system without having to perform a ‘Save
as’ function. The system creates a revision attribute that preserves
multiple versions without overwriting any previous versions. When
opening files within an application on Cassini, Guru to automatically
loads the latest version/revision of the requested file. In the instance of
a test system not connected to a Guru server, this would load the
latest local version. When connected to a Guru server, the test
system’s Guru will automatically retrieve the latest, most up-to-date
version of a file/object found on the server. It then saves this version to
the local database as well. This concept applies to files shared and/or
edited on multiple Cassini test systems or virtual workstations.

OBSOLETE OBJECTS
Guru object versioning insures that the most current object is available
for the requested software resource. However, in some cases it is
necessary to remove objects from selection menus and applications
that are no longer needed. In Guru, objects that are no longer needed
are obsoleted. Obsoleting an object in Guru does not delete the
object, but creates a ‘obsolete‘ attribute that instructs programs and
applications that the resource is no longer used. This action removes
the unwanted object from views and menus in applications such as
the Guru Browser. This “view removal” applies to networked versions
of the object, meaning once an object is obsoleted on a Cassini’s
local Guru, it will be obsoleted on the Guru Server and all network
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connected Cassini systems. Obsolete objects loose all previous
revisions of that object, so only one copy of the object is retained in
case it needs to be retrieved for later use.

FIGURE 1.70 ACCESSING GURU BROWSER
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EXPIRE ON DATE FOR TEST DATA
The large storage capacity of a networked Guru and the relatively
small file size of objects allows every revision of an object to be
retained. However, in some instances it is desirable to remove
unwanted or extra objects from the database to free up storage. To
accommodate this, objects can be assigned an “Expire On” date
attribute that is set when the object is first created. Once the
expiration date elapses, the Guru object will be permanently deleted
from the local and all network connected Gurus and will no longer be
recoverable.
NOTE: Only RiTestData objects include ‘Expire On’ date attributes. The default Guru
expiration date for RiTestData objects is 30 days. The Expire On duration is defined in
the Exec dialog by the system administrator. Contact your Cassini ATE administrator or
RI support for assistance with ‘Expire On’ settings.

GURU BROWSER
The Guru Browser application provides a search, import, export, and
revision history viewing tool for all objects and resources on a Cassini
test system and networked Guru Servers. It is accessed through the
Apps button found on the right side of the screen of the Cassini test
system environment as shown in Figure 1.70.

DESCRIPTION
Access Guru Browser by selecting the Apps button and then selecting
Guru Browser from the scroll list of applications

© Roos Instruments Inc.

The Guru Browser window, shown in Figure 1.68, displays objects in
a tabulated view in the center pane. Each row represents a single
object with columns representing an attribute key type. Left-clicking
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on an object in the tabulated view will highlight the object row and
display all object key-value pairs in a list view in the pane below the
tabulated view. This list of key-value pair attributes provides the user
with more information about the object such as: object size, object
class, the object’s creation date, Guru ID of the system that created it,
and more. Left-clicking on a column heading will organize the object
rows in ascending or descending order with respect to the selected
key type. On the left side of the Guru browser window are drop-down
lists selections of attribute key-value pairs. The drop-down selections

FIGURE 1.71 GURU EXPORT LIST TAB VIEW

© Roos Instruments Inc.
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allow the user to filter object searches against up to four key-value
pair criteria. Listed along the bottom of the Guru Browser window are
the function tabs. Clicking on these tabs switches between the
various functions of Guru browser, showing a pane optimized for the
selected feature functionality.

GURU EXPORT LIST
The Guru Export List tab is used for exporting objects and/or groups
of objects from a Guru as .gzp files. An example of the Guru export
list layout is shown in Figure 1.71. This tool is useful for transferring
Guru objects via email, FTP, USB flash drive to Roos Instruments support or another company. Objects from the browser tab can be added
to the export list by selecting them in the tabulated view and choosing
the Export > Send to Export List options from the Guru Browser’s
menu selection or right mouse button menu. The list of objects are displayed in their tabulated view of the export list. The various export list
actions are provided in the pane on the left. Choose Export to create
the .gzp file. The user is provided an opportunity to add comments to
the file and select the path and file name.
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GURU IMPORT LIST
The Guru import list tab is used for importing objects and/or groups of
objects into Guru from a .gzp file attachment via shared network or
USB flash drive. This tool is useful for loading objects such as TIMspecific calibration data into a Cassini test system’s local Guru. An
example of the Guru import list tab layout is shown in Figure 1.72. The
import list tab is divided into three panes. The bottom pane lists .gzp
files to be imported into Guru. Selecting the Get Import File(s)
provides a pop-up window for selecting .gzp files for import. The
selected .gzp will be listed in the lower pane of the window. Selecting
a .gzp in this list, and then left-clicking the upper left pane will list the
contents of the .gzp file, typically objects or groups of objects as .GAT
files. Highlighting these .GAT files by left-clicking on a file in this pane
will display a list view of the object’s attribute key-value pairs in the
pane to the right. Selecting the Import button on a selected .gzp file
will import it’s contents in Guru. Guru will automatically resolve
revision/version conflicts of imported objects with the system’s local
Guru. The importer GUI provides visual cues of the revision resolution
actions the importer will take with individual objects within an
imported file as shown in Figure 1.72:

System Information | Guru
• Magenta text denotes that object to be imported is older than
the version that exists on the local Guru. This object will be
imported, and when the object resource is requested by an
application, the current version on the local Guru will be used.
The imported older version will be saved in local guru’s revision
history.
• Black text denotes that the object already exist in the local Guru
and is the most current version and as such, the object in the
import list will not be imported.

FIGURE 1.72 GURU IMPORT LIST TAB VIEW

• Green text denotes objects that do not currently exist in the local
Guru and will imported
• Red text denotes that object to be imported is newer than the
version that exists on the local Guru. This object will be imported,
and when requested by an application, the imported version will
be used. The older version will be saved in the local guru’s
revision history.
© Roos Instruments Inc.
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NOTE: Always save resources and close applications that may create versions of objects
that are being imported.
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FIGURE 1.73 GURU REVISION HISTORY TAB VIEW

REVISION HISTORY
The Guru revision history tab is used for viewing the revision history of
an object. An example of the revision history tab layout is shown in
Figure 1.73. Selecting an object in the tabulated view of the Browser,
and then clicking on the Revision History tab will display a table view
of the selected object’s file history in the top pane. The columns of the
table view display the object’s Name, Creation Date, and Version
attribute keys. Left-clicking on the column headers will sort the table
in ascending or descending order with respect to the selected key
type. Left-clicking on a version in the table will highlight the row and
display or refresh the object version’s information in a list view in the
pane below the table. Right-clicking on an object revision in the table
provides a menu with options to ‘Remove from local,' ‘Make Last
RevisionOf,' and ‘Send to Export List.' The ‘Remove from Local’
option will remove the selected object version from the local Guru.
The ‘Make Last RevisionOf’ option will make the currently selected
version of the object into the latest version. Applications that use this
object will now use this version of the object. The ‘Send to Export
List’ option will add the selected version to the Guru Export List.
CAUTION: DO NOT remove or alter the revision version of an object without consent
from authorized personnel.

© Roos Instruments Inc.
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Device Definition
Device Pins Definition
DIB (Device Interface Board) Definition

Attributes

Layer Tabs

Fixture Definition

Input Panes
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INTRODUCTION
The Device Connection Editor allows the user to define software
objects representing the resource mapping layers between TIMs and
from TIM instruments to DUT pins. These layers, defined as Fixture,
Dut Interface and Dut, serve as the tester integration and enable the
user to dynamically reconfigure the tester resources for different

FIGURE 1.74 ACCESSING THE DEVICE CONNECTION EDITOR
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applications. In addition, the integration layers allow cascaded
calibration path names used for RF interconnections, and enable
software control of relays/switches in the Fixture and Device Interface
Board (DIB). The software objects are linked to their associated
Fixture or DIB hardware with a unique serial number chip (a.k.a.
electronic serial number or ESN) that identifies the resource in the
hardware configuration. This allows the software to identify and load
calibration and control resources automatically during System Checks
and Startups.
Resource mapping in the Device Connection Editor is divided into four
layers: Device, Device Pins, DIB, and Fixture. The Device Pins, DIB
and Fixture layers are three configurable components of the device
interconnect environment and the Device layer serves as the target
device for the application. Combined, these allow the user to tailor the
test system resources to a specific device or a family of devices.
The following section describes:
• The Device Connection Editor user interface
• The interrelation of resource mapping layers
• How to create and modify device interface layer definitions
• How to link the device interface software objects to their
associated hardware

The Device Connection Editor can be accessed from the Cassini Apps
list as shown above.

© Roos Instruments Inc.
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USER INTERFACE
The Device Connection Editor provides three editable panes, the top
pane has Layer tabs that provide their corresponding panes with
contextual input forms for their respective Layer, see Interactive 1.2.
The upper pane displays the Attributes form and the lower two panes
display DIB and Fixture connection forms. The top pane contains
global information about the interconnect layer’s software object such
as version (Version attribute) and release status (Status attribute) as

Device Pins

Fixture

DIB

Device Family

Multi-Site Defintions

Fixture Family

DIB Family

Title

Device Pin Site

Fixture Title

DIB Title

Permission

Device Pin Family

Fixture Class

Device Family

Version

Device Pins Title

Interface

Device Pins Family

Status

Device Family

28V Power

Fixture Family

Device Permission

Device Family

Serial Number

Version

Tester

Permission

Status

Serial Number

Version

Permission

Status

Version
Status

The diagram shows the four layers of the Device Connection Editor
and their associated attributes. Shared attributes link layers in the
software for named path and pin resource mapping to cascade vectorerror correction or offset in the calibration values for each layer.

© Roos Instruments Inc.

1. Create a target device.
2. Define the pins/ports of the device to be tested.
3. Define the Fixture interconnect (integration layer) for the device or
application.
4. Define the Device Interface Board (DIB) resource mapping from
the Fixture to the Device Pins.

FIGURE 1.75 ATTRIBUTE LAYERS & CONNECTIONS
Device

well as specialized attributes that link the different layers together in
the hierarchy shown in Figure 1.75. This hierarchy of layer attributes
also serves as the workflow in the Device Connection Editor:

In addition, the specialized attributes (Device Family, Permission)
narrow search results for other layers. When a Device is loaded in the
device connection editor, subsequent Device Pins, DIB, and Fixture
load dialog windows default to displaying objects that share the same
Device Family and Permission attributes of the loaded Device. While a
shared Device Family attribute between layers connect them, the
Permission attribute enforces user access control to the objects
created in the Device Connection Editor and their use in the Cassini
software environment. This restricts viewing and editing of these
objects to users who are members of a group or role with access to
that permission.
NOTE: Contact your Cassini system administrator for information on user permission
access.
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The Dev Conn menu changes depending on what Layer tab is
selected. For Example, to load a Fixture, first select the Fixture tab,
then choose Open from the Dev Conn menu.
While access control is set from the Guru Logon button, the Device
Connection Editor application allows for login with a different user
within the application only. This allows for different user permission/
access control within the Device Connection Editor application.
To login with a diﬀerent user in the Device Connection Editor:
1. From the menu options select System > Logoﬀ.
2. From the menu options select System > Logon.
3. Enter the user name and corresponding password for the desired
user in the RI Guru Password window and select Log On.
NOTE: The Logoff menu option only applies to the Device Connection Editor
application and does not affect access for other applications or future applications
launched from the Guru > Apps button.

© Roos Instruments Inc.
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DEVICE DEFINITION
Accessed from the Device tab, the Device object or Device Definition
defines a target that subsequent device pins, device interface board,
fixture and/or Device Control Definitions will be associated. This layer
only contains user-defined attributes. Guru uses this Device object
(Device Family attribute) to link all of the layer definitions created in the
Device Connection Editor automatically when importing or exporting
Fixture, DIB, Device Pins, and/or Device Control definition resources.

INTERACTIVE 1.3 DEVICE DEFINITION

System Information | Device Connection Editor
To create a new Device:
1. Select the Device tab from the attributes pane.
2. From the menu options select Dev Conn > New Device...
3. In the New Device pop-up window fill in the attribute fields shown
in Figure 1.76 and listed below with their descriptions:
Device Family is used to tag and link all layers (Device Pins, DIB, and
Fixture definitions) in the Device Connection Editor that are related to
this device. It is recommended to use a generic Device Family
attribute value.
NOTE: These attributes are used to filter available definition selections in Load
windows in the Device Pins, DIB, and Fixture tabs to the currently loaded Device.
Device Title is the user-specified name of the target device. In a family
of devices it is used to identify a specific variant of a device.
NOTE: The Device Title value defaults to the Device Family value.

Attributes

Permission assigns a user-defined value that can restrict read, write
access to the Device object in other applications and file resources in
the software environment according to User Access roles in Guru.
See the User Access Control section of Guru for more information.
It is a shared attribute value across related Device Pins, DIB, and
Device Control definitions (see Figure 1.75) that is also used for

© Roos Instruments Inc.
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category identification to narrow search results in Load windows in
the Device Connection Editor.

System Information | Device Connection Editor

FIGURE 1.76 NEW DEVICE DEFINITION

Version is a user-defined revision number such as 1.0, 1.1, etc.
Status is a drop down selection list of ‘alpha’, ‘beta’, or ‘released’
values. The ‘alpha’ and ‘beta’ values are intended for devices that are
in stages of development. The ‘released’ attribute value is to
designate that the object is ready for production and makes the
Device definition read-only.
NOTE: The ‘released’ attribute value prevents any further changes by disabling the Save
menu options for the Device definition.

4. Click OK to add the values to the Device attribute fields.

To modify a Device attribute:
1. Highlight the entry by left clicking on the desired value in the
attribute pane.
2. Right click on the selected entry and select Edit from the menu.
3. Click OK to save the changes to the Device attribute entry.
© Roos Instruments Inc.
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3. Click OK to complete the save.

To save changes to a Device definition:
1. From the menu options select Dev Conn > Save Device

NOTE: A Save As creates a new object history thread for the Device definition and does
not retain the save history of the original Device definition.

2. In the Save window, Version and Status attribute values can be
modified to reflect changes.

To load a Device definition:

3. Click OK to complete the save.

1. From the menu options select Dev Conn > Load...

NOTE: Each save creates a history of saved changes to the Device definition. Each
saved version can be viewed from the ‘History...’ button in the Load Device window.

2. In the Device Selection window, the Device Family and Permission
drop down lists can be used to narrow the search field by the
attribute value.

1. From the menu options select Dev Conn > Save Device As...

3. Highlight the device by left clicking on the desired definition in the
selection pane. The table can be resorted by any column by
Right clicking anywhere and choose from the Sort By menu.

2. In the Saving New Device window:

4. Click OK to load the latest version of the selected definition.

To save a new Device definition:

The Device Title, Version, and Status can be modified by the user.
To load a previously saved version of a Device definition:
A new Device Family can be selected from the drop down list of
previously created attribute values.
The Permission can be selected from the drop down list of
previously created attribute values or a new value can be created
by clicking on the New... button.

1. From the menu options select Dev Conn > Load Device...
2. Highlight the device by left clicking on the desired definition in the
selection pane. The table can be resorted by any column by
Right clicking anywhere and choose from the Sort By menu.
3. Click History... button to open the Object History window.

© Roos Instruments Inc.
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4. Select the desired version from the list of saved Device definitions.
NOTE: Saving a previous version of the Device definition from the History creates a
new save entry with the latest save timestamp. This version becomes the default definition
on subsequent load requests.

© Roos Instruments Inc.
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DEVICE PINS DEFINITION
The Device Pins object or Device Pins Definition is accessed from the
Device Pins tab and defines the port and pin resources of the
created or selected device from the previous Device tab. This layer
maps Cassini resources to device pins from the DIB and/or fixture.
This layer in combination with the DIB and Fixture layers provides the
ability to reassign Cassini instrument button parameters and values in

System Information | Device Connection Editor
the graphical programming environment with device pin naming
conventions. The Device Pins definition consists of Attributes, Pins
Definitions, and Pin Groups that are created and modified as
described in the following text.
To create a new Device Pins:
1. From the menu options select Dev Conn > New Device Pins...
2. In the New Device Pins pop-up window fill in the attribute fields
shown in Figure 1.77 and listed below with their descriptions:

INTERACTIVE 1.4 DEVICE PINS DEFINITION
Multiple Definitions provides a ‘Yes’ or ‘No’ selection box for
supporting pin identification across multiple sites. The default
value is the ‘No’ selection.

Device Pins

Device Pins Site is used when the Multiple Definitions attribute is
set to the ‘Yes’ selection. It provides a user-defined value or
values to designate the site of corresponding pins by prefixing the
pin value with the Device Pin Site value.
NOTE: If the Multiple Definition value is left in the default ‘No’ selection the Device
Pins Site value should be left blank.

Device Pin Groups

Device Pins Family is used to link the Device Pins and DIB
layer objects in the Device Connection Editor for mapping
resources from the target device pins to the device interface
board pin/port designations. It is recommended to use a
© Roos Instruments Inc.
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generic Device Pin Family attribute value if multiple device
designs or a family of devices will be supported.
NOTE: This attribute is used to filter available definition selections in Load windows in
the DIB tab to the currently loaded Device Pin Family.

Device Pins Title is the user-specified name of the target device
pins. In a family of devices it is used to identify a specific device
pin variant or configuration.

System Information | Device Connection Editor
identification to narrow search results in Load windows for these
layers in the Device Connection Editor.
NOTE: Always load the target Device definition before creating a new Device Pins
definition.

FIGURE 1.77 NEW DEVICE PINS DEFINITION

NOTE: The Device Pins Title value defaults to the Device Family value.

Device Family provides a drop-down selection list of available
attribute values created in the Device layer. These link the Device
Pin definition to the target Device definition.
NOTE: If a Device definition is loaded, the Device Family attribute will default to the
Device layer attribute value in Device Pin saves.

Permission is automatically assigned from the Permission
attribute value of the loaded Device definition and cannot be
altered in the New Device Pins window. It is a shared attribute
value across related Device, DIB, and Device Control
definitions (see Figure 1.77) that is also used for category
© Roos Instruments Inc.
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Version is a user-defined revision number such as 1.0, 1.1, etc.
Status is a drop down selection list of ‘alpha’, ‘beta’, or ‘released’
values. The ‘alpha’ and ‘beta’ values are intended for devices that are
in stages of development. The ‘released’ attribute value designates
that it is ready for production and makes the Device Pins definition
permanently read-only.

System Information | Device Connection Editor
2. In the Save window, Version and Status attribute values can be
modified to reflect changes.
3. Click OK to complete the save.
NOTE: Each save creates a history of saved changes to the Device Pins definition. Each
saved version can be viewed from the ‘History...’ button in the Load Device Pins
window.

NOTE: The ‘released’ attribute value prevents any further changes by disabling the Save
menu options for the Device Pins definition.
To save a new Device Pins:
3. Click OK to add the values to the Device Pins attribute fields.

1. From the menu options select Dev Conn > Save Device Pins
As...
2. In the Saving New Device Pins window:

To modify a Device Pin attribute:
1. Highlight the attribute by left clicking in the selection pane.
2. Right click on the selected entry and select Edit from the menu.
3. Click OK to save the changes to the Device Pin attribute field.

To save changes to a Device Pins:
1. From the menu options select Dev Conn > Save Device Pins

© Roos Instruments Inc.

The Device Pins Site, Device Pins Family, Device Pins Title,
Version, and Status can be modified by the user.
A new Device Family can be selected from the drop down list of
previously created attribute values.
The Permission is automatically assigned from the Permission
attribute value of the loaded Device definition and cannot be
altered.
3. Click OK to complete the save.
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NOTE: A Save As creates a new history thread for the Device Pins definition and does
not retain the save history of the original Device Pins definition.

System Information | Device Connection Editor
NOTE: Saving a previous version of the Device Pins definition from the History creates
a new save entry with the latest save timestamp. This version becomes the default
definition on subsequent load requests.

To load a Device Pins:
1. From the menu options select Dev Conn > Load Device Pins...
2. In the Device Pins Selection window, the Device Family and
Device Pins Family drop down list can be used to narrow the
search field results by selecting an attribute value.
3. Highlight the device pins by left clicking on the desired definition in
the selection pane. The table can be resorted by any column by
Right clicking anywhere and choose from the Sort By menu.

DEVICE PINS DEFINITION
The Device Pins tab has two panes below the attributes pane for
defining the device pin and ports - Device Pins Definition and Device
Pins Group.
The Device Pins Definition pane allows the user to input and describe
the DUT pins in the Device Connection Editor.

4. Click OK to load the latest version of the selected definition.

NOTE: Device Pin Definitions when used in conjunction with a DIB definition
automatically rename individual TIM resources. For example, the Dpins instrument
pins D1-1 through D1-20 are renamed with the user-specified Pin Name values.

To load a previously saved version of a Device Pins:

To add a Device Pins Definition entry:

1. From the menu options select Dev Conn > Load Device Pins...

1. Right click on the Device Pins Definition pane and select Add
from the menu.

2. Highlight the device pins by left clicking on the desired definition in
the selection pane.
3. Click History... to open the Object History window.
4. Select the desired version from the list of saved Device Pins
definitions.
© Roos Instruments Inc.

2. Complete the entry form in the Add/Edit Device Pin window (see
Figure 1.78) as described below:
The Pin Identifier is commonly used to designate the pin number
as specified on a data sheet.
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The Pin Name is commonly used to designate the pin resource as
specified on a data sheet.
The Signal is a generic entry that is commonly used to designate
the signal type, i.e - DC, digital, RF, etc.

System Information | Device Connection Editor
The Type provides a drop-down list of selectable
instrument resources on Cassini as well as allowing userdefined entries.
The Description provides additional information input about
the pin resource.
NOTE: The Pin Identifier and Pin Name entries are used as the connection resource
for mapping DIB Path and DIB Resource Pins.

FIGURE 1.78 ADDING A PIN DEFINITION
3. Click OK to add the entry to the Device Pin Definition field.

To modify a Device Pins Definition entry:
1. Highlight the entry by left clicking on the desired definition in the
Device Pins Definition pane.
2. Right click on the selected entry and select Edit from the menu.
3. Click OK to save the changes to the Device Pin Definition field.

© Roos Instruments Inc.
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To copy a Device Pins Definition entry:

System Information | Device Connection Editor
NOTE: The Exclude pin field is populated by Device Pin Definition entries.

1. Highlight the entry by left clicking on the desired definition in the
Device Pins Definition pane.
2. Right click on the selected entry and select Copy Row from the
menu.
3. Click OK to add the entry to the Device Pin Definition field.

4. Click the >> button to add the selected resource to the Include
Pin field. To remove a resource from the Include Pin field left click
to select and click the << button to move it back to the Exclude
Pin field.
5. Click OK to add the entry to the Device Pins Group field.

The Device Pins Group pane allows the user to designate a set of pins
with a user-defined name. This grouping convention can be used in
the graphical programming environment to perform multi-pin
measurements as a batch command or as communication pin
designation with the RI8535 Digital TIM’s Dpins instrument by using
the Pin State button. (See RI8535 Pin State button)

To add a Device Pins Group entry:
1. Right click on the Device Pins Group table form and select Add
from the menu.
2. In the Device Pins Group window (see Figure 1.79) input a userspecified Group Name that is used to designate the pins in a
group.
3. Left click on the desired pins in the Exclude Pin to select them. To
unselect a pin, left click on the highlighted field.
© Roos Instruments Inc.
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To modify a Device Pins Group entry:

System Information | Device Connection Editor

FIGURE 1.79 ADDING A DEVICE PINS GROUP

1. Highlight the entry by left clicking on the desired definition in the
table form.
2. Right click on the selected entry and select Edit from the menu.
3. Click OK to save the changes to the Device Pin Definition field.

To copy a Device Pins Group entry:
1. Highlight the entry by left clicking on the desired definition in the
Device Pins Group table form.
2. Right click on the selected entry and select Copy Row from the
menu.
3. Click OK to add the entry to the Device Pin Group field.

Add Types to a Device Pins Group entry:
Once a Device Pins Group has been created, pins within the group
can be assigned a pin type. Types designate communication protocol
resources such as clock, r/w, strobe, and scan pins in addition to
specialized pin states such as open, off, and termination. Device pin
groups with types are displayed as selection choices in the Serial
© Roos Instruments Inc.
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Group button of the RI8535 Digital TIM’s Dpins instrument to
designate serial or scan communication pin resources.
1. Highlight the Device Pins Group by left clicking on the desired
entry in the Device Pins Group table row.
2. Right click on the selected entry and select Edit from the menu.

System Information | Device Connection Editor
3. Right click on the Types field and select Add from the menu.
4. In the Device Pins Group Type window (see Figure 1.80), select a
resource type from the drop-down box.
5. Left click on the desired pin or pins in the Exclude Pin list to select
them. To unselect a pin, left click on the highlighted field.
NOTE: The Exclude pin field is populated by Device Pin Definition entries.

FIGURE 1.80 ADDING A DEVICE PINS GROUP TYPE
6. Click the >> button to add the selected resource to the Include
Pin field. To remove a resource from the Include Pin field left click
to select and click the << button to move it back to the Exclude
Pin field.
7. Click OK to add the type for the selected pin or pins in the Device
Pin Group.

© Roos Instruments Inc.
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DIB (DEVICE INTERFACE BOARD) DEFINITION
The DIB object or DIB definition is accessed from the DIB tab (see
Interactive 1.5) and defines the signal paths between the device pins
and fixture resources on the PCB. This layer works in conjunction with
the Device Pin and Fixture objects to reassign Cassini instrument
button parameters and values in the graphical programming
environment with device pin naming conventions. As well as providing
pin/port mapping, the RF paths defined by the DIB represent a
calibration layer that is cascaded with the fixture layer to extend scalar
and vector error correction from the fixture signal launches to the
device. The DIB definition consists of attributes, DIB paths, and DIB
resource pins that are created and modified as described in the
following text.

System Information | Device Connection Editor

INTERACTIVE 1.5 DEVICE INTERFACE BOARD DEFINITION

DIB Paths

DIB Resource Pins

NOTE: A Fixture Definition and Device Pins Definition must exist or be created before
defining the resource connection in a DIB Definition.

To create a new DIB:
1. From the menu options select Dev Conn > New DIB...

recommended to use a generic DIB Family attribute value if multiple
designs or a family of devices will be supported.

2. In the New DIB pop-up window fill in the attribute fields that are
listed below with their descriptions:

DIB Title is the user-specified name of the device interface board. In a
family of DIBs it is used to identify a specific DIB version or design
variant.

DIB Family provides a drop-down selection list of available attribute
values and allows user input values used to identify a device interface
board design or a family of board designs for a particular device. It is

NOTE: The DIB Title value defaults to the DIB Family value.

© Roos Instruments Inc.
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Device Family provides a drop-down selection list of available attribute
values created in the Device layer. These link the DIB definition to the
target Device definition.
NOTE: If a Device definition is loaded, the Device Family attribute will default to the
Device layer attribute value in DIB saves.

System Information | Device Connection Editor
Serial Number is an automatically generated, unique alphanumeric
identification number.
NOTE: The user can input a specified value but it must be unique for each DIB
definition.

Device Pins Family provides a drop-down selection list of available
attribute values created in the Device Pins layer. Is used to link the
Device Pins and DIB layer objects in the Device Connection Editor
for mapping resources from the target device pins to the device
interface board pin/port designations.

Permission is a shared attribute value across related Device, DIB, and
Device Control definitions (see Figure 1.75) that is also used for
category identification to narrow search results in load windows for
these layers in the Device Connection Editor. If a fixture definition is
loaded, the value will default to the Fixture layer attribute value in DIB
create/save windows

NOTE: This attribute is used to filter available definition selections in Load windows in
the DIB tab to the currently loaded Device Pin Family.

NOTE: The Permission attribute value of the DIB must match the Permission values of
loaded Device, Device Pins, and Fixture definition in the Device Connection Editor.

Fixture Family provides a drop-down selection list of available attribute
values created in the Fixture layer. It is used to link the Fixture and
DIB layer objects in the Device Connection Editor for mapping
resources from the fixture signal launches to the device interface
board pin/port designations.

Version is a user-defined revision number such as 1.0, 1.1, etc.

NOTE: If a Fixture definition is loaded, the value will default to the Fixture layer
attribute value in DIB create/save windows.

© Roos Instruments Inc.

Status is a drop down selection list of ‘alpha’, ‘beta’, or ‘released’
values. The ‘alpha’ and ‘beta’ values are intended for DIBs that are in
stages of development. The ‘released’ attribute value designates that
it is ready for production and makes the DIB definition read-only.
NOTE: The ‘released’ attribute value prevents any further changes by disabling the Save
menu options for the DIB definition.
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3. Click OK to add the values to the DIB attribute fields.

System Information | Device Connection Editor
To save a new DIB definition:
1. From the menu options select Dev Conn > Save DIB As...

To modify a DIB attribute:

2. In the Saving New DIB window:

1. Highlight the entry by left clicking on the desired value in the
attribute pane.

The DIB Family, DIB Title, Version, and Status can be modified by the
user.
The Device Family, Device Pins Family, and Fixture Family can be
selected from the drop down list of previously created attribute values.
The Permission can be selected from the drop down list of previously
created attribute values or a new value can be created by clicking on
the New... button.

2. Right click on the selected entry and select Edit from the menu.
3. Click OK to save the changes to the DIB attribute field.

To save changes to a DIB definition:
1. From the menu options select Dev Conn > Save DIB
2. In the Save window, Version and Status attribute values can be
modified to reflect changes.

3. Click OK to complete the save.
NOTE: The ‘Save As’ creates a new history of changes thread for the DIB definition
and does not retain the save history of the original DIB definition.

3. Click OK to complete the save.

To load a DIB definition:

NOTE: Each save creates a history of saved changes to the DIB definition. Each saved
version can be viewed from the ‘History...’ button in the Load DIB window.

1. From the menu options select Dev Conn > Load DIB...
2. In the DIB Selection window, the Device Family, DIB Family,
Fixture Family, and/or Device Pins Family drop down list can be
used to narrow the search field results by selecting an attribute
value.
3. Highlight the DIB by left clicking on the desired definition.

© Roos Instruments Inc.
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4. Click OK to load the latest version of the selected definition.

DIB DEFINITION
The DIB tab has two panes below the attributes pane for defining the
device interface board: DIB Paths and DIB Resource Pins.

To load a previously saved version of a DIB definition:
1. From the menu options select Dev Conn > Load DIB...
2. Highlight the DIB by left clicking on the desired definition.
3. Click History... to open the Object History window.

DIB Paths define RF resource connections from the Device Pins to
Fixture/TIM resource ports through the DIB. Paths provide calibration
variable name entries that can apply error correction to compensate

FIGURE 1.81 ADDING A DIB PATH

4. Select the desired version from the list of saved DIB definitions.
NOTE: Saving a previous version of the DIB definition from the History creates a new
save entry with the latest save timestamp. This version becomes the default definition on
subsequent load requests.

© Roos Instruments Inc.
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for path loss in the DIB PCB and designate switch paths for
controlling switch states on the DIB.
NOTE: Each physical DIB PCB is identified by the Cassini software with a unique
electronic serial number (ESN). This allows for each DIB PCB to have unique
calibration data for each calibration path defined in the DIB definition.

To add a new DIB Path:
DIB Paths definitions must be unique:
• State Name and Value entry pairs cannot be repeated.
• Calibration Name entries must be unique for each path.
• Switched paths from the same Fixture Pin to the same Device Pin
(fan-out/fan-in paths) must have unique Switch entries and State
Value entries.
NOTE: A Device Pins and Fixture definition must be loaded in the Device Connection
Editor before defining DIB Paths.

The Fixture Pin Name provides a drop-down selection list of available
fixture resources from the Fixture definition and allows user input
values. These values define the fixture side resource connection of the
DIB Path. New user entries in the Fixture Pin Name field of the DIB
definition become available in the Fixture definition.
The Device Pins Device Site, Device Pins Identifier, and Device Pins
Name provide drop-down selection list of the values available in the
loaded Device/Device Pins definition. These values define the device
side resource connection of the DIB Path.
The State Name and Value fields are used in conjunction with the
Switch field to create a button for the graphical programming
environment that represents the switch path state. The button owner
is ‘DIB’ with the Name field as the button function and Value field
defining the button parameter. See example below:

DIB
Switch1

RF3 to Pin5

Owner: DIB
State Name: Switch1
State Value: RF3 to Pin5

1. Right click on the DIB Path table form and select Add from the
menu.
2. Complete the entry fields in the Adding New Device Interface
Definition window (see Figure 1.81) for the Fixture Pin, Device
Pins, State, Switch and/or Calibration Name described below:
© Roos Instruments Inc.

The Switch field contains the switch control/command string
represented by the graphical button created from the State Name and
Value. DIB switches are controlled via control bits supplied from the
fixture. Consult the application notes for control bit (CBIT) command
strings based on the module and fixture carrier type.
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The Calibration Name provides a user-defined name for associating
error correction with the designated path. For more information, see
the DIB Calibration in this section.
3. Click OK to add the entry to the DIB path field.
NOTE: Calibration data is applied automatically for the designated path when the DIB
instrument is added to the System Configuration.

To modify a DIB Path entry:
1. Highlight the entry by left clicking on the desired path in the DIB
Path pane.
2. Right click on the selected entry and select Edit from the menu.

System Information | Device Connection Editor
DIB Resource Pins designate resource mapping on the DIB from a
fixture/TIM resource to a device pin specified in the Device Pins
tab. This resource mapping is used to rename the RI8535 Digital
TIM’s Dpins instrument button resources in the graphical
programming environment (D1-1 through D1-20, D2-1 through
D2-20, etc.) with the naming conventions defined by the user in
the Device Pins Definition.

To add a new DIB Resource Pin:
DIB Resource Pins must be unique, the Device Pin and Resource
entry pairs cannot be repeated.
NOTE: A Device Pins and Fixture definition must be loaded in the Device Connection
Editor before defining DIB Paths.

3. Click OK to save the changes to the DIB Path field.

To copy a DIB Path entry:
1. Highlight the entry by left clicking on the desired definition in the
DIB Path pane.
2. Right click on the selected entry and select Copy Row from the
menu.
3. Click OK to add the entry to the DIB Path field.
© Roos Instruments Inc.

1. Right click on the DIB Resource Pin pane and select Add from the
menu.
2. Complete the entry fields in the Editing DIB Resource Connection
window (see Figure 1.82) for the Device Pin and Resource Pin
described below:
The Device Pins Device Site, Identifier, and Name are drop-down
selections from the available resources in the loaded Device Pin
definition. These values define the device side resource
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connection.

System Information | Device Connection Editor

FIGURE 1.82 ADDING A DIB RESOURCE PIN

The Resource Name provides a drop-down selection list of
available instrument resources from the Fixture definition. The
TIM resource Model and Location values available in the dropdown selections are defined by the tester configuration specified
in the Fixture definition’s Tester attribute. These values define the
fixture side resource connection.
3. Click OK to add the entry to the DIB Resource Connection field.

© Roos Instruments Inc.
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To modify a DIB Resource Pin entry:

DIB CALIBRATION

1. Highlight the entry by left clicking on the desired path in the DIB
Resource Pins pane.

When a Calibration Name is added to a Fixture Path, it creates a
calibration variable that stores the calibration data associated with the
RF path in the Fixture Definition. This extends error-corrected source
and measurement capability to the DIB. When a ‘Dut Instrument‘ with
calibration data is added to the system configuration, all source
amplitude settings and receiver measurements of the test system are
relative to the calibration plane of the DIB, i.e - a source TIM power
setting in the software/test plan of +1dBm is reflected as +1dBm at
the calibration plane of the DIB. When any calibration variable
associated with a Fixture Path is created, it has a default data type of
RiFrVs2pS (frequency vs. 2-port s-parameter) and two data points:
S11, S21, S12, and S22 at 1kHz and S11, S21, S12, and S22 at
20GHz. By default, the calibration data is linearly interpolated between
any two successive data points to provide error correction for any
value between the calibration endpoints.

2. Right click on the selected entry and select Edit from the menu.
3. Click OK to save the changes to the DIB Resource Pin form.

To copy a DIB Resource Pin entry:
1. Highlight the entry by left clicking on the desired definition in the
DIB Resource Pin table row.
2. Right click on the selected entry and select Copy Row from the
menu.
3. Click OK to add the entry to the DIB Resource Pin field.

NOTE: Calibration data that has the Spline calculation button applied is saved as a
jbSpline datatype and uses a second order polynomial interpolation between any two
successive data points.

To view the default calibration data:
1. With the DIB tab selected in the Device Connection Editor, select
Dev Conn > Edit Default Cal... from the menu options. The RI
Default Cal window (see Figure 1.83) provides a drop-down list of
© Roos Instruments Inc.
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calibration variables created from DIB Paths and unassociated
calibration variables.

System Information | Device Connection Editor
in the left pane with the associated values for a selected data
point in the right pane.

2. Select a calibration name from the Cal Name drop down list.
3. The Cal Type fields will display the default data type of the
selected calibration variable and display the number of data points

FIGURE 1.83 VIEW DIB DEFAULT CALIBRATION DATA

To change the default calibration data type:
1. With the DIB tab selected in the Device Connection Editor, select
Dev Conn > Edit Default Cal... from the menu options to open
the RI Default Cal Window window (see Figure 1.83).
2. Select a calibration name from the drop down list.
3. The Cal Type fields will display the default data type of the
selected calibration variable and display the number of data points
in the left pane with the associated values for a selected data
point in the right pane.

To add data points to the default calibration:
1. With the DIB tab selected in the Device Connection Editor, select
Dev Conn > Edit Default Cal... from the menu options to
access the RI Default Cal Window (see Figure 1.83).
2. In the left pane of the Cal Type fields right click and select Add
from the menu.
3. In the Adding Cal Data Row window input the number of
additional data points in the ‘# of rows to add’ field and the
© Roos Instruments Inc.
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location of the new data points relative to the existing data points
in the ‘Starting index’ field.

System Information | Device Connection Editor
3. In the New Cal Default window complete the fields listed below:
The Cal Name defines the new calibration variable designation.

4. Click OK to add.
To remove a data point from the default calibration:
1. With the DIB tab selected in the Device Connection Editor, select
Dev Conn > Edit Default Cal... from the menu options to
access the RI Default Cal Window (see Figure 1.83).
2. In the left pane of the Cal Type fields right click on a datapoint to
highlight it and select Delete from the menu.

NOTE: Calibration variable names must be unique.
The Cal Type field provides a drop-down list of data types to select for
the calibration variable.
The Data Size defines the number of data points in the default
calibration variable.
4. Click OK to add the calibration variable.

In addition to calibration variables that are linked to DIB Paths,
additional calibration variables can be added to the DIB Definition.
When the ‘Dut Interface’ instrument is loaded into the System
Configuration, these unassociated calibration variables are available
as calibration data in test plans.

To add a calibration variable:
1. With the DIB tab selected in the Device Connection Editor, select
Dev Conn > Edit Default Cal... from the menu options to
access the RI Default Cal Window (see Figure 1.83).
2. Click the Add New Cal Entry button.
© Roos Instruments Inc.
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DIB CALIBRATION LIST
The DIB Calibration List is a user-defined collection of test plans for
performing a DIB calibration, verifying the calibration results, and DIBspecific diagnostics. This allows the user to define specific calibration
methodologies and performance requirements for a DIB or a class of
DIBs, and easily access the list directly from the ‘Device Interface’
instrument in the System Configuration window.

System Information | Device Connection Editor
The following steps describe how to create DIB-specific calibration
and diagnostic test plans from generic test plans and how to add
these test plans to the DIB’s calibration list to run them from a
specialized calibration or diagnostic executive accessed from the right
click Calibration menu on the ‘Device Interface’ instrument.

Create DIB-specific calibration test plans:

FIGURE 1.84 ADD/EDIT DIB CALIBRATION LIST
NOTE: Calibration variables associated with RF paths must first be created in a DIB
Definition and the ‘Dut Interface’ instrument must be loaded into the System
Configuration in order to access them in the graphical programming environment.

1. Load a DIB definition with calibration paths and/or calibration
variables into the System Configuration.
NOTE: The DIB definition can be loaded manually by selecting Instrument > Add DIB
Def... from the menu options in the System Configuration Window or docking a DIB to
the fixture with the desired DIB definition.
2. Open or create a new test plan by choosing Test > Plans from
the main Cassini window.
3. Place a Cal Data input block in a test panel.
DIB calibration data is written to the Cal Data input block in test
plans. It is found in the System > data saves of the Editor Panel.
See the edit button descriptions for more information.
© Roos Instruments Inc.
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4. Right click anywhere within the white space area contained by the
System box that surrounds the gray Cal Data box and select
Change Owner from the pop-up menu list.
5. From the list of available instruments in the system configuration,
select Dut Interface from the pop-up menu list.
6. Right click anywhere within the gray Cal Data box and select Cal
Name... from the pop-up menu list.
7. Select the desired DIB calibration variable with which to save
measurement data.
NOTE: Negative dB values are interpreted as path loss. The Cassini software will
compensate by increasing signal input values of sources in the associated path or adding
the path loss as a correction to measurements values for receive paths. Positive dB values
are interpreted as path gain. The Cassini software will compensate by decreasing signal
input values of sources in the associated path or subtracting the path gain correction
from measurements values for receive paths.

System Information | Device Connection Editor

To add a DIB calibration test plan to the Calibration List:
1. With the DIB tab selected in the Device Connection Editor, select
Dev Conn > Edit Cal List... from the menu options.
2. In the Calibration List (see Figure 1.84) window, right click on the
Calibration List pane and select Add from the menu to access the
Add/Edit Calibration List window.
3. In the Add/Edit Calibration List window select ‘calibrate’ from the
Type drop down list to add the selection to the Cal Exec list or
‘diagnose’ to add it to the Diag Exec list. The Testplan Selection
form provides drop down lists for the Device Family, DIB Family,
Fixture Family, Category, and Version attributes to narrow the list
of displayed test plans. The ‘verify’ Type is not seen by either the
Cal or Diag Execs from the System Configuration window.
NOTE: Calibration and validation test plans should both use the Type: ‘calibrate’
selection when adding them to the Calibration List.

8. Save the test plan by selecting File > Save Cal Test > Dib from
the menu options.
9. In the Save DIB Calibration Testplan window an additional ‘dib’
attribute can be added to the testplan. From the drop-down list
select the DIB Family attribute for the desired DIB Definition.
10. Click save to finish.
© Roos Instruments Inc.

4. Left click on the desired testplan in the list to select it and click
OK to add it to the list.
5. Repeat the process to add multiple test plans to the list.
NOTE: Test plans are displayed in the DIB Calibration Executive window in the order
listed in the Calibration List.
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Edit the order of test plans in the Calibration List:
1. In the Calibration List window (see Figure 1.84) left click on a
testplan in the form and then right click and select Move Up from
the menu to change the location of the selected testplan to
precede the testplan listed above it in the list.

System Information | Device Connection Editor
3. The DIB calibration executive interface operates the same as the
TIM calibration executive. Reference the calibration procedure for
more information on using the calibration executive UI.

2. Select Move Down from the right click menu to change the
location of the selected testplan to follow the testplan listed below
it in the list.
3. Select Delete from the right click menu to remove the selected
testplan from the list.
4. Select Dev Conn > Save DIB from the window menu to save
changes to the Calibration List in the DIB Definition.

Open the DIB Calibration Executive or Diagnose Executive:
1. Attach the DIB to the fixture and perform a System Check or
System Startup to load the ‘Dut Instrument’ DIB Definition.
2. From the System Configuration window left click on the ‘Dut
Instrument’ to highlight it in the list and then right click and select
Calibration > Calibrate from the menu to open the Calibration
Executive window. Select Calibration > Diagnose to open the
Diagnostic Executive window.

© Roos Instruments Inc.
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LINK A DIB DEFINITION TO A DIB

To link a DIB ESN to a DIB Definition:

A DIB Definition is linked to the physical hardware through Guru using
a unique ID provided by an electronic serial number (ESN) chip loaded
on the PCB and connected in line with the the S/N pins on the Fixture
Carrier or FIX block. This ESN is used by Guru to identify and load
unique calibration data for each specific DIB and by extension, the
additional software resources (RF paths/pins, calibration variables,
calibration list, and graphical programming buttons) specified by the
DIB definition. Once the ESN is linked in Guru via the DIB’s calibration
object, the DIB definition resources are loaded automatically when the
DIB and Fixture is docked to the test head and a System Check or
System Startup is performed.

1. Dock the DIB to the fixture and perform a System Check.

NOTE: Device interface boards must include a unique Electronic Serial Number (ESN)
provided by a 1-Wire bus compatible electronic serial number chip on the PCB. (i.e.
Dallas Semiconductor Corp DS2401)

NOTE: If the DIB’s serial number ID has not been associated to a DIB Definition
previously, the Messages window will display a notification in red text that the serial
number is not associated with any current definitions.

2. In the System Configuration Window select Instrument > Add
DIB Def... from the menu options.
3. Choose the desired DIB definition by left clicking to highlight it in
the list and click the Select button. This will add a ‘Dut Interface’
instrument with the associated resources from the definition to the
System Configuration.
4. Left click on the ‘Dut Interface’ instrument in the System
Configuration list to highlight it and then right click and select
Calibration > Save from the menu.
CAUTION: If a DIB definition is updated in the Device Connection Editor, the
currently loaded ‘Dut Interface’ instrument (DIB Definition) must be removed from the
System Configuration and added again for the latest DIB definition to be loaded.

© Roos Instruments Inc.
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View DIB Calibration Data:
1. Dock the DIB to the fixture and perform a System Check or
System Startup to load the ‘Dut Instrument’ resource.
2. From the System Configuration window left click on the ‘Dut
Instrument’ to highlight it in the list and then right click and select
Calibration > Inspect from the menu.
3. The Inspecting Cal Table displays the calibration variables in the
left pane and the calibration data values in the right pane of
selected variables.
4. Left click on the desired calibration variable in the left pane to
highlight it in the list and then right click and select View from the
menu to display the data in a plot window.

© Roos Instruments Inc.
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FIXTURE DEFINITION
The Fixture object or Fixture Definition is accessed from the Fixture
tab and defines RF instrument resource connections between TIMs
and from TIM resources to the DIB interface signal launches. The RF
paths between instruments define the tester’s integration layer,
allowing the test system to be dynamically reconfigured by a userdefined connections. These RF paths also represent a calibration layer

INTERACTIVE 1.6 FIXTURE DEFINITION

System Information | Device Connection Editor
that is cascaded with the RF TIMs to extend scalar and vector error
correction from the TIM interface to the DIB signal launches. In
addition, the fixture provides application extension through RIFLcontrolled fixture instruments such as switches, relays, control/switch
driver modules, and specialized digital/parametric measurement
resources. The Fixture layer works in combination with the Device Pin
and DIB definitions to provide the ability to reassign Cassini instrument
button parameters and values in the graphical programming
environment with device pin naming conventions. The Fixture
definition consists of attributes and paths that are created and
modified as described in the following text.

To create a new Fixture:
1. From the menu options select Dev Conn > New Fixture...
2. In the New Fixture pop-up window fill in the attribute fields that are
listed below with their descriptions:

Fixture Paths

© Roos Instruments Inc.

Fixture Family provides a drop-down selection list of available attribute
values and allows user input values to identify a fixture design for a
range of device applications or for a particular device. It is
recommended to use a generic Fixture Family attribute value if
multiple DIB designs or a family of devices will be supported. This
attribute is used to link the Fixture and DIB layer objects in the
Device Connection Editor for mapping resources from the fixture
signal launches to the device interface board pin/port designations.
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Fixture Title is the user-specified name of the fixture. In a family of
fixtures it is used to identify a specific fixture version or application
variant.

Device Family provides a drop-down selection list of available attribute
values created in the Device layer. These link the Fixture definition to
the target Device definition.

NOTE: The Fixture Title value defaults to the Fixture Family value.

NOTE: If a Device definition is loaded, the Device Family attribute will default to the
Device layer attribute value in Fixture saves.

The Fixture Class Selection provides a list of fixture carrier board types
to define the selected hardware and software interfacing for
controlling modules, fixture power, and RIFL communication with the
fixture.
The Interface provides a drop-down list selection of PCB/firmware
versions of the chosen Fixture Class Selection value based on the
Fixture Class Selection attribute.
The 28 Volt Power option provides a ‘On’ or ‘Off’ selection box for
setting the default state of the 28V fixture power. The 28 volts is
supplied from the Cassini test head RIFL block when the fixture is
docked and checked into the System Configuration during a System
Check or System Startup. The supply is commonly used to power RF
relays in the fixture.
NOTE: The 28 Volt Power On/Off state can be set in a testplan using the Fixture 28V
button found in the Editor Panel or set manually with a Control Panel under the Tester
> state instrument settings.

The Tester selection provides a drop-down list of test system
configurations. These configurations define the available TIM
instruments and their TIM slot locations on the Cassini test head. This
attribute is used to automate the resource selection and location
menus when defining instrument connections in the Fixture Path field.
NOTE: The tester configuration is displayed in the title bar of the System Configuration
Window.

Serial Number is an automatically generated, unique alphanumeric
identification number.
NOTE: The user can input a specified value but it must be unique for each Fixture
definition.

Permission provides a drop-down list of previously created values that
can be selected or a new value can be created by clicking on the
© Roos Instruments Inc.
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New... button. The Permission attribute is shared across related
Device, DIB, and Device Control definitions (see Figure 1.75) that is
also used for category identification to narrow search results in Load
windows for these layers in the Device Connection Editor.
NOTE: The Permission attribute value of the Fixture must match the Permission values
of loaded Device, Device Pins, and DIB definitions in the Device Connection Editor.

System Information | Device Connection Editor
To modify a Fixture attribute:
1. Highlight the entry by left clicking on the desired value in the
attribute table form.
2. Right click on the selected entry and select Edit from the menu.
3. Click OK to save the changes to the Fixture attribute field.

Version is a user-defined revision number such as 1.0, 1.1, etc.

To save changes to a Fixture Definition:

Status is a drop down selection list of ‘alpha’, ‘beta’, or ‘released’
values. The ‘alpha’ and ‘beta’ values are intended for fixtures that are
in stages of development. The ‘released’ attribute value designates
that it is ready for production and makes the Fixture definition readonly.

1. From the menu options select Dev Conn > Save Fixture

NOTE: The ‘released’ attribute value prevents any further changes by disabling the Save
menu options for the Fixture definition.

3. Click OK to add the values to the Fixture attribute fields.

2. In the Save window, Version and Status attribute values can be
modified to reflect changes.
3. Click OK to complete the save.
NOTE: Each save creates a history of saved changes to the Fixture definition. Each
saved version can be viewed from the ‘History...’ button in the Load Fixture window.

To save a new Fixture Definition:
1. From the menu options select Dev Conn > Save Fixture As...
2. In the Saving New Fixture window:
The Fixture Family, Fixture Title, Serial Number, Version, and Status
can be modified by the user.

© Roos Instruments Inc.
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NOTE: The user can specify a Serial Number value but it must be unique for each
Fixture definition.

System Information | Device Connection Editor

To load a previously saved version of a Fixture Definition:
1. From the menu options select Dev Conn > Load Fixture...

The Fixture Class Selection, Interface, 28 Volt Power, Device Family,
and Tester, can be selected from the drop down list of previously
created attribute values.
The Permission can be selected from the drop down list of previously
created attribute values or a new value can be created by clicking on
the New... button.
3. Click OK to complete the save.
NOTE: A Save As creates a new history of changes thread for the Fixture definition and
does not retain the save history of the original Fixture definition.

2. Highlight the Fixture by left clicking on the desired definition in the
table form.
3. Click History... to open the Object History window.
4. Select the desired version from the list of saved Fixture definitions.
NOTE: Saving a previous version of the Fixture definition from the History creates a
new save entry with the latest save timestamp. This version becomes the default definition
on subsequent load requests.

To load a Fixture Definition:
1. From the menu options select Dev Conn > Load Fixture...
2. In the Fixture Selection window, the Device Family and Fixture
drop down list can be used to narrow the search field results by
selecting an attribute value.
3. Highlight the Fixture by left clicking on the desired definition in the
form.
4. Click OK to load the latest version of the selected definition.
© Roos Instruments Inc.
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FIXTURE DEFINITION
The Fixture tab has two table forms below the attributes field: DIB
Paths and Fixture Paths. The DIB Paths display paths in a loaded DIB
definition for reference purposes. Left clicking on the DIB Paths table
will switch to the DIB tab for modifying paths or displaying DIB
Resource Pins. The Fixture Paths define RF cable connections
between TIM instruments on the bottom plate as well as to define

System Information | Device Connection Editor
signal paths from TIM instruments to the DIB signal launches on the
fixture top plate. The RF paths between instruments define Cassini’s
integration layer to define power meter, spectrum analyzer, and vector
network analyzer virtual instruments. Signal paths from an instrument
resource to the device interface can have calibration data associated
with the path to provide scalar or vector error correction for path loss
and/or mismatch in the fixture and designate switch paths for
controlling switch states in the fixture.

FIGURE 1.85 ADD FIXTURE PATH
To add a new Fixture Path:
Fixture paths must be unique:
• State Name and Value entry pairs cannot be repeated.
• Calibration Name entries must be unique for each path.
• Switched paths from the same Fixture Pin to the same DIB/
Resource 2 (fan-out/fan-in paths) must have unique Switch
entries and State Value entries.
NOTE: A Device Pins and Fixture definition must be loaded in the Device Connection
Editor before defining DIB Paths.
1. Right click on the Fixture Path table and select Add from the
menu.

© Roos Instruments Inc.
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2. Complete the entry fields in the Adding New Fixture Path
Definition window (see Figure 1.85) for Resource 1 and Resource
Pin1 described below:

The Pin Name is the name of the resource port of the selected
instrument in the Physical Pin field as referenced in buttons in the
graphical programming environment.

Resource Name1 provides a drop-down selection list of available
instruments resources from the system configuration defined by the
Tester attribute value.

NOTE: If the selected instrument is a virtual instrument (NoiseFigure, VNA, DataSim)
or contains only a single resource, i.e. - the RecLO or Pmeter, the Resource Pin1 fields
are left blank.

The Resource Model1 is the TIM model number of the selected
instrument in the Resource Name1 field.

3. Complete the entry fields in the Adding New Fixture Path
Definition window for the DIB/Resource 2, DIB/Resource Pin2,
and Pin Name described below:

NOTE: The value is automatically selected from the entry in the Resource Name1 field
and cannot be edited.

The Resource Location is the TIM slot of the selected instrument in
the Resource Name1 field.
NOTE: The Resource Location value is automatically selected from the entry in the
Resource Name1 field as defined by the Tester attribute.

The Physical Pin provides a drop-down selection list of available
instruments resource ports for the selected instrument in the
Resource Name1 field.
The Pin Title is the name of the resource port of the selected
instrument in the Physical Pin field as shown on block diagrams.
© Roos Instruments Inc.

Resource Name2 provides a drop-down selection list of available
instruments resources from the system configuration defined by the
Tester attribute value and includes a ‘Dut Interface’ entry to designate
a resource connection to the top plate signal launches for connecting
to a DIB.
The Resource Model2 is the TIM model number of the selected
instrument in the Resource Name1 field. If ‘Dut Interface’ is selected
for the Resource Name2 field, the Resource Model2 field is left blank.
NOTE: The Resource Model2 value is automatically selected from the entry in the
Resource Name2 field and cannot be edited.

The Resource Location is the TIM slot of the selected instrument in
the Resource Name2 field. If ‘Dut Interface’ is selected for the
Resource Name2 field, the Resource Model2 field is left blank.
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NOTE: The Resource Location value is automatically selected from the entry in the
Resource Name2 field as defined by the Tester attribute.

The DIB/Resource Pin2 provides a drop-down selection list of
available instruments resource ports for the selected instrument in the
Resource Name2 field. If ‘Dut Interface’ is selected for the Resource
Name2 field, the DIBResource Pin2 field is unavailable.
The Pin Title is the name of the resource port of the selected
instrument in the Physical Pin field as shown on block diagrams. If
‘Dut Interface’ is selected for the Resource Name2 field, the DIB/
Resource Pin2 field is unavailable.
The Pin Name provides a selection box with the options ‘Create
Default Pin’ or to ‘Enter/Select Name.’ If the ‘Create Default Pin’
option is selected, the Pin Name uses the Default Name fields to
generate a unique Pin Name. If the ‘Enter/Select Name’ option is
selected, a user-defined name can be input in the Pin Name field.

System Information | Device Connection Editor
launch types. The Block Number provides a drop down selection of
launch locations on the top plate from 1 to 40. The Pin Number
provides a drop-down selection of available pins based on the Block
Type selection.
NOTE: Entries in the Pin Name fields of the Fixture definition become available in the
Fixture Pin Name drop-down selections in the DIB definition.

4. Complete the entry fields in the Adding New Fixture Path
Definition window for the Fixture Site, State, Switch and/or
Calibration Name described below:
The Fixture Site provides a user-defined site designation for repeated
device or DIB Pin Names in a multi-site application.
The State Name and Value fields are used in conjunction with the
Switch field to create a button for the graphical programming
environment that represents a switch path state. The button owner is
Fixture with the Name field being the button function and Value field
defining the button parameter. See following example:

NOTE: If the selected instrument is a virtual instrument (NoiseFigure, VNA, DataSim)
or contains only a single resource, i.e. - the RecLO or Pmeter, the DIB/Resource Pin2
fields are left blank.

The Default Name fields provide top plate signal launch information to
generate a unique Pin Name when the when ‘Create Default Pin’ is
selected. The Block Type provides a drop-down selection of signal
© Roos Instruments Inc.
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Fixture
RF3 Switch

RF3 to Pin5

System Information | Device Connection Editor
Modify a Fixture Path entry:

Owner: Fixture
State Name: RF3 Switch

1. Highlight the entry by left clicking on the desired path in the table
form.

State Value: RF3 to Pin5

2. Right click on the selected entry and select Edit from the menu.

The Switch field contains the switch control/command string
represented by the graphical button created from the State Name and
Value. The command string is dependent on the switch module and
fixture carrier type. Consult the application notes for command strings
based on the module and fixture carrier type.
The Calibration Name provides a user-defined name for associating
error correction with the designated path.
WARNING: Do not create Calibration Names for signal paths or
resource connections between TIMs. These paths are calibrated as
part of the tester’s annual system calibration.

3. Click OK to save the changes to the Fixture Path field.

Copy a Fixture Path entry:
1. Highlight the entry by left clicking on the desired definition in the
table form.
2. Right click on the selected entry and select Copy Row from the
menu.
3. Click OK to add the entry to the Fixture Path field.

The Description field provides an optional ascii input field for
documentation purposes.
5. Click OK to add the entry to the Fixture Path field.

© Roos Instruments Inc.
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FIXTURE INSTRUMENTS
A fixture instrument or multiple fixture instruments can be assigned to
a fixture definition. The firmware and software resources of these
fixture instruments are loaded when the fixture is docked and a
System Check or System Startup is performed. The fixture instrument
is added to the System Configuration and the associated buttons
and/or measurement blocks are accessible in the graphical

FIGURE 1.86 ADD FIXTURE INSTRUMENT
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programming environment through the Editor Panel in the ‘Fixture’
instrument.

To add an instrument to the fixture:
1. From the menu options select Dev Conn > Edit Instrument...
The Edit Instruments window (see Figure 1.86) is divided into two
panes. The Left pane lists all loaded fixture instruments as a
numbered list and the right pane displays information about
instruments selected in the right pane.
2. Right click in the left pane and select Add from the menu.
3. In the Instrument Selection window (see Figure 1.86) left click on
the desired instrument and click OK to add.
The right pane displays the fixture instrument information:
SN displays the uniques, alphanumeric identification number of
the fixture instrument.
Name displays the designation of the fixture instrument in the
software (System Configuration, Editor/Control Panels).
Class displays the fixture instrument model number.
moduleMap displays the location of the fixture instrument on the
fixture carrier PCB.
NOTE: Fixture instruments connect to module locations in the fixture for power and
RIFL communication.

© Roos Instruments Inc.
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4. In the right pane, left click on the moduleMap to highlight it, right
click and select Edit from the pop-up menu.
5. Select the module location from the drop-down list to match the
physical module location of the fixture instrument on the carrier
PCB and select OK to save the new location.
6. Click OK in the Editing Instruments window to save all changes.

System Information | Device Connection Editor

FIXTURE MODULES
A fixture module or multiple fixture modules can be assigned to a
fixture definition. The firmware and software resources of fixture
modules are loaded when the fixture is docked and a System Check
or System Startup is performed. Fixture modules provide signal
switching, control bits, relay/switch drivers, and mux resources that
are controlled by the Switch command values in the Fixture Path.

FIGURE 1.87 ADD FIXTURE MODULE
To remove a fixture instrument from the Fixture definition:
1. From the menu options select Dev Conn > Edit Instruments...
to access the Edit Instruments window (see Figure 1.86).
2. In the left pane, left click on the fixture instrument to highlight it,
right click and select Delete from the menu.

© Roos Instruments Inc.
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To add a module to the Fixture definition:
1. From the menu options select Dev Conn > Edit Modules...
The Edit Modules window (see Figure 1.87) is divided into two
panes. The Left pane lists all loaded Modules as a numbered list
and the right pane displays information about modules selected in
the right pane.
2. Right click in the left pane and select Add from the menu.

To remove a module from the Fixture definition:
1. From the menu options select Dev Conn > Edit Modules... to
access the Edit Modules window (see Figure 1.87).
2. In the left pane, left click on the module to highlight it, right click
and select Delete from the menu.

3. In the Module Selection window left click on the desired module
and click OK to add. The right pane will now display the module
information:
Class displays the module type.
Name displays the designation of the module in the software.
Location displays the location of the module on the fixture carrier
PCB.
NOTE: Consult the online application notes for module command strings.

4. In the right pane, left click on the Location to highlight it, right click
and select Edit from the menu.
5. Select the module location from the drop-down list to match the
physical module location on the fixture carrier PCB and select OK
to save the new location.
6. Click OK in the Editing Modules to save all changes.
© Roos Instruments Inc.
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FIXTURE CALIBRATION
When a Calibration Name is added to a Fixture Path, it creates a
calibration variable that stores the calibration data associated with the
RF path in the Fixture Definition. This extends error-corrected source
and measurement capability to the fixture. When the ‘Fixture’
instrument is added to the system configuration, all source TIM
amplitude settings and receiver measurements are relative to the

FIGURE 1.88 EDIT FIXTURE DEFAULT CALIBRATION
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calibration plane of the Fixture, i.e - a source power setting in the
software/test plan of +1dBm is reflected as +1dBm at the calibration
plane of the fixture. When any calibration variable associated with a
Fixture Path is created, it has a default data type of RiFrVs2pS
(frequency vs. 2-port s-parameter) and two data points: S11, S21,
S12, and S22 at 1kHz and S11, S21, S12, and S22 at 20GHz. By
default, the calibration data is linearly interpolated between any two
successive data points to provide error correction for any value
between the calibration endpoints.
NOTE: Calibration data that has the Spline calculation button applied is saved as a
jbSpline datatype and uses a second order polynomial interpolation to compute values
between any two successive data points.

To view the default calibration data:
1. With the Fixture tab selected in the Device Connection Editor,
select Dev Conn > Edit Default Cal... from the menu options.
The RI Default Cal window (see Figure 1.88) provides a dropdown list of calibration variables created from Fixture Paths and
unassociated calibration variables.
2. Select a calibration name from the Cal Name drop down list.
3. The Cal Type fields will display the default data type of the
selected calibration variable and display the number of data points
in the left pane with the associated values for a selected data
point in the right pane.
© Roos Instruments Inc.
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To change the default calibration data type:

To remove a data point from the default calibration:

1. With the Fixture tab selected in the Device Connection Editor,
select Dev Conn > Edit Default Cal... from the menu options to
access the RI Default Cal Window window (see Figure 1.88).

1. With the Fixture tab selected in the Device Connection Editor,
select Dev Conn > Edit Default Cal... from the menu options to
access the RI Default Cal Window (see Figure 1.88).

2. Select a calibration name from the drop down list.

2. In the left pane of the Cal Type fields right click on a datapoint to
highlight it and select Delete from the menu.

3. The Cal Type fields will display the default data type of the
selected calibration variable and display the number of data points
in the left pane with the associated values for a selected data
point in the right pane.

To add data points to the default calibration:
1. With the Fixture tab selected in the Device Connection Editor,
select Dev Conn > Edit Default Cal... from the menu options to
access the RI Default Cal Window (see Figure 1.88).
2. In the left pane of the Cal Type fields right click and select Add
from the menu.
3. In the Adding Cal Data Row window input the number of
additional data points in the ‘# of rows to add’ field and the
location of the new data points relative to the existing data points
in the ‘Starting index’ field.
4. Click OK to add.

© Roos Instruments Inc.

In addition to fixture path calibration variables, additional calibration
variables can be added to the Fixture Definition. When the Fixture
instrument is loaded into the System Configuration, these
unassociated calibration variables are available as calibration data in
test plans.
To add a calibration variable:
1. With the Fixture tab selected in the Device Connection Editor,
select Dev Conn > Edit Default Cal... from the menu options to
access the RI Default Cal Window (see Figure 1.88).
2. Click the Add New Cal Entry button.
3. In the New Cal Default window complete the fields listed below:
The Cal Name defines the new calibration variable designation.
NOTE: Calibration variable names must be unique.
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FIXTURE CALIBRATION LIST
The Cal Type field provides a drop-down list of data types to select for
the calibration variable.
The Data Size defines the number of data points in the default
calibration variable.
4. Click OK to add the calibration variable.

The Fixture Calibration List is a user-defined collection of test plans for
performing Fixture calibration, verifying the calibration results, and
Fixture-specific diagnostics. This allows the user to define specific
calibration methodologies and performance requirements for a fixture
or a class of fixtures, and easily access the list directly from the
‘Fixture’ instrument in the System Configuration window.
The following steps describe how to create Fixture-specific calibration
test plans from generic test plans and how to add these calibration
plans to the Fixture’s calibration list to run them from a specialized
calibration or diagnostic executive window accessed from the
Calibration menu when right clicking on the ‘Device Interface’
instrument.
Create fixture-specific calibration test plans:
NOTE: Calibration variables associated with RF paths must first be created in a fixture
definition and the ‘Fixture’ instrument must be loaded into the System Configuration in
order to access them in the graphical programming environment.

1. Load a fixture definition with calibration paths and/or calibration
variables into the System Configuration.
NOTE: The fixture definition can be loaded manually by selecting Instrument > Add
Fixture Def... from the menu options in the System Configuration Window or docking a
fixture with the desired fixture definition.
© Roos Instruments Inc.
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2. Create or open a new test plan.
3. Place a Cal Data input block in a test panel. Fixture calibration
data is written to the Cal Data input block in test plans. It is found
in the System > data saves of the Editor Panel. See the edit
button descriptions for more information.
4. Right click anywhere within the white space area contained by the
System box that surrounds the gray Cal Data box and select
Change Owner from the menu list.
5. From the list of available instruments in the system configuration,
select Fixture from the menu.
6. Right click anywhere within the gray Cal Data box and select Cal
Name... from the pop-up menu list.
7. Select the desired calibration variable with which to save
measurement data.
NOTE: Negative dB values are interpreted as path loss. The Cassini software will
compensate by increasing signal input values of sources in the associated path or adding
the path loss as a correction to measurements values for receive paths. Positive dB values
are interpreted as path gain. The Cassini software will compensate by decreasing signal
input values of sources in the associated path or subtracting the path gain correction
from measurements values for receive paths.

© Roos Instruments Inc.
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8. Save the test plan by selecting File > Save Cal Test > Fixture
from the menu options.
9. In the Save Fixture Calibration Testplan window an additional
Fixture attribute can be added to the testplan. From the dropdown list select the Fixture Family attribute for the desired Fixture
Definition.
10. Click save to finish.

Add a fixture calibration test plan to the Calibration List:
1. With the Fixture tab selected in the Device Connection Editor,
select Dev Conn > Edit Cal List... from the menu options.
2. In the Calibration List window right click anywhere on the
Calibration List pane and select Add from the menu to access the
Add/Edit Calibration List window.
3. In the Add/Edit Calibration List window (see Figure 1.89) select
‘calibration’ from the Type drop down list. The Testplan Selection
fields provide drop down lists for the Device Family, DIB Family,
Fixture Family, Category, and Version attributes to narrow the
search field results of displayed test plans.
NOTE: Calibration and validation test plans both use the Type: ‘calibration’ when
adding them to the Calibration List.
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4. Left click on the desired testplan in the list to select it and click
OK to add it to the Calibration List.

System Information | Device Connection Editor

FIGURE 1.89 EDIT FIXTURE CALIBRATION LIST

5. This process is repeated to add multiple calibration test plans to
the list.
NOTE: Calibration test plans are displayed in the fixture calibration executive in the
order listed in the Calibration List.

Edit the order of test plans in the Calibration List:
1. In the Calibration List window (see Figure 1.89), right click an entry
and select Move Up from the menu to change the location of the
selected testplan to precede the testplan listed above it in the list.
2. Select Move Down from the right click menu to change the
location of the selected testplan to follow the testplan listed below
it in the list.
3. Select Delete from the right click menu to remove the selected
testplan from the list.
4. Select Dev Conn > Save Fixture from the Device Connection
Editor window menu to save changes to the Calibration List in the
Fixture Definition.

© Roos Instruments Inc.
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Access the Fixture Calibration List Executive:

LINKING A FIXTURE DEFINITION TO A FIXTURE

1. Dock the fixture and perform a System Check or System Startup
to load the Fixture instrument.

A fixture definition is linked to the fixture hardware through Guru using
a unique electronic serial number chip ID. This serial number is used
by Guru to identify and recall unique calibration data for each specific
fixture and by extension, the additional software resources (RF paths,
TIM interconnections, calibration variables, calibration list, and
graphical programming buttons) in the fixture definition. Once the
serial number ID is linked in Guru, the fixture definition resources are
loaded automatically when the fixture is docked to the test head and
a System Check or System Startup is performed.

2. From the System Configuration window, left click on the Fixture to
highlight it in the list and then right click and select Calibration >
Calibrate from the menu to open the Calibration Executive.
3. The fixture Calibration Executive interface operates the same as
the TIM Calibration Executive. Reference the calibration procedure
for more information on using the calibration executive UI.

NOTE: Pod fixtures generate a unique alphanumeric ID in the fixture carrier’s onboard
programmable array logic chip.
Matrix fixtures generate a unique alphanumeric ID with an electronic serial number
chip on the fixture carrier’s PCB.
Calibration/diagnostic plates generate a unique alphanumeric ID with an electronic
serial number chip attached to the RIFL bottom plate block.

© Roos Instruments Inc.
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To program a fixture definition to a fixture:

To view fixture calibration data:

1. Dock the fixture to the test head and perform a System Check.

1. Dock the fixture and perform a System Check or System Startup
to load the Fixture instrument. The fixture RF paths and
associated calibration data are mapped to their connected TIM
instrument resources.

NOTE: If the fixture’s serial number ID has not been programmed with a Fixture
Definition previously, the Messages window will display a notification in red text that the
serial number is not associated with any current definitions.

2. In the System Configuration Window select Instrument > Add
Fixture Def... from the menu options.
3. Choose the desired fixture definition by left clicking to highlight it in
the list and click the Select button. This will add a Fixture
instrument with the associated resources from the definition to the
system configuration.
4. Left click on the Fixture instrument in the System Configuration list
to highlight it and then right click and select Calibration > Save
from the menu.
CAUTION: If a fixture definition is updated in the Device Connection Editor, a
currently loaded Fixture instrument (Fixture Definition) must be removed from the
System Configuration and checked back in for the latest fixture definition to be loaded.

© Roos Instruments Inc.

2. From the System Configuration window left click on the Fixture to
highlight it in the list and then right click and select Calibration >
Inspect from the menu.
3. The Inspecting Cal Table displays the calibration variables in the
left pane and the calibration data values in the right pane of
selected variables.
4. Left click on the desired calibration variable in the left pane to
highlight it in the list and then right click and select View from the
menu to display the data in a plot window.

NOTE: Negative dB values are interpreted as path loss. The Cassini software will
compensate by increasing signal input values of sources in the associated path or adding
the path loss as a correction to measurements values for receive paths. Positive dB values
are interpreted as path gain. The Cassini software will compensate by decreasing signal
input values of sources in the associated path or subtracting the gain values from
measurements values for receive paths.
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DEVICE CONTROL EDITOR

TOPICS

Introduction
User Interface

INTERACTIVE 1.7 DEVICE CONTROL EDITOR

Device Control Definition
DUT Instrument

Object Field

Object Tabs

Register Field
Protocol Tabs

© Roos Instruments Inc.
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INTRODUCTION
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FIGURE 1.90 ACCESSING THE DEVICE CONTROL EDITOR

The Device Control Editor creates a software object that defines the
communication protocol, register structure, and bit strings of a device
under test. This Device Control Definition is used to create protocol
aware buttons of a DUT instrument in the graphical programming
environment that represent registers or groups of registers. This
allows the user to develop and maintain device controls for a family of
similar parts or successive generations with new features, registers, or
control bits separate from the test plan development environment.
The resultant software object can then be linked to a Device Definition
to integrate the control definition with the target device under test
created in the Device Connection Editor. The following text describes:
• The Device Control Editor user interface
• How to define the digital communication protocol and register
structure
• How to link the Device Control Definition to a Device Definition

The Device Control Editor can be found in the Cassini Apps list as
shown above.

© Roos Instruments Inc.
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USER INTERFACE

System Information | Device Control Editor

FIGURE 1.91 DEVICE CONTROL EDITOR USER INTERFACE

The Device Control Editor is divided into two editable panels each
with tabs that provide their corresponding with contextual input fields,
see Figure 1.91.
The upper panel contains the Attributes and Formats tabs with values
that apply to the Device Control Definition.
The upper panel defines values that apply to all settings in the Device
Control Definition, with the descriptions below:
The Attributes tab defines the software object properties that are
used by Guru for indexed searches and linking the Device Control
Definition object to a specific device defined by the user in the Device
Connection Editor. Selecting a Device Family value created in the
Device, Device Pins, and Fixture tabs of the Device Connection
Editor, the Device Control Definition is linked to these software
objects, making the control definition available to the specified device
and fixture when used in the graphical programming environment.
The Formats tab defines the communication protocol and format of
the clock and strobe pin. The type field designates SPI, I2C, or
Parallel protocols, setting the clock/data/strobe behavior. The
remaining fields set individual pin and bit stream behavior:
The clockPolarity and strobePolarity fields set the logic states of the
clock and strobe pins relative to the data.
The direction field designates big endian (‘msbFirst’) or little endian
(‘lsbFirst’).
© Roos Instruments Inc.

The panel at the top provides information about the device with tabs
located on the right hand side. The ‘Attributes‘ tab displays information
about the control definition object: device family, status, title, and
version of the device control.

The strobeLength field sets the duration of the strobe or latch
condition during a data emit.
See Diagram 2 for details on protocol format settings.
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To create a new Device Control Definition:

System Information | Device Control Editor
NOTE: The ‘released’ value prevents changes by disabling the Save menu option.

1. From the menu options select Dev Control > New...
2. In the Create New Device Control Window, fill in the attribute fields
that are listed below with their descriptions:

3. Click OK to add the values to the attribute fields.

Title is the user-specified name of the target device. It is used for
device selection.

FIGURE 1.92 CREATING A DEVICE CONTROL DEFINITION

Format provides a drop-down selection list that defines the
communication protocol: serialStdFormat (SPI), serialGenericFormat
(generic serial), serialI2CFormat (I2C), serialI2CEmbedAdd (Embedded
I2C).
Device Family provides a drop-down selection list of available attribute
values created in the Device Connection Editor Device layer. These
link the Device Control Definition to the target device.
Permission is automatically selected by the Permission attribute
created in the Device Connection Editor for the selected Device
Family.
Version is a user-defined revision number, i.e - 1.0, 1.1, etc.
Status is a drop down selection list of ‘alpha’, ‘beta’, or ‘released’
values. The ‘alpha’ and ‘beta’ values are intended for devices that are
in stages of development. The ‘released’ attribute value designates
that it is ready for production and makes the Device Control Definition
read-only.
© Roos Instruments Inc.

Under the Dev Control menu, select ‘New...’ to create and define a
Device Control Definition. ‘Load...’ allows the user to view and edit an
existing Device Control Definition.
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To save changes to a Device Control Definition:

To load a Device Control Definition:

1. From the menu options select Dev Control > Save

1. From the menu options select Dev Control > Load...

2. In the Save window, Version and Status attribute values can be
modified to reflect changes.

2. In the Device Control Selection window, the Device Family and
Device Pins attribute value drop down list can be used to narrow
the search field.

3. Click OK to complete the save.
NOTE: Each save creates a history of saved changes of the Device Control Definition.
The saved versions can be viewed from the History button in the Load Device Control
window.

3. Highlight the device control by left clicking on the desired
definition in the table form.
4. Click OK to load the latest version of the selected control
definition.

To save a new Device Control Definition:
1. From the menu options select Dev Control > Save As...
2. In the Save As window:
The Title, Version, and Status can be modified by the user.
A new Device Pins Family and Device Pins can be selected from
the drop down list of previously created attribute values.
The Permission attribute is inherited from the currently active
Device Control Definition and cannot be modified.
3. Click OK to complete the save.

To load a previously saved version of a control definition:
1. Highlight the device control by left clicking on the desired
definition in the table form.
2. Click History... to open the Object History window.
3. Select the desired version from the list of saved Device Control
Definitions.
4. Click OK to load the selected control definition.

NOTE: A ‘Save As’ creates a new history of changes thread and does not retain the save
history of the original Device Control Definition.

© Roos Instruments Inc.
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DEVICE CONTROL DEFINITION

To add a Serial Register:

The lower panel of the window provides an editable table of the
register definitions and tabs that provide contextual input fields. These
allow the user to define the number and structure of the register/s
with the different protocol tabs described below:

1. Right click on the table form.

The Serial Register tab defines a register or multiple registers in a
device:

2. Select Add from the pop-up menu.
3. Fill in the Name, Size (number of bits in register), Format, and
Priority fields.
4. Select OK to add the new register entry.

The Name column identifies an individual register or bank.
The Size column denotes the number of bits in the corresponding
register bank.

To modify a Serial Register:

The Format column defines the protocol type.

1. Left click on the register of interest in the table row
to highlight it.

The Priority column defines the order in which the register bank is
emitted during a register write command. A lower number signifies a
higher priority, i.e. - a register with a Priority value of 0 will be emitted
before a register with a Priority value of 1.
The Attributes column allows for additional compiler directive
parameters of the register such as: time cost, settling time, pre/post
measure behavior, and read only status.

2. Right click on the highlighted register.
3. Select Modify from the menu.

To delete a Serial Register:
1. Left click on the register of interest in the table row
to highlight it.
2. Right click on the highlighted register.
3. Select Delete from the menu.

© Roos Instruments Inc.
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FIGURE 1.93 DEFINING A SERIAL REGISTER

System Information | Device Control Editor
The Serial Field tab defines a bit or group of bits within a selected
register. These bit definitions are used to create a protocol-aware
button in the graphical programming environment that represents the
bit settings/state with a user-defined name and parameters as shown
in Figure 1.94 and described below:
The Name defines the function or segment of bits in the register.
The Size defines the number of bits associated with the bit segment
starting with the bit location defined by the First Bit Loc. field.
The Register provides a drop-down list of available registers created in
the Serial Register tab to define the register field structure.
The First Bit Loc. field denotes the location of the first bit in a bit
segment referenced by the direction field in the Formats tab setting
(MSB first or LSB first).

Right click on the spreadsheet to add, edit, copy, delete, and sort

NOTE: ‘msbFirst’ denotes the most significant bit as bit location 1 in the Serial Field
first bit location. ‘lsbFirst’ denotes the least significant bit as location 1 in the Serial Field
first bit location.

registers.

The Type field defines the graphical button representation of the bits in
the test plan editor and the type of button interaction (see Figure 1.94
for an example):
‘State’ creates a drop-down list button with user-defined names and
associated bit values to select. When this option is selected, the State
field below the Type drop-down selection is used to define the name
© Roos Instruments Inc.
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of the state(shown in the button used in the graphical programming
environment) and the corresponding bits for the state.
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FIGURE 1.94 DEFINING A SERIAL FIELD

‘Integer’ creates a button with an integer type input corresponding to
the associated bits. Reference button types for more information.
‘Constant’ sets the bit or bits to a fixed value.
NOTE: A ‘Constant‘ type does not create a button in the graphical programming
environment since it is a fixed value. If a visible constant button is desired, a ‘State’ type
with a single value can be used to represent the button.

The Default field sets the initial state or bit value of the button. This is
the “idle” state value of the button in the Edit Panel.
The resulting protocol-aware button has an owner of ‘Dut’ with the
Name field defining the button function, the Value field defining the
button parameter, and the Type field defining the button type. See the
following example based on the values in Figure 1.94:

Right click on the Serial Field table to add, edit, copy, delete, and sort
Serial Field parameters.

Dut
ST0_VCO_DIV_Ratio

1

Register: ST0
Name: ST0_VCO_DIV_RATIO
Type: Integer
Default: 1

© Roos Instruments Inc.
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To add a Serial Field:
1. Select the desired register to add a serial field from the Register
drop-down box.
2. Right click on the table form.
3. Select Add from the pop-up menu.
4. Fill in the Name, Size (number of bits in field), Register, First Bit
Loc. (1st bit location relative to the direction value in the
Formats), and Type fields
5. Select OK to add the new register entry.

System Information | Device Control Editor
3. Select Delete from the menu.

The Compound Field tab defines a group of Serial Fields within a
register or multiple registers and their bit settings. This allows for
multiple register writes and serial bit fields to be expressed as a single
button within the graphical programming environment. The compound
register is specified with a user-defined Name and bit/serial registers
parameters as shown in Figure 1.95 and described below:
The Name is a user-specified description or function of the group of
serial fields.
The Dependents field list the serial fields defined by the Compound
Field.

To modify a Serial Field:
1. Left click on the serial field in the table row to modify.
2. Right click on the highlighted field.
3. Select Modify from the menu.

To delete a Serial Field:
1. Left click on the field of interest in the table row
to highlight it.

The Data field list the serial field values of the specified Dependents.
The resulting protocol-aware compound field button has an owner of
‘Dut’ with the Name field defining the button function and
representing the serial fields and the Data field defining the button
value and representing the serial field values. See the following
example based on the values in Figure 1.95:
Dut
Test_Setup

Meas_1

Name: Test_Setup
Name: ST0_CP_SEL, ST1_NUMFRAC_DIV,
ST1_RF1_DIVSEL
Default: Meas_1

2. Right click on the highlighted register.
© Roos Instruments Inc.
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FIGURE 1.95 DEFINING A COMPOUND FIELD
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To add a Compound Field:
1. Right click on the Compound Field table form.
2. Select Add from the pop-up menu.
3. In the Adding New Serial Compound Field window, fill in the
values for the Name, Dependents, Data, and Default inputs.
To add Dependents:
1. Right click in the field and select Add from the pop-up menu.
2. In the New Dependent window select a Serial Field from the
drop down list of previously defined values.
3. Click OK to add the Serial Field to the Dependents list.
4. Repeat steps to add multiple Serial Fields.
To add Data entries:

Right click on the spreadsheet to add, edit, copy, delete, and sort
Compound Fields.

1. Right click in the Data field and select Add from the pop-up
menu.
2. In the Adding Data window, left click on the Value field next to
the desired Data field to add a value
NOTE: The Data field value must match the entry Type and available values of the
Serial Field.

© Roos Instruments Inc.
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4. Select OK in the Adding New Serial Compound Field to add the
new compound field entry.

The Parallel tab defines one or more device pins as a parallel port
group to create a protocol-aware button in the graphical programming
environment. The button has a user-defined name or function that
represents the bit settings/state of the parallel port with the port bit
mapping defined by a Device Pins Definition created in the Device
Connection Editor.

To modify a Compound Field:

NOTE: The Parallel communication protocol requires a devicePins family attribute be
added to the Device Control Definition that targets a Device Pins definition for
mapping the parallel bit resources.

3. Click OK in the Adding Data window to update the Data values
in the Adding New Serial Compound Field window.
4. Repeat steps to add multiple Data field entries.

1. Left click on the compound field in the table row to modify.
2. Right click on the highlighted field.

To add a device pins family attribute to a parallel protocol:

3. Select Modify from the menu.

1. In the Attributes tab, right click on the field and select ‘Add’ from
the menu.

To delete a Compound Field:
1. Left click on the compound field in the table row to modify.
2. Right click on the highlighted field.
3. Select Delete from the menu.

© Roos Instruments Inc.

2. In the Adding Port Attribute Window, select ‘devicePins family’ in
the Name drop down list.
3. Select the desired device pins from the Value drop down list and
click OK to add the device.
NOTE: The ‘device family’ attribute of the Device Control Definition must match the
‘device family’ attribute of the Device Pin Definition/object created in the Device
Connection Editor.
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4. Select Dev Control > Save from the menu options to update the
Device Control Definition with the new attribute.

2. In the Editing Pins Map Data window left click on the Value drop
down list to choose a resource from the Device Pin definition.

To create a parallel pin definition:

3. Click OK to complete the changes.

1. Right click on the table form.
2. Select Add from the pop-up menu.
3. In the Adding Parallel Port window complete the fields shown in
Figure 1.96 and described below:
The Name field provides a user-defined designation of the parallel
pins.
The Size field denotes the number of bits that represent the parallel
port.
NOTE: The Pin Mapping is inactive until the Size field is specified.
The Pin Mapping form displays a table view of the parallel bit
mapping. The number of Port Bit/Device Pins fields are defined by the
Size field and default to the first device pins available in the Device
Pins definition.
To modify a Port Bit/Device Pins field:
1. Left click on the desired Port Bit/Device Pins field to highlight it,
then right click and select Edit from the menu.

© Roos Instruments Inc.

The Type field defines the graphical button interaction that will
represent the bit values on the parallel port for a given operation:
‘State’ creates a drop-down list button with user-defined names and
associated bit values to select. When this option is selected, the State
field below the Type drop-down selection is used to define the name
of the state (shown in the button used in the graphical programming
environment) and the corresponding bits for the state.
‘Integer’ creates a button with an integer type input button
corresponding to the associated bits. Reference button types for
more information.
4. Select OK to add the parallel control entry.

To Modify a parallel pin definition:
1. Left click on the parallel control of interest in the table form
to highlight it.
2. Right click on the highlighted register and select ‘Modify’ from the
menu.
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FIGURE 1.96 PARALLEL COMMUNICATION DEFINITION
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EXAMPLE A PARALLEL COMMUNICATION DEFINITION

The above example shows the parallel control definition and
corresponding Device Pins definition required from the Device
Connection Editor.

The parallel port name and size are defined by the user, with the port
bit mapping options selected from the Device Pins definition.

© Roos Instruments Inc.
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The Burst tab defines a bitstream to be emitted as a single packet or
burst in a test plan using the Serial Data button found in the Dpins
instrument of the RI8535: Universal Digital TIM or in the Static Digital
instrument of the RI8546: Device Power/Measure TIM. Burst types are
typically used to define a device mode a DUT with multiple register
writes for a test condition setup. It is also used with pointer/address,
or conditional register structures where successive register field writes
are dependent or conditional on previous register field writes.

System Information | Device Control Editor
define the bit stream in the Value field.
When used with the Type Value: ‘Generic R/W’ selection, the user can
input multiple arbitrary binary bitstream values. This is useful for
importing large excel and/or .csv register map commands by rightclicking on the Burst field and selecting ‘Import From CSV without
header’ from the menu.
NOTE: The ‘Export to CSV without header’ option can be used to generate the .csv
import template.

NOTE: Serial Burst device control commands can be used in conjunction with the
protocol-aware Serial Field button device control commands in test plans.

To create a Burst definition:
1. Right click on the table form and select ‘Add’ from the pop-up
menu.
2. In the Adding New Burst window complete the fields shown in
Figure 1.97 and described below:
The Name value provides a user-defined designation of the burst
command.

The ‘command’ option is used to define a user comment in the burst
that is ignored in the bit stream by setting the Type Value to the
‘/’ (forward slash character) and the comment in the Value field as
shown in Figure 1.97.
The ‘field’ option allows the user to select a previously defined Serial
Field within a Serial Register in the Type Value field. The bit stream is
defined in the Value field using the Type style of the selected Serial
Field: decimal or state values.
When used with the Type Value: ‘Generic R/W’ selection, the user can
input the binary value for the selected Serial Field.

The Type Name, Type Value, and Value values provide different
options for defining the burst bitstream:

The ‘pause’ defines a specified delay within the burst by setting the
Value to desired value in units of microseconds. The Type Value field is
ignored.

The ‘register’ option allows the user to select a Serial Register from
the list of previously created registers in the Type Value field and to

3. Click OK to save changes.

© Roos Instruments Inc.
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FIGURE 1.97 DEFINING A BURST COMMAND
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To modify a Burst definition:
1. Left click on the desired field to highlight it then right click and
select ‘Edit’ from the pop-up menu.
2. Click OK to save changes.

Using a Burst command in a test plan:
Burst commands are invoked in test plans using the Serial Data
button (of a Dpins instrument in the RI8535 or the Static Digital
instrument in the RI8546) within a premeasure group in a test panel.
The command ‘burst:[Name value]’ is input in the Serial Data button
to emit all bit/register values with the same Name in burst command
in the order they are listed in the burst pattern. Using the burst
command in Figure 1.97 as an example, the value ‘burst:Test516’ in
the Serial Data button as shown below would emit six, 16-bit serial
commands sequentially in the order listed in the burst definition.
The burst command name and parameters are defined by the user as
shown in the above example.

© Roos Instruments Inc.

Dpins1
Serial Data
burst:Test516
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FIGURE 1.98 IMPORT BURST COMMAND FROM .CSV

The above example shows the .csv format for importing burst
commands.

© Roos Instruments Inc.
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DUT INSTRUMENT

System Information | Device Control Editor

GALLERY 1 ADDING A DUT INSTRUMENT

The DUT (Device Under Test) instrument is a virtual instrument created
in the Device Control Editor. This “virtual instrument” provides
protocol-aware device control with graphical buttons in the Edit Panel
for use in test plans. The underlying bit emits, register structure, and
communication protocol are displayed as command/control buttons
with user-defined naming conventions for better readability and code
maintenance. They are also available in the Control Panel for
interactively controlling the DUT register settings at a breakpoint.
Reference Figure 1.90, Figure 1.91, and Figure 1.94 on how to create
a DUT virtual instrument.

ADD A DEVICE TO THE SYSTEM CONFIGURATION
To activate a Device Control Definition for use in test plans, a ‘Dut’
instrument must be added as a virtual instrument to the System
Configuration.

From an open test plan, select the ‘Tester’ menu and ‘Change DUT
control...’ from the list to add or change a DUT instrument.

© Roos Instruments Inc.
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To add a device (see Gallery 1):
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EXAMPLE B USING DUT CONTROL BUTTONS

NOTE: A target device must be created in the Device Connection Editor before a DUT
instrument can be created and used in a test plan. When creating a new Device Control
Definition, the ‘Device Family’ field drop down list selection in the Device Control
Editor must match the ‘Device Family’ of the user’s Device and Device Pins.

1. From the Main System Window, select ‘Test’ > ‘Devices...’ from the
menu options.
2. Left mouse click on the desired device in= the Activate Device
window and click the Activate.

After the DUT virtual instrument has been added, a ‘DUT’ instrument
appears in the list of instruments available in the Edit Panel. The middle
pane provides windows with 20 buttons in each for all of the protocolaware controls. Selecting a button from the lower pane provides
information about the button’s bit parameters in the upper right pane.

© Roos Instruments Inc.
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2

The Graphical Programming
Chapter provides general
information about:
•Test Plan Development
Environment
•Test Design
•Button/Measurement
Block Functions & Use

SECTION 1

INTRODUCTION
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TOPICS

Overview
State Machine Compiler
Synapse - Automated Test Optimizer
Graphical Programming User Interface
Disconnect Settings & Connect Sequence
Test Program Defaults
Test Sections & Panels
Conditional Statements
Instrument Buttons & Measurement Blocks
Grouping Buttons & Group Types
© Roos Instruments Inc.
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OVERVIEW
Cassini was designed from the ground up to have a more
comprehensive interaction of hardware and software. Using a statebased approach in the software, the measurement functions and
instrument commands operate on the physical resources within the
tester at a hardware-state level. What this means for a user on Cassini
is that the programming interface and workflow reflect this statebased method when it comes to developing measurement algorithms
and building test plans. The object-oriented programming language
used to control the instruments is represented in a graphical
programming environment, with instrument buttons and blocks that
can be connected to control instrument states, and define arithmetic
functions or measurements. The library of available instrument buttons
and measurement blocks are available in the Edit Panel. These
programming resources are dynamically created by the test system
from test instrument modules connected to Cassini’s test head or
added by a user in the simulator. The graphical state-flow abstraction
simplifies test plan design with more efficient coding and faster
deployment of new instrument and measurement programming
elements when compared to traditional ATE programming. The
following text provides a brief introduction to the state machine
compiler, and graphical programming UI on the Cassini test system
followed by instrument button and block descriptions, uses, and
examples.

© Roos Instruments Inc.

GALLERY 1 CASSINI GRAPHICAL TEST DEVELOPMENT ENVIRONMENT

Global Defaults Example

STATE MACHINE COMPILER
Using the instrument state construct, the compiler translates
instrument settings and measurement functions of each test panel in
the test program into ‘instrument test states’. These states are used
to generate a real-time, finite state machine that drives the hardware.
Coupled with onboard FPGA based processing in the
instrumentation, this enables distributed processing with several key
advantages:
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1. Real-time signal processing and measurements
2. Absolute instrument/measurement timing and lock-step
synchronicity across instruments
3. No processor lags or interrupts from the system computer during
test execution since the state machine operates independent of
the system controller.
4. Ability to execute real-time instrument state halts of the test
system at measurements states with active hardware for in-situ
debugging of test programs with interactive instrument and
measurement control.

SYNAPSE - AUTOMATED TEST OPTIMIZER
Synapse is a built-in state optimizer designed to address the two main
challenges with test program design:
1.) Create test run-time code that eliminates redundant or superfluous
instrument calls
2.) Create compiled code that executes the fastest and with the
highest efficiency for any given hardware setup on the tester.
The optimizer uses the hardware state information of the test objects
to analyze the program execution behavior and identify measurements
that use shared hardware states to combine or run tasks concurrently
in the hardware. As well, the optimizer has access to instrument state
transition timing information, i.e - instrument switching and settling
times. It uses this information to perform a time cost analysis
© Roos Instruments Inc.

optimization to determine the optimum measurement order for the
fastest execution. Lastly the optimizer removes redundant or
superfluous test states, virtually eliminating unintentional and/or
unessential test code.
In addition to the automated test program optimization, the user can
view the code execution order, and control how and where
optimization can be applied:
• Individual tests and measurement can be isolated from the optimizer
• Groups of sequential measurements can be excluded
• The optimizer can be completely disabled
As well, a comprehensive breakdown of the test program can be
viewed through the Delta Settings panel as shown in Example A. This
provides test duration information including: instrument setup times,
measurement computation, and overall test program time. To access
the delta settings, compile an open test plan and select select
‘Options’> ‘Display Delta Settings’ from the menu option at the top of
the test plan.

USER INTERFACE
The test design environment provides both views and user control of
test flow organization and test design, see Gallery 1. The user
interface window is divided into two sections. In the top pane is a
view of the test program flow divided into different programming
sections. By default this view contains the “Test Plan Settings” which
contains a global default, disconnect settings, and connect sequence
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section. The user can add a test section by right clicking within this
pane and choosing “Add Test Section” from the selection menu. This
test flow view allows the user to control and organize their test plans
in a linear flow convention. Selecting or left clicking on any of the test
flow sections on in the top pane will display the button or block
contents contained within the selected section in the pane on the
bottom of the UI. The bottom pane is the test design canvas for
placing the graphical instrument control buttons and measurement
blocks from the library contained in the Edit Panel.
To Create a New Test Plan:
1. From the Main System Window, select Test > Plans from the
menu options.
2. In the Select Testplan window, left click on the new button to
open a blank test plan.
To Save a Test Plan:
1. From an open test plan window, select File > Save Guru from
the menu options.
2. The Save Testplan window provides a Title field at the bottom for
the test plan name and four attribute fields: Type, Device, Version,
and Category that allow the user to add user-specified attributes
to the saved test plans or select from the available attributes in the
drop down list. These attributes are used to link the test plan to
specific device and user permissions as well as providing guru
search indexes when accessing the test plan.
© Roos Instruments Inc.

NOTE: No attribute field can be left blank on an initial save.

To Access a Test Plan:
1. From the Main System Window, select Test > Plans from the
menu options.
2. The Select Testplan window provides a scrollable list of all
available test plans on the local test system and guru server (if
available). The drop-down attribute fields: Type, Device, Version,
and Category allow the user to narrow the list of displayed test
plans based on the selected values.
3. Left click on the desired testplan to highlight it and click on the
Select button.
NOTE: A status window will indicate that the test plan is loading. The window will
close automatically once the test program has opened. Loading time can vary depending
on the locality of the test plan, i.e. - test plans saved on the local hard drive load faster
than test plans fetched from the guru server. Guru server response time is set by the IT/
network administrator.
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EXAMPLE A DELTA SETTINGS

The above figure is the delta settings of a compiled test program. The
left pane shows the order test panels are executed in the test program.
Selecting a test panel displays the hardware setup time, instrument
settling time, estimated and actual execution time of all measurements
in the panel. The Deltas section below the timing information displays

Graphical Programming | Introduction
disconnecting from a device under test (DUT). The Disconnect
Settings section allows the user to define application-specific resource
pin, port settings, and instrument states (that may differ from the test
systems default settings or user’s global defaults) before the first
device under test is placed in the socket and to define the state the
tester’s instrument pin or port settings return to at the end of a test
program before the DUT is removed from the socket. This is the state
the system enters first, before the DUT is inserted and before the DUT
is removed.
The connect sequence is a specialized section that defines a userspecific order in which resource pins, port settings and/or instrument
states are set at the onset of testing. The sequencing executes
instrument state buttons in the lower pane following a left-to-right
convention for first-to-last order sequencing. The leading edge of
placed edit button in this panel defines the left-to-right sequence.
NOTE: The values or settings of a button placed in the Connect Sequence panel is
ignored because by default the test optimizer can select the initial instrument conditions
for the first test to improve test time unless otherwise specified by the user.

the order of instrument state changes in the panel.

DISCONNECT SETTINGS/CONNECT SEQUENCE
The Disconnect Settings and Connect Sequence sections (see
images 1 and 2 of Gallery 1) are used strictly for designating the test
system’s default states before a test program starts, at the end of a
test program, and the sequencing of these states when connecting or
© Roos Instruments Inc.

GLOBAL DEFAULTS AND SECTION DEFAULTS
The programming environment has a tiered structure of system,
global, section, and panel window defaults to help the user organize
and maintain complex test plans and measurements. The System
Defaults are essentially the test systems default idle or “safe” state for
all the attached instruments. These are subsequently the default
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values displayed in the Edit Panel for all of the attached instruments.
The Global Defaults section allows the user to define the default
instrument state settings that will hold true for the entire test program
by placing state buttons in the lower pane. Section Defaults are
located in every Test Section, allowing the user to define instrument
state settings that will hold true for all test panels with the test section
by placing state buttons in the lower pane. Instrument state buttons
can also be placed in the test panel to apply the parameter settings
for only the measurements contained therein.
The default hierarchy is enforced explicitly in the test program with the
highest priority given to buttons placed in the test panel and the
lowest given to the system default settings, i.e - a button placed in a
test panel will override the button default placed in the test section,
global, or system defaults in that order. This default hierarchy is also
enforced implicitly in the test program, i.e - when a button state is not
defined in a panel, the compiler will default to the value of the button
placed in the section default. If the button is not in the section default,
the setting will defer to the global default settings. If the button is not
placed in the global defaults, the button setting for the test panel will
default to the system default settings. This default hierarchy structure
gives the user the flexibility to exert control over several
measurements or to individual measurements.
NOTE: State buttons used within the Global Defaults and Section Defaults panels do
not follow a sequencing convention. The sequence is controlled by the compiler. Within
test panels, the instrument state buttons are executed first, followed by premeasure
groups, measurement or function blocks, and finally postmeasure groups.
© Roos Instruments Inc.
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TEST SECTIONS & TEST PANELS
Test sections provide a test flow convention and organization for the
user’s test program, see image 4 of Gallery 1. The user can add a test
panel by right clicking on a highlighted Test Section and choosing
Add Test or Add Test State from the selection menu. Measurements
are designed by placing instrument state buttons and measurement
or function blocks in the test panel sections. The programmer
connects blocks by drawing lines to create algorithmic flow. The lines
propagate each block’s object attribute information to the connected
block to relay data, function, and calling conventions. This allows the
compiler to automatically manage data type flow, measurement unit
handling, and advanced multi-instrument measurement (virtual
instrument) functions for the user. The graphical approach also allows
programmers to build test programs and measurement flows by
dropping instrument state buttons that represent instrument control
states and interconnect measurement or arithmetic element blocks
from edit panel library to create algorithmic flow.

CONDITIONAL STATEMENTS
The Conditional Statements section allows the user to insert control
statements that can modify or alter the test program flow during run
time, i.e - skip all tests in a test section or abort the test program. The
logic statements are defined by the System buttons found in the ‘Flow
Control’ panel of the Editor: abortIfTrue, abortIfFalse, skipIfTrue,
skipIfFalse, PromptIfFalse, and Prompt. The first four button types
when placed in the Conditional Statements section check the true/
false status of conditional flag defined by the user via the Set Flag
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input block. If the conditional flag status matches the button/s in the
conditional section, the test program flow is altered accordingly. See
the Flow Control edit panel button descriptions in Section 11 RI8574: System Controller (EPC) for more information.
Conditional Statement panels are located at the beginning of every
test section, allowing the user to apply the test program flow changes
to all test panels/measurements contained therein.

SYMBOL TABLE
The symbol table allows the user to define integer values and pointer
names for use as button values in the graphical programming
environment. The symbol file can be defined as a table associated
with the test program or as an external text file, separate from the test
program, that is requested at runtime. The symbol table can be
viewed, modified, and/or saved in an open test plan by selecting the
Options menu and the corresponding menu choice listed below:

Options > Remove Symbol Table - prompts the user with an option
to delete the symbol table associated with the current test plan.
Options > Display Symbols - displays all symbols in the symbol
table and
NOTE: Symbol values are limited to integer values and integer value input buttons.

MEASUREMENT BLOCK AND BUTTON
CONVENTIONS

Options > Edit Symbol Table - opens the Edit Symbol Table
Window to view and edit the symbol names and their corresponding
values.

There are two types of coding elements used to build graphical test
programs: state buttons and function blocks. Both contain object
oriented attributes and conventions that relay data, function, and
calling conventions to the compiler. When function or measurement
blocks’ input/outputs are linked, the software can identify intrinsic
characteristics of upstream and downstream interconnected blocks in
the algorithm flow. This allows the test builder system to check
continuity of variable type, data conversion, and unit of measurement
as well as automate advanced multi-instrument measurement
functions. At the top left of every block or button is the ‘Owner’
attribute. The owner ties the block or button object to its’ associated
instrument.

Options > Save Symbol Table - saves the symbol table values and
prompts the user for a symbol file name.

NOTE: All buttons and blocks must contain an owner. Test Plans that contain buttons
and blocks without owners or misidentified owners will fail to compile.

Options > Load Symbol Table - prompts the user to choose a
symbol table to be associated with the current test plan from all of the
available symbol files in Guru.

© Roos Instruments Inc.
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Within the block at the top left corner is the ‘Function’ attribute that
defines the control or operation task. Depending on the type of button
or block, the function may denote a measurement, instrument
resource or operation. Within the function area are user-editable fields
such as variable name, a list of options, or numerical entry.

TYPES OF BUTTONS AND MEASUREMENT BLOCKS

NOTE: Buttons or Measurement blocks highlighted in red within a test panel denote the
associated instrument is not present or active in the test system. Test Plans with these
buttons or blocks will not compile unless the instrument is activated, the test panel or test
section is de-activated, or the buttons or blocks are removed.

RFSource1
Frequency

Examples and descriptions of the four common button or block types
found in the edit panel are given below.

2400

Owner: RFSource1
Function: Frequency
Parameter: 2400 (user defined in
units of MHz)

State Button
Defines an instrument or device setting. These programming elements
are used to create a defined instrument or device state within a test
panel. They are most commonly used in conjunction with
measurement blocks and are executed before any measurement
functions are executed within a test panel. Left clicking on the
parameter region of a state button will display the input/value options.
NOTE: ‘Enter Value’ dialogs allow SI units in the input field (G=Giga, Meg=Mega, k =
kilo, etc.) Most parameters are displayed in standard SI units in the default value (volts,
seconds, dBm, etc.). Frequency values without an SI unit in the default are in units of
MHz.

© Roos Instruments Inc.
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RFSource1
Sample Rate

The three types of standard state buttons are shown below:

25ns

RFSource1
Frequency

999

Drop-Down List
Integer value
Integer value buttons prompt the user for a numerical input value. If
the numerical value exceeds the instrument’s minimum or maximum
range settings, the value is set to the closest acceptable set value at
program compile. The input prompt is accessed by left clicking within
the parameter field of the state button.

Dpins1
Serial Data

Text String
Text string buttons prompt the user for an ASCII input value. The input
prompt is accessed by left clicking within the parameter field of the
state button.

© Roos Instruments Inc.

The drop-down list button provides a list of selectable settings. The
drop-down list is accessed by left clicking within the parameter field of
the state button.

RFSource1
Frequency

Freq_1

Owner: RFSource1
Function: Frequency
Parameter: Freq_1 (user-defined
local variable in units of MHz)

State Button set from Local Variable
Defines an integer value button type that is set by a user-defined local
variable that is dynamically generated during test program runtime.
The parameter field is color coded yellow to indicate the value is being
set by a local variable. The local variable is created using the Local
Var, Local Var Put or Var Prompt input buttons found in the System
instrument.
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NOTE: Local Variable button values are not available in the Delta Settings or in a
Control Panel at a test program breakpoint because the value is generated at program
run time.

Receiver
Measure

Power

Owner: Receiver
A

Function: Measure
Parameter: Power

RFSource1
Frequency

Freq_2

Owner: RFSource1
Function: Frequency

Output Measurement block

State Button set from Symbol

These blocks are designated with a gray region within the
measurement name and provide an output value from an instrument.
The black box with “A” denotes the instrument’s measurement output
that can be connected to a variable or calculation block.

Defines an integer value button type with a user-defined symbol. The
parameter field is color coded green to indicate the value is being set
by a symbol. Symbols can be created in the test program using the
Set Symbol input button found in the System instrument, by defining
the values in a symbol table, or from an external text file.

System
Calc
A

Parameter: Freq_2 (user-defined
symbol in units of MHz)

calc
B

Owner: System
Function: Calc (Calculation)
A

Parameter: calc (a menu list of operations for 2 input, single output calculation are accessed by left clicking the center of the button)

Calculation or Function Measurement block
Calculation or function blocks are designated with a gray region within
the Function area. These blocks provide one, two, or three inputs on
the left side of the block designated by red squares with “A”, “B”, and
© Roos Instruments Inc.
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“C.” The output on the right side of the block is designated with an
“A” in a black square. Algorithmic flow is designed by stringing
together multiple blocks with a left-to-right flow convention to denote
execution order.

System
Local Var
A

X

Owner: System
Function: Local Var (Local Variable)
Parameter: X (user-defined variable
name)

ADDING BUTTONS & MEASUREMENT BLOCKS
Edit panel buttons can be added to test programs by holding the Ctrl
key and left mouse button clicking the button to select it. The button
is inserted into a test panel by holding the Ctrl key and left mouse
button clicking anywhere on the background of the panel to paste it.
This can be repeated to paste multiple instances of the button. When
finished, hold the Ctrl key and left mouse button click on the button
selected earlier in the edit panel to unselect it. Selecting multiple
buttons within an edit panel will allow the user to paste all the selected
buttons as a group within a panel. To move the pasted group of
buttons individually within a test panel they must first be ungrouped.

Input Measurement block

CONNECTING MEASUREMENT BLOCKS

Variables are denoted with a gray region within the Function area and
provide an input designated with a red square on the left side of the
block. There are two types of variables available: local variables and
data saves. Local variables are used for temporary data storage,
typically for use between test panels in multistage measurements or
multiple step algorithms. Local variable data is discarded at the end of
a test plan’s execution.

Dpins1
Meas

Data saves store variable information for data logs, final test results,
and data reporting and are saved at the end of a Test Plan.

© Roos Instruments Inc.

Precision Voltage A

calc
Dpins1
Instr State Source

Vhigh

System
Local Var

System
Calc
A

A
A

X

B

A

Measurement and algorithmic flow are created by linking function
blocks in the test program’s graphical environment. Calculation and
logic functions provide connection anchors to accommodate block
connections. Inputs are denoted by red squares on the left side of the
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function block and outputs are denoted by black squares on the right
side of function blocks. Multiple input operands are designated with
an “A”, “B”, “C” within the red squares. This convention encourages a
left-to-right logic flow design that aids in function comprehension and
code maintenance.

To disconnect blocks:

To connect blocks:

2. Drag the crosshair cursor and connection line to the origin of the
input or output anchor (black or red square) of interest on the
associated block to remove the connection.

1. Right click and hold the center of the block to move and organize
blocks of interest relative to one another following the output to
input convention of left-to-right
2. To connect an input anchor to and output anchor, right mouse
button click and hold within the black/red square of either block of
interest.

1. Right mouse button click and hold within the black or red square
of either connected blocks of interest. The cursor will change from
an arrow to crosshairs to confirm the port selection.

GROUPING & UNGROUPING
RFSource1
Frequency

2400
RFSource1
Power

NOTE: The cursor will change from an arrow to crosshairs to confirm the port
selection.

3. Drag the crosshair cursor and connection line to the input/output
anchor (black/red square) of interest on the associated block,
either direction works.
4. Release the right mouse button to complete the connection.
5. Multiple output anchor connections can be made to different
function block input anchors

Receiver
Measure

Power

A

-20

A button group is denoted by a “grouping box” that surrounds
buttons and/or blocks as shown in the example above. Grouped
elements can be moved or pasted as a set. Selecting multiple buttons
and/or blocks in an edit panel and pasting them in a test panel will
automatically group the buttons as a set and provide a shared owner
to the grouping box. Button/blocks with different button owners
(example above) can be grouped with an arbitrary grouping box to
help organize, move and paste them as a set.

6. Input anchors (red) support only one connection per site.
© Roos Instruments Inc.
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To group a set of buttons together:

2. From the menu list select ‘Contract’.

1. Select the buttons of interest by holding the Ctrl key and left
clicking anywhere inside the intended blocks/buttons to select
them.

3. A pop-up prompt will allow the user to name the button or input/
output block representing the collapsed group. Type a name and
select ‘OK’.

2. Right click on one of the selected buttons to view menu options.

NOTE: The buttons and/or blocks must be grouped with a grouping box.

3. Select ‘Group Selected’ to bring up the grouping options.
4. From the grouping options, select ‘Group’ to place an arbitrary
grouping box around the buttons/blocks.

The box must be expanded to view or change buttons within a
contracted group.

5. The elements can now be selected and/or moved as a single set.

To expand a contracted group:

Buttons within a group can be separated by right clicking on the
background of the grouping box and selecting ‘Ungroup’ from the
menu. The ungrouped buttons can be individually moved or
reorganized.

4. Right click on the contacted button/block and select ‘Settings...’
from the menu.
5. From the menu list select ‘Expand’

Contracting/Expanding Grouped Buttons:
A grouped set of buttons can be collapsed to form a single button.
This can be used to reduce the number of buttons in a panel or
complex algorithms that use multiple interconnected calculation and
input/output blocks.
To contract grouped button and/or blocks:
1. Right click on the background of the grouping box and selecting
‘Settings...’ from the menu.
© Roos Instruments Inc.
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Measure Sequence
RFSource1
Frequency

2400

Receiver
Measure

Measure
RFSource1
Frequency

2400
RFSource1
Power

System
Sequence Delay

A

1000

Receiver
Measure

Power

Power

A

-20

Measure groups are used in test panels to associate a button setting
or multiple button settings with a single measurement. This group
type is typically used in test panels with multiple measurements to
associate a particular set of button states with a measurement.
To create a Measure Group:
1. Select the buttons of interest by holding the Ctrl key and left
clicking anywhere inside the intended blocks/buttons to select
them.
2. Right click on one of the selected buttons to view menu options.
3. Select ‘Group Selected’ to bring up the grouping options.

RFSource1
Power

-20

Measure Sequences, much like Measure groups, are used in test
panels to associate a button setting or multiple button settings with a
measurement. Measure sequences include control of the order in
which the button settings are executed and can include multiple
measurements in the Measure Sequence grouping. Button settings
and measurement blocks are executed from left to right as they are
placed in the test panel, using the left edge of the state buttons as the
indicator of location. In the provided example, The RFSource1
Frequency setting is set to 2.4GHz, then the test system pauses for
1ms (Sequence Delay), then RFSource1’s signal power is set to
-20dB. This group type is typically used in test panels to define multistep measurements or multiple measurements that require a specific
order of operation.

4. From the grouping options, select ‘Measure’ to place the Measure
grouping box around the buttons/blocks.

© Roos Instruments Inc.
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To create a Measure Sequence Group:
1. Select the buttons of interest by holding the Ctrl key and left
clicking anywhere inside the intended blocks/buttons to select
them.
2. Right click on one of the selected buttons to view menu options.
3. Select ‘Group Selected’ to bring up the grouping options.
4. From the grouping options, select ‘Measure Sequence’ to place
an the Measure Sequence grouping box around the buttons/
blocks.

Graphical Programming | Introduction

PRE MEASURE & POST MEASURE GROUPS
Pre Measure and Post Measure groups are used in test panels to
define a sequence of button settings that occur directly before or after
every measurement. Buttons placed within Pre Measure and Post
Measure groups are executed from left to right as they are placed in
the test panel, using the left edge of the state buttons as the indicator
of location. If multiple measurement blocks are placed in the same
test panel with Pre/Post Measure groups, the buttons within the Pre
Measure are executed prior to each measurement, and the Post
Measure is executed after each measurement, i.e - if there are 4
measurement blocks, the Pre/Post Measure buttons will be executed
4 times. Pre Measure and Post Measure groups enforce an explicit
execution command to the compiler that overrides the test optimizer,
meaning that repeated and/or redundant button state settings will be
executed.
NOTE: Only state buttons (no measurement or calculation blocks) can be placed in Pre
Measure and Post Measure groups. If Pre/Post Measure groups are placed in the section
defaults, the button settings will be executed before every measurement in every test panel
within the test section.

© Roos Instruments Inc.
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To create a Pre Measure or Post Measure Groups:
1. Select the buttons of interest by holding the Ctrl key and left
clicking anywhere inside the intended blocks/buttons to select
them.
2. Right click on one of the selected buttons to view menu options.
3. Select ‘Group Selected’ to bring up the grouping options.
4. From the grouping options, select ‘Pre Measure’ or ‘Post
Measure’ to place the corresponding grouping box around the
buttons/blocks.
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LOCK STEP GROUPS
Lock Step groups are a button grouping used to link two sweep/
range indices or two list indices in a fixed execution order. The lock
step group is a compiler directive that overrides the test program
optimizer, allowing the user to define the execution order of a specific
instrument parameter in a sweep. This is typically used to control the
order of operations of two or more instrument button parameter
sweeps/lists or to create a user-defined index order for an instrument
sweep for plots or datalog saves when used in conjunction with the
Index, Inner Loop, or Outer Loop System buttons (reference the
System Edit button descriptions for more information).
NOTE: Only instrument sweeps, ranges, lists, inner/outer loop, or Index buttons are
permitted within the Lock Step group (no measurement or calculation blocks).

NOTE: The index size of the range, i.e - the number of indices, of the instrument button
pairs used in the loops must match.

NOTE: The leftmost button range/sweep parameter within the Lock Step group defines
the measurement index in datalog saves and plots.

© Roos Instruments Inc.
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To create Lock Step Groups:
1. Select the buttons of interest by holding the Ctrl key and left
clicking anywhere inside the intended blocks/buttons to select
them.
2. Right click on one of the selected buttons to view menu options.
3. Select ‘Group Selected’ to bring up the grouping options.
4. From the grouping options, select ‘Lock Step’ to place the Lock
Step grouping box around the buttons.
NOTE: For a Lock Step with a large number of indices, the buttons within a Lock Step
group can be converted into a table of values.

Graphical Programming | Introduction

COMBINED GROUPS
Combined groups is a button grouping used for digital communication
applications such as SPI, Parallel, or I2C using the protocol aware
DUT instrument. This group type is used to force several device
buttons to be executed as a single emit. This is typically used with SPI
communication protocols to read or write to multiple registers using a
single strobe period versus writing to each register with multiple writes
and strobes.
To create a Combined Group:

To create a table of values:

1. Select the buttons of interest by holding the Ctrl key and left
clicking anywhere inside the intended blocks/buttons to select
them.

• Right click within the Lock Step grouping box, and choose “make CSV” from the
pop-up menu.

2. Right click on one of the selected buttons to view menu options.

• Right click within the Lock Step grouping box, select “edit CSV” from the pop-up
menu to open the table edit window.
Only the first button state is required for each button in the group.

© Roos Instruments Inc.

3. Select ‘Group Selected’ to bring up the grouping options.
4. From the grouping options, select ‘Combined’ to place the
Combined grouping box around the buttons.
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TOPICS

Instruments Provided by this TIM
Test Head Location Information
Configuration Panel
Instrument Diagram with Edit Buttons
Edit Panel Button Descriptions
Control Panel
Tap the links above to quickly access content.

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM

TIM LOCATION

The instrument in this TIM appear as Source1, Source2, Source3
and RecLO in the panel dialog windows. This instrument can also be
used as the Local Oscillator (L.O.) for the system’s Receiver.

The RI7725 used in located in the Auxiliary Rack and uses an auxiliary
rack TIM, also referred to as a Remote TIM, to route resources to the
test head. Remote TIMs are typically placed closest to the Auxiliary
Rack (slots T1, T2, T15, T16). In a typical application, the source
resources are routed, via RF semi-rigid interconnect cables, on the
fixture bottom plate or interface plate to Test Set and/or Receiver
TIMs.

Model and Name as it appears in the Tester Configuration:
• Source1, RI7725x .01 - 20 GHz Rf source
NOTE: The “1” in Source1 represents the enumeration of the RI7725 in the system
configuration. Multiple RI7725 instruments are enumerated incrementally by the system
as “1”,“2”,“3”, etc., in the configuration, edit, and control panels (i.e - Source1, Source2,
Source3, etc.). This instrument is named RecLo when used as a Local Oscillator for the
system’s Receiver. The “x” in RI7725x denotes the model revision number.

© Roos Instruments Inc.

NOTE: Always calibrate the named paths after any changes to the layout (bend) in the
cables from the Source through the AUX Rack’s Remote TIM to maintain maximum
signal fidelity.
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C ONFIGURATION P ANELS 1 RI7725 CONFIGURATION PANEL

View connection settings for the Source1 instrument.

SOURCE1
The Source1 instrument provides one setting in the configuration
panel: RF outputA with only “none” as an option.

Source# configuration panel shows “none” as only connection
option since the Device Connection Editor is now used to define
connections.

© Roos Instruments Inc.
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I NSTRUMENT B UTTON D IAGRAM 2.1
Roos Instruments, Inc.

Block Diagram, 20 GHz Source TIM
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EDIT PANEL
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STATE PANEL

The catalog of control buttons for this TIM to be use when building
automated Test Programs. Each “Source#” instrument includes
control of it’s frequency and power etc.

Frequency

999
Frequency

E DIT P ANELS 1 RI7725 EDIT PANEL

A decimal notation input button that sets the Phase Locked Source
Output Frequency in units of MHz with 1 Hz resolution.
Power

0
Power
A decimal notation input button with units of dBm that sets the
Source RF Power, taking into account all the current path losses, to
deliver the desired power at the device. The hardware minimum
resolution is 0.1 dBm and the actual dynamic range is a combination
of the maximum available power and the current path losses including
any step attenuator value. ALC dynamic range is typically <35 dB.
Rf State

oﬀ
Rf State
Source# edit panel only includes “state” buttons.

© Roos Instruments Inc.

A drop down list button that in the “off” state sets the RF Output
Power control ALC section to the lowest value (typical Range is >35
dB), but depending on the desired output power commanded, the
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Source Step Attenuator setting, and fixture losses, etc., the amount of
available range may vary.
NOTE: Check to see how much power is being delivered to the device in the “off” state
and if it could be an issue, to completely remove the sources signal contribution, the test
developer should switch the Rf signal to an unused path in the Test Head, or Fixture etc.
Select one of the solid state switches if possible since anything mechanical has a finite life
time.

Freq Offset

0
Freq Oﬀset
A decimal notation input button that adjusts the generators final stage
Phase Lock Loop’s post lock output frequency within its ±10 MHz
range, used for fast short Frequency moves.
Fast Settle

0
Fast Settle

A drop down list button that adjust the settling time of a frequency
change to either Phase Stable (the default “off” position) or Amplitude
only stable (“on” position). Settings this button to “on” reduces
frequency change times by more than 60%.

© Roos Instruments Inc.
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C ONTROL P ANELS 1 RI7725 CONTROL PANEL

The catalog of real-time control buttons for this RF Source TIM that
produces a phase locked 10 MHz up to 20 GHz sine wave signal
connected through an AUX rack to a special “Rack Connection” TIM
that exposes the standard RF Ports and provides control.
Along with the realtime control buttons that look and operate the
same functions as in the edit panels, an information only display
button grouping provides a window into what the actual source
parameters are set to independent of any system wide frequency
offsets or path loss power corrections. This is extremely valuable
when debugging the entire Tester, Test Fixture and Device Interface
Board path.

Source# control panel to change states and see power correction.

© Roos Instruments Inc.
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RI8508: RF MODULATED
SOURCE
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TOPICS

Instruments Provided by this TIM
Configuration Panels
Instrument Diagram with Edit Buttons
Edit Panel Button Descriptions
Control Panel
Tap the links above to quickly access content.

© Roos Instruments Inc.

224

Cassini ATE System Reference Guide

Graphical Programming | RI8508: RF Modulated Source

INSTRUMENTS PROVIDED BY THIS TIM
The subset instruments in this TIM appear as QamSource1 and
RFSource1 in the panel dialog windows.
Model and Name as it appears in the Tester Configuration:
• QAMSource1, Ri74212x QAM Generator
• RFSource1, RI8508x .1 - 6GHz Rf Source
NOTE: Multiple RI8508 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - RFsource1,
QAMSource1; RFsource2, QAMSource2 ; RFSource3, QAMSource3 ; etc). The “x” in
RI8508x denotes the model revision number.

© Roos Instruments Inc.
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QAMSOURCE1

The configuration panel displays the resource port mapping of the
QamSource and RfSource instruments and loaded waveforms in the
RI8508’s on-board FPGAs.

The QamSource instrument provides three settings in the
configuration panel: Edit Waveforms, Aux Out and Output. The green
Output button defines the instrument resource connection defined by
a fixture.

C ONFIGURATION P ANELS 2 RI8508 CONFIGURATION PANELS

NOTE: “Output” can only be defined by a fixture definition.

EDIT WAVEFORMS
This button displays the current waveform/pattern loaded into the
QamSource’s arbitrary waveform generator. A left-button click on the
button opens the Edit QamSource Patterns window (See Figure 2.1).
The left pane of the Edit Patterns window displays a list of all
waveforms that have been loaded into the instruments on-board
memory. Selecting any of these waveforms with a left-mouse button
displays more information in the right pane: start address in memory,
number of samples, sample clock rate, peak magnitude, RMS
magnitude in dB, and information about the original waveform file
from Guru. New waveforms can be added to the list by selecting
Pattern > add from Guru from the menu options. The user can then
select a waveform from Guru and specify additional information.
QamSource1 configurations including waveform and output
configurations.

© Roos Instruments Inc.
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NOTE: Waveforms are programmed into memory sequentially. While waveforms can be
removed from the list view by selecting them and using the menu option “Pattern >
remove,” they are not erased from the memory. To make used memory available again,
all waveforms must be purged using the “Pattern > Erase > All Patterns” menu option.

RFSOURCE1

AUX OUT

NOTE: “Output1” and “Output2” can only be defined by a fixture definition.

The RfSource instrument provides five user settings in the
configuration panel: Edit Patterns, aux In, Aux In, Output2, and
Output1. The green Output2 and Output1 buttons define resource
connections to the fixture.

This drop down list button selects the TIM’s internal resource routing
to the auxiliary port. This selection will define the resource available at
this port when using a state button within a test program or panel.
Example
From :

QamSource1-Internal RF output- internal:
base name: AuxOut
type: internal

To :

RFSource1-Internal RF input
base name: AuxIn

Path :

QamSource1-Internal RF Output- internal:
RfSource1-Internal RF input

© Roos Instruments Inc.
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EDIT PATTERNS
This button displays the current waveform/pattern loaded into the
RfSource’s complex baseband I/Q modulator. A left mouse click on
the button opens the Edit Patterns window as shown in Figure 2.1.
The left pane of the Edit Patterns window displays a list of all
waveforms that have been loaded into the instruments on-board
memory. Selecting any of these waveforms with a left-mouse button
displays more information in the right pane: start address in memory,

number of samples, sample clock rate, peak magnitude, RMS
magnitude in dB, and information about the original waveform file
from Guru. New waveforms can be added to the list by selecting
Pattern > add from Guru from the menu options. The user can then
select a waveform from Guru and specify additional information.
NOTE: Waveforms are programmed into memory sequentially. While waveforms can be
removed from the list view by selecting them and using the menu option “Pattern >
remove”, they are not erased from the memory. To make used memory available again,
all waveforms must be purged using the “Pattern > Erase > All Patterns” menu option.

FIGURE 2.1 EDIT PATTERNS DIALOG

aux In
This drop down list selection button allows the user to select from
predetermined routing built into the source. These connections are
managed by the user by making sure both ends of a desired path are
selected when use in a test plan.
An example is show below:
Path:

RFSource1-aux In - Internal RF input
base name: auxIn

Aux In
This drop down list selection button allows the user to select from
predetermined routing built into the source. These connections are
managed by the user by making sure both ends of a desired path are
selected when use in the pest plan.
© Roos Instruments Inc.
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An example is show below:
From :

RFSource1-Internal RF input
base name: AuxIn

To :

QamSource1-Internal
RF output- internal:
base name: AuxOut
type: internal

Path :

RfSource1-Internal
RF input: QamSource1-Internal
RF Output- internal

NOTE: The ‘aux In’ and ‘Aux In’ resource configurations of the RfSource instrument
are managed automatically in Cassini 16 ATE systems, but must be defined by the user
in a testplan when using the Small Cassini ATE systems.

© Roos Instruments Inc.
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I NSTRUMENT B UTTON D IAGRAM 2.2
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EDIT PANELS
The RI8508 edit panel or editor window provides instrument function
blocks and state buttons for QamSource1 and RfSource1. These
button and blocks, used in Cassini’s graphical test programming
environment, are defined in the following text.

QAMSOURCE1
QamSource1 contains CW Control, Basic Modulation and modulation
subsystem panels.

CW CONTROL EDIT PANEL

E DIT P ANELS 2 RI8508: QAMSOURCE EDIT PANELS
Frequency

100

Frequency

A decimal notation input button in units of that sets the QamSource
signal frequency. The valid input range is 100 to 400 (100MHz to
400MHz) in 1 Hz steps.
Power

0

Power
A decimal notation input button in units of dBm that set the desired
power at the device. The valid range of values is -60 to 10 (+10 dBm
to > -60 dBm.
QamSource1 buttons used for Continuous Wave (CW) controls in a
Test Panel.
© Roos Instruments Inc.
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Rf State

oﬀ

Rf State
A drop down list button that sets the output power level control of the
QamSource instrument.

The ‘on’ state modulates the internal arbitrary waveform generator
with the main signal output.
The ‘off’ state disconnects the internal arbitrary waveform generator
from the main signal output.
Source Output Mode

Output 1

The ‘off’ state sets the power level control to the highest attenuation
value of ~60 dB.

Source Output Mode

The ‘on’ state sets the power level control to the lowest attenuation
value of ~0 dB.

A drop down list button that routes signal from the QamSource
between the output ports.

NOTE: The amount of attenuation in the ‘off’ state is dependent on the signal level set
by the Power button, i.e. if the Power button is set to +10 dBm then the Rf State ‘off’
value will be ~60 dB lower = -50dBm; If the Power button is set to -50 dBm, the Rf
State ‘off” would only be ~10 dB lower (-60dB). To completely remove the source signal
contribution, the test plan should switch the source signal to an unused path in the TIM
or Fixture, avoiding mechanical switching which have a finite lifetime due to wear.

The ‘Output 1’ selections routes signal out of the Output1 (C5) port.
The ‘Output 2’ selections routes signal out of the Output2 (C1) port.
The “Aux” selection routes signal to the Low Freq Output (C6) port.

Modulation

oﬀ

Modulation
A drop down list button that modulates the QamSource carrier tone
set by the Frequency and Power buttons.

© Roos Instruments Inc.
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BASIC MODULATION EDIT PANEL

Type

None
Max Samples

1000

Type

Max Samples

A drop down list button that selects a modulation type from built-in
waveforms.

An integer value button that sets the number of desired samples per
computed waveform. The maximum number of samples is 4000.

The ‘none’ selection is the default value for no modulation type
selected.

Mod Frequency

100000
Mod Frequency
A decimal notation input button that sets the QamSource modulation
frequency in units of Hz.
Mod Index

1.0

The ‘Quad’ selection generates two sine waves that are 90o phase
coherent at a frequency set by the Mod Frequency button. It is
modulated onto the carrier signal set by the Frequency and Power
buttons.
The ‘File’ selection uses a waveform file selected by the Waveform
File button. It is modulated onto the carrier signal set by the
Frequency and Power buttons.
The ‘Pattern’ selection uses a modulation waveform selected by the
Pattern button. It is modulated onto the carrier signal set by the
Frequency and Power buttons.

Mod Index
A decimal notation input button that sets the ratio of the excursions of
the modulated signal to the signal level of the unmodulated carrier in
the time domain.

The ‘Modulation’ selection generates a modulation set by the buttons
in the ‘modulation’ Editor Panel: Modulation Type, Data Rate, Data
Bits, Prn Type, and Preamble Bits. It is modulated onto the carrier
signal set by the Frequency and Power buttons.
The ‘FM Tone’ selection generates a single frequency (tone)
modulation. The toned (single frequency) modulating signal consists

© Roos Instruments Inc.
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of only one frequency component set by the Mod Frequency button
and is modulated onto the carrier signal set by the Frequency and
Power buttons.
The ‘FM Stereo’ selection generates an FM modulated signal with a
left (L) and right (R) channel encoded as sum (L+R) and difference
(L−R) signals set by the Mod Frequency button, onto the carrier set
by the Frequency and Power buttons.
The FM Stereo Left selection generates the FM Stereo signal with only
the left channel encoded onto the carrier. The modulation frequency is
set by the Mod Frequency button with the carrier set by the
Frequency and Power buttons.
Interpolation

20

Interpolation
A decimal notation input button that sets the data interpolation of the
modulation signal.
250 MHz
, where 3.0 ≤ x ≤ 63.0.
NOTE: The interpolation sample rate is
x

Mode

run

Mode
Drop down list button that controls the pattern or waveform emit from
the QamSource instrument.
The ‘run’ value is used in global or section defaults or within a test
panel to initiate a waveform.
The ‘stop’ value is used in global or section defaults or within a test
panel to cease a waveform.
The ‘pmStart’ value is used to trigger a burst of the waveform with a
precision start time designated by the user within a test panel using a
pre-measure sequence grouping.
The ‘pmStop’ value is used to trigger the end of a waveform burst
with a precision stop time designated by the user within a test panel
using a post-measure sequence grouping.
The ‘trigger’ value is used to start a waveform burst with a pre-set
start time of 0 and is terminated by the user within a test panel using
a ‘pmStop’ in the post-measure sequence grouping.
NOTE: ‘pmStart” and ‘pmStop’ must be used together within a test panel for the desired
result of syncing the waveform with an event or user start time.

© Roos Instruments Inc.
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Pattern

MODULATION EDIT PANEL

none

Pattern

Filter

A drop down list button that selects the name of the desired pattern
from the instrument’s preloaded internal memory.
Waveform File

none

Waveform File

None

Filter
A drop down list button that selects a digital filter type to be applied to
the waveform. Built-in types include: “Raised Cosine”, “Gaussian”,
“GMSK”, or a user-defined filter type provided with the Filter File
button.

Drop down list button that selects a waveform from the preloaded
user-defined waveforms on the instrument.

Filter Shape

0.0

Filter Shape
A decimal notation input button that sets the Filter Shape Factor.
NOTE: This button is dependent on the filter type defined with the Filter button.

Filter Bw

1.0

Filter Bw
A decimal notation input button that sets the desired ratio of the
selected digital filter’s bandwidth to the symbol bandwidth.
© Roos Instruments Inc.

235

Graphical Programming | RI8508: RF Modulated Source

Cassini ATE System Reference Guide
Filter Taps

Filter File

5.0

none

Filter Taps

Filter File

A drop down list button that selects the file name of a user-defined
digital filter taps or coefficients file.

A drop down list button that selects the file name of a user-defined
digital filter taps or coefficients file.

Data Bits

Prn Type

100

PN7

Data Bits

Prn Type

An integer value button that sets the number of data symbols per
record.

A drop down list button that selects the size of the pseudo random
number seed used in the sequence generator. i.e “PN5”, “PN7”,
“PN9” etc.

Data Rate
Data Delay

100000

0

Data Rate
A decimal notation input button that sets the output data rate in
symbols per second.
Modulation Type

Data Delay
A decimal notation input button that sets a delay of the output
modulation in units of seconds. It is used in conjunction with the
Mode: ‘pmStart’ button setting.

none

Modulation Type
A drop down list button that selects the type of base modulation to
generate. i.e “8PSK” or 8-Symbol Phase Shift Keying

© Roos Instruments Inc.
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Preamble Bits

0

Preamble Bits
An integer value button that sets the number of alternating “1’s” and
“0’s” output at the beginning of a waveform.

© Roos Instruments Inc.
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RFSOURCE1

SOURCE STATE EDIT PANEL

RfSource1 contains Source State, waveform and modulation panels.

Src Mode

E DIT P ANELS 3 RI8508: RFSOURCE EDIT PANELS

A drop down list button that enables continuous wave or pulsed
operation.
‘cw’ is the default value and provides continuous wave operation.
‘pulse’ value enables a pulsed or burst RF mode. In this setting, the
Src Seq button controls the on/off state of the pulsed signal output.

Src Seq
A drop down list button that controls the on/off state of a pulsed RF
signal by controlling the state of an internal relay with microsecond
switching speed. It is used in conjunction with the Src Mode button
with the ‘pulse’ button setting.
NOTE: The button must be placed in a pre-measure or post-measure group to control
the RF on or off pulse setting.
RfSource1 buttons used for basic source state control including
frequency and power.

© Roos Instruments Inc.

‘pulse on’ connects the internal relay to the source’s output port
specified by the Source Output Mode button with the frequency and
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power parameters defined by the Frequency and Power button
settings.

Rf State

oﬀ

‘pulse off’ disconnects the source from the output port to create the
off setting.

Rf State

NOTE: The “pulse off” setting of the relay provides approximately -40 dB of isolation/
attenuation of the Power button setting to create the pulse off condition.

A drop down list button that sets the output power level control of the
RfSource instrument.
The ‘off’ state sets the power level control to the highest attenuation
value of ~60 dB.

Frequency

999

Frequency
A decimal notation input button that sets the RfSource center
frequency in units of MHz. The valid input range is 1 to 6000 (1MHz to
6GHz) in 1 Hz steps.
Power

The ‘on’ state sets the power level control to the lowest attenuation
value of ~0 dB.
NOTE: The amount of attenuation in the ‘off’ state is dependent on the signal level set
by the Power button, i.e. if the Power button is set to +10 dBm then the Rf State ‘off’
value will be ~60 dB lower = -50dBm; If the Power button is set to -50 dBm, the Rf
State ‘off” would only be ~10 dB lower (-60dB). To completely remove the source signal
contribution, the test plan should switch the source signal to an unused path in the TIM
or Fixture, avoiding mechanical switching which have a finite lifetime due to wear.

0

Power
A decimal notation input button in units of dBm that sets the RF
power. The valid input range is -60 to 10 (- 60dBm to +10dBm) in
0.1dB steps.

© Roos Instruments Inc.
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Source 1 Attn

The “Aux” selection routes signal to the Low Freq Output (C6) port.

0db

Modulation

Source 1 Attn

oﬀ

A drop down list button that provides an option for connecting a
calibrated 40 dB attenuator internally to the RF source output path for
increased low-end dynamic signal range.
Source 1 Amp

oﬀ

Source 1 Amp
A drop down list button that in the “on” state connects an internal
20dB gain amplifier into the output path. The linear amplification range
is between 400 MHz to 6 GHz. This button is used to boost the highend dynamic signal range, typically used for Power button settings
request of greater than +7dBm.

Modulation
A drop down list button that modulates the Rfsource carrier tone set
by the Frequency and Power buttons.
The ‘on’ state modulates the internal arbitrary waveform generator
with the main signal output.
The ‘off’ state disconnects the internal arbitrary waveform generator
from the main signal output.

Source Output Mode

Output 1
Source Output Mode
A drop down list button that routes signal from the RfSource
instrument between the output ports.
The ‘Output 1’ selections routes signal out of the Output1 (C5) port.
The ‘Output 2’ selections routes signal out of the Output2 (C1) port.
© Roos Instruments Inc.
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WAVEFORM EDIT PANEL

Amplitude Balance

1
I_ Amplitude

1

I_ Amplitude
A decimal notation input button in units of volts that sets the peak
voltage for the in-phase component of the output waveform. Range is
0 V to 3 V peak.
I_ Offset

1

I_ Offset

Amplitude Balance
A decimal notation input button that sets the gain ratio between the
in-phase and quadrature waveforms.
Q_ Amplitude

1

Q_ Amplitude
A decimal notation input button in units of volts that sets the peak
voltage for the quadrature component of the out put waveform.
Range is 0 V to 3 V peak.

A decimal notation input button in units of volts that sets the DC offset
voltage for the in-phase component of the waveform. Range is ±3 V.

Q_ Offset

1

Q_ Offsets

NOTE: Output waveform + DC offset cannot exceed 3 volts.

I_ Phase

0

A decimal notation input button in units of volts that sets the DC offset
voltage for the quadrature component of the waveform.
Range is ± 3 V.
NOTE: Output waveform + DC offset cannot exceed 3 volts.

I_ Phase
A decimal notation input button in units of degrees that sets the
phase delay of the in-phase component of the waveform.
© Roos Instruments Inc.

241

Graphical Programming | RI8508: RF Modulated Source

Cassini ATE System Reference Guide
Q_ Phase

Max Samples

0

1

Q_ Phase

Max Samples

A decimal notation input button in units of degrees that sets the
phase delay of the quadrature component of the waveform.

An integer value button that sets the maximum number of samples
per waveform.

Phase Balance

0

NOTE: “Max Samples” only applies to non Waveform or Pattern type signal files.
Maximum number of samples is 4000.

Phase Balance
A decimal notation input button that sets the phase ratio between the
in-phase and quadrature waveforms.
Sample Rate

25ns

Sample Rate
A drop down list button that sets the waveform data point output rate.
Data point output sample rates options are “1 μsec”, “100 nSec”, “50
nSec”, “31.25 nSec”, “25 nSec”, and “12.5 nSec” corresponding to
“1 MHz”, “10 MHz”, “20 MHz”, “32 MHz”, “40 MHz”, and “80 MHz”
respectively.
NOTE: Waveform data point sample rates must comply with one of these listed sample
rates. “Pattern” files have a maximum sample rate of “31.25 nSec” or “32 MHz.”

© Roos Instruments Inc.

Mod Frequency

100000

Mod Frequency
A decimal notation input button that sets the modulation frequency for
the built-in standard waveform types. This frequency is converted to
the data rate.
Type

none

Type
A drop down list button that selects from the built-in modulation
waveform standards: “Tone”, “Quad”, “Sine”, “Quad Mod Test”, and
“Square Wave”. “File” and “Pattern” instructs the compiler to use a
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user-defined modulations from either a supplied file, or one-built with
buttons from the Modulation builder.

The ‘pmStart’ value is used to trigger a burst of the waveform with a
precision start time designated by the user within a test panel using a
pre-measure sequence grouping.

Waveform File

none

Waveform File
A drop down list button that selects a waveform from a pre-loaded file
at run time.
Pattern

none

Pattern

The ‘pmStop’ value is used to trigger the end of a waveform burst
with a precision stop time designated by the user within a test panel
using a post-measure sequence grouping.
The ‘trigger’ value is used to start a waveform burst with a pre-set
start time of 0 and is terminated by the user within a test panel using
a ‘pmStop’ in the post-measure sequence grouping.
NOTE: ‘pmStart” and ‘pmStop’ must be used together within a test panel for the desired
result of syncing the waveform with an event or user start time.

A drop down list button that selects the name of a user-defined
pattern loaded into internal memory.
Mode

run

Mode
Drop down list button that controls the pattern or waveform emit from
the RfSource instrument.
The ‘run’ value is used in global or section defaults or within a test
panel to initiate a waveform.
The ‘stop’ value is used in global or section defaults or within a test
panel to cease a waveform.
© Roos Instruments Inc.
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MODULATION EDIT PANEL

Mod Index

1.0
Filter

none

Filter
A drop down list button that selects a digital filter type to be applied to
the waveform. Built-in types include: “Raised Cosine”, “Gaussian”,
“GMSK”, or a user-defined filter type provided with the FilterFile
button.
Filter Bw

1.0

Mod Index
A decimal notation input button that sets the ratio of the excursions of
the modulated signal to the level of the unmodulated carrier.
Data Bits

100

Data Bits
Decimal notation input button that sets the number of data points per
record.
Data Rate

Filter Bw
A decimal notation input button that sets the ratio of the selected
filter’s bandwidth with the symbol bandwidth.
Filter Taps

100000

Data Rate
Decimal notation input button that sets the output data sample rate.

5.0

Modulation Type

none

Filter Taps
Decimal notation input button that sets the total number of digital filter
coefficients.

© Roos Instruments Inc.

Modulation Type
A drop down list button that selects a modulation from the built-in
standards: “Ran FSK” - Random Frequency Shift Keying, “8PSK” - 8
Symbol Phase Shift Keying, “Edge”, “QPSK” Quadrature Phase Shift
Keying, “FM Tone”, and “AM Tone”
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Filter File

none

Filter File
A drop down list button that selects the file name of a user-defined
digital filter. The filter coefficients should be normalized to unity gain.
Prn Type

PN7

Prn Type
A drop down list button that selects the size of the pseudo random
number seed used in the sequence generator. i.e “PN5”, “PN7”,
“PN9”, etc.
Data Delay

0

Data Delay
A decimal notation input button that sets a delay of the output
modulation in units of seconds. It is used in conjunction with the
Mode: ‘pmStart’ button setting.

© Roos Instruments Inc.
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CONTROL PANELS

instruments at a breakpoint within a running test plan or
measurement.

The control panel provides a direct view and control of RI8508
instrument settings much like the view and controls of bench-top
equipment. This panel is also used for in-situ view and control of the

QAMSOURCE1

C ONTROL P ANELS 2 RI8508 CONTROL PANELS

QamSource1 contains CW Control, Basic Modulation and modulation
panels.

BASIC MODULATION CONTROL PANEL
This panel provides the ability to control the modulation waveform
voltage and delay (phase) independently to the in-phase and
quadrature component signals of the modulator.

I_ Amplitude
A decimal notation input button in units of volts that sets the peak
voltage for the in-phase component of the output waveform. Nominal
is 1 Volt.

I_ Offset
A decimal notation input button in units of volts that sets the DC offset
voltage for the in-phase component of the waveform.

I_ Phase
QamSource1 provides real-time interaction with the continuous wave
(CW) buttons.

© Roos Instruments Inc.

A decimal notation input button in units of degrees that sets the
phase delay of the in-phase component of the waveform.
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Q_ Amplitude
A decimal notation input button in units of volts that sets the peak
voltage for the quadrature component of the output waveform.
Nominal is 1 Volt.

Graphical Programming | RI8508: RF Modulated Source

RFSOURCE1
RfSource1 contains RF Control, waveform and modulation panels.

RF CONTROL PANEL

Q_ Offset

An information only display button grouping is provided.

A decimal notation input button in units of volts that sets the DC offset
voltage for the quadrature component of the waveform.

RfSource1 Group

Q_ Phase

This group provides a view of the actual internal RfSource parameters
settings, independent of any system wide frequency offsets or path
loss power corrections.

A decimal notation input button in units of degrees that sets the
phase delay of the quadrature component of the waveform.

NOTE: This view is useful when debugging the entire Tester, Test Fixture and Device
Interface Board path.

WAVEFORM CONTROL PANEL
Offset Frequency
A decimal notation input button in units of Hz that offsets the
Frequency of the waveform output.
NOTE: Amplitude values and offsets for the in-phase and quadrature voltages and phase
must be set in the test plan/program. There is no real-time control available for these
settings.

© Roos Instruments Inc.
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TOPICS

Instruments Provided by this TIM
Configuration Panels
Edit Panel Button Descriptions
Control Panel
Tap the links above to quickly access content.

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
This TIM provides digital pins in banks of 20 up to a possible 120 in a
single TIM. The instruments in this TIM appear as DPins1, DPins2, ...
DPins6 in the panel dialog windows. Additional TIMs appear as
DPins1_#, where the “#” represents the 2nd, 3rd, etc... TIM.
Model and Name as it appears in the Tester Configuration:
• Dpins1, Ri8535x Cassini Digital D1
NOTE: The “x” in the model number denotes the revision of the instrument. If there are
more than one digital TIM in the configuration, then an underscore followed by an
enumeration is appended to the Owner Name, i.e - DPins1_2, DPins2_2, etc.
The number of pin cards in a Digital TIM are as listed below:
RI8535B2 - 20 pin model
RI8535B1 - 40 pin model
RI8535B0 - 80 pin model

© Roos Instruments Inc.
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CONFIGURATION PANELS
The configuration panel displays the number of digital pin cards in the
TIM and loaded patterns in the RI8535’s on-board FPGAs.

C ONFIGURATION P ANELS 3 RI8535 UNIVERSAL DIGITAL

DPINS1
Each Dpins instrument denotes a 20-pin digital card.

EDIT PATTERNS
The Edit Patterns button views and loads digital patterns into the
specified Dpins instrument’s onboard-FPGA.
NOTE: The Digital Translate application found under the Apps button in the Guru bar,
imports logic patterns from a WGL (STIL), ATP or CSV file into Guru.

To load a digital pattern in the Dpins instrument:
1. In a System Configuration window, left click on the target Dpins
instrument to highlight it.
2. With the Dpins instrument highlighted, in the lower pane of the
Configuration window, left mouse click on the Edit Patterns:
‘Push’ button to open the Editing Patterns window.
3. Select ‘Patterns’ > ‘add from Guru’ from the menu options.
4. In the Editing Patterns window, from the menu options select
Pattern > ‘add from guru’ to open the Pick Pattern Window.
Digital patterns can be loaded for each Dpins# instrument

5. Select the desired pattern from the list and click OK to load.
6. The selected pattern will appear in the Editing Patterns window.

© Roos Instruments Inc.
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FIGURE 2.2 EDIT PATTERNS DPINS DIALOG

Multiple patterns are displayed in the left pane with information
displayed in the right pane for the selected pattern.

NOTE: The digital pattern is saved into the Dpins on-board FPGA. This process must
be repeated to load new or updated patterns.

© Roos Instruments Inc.
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EDIT PANELS

graphical test programming environment and are defined in the
following text.

The RI8535 edit panel or editor window provides instrument function
blocks and state buttons for a Dpins instrument consisting of 20-pin
digital resources. These button and blocks are used in Cassini’s

DPINS1
Each Dpins# (1 thru 6) instrument contains contains DC Pin Measure,
Pin Setup, Pin State, Pin Measure, Patterns, Serial Data, Serial Scan,
and Logic Analyzer subsystem panels.

E DIT P ANELS 4 RI8535 UNIVERSAL DIGITAL EDIT PANELS
PANEL: DC PIN MEASURE
Measure Mode

none
Measure Mode
A drop down list button that sets the measurement mode of the
selected pin set by the Measure Pin button.
‘none’ is the default mode and disconnects all measurement
resources from the designated pin.
‘Voltmeter’ provides precision voltage measure with a high series
resistance (1MΩ).

DC Pin Measure provides multimeter and continuity resources and
measurement blocks.
© Roos Instruments Inc.

The ‘Imeas’ selection forces a voltage defined by the Measure V
Force button and measures the resulting current for the selected
resource using the Measure Pin. The Measure I Limit button
restricts the maximum amount of current delivered by the supply
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during the measurement to avoid damaging the device pin if there is a
DUT failure.
NOTE: The Pin Mode button must be set to ‘continuity’ to use this mode.

The ‘vMeas’ selection forces a current defined by the Measure I
Force button and measures the resulting voltage for the selected
resource using the Measure Pin. The Measure V Limit button
restricts the maximum voltage applied during the measurement.
Typically the Measure V Limit button is set to the DUT’s supply rail or
ground depending on the polarity of the Measure I Force button to
avoid damaging the device pin.
NOTE: The Pin Mode button must be set to ‘continuity’ to use this mode.

Graphical Programming | RI8535: Universal Digital
The ‘vCal’ selection is the same mode as the ‘vMeas’ mode with the
exception that the current limit settings are deactivated. The value set
with the Measure I Limit is ignored, and the supply will deliver as
much available current as the internal supply can force to set the
voltage defined by the Measure V Force button.
NOTE: This mode is typically used in continuity tests for device pins with large in-rush
currents or long duration time constants during power up.
The Pin Mode button must be set to ‘continuity’ to use this mode.

The ‘iCal’ selection is the same mode as the ‘Imeas’ mode with the
exception that the voltage limit settings are deactivated. The value set
with the Measure V Limit is ignored, and the supply will deliver as
much available voltage as possible to force the current condition
defined by the Measure I Force button.

The ‘low Current’ selection measures the current for a selected
resource defined by the Measure Pin. This mode sets use a highprecision sense resistor to access the lowest current measurement
range possible and incorporates a built-in, recursive averaging
method to measure DC currents in the pA range.

NOTE: The Pin Mode button must be set to ‘continuity’ to use this mode.

NOTE: The Pin Mode button must be set to ‘leakage’ to use this mode.

The ‘continuity+’ mode forces a current and measures the voltage of
a Device Pin Group designated by the Continuity button. The
continuity state of the pin group is measured using the Read

© Roos Instruments Inc.

CAUTION: In the iCal mode the pin voltages can exceed the rail voltages of the device
under test.
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Continuity measurement block with the Pin Mode button set to
‘continuity.’

button. This button is commonly used in conjunction with the
Measure Mode button.

The ‘continuity-’ mode sinks a current and measures the voltage state
of a Device Pin Group designated by the Continuity button. The
continuity state of the pin group is measured using the Read
Continuity measurement block with the Pin Mode button set to
‘continuity.’

‘normal’ connects an internal protection diode network to each of the
Dpins to allow for standard voltage drive and digital read/write modes
as the default pin mode.

Measure Pin

None
Measure Pin
A drop down list button that selects the Digital Output pin to be
connected to the DPins internal measurement module (PMU).

‘continuity’ disconnects the protection diode network from the Dpins
and offsets the internal measurement module to test for continuity
voltage compliance within the range of +3V to -1.5V on all pins.
The ‘leakage’ mode disconnects the protection diode network from
and all source and measurement resources from the Dpins to prevent
stray leakage currents from affecting low current measurements. This
mode is used in conjunction with the Measure Mode button in the
‘Imeas’ and ‘low current’ modes.

The ‘none’ selection disconnects the digital pin resource from all
internal measurement resources.
‘D1-1’ through ‘D1-20’ selections connects the specified resource pin
to the internal measurement resources specified by the Measure
Mode and Pin Mode buttons.
Pin Mode

normal

Measure V Force

0
Measure V Force
Decimal notation button that sets the value of the voltage force
condition for the Measure Mode: ‘Imeas’ setting. The condition is
applied to the resource designated by the Measure Pin button. The
values are in units of volts.

Pin Mode
A drop down list button that selects the internal resource to be
connected to the resource pin designated by the Measure Pin
© Roos Instruments Inc.
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Measure I Force

Current Meas Max

0

1000 u

Measure I Force

Current Meas Max

Decimal notation button that sets the value of the current force
condition for the Measure Mode: ‘vMeas’ setting. The condition is
applied to the resource designated by the Measure Pin button. The
values are input in units of amps.

Decimal notation input button that optimizes the dynamic range of the
internal current measure module to within one of four sense resistor
ranges: <2 mA, <200 µA, <20 µA, and <2 µA (i.e. a button value of
500 mA will select the dynamic range to <2 mA for the ADC). This
button is used with the Measure Mode:‘Imeas’, ‘iCal’, or ‘low
Current’ settings and Measure Pin buttons.

CAUTION: Setting a value of 0 can cause unexpected or irregular current or voltage
measurement conditions at the device pin.

Measure V Limit
Continuity

none
Continuity
A drop down list button that selects a Device Pin Group used for
continuity measurements. Pin groups are defined in the Device Pins
tab of the Device Connection Editor. The associated ‘Dut’ instrument
must be active in the system configuration to be accessible to the
Continuity button options. Reference the Dut Instrument section for
information on how to add a ‘Dut’ instrument to the system
configuration.

0
Measure V Limit
Decimal notation input button that sets the maximum voltage
amplitude for the Measure Mode: ‘vMeas’ button setting. This
setting voltage-limits the supply with a clamping diode when in current
drive mode to prevent damaging a DUT pin from unwanted and/or
excessive voltage caused by the Measure I Force button current
criterion.
Measure I Limit

0

Measure I Limit
Decimal notation input button that sets the maximum current
amplitude for the Measure Mode: ‘Imeas’ button setting. This setting
© Roos Instruments Inc.
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current-limits the supply to prevent damaging a DUT pin from
unwanted and/or excessive current caused by the the Measure V
Force button voltage criterion.

MEAS
Read Continuity

A

Meas: Read Continuity
CAUTION: Setting a value of 0 can cause unexpected or irregular current/voltage
measurement conditions at the device pin.
MEAS
Precision Current

A

Meas: Precision Current
Measurement block that computes the current at a resource pin
designated by the Measure Pin button. The maximum measurable
current is 2 mA. It is used with the Measure Pin and Pin Mode:
‘continuity’ or ‘leakage’ button settings.
MEAS
Precision Voltage

A

Meas: Precision Voltage
Measurement block that computes the current at a resource pin
designated by the Measure Pin button. The maximum measurable
voltage range is -3V to +5V. It is used with the Measure Pin and Pin
Mode buttons.

© Roos Instruments Inc.

Measurement block that uses an internal voltage comparator to
compute the result of a continuity test. This measurement block is
used in conjunction with the Measure Mode: ‘continuity+’ or
‘continuity-’, Pin Mode: ‘continuity’ and Continuity buttons. The
results are provided for every pin in the Device Pin Group designated
by the Continuity button. The value return by the measurement block
is as follows:
A returned value of 0 is a “pass,” denoting a measured voltage diode
drop value between -1 to +3V, excluding 0V. For example, a
measured voltage of 0.7V would be returned as 0 denoting a ‘pass’
value.
A returned value of 1 is a “short,” denoting a measured voltage value
of approximately 0V.
A returned value of 2 is an “open,” denoting a measured voltage value
of the rail conditions of -1V or +3V.

256

Graphical Programming | RI8535: Universal Digital

Cassini ATE System Reference Guide

and Logic Analyzer features of the Dpins.
The comparator voltage set range is 0 to +4V.

PANEL: PIN SETUP
Vhigh

Vterm

0

0

Vhigh

Vterm

A decimal notation input button that sets the voltage value for a
logical ‘1’ or ‘high’ condition for all Dpins in the 20-pin bank. The
voltage range is 0 to +4V.

A decimal notation input button that sets the termination voltage
condition. This button is used with the D1-1 through D1-20: ‘Vterm’
button settings to set the voltage condition of the Dpins to a specified
value. The voltage set range is 0 to +4V.

Vlow

Vector Period

0

25 n

Vlow
A decimal notation input button that sets the voltage value for a
logical ‘0’ or ‘low’ condition for all Dpins in the 20-pin bank. The
voltage range is 0 to +4V.
Vcompare

4

Vcompare
A decimal notation input button that sets the voltage comparator
condition for all Dpins in the 20-pin bank. The voltage comparator is
used by data read functions and logical analyzer capture tools and is
commonly used with buttons found in the Serial Data, Pin Measure,

© Roos Instruments Inc.

Vector Period
Decimal notation input button that sets the clock period (clock rate)
for any clock pins used for digital communication. The period is input
in units of seconds with a maximum rate of 100MHz (‘10 n’ value).
For Scan Timing information, reference Diagram 1 in the Appendix |
Section 3: RI8535 Universal Digital.
Clock Mode

normal

Clock Mode
A drop down list button that selects the pin or pins in the 20-pin bank
that will be used as clocks for digital communication protocols.
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‘normal’ mode is the default mode and enables pins 5, 10, 15, and 20
as clock pins.

Read Stb

-0.1

‘off’ deactivates all pins

Read Stb

‘all’ allows all pins to be used as clock pins. In this mode, the Clock
Width, Data Stb, and Read Stb button values are ignored (duty
cycle adjustment and read/data offsetting are disabled).

A decimal notation input button that sets the strobe offset in seconds
relative to the active edge of the clock. For entries greater than 0.01,
the button input value is multiplied by the clock period value in the
Vector Period button to generate the offset value used. A value of 0
sets the strobe offset to zero, aligning the strobe’s active edge with
the first active clock edge. This button is used with the Clock Mode:
‘normal’ button setting.

‘d20’ designates pin 20 as the only clock in the Dpins bank of pins.
‘delay20’ mode is no longer supported.

Data Stb

NOTE: A value less than 0 is recommended to provide adequate settling and rise/fall
edge time alignment of the strobe signal caused by the device under test or interconnect.

-0.4

Data Stb
A decimal notation input button that sets the leading edge offset of
the data packet in seconds relative to the active edge of the clock.
For entries greater than 0.01, the button input value is multiplied by
the clock period value in the Vector Period button to generate the
offset value. This button is used with the Clock Mode: ‘normal’
button setting.
NOTE: A value less than 0 is recommended to provide adequate settling and rise/fall
edge time alignment of the strobe signal caused by the device under test or interconnect.

Clock Width

0.4

Clock Width
A drop down list button that sets the clock width (duty cycle of the
clock) of the ‘active’ region. The default value of 0.4 represents a 40%
active duty cycle. This button is used with the Clock Mode: ‘normal’
and Vector Period buttons.
NOTE: Only pins 5, 10, 15, and 20 can adjust duty cycle using the Clock Width button
setting.

© Roos Instruments Inc.
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‘sClk’ sets the pin as a I2C protocol, clock driver output pin that aligns
the clock duty cycle (rising and falling edge) to occur within the data
bit duty cycle as shown in Figure 2.3.

PANEL: PIN STATE
D 1-1

open

D1-1 through D1-20

‘data’ sets the pin as an output pin to send data to an external

A drop down list button that sets the pin state for static voltage or
declares the logic type in a communication protocol.

FIGURE 2.3 SCLK MODE DATA/CLOCK TIMING DIAGRAM

‘open’ disconnects the specified Dpin from all internal logic drive and
read resources.
‘on’ sets the pin to the voltage value specified by the Vhigh button.
‘off’ sets the pin to the voltage value specified by the Vlow button.
‘clock’ sets the pin as a clock driver output pin to provide a
synchronous clock signal to an external device’s clock input pin for
various communication protocols. This setting is commonly used with
the Clock Mode, and Vector Period buttons to designate the clock
setup and speed as well as the Read Size button to designate the
number of clock edges in a data read/write packet.
‘/clock’ sets the pin as a reversed value clock driver output pin to
provide a synchronous clock signal to an external device’s clock input
pin for various communication protocols.

© Roos Instruments Inc.

The ‘sClk’ mode enforces the I2C protocol clock(SCL) and data(SDA)
alignment.

device’s data input pin in synchronous communication protocols.
‘aux’ sets the pin as a generic output pin to send data to an external
logic-based device’s auxiliary pin in synchronous communication
protocols.
‘/aux’ sets the pin as a reversed value, generic output pin to send
data to an external device’s auxiliary pin in synchronous
communication protocols.
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‘strobe’ sets the pin as a latch enable or strobe output pin to drive an
external device’s enable pin in synchronous communication protocols.
‘/strobe’ sets the pin as a reversed value latch enable or strobe output
pin to drive an external device’s enable pin in synchronous
communication protocols.
‘read’ designates the pin as an input pin to capture data from the
device under test, connecting an internal high impedance network to
provide a suitable load. This setting is commonly used with the Read
Pin button to designate a memory buffer for captured data.
‘term’ connects the designated pin to a series 50Ω resistor terminated
with the voltage value specified by the Vterm button.

Pin State

none
Pin State
A drop down list button that allows the user to select a pin group that
sets the state of the pins in the Dpins bank according to the pin
group’s designations defined by a Device Pins Group of a Device
Pins definition in the Device Connection Editor. The associated device
must be active in the system configuration to be accessible to the
Serial Group and Device Pins button options. Reference the Dut
Instrument section for information on how to add a device to the
system configuration.

‘r/w’ sets the pin as a bilateral read/write pin to support an external
flip-flop or other logic-based device’s synchronous communication
protocol. This setting is commonly used with the Read Pin, and
Read Size buttons to designate a memory buffer for captured data
as well as Serial Data, Serial Type, and Serial Idle buttons to
designate data write information.
NOTE: The Dpin used as a I²C bidirectional read/write pin must be set to ‘r/w’ to
prevent data collisions.

© Roos Instruments Inc.
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Size, Read Polarity, and Read Delay buttons with the Read Serial
measurement block.

PANEL: PIN MEASURE
Measure Time

10 u

MEAS

Measure Time

Pin Frequency

A decimal notation input button that sets the capture window of the
frequency counter in units of seconds. This button is used in
conjunction with the Read Pin button and Pin Frequency
measurement block.

A

Meas: Pin Frequency
Measurement block that computes the frequency of the Dpins
resource selected by the Read Pin button with a capture window set
by the Measure Time button. The value is returned in units of Hz.

Read Pin

none

Read Pin
A drop down list button that connects internal measurement module
resources for the designated pin. The measurement resource used is
dependent on the additional buttons and/or blocks included in the
testplan, with commonly used setups listed as follows:
Frequency counter resource includes the Pin Mode: ‘normal’ and
Measure Time buttons with Pin Frequency measurement block.

MEAS

Read Pin State

A

Meas: Read Pin State
Measurement block that uses the internal voltage comparator to
compute the state of the pin selected by Read Pin button. This
button is used in conjunction with the Pin Mode: ‘continuity’ button
setting.

The voltage comparator resource includes the Pin Mode: ‘continuity’
button and Read Pin State measurement block.
The internal read buffer resource used for synchronous
communication protocols includes the Pin Mode: ‘normal’, Read
© Roos Instruments Inc.
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placed at the beginning of the sequence and followed by a
Sequence Delay and Pattern Mode: ‘run’ button.

PANEL: PATTERNS
Seq Pattern

none

Seq Pattern
A drop down list button used to specify a pattern name that will be
emitted by the designated communication pins. It is commonly used
with the Pattern Fail measurement block. The Seq Pattern button is
only valid in a pre/post measure group. In the pre/post measure group
it is followed with a Seq Repeat button to execute.

‘beginStep’ initiates the pattern emit engine in an inner/outer loop
grouping. When the outer loop value is equal to 1, the pattern is
loaded and on increments of the loop, the pattern is emitted.
‘run’ starts the pattern emit in a measure sequence.
‘nextStep’ restarts the pattern in a measure sequence.
‘stop’ forces a hard stop of the pattern emit in a measure sequence
or post measure group.
Seq Repeat

Pattern Mode

idle

Pattern Mode
A drop down list button that controls the pattern emit engine. It is
placed in a pre/post measure or measure sequence button grouping
with the Seq Pattern and Seq Repeat buttons with a Pattern Fail
or Read Special measurement block.
‘idle’ is the default off state of the pattern emit engine.
‘begin’ initiates the pattern emit engine to load the pattern specified
by the Seq Pattern button. In a measure sequence it is typically

© Roos Instruments Inc.

1

Seq Repeat
An integer data entry button to specify the number of times to repeat
a prior pattern. A value of 0 repeats indefinitely.
MEAS

Read Special

A

Meas: Read Special
Measurement block that uses a 4-bit capture buffer on Dpins 16, 17,
18, and 19, using Dpins 20 as a clock input from the device. The
returned value is a vector vs. time result with the size of the capture
set by Read Size button.
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PANEL: SERIAL DATA

NOTE: the Clock Mode: ‘d20’ button setting must be used.
MEAS

Pattern Fail

Serial Idle
A

Meas: Pattern Fail
Measurement block that returns bit location of the first pattern failure.
The block returns 0 if there are no pattern failures.
NOTE: The first bit location is designated as location 1.

Serial Idle
Text string input button that sets the idle state for the designated
clock, strobe, data and aux pins. The input text capitalization
determines the voltage state of the pins before and after a
communication protocol is executed. The input value ‘CDSa’,
represents an idle ‘high’ voltage value set by the Vhigh button for
clock, data, and strobe with an idle ‘low’ voltage value set by the
Vlow button for the aux pin. This button is commonly used with the
D1-1 through D1-20, Serial Data, Read Pin, Read Size, Vector
Period, and Clock Mode buttons for serial communication.
NOTE: The idle state of the pins must be defined by the Serial Idle button for serial
communication emits to be executed.

© Roos Instruments Inc.
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Serial Data

Serial Data

NOTE: The read mask can be expressed in short-form notation with a number followed
by an ‘X’. ‘0’, or ‘1’ to represent the number of characters in the mask positions, i.e. - the
read mask input value ‘1111XXXX’ can be expressed as ‘41 4X’ and the read mask input
value ‘XXXX 0000 1111 1111’ can be expressed as ‘4X 40 81’.

Text string input button that generates a serial emit pattern for the
serial data output. Data is input as protocol:packet size:write data:
read mask.

Example Serial Data button inputs:

NOTE: The Serial Data button must be used in a Premeasure or Measure Sequence
group.

The protocol values supported are: ‘jtag’, ‘i2c’, and ‘spi’.
The packet size value is a number representing the number of bits
and associated clock cycles in the packet emit.

Serial Data
spi:16:1100 1111 0000 0000:8X 81

SPI protocol with 16 clock edges that is emitting the hexadecimal
byte CF00 and reading back 16 bits; The first 8 values are ignored,
representing the read data as an 8-bit decimal value between 0-255.
Serial Data

The write data value is the data to be emitted to the device under
test in binary form. The value is input as hexadecimal values for the
I2C protocol.
The read mask text value is an optional entry that defines mask bits
to be logical AND’d with the bits captured on the read pin from the
device under test. A value of ‘1’ retains the associated bit, ‘0’ or ‘X’
represent ‘don’t care’ values in the bit stream. For example
‘1111XXXX’ would capture the first four bits and discard the last four
bits in a capture. The value is input as hexadecimal values for I2C
protocol.

© Roos Instruments Inc.

jtag:16:80 81

JTAG protocol with 16 clock edges that is emitting the hexadecimal
byte 00FF and ignoring any read bits.
Serial Data
i2c:9:CF

I2C protocol emit with 8 data clock edges and 1 ACK bit that is
emitting the hexadecimal byte CF (1100 1111) and ignoring any read
bits.
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NOTE: Whitespace characters (space bar) are ignored in the Serial Data button and
can be used to separate and view binary data chains as bytes.

This button is commonly used with the D1-1 through D1-20, Serial
Idle, Serial Type:‘manual’, Read Pin, Read Size, Vector Period,
and Clock Mode buttons as well as the Serial Read measurement
block.

devices that contain multiple registers with programmable functions.
This button selection will override the settings for any Clock Polarity,
Serial Direction, Strobe Length, and Strobe Polarity buttons in
the test plan. See the Device Control Definition and DUT Instrument
section for more information.
CAUTION: The Serial Type button of the StaticDigital instrument in the RI8546
Device Power TIM defaults to the value of ‘Dut Defined.’ If the Dpins instrument is the
target communication instrument, all Static Digital Serial Type buttons must be placed
in the Global Defaults of a test plan and set to ‘none.’

Serial Type

manual

Serial Group

none

Serial Type
Drop down list button that defines the communication control mode
for the read data, data, clock, and strobe pins set by the D1-1
through D1-20 button settings. The selection type inherits and
enforces timing behavior specified by the protocol in the Serial Data
button or Device Control Definition.
The ‘manual’ selection provides communication control via the Serial
Data button. This button is commonly used with the D1-1 through
D1-20, Serial Idle, Serial Type:‘manual’, Read Pin, Read Size,
Read Pin, Vector Period, and Clock Mode buttons as well as the
Serial Read measurement block.

Serial Group
A drop down list button that selects a pin group to define the clock,
data, read, and or strobe pins. Pin groups are defined in the Device
Pins tab of the Device Connection Editor. A ‘DUT’ (Device definition
with associated Device Pins definition) must be active in the system
configuration to access the Serial Group button options. Reference
the Dut Instrument section for information on how to add a device to
the system configuration.

The ‘DUT Defined’ selection uses the communication parameters
defined in the Device Control Editor under the Formats tab to enable
protocol-aware communication with a DUT. It is typically used with
© Roos Instruments Inc.
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Read Polarity

normal

Read Polarity

The internal read buffer resource used for synchronous
communication protocols includes the Pin Mode: ‘normal’, Read
Size, Read Polarity, and Read Delay buttons with the Read Serial
measurement block.

Drop down list button that sets the polarity of the bit values on the
read pin designated by the Read Pin button.
‘normal’ is the default mode and does not alter the bit polarity of the
bits from the device under test.
‘inverted’ reverses the bit polarity of the captured bits on the read line
from the device under test.
Read Pin

none

Read Delay

0

Read Delay
Drop down list button that offsets the read signal from the clock to
adjust bit read timing alignment. The input values are in units of
number of clock periods with valid input values of: -1, 0, 1, or 2. This
button is commonly used with the D1-1 through D1-20, Read Pin,
Read Size, Read Pin, Vector Period, and Clock Mode buttons as
well as the Serial Read measurement block.

Read Pin
A drop down list button that selects internal measurement resources
to connect to the designated pin. The measurement resource used is
dependent on additional buttons and/or measurement blocks
included in the testplan, with commonly used Read Pin setups listed
as follows:
Frequency counter resource includes the Pin Mode: ‘normal’ and
Measure Time buttons with Pin Frequency measurement block.

Read Size

0

Read Size
Integer data button that sets the number of bits to capture.
The maximum value is 1000 samples.
When used with the Serial Read measurement block, the Read Size
sets the decimal expression range, i.e - a Read Size value of ‘12’
would give answers in the decimal range from 0-4095.

The voltage comparator resource includes the Pin Mode: ‘continuity’
button and Read Pin State measurement block.

© Roos Instruments Inc.
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When used with the Logic Analysis measurement block, the capture
size is the Read Size value multiplied by the over sample rate set by
Logic Analyzer Mode value.

‘pause’ halts the read capture. It is used in conjunction with a
Sequence Delay button and the Read Mode: ‘resume’ and/or
‘stop’ setting in a measure sequence or pre measure grouping.

NOTE: The Read Size can be dynamically set within a measure sequence group to
adjust the capture parameters for multiple measurements, i.e. - the Read Size button
value can be set to ‘8’ for a Serial Read measurement to provide a decimal range from
0-255 and then set to 100 to capture a larger capture range for the Logic Analysis
measurement block within a single measure sequence group.

‘resume’ continues a previously paused read capture. It is used in a
measure sequence or pre measure grouping after a Read Mode:
‘pause’ setting typically in conjunction with a Sequence Delay button
to modify the data capture.
NOTE: Read Mode buttons are only valid in premeasure or measure sequence groups.

Read Mode

stop

Serial Lv Write

0.0

Read Mode
Drop down list button that defines bit capture actions. Multiple Read
Mode buttons are typically used in conjunction with Sequence Delay
buttons (in the System > state selection of the Edit Panel) to define
the capture window duration.
‘stop’ terminates the read capture. It is typically placed last in a
measure sequence or in a post measure grouping.

Serial Lv Write
Input button used as the target of a local variable write. It uses the
Serial Data packet size and read mask to set the value range size.
NOTE: This button is only valid in premeasure or postmeasure button groups.

‘start’ initiates the read capture. It is typically placed before a Serial
Data button or other DUT instrument emit command in a measure
sequence or pre measure grouping to modify the data capture.

© Roos Instruments Inc.
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PANEL: SERIAL SCAN

MEAS

Serial Read

A

Read Polarity

Meas: Serial Read
Measurement block that captures and returns the contents of the
serial read buffer designated by the Read Pin and Read Size
buttons and returns the decimal value of the bits. See the A shift B
and C calculation block for extracting individual bits or bit strings
within a serial read capture.

normal

Read Polarity
Drop down list button that sets the polarity for the read pin designated
by the Read Pin button.
‘normal’ is the default mode and maintains the logic polarity of the
captured bits read from the device under test.
‘inverted’ reverses the logic polarity of the captured bits from the
device under test.
Read Pin

none

Read Pin

A drop down list button that selects internal measurement resources
to connect to the designated pin. The measurement resource used is
dependent on additional buttons and/or measurement blocks
included in the testplan, with commonly used Read Pin setups listed
as follows:
Frequency counter resource includes the Pin Mode: ‘normal’ and
Measure Time buttons with Pin Frequency measurement block.
© Roos Instruments Inc.
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The voltage comparator resource includes the Pin Mode: ‘continuity’
button and Read Pin State measurement block.

Repeat and or Pattern Mode buttons to execute the emit of the
designated pattern.

The internal read buffer resource used for synchronous
communication protocols includes the Pin Mode: ‘normal’, Read
Size, Read Polarity, and Read Delay buttons with the Read Serial
measurement block.
Read Delay

0

Read Delay
Drop down list button that offsets the read signal from the clock to
adjust bit read timing alignment. The input values are in units of
number of clock periods with valid input values of: -1, 0, 1, or 2. This
button is commonly used with the D1-1 through D1-20, Read Pin,
Read Size, Read Pin, Vector Period, and Clock Mode buttons as
well as the Serial Read measurement block.

Seq Repeat

1

Seq Repeat
An integer value button that sets the number of repeats of a
designated pattern from the Seq Pattern button. It is only valid in pre
measure or measure sequence groups and is used in conjunction with
the Pattern Mode button.
NOTE: Scan patterns are limited to the default value of 1.

Pattern Mode

idle
Seq Pattern

none

Seq Pattern
Drop down list button of scan pattern/s loaded into the Dpins
instrument that will be emitted. It is only valid in pre measure or
measure sequence groups and is used in conjunction with a Seq
© Roos Instruments Inc.

Pattern Mode
A drop down list button that controls the pattern emit engine. It is
placed in a pre/post measure or measure sequence button grouping
with the Seq Pattern and Seq Repeat buttons with a Pattern Fail
or Read Special measurement block.
‘idle’ is the default off state of the pattern emit engine.
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‘begin‘ initializes the pattern engine to load the pattern designated by
the Seq Pattern button into the emit buffer.
‘beginStep’ initiates a pattern emit in an inner/outer loop grouping
only. When the outer loop value is equal to 1, the pattern is loaded
and on increments of the loop, the pattern is emitted.
‘run’ starts the pattern emit.
‘nextStep’ restarts the pattern.

MEAS

Pattern Fail

A

Meas: Pattern Fail
Measurement block that returns an integer value indicating the bit
location of the first pattern failure. The block returns 0 if there are no
pattern failures.
NOTE: The first bit location is designated as location 1.

‘stop’ forces a hard stop of the pattern emit.

Serial Group

none
Serial Group
A drop down list button that selects a pin group used for continuity
measurements. Pin groups are defined in the Device Pins tab of the
Device Connection Editor. The associated device must be active in
the system configuration to be accessible to the Serial Group button
options. Reference the Dut Instrument section for information on how
to add a device to the system configuration.

© Roos Instruments Inc.
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PANEL: LOGIC ANALYZER

Logic Analyzer Capture

current
Logic Analyzer Trigger

oﬀ
Logic Analyzer Trigger
Drop down list button that controls the analyzer’s capture trigger
timing when using the Logic Analysis measurement block. This
button is only valid in a pre/post measure and measure sequence
groups and is commonly used with the Logic Analyzer Signal,
Logic Analyzer Trigger, and Logic Analyzer Capture buttons.

Logic Analyzer Capture
Drop down list button that selects the pins that will be connected to
the analyzer instrument during data capture using the Logic Analysis
measurement block. It is placed in the Global or Section Defaults of a
test plan and is commonly used with the Logic Analyzer Signal,
Logic Analyzer Trigger, and Logic Analyzer Mode buttons.
‘Current’ selects all pins designated in the Seq Pattern button
pattern emit.

‘off’ is the default state and disables the trigger.

‘All’ selects all 20 pins.

‘enable’ sets the trigger to begin/end when a Read Mode:‘start’
button is encountered in the pre measure or measure sequence
group.

‘Serial’ selects the pins designated by the Serial Group button.

‘immediate’ initiates the trigger in a pre measure or measure
sequence group where the Logic Analyzer Trigger:‘immediate’
button is encountered in the sequence.

‘Other’ selects the pins designated by the Pin Group button.
Logic Analyzer Signals

wide
Logic Analyzer Signals
Drop down list button that captures and displays additional internal
signals in the logic analyzer plot when using the Logic Analysis
measurement block. It is placed in the Global or Section Defaults of a
test plan and is commonly used with the Logic Analyzer Mode,
Logic Analyzer Trigger, and Logic Analyzer Capture buttons.

© Roos Instruments Inc.
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‘wide’ displays additional internal capture/timing/trigger signals of the
logic analyzer on y-axis: 21 through 24 of the plot view.
See Example C.
‘narrow’ limits the logic analyzer to only display the 20 Dpins in the
analyzer plot viewer.

Logic Analyzer Mode

X4
Logic Analyzer Mode
Drop down list button that selects the oversample rate of the logic
analyzer relative to the clock period set by the Vector Period button
when capturing signals with the Logic Analysis measurement block.
It is placed in the Global or Section Defaults of a test plan and is
commonly used with the Logic Analyzer Signal, Logic Analyzer
Trigger, and Logic Analyzer Capture buttons.

Read Size

0

Read Size
Integer data button that sets the number of samples to capture in a
bit stream. The maximum input value is 1000 samples.
When used with the Serial Read measurement block, the Read Size
sets the decimal expression range, i.e - a Read Size value of ‘12’
would give answers in the decimal range of 0-4095.
When used with the Logic Analysis measurement block, the capture
size is the Read Size value multiplied by the over sample rate set by
Logic Analyzer Mode value.
NOTE: The Read Size can be dynamically set within a measure sequence group to
adjust the capture parameters for multiple measurements, i.e. - the Read Size button
value can be set to ‘8’ for a Serial Read measurement to provide a decimal range from
0-255 and then set to 100 to capture a large emit range for the Logic Analysis
measurement block within a single measure sequence group.

‘X4’ is the default setting and sets the capture rate to four samples
per clock period
Logic Analyzer Trigger Mode

‘X2’ sets the capture rate to two samples per clock period.
‘X1’ sets the capture rate to one sample per clock period.

oﬀ
Logic Analyzer Trigger Mode
Drop down list button that selects an event to trigger the logic
analyzer signal capture of the Logic Analysis measurement block. It
is placed in the Global or Section Defaults of a test plan and is

© Roos Instruments Inc.
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commonly used with the Logic Analyzer Signal, Logic Analyzer
Trigger, Logic Analyzer Capture, and Logic Analyzer Mode
buttons.
‘off’ deactivates the trigger and no data is captured.
‘external’ is for RI internal purposes only.
‘onFail’ triggers the logic analyzer capture to start immediately
following a measured fail bit in a pattern designated by the Seq
Pattern button.

Graphical Programming | RI8535: Universal Digital
Trigger Vector

0

Trigger Vector
Integer value button that offsets the starting point of a trigger event by
the specified number of bits or clock edges defined by the Location
Mode and Logic Analyzer Trigger Mode buttons.

Location Mode

‘onRead’ triggers the logic analyzer capture to start when the Read
Mode: ‘start‘ is encountered, subject to the offset imposed by the
Read Delay setting.
‘atVector’ triggers the logic analyzer capture to start the capture in
accordance with the Location Mode setting, subject to the offset
imposed by the Trigger Vector button value.
‘patternStart’ captures all bits in the pattern specified by the Seq
Pattern button.
‘serial’ triggers the captures bits after Serial Data button or DUT
instrument protocol buttons.

dutClocks

Location Mode
Drop down list button that selects the method for counting pattern
vectors when using the Trigger Vector button to start or offset the
start of a logic analyzer capture. This button is used in conjunction
with the Logic Analyzer Trigger Mode button to designate the
target vector type.
‘dutClocks’ sets the clock pin designated by a D1-1 to D1-20: ‘clock’
or ‘/clock’ button setting as the vector target with the Logic
Analyzer Trigger Mode: ‘serial’ or ‘onRead’ button setting and
Trigger Vector offset value.
‘vector’ sets the pattern designated by a D1-1 to D1-20: ‘clock’ or
‘/clock’ buttons as the signal vector target with the Logic Analyzer
Trigger Mode: ‘atVector’ button setting and Trigger Vector offset
value.

© Roos Instruments Inc.
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MEAS

Logic Analysis

A

Meas: Logic Analysis
The Logic Analysis measurement block captures the bit stream of
pins specified by the Logic Analyzer Capture button and displays
them in a plot window of a Local Variable save. This button is used
in conjunction with the Read Size, Read Mode, Logic Analyzer
Signal, Logic Analyzer Trigger, Logic Analyzer Capture, and
Logic Analyzer Mode buttons. See Example B.
NOTE: The output of the Logic Analysis measurement block must be connected to a
Local Variable save. The analyzer plot can be viewed by compiling the test program, left
clicking on the Local Variable save block and selecting the Rectangular plot viewer with
the Sort By Format set to ‘index’ and the x parameter set to ‘time’. Each Dpin is
displayed on the y-axis value that corresponds to the pin number, i.e - the y-axis value of
10 represents Dpins1 bit 10 or D1-10. See Example C.

© Roos Instruments Inc.
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EXAMPLE C LOGIC ANALYZER VIEWER

The above shows the setup for serial SPI communication (buttons on
the left of the panel) and the logic analyzer display and capture setup
(buttons on the right of the panel)

The plot viewer shows the resulting clock, data, read and strobe bit
streams in a logic analyzer capture. The plot is centered on Dpin 9
(data write) with Dpin 10 (clock) above, Dpin 8 (read) and Dpin 7
(strobe) below.

© Roos Instruments Inc.
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Real-time control of the instruments in this TIM.
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DPINS
PIN PARAMETERS
Allows Dpins voltage supply control and clock controls.

C ONTROL P ANELS 3 RI8535 UNIVERSAL DIGITAL

PIN STATE CONTROL PANEL
Enables individual pin state settings for voltage setting and
communication pin designation.

DC PIN MEASURE CONTROL PANEL
DC Pin Measure enables pin measure setup and real-time
measurements for Voltage and Current.
Voltages are displayed in units of Volts and current in units of Amps in
real-time.

PIN MEASURE CONTROL PANEL
Allows Dpins voltage supply control and clock controls.

© Roos Instruments Inc.

Displays frequency counter results for the selected pin and capture
window adjustment. Frequency values are displayed in Hz in real-time.
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PATTERNS CONTROL PANEL
Provides digital communication setup and emit control buttons for
manual pattern emits and bit read capability.

© Roos Instruments Inc.
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TOPICS

Instruments Provided by this TIM
Instrument Diagram with Edit Buttons
Edit Panel Button Descriptions
Control Panel

Tap the links above to quickly access content.

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as Test Head in the panel dialog
windows.
Model and Name as it appears in the Tester Configuration:
• Test Head, RI8545x 4 port Testset
NOTE: Multiple RI8545 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - Test Head, Test Head2,
Test Head3, etc). The “x” in RI8564x denotes the model revision number.

© Roos Instruments Inc.
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I NSTRUMENT B UTTON D IAGRAM 2.3
Roos Instruments, Inc - Cassini

Block Diagram, Test Set
RI8545B
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EDIT PANELS

PANEL: RF SETUP

Automated control of the instruments in this TIM with use by the Test
Plan Editor.

Rf2

src3

Rf 2

E DIT P ANELS 5 RI8545 4 PORT TESTSET

Drop down list button that controls the resource connections to the
RF2 (C7) coupled input/output port. The button configures the
mechanical relay R-2 to connect RF2 to various internal resources or
input/output ports.
This button in combination with the Source 1, Source 1 Mode,
Receive Mode, and Load State buttons set the signal path routing
through the TIM’s internal mechanical relay connections.
‘src3’ selection connects RF2 (C7) as an output port driven by the
resource connected to Src 3 (C6).
‘receive-src1’ connects RF2 (C7) to the internal set of solid state
switches: M26-B (controlled by Output Port), M11-B (controlled by
Load State, M14-B (controlled by Receive Mode), M26-T
(controlled by Input Port, and M11-T (controlled by Source 1 Mode).
This selection is used to connect RF2 (C7) to the Receiver Hi Out
(C1), the internal RF 50Ω load or short termination, Src 1 (C5), Aux In
(C2) or Noise Source 1.

RF Setup controls instrument resource routing.

© Roos Instruments Inc.
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Rf3

Rf6

receive

receive

Rf 3

Rf 6

Drop down list button that controls the resource connections to the
RF3 (C3) coupled input/output port. The button configures the
mechanical relay R-3 to connect RF3 to various internal resources or
input/output ports.

Drop down list button that controls the resource connections to the
RF6 (C8) coupled input/output port. The button configures the
mechanical relay R-6 to connect RF6 to various internal resources or
input/output ports.

‘src1-noise’ connects RF3 (C3) to the internal set of solid state
switches: M26-T (controlled by Input Port), M11-T (controlled by
Source 1 Mode. This selection is used to connect RF3 (C7) to Src 1
(C5), Aux In (C2) or Noise Source 1.

‘src1-noise’ connects RF6 (C8) to the internal set of solid state
switches: M26-T (controlled by Input Port), M11-T (controlled by
Source 1 Mode. This selection is used to connect RF6 (C8) to Src 1
(C5), Aux In (C2) or Noise Source 1.

‘receive’ connects the input port to the internal set of solid state
switches: M26-B (controlled by Output Port), M11-B (controlled by
Load State, M14-B (controlled by Receive Mode). This mode is
typically used to connect RF3 (C3) to Receiver Hi Out (C1) for receiver
type measurements: Output Port: ‘Rf 3’, Load State: ‘receiver’,
Receive Mode: ‘receiver’.

‘receive’ connects the input port to the internal set of solid state
switches: M26-B (controlled by Output Port), M11-B (controlled by
Load State, M14-B (controlled by Receive Mode). This mode is
typically used to connect RF6 (C8) to Receiver Hi Out (C1) for receiver
type measurements: Output Port: ‘Rf 6’, Load State: ‘receiver’,
Receive Mode: ‘receiver’.

NOTE: The ‘receive’ mode can also access Src 1 (C5) for s-parameter measurements.
This “back-door” mode is useful for reducing wear of electro-mechanical switches R-3,
R-6, and R-7, helping to extend their lifecycle and reducing settling times in
measurements. Reference Gallery 2 for example and suggested setups.1

NOTE: The ‘receive’ mode can also access Src 1 (C5) for s-parameter measurements.
This “back-door” mode is useful for reducing wear of electro-mechanical switches R-3,
R-6, and R-7, helping to extend their lifecycle and reducing settling times in
measurements. Reference Gallery 2 for example and suggested setups.

© Roos Instruments Inc.
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Rf7

Source 1

receive

RF 3

Rf 7

Source 1

Drop down list button that controls the resource connections to the
RF7 (C4) coupled input/output port. The button configures the
mechanical relay R-7 to connect RF7 to various internal resources or
input/output ports.

Drop down list button that controls the solid state switch M26-T in the
block diagram.

‘src1-noise’ connects RF7 (C4) to the internal set of solid state
switches: M26-T (controlled by Input Port), M11-T (controlled by
Source 1 Mode. This selection is used to connect RF6 (C8) to Src 1
(C5), Aux In (C2) or Noise Source 1.
‘receive’ connects the input port to the internal set of solid state
switches: M26-B(controlled by Output Port), M11-B(controlled by
Load State, M14-B(controlled by Receive Mode). This mode is
typically used to connect RF7 (C4) to Receiver Hi Out (C1) for receiver
type measurements: Output Port: ‘Rf 7’, Load State: ‘receiver’,
Receive Mode: ‘receiver’.
NOTE: The ‘receive’ mode can also access Src 1 (C5) for s-parameter measurements.
This “back-door” mode is useful for reducing wear of electro-mechanical switches R-3,
R-6, and R-7, helping to extend their lifecycle and reducing settling times in
measurements. Reference Gallery 2 for example and suggested setups.

© Roos Instruments Inc.

‘Rf 2’, ‘Rf 3’, ‘Rf 6’, and ‘Rf 7’ values provides intermediary path
routing control between resources set by Source 1 Mode: Src 1
(C5), Aux In (C2) or Noise Source 1 and the electro-mechanical relays
R-2, R-3, R-6, and R-7. In typically applications, this button is used
with Rf 2 set to ‘receive-src1’, and Rf 3, Rf 6 or Rf 7 buttons are set
to ‘src1-noise’ when routing source resources to the coupled ports.
The ‘load’ selection provides intermediary path routing control
between resources set by Source 1 Mode: Src 1 (C5), Aux In (C2) or
Noise Source 1 and the solid-state switch M26-T that is controlled by
the Load State button. This setting has the same function as the ‘Rf
2’ selection.
NOTE: When Receiver Mode is set to ‘s-parameter’, the Input Port button supersedes
the Source 1 button for control of the M26-T switch position, thus the Source 1 button is
not required in the test panels for this function.
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Source 1 Mode

Input Port

source

Rf 3

Source 1 Mode

Input Port

This list select button directly controls the solid state switch M11-T. It
is used to connect Src 1 (C5), Aux In (C2) or Noise Source 1 to the
internal switching network and used in conjunction with the Source
1, Rf 2: ‘receive-src1’, and Rf 3: ‘src1-noise’, Rf 6: ‘src1-noise’ or Rf
7: ‘src1-noise’ button settings to route signals to the coupled ports
RF2 (C7), RF3 (C3), RF6 (C8), or RF7 (C4)

This drop down list selection button that designates which of the RF
input/output ports [RF2 (C7), RF3 (C3), RF6 (C8), or RF7 (C4)] will be
defined as the input port to the Device Under Test for protocol-aware
s/wave parameter measurements. This button activates the compiler’s
expert system mode to control and orchestrate the entire internal
switch network for all wave parameters measurements automatically.
This programming approach allows the user to avoid having to setup
the switching network for each load condition and forward/incident
wave measurement. The compiler also automatically computes errorcorrected s11, s12, s21, and s22. The Output Port button, and
corresponding source/receive mode settings for Rf 2, Rf 3, Rf 6 and/
or Rf 7 buttons are used with the Input Port button.

‘source’ connects the input port Src 1 (C5) to the M26-T switch to
route a stimuli signal to output ports.
‘noise’ connects the internal noise diode Noise Source 1 to the M26-T
switch. This button setting is used in conjunction with the Noise Src
button to activate/deactivate the noise reference standard.
‘source2’ mode connects the Aux In (C2) to the internal switching
network for utilizing a second external source; to to drive RF output
ports selected by the Source 1, Rf 2: ‘receive-src1’ or Rf 3/Rf 6/Rf
7: ‘receive-src1’ buttons.

NOTE: The ‘Rf 4’ selection is a Small Cassini mode that is not supported in Cassini 16.

Output Port

Rf 6

Output Port
This drop down list selection button that designates which of the
input/output ports [RF2 (C7), RF3 (C3), RF6 (C8), or RF7 (C4)] will be
defined as the output port from the Device Under Test for protocol© Roos Instruments Inc.
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aware s/wave parameter measurements. This button activates the
compiler’s expert system mode to control and orchestrate the entire
internal switch network for all wave parameters measurements
automatically. This programming approach allows the user to avoid
having to setup the switching network for each load condition and
forward/incident wave measurement. The compiler also automatically
computes error-corrected s11, s12, s21, and s22. The Input Port
button, and corresponding source/receive mode settings for Rf 2, Rf
3, Rf 6 and/or Rf 7 buttons are used with the Output Port button.
NOTE: The ‘Rf 5’ selection is a Small Cassini mode that is not supported in Cassini 16.

Rec Attenuation

0db
Rec Attenuation
This drop down list selection button configures the receive attenuator
found at the common port output of the M14-B switch. The solidstate attenuator has calibrated attenuation steps of 0 dB, 10 dB, 20
dB, or 30 dB. This button is commonly used in s-parameter and
power measurement receive measurements to prevent overdriving/
saturating the downstream receiver’s RF front-end or optimizing the
RF input signal power for best dynamic range with the receiver.

© Roos Instruments Inc.

Receive Mode

s-parameters
Receive Mode
This drop down list selection button selects which resource is routed
to the output port Receiver Hi Out (C1) by directly setting the solid
state switch position of M14-B.
‘s-parameters’ connects Receiver Hi Out (C1) to the coupled ports
pairs RF2/RF3 (M14-B: Position 3) or RF6/RF7 (M14-B: Position 4)
depending on the settings of the Input Port, Output Port and the
Parameter buttons. For example, setting Output Port to ‘RF2’,
Input Port to ‘RF3’ and Parameter to ‘a1’ would route the incident
signal on the CP-2 coupler’s ‘a’ port to Receiver Hi Out (C1).
‘ref noise’ connects the Receiver Hi Out (C1) output port to the
internal noise reference standard(M14-B: Position 2).
NOTE: This noise reference is used as a stable power reference strictly for the
instrument’s internal self-check.

‘receiver’ connects the the Receiver Hi Out (C1) output port as a
direct receive path (M14-B: Position 1) typically for RF2 (C7), RF3
(C3), RF6 (C8), or RF7 (C4). Resource routing to the direct receive
path is dependent on the Load State button (controls M11-B), Input
Port button (controls M26-T), and by setting the Rf 2/Rf 3, Rf 6 or Rf
7 button to their receive mode setting.
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Load State

load

Parameter

a1

Parameter
Drop down list button that designates which of the coupler ports
[CP-2 (RF2), CP-3 (RF3), CP-6 (RF6), CP-7 (RF7)] will be routed to the
switching network. It is typically used for routing incident/reflected
wave signals to the receiver for wave/s-parameter measurements.
The ‘a1’, ‘b1’. ‘a2’, and ‘b2’ selections uses the compiler’s expert
system to automatically select the correct switch routing. These
selections require an RF port to be set by Input Port and Output
Port buttons and corresponding Rf 2/Rf 3, Rf 6 or Rf 7 button
selections.
The ‘rf2a’, ‘rf2b’, ‘rf3a’, ‘rf3b’, ‘rf6a’, ‘rf6b’, ‘rf7a’, or ‘rf7b’ selections
allow the user to explicitly control the port selection of switches B Top
and D Bottom shown at the top of the block diagram.
NOTE:
a1 is the incident wave to the input port of the device under test.
b1 is the reflected wave from the input port of the device under test.
a2 is the incident wave to the output port of the device under test.
b2 is the reflected wave from the output port of the device under test.

© Roos Instruments Inc.

Load State
Drop down list button that directly controls the solid state switch
M11-B.
The ‘source1’ selection is used to connect Src 1 (C5), Aux In (C2) or
Noise Source 1 to M11-B for routing these resources to RF2 (C7),
RF3 (C3), RF6 (C8), or RF7 (C4) using the “back-door” switching
route. The buttons Source 1: ‘Rf 2’ or ‘load’ | Source 1 Mode:
‘source’, ‘source2’, or ‘noise’ | Rf 2: ‘receive-src1’, and Rf 3: ‘src1noise’, Rf 6: ‘src1-noise’ or Rf 7: ‘src1-noise’ are used with this Load
State selection.
NOTE: The “backdoor” signal routing technique exploits the switching topology of the
solid-state switches to reduce settling times in measurements and wear of
electromechanical switches R-3, R-6, and R-7, helping to extend their lifecycle. Reference
Gallery 2 for example and suggested configurations.

“reflect” is used to connect a 50Ω “short” standard to RF2 (C7), RF3
(C3), RF6 (C8), or RF7 (C4). This provides a controlled RF reflection
condition for unidirectional s-parameter measurements. This button
selection commonly uses the Spar Mode: ‘unidirectional’, Input
Port, Output Port buttons and corresponding Rf 2/Rf 3, Rf 6 or Rf
7 buttons.
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“load” is used to connect a 50Ω standard load to RF2 (C7), RF3 (C3),
RF6 (C8), or RF7 (C4). This provides a controlled RF matching
condition for s-parameter measurements. This button selection
commonly uses the Spar Mode, Input Port, Output Port buttons
and corresponding Rf 2/Rf 3, Rf 6 or Rf 7 buttons.
‘receive’ is used to connect the intermediary signal route from RF2
(C7), RF3 (C3), RF6 (C8), or RF7 (C4) to the Receiver Hi Out (C1)
output port for receiver type measurements. This button selection
commonly uses the Receive Mode: ‘receiver’, Rf 2: ‘receive-src1’,
Rf 3: ‘receive’, Rf 6: ‘receive’, or Rf 7: ‘receive’ button settings in test
panels.
Noise Src

oﬀ

Noise Src
Drop down list button that controls the state of the internal noise
source standard Noise Source 1.
The ‘On’ selection powers the noise source, producing an RF
calibrated “Hot” noise power.

Rf Input Offset

0db
Rf Input Offset
This list select button directly controls the receive attenuator and LNA
for the Receive Hi Out (C1) port. They are located between the last
solid state switch (M14-B) and the Receive Hi Out (C1) port in the
block diagram. The receive attenuator and LNA allow the user to
optimize incoming signal power levels typically to prevent saturation of
the receiver’s RF mixers. This is useful for compensating for the gain
of active device, or losses from passive components for s-parameter/
receiver type measurements.
The list options ‘-30’, ‘-20’, ‘-10’, ‘0’, ‘10’, ‘20’, ‘30’ are displayed in
units of dB.
NOTE: Saturation of the downstream RF mixers in the receiver TIM will cause
nonlinear behavior in the form of signal harmonics at the downconverter’s output and
unstable measurements.

The ‘Off’ selection deactivates power from the noise diode. This mode
can be used for so called “cold” noise power measurements.
NOTE: The calibration factors for Noise Source 1 are frequency dependent and are
selected by the compiler based on the Frequency button definition found in the System
instrument of the Edit Panel.
© Roos Instruments Inc.
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If Input Offset

GALLERY 2 RI8545 EXAMPLE TOPOLOGIES

0db

If Input Offset
This list select button is a modifier of the If Gain button value found in
the RI8587 or RI8581 Receiver TIM. It provides relative IF gain
modification, i.e If Gain: ’38’ and If Input Oﬀset: ‘-30’ would result in
an actual IF Gain in the receiver of ‘8’. This button is typically used to
offset output signals from high-gain devices or losses from passive
DUTs to maintain consistent signal power into the receiver.
The list options ‘-36’, ‘-30’, ‘-24’, ‘-18’, ‘-12’, ‘-6’, ‘0’, ‘6’, ‘12’, ‘18’,
‘24’, ‘30’ and ‘36’) are in units of dB.

Measuring Src 1 with the Receiver (Thru Measurement)
Example: The signal at Src 1 (C5) is routed to the receiver. This is a
common diagnostic setup used to confirm test plans route the source/
receive paths as expected. The RF3 (C3) port is terminated with a
standard 50Ω termination to reduce signal ripple and using a VNA
type or s-parameter measurement provides the signal at Src1 (C5) via
the the a1 term (incident wave).

© Roos Instruments Inc.
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PANEL: MEASUREMENTS

NOTE: At higher frequencies and with averages greater than 8 to 16, some improvement
in accuracy and repeatability are often achieved using the adjacent averaging mode.
Average Mode

std

Spar Mode

Average Mode
A drop down list button that is associated with the higher-level macro
measurement buttons that sets the method of averaging used.
The “std” mode uses the number of Averages set by the System
Button when measuring and completes all the averages of each of the
parameters in a high-level macro button before moving to the next
parameter. For example, on an S11 measurement with 4 averages,
the tester would measure a1, a1, a1, a1, then b1, b1, b1, b1. This is the
fastest averaging mode, but if the signal drifts while the a1
measurements are being made, the measurement can be less
accurate.
The “adjacent” mode uses the number of Averages set by the
System Button as above, but when measuring to satisfy a high-level
macro button, it takes data from each of the parameters needed one
at a time, before completing another round of measurements for the
average. For example, on an S11 measurement with 4 averages, the
tester would measure a1, b1, a1, b1, a1, b1, a1, b1. This makes the a1
and b1 measurements virtually simultaneous. The “adjacent
averaging” mode is slightly slower than the “std” mode, but can
minimize the effects of any signal drift especially for large number of
averages.
© Roos Instruments Inc.

unidirectional

Spar Mode
This list select button defines the calculation mode for two-port,
vector error-corrected scattering parameters. The mode selection
affects the compiler’s decisions for load and source routing schemes
in the TIM and the subsequent calculation methods for s/wave
parameter measurements.
The ‘unidirectional’ mode computes s-parameters by only applying
the source to the input of the DUT and using a bi-state, load pull
condition on the output port to compute the a1, b1, and b2 wave
parameters. This mode infers the a2 wave parameter and thus S22,
and is faster than the bidirectional mode. Unidirectional mode is
optimal for unilateral active devices (essentially zero reverse
transmission coefficient, i.e. S12=0) such as power amplifiers.
The ‘bidirectional’ mode computes s-parameters using the traditional
switched source methodology for measuring all eight transmission
parameters and then computing scattering parameters. This selection
executes all four source/load conditions on the DUT, providing the
most accurate s/wave parameters possible. The bidirectional mode is
optimal for passive, low-gain, or low-loss devices.
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This button is commonly used with the Input Port, Output Port,
Parameter, Receive Mode: ‘s-parameter’ and corresponding Rf 2,
Rf 3, Rf 6 or Rf 7 button designations.

Meas: Wave Param at Output Freq
MEAS

Wave Param at Output Freq

A

Meas: Wave Param at Input Freq
MEAS

Wave Param at Input Freq

A

Measurement block performs a two-port, error-corrected wave
parameter measurement resulting in all 8 transmission parameters:
a11, a12, a21, a22, b11, b12, b21, b22 for a given device input frequency. It
uses the bi-state load pull method with the result in absolute voltage.
The receiver’s tuned frequency for this button is defined by the Freq
Reference, Input Freq Oﬀset, and/or Input Freq Scale buttons
found in the System instrument panel. This block is typically used for
user-custom s/wave parameter-like calculations.
NOTE: The frequency control button set is typically used for measuring frequency
converting devices.

Measurement block performs a two-port, error-corrected wave
parameter measurement resulting in all 8 transmission parameters:
a11, a12, a21, a22, b11, b12, b21, b22 for a given device output frequency.
It uses the bi-state load pull method with the result in absolute
voltage. The receiver’s tuned frequency for this button is defined by
the Freq Reference, Output Freq Oﬀset, and/or Out Freq Scale
buttons found in the System instrument panel. This block is typically
used for user-custom s/wave parameter-like calculations.
NOTE: The frequency control button set is typically used for measuring frequency
converting devices.

Meas: Wave Param at Receive Freq
MEAS

Wave Param at Receive Freq

A

Measurement block performs a two-port, error-corrected wave
parameter measurement resulting in all 8 transmission parameters:
a11, a12, a21, a22, b11, b12, b21, b22 for a given frequency. It uses the bistate load pull method with the result in absolute voltage. The
© Roos Instruments Inc.
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receiver’s tuned frequency for this button is defined by the
Frequency, and/or Freq Oﬀset buttons found in the Receiver’s
instrument panel. This block is typically used for user-custom s/wave
parameter-like calculations.

Meas: Thru Measurement at Input Freq
MEAS

Thru Measurement at Input Freq

A

NOTE: The phase is only defined within a set and not with any other readings.

Meas: InputPower at Input Freq
MEAS

Input Power at Input Freq

A

Performs an error-corrected a11 (forward or incident wave at input with
output terminated) and b21 (wave at terminated output with source at
input) measurement with the receiver frequency defined by defined by
the Freq Reference, Input Freq Oﬀset, and/or Input Freq Scale
buttons found in the System instrument panel. The resulting data is
corrected absolute power, with default units of Watts.
NOTE: The phase is only defined within a test and not with any other readings.

Measurement block performs an error-corrected a11 (forward or
incident wave at input with output terminated) measurement with the
receiver set to measure at the frequency defined by the Freq
Reference, Input Freq Offset, and/or Input Freq Scale buttons found in
the System instrument panel. The resulting data is corrected absolute
power, with default units of Watts
NOTE: Units can be changed to dBm using the Convert button found in System >
General Calculation panel.

© Roos Instruments Inc.

291

Graphical Programming | RI8545: 0.1 to 20 GHz TestSet

Cassini ATE System Reference Guide

The ‘pulse off’ selection deactivates the RF pulse signal defined by
the Pulse Width button.

PANEL: PULSE AND SEQUENCE
Pulse Width

0

Pulse Width
Decimal notation input button in units of µs used in premeasure
groups to generate a narrow RF pulse by switching the Source 1
Mode solid-state switch (M11-T in the block diagram) from the Src 1
(C1) port to the internal Noise Source 1 port. This button is used in
conjunction with the Measure Mode:pulse button setting and Src 1
Seq button.

The ‘Rf 3’ selection sets the M26-T switch to route the RF pulse
signal to the ‘src1-noise’ port of the R-3 relay.
The ‘Rf 6’ selection sets the M26-T switch to route the RF pulse
signal to the ‘src1-noise’ port of the R-6 relay.
The ‘Rf 7’ selection sets the M26-T switch to route the RF pulse
signal to the ‘src1-noise’ port of the R-7 relay.

Measure Mode

cw

Src 1 Seq

restore

Src 1 Seq
This drop down list selection button is used strictly in premeasure
groups to temporarily override buttons that control the routing of the
M26-T solid state switch in s/wave parameter measurements for
custom RF pulse applications.
The ‘restore’ selection reverts the switch settings and control back to
the last panel, section default, or global defaults set by the buttons
found in the RF Setup panel.
The ‘pulse on’ selection activates the RF pulse signal defined by the
Pulse Width button.
© Roos Instruments Inc.

Measure Mode
This drop down list selection button is used in test panels or section
defaults to control the state of the RF pulse width function. The
default start position is the Noise Source 1 path (effectively
disconnected from Src 1 (C5) input.
The ‘cw’ selection is the default value and provides continuous wave
operation.
The ‘pulse’ selection enables short duration sourcing operation with
the Pulse Width button setting defining the pulse duration and the
Src 1 Seq button defining the signal routing.
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CONTROL PANELS
Real-time control of the routing of instruments through this TIM.

C ONTROL P ANELS 4 RI8545 0.1 TO 20GHZ TESTSET

RF Control Panel provides real time control of routing through the
Testset.

© Roos Instruments Inc.
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Rf 2

Output Port

Configure the connections to this RF port. Either a connection to
Source1 or to Source3.

Select the output port for measurement. Independent of the “Rf” port
connections, this button selects which port to measure as the input.

Rf 3

Noise Src

Configure the connections to this RF port. Either a connection to
Source1-Noise source or the receive path.

Turn the noise source used for noise figure on and off.

Rf 6

Load State
Sets the state for the output port to load.

Configure the connections to this RF port. Either a connection to
Source1-Noise source or the receive path.

Receive Mode

Rf 7

Sets the receive path to receive using the noise detector (scalar) or sparameter detector (vector with phase and magnitude).

Configure the connections to this RF port. Either a connection to
Source1-Noise source or the receive path.

Rec Attenuation

Source 1

Set the attenuation in the s-parameter and power measurement
paths.

Sets the port which is connected to Source1.

Source 1 Mode
Set the Source1 mode to be either the RF source or a noise source.

Input Port

Parameters-parameter
Select the wave parameter for measurement, a1 is incident.

Noise Reference
Turn the noise source used for drift calibration on and off.

Select the input port for measurement. Independent of the “Rf” port
connections, this button selects which port to measure as the input.
© Roos Instruments Inc.
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TOPICS

Instruments Provided by this TIM
Edit Panel Button Descriptions
Static Digital Button Modes
Control Panel
Tap the links above to quickly access content

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM

Graphical Programming | RI8546: Device Power/Measure

D IAGRAM 1 RI8546 DEVICE POWER - INSTRUMENTS

The instrument in this TIM appear as DutControl, PowerVI,
StaticDigital in the panel dialog windows.
Model and Name as it appears in the Tester Configuration:
• DutControl, Ri7421x Dut Control
• PowerVI, RI7431x High Current Supplies
• StaticDigital, RI74311x 16-bit Device Digital Controller
NOTE: Multiple RI8546 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e DutControl,PowerVI,StaticDigital ; DutControl2,PowerVI2,StaticDigital2;
DutControl3,PowerVI3,StaticDigital3 ; etc.).
The “x” in the instrument names denotes the model revision number.

DUT Control, Static Digital, and Power VI instruments with the RI8546

© Roos Instruments Inc.
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DUTCONTROL

EDIT PANELS
Automated control of the instruments in this TIM with use by the Test
Plan Editor.

PANEL: DEVICE POWER 1 TO 8

E DIT P ANELS 6 RI8546 DEVICE POWER

See Example D at the end of the Edit Panels section for example
measurements using the device power pins.
Device Power 1

open
Device Power 1 through Device Power 8
Drop down list buttons that individually control the state of each of the
power supply pins independently. This bank of 8 device power pins
can be connected to a voltage or current resource (Meas I/V 1/2/3/4),
a precision voltage measure resource (Monitor→DPVP Meas I/V), or
power supplies VCC3 and/or VCC4 via a switching network in the
DUT Control subsystem, see Diagram 1.
The default ‘open’ selection disconnects the designated Device
Power pin from all instrument resources by setting the switch state to
the “open” position, leaving the pin in a DC floating state.

DUTControl device power 1 to 8 provide access to individual pin
states and shared control of Voltage and Current.

The ‘Vcc3’ selection connects the designated Device Power pin to
the VCC3 ±10 V, 200 mA power supply for sourcing DC voltage. This
setting is used with the Vcc3 and Icc3 Max buttons.

1 of 12

© Roos Instruments Inc.
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The ‘Vcc4’ selection connects the designated Device Power pin to
the VCC4 ±10 V, 200 mA power supply for sourcing DC voltage. This
setting is used with the Vcc4 and Icc4 Max buttons.
The ‘both’ selection connects VCC3 ±10 V, 200 mA and VCC4 ±10 V,
200 mA power supplies in parallel to the designated Device Power pin
for sourcing DC voltage. This mode is used for supplying drive
currents up to 450 mA with Device Power pins. This setting is used
with the Vcc3, Icc3 Max, Vcc4, and Icc4 Max buttons.

Vcc 4

Vcc 4

0

Decimal notation input button that sets the voltage for the VCC4 ±10
V, 200 mA power supply that services Device Power pins 1-8. The
input is in units of volts with a resolution of 0.3mV and a voltage
accuracy of ±10 mV.
Icc 3 Max

NOTE: The Vcc3 and Vcc4 buttons must be set to the same voltage and the Icc3 Max/
Icc4 Max buttons must be set to the same expected current value for proper function.

The ‘precision’ selection connects the designated Device Power pin
to the precision voltage measure instrument DPVP Meas I/V via the
monitor multiplexer. This mode is used for measuring currents in the
pA range and for force voltage or current and measure current/voltage
measurements.

0.35
Icc 3 Max
Decimal notation input button that sets the maximum current limit for
VCC3 ±10 V, 200 mA power supply that services Device Power pins
1-8. This is used to prevent excessive current from damaging DUT
pins in the event of DC shorts or DUT failures. The input is in units of
amps with a resolution of 10µA. A negative current value will sink the
specified current value from the Device Power pin/s connected to
VCC3.

Vcc 3

Vcc 3

0

NOTE: Clamping the current value for VCC3 below the required drive voltage can
result in insufficient voltage at the designated Device Power pin.

Decimal notation input button that sets the voltage for the VCC3 ±10
V, 200 mA power supply that services Device Power pins 1-8. The
input is in units of volts with a resolution of 0.3mV and a voltage
accuracy of ±10mV.
© Roos Instruments Inc.
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Icc 4 Max

PANEL: MEASUREMENTS

0.35
Icc 4 Max
Decimal notation input button that sets the maximum current limit for
VCC4 ±10 V, 200 mA power supply that services Device Power pins
1-8. This is used to prevent excessive current from damaging DUT
pins in the event of DC shorts or DUT failures. The input is in units of
amps with a resolution of 10µA. A negative current value will sink the
specified current value from the Device Power pin/s connected to
VCC4.
NOTE: Clamping the current value for VCC4 below the required drive voltage can
result in insufficient voltage at the designated Device Power pin.

See Example D at the end of the Edit Panels section for example
measurements using the Vmeasure pins.
Voltage Meas Max

10
Voltage Meas Max
Decimal notation input button that sets the maximum expected
voltage amplitude for DC voltage measurements using the Meas I/V
1/2/3/4 (VCC1/VCC2/VCC3/VCC4), Meas I/V 5/6/7/8 (VCC5/VCC6/
VCC7/VCC8), or VMeasure resources (VM1-VM4/VM1N-VM4N). The
setting optimizes the dynamic range of the internal ADC’s input to
within one of four voltage ranges: <10 V, <1 V, <100 mV, and <10 mV
(i.e - a button value of 150 mV will select the input range to <1 V for
the ADC). Input values are in units of volts with a maximum value of
10 V. Input values are in units of volts with a maximum value of 10 V.
This button is commonly used with the Vmeasure and/or Voltage
Meas Mode buttons and paired with a Voltage measurement block.
Current Meas Max

1
Current Meas Max
Decimal notation input button that sets the maximum expected
current amplitude for DC current measurements using the Meas I/V
© Roos Instruments Inc.
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1/2/3/4 (VCC1/VCC2/VCC3/VCC4), Meas I/V 5/6/7/8 (VCC5/VCC6/
VCC7/VCC8), or VMeasure resources (VM1-VM4/VM1N-VM4N). The
setting optimizes the dynamic range of the internal ADC’s input to
within one of four sense resistor ranges: <250 mA, <25 mA, <2.5 mA,
and <250 µA (i.e - a button value of 10 mA will select the dynamic
range to <25 mA for the ADC). Input values are in units of amps with
an effective maximum value of 250 mA. This button is commonly used
with the Imeasure and/or Imeasure Bw buttons and paired with a
Current measurement block.
Samples

21
Samples
Decimal notation-value button that sets the total number of samples
in a voltage versus time measurement. This button is commonly used
with the Meas Rate button and Voltage Vs Time measurement
block.
NOTE: Maximum number of samples is 100.

Voltage Meas Mode

single
Voltage Meas Mode
Drop down list button that sets the mode of the Vmeasure resources
(VM1-VM4/VM1N-VM4N). This button is commonly used with the
Vmeasure and Voltage Meas Max buttons.
The ‘single’ selection measures voltages on VM1-VM4 or VM1NVM4N pins individually as single-ended or ground-referenced voltage
measures using a fast 12-bit DAC.
The ‘single-Hi Res’ selection measures voltages on VM1-VM4 or
VM1N-VM4N pins individually as single-ended or ground-referenced
voltage measures using a precision 24-bit DAC with 17mS/sample
rate.
The ‘diff’ selection measures differential voltages on VM1-VM4 and
VM1N-VM4N pin pairs (i.e. - the voltage across pins VM1 and VM1N
or VM4 and VM4N) using a fast 12-bit DAC.
The ‘diff-Hi Res’ selection measures differential voltages on VM1-VM4
and VM1N-VM4N pin pairs using a precision 24-bit DAC with 17mS/
sample rate.

© Roos Instruments Inc.
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VCC2, ..VCC8). This button is paired with a Voltage measurement
block.

Imeasure

Vcc1
Imeasure

Imeasure Bw

Drop down list button that chooses the resource pin for a current
measurement. The list options are any of the Device Power supplies
(VCC1, VCC2, ..VCC8). This button is paired with a Current
measurement block.
Meas Rate

20000
Meas Rate
Decimal notation input button that sets the measure sample rate for a
voltage versus time measurement. The sample rate is in units of Hz
with a maximum value of 50 kHz. This button is paired with a Voltage
Vs Time button within a test panel and is commonly used with a
Samples, Voltage Meas Max, and Vmeas button within a test
panel/section default.
Vmeasure

Vm1

fast
Imeasure Bw
Drop down list button that sets the bandwidth of the current
measurement resource within Meas I/V 1/2/3/4 and/or Meas I/V
5/6/7/8.
The ‘fast’ selection is the default mode.
The ‘slow’ selection is used to reduce noise for sensitivity and/or lowcurrent (<2.5mA) measurements.
MEAS
Voltage

A

Meas: Voltage
Measurement block that evaluates the voltage at a resource pin
selected by the Vmeasure button. The measurement result is in units
of volts, with a maximum measure value of ±10V DC.

Vmeasure
Drop down list button that chooses the resource pin for a voltage
measurement. The list options are any Vmeasure resource pin (VM1VM4/VM1N-VM4N) or one of the Device Power supplies (VCC1,
© Roos Instruments Inc.
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PANEL: DEVICE POWER 9 TO 16

MEAS
Current

A

See Example D at the end of the section for example measurements
using the Device Power pins.

Meas: Current
Measurement block that evaluates the current at a resource pin
selected by the Imeasure button. The measurement result is in units
of amps.

open
Device Power 9 through Device Power 16

MEAS
Voltage Vs Time

Device Power 9

A

Meas: Voltage Vs Time
Measurement block that evaluates the voltage relative to time at pin
selected by the Vmeasure button. This button uses the Samples
and Meas Rate to configure the measurement parameters. Results
are output in RiVoltageVsTimeInt data type.

Drop down list buttons that individually control the state of each of the
power supply pins independently. This bank of 8 device power pins
can be connected to a voltage or current resource (Meas I/V 1/2/3/4),
a precision voltage measure resource (Monitor→DPVP Meas I/V), or
power supplies VCC1 and/or VCC2 via a switching network in the
DUT Control subsystem, see Interactive 8.
The default ‘open’ selection disconnects the designated Device
Power pin from all instrument resources by setting the switch state to
the “open” position, leaving the pin in a DC floating state.
The ‘Vcc1’ selection connects the designated Device Power pin to
the VCC1 ±10V, 200mA power supply for sourcing DC voltage. This
setting is used with the Vcc1 and Icc1 Max buttons.
The ‘Vcc2’ selection connects the designated Device Power pin to
the VCC2 ±10V, 200mA power supply for sourcing DC voltage. This
setting is used with the Vcc2 and Icc2 Max buttons.

© Roos Instruments Inc.
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The ‘both’ selection connects VCC1 ±10V, 200mA and VCC2 ±10V,
200mA power supplies in parallel to the designated Device Power pin
for sourcing DC voltage. This mode is used for supplying drive
currents up to 450mA with Device Power pins 9 through 16. This
setting is used with the Vcc1, Icc1 Max, Vcc2, and Icc2 Max
buttons.
NOTE: The Vcc1 and Vcc2 buttons must be set to the same voltage and the Icc1 Max/
Icc2 Max buttons must be set to the same expected current value for proper function.

Vcc 2

Vcc 2

0

Decimal notation input button that sets the voltage for the VCC2
±10V, 200mA power supply that services Device Power pins 9-16.
The input is in units of volts with a resolution of 0.3mV and a voltage
accuracy of ±10mV.
Icc 1 Max

0.35
The ‘precision’ selection connects the designated Device Power pin
to the precision voltage measure instrument DPVP Meas I/V via the
Monitor multiplexer. This mode is used for measuring currents in the
pA range and for force voltage or current and measure current/voltage
measurements.
Vcc 1

Vcc 1

0

Decimal notation input button that sets the voltage for the VCC3
±10V, 200mA power supply that services Device Power pins 9-16.
The input is in units of volts with a resolution of 0.3mV with a voltage
accuracy of ±10mV.

© Roos Instruments Inc.

Icc 1 Max
Decimal notation input button that sets the maximum current limit for
VCC1 ±10V, 200mA power supply that services Device Power pins
9-16. This is used to prevent excessive current from damaging DUT
pins in the event of DC shorts or DUT failures. The input is in units of
amps with a resolution of 10µA. A negative current value will sink the
specified current value from the Device Power pin/s connected to
VCC1.
NOTE: Clamping the current value for VCC1 below the required drive voltage can result
in insufficient voltage at the designated Device Power pin.
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Icc 2 Max

PANEL: VCC5 6 7 8

0.35
Icc 2 Max
Decimal notation input button that sets the maximum current limit for
VCC2 ±10V, 200mA power supply that services Device Power pins
9-16. This is used to prevent excessive current from damaging DUT
pins in the event of DC shorts or DUT failures. The input is in units of
amps with a resolution of 10µA. A negative current value will sink the
specified current value from the Device Power pin/s connected to
VCC2.
NOTE: Clamping the current value for VCC2 below the required drive voltage can
result in insufficient voltage at the designated Device Power pin.

See Example D at the end of the Edit Panels section for example
measurements using the VCC pins.
Vcc 5

0
Vcc 5 through Vcc 8
Decimal notation input buttons that set the individual voltage for the
associated, independent power supplies (VCC5, VCC6, VCC7,
VCC8). The input is in units of volts with a resolution of 0.3mV and a
voltage accuracy of ±10mV.
Vcc 5 Sense

internal
Vcc 5 Sense through Vcc 8 Sense
Drop down list buttons that sets the feedback voltage sense mode for
the associated independent power supplies (VCC5, VCC6, VCC7,
VCC8). The voltage sense feedback system regulates the voltage
value of the supply/pin.
The ‘internal’ selection sets the voltage feedback mode to use the
internal sense resistor and Meas I/V 5/6/7/8 resource connected
between the power supply the associated VCC pin. For example,
between the VCC6 ±10V, 200mA power supply and VCC6F (Force)
pin.
© Roos Instruments Inc.
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The ‘external’ selection sets the voltage feedback mode to use the
sense line (i.e. - for VCC6F, the VCC6S pin would be used to provide
voltage feedback regulation. This mode is used to compensate for
ohmic losses in the device interface between the resource output pin
on the TIM and the device under test. The VCC#S (Sense) pin is
connected in near the device pin using the associated VCC#F (Force)
pin, providing a low-loss DC feedback path to compensate for voltage
loss and ensure accurate voltage at the device pin.
Vcc 5 Output

oﬀ

Icc 5 Max

0.35
Icc 5 Max through Icc 8 Max
Decimal notation input buttons that set the individual maximum
current limit for the independent power supplies (VCC5 ±10 V, 200
mA; VCC6 ±10 V, 200 mA; VCC7 ±10 V, 200 mA; VCC8 ±10 V, 200
mA). This is used to prevent excessive current from damaging DUT
pins in the event of DC shorts or DUT failures. The input is in units of
amps with a resolution of 10 µA. A negative current value will sink the
specified current value from the associated VCC#F (Force) pin/s.

Vcc 5 Output through Vcc 8 Output
Drop down list buttons that control the individual relays between the
power supplies (VCC5 ±10V, 200 mA; VCC6 ±10V, 200 mA; VCC7
±10V, 200 mA; VCC8 ±10V, 200 mA and the VCC# force/sense
resource pins).

NOTE: Clamping the current value for VCCs below the required drive voltage can result
in insufficient voltage at the resource pin.

The ‘on’ selection connects the supply to its associated resource
pins.
The ‘off’ selection disconnects the supply from its associated
resource pins.

© Roos Instruments Inc.
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PANEL: PRECISION MEAS
See Example D at the end of the Edit Panels section for example
measurements using the precision measure resource.
Measure Mode

restricts the maximum voltage applied by DPVP ±10V, 2 mA during
the measurement. Typically the Measure V Limit button is set to the
DUT’s supply rail or ground depending on the polarity of the Measure
I Force button to avoid damaging the device pin.
NOTE: This mode is typically used for continuity tests or testing protection diodes on
DUT pins.

none
Measure Mode
Drop down list button that sets the mode of the precision measure
instrument (DPVP Meas I/V).
The ‘none’ selection disconnects the precision measure resource from
the monitor line.
The ‘vm’ selection is the volt meter mode. This provides precision
voltage measure with an extremely high series resistance (1MΩ) much
the same as a standard volt meter.
The ‘Imeas’ selection forces a voltage defined by the Measure V
Force button and measures the resulting current for the selected
resource using the Measure Pin. The Measure I Limit button
restricts the maximum amount of current delivered by the supply
(DPVP ±10 V, 2 mA) during the measurement to avoid damaging the
device pin if there is a DUT failure.
The ‘vMeas’ selection forces a current defined by the Measure I
Force button and measures the resulting voltage for the selected
resource using the Measure Pin. The Measure V Limit button
© Roos Instruments Inc.

The ‘low Current’ selection measures the current for a selected
resource defined by the Measure Pin. This mode sets the precision
measure’s sense resistor to it’s lowest current measurement range
and incorporates a built-in, recursive averaging method to measure
DC currents in the pA range.
The ‘vCal’ selection is the same mode as the ‘vMeas’ mode with the
exception that the current limit settings are deactivated. The value set
with the Measure I Limit is ignored, and the supply (DPVP ±10V, 2
mA) will push as much available current as possible to force the
voltage defined by the Measure V Force button.
NOTE: This mode is typically used in continuity tests for device pins with large in-rush
currents or long duration time constants during power up.

The ‘iCal’ selection is the same mode as the ‘Imeas’ mode with the
exception that the voltage limit settings are deactivated. The value set
with the Measure V Limit is ignored, and the supply (DPVP ±10V, 2
306

Graphical Programming | RI8546: Device Power/Measure

Cassini ATE System Reference Guide
mA) will provide as much available voltage as possible to force the
current condition defined by the Measure I Force button.
NOTE: Use caution with this mode, as pin voltages can exceed the rail voltages of the
device under test.

Vcc Measure Pin

None
Vcc Measure Pin

Measure I Force

0
Measure I Force
Decimal notation button that sets the value of the current force
condition for the Measure Mode: ‘vMeas’ setting. The condition is
applied to the resource designated by the Vcc Measure Pin or
Measure Pin button. The values are input in units of amps.
NOTE: Setting a value of 0 can cause unexpected or irregular current or voltage
measurement conditions at the device pin.

Drop down list button that chooses which of the independent VCC
supplies (VCC5 ±10V, 200 mA; VCC6 ±10V, 200 mA; VCC7 ±10V,
200 mA; VCC8 ±10V, 200 mA) to measure with the precision measure
instrument (DPVP Meas I/V) via the Monitor connection.
Measure V Force

0
Measure V Force
Decimal notation button that sets the value of the voltage force
condition for the Measure Mode: ‘Imeas’ setting. The condition is
applied to the resource designated by the Vcc Measure Pin or
Measure Pin button. The values are input in units of volts.

© Roos Instruments Inc.

Measure V Limit

0
Measure V Limit
Decimal notation input button that sets the maximum voltage
amplitude for the Measure Mode: ‘vMeas’ button setting. This
setting enables internal voltage-limiting in the precision measure
supply (DPVP ±10V, 2 mA) to prevent damaging a DUT pin from
unwanted and/or excessive voltage caused by the Measure I Force
button current criterion.
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Measure I Limit

Measure Pin

0

none

Measure I Limit

Measure Pin

Decimal notation input button that sets the maximum current
amplitude for the Measure Mode: ‘Imeas’ button setting. This setting
enables internal current-limiting diodes in the precision measure’s
supply (DPVP ±10V, 2 mA) to prevent damaging a DUT pin from
unwanted and/or excessive current caused by the the Measure V
Force button voltage criterion.

Drop down list button that choose the pin resource to be measured.
This button is used with the Measure Mode button and associated
measurement parameter buttons defined therein.

NOTE: Setting a value of 0 can cause unexpected or irregular current/voltage
measurement conditions at the device pin.

Current Meas Max

1

Measure Time

0
Measure Time
Decimal notation input button that sets the measurement span in
units of seconds for the Precision VoltageVsTime and Precision
CurrentVsTime measurement blocks. This button is used with the
Meas Rate button, where the total number of samples (i.e Meas
Rate * Measure Time values) must not exceed 2000.
Measure Rate

Current Meas Max
The decimal notation input button optimizes the dynamic range of the
internal ADC’s input to within one of four sense resistor ranges: <2
mA, <200 µA, <20 µA, and <2 µA (i.e. a button value of 500 mA will
select the dynamic range to <2 mA for the ADC). This button is used
with the Measure Mode:‘Imeas’, ‘iCal’, or ‘low Current’, Measure
Pin, and or Vcc Measure Pin buttons.

© Roos Instruments Inc.

20000
Meas Rate
Decimal notation input button used with the Measure Time button
that defines the sample rate for Precision VoltageVsTime and
Precision CurrentVsTime measurement blocks. The button value is
listed in units of Hz with a maximum sample rate of 50 kHz.
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MEAS
Precision Current

MEAS
A

Precision Voltage

A

Meas: Precision Current

Meas: Precision Voltage

Measurement block that computes the current at a resource pin via
the Monitor→DPVP Meas I/V. The maximum measurable current is 2
mA. A resource to measure is selected by one of the following buttons
or groups of buttons:

Measurement block that computes the voltage at a resource pin via
the Monitor→DPVP Meas I/V. The maximum measurable voltage is
±10 V. A resource to measure is selected by one of the following
buttons or groups of buttons:

Measure Pin button found in the “precision meas” instrument panel
of the DutControl for one for one of the device power buttons:
DP1..DP16

Measure Pin button found in the “precision meas” panel of the
DutControl instrument for one for one of the device power buttons:
DP1..DP16

Measure Pin:‘Vm’ button found in the “precision meas” panel of the
DutControl instrument, Vmeasure (to select which Vmeasure pin:
VM1..4 or VM1N..VM4N), and Voltage Meas Mode:‘single-Hi Res’
buttons found in the “measurements” instrument panel of the
DutControl.

Measure Pin:‘Vm’ button found in the “precision meas” panel of the
DutControl instrument, Vmeasure (to select which Vmeasure pin:
VM1..4 or VM1N..VM4N), and Voltage Meas Mode:‘single-Hi Res’
buttons found in the “measurements” instrument panel of the
DutControl.

Measure Pin button found in the “measure” panel of the StaticDigital
instrument for DB1..DB16.

Measure Pin button found in the “measure” panel of the StaticDigital
instrument for DB1..DB16.

Measure Pin button found in the “measurements” panel of the
PowerVI instrument for V1 or V2.

Measure Pin button found in the “measurements” panel of the
PowerVI instrument for V1 or V2.

© Roos Instruments Inc.
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MEAS
Precision VoltageVsTime

MEAS
A

Precision CurrentVsTime

A

Meas: Precision VoltageVsTime

Meas: Precision CurrentVsTime

Measurement block that computes sampled voltage over time at a
resource pin via the Monitor→DPVP Meas I/V. This block uses the
Measure Time and Meas Rate buttons to define the sampling
parameters. The maximum measurable voltage is ±10 V. A resource
to measure is selected by one of the following buttons or groups of
buttons:

Measurement block that outputs sampled current over time at a
resource pin via the Monitor→DPVP Meas I/V. This block uses the
Measure Time and Meas Rate buttons to define the sampling
parameters. The maximum measurable current is 2 mA. A resource to
measure is selected by one of the following buttons or groups of
buttons:

Measure Pin button found in the “precision meas” panel of the
DutControl instrument for one for one of the device power buttons:
DP1..DP16

Measure Pin button found in the “precision meas” panel of the
DutControl instrument for one for one of the device power buttons:
DP1..DP16

Measure Pin:‘Vm’ button found in the “precision meas” pane of the
DutControl instrument, Vmeasure (to select which Vmeasure pin:
VM1..4 or VM1N..VM4N), and Voltage Meas Mode:‘single-Hi Res’
buttons found in the “measurements” instrument panel of the
DutControl.

Measure Pin:‘Vm’ button found in the “precision meas” panel of the
DutControl instrument, Vmeasure (to select which Vmeasure pin:
VM1..4 or VM1N..VM4N), and Voltage Meas Mode:‘single-Hi Res’
buttons found in the “measurements” instrument panel of the
DutControl.

Measure Pin button found in the “measure” panel of the StaticDigital
instrument for DB1..DB16.

Measure Pin button found in the “measure” panel of the StaticDigital
instrument for DB1..DB16.

Measure Pin button found in the “measurements” panel of the
PowerVI instrument for V1 or V2.

Measure Pin button found in the “measurements” panel of the
PowerVI instrument for V1 or V2.

© Roos Instruments Inc.
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PANEL: CURRENT FORCE
See Example D at the end of the Edit Panels section for example
measurements using the current force modes.
Vcc 1 Mode

voltage

7 buttons. The sense feedback corrects for ohmic losses through the
device interface, providing a corrected voltage value at the DUT pin
that is independent of the load resistance or output current (up to
~230 mA) on the designated supply pin.
NOTE: The sense resource pin must be connected to the supply resource pin close to the
DUT to provide accurate voltage-sense feedback correction. It is recommended to use
low-loss wire.

Vcc 1/3/5/7 Mode
Drop down list buttons that individually set the modes of the
independent supplies VCC1 ±10 V, 200 mA, VCC3 ±10 V, 200 mA,
VCC5 ±10 V, 200 mA, or VCC7 ±10 V, 200 mA.
The ‘voltage’ selection sets the associated supply to operate as a
voltage source, maintaining a fixed voltage value specified by the Vcc
1, Icc 3, Icc 5, or Vcc 7 buttons, independent of the load resistance
or output current (up to ~230 mA) on the designated supply pin.
The ‘current’ selection sets the associated supply to operate as a
current source, delivering or absorbing a current specified by the Icc
1, Icc 3, Icc 5, or Icc 7 buttons, independent of voltage on the
designated supply pin. The Vcc 1/3/5/7 Max and Vcc 1/3/5/7 Min
buttons clamp the voltage swing range within a user-specified range
for this mode.

Icc 1

0
Icc 1/3/5/7
Decimal notation input buttons that define the independent forcing
current conditions for VCC1 ±10 V, 200 mA, VCC3 ±10 V, 200 mA,
VCC5 ±10 V, 200 mA, or VCC7 ±10 V, 200 mA supplies. The range of
valid input values is ±200 mA with a resolution of 10 µA. This button is
used with it’s associated Vcc 1/3/5/7 Mode: ‘current’ button, and
Vcc 1/3/5/7 Min/Max buttons.
NOTE: Only VCC1, VCC3, VCC5, and VCC7 supplies are capable of functioning as
current sources. Setting a value of 0 can cause unexpected or irregular current or voltage
measurement conditions at the device pin.

The ‘vExtS’ selection sets the supply to operate as a voltage source,
using the external sense pin resource as a feedback loop to force a
“calibrated” voltage value specified by the Vcc 1, Icc 3, Icc 5, or Vcc
© Roos Instruments Inc.
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Vcc 1 Max

15

POWERVI
PANEL: HI CURRENT POWER SUPPLIES

Vcc 1/3/5/7 Max
Decimal notation input buttons that define the independent maximum
voltage condition for VCC1 ±10 V, 200 mA, VCC3 ±10 V, 200 mA,
VCC5 ±10 V, 200 mA, or VCC7 ±10 V, 200 mA supplies when in
current mode. The setting switches in clamping diodes to define an
upper voltage limit that is used to prevent a resource voltage pin from
exceeding a DUT’s rail voltage. This button is used with the Vcc
1/3/5/7 Mode: ‘current’ button, and Vcc 1/3/5/7 Min buttons.
Vcc 1 Min

-15
Vcc 1/3/5/7 Min
Decimal notation input buttons that define the independent minimum
voltage condition for VCC1 ±10 V, 200 mA, VCC3 ±10 V, 200 mA,
VCC5 ±10 V, 200 mA, or VCC7 ±10 V, 200 mA supplies when in
current mode. This button switches in clamping diodes to define the
lower voltage limit used to prevent a resource voltage pin from
exceeding a DUT’s rail or ground voltage. This button is used with the
Vcc 1/3/5/7 Mode: ‘current’ button, and Vcc 1/3/5/7 Max buttons.

© Roos Instruments Inc.

See Example D at the end of the Edit Panels section for example
measurements using the Power VI pins.
Power V 1

0
Power V 1
Decimal notation input button that sets the voltage value for the
Power VI’s VI1 0-10 V, 3 A high-current supply. Range of valid input
values are 0 to 10 in units of volts. This button is used with the Power
I 1 and V1 Output buttons.
Power V 2

0
Power V 2
Decimal notation input button that sets the voltage value for the
Power VI’s VI2 0-10 V, 3 A high-current supply. Range of valid input
values are 0 to 10 in units of volts. This button is used with the Power
I 2 and V2 Output buttons.
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Power I 1

0

The ‘off’ disconnects the VI1 0-10 V, 3 A supply outputs from the VI1F
pins.

Power I 1

V 2 Output

Decimal notation input button that sets the maximum current limit
value for the Power VI’s VI1 0-10 V, 3 A high-current supply. Input
values are in units of amps with a range of 0 to 3 amps and 11 bits of
resolution (~1.5 mA). This button is used with the Power V 1 and V1
Output buttons.
Power I 2

0
Power I 2

oﬀ
V 2 Output
Drop down list button that controls the output relay between the VI2F
pins and the VI2 0-10 V, 3 A supply.
The ‘on’ connects the VI2 0-10 V, 3 A supply outputs to the VI2F pins.
The ‘off’ disconnects the VI2 0-10 V, 3 A supply outputs from the VI2F
pins.

Decimal notation input button that sets the maximum current limit
value for the Power VI’s VI2 0-10 V, 3 A high-current supply. Input
values are in units of amps with a range of 0 to 3 amps and 11 bits of
resolution (~1.5 mA). This button is used with the Power V 2 and V2
Output buttons.
V 1 Output

oﬀ
V 1 Output
Drop down list button that controls the output relay between the VI1F
pins and the VI1 0-10 V, 3 A supply.
The ‘on’ connects the VI1 0-10 V, 3 A supply outputs to the VI1F pins.
© Roos Instruments Inc.
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PANEL: MEASUREMENTS
See Example D at the end of the this section for example
measurements using the static digital measurements.
Voltage Meas Max

10
Voltage Meas Max
Set the max magnitude for voltage measurement for the Power VI
instrument’s internal voltage or current measure resource Meas I/V,
1/2. This picks the range used.
Current Meas Max

1
Current Meas Max
The Decimal notation input button that optimizes the dynamic range
of the Meas I/V, 1/2 resource’s internal sense resistor and ADC input.
This button is used with the Imeasure button, Current Vs Time and/
or Current measurement blocks.

voltage measurements. This button is used with the Voltage Meas
Max button and Voltage measurement block or the Meas Rate and
Samples buttons with the Voltage Vs Time measure block.
The ‘V1’ selection connects the Meas I/V, 1/2 resource to the VI1
0-10 V, 3 A supply output for effectively measuring the VI1F pins.
The ‘V2’ selection connects the Meas I/V, 1/2 resource to the VI2
0-10 V, 3 A supply outputs, for effectively measuring the VI2F pins.
Imeasure

V1
Imeasure
Drop down list button that connects the PowerVI’s internal measure
resource (Meas I/V, 1/2) to the selected high-current power supply for
current measurements. This button is used with the Current Meas
Max button and Current measurement block or the Meas Rate and
Samples buttons with the Current Vs Time measure block.
Meas Rate

20000
Meas Rate

Vmeasure

V1
Vmeasure
Drop down list button that connects the PowerVI’s internal measure
resource (Meas I/V, 1/2) to the selected high-current power supply for
© Roos Instruments Inc.

Decimal notation input button used with the Samples button that
defines the sample rate for Voltage Vs Time and Current Vs Time
measurement blocks in the Power VI instrument. The button value is
listed in units of Hz with a maximum sample rate of 50 kHz.
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Samples

MEAS

21

Voltage Vs Time

A

Samples

Meas: Voltage Vs Time

Decimal notation input button that sets the measurement span in
units of seconds for the Voltage Vs Time and Current Vs Time
measurement blocks. This button is used with the Meas Rate button.
The measurement window is the values of Meas Rate * Sample.

Measurement block that computes sampled voltage over time at a
PowerVI resource pin (designated by the Vmeasure button) via the
internal Meas I/V, 1/2 resource. This block uses the Voltage Meas
Max, Measure Rate, and Samples buttons to define the sampling
parameters. The maximum measurable voltage is ±10V.

NOTE: Maximum number of samples is 2000.

MEAS
Current Vs Time

Measure Pin

None
Measure Pin
Drop down list button that chooses the pin resource to be measured
with the precision measure resource via the Monitor . This button is
used with the Measure Mode button and associated measurement
parameter buttons defined therein.

A

Meas: Current Vs Time
Measurement block that outputs sampled current over time at a
resource pin (designated by the Imeasure button via the DPVP Meas
I/V. This block uses the Current Meas Max, Measure Time, and
Meas Rate buttons to define the sampling parameters.

The ‘V1’ selection measures VI1 0-10 V, 3 A supply with the internal
Meas I/V, 1/2 resource.
The ‘V2’ selection measures VI2 0-10 V, 3 A supply with the internal
Meas I/V, 1/2 resource.

© Roos Instruments Inc.
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EXAMPLE D RI8546 DEVICE POWER MEASUREMENTS
MEAS

Voltage

A

Meas: Voltage
Measurement block that measures voltage at a PowerVI resource pin
(designated by the Vmeasure button) via the internal Meas I/V, 1/2
resource. This block uses the Voltage Meas Max button to optimize
the internal ADC’s dynamic range. The maximum measurable voltage
is ±10V.
MEAS

Current

A

Meas: Current
Measurement block that outputs sampled current over time at a
resource pin (designated by the Imeasure button via the DPVP Meas
I/V. This block uses the Current Meas Max button to optimize the
internal ADC’s sense resistors for maximum dynamic range.

Current Measurement with a Device Power(DP) Pin

1 of 19
© Roos Instruments Inc.
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STATICDIGITAL

Db 1

open

PANEL: DEVICE DB
Db 1 through Db 16
See Diagram 2 at the end of the Edit Panels section for a timing
diagram when using the Device Serial modes.
Von

0

NOTE: DB pins used for communication must be set to ‘on’, ‘off’, or ‘openCol’ (DB2
and DB10 only) within the bit stream emit test panel, section defaults, or global defaults.

Von
Decimal notation input button that sets the fixed voltage level for the
logic “on” state for the 8 Device Bit pins DB1 to DB8.
The valid input range is ±10 volts.
Voff

0
Voff
Decimal notation input button that sets the fixed voltage level for the
logic “off” state for the 8 Device Bit pins DB1 to DB8.
The valid input range is ±10 volts.

© Roos Instruments Inc.

Drop down list buttons that individually control the Device Bit line
states. When the associated DB resource is used for serial
communication, this button value defines the voltage or logical state
of the pin before and after serial communication emits.

The ‘open’ selection disconnects the associated device bit pin from all
internal resources, leaving it as a floating pin.
The ‘on’ selection connects the associated device bit pin to the V ON
±10V, 2 mA resource (Logic state “on”/high voltage value).
The ‘off’ selection connects the associated device bit pin to the V OFF
±10V, 2 mA resource (Logic state “off”/low voltage value).
The ‘openCol’ selection, which is only available on DB2 and DB10
configures these device bit pins as open collector. This mode requires
the addition of a pull-up/pulldown resistor on DB2/DB11 either on the
device interface board or within the fixture. It is typically used with I2C
communication. See the Serial Type: ‘I2C’ button mode for more
details.
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Von High Byte

PANEL: DEVICE SERIAL PORT

0
Von High Byte

Data Read

Decimal notation input button that sets the fixed voltage level for the
logic “on” state for the 8 Device Bit pins DB9 to DB16 (high byte). The
valid input range is ±10 volts.
Voff High Byte

0
Voff High Byte
Decimal notation input button that sets the fixed voltage level for the
logic “off” state for the 8 Device Bit pins DB9 to DB16 (high byte). The
valid input range is ±10 volts.

None

Data Read
Drop down list button that configures the appointed device bit pin
(DB1..DB16) to acts as the serial read data pin. The DB line that is
designated as the data read line is connected to the DUT’s data
output pin to support data reads with speeds to 250 kHz. The Serial
Data Read button defines the total number of bits to read from a bit
stream.
NOTE: The device bit lines DB1/DB9 (selection ‘Db1’ or ‘Db9’) support faster read
speeds up to 1 MHz (with Data: ‘Db2’ or ‘Db10’ and Clock: ‘Db3’ or ‘Db11’ buttons).

Clock

None
Clock
Drop down list button that configures which DB pin acts as the serial
clock pin. An arbitrary pin selection can support a maximum of 250
kHz. The Serial Clock Period button controls the clock speed and
the Serial Clock Polarity button controls the polarity of the clock
rise/fall edges relative to the data stream.
© Roos Instruments Inc.
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See Diagram 2 for a timing diagram of strobe parameters.

Strobe 1

NOTE: The device bit lines DB3/DB11 (selection ‘Db3’ or ‘Db11’) support faster clock
speeds up to 1 MHz (with Data Read: ‘Db1’ or ‘Db9’ and Data Read: ‘Db2’ or ‘Db10’
buttons).

Data

None

Strobe 1
Drop down list button that configures which DB pin acts as a serial
strobe or read/write/enable pin to the DUT. The DB line that is
designated as the data line is connected to the DUT’s strobe or
enable pin (s) support for speeds up to 250 kHz.

None

Strobe 2

Data
Drop down list button that configures which DB pin acts as the serial
data write pin to the device under test. The DB line that is designated
as the data line is connected to the DUT’s data output pin to support
data reads with speeds to 250 kHz. The Serial Direction button sets
the emit order of the bit stream, i.e. most significant bit first or least
significant bit first. The Serial Size button defines the total number of
bits in a single emit stream.
NOTE: The device bit lines DB2/DB10 (selection ‘Db2’ or ‘Db10’) support faster write
speeds up to 1 MHz (with Data Read: ‘Db1’ or ‘Db9’ and Clock: ‘Db3’ or ‘Db11’
buttons).

None

Strobe 2
Drop down list button that configures which DB pin acts as a serial
strobe or read/write/latch enable pin to the device under test. The DB
line that is designated as the data line is connected to the DUT’s
strobe or enable pin (s) support speeds up to 250 kHz.
Serial Type

DUT Defined

Serial Type
Drop down list button that defines the serial communication protocol
for the selected device bit lines. The selection type inherits and
enforces protocol timing behavior on the designated read data, data,
clock, and strobe lines.

© Roos Instruments Inc.

319

Cassini ATE System Reference Guide
The ‘DUT Defined’ selection uses the communication parameters
defined in the Device Control Editor under the Formats tab to enable
protocol-aware communication with a DUT. It is typically used with
devices that contain multiple registers with complex programmable
functions. This button selection will override the settings for the Clock
Polarity, Serial Direction, Strobe Length, and Strobe Polarity
buttons found in the ‘device serial port’ panel. See the DUT
Instrument section for more information.
CAUTION: If multiple RI8546 Device Power/Measure TIMs and/or RI8535
Universal Digital TIMs are part of the test system configuration, only one TIM can use
the Serial Type button set to ‘DUT Defined’ in the test plan.
The ‘Local’ is for RI internal purposes only.
The ‘None’ selection does not enforce any protocol timing behavior
on the Serial Data button emits. Use the Serial Clock Polarity,
Serial Strobe Polarity, Serial Clock Period, Serial Direction,
Serial Read Size, and Serial Strobe Length to define the Clock,
Data, Read, and Strobe Characteristics.

Graphical Programming | RI8546: Device Power/Measure
up/pulldown resistors on the Device Interface board or within the
fixture.
NOTE: The Data button must be set to DB2 or DB10, and the DB2/DB10 state
button used must be set to ‘openCol’ to prevent data or logic collisions between the Data
and Data Read DB resources.

The Serial Clock Line or SCL (defined by Clock button) must include
pull-up resistors on the DB resource selected by the Clock button on
the Device Interface board or within the fixture. Data writes are set in a
test panel using the I2C Address, I2C Register, I2C Write buttons
found under the I2C Measure Panel of the Static Digital instrument.
Bits are captured using the I2Cbyte block also found in the I2C
Measure Panel of the Static Digital instrument.
NOTE: The I²C standard typically uses +5 V or +3.3 V logic voltages although other
voltages are permitted. The design has a 7-bit or a 10-bit (depending on the device used)
address space and common I²C bus speeds are 100 kbit/s standard mode and 10 kbit/s
low-speed mode, but arbitrary clock frequencies are allowed.

The ‘Read’ is for RI internal purposes only.
The ‘I2C’ selection applies clock and data timing conventions used in
the two bidirectional open-drain lines of the I²C protocol as well as
automatically generating the Start Condition, ACK (Acknowledge) bit,
Stop Condition. The bidirectional Serial Data Line or SDA is defined by
the Data and Data Read buttons. This bidirectional pin is created by
tying the user-designated Data and Data Read DB resources to pull© Roos Instruments Inc.

The ‘I3C’ selection is no longer supported.
The ‘SPI’ selection will enforce a reduced duty cycle on the
designated clock resource of ~30%. This relaxes hold conditions for
writing data to the DUT and capturing read data from the DUT.
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The ‘Generic’ selection provides basic serial bit stream capability via
the Serial Data button. This mode, like the ‘generic’ mode, is used
for arbitrary serial communication. Use the Serial Clock Polarity,
Serial Strobe Polarity, Serial Clock Period, Serial Direction,
Serial Read Size, and Serial Strobe Length to define the Clock,
Data, Read, and Strobe Characteristics.

binary. A read operation is input as a mask that is logically AND’d with
the read bits using an input value of X’s for ‘don’t cares’ and 1’s for bit
reads. Spaces in the input value are ignored. For example, a 16-bit
emit consisting of an 8-bit write of CA(hex) followed by a read of 8bits would be input to the Serial Data button as: 1100101011111111.
NOTE: If the Serial Auto Init button in the device serial port panel is set to ‘off’, this
button will only function within premeasure and postmeasure button groups.

The ‘Generic Read’ is for RI internal purposes only.
Serial Size

0

Serial Clock Polarity

Serial Size

positive

Decimal notation-value button that defines the total number of bits in
the serial output word and sets the number of clock edges to
correspond with the serial size value. If a strobe condition is defined,
this button configures the strobe length to comply with the number of
bits defined by the Serial Data button. A value of zero will default to
the automatic read size defaults designated in the various Serial Type
button value’s configuration settings (bit length may vary by type). The
maximum value is 1000 bits for a single read/write operation.

Serial Clock Polarity
Drop down list button that defines the signal polarity of the userdesignated clock pin. When the Serial Type button is set to ‘DUT
Defined’, this button’s setting is overridden by the settings defined by
the user for the DUT in the Device Control Editor under the Formats
tab.

Serial Data

The ‘positive’ selection sets the base value of the clock to binary
‘0’ (voltage value of the Voﬀ or Voﬀ Low Byte buttons). This is
typically used when the data is to be captured on the clock's rising
edge (low→high transition) and data is propagated on a falling edge
(high→low clock transition).

Text string input button that defines a bit pattern for the serial data
output from the specified data pin to the DUT. The value is input in

The ‘negative’ selection selection sets the base value of the clock to
binary ‘1’ (voltage value of the Von or Von High Byte buttons). This is

Serial Data

© Roos Instruments Inc.
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typically used when the data is to be captured on the clock's falling
edge (high→low clock transition) and data is propagated on a rising
edge (low→high transition).
See Diagram 2 for a timing diagram of clock parameters.
Serial Strobe Polarity

positive

Serial Strobe Polarity
Drop down list button that defines the signal polarity of the userdesignated strobe/enable/activation pin with respect to the clock/
data. When the Serial Type button is set to ‘DUT Defined’, this
button’s setting is overridden by the settings defined by the user for
the DUT in the Device Control Editor under the Formats tab.

Serial Clock Period

20 u

Serial Clock Period
Decimal notation-value button that sets the period of the serial data
rate. For periods less than 10µs (higher than 100 kHz), the fast-mode
pins must be used for the data read (DB1/DB9), data (DB2/DB10),
and clock pins (DB3/DB11). The maximum clock speed for the fastmode pins is 1 MHz.
See Diagram 2 for a timing diagram of clock period parameter.
Serial Direction

msb first

Serial Direction

The ‘positive’ selection sets the base value of the strobe to zero. This
is typically used to designate valid data to be captured after the rising
edge and during a high value of the strobe pin (low→high transition) of
the designated pin and data is invalid after the falling edge (high→low
clock transition) and low value of the strobe pin.

Drop down list button that designates the order the serial bits within a
bit stream are emitted. Setting the Serial Type to ‘DUT Defined’
overrides this buttons setting.

The ‘negative’ selection sets the base value of the strobe to one. This
is typically used to designate valid data to be captured after the falling
edge (high→low clock transition) and low value of the strobe pin and
data is invalid after the rising edge and during a high value of the
strobe pin (low→high transition) of the designated pin.

The ‘lsb first’ selection configures the serial data stream to output the
least significant bit first from the tester to the DUT.

The ‘msb first’ selection configures the serial data stream to output
the most significant bit first from the tester to the DUT.

See Diagram 2 for a timing diagram of strobe parameters.
© Roos Instruments Inc.
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Serial Auto Init

Serial Auto Init

on

Drop down list button that provides serial communication initialization.
The button is designed to automate the initialization of communication
with the DUT when the supply’s (VON/VOFF) driving the device bits
(DB1..16) are activated in a test panel, section default, or global
default. The concept is to set the device under test into a known
state. This would be used when the DUT is powered up the first time:
Apply rail voltage (typically using DUT Control lines - DPs), power up
the communication subsystem (using the Static Digital lines - DBs),
and then set the DUT into a known default state. It is also used to
reset the part into a default state after a test or measurement without
powering down the DUT: VON set to 0 V (off) - no clock, DUT registers
are now in an unknown state, VON set to >0 V (on), the DUT’s registers
unknown state is invalidated by an automatic serial initialization into a
default state defined by the user.
The default ‘on’ selection will automatically send the default serial
initialization conditions to the DUT’s serial registers when the voltage
level of the Static Digital’s supply VON exceeds 0 V. This mode is used
with the Serial Type button set to ‘DUT Defined’ and the default
register parameters are set by the user using the Active button within
the DUT instrument (see note below).
NOTE: The default serial state conditions are defined by the user in the Device Control
Editor. This creates a ‘DUT Instrument’ that can be added to the Edit Panel. Within
the ‘DUT’ instrument is a list-select ‘State’ button with several default states the user can
© Roos Instruments Inc.

use to define the initialization state of the device under test. Placing this button in a test
panel, section default or global default defines the default register conditions sent to the
device when a serial auto-initialization event occurs (VON is powered up).

The ‘off’ selection disables auto-initialization. In this mode, serial
register emits using the Serial Data and I2C Write buttons will only
execute within a premeasure/postmeasure group.
Serial Read Size

0
Serial Read Size
Decimal notation input button that defines the number of bits to read
after a serial emit, corresponding to the number of clock edges from
the Serial Size value that will be used for the read capture. A value of
zero will default to the automatic read size defaults designated in the
various Serial Type button value’s configuration settings (bit length
may vary by type). The maximum value is 1000 bits for a single read
or write operation.
Serial Strobe Length

short

Serial Strobe Length
Drop down list button that defines the strobe length type. When the
Serial Type button is set to ‘DUT Defined’, this button is overridden
by the settings defined by the user for the DUT in the Device Control
323
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Editor under the Formats tab. This button is used in conjunction with
the Serial Data and Serial Clock Polarity buttons.

or DB10 with the ‘openCol’ selection and requires the addition of a pull-up/pulldown
resistor on DB2/DB11.

The ‘short’ selection is the default strobe length condition that
extends from the first rising or falling (Serial Clock Polarity button)
edge of the valid data bit stream, to the last rising or falling edge of
the valid data bit stream.
The ‘long’ selection extends the strobe length condition by one clock
period beyond the last valid data bit. This mode is typically used with
communication that include bus buffers requiring an extra clock cycle
to latch the valid data from the buffer into the device’s logic. See
Diagram 2 for a timing diagram of strobe parameters.

MEAS
Serial Data

A

Meas: SerialData
Measurement block that captures a serial data stream and returns the
binary values as a float data type value. This block uses the Serial
Read Size button to define the number of bits to be read from the
trailing end of the Serial Data value emit. See the A shift B and C
calculation block for manipulating individual bits or bit strings within a
serial read capture.
NOTE: To create a single R/W pin resource, the individual DB resource pins used for
the read and write must be physically connected together. The write pin must use DB2
© Roos Instruments Inc.
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PANEL: MEASURE

Measure Pin

None

D IAGRAM 2 SERIAL DIGITAL SETTINGS & TIMING DIAGRAM
Polarity Setting
Positive

Serial Clock
Period
Serial Size /
Serial Read
Size

Data Write /
Data Read

Drop down list button that defines the data bit pin (DB1..16) that will
be connected to the precision current/voltage measurement
instrument via the Monitor→DPVP Meas I/V.

Negative

…..

Clock

Measure Pin

NOTE: A DB resource pin cannot be driven by a Von/Voff or Von High Byte/Voff
High Byte supply and the DPVP Meas I/V in parallel.

Bit Stream

Sync
Strobe (long)

oﬀ

Sync

Strobe (short)

Max Clock/Data Speed: Arbitrary DB pin - 250 kHz / 4µs
Fast Mode - 1 MHz / 1µs

State value set by DB1..16 buttons:
Must be set to ’on’, ‘off’

The above timing diagram shows the behavior of the clock, strobe, and
data pins regarding the parameter buttons found in the Device Serial
Port pane of the Static Digital Instrument.

© Roos Instruments Inc.

Drop down list button that is used to synchronize measurements
based on the specified logic condition set. This button is used strictly
in a premeasure group that causes the test/measurement start to hold
until the button value is true. The maximum wait time is 100 ms.
The ‘off’ selection is the default state of the button, which enforces no
measurement/test synchronization.
The ‘Db1High’ selection forces the start of a test/measurement in the
panel to wait until the logic value on the DB1 pin is above the voltage
value specified by the Von button.
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The ‘Db1Low’ selection forces the start of a test/measurement in the
panel to wait until the logic value on the DB1 pin is below the voltage
value specified by the Voﬀ button.

Graphical Programming | RI8546: Device Power/Measure

PANEL: I2C SERIAL
I 2 C Address

The ‘Db9High’ selection forces the start of a test measurement in the
panel to wait until the logic value on the DB9 pin is above the voltage
value specified by the Von button.
The ‘Db9Low’ selection forces the start of a test measurement in the
panel to wait until the logic value on the DB9 pin is below the voltage
value specified by the Voﬀ button.

11000000

I2C Address
Data input button that defines the slave address of arbitrary bit length
in binary for I2C communications using the values ‘1’ and ‘0’ (Spaces
are ignored). The IC byte measurement block automatically generates
a read by setting the value of the LSB in the I2C Address button to a
read bit(logic high).
NOTE: an ACK bit is automatically generated every eight bits(byte).

I 2 C Register

10110000

I2C Register
Data input button that defines the register value in binary of arbitrary
length for I2C communications using the values ‘1’ and ‘0’ (Spaces
are ignored).
NOTE: an ACK bit is automatically generated every eight bits(byte).

© Roos Instruments Inc.
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Address button value with read bit (logic high), ACK bit, 16 clock
edges defined by the Serial Read Size button (with ACK bits
between every byte), and then a Stop Condition.

I 2 C Write

11000000

I2C Write
Data input button that defines a data write of arbitrary length in binary
for I2C communications using the values ‘1’ and ‘0’ (Spaces are
ignored).
NOTE: If the Serial Auto Init button in the device serial port panel is set to ‘off’, then
this button will only function within premeasure and postmeasure button groups.

MEAS
IC byte

A

Meas: IC byte
Measurement block that captures an I2C byte/s and returns the binary
value as an integer value. This block automatically generates a read
bit (logic high bit) in the LSB of the slave address. This measurement
block is used with the Serial Read Size button to define the number
of clock edges for a byte or block(multiple bytes) that follow the slave
address defined by the I2C Address button. For example, a panel
with the IC byte measurement block and a Serial Read Size button
with value 16 would generate the following:
Start Condition, I2C Address button value with write bit (logic low),
ACK bit, I2C Register button value, ACK bit, Start Condition, I2C
© Roos Instruments Inc.
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CONTROL PANELS
Real-time control of the instruments in this TIM. Only lists buttons not
already described in the Edit Panel.

C ONTROL P ANELS 5 RI8546 DEVICE POWER

DUTControl Voltage measure controls Current and Voltage
measurements.
1 of 11
© Roos Instruments Inc.
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TOPICS

Instruments Provided by this TIM
Configuration Panels
Instrument Diagram with Edit Buttons
Edit Panel Button Descriptions
Control Panel

Tap the links above to quickly access content

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as Test Head40 in the panel dialog
windows.
Model and Name as it appears in the Tester Configuration:
• Test Head40, Ri8563x 4-40.5 GHz Test Set
NOTE: Multiple RI8563 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - Test Head40, Test
Head402, Test Head403, etc). The “x” in RI8563x denotes the model revision number.

© Roos Instruments Inc.
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CONFIGURATION PANELS
There are two versions of the RI8563 TIM. The RI8563B version also
contains a Receiver and does not require and the use of the main
system receiver. The Ri8563C streamlined design and requires a
system receiver that is connected through the Test Fixture’s interface.
All of the connection path buttons Lo Input, High Band Input, Lo
Band Input, Aux IF Output, Aux RF Output, Second Aux RF
Output, External Mixer IF Input #1, 2, and 3, and External Mixer
Lo Output #1, 2, and 3 are green as in all the instruments that
provide connections to the Test Fixture interface. This means they
must be defined by the connections that are listed in the Test Fixture
definition, but are still displayed here.
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EDIT PANELS
The catalog of control buttons for this TIM to be use when building
automated Test Programs. These next few panels are common to
both the Ri8563B and Ri8563C models.

E DIT P ANELS 7 RI8563 4-40 GHZ TEST SET
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PANEL: RF SETUP
The output source frequency and power of the RI8563 are
controlled by the driving source Power and Frequency buttons in
conjunction with a fixture definition with a connection between the
driving source output port and the RI8563’s RF In (C1) input ports.

Src Mode

cw

Src Mode
A drop down list button that controls a high-speed the source mode
of the resource connected to the RF In (C1) input port out of the In/
Out 20-40GHz (C8) output port.
The ‘cw’ setting is the default mode and provides continuous RF
power sourcing.
The ‘pulse’ setting enables gated RF power sourcing. This mode is
used in conjunction with the Src 1 Seq button to control the pulse
duration.

Testhead40 RF Setup panel controls RF 1 and Parameter switching of
the TIM.
© Roos Instruments Inc.
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Src 1 Seq

pulse on

The ‘off’ selection disconnects the RF In (C1) port source from the 4x
frequency multiplier chain.

Src 1 Seq
A drop down list button used in Pre Measure and Post Measure
groups to controls RF source pulsing of the resource connected to
the RF In (C1) input port out of the In/Out 20-40GHz (C8) output port.
It is used in conjunction with the Src Mode:‘pulse’ button setting and
a Sequence Delay button (found in the System > state panel of the
Editor) to define the duration of the RF pulse.

The measure frequency of the RI8563 is set by the RI8581/RI8587
Receiver TIM’s Frequency button in conjunction with a fixture
definition defining a connection between one of the Receiver’s IF
In and LO Out ports and the RI8563’s LO In [C3] and IF Out [C6]
ports.
Parameter

The ‘pulse on’ setting starts the RF signal pulse when encountered in
the Pre Measure sequence.
The ‘pulse off’ setting stops the RF signal pulse when encountered in
the Pre Measure or Post Measure sequence.
Rf 1

oﬀ

Rf 1
A drop down list button that sets the state of the 8x frequency
multiplier in the source path from the RF In (C1) input port.
The ‘on’ selection connects the source path from the RF In (C1) port
to the microwave multiplier and out of the In/Out 20-40GHz (C8)
output port.

© Roos Instruments Inc.

none

Parameter
Drop down list button that designates a coupler port that will be
routed to the IF switching network for measuring incident/reflected
waves and/or computing s-parameters.
The ‘none’ selection disconnects all IF resources from the
downstream receiver chain.
The ‘a1‘ selection routes the down-converted IF signal from the
incident signal (a1 denoted as the ‘a’ port of the coupler in Instrument
Button Diagram 2.4) of the In/Out 20-40GHz (C8) port to the
downstream receiver chain.
The ‘b1’ selection routes the down-converted IF signal from the
reflected signal (b1 denoted as the ‘b’ port of the coupler in
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Instrument Button Diagram 2.4) of the In/Out 20-40GHz (C8) port to
the downstream receiver chain.
The ‘b2’ selection routes the IF signal from the down-converted In/
Out 20-40GHz (C4) port port (b2 signal ) to the downstream receiver
chain.
NOTE:
a1 is the incident wave to the input port of the device under test.
b1 is the reflected wave from the input port of the device under test.
b2 is the reflected wave from the output port of the device under test.

NOTE: The b2 port measurement is sensitive to mismatch effects because it connects
directly to the mixer input port without any attenuation or coupling to control the
match.

Graphical Programming | RI8563: 4GHz to 40.5GHz TestSet

PANEL: MEASUREMENTS
Parameter

std

Average Mode
A drop down list button that sets the method of averaging used for sparameter measurements. It is commonly used with the S11, Thru
Measure, and S Parameter measurement blocks.
The ‘std’ (standard) mode measures and averages each individual
wave parameter during an s-parameter measurement. The Averages
button value (found in the System > state panel of the Editor) sets
the number of samples for the average. For example, a test panel with
an S11 measurement block and Averages button value of ‘4’, would
measure a1, a1, a1, a1, then b1, b1, b1, b1.
NOTE: The ‘std’ is the fastest averaging mode.

The ‘adjacent’ mode interleaves the measure of wave parameters
during an s-parameter measurement. The Averages button value
(found in the System > state panel of the Editor) sets the number of
samples for the average. For example, a test panel with an S11
measurement block and Averages button value of ‘4’, would capture
the measurements as a1, b1, a1, b1, a1, b1, a1, b1.and then average
the individual wave parameters. The ‘adjacent’ averaging mode is
© Roos Instruments Inc.
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slower than the ‘std’ mode due to additional signal switching between
wave captures, but can minimize memory, temperature and/or signal
instability from the DUT during large measurement captures or
averages.
NOTE: At higher frequencies and with averages greater than 8 to 16, some improvement
in accuracy and repeatability are often achieved using the adjacent averaging mode.

MEAS

Thru

MEAS

Input Wave

Meas: InputWave
Measurement block that captures the incident and reflected waves as
a11 [signal out of In/Out 20-40GHz (C8)], measured on the ‘a’ port of
the coupler in Instrument Button Diagram 2.4) and b11 [signal into In/
Out 20-40GHz (C8)], measured on the ‘b’ port of the coupler in
Instrument Button Diagram 2.4). The output data type is two complex
voltages for a11 and b11.

A

MEAS

Meas: Thru

S11

Measurement block that computes the error correction factors for the
signal path connecting In/Out 20-40GHz (C8) and In/Out 20-40GHz
(C4) to generate a ‘perfect’ thru reference from a non-perfect thru
standard. The computed error correction factors emulate a perfect
thru(lossless) with S11 and S22 terms equal to zero(negative infinity
approximated by -180dB), and S21 and S12 equal to one(0dB). The
output data type is a complex thru wave format.

A

A

Meas: S11
Measurement block which performs a series of a1 and b1 wave
parameter measurements to calculate a vector error-corrected S11
(b1 / a1) measurement. The output data type is a ratio expressed as a
complex voltage.

NOTE: This measurement block is typically used as a calibration method to create a
perfect thru standard from a generic, non-perfect thru path for relative measurement
comparisons.

© Roos Instruments Inc.
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CONTROL PANELS
Provides real-time control of the instruments in this TIM. Please refer
to the Edit Panels for help with buttons contained in both “Edit” and
“Control” panels. RF control panel

C ONTROL P ANELS 6 RI8563 4-40 GHZ TEST SET

Testhead40 RF control panel provides real time access to switching
the 40GHz instrument.

© Roos Instruments Inc.
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RI8564: 71GHZ TO
86GHZ TESTSET
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TOPICS

Instruments Provided by this TIM
Instrument Diagram with Edit Buttons
Edit Panel Button Descriptions
Control Panel

Tap the links above to quickly access content

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as Test Head77 in the panel dialog
windows. Model and Name as it appears in the Tester Configuration:
• Test Head77, Ri8564x 81 GHz Test Set
NOTE: Multiple RI8564 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - Test Head77, Test
Head772, Test Head773, etc). The “x” in RI8564x denotes the model revision number.

© Roos Instruments Inc.
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I NSTRUMENT B UTTON D IAGRAM 2.5: RI8564B VERSION
Roos Instruments, Inc - Cassini

The Rf 1 frequency power settings are controlled by
the driving source. For example, if the Source1 TIM
is driving the RF In port, then the Frequency and
Power buttons for Source1 will define the settings.

C5

Block Diagram
RI8564B, 75-81 GHz 1-Path TIM
2013-08-01

a

Drive In

IF Out Test Point

IF Aux In
LO In

Tap for Zoom View

RF1
75-81 GHz
WR12

Copyright Roos Instruments, Inc.
Subject to change without notice

C1

Ext Mixer LO Out

Ext Mixer IF In

LO Aux Out
C8

RF

LO

3 dB

IF

C4

C5
Ext Mixer LO Out

b1
BPF
3

b

RF

LO

1

Parameter
a1
4
2

3 dB

10 dB

6 dB

C4
LO Aux Out

a1

IF
BPF

Power
0

Atten
Control

C6
IF Out Test Point

Noise Source
off
Rms Gain
High

Noise
Source
Control

Complex Detector Board

off

C3
LO In

Atten

J1

21.4 MHz

RMS/Noise
Detector

If Gain
20

A/D

4 MHz
BPF

0°

BPF

Parameter
a1

RF
PA

C8
Ext Mixer IF In

Rec Frequency
20000

Complex

0/90° Detector

7 kHz
BPF

A/D

If Bw
200KHz

C2
IF Aux In

© Roos Instruments Inc.

mmw
PA

IF
Switch

b1

J9

Rf State
x8
off

a1
J10

C1
Drive In

I.F. Amplifier Board

on

J2

Noise
Source

Rms Bw
Slow

5 MHz
200 kHz
7 kHz
TOI

21.4 MHz

Trigger Mode
normal
Trigger
off

Average Mode Meas Rate
std
80000
Samples
1

Delay
0

339

Graphical Programming | RI8564: 71GHz to 86GHz TestSet

Cassini ATE System Reference Guide

I NSTRUMENT B UTTON D IAGRAM 2.6: RI8564C VERSION
Roos Instruments, Inc - Cassini

The Rf 1 frequency power settings are controlled by
the driving source. For example, if the Source1 TIM
is driving the RF In port, then the Frequency and
Power buttons for Source1 will define the settings.
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EDIT PANELS
Automated control of the instruments in this TIM with use by the Test
Plan Editor.

E DIT P ANELS 8 RI8564B: 75-81GHZ TEST SET

E DIT P ANELS 9 RI8564C: 71-86GHZ TEST SET

Testhead77 RF Setup panel sets the instrument states for all

Testhead77 RF Setup panel sets the instrument states for all

measurements.

measurements.

© Roos Instruments Inc.
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PANEL: RF SETUP
Parameter

NOTE:
a1 is the incident wave to the input port of the device under test.
b1 is the reflected wave from the input port of the device under test.
b2 is the reflected wave from the output port of the device under test.

none

Parameter
Drop down list button that designates the coupler port that will be
routed to the internal switching network. This routes the incident/
reflected wave signals to the receiver for wave/s-parameter
measurements.
The ‘none’ selection disconnects all IF resources from the
downstream receiver chain.
The ‘a1‘ selection configures the internal switches to route the
incident signal from coupler arm ‘a’ (Instrument Button Diagram 2.5 or
Instrument Button Diagram 2.6) to the downstream receiver chain.

Noise Source

oﬀ

Noise Source
Drop down list button that connects the internal Noise Source.
‘on’ activates the noise source.
‘off’ deactivates the noise source.
NOTE: For noise figure measurements, the source power to Drive In [C1] must be
turned off by setting the RI8564 Rf State button ‘off’.

The ‘b1’ selection configures the internal switches to route the
coupled arm ‘b’ (Instrument Button Diagram 2.5 or Instrument Button
Diagram 2.6) to the downstream receiver chain.
The ‘b2’ selection routes the source connected to the LO In (C3) port
out of the LO Out (C5) port to drive an external mixer and routes the
IF In (C8) down-converted signal from the external mixer to the
downstream receiver chain. Reference Instrument Button Diagram 2.
6.

Power

0

Power
Decimal notation input button that controls the step attenuator in the
Drive In (C1) path to set the signal power at the RF1 71-86GHz WR12
output port. Values are input in units of dBm.

The ‘Rf4’ selection is no longer supported on the RI8564B version.
© Roos Instruments Inc.
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The valid input range is -20 to 5 (-20 dBm to +5 dBm). RI8564B

Rf State

oﬀ

The valid input range is -45 to 5 (-45 dBm to +5 dBm). RI8564C

Rf State
The source frequency of the RI8564 is set by the Frequency button
of the source connected to the Drive in (C1) input port in
conjunction with a fixture definition with a connection between the
source’s output port and the RI8564‘s Drive In (C1) ports.

Rec Frequency

20000

A drop down list button that sets the multiplied RF source signal state.
The ‘on’ selection connects the source path from the Drive in (C1)
port to the microwave multiplier and out of the RF1 71-86GHz WR12
output port.
The ‘off’ selection disconnects the RF source from the multiplier
chain.

Rec Frequency
Decimal notation input button that sets frequency of the source
connected to the LO In (C3) port to down convert signals for the
internal receiver. The input values are in units of MHz with a valid
range of 75000 to 81000 (75GHz to 81GHz).
(RI8564B only)
The frequency of the RI8564C is set by the RI8581/RI8587
Receiver TIM’s Frequency button in conjunction with a fixture
definition defining a connection between one of the Receiver’s IF
In and LO Out ports and the RI8564C’s LO In [C3] and IF Out [C6]
ports.

© Roos Instruments Inc.
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PANEL: MEASUREMENTS

Average Mode

std

Average Mode

MEAS

Input Wave at Input Freq

A

Meas: Input Wave at Input Freq
Measurement block that captures the incident and reflected waves as
a11 (signal out of W1 71-86GHz output, measured on the ‘a’ port of
the coupler in Instrument Button Diagram 2.5) and b11 (signal into W1
71-86GHz port, measured on the ‘b’ port of the coupler in Instrument
Button Diagram 2.5). The output data type is two complex voltages
for a11 and b11. (RI8564B only)

A drop down list button that sets the method of averaging used for sparameter measurements. It is commonly used with the S11, Thru
Measure at Input Freq, and S Parameter measurement blocks.
The ‘std’ (standard) mode measures and averages each individual
wave parameter during an s-parameter measurement. The Averages
button value (found in the System > state panel of the Editor) sets
the number of samples for the average. For example, a test panel with
an S11 measurement block and Averages button value of ‘4’, would
measure a1, a1, a1, a1, then b1, b1, b1, b1.

MEAS

S11

NOTE: The ‘std’ is the fastest averaging mode.
A

Meas: S11
Measurement block which performs a series of a1 and b1 wave
parameter measurements to calculate a vector error-corrected S11
(b1 / a1) measurement. The output data type is a ratio expressed as a
complex voltage.

© Roos Instruments Inc.

The ‘adjacent’ mode interleaves the measure of wave parameters
during an s-parameter measurement. The Averages button value
(found in the System > state panel of the Editor) sets the number of
samples for the average. For example, a test panel with an S11
measurement block and Averages button value of ‘4’, would capture
the measurements as a1, b1, a1, b1, a1, b1, a1, b1.and then average
the individual wave parameters. The ‘adjacent’ averaging mode is
slower than the ‘std’ mode due to additional signal switching between
wave captures, but can minimize memory, temperature and/or signal
344
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instability from the DUT during large measurement captures or
averages.
NOTE: At higher frequencies and with averages greater than 8 to 16, some improvement
in accuracy and repeatability are often achieved using the adjacent averaging mode.

Meas: Thru Measurement at Input Freq
MEAS

Thru Measurement at Input Freq

A

MEAS

Input Wave

A

Meas: Input Wave
Measurement block that captures the incident and reflected waves as
a11 (signal out of W1 71-86GHz output, measured on the ‘a’ port of
the coupler in Instrument Button Diagram 2.6) and b11 (signal into W1
71-86GHz port, measured on the ‘b’ port of the coupler in Instrument
Button Diagram 2.6). The output data type is two complex voltages
for a11 and b11.(RI8564C Only)

Measurement block that computes the error correction factors for the
signal path connecting RF1 and the b2 downconversion path
connected to IF In (C8) or Aux IF In (C2) to generate a ‘perfect’ thru
reference from a non-perfect thru standard. The computed error
correction factors emulate a perfect thru (lossless) with S11 and S22
terms equal to zero (negative infinity approximated by -180dB), and
S21 and S12 equal to one (0dB). The resulting data is corrected
absolute power, with default units of Watts. (RI8564C Only)
NOTE: This measurement block is typically used as a calibration method to create a
perfect thru standard from a generic, non-perfect thru path for relative measurement
comparisons.

© Roos Instruments Inc.
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PANEL: RECEIVER STATE

If Gain

20
If Bw

200 kHz

If Bw
Drop down list select button that sets the internal receiver’s analog
detection bandwidth within the IF Board, 21.4 MHz in the Instrument
Button Diagram 2.5.
The ‘5 MHz’ option is the full bandwidth of the receiver’s front-end.
The ‘7 KHz’ value is a bandpass filter applied before the IF signal is
converted to zero IF/baseband.
The ‘200 kHz’ is a low pass filter applied after IF conversion to zero IF.
The ‘TOI’ value activates a filtering/gain/attenuator mode that selects
the ‘7 kHz’ IF filter and optimizes the ratio of the gain scheme for the
amplifiers on the input and output sides of the IF filter to place all of
the gain on the output side for high-fidelity third order intercept
measurements. In ‘TOI’ mode the If Gain button is limited to values of
‘8’ and ‘14’. (RI8564B only)
NOTE: The If BW button value is ignored and a 10 MHz IF bandwidth is used when a
RMS Power, RMS Power vs. Time, or RMS Voltage measurement block is used in a
test panel.

© Roos Instruments Inc.

If Gain
Drop down list select button that sets the gain of an amplifier in units
of dB within the IF Board, 21.4 MHz in the Instrument Button Diagram
2.5. This value should be optimized for best dynamic range. The
selection options of ‘8’, ‘14’, ‘20’, ‘26’, ‘32’, ‘38’, ‘44’, ‘50’, ’56’, ’62’,
and ’68’ are in units of dB. (RI8564B only)
NOTE: Optimal settings are achieved by increasing the value until an overflow messages
appears in the message window during test compile or run and then selecting the value
below the setting that causes an overflow warnings.
When used with the If Bw button set to the ‘TOI’ option, the If Gain setting is the ratio
between the input and output amplifiers of the IF filters to place all of the gain on the
output side. In this mode, only the ‘8’ and ‘14’ values of the IF gain button are valid.

If Bw

80000

Meas Rate
Decimal notation input button that sets the sample rate of the
receiver’s digitizer in units of Hz. The maximum sample rate is 200
kHz. (RI8564B only)
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Rms Bw

Rms Gain

Slow

High

Rms Bw

Rms Gain

Drop down list select button that sets the post-detection bandwidth
for Root Mean Squared (RMS) measurements. This button is used to
optimize the settling speed of the detectors lock and measure speed.
It is commonly used with the RMS Power, RMS Voltage, and
Delayed RMS Power measurement blocks. (RI8564B only)

Drop down list button that sets the post-detection gain. This button is
commonly used with the RMS Power, RMS Voltage, and Delayed
RMS Power measurement blocks. (RI8564B only)

NOTE: The ‘Fast’ setting can be susceptible to increased measurement instability due to
DUT and fixture path dependent settling times.

The ‘High’ setting is approximately 0dB.
The ‘Low’ setting is approximately -20dB.
NOTE: The RMS detector receive path is automatically selected when an RMS Power,
RMS Voltage, or Delayed RMS Power measurement block is used.

An RMS measurement overrides the If Bw button and uses a 10 MHz
IF bandwidth.
NOTE: The RMS detector receive path is automatically selected when an RMS Power,
RMS Voltage, or Delayed RMS Power measurement block is used.

Samples

1

Samples
Integer value button that sets the number of samples per
measurement block. The maximum number of samples is 2000.
(RI8564B only)

© Roos Instruments Inc.
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PANEL: RECEIVER MEASUREMENTS

Meas: Phase Noise (watts/hz)
MEAS

Phase Noise (watts/hz)

MEAS

Noise Power

A

A

Meas: Noise Power
Measurement block that performs a noise power measurement for the
current path. (RI8564B only)

Measurement block that calculates the noise power within a 1Hz
bandwidth using the configured setup. Uses the Noise Power
measurement as its base. (RI8564B only)
MEAS

Voltage Vs Time

MEAS

A

Meas: Voltage Vs Time
Voltage

A

Meas: Voltage
Measurement block that performs a complex voltage measurement
for the current path. (RI8564B only)

Measures an RF signal complex voltage amplitude/voltage vector and
records the value with it’s corresponding measurement time.
(RI8564B only)
MEAS

MEAS

RMS Power Vs Time
Power

A

Meas: Power
Measurement block that measures error-corrected (calibrated) power
for the current path. It converts voltage measurements to power and
then averages the result. (RI8564B only)

A

Meas: RMS Power Vs Time
Measures RMS power for the selected port using the dedicated RMS/
Noise detector path and records the corresponding measurement
time. (RI8564B only)
NOTE: The If BW button value is ignored and a 10 MHz IF bandwidth is used when
this measurement block is used in a test panel.

© Roos Instruments Inc.
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PANEL: DIGITIZER MEASUREMENTS
MEAS

RMS Power

Trigger

A

oﬀ

Meas: RMS Power
Trigger
Measurement block that performs a RMS power measurement for
current path using the internal RMS/Noise detector. (RI8564B only)
NOTE: The If BW button value is ignored and a 10 MHz IF bandwidth is used when
this measurement block is used in a test panel.

Drop down list button that is used in a pre/post measure groups to
activate (‘on’) or deactivate (‘off’) triggered receiver measurements.
This button is commonly used with the Delay button in the pre/post
measure group and the Trigger Mode button in the test panel or
section default. (RI8564B only)
Trigger Mode

MEAS

RMS Voltage

normal
A

Meas: RMS Voltage

Trigger Mode

Measurement block measures RMS voltage by converting the
complex voltage vector into a scalar amplitude vector and then
computes the root mean square value. (RI8564B only)

Drop down list button that configures the receiver’s detector hardware
for different trigger/pulse type measurements. This button is
commonly used in test panels with the Trigger and Delay buttons
placed in pre/post measure groups. (RI8564B only)

NOTE: The If BW button value is ignored and a 10 MHz IF bandwidth is used when
this measurement block is used in a test panel.

The ‘normal’ selection uses the receiver’s voltage detector for
triggered measurements.
The ‘voltage’ selection performs the same function as the ‘normal’
mode.

© Roos Instruments Inc.
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The ‘power’ selection uses the RMS detector for triggered
measurements.

MEAS

Delayed Voltage

The ‘V vs T’ selection uses the voltage detector for triggered Voltage
vs Time block measurements.

A

Meas: Delayed Voltage
Measurement block that performs a complex voltage calculation after
the time specified in the Delay button. (RI8564B only)

Delay

0

MEAS

Delay
Decimal notation input button used within pre/post measure groups
to delay the start of a triggered measurement with a user-defined
duration. The value is in units of seconds with a maximum value of
0.01 seconds and a resolution of 1µs. This button is commonly used
with the Trigger button. (RI8564B only)

Triggered Digitizer

A

Meas: Triggered Digitizer
Measurement block that performs a complex voltage vs time
calculation relative to the specified Trigger Mode and Trigger
buttons in the premeasure group. (RI8564B only)

MEAS

Delayed RMS Power

A

Meas: Delayed RMS Power
Measurement block that performs a RMS power calculation after a
the time specified in the Delay button. (RI8564B only)

© Roos Instruments Inc.
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CONTROL PANELS
Real-time control of the instruments in this TIM.

C ONTROL P ANELS 7 RI8564B 75-81GHZ TEST SET
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RECEIVER CONTROL
POWER DBM, VOLTAGE DBM, NOISE DBM/HZ,
RMSDBM
The above values are live and refresh when the button is LMB clicked.

Testhead77 RF control panel provides real-time control of the
switched instruments in this TIM.

© Roos Instruments Inc.

351

SECTION 9

RI8567: 0.01 TO 12GHZ
TESTSET

Graphical Programming | RI8567: 0.01 to 12GHz TestSet

TOPICS

Instruments Provided by this TIM
Instrument Diagram with Edit Buttons
Edit Panel Button Descriptions
Control Panel

Tap the links above to quickly access content

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as RFMeasure1 in the panel dialog
windows.
Model and Name as it appears in the Tester Configuration:
• RfMeasure1, RI8567x 2 port Testset+Receiver
NOTE: Multiple RI8567 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - RFMeasure1,
RFMeasure2, RFMeasure3, etc). The “x” in RI8567x denotes the model revision
number.

© Roos Instruments Inc.
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I NSTRUMENT B UTTON D IAGRAM 2.7 RI8567
The Parameter button values of ‘a1’, ‘b1’, ‘a2’, and
‘b2’ are relative to the button values for the Input
Port and Output Port. The values shown represent
the test set’s button defaults.
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PANEL: RF SETUP

Automated control of the instruments in this TIM with use by the Test
Plan Editor.

Rf2

receive

Rf 2

E DIT P ANELS 10 RI8567: 100 KHZ - 12GHZ TEST SET

Drop down list button that controls the resource connections to the
RF2 (C7) coupled input/output port. The button configures the M29
solid-state switch (reference the Instrument Button Diagram 2.7) to
connect RF2 to various internal resources.
This button in combination with the Source and Receive Mode
buttons set the signal path routing through the TIM’s internal
mechanical relay connections.
The ‘source’ selection connects RF2 (C7) to the M14 solid-state
switch controlled by the Source button for using RF2 (C7) as an
output port driven by a signal from Src In 1 (C5).
The ‘receive’ selection connects RF2 (C7) to the internal solid-state
switch M26 controlled by Input Port, Output Port, and Receive
Mode buttons for using RF2 (C7) as an input for s-parameter or direct
receiver measurements.

RFMeasurement# RF Setup panel provides switched resource control
for instruments in this TIM.

© Roos Instruments Inc.

The ‘reflect’ selection connects RF2 (C7) to the internal “short”
termination on the M11 solid-state switch at port position 2.
The ‘noise’ selection connects RF2 (C7) as an output port driven by
the noise source at port position 3 on the M29 solid-state switch.
355

Cassini ATE System Reference Guide

Graphical Programming | RI8567: 0.01 to 12GHz TestSet
Rf3

Source

receive

RF 3

Rf 3

Source

Drop down list button that controls the resource connections to the
RF3 (C3) coupled input/output port. The button configures the
mechanical relay and solid-state switch M11 (reference the Instrument
Button Diagram 2.7) to connect RF3 to various internal resources.

Drop down list button that controls the solid-state switch M14
(reference the Instrument Button Diagram 2.7) for routing the Src In 1
(C5) resource to the specified port.

This button in combination with the Source, Source Mode, and
Receive Mode buttons set the signal path routing through the TIM’s
internal mechanical relay connections.

The ‘RF 2’ selection connects Src In 1 (C5) to switch position 1 of
M14 for routing to RF2 (C7).
The ‘RF 3’ selection connects Src In 1 (C5) to switch position 4 of
M14 for routing to RF3 (C3).

The ‘source’ selection connects RF3 (C3) to the M14 solid-state
switch controlled by the Source button for using RF3 (C3) as an
output port driven by a signal from Src In 1 (C5).
The ‘receive’ selection connects RF3 (C3) to the internal solid-state
switch M26 controlled by Input Port, Output Port, and Receive
Mode buttons for using RF3 (C3) as an input for s-parameter or
direct receiver measurements.
The ‘reflect’ selection connects RF3 (C3) to the internal “short”
termination on the M11 solid-state switch at port position 2.
The ‘load’ selection connects RF3 (C3) to the internal 50Ω “load”
termination on the M11 solid-state switch at port position 3.

© Roos Instruments Inc.

Source Mode

single

Source Mode
Drop down list button provides resource routing for Src In 2 (C6) and
Src In 1 (C5) to RF3 (C3) by directly controlling the mechanical relay
attached to the CP-3 coupler.
The ‘single’ sets the relay in the “normally closed” position, to connect
Src In 1 (C5) to RF3 (C3). Use Rf 3 and Source buttons to route
signals through to RF3 (C3).
‘dual’ sets the relay in the “normally open” position, to connect Src In
2 (C6) to RF3 (C3), bypassing the switches controlled by Rf 3 and
Source buttons.
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Input Port

Rf 2

Input Port

Input Port and Receive Mode buttons are used with the Output
Port button.
NOTE: The Input Port value must differ from the Output Port button setting.

This drop down list selection button that designates which of the RF
coupled ports RF2 (C7), RF3 (C3) will be defined as the input port to
the Device Under Test for protocol-aware, s-parameter
measurements. This button designates the coupled ports and switch
state for the a1 and b1 signals for all wave parameter measurements
and automates the load condition for forward/incident waves. The
Output Port and Receive Mode buttons are used with the Input
Port button.
NOTE: The Input Port value must differ from the Output Port button setting.

Output Port

Rf 3

Rec Attenuation

0db
Rec Attenuation
This drop down list selection button configures the receive attenuator
found at the common port output of the M26 switch (reference the
block diagram in the Appendix). The solid-state attenuator has
calibrated attenuation steps of 0 dB, 10 dB, 20 dB, or 30 dB. This
button is commonly used in s-parameter and power measurement
receive measurements to prevent overdriving/saturating the
downstream receiver’s RF front-end or optimizing the RF input signal
power for best dynamic range with the receiver.

Output Port
This drop down list selection button that designates which of the RF
coupled ports RF2 (C7), RF3 (C3) will be defined as the output port to
the Device Under Test for protocol-aware, s-parameter
measurements. This button designates the coupled ports and switch
state for the a2 and b2 signals for all wave parameter measurements
and automates the load condition for forward/incident waves. The

© Roos Instruments Inc.

Receive Mode

s-parameters
Receive Mode
This drop down list selection button selects which resource is routed
to the internal receiver by directly setting the solid-state switch
position of M26 (reference the block diagram in the Appendix).
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The ‘s-parameters’ selection connects the receiver to the coupled
ports pairs RF2/RF3 depending on the settings of the Input Port,
Output Port and the Parameter buttons. For example, setting Input
Port to ‘RF2’, Output Port to ‘RF3’ and Parameter to ‘a1’ would
route the incident signal on the CP-2 coupler’s ‘a’ port to the receiver
via switch M26:Position 3.
‘ref noise’ connects the the internal noise reference located on switch
M26: Position 1 to the receiver.
NOTE: This noise reference is used as a stable power reference strictly for the
instrument’s internal self-check.

switching network. It is typically used for routing incident/reflected
wave signals to the receiver for wave/s-parameter measurements.
The a1, ‘b1’. ‘a2’, and ‘b2’ selections use the compiler’s expert
system to automatically select the correct switch routing. These
selections require an RF port to be set by Input Port, Output Port,
and Receive Mode:’s-parameters’ buttons.
NOTE:
a1 is the incident wave to the input port of the device under test.
b1 is the reflected wave from the input port of the device under test.
a2 is the incident wave to the output port of the device under test.
b2 is the reflected wave from the output port of the device under test.

‘receiver’ connects RF2/RF3 as input ports to the receiver via M26:
Position 2 or M26: Position 4. This mode is used with the Rf
2:’receiver’ or Rf 3:’receiver’ button settings.
The ‘Aux Input’ routes the Low Freq (Aux) In (C8) input port to the
receiver. This mode is used for measuring signals from baseband to
4.4GHz with the receiver through the auxiliary port.
Parameter

a1

Parameter
Drop down list button that designates which of the coupler ports
[CP-2 (RF2), CP-3 (RF3), CP-6 (RF6), CP-7 (RF7)] will be routed to the
© Roos Instruments Inc.

Noise Src

oﬀ

Noise Src
Drop down list button that controls the state of the internal noise
source standard Noise Source 1.
The ‘on’ selection powers the noise source, producing an RF
calibrated “Hot” noise power.
The ‘Off’ selection deactivates power from the noise diode. This mode
can be used for so called “cold” noise power measurements.
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NOTE: The calibration factors for Noise Source 1 are frequency dependent and are
selected by the compiler based on the Frequency button definition found in the System
instrument of the Edit Panel.

Rf Input Offset

0db
Rf Input Offset
This drop down list select button directly controls the receive
attenuator and LNA for the receiver. They are located between the last
solid state switch M26 and the receiver’s mixer (reference the block
diagram in the Appendix). The receive attenuator and LNA allow the
user to optimize incoming signal power levels typically to prevent
saturation of the receiver’s RF mixers. This is useful for compensating
for the gain of active device, or losses from passive components for sparameter/receiver type measurements.

If Input Offset

0db

If Input Offset
This drop down list select button is a modifier of the If Gain button
value found in the RI8587 or RI8581 Receiver TIM. It provides relative
IF gain modification, i.e If Gain: ’44’ and If Input Oﬀset: ‘-12’ would
result in an actual IF Gain in the receiver of ’32’. This button is typically
used to offset output signals from high-gain devices or losses from
passive DUTs to maintain consistent signal power into the receiver.
The list options ‘-12’, ‘-6’, ‘0’, ‘6’, ‘12’, ‘18’, ‘24’) are in units of dB.

The list options ‘-30’, ‘-20’, ‘-10’, ‘0’, ‘10’, ‘20’, ‘30’ are displayed in
units of dB.
NOTE: Saturation of the downstream RF mixers in the receiver TIM will cause
nonlinear behavior in the form of signal harmonics at the downconverter’s output and
subsequent measurement instability.

© Roos Instruments Inc.
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PANEL: VNA MEASUREMENTS
Average Mode

slower than the ‘std’ mode due to additional signal switching between
wave captures, but can minimize memory, temperature and/or signal
instability from the DUT during large measurement captures or
averages.

std

Average Mode

NOTE: At higher frequencies and with averages greater than 8 to 16, some improvement
in accuracy and repeatability are often achieved using the adjacent averaging mode.

A drop down list button that sets the method of averaging used for sparameter measurements. It is commonly used with the S11, Thru
Measure at Input Freq, and S Parameter measurement blocks.
The ‘std’ (standard) mode measures and averages each individual
wave parameter during an s-parameter measurement. The Averages
button value (found in the System > state panel of the Editor) sets
the number of samples for the average. For example, a test panel with
an S11 measurement block and Averages button value of ‘4’, would
measure a1, a1, a1, a1, then b1, b1, b1, b1.
NOTE: The ‘std’ is the fastest averaging mode.

The ‘adjacent’ mode interleaves the measure of wave parameters
during an s-parameter measurement. The Averages button value
(found in the System > state panel of the Editor) sets the number of
samples for the average. For example, a test panel with an S11
measurement block and Averages button value of ‘4’, would capture
the measurements as a1, b1, a1, b1, a1, b1, a1, b1.and then average
the individual wave parameters. The ‘adjacent’ averaging mode is
© Roos Instruments Inc.

Spar Mode

unidirectional

Spar Mode
This list select button defines the calculation mode for two-port,
vector error-corrected scattering parameters. The mode selection
affects the compiler’s decisions for load and source routing schemes
in the TIM and the subsequent calculation methods for s/wave
parameter measurements.
The ‘unidirectional’ mode computes s-parameters by applying the
source to the input of the DUT and using a bi-state, load pull
condition on the output port to compute the a1, b1, and b2 wave
parameters. This mode infers the a2 wave parameter and thus S22,
and is faster than the bidirectional mode. Unidirectional mode is
optimal for unilateral active devices (essentially zero reverse
transmission coefficient, i.e. S12=0) such as power amplifiers.
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The ‘bidirectional’ mode computes s-parameters using the traditional
switched source methodology for measuring all eight transmission
parameters and then computing scattering parameters. This selection
executes all four source/load conditions on the DUT, providing the
most accurate s/wave parameters possible. The bidirectional mode is
optimal for passive, low-gain, or low-loss devices.
This button is commonly used with the Input Port, Output Port,
Parameter, Receive Mode: ‘s-parameter’ and corresponding Rf 2
and Rf 3 button designations.
MEAS
Wave Param at Input Freq

A

Meas: Wave Param at Input Freq
Measurement block performs a two-port, error-corrected wave
parameter measurement resulting in all 8 transmission parameters:
a11, a12, a21, a22, b11, b12, b21, b22 for a given device input frequency. It
uses the bi-state load pull method with the result in absolute voltage.
The receiver’s tuned frequency for this button is defined by the Freq
Reference, Input Freq Oﬀset, and/or Input Freq Scale buttons
found in the System instrument panel. This block is typically used for
user-custom s/wave parameter-like calculations.
NOTE: The frequency control button set is typically used for measuring frequency
converting devices.

© Roos Instruments Inc.

MEAS
Wave Param at Output Freq

A

Meas: Wave Param at Output Freq
Measurement block performs a two-port, error-corrected wave
parameter measurement resulting in all 8 transmission parameters:
a11, a12, a21, a22, b11, b12, b21, b22 for a given device output frequency.
It uses the bi-state load pull method with the result in absolute
voltage. The receiver’s tuned frequency for this button is defined by
the Freq Reference, Output Freq Oﬀset, and/or Out Freq Scale
buttons found in the System instrument panel. This block is typically
used for user-custom s/wave parameter-like calculations.
NOTE: The frequency control button set is typically used for measuring frequency
converting devices.

MEAS
Wave Param at Receive Freq

A

Meas: Wave Param at Receive Freq
Measurement block performs a two-port, error-corrected wave
parameter measurement resulting in all 8 transmission parameters:
a11, a12, a21, a22, b11, b12, b21, b22 for a given frequency. It uses the bistate load pull method with the result in absolute voltage. The
receiver’s tuned frequency for this button is defined by the
Frequency, and/or Freq Oﬀset buttons found in the Receiver’s
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instrument panel. This block is typically used for user-custom s/wave
parameter-like calculations.

MEAS
A

Thru Measurement at Input Freq

Meas: Thru Measurement at Input Freq

NOTE: The phase is only defined within a set and not with any other readings.

MEAS
Input power at Input Freq

A

Meas: Input power at Input Freq
Measurement block performs an error-corrected a11 (forward/incident
wave at input with output terminated) measurement with the receiver
set to measure at the frequency defined by the Freq Reference,
Input Freq Oﬀset, and/or Input Freq Scale buttons found in the
System instrument panel. The resulting data is corrected absolute
power, with default units of Watts

Measurement block that computes the error correction factors for the
signal path connecting RF2 (C7) and RF3 (C3) to generate a ‘perfect’
thru reference from a non-perfect thru standard. The computed error
correction factors emulate a perfect thru (lossless) with S11 and S22
terms equal to zero (negative infinity approximated by -180dB), and
S21 and S12 equal to one (0dB). The input frequency is defined by
the Freq Reference, Input Freq Oﬀset, and/or Input Freq Scale
buttons found in the System instrument panel of the Editor. The
resulting data is corrected absolute power, with default units of Watts.
NOTE: This measurement block is typically used as a calibration method to create a
perfect thru standard from a generic, non-perfect thru path for relative measurement
comparisons.

NOTE: Units can be changed to dBm using the Convert button found in System >
General Calculation panel.

© Roos Instruments Inc.
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PANEL: RECEIVER STATE

Mix Side

default
Frequency

1000

Frequency
Decimal notation input button that sets the tuned frequency of the
receiver in MHz. This frequency value is set by the System
Reference button (found in the ‘System’>‘Input Output State’ panel
of the Editor) when using a virtual instrument such as: VNA, noise
figure, or other multi-TIM measurements.

Mix Side
Drop down list select button that selects the ‘High’ (upper) or
‘Low’ (lower) sideband of the down-converted signal image to be
digitized by the receiver. The ‘default’ value allows the compiler to
select the optimal value.
NOTE: Changing from the default setting can affect tester accuracy. The ‘high’ or ‘low’
button settings should only be used if there is spurious or undesirable spectral content
from the device under test in the default sideband which interferes with the measurement.
For best accuracy, the ‘default’ setting should be used.

NOTE: This button is only used for measurements defined by the receiver instrument
such as a power or vector voltage measurement.
If Gain
Freq Offset

0

Freq Offset
Decimal notation input button that sets the receiver output offset
frequency in MHz. Maximum offset range is ±5MHz.
NOTE: A maximum offset range of ±10MHz is possible within certain frequency ranges.
Consult the message window during compile to ensure offset compliance for a given
center frequency.

© Roos Instruments Inc.

20

If Gain
Drop down list select button that sets the gain of an amplifier in units
of dB within the “IF Board, 21.4MHz” shown in the block diagram.
This value should be optimized for best dynamic range. The selection
options of ‘8’, ‘14’, ‘20’, ’26’ ‘32’, ‘38’, ‘44’, ‘50’, ’56’, ’62’, and ’68’
are in units of dB.
NOTE: Optimal settings are achieved by increasing the value until an overflow messages
appears in the message window during test compile or run and then selecting the value
below the setting that causes an overflow warnings.
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Samples

1

If Bw

200 kHz

If Bw
Drop down list select button that sets the receiver’s analog detection
bandwidth within the “IF Board, 21.4MHz” in the block diagram. The
‘5MHz’ option is the full bandwidth of the receiver’s front-end.
The ‘7KHz’ value is a bandpass filter applied before the IF signal is
converted to zero IF/baseband.
The ‘200 kHz’ is a low pass filter applied after IF conversion to zero IF.
The ‘TOI’ value activates a filtering/gain/attenuator mode that selects
the ‘7kHz’ IF filter and optimizes the IF and baseband gain/attenuator
scheme for third order intercept measurements. In ‘TOI’ mode the If
Gain button is limited to values of ‘8’ and ‘14’.
NOTE: The button value is ignored and a 10 MHz bandwidth is used when an RMS
Power, Computed RMS, or RMS Power vs. Time measurement block is used in a test
panel.

Samples
Decimal notation input button that sets the total number of
measurement samples.
Meas Rate

80000

Meas Rate
Decimal notation input button that sets the sample rate of the
receiver’s digitizer in units of Hz. The maximum sample rate is 200
kHz.
Rms Bw

slow

Rms Bw
Drop down list select button that sets the post-detection bandwidth
when an RMS Power, Computed RMS, or RMS Power vs. Time
measurement block is used. This button is used to optimize the
settling speed of the detectors lock and measure speed.
NOTE: The ‘Fast’ option setting can be susceptible to increased measurement instability
due to DUT and fixture path dependent settling times.

© Roos Instruments Inc.
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NOTE: The RMS detector receive path is automatically selected when an RMS Power,
RMS Voltage, or RMS PowerVsTime measurement block is used.

PANEL: RECEIVER MEASUREMENTS
MEAS
Computed RMS A

Rms Gain

High

Rms Gain
Drop down list button that sets the post-detection gain.
‘High’ is approximately 0dB.

Meas: Computed RMS
Measurement block computes an RF signals RMS power using the
complex voltage detector in the receiver.
NOTE: The If BW button value is ignored and a 10 MHz IF bandwidth is selected
when this measurement block is used in a test panel.

‘Low’ is approximately -20dB.
MEAS
CCDF

A

Meas: CCDF
This measure block computes the Complex Cumulative Distribution
Function (CCDF). Measure the CCDF at the given Par Level
measureRate and samples. Result is ratio of samples above the PAR
level to total samples

© Roos Instruments Inc.
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MEAS

MEAS
PAR 0.01%

RMS Power

A

A

Meas: RMS Power

Meas: PAR 0.01%
Measures and compute the power of the Peak to Average Ratio at
0.01%. It is used in conjunction with the Par Level and Par Range
buttons and commonly used with the Averages and Samples
buttons to determine the average power and number of sample
points to use for peak detection respectively.
MEAS
Voltage

Measurement block that computes the RMS power for the selected
port using the RMS/Noise detector. The Rf 2:‘receive’ and/or Rf
3:‘receive’ buttons settings are used to select the measurement port
for this block.
NOTE: The If BW button value is ignored and a 10 MHz IF bandwidth is selected
when this measurement block is used in a test panel.

A

Meas: Voltage
Measures the RF signal’s complex voltage amplitude for the selected
port. The input signal is mixed with the receiver’s orthogonal tuning
signals, providing input signal phase and amplitude represented as a
complex voltage value or voltage vector. It is commonly used with the
Average button found in the System > state panel of an Editor.

MEAS
Voltage vs Time

A

Meas: Voltage vs Time
Measures an RF signal complex voltage amplitude/voltage vector and
records the value with it’s corresponding measurement time.
MEAS
RMS Power vs Time

A

Meas: RMS Power vs Time
Measures RMS power for the selected port using the dedicated RMS/
Noise detector path and records the corresponding measurement
time.
© Roos Instruments Inc.
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NOTE: The If BW button value is ignored and a 10 MHz IF bandwidth is selected
when this measurement block is used in a test panel.

Par Level

0

Par Level

MEAS
Phase Noise (watts/hz)

A

Meas: Phase Noise (watts/hz)
Measure the noise power in units of Watts/Hz in a 1 Hz bandwidth
with the user-defined setup. Uses the Noise Power measurement as it
base.

Decimal notation input button that defines the expected peak or
maximum power level of the stimulus signal in dBm. This button is
used with the Par Range button and PAR 0.01% and CCDF
measurement blocks.

Par Range

MEAS

4
Power

A

Par Range

Meas: Power
Measures the corrected signal power for the selected port and path.
The block converts complex voltage to a scalar power value.
MEAS
Noise Power

A

Meas: Noise Power
Measurement block measures noise power for a selected port using
the dedicated noise detector in the receiver’s baseband subsystem.

© Roos Instruments Inc.

Decimal notation input button that defines the power level range in
dBm below the Par Level button setting that will be divided into 8
power step measurement levels when measuring the signal power
levels for PAR or CCDF of a stimulus signal. The Par Level and Par
Range buttons combine to define the measurement dynamic range
and power step size, i.e - a Par Level value of ‘0’ and Par Range
value of ‘4’ defines an expected peak signal power of 0dBm with a
measurement resolution of 0.5dB/step size (4dBm/8 steps) below the
expected peak power. This button is used with the PAR 0.01% and
CCDF measurement blocks.
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The ‘power’ selection uses the RMS detector for triggered
measurements.

PANEL: DIGITIZER MEASUREMENTS
Trigger

oﬀ

The ‘V vs T’ selection uses the voltage detector for triggered Voltage
vs Time block measurements.

Trigger

Delay

Drop down list button that is used in a pre/post measure groups to
activate (‘on’) or deactivate (‘off’) triggered receiver measurements.
This button is commonly used with the Delay button in the pre/post
measure group and the Trigger Mode button in the test panel or
section default.
Trigger Mode

normal

0

Delay
Decimal notation input button used within pre/post measure groups
to delay the start of a triggered measurement with a user-defined
duration. The value is in units of seconds with a maximum value of
0.01 seconds and a resolution of 1µs. This button is commonly used
with the Trigger button.

Trigger Mode
Drop down list button that configures the receiver’s detector hardware
for different trigger/pulse type measurements. This button is
commonly used in test panels with the Trigger and Delay buttons
placed in pre/post measure groups.
The ‘normal’ selection uses the receiver’s voltage detector for
triggered measurements.

MEAS
Triggered Complex V A

Meas: Triggered Complex V
Measurement block that calculates an RF signals complex voltage
vector vs. time relative to a specified trigger in the premeasure. This
measurement block is commonly used with the Trigger, Trigger
Mode, and/or Delay buttons.

The ‘voltage’ selection performs the same function as the ‘normal’
mode.

© Roos Instruments Inc.
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PANEL: SPECTRUM MEASUREMENTS

MEAS
Triggered Power

A

If Shift

Meas: Triggered Power
Measurement block computes RF signal power vs. time from
measured complex voltage relative to a specified trigger in the
premeasure. This measurement block is commonly used with the
Trigger, Trigger Mode, and/or Delay buttons.

0

If Shift
Decimal notation input button that sets the frequency offset for the
FPGA-based mixer within the digital signal processor subsystem.
Values are in units of Hz with a range of 0 to 100 kHz.
Det Bw

bypass

Det Bw
Drop down list button that configures the bandwidth of a postmeasure, low-pass digital filter in the receive detector’s FPGA-based
DSP chain. These provide selectable, narrow-band filters with typically
60 dB of stop band attenuation. The ‘bypass’ selection is the default,
applying no digital filter. The other options are 3 MHz, 2 MHz, 1 MHz,
500 kHz 200 kHz, 100 kHz, 50 kHz, 25k Hz, 10k Hz, 5k Hz, 2.5 kHz,
and 1 kHz bandwidth filters.

© Roos Instruments Inc.
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MEAS
Spectrum Power A

Meas: Spectrum Power
Measurement block computes the spectral power in units of Watts/Hz
using the receiver’s FPGA-based, real-time DSP.
MEAS
Spectrum vs. Time A

Meas: Spectrum Voltage
Measurement block computes spectral voltage vectors (complex
voltage) versus time using the receiver’s FPGA-based, real-time DSP.

© Roos Instruments Inc.
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RECEIVER CONTROL PANEL
POWER DBM, VOLTAGE DBM, NOISE DBM/HZ, RMS
DBM, Path Gain
All above measurements are refreshed in real-time when clicked.

C ONTROL P ANELS 8 RI8567: 100 KHZ - 12GHZ TEST SET

RFMeasure# Rf control panel controls the states of the receiver in
real time.

© Roos Instruments Inc.
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RI8572: WAVEFORM
GENERATOR & MEASURE
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TOPICS

Instruments Provided by this TIM
Configuration Panel
Instrument Diagram with Edit Buttons
Edit Panel Button Descriptions
Control Panel

Tap the links above to quickly access content

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as Oscilloscope, SineGen, and
Waveform in the panel dialog windows.
Model and Name as it appears in the Tester Configuration:
• Oscilloscope, RI74105x Hi Spd scope/counter/BER
• SineGen, Ri7403x Dual Sine Source
• Waveform, Ri74211x Complex Waveform
NOTE: Multiple RI8594 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e Oscilloscope,SineGen,Waveform; Oscilloscope2,SineGen2,Waveform2;
Oscilloscope2,SineGen2,Waveform2; etc).
The “x” in RI8594x denotes the model revision number.

© Roos Instruments Inc.
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Configure the Instruments in this TIM.
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Graphical Programming | RI8572: Waveform Generator & Measure

WAVEFORM
EDIT PATTERNS
This button displays the current waveform/pattern loaded into the
Waveform instrument’s arbitrary waveform generator. A left-button
click on the button opens the Edit Waveform Patterns window (See
Figure 2.1). The left pane of the Edit Patterns window displays a list of
all waveforms that have been loaded into the instruments on-board
memory. Selecting any of these waveforms with a left-mouse button
displays more information in the right pane: start address in memory,
number of samples, sample clock rate, peak magnitude, RMS
magnitude in dB, and information about the original waveform file
from Guru. New waveforms can be added to the list by selecting
‘Pattern’ > ‘add from Guru’ from the menu options. The user can then
select a waveform from Guru and specify additional information.
NOTE: Waveforms are programmed into memory sequentially. While waveforms can be
removed from the list view by selecting them and using the menu option “Pattern >
remove,” they are not erased from the memory. To make used memory available again,
all waveforms must be purged using the “Pattern > Erase > All Patterns” menu option.

Shows the Oscilloscope connections.

© Roos Instruments Inc.
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Detector

Frequency Wf 8

J3

SineGen
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0

Amplitude Wf 9
0

Frequency Wf 9
0

Trigger
stop

Max Samples
1000

Waveform Ratio
1.25

10 us!
1 us!
100 ns!
50 ns!
25 ns!
12.5 ns!
6.25 ns!
3.125 ns!
1.56 ns

C13
C5
Digitizer
In2, WF7
Waveform
Out2, WF3

C1
C9
Digitizer
In1, WF6
Waveform
Out1, WF2
Low Noise
Clock, WF1

Sinegen
Out2, WF9
C16
C8

Sinegen
Out1, WF8
C4
C12

M18
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EDIT PANELS
Automated control of the instruments in this TIM with use by the Test
Plan Editor.

Graphical Programming | RI8572: Waveform Generator & Measure

OSCILLOSCOPE
PANEL: SCOPE
Measure Type

E DIT P ANELS 11 RI8572: WAVEFORM GENERATOR & MEASURE

counter
Measure Type
Drop down list button that sets the operation type for the oscilloscope
instrument. This button is found in the ‘scope’, ‘counter/ber’, and
‘time analyzer’ subsystem panes of the oscilloscope. Buttons and
blocks found in these subsystem panes are settings/parameters used
by the corresponding function choice of this button. The description
of each function is as follows:
The ‘scope’ setting is an oscilloscope function optimized for signal
capture of sinusoidal waveforms from 1 Hz to 80 MHz.
The ‘digitizer’ setting is a digitizing oscilloscope function for arbitrary
signals from 1 Hz to 80 MHz.

Oscilloscope scope panel provides basic state and measurement
buttons.

© Roos Instruments Inc.

The ‘counter’ setting performs frequency counting operation of
sinusoidal, square-wave, and pulse signals. This function requires a
voltage reference or trigger and several periods of the input signal to
accurately compute signal frequency.
The ‘time analyzer’ setting performs timing computations of signal
events using a trigger and a user-defined measurement timing
window.
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The ‘ber’ setting performs a bit error rate calculation. A predefined,
pseudo-random gray code bit stream is emitted from the userselected port. The digitizer captures the return signal after a userspecified wait or trigger time and then calculates the bit error rate.
The ‘reciprocal’ setting performs a signal frequency count using a
reciprocal count method optimized for faster computation of signals
below 1 MHz. The reciprocal counter uses the input signal as a trigger
and counts the internal clock edges across one period of the input
signal.

Samples

100
Samples
Decimal notation input button that sets the total number of samples in
the oscilloscope capture window.
NOTE: Maximum number of samples is 2000.

Input Freq

Sample Rate

1M

1M

Input Freq

Sample Rate

Decimal notation input button that sets the frequency of the expected
input signal in units of Hz. The expected input frequency value
enables accurate signal reconstruction of input signals with frequency
values greater than the Nyquist sample rate of the oscilloscope.

Decimal notation input button that sets the oscilloscope’s sample rate
in units of Hz.
NOTE: Maximum sample rate is 80MS/s

NOTE: This button enables a Cassini system compiler directive to compensate for signal
path calibrations for a known frequency value.

© Roos Instruments Inc.
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MEAS

PANEL: COUNTER/BER

Complex vs Time A

Measure Time

0

Meas: Complex vs Time

Measure Time

Measurement block that computes an RiComplex Voltage vs time
result. Using port WF7 as the real (in-phase) signal component and
the WF6 port as the imaginary (quadrature) signal component, the
block computes a voltage vector representation of an I/Q baseband
signal by digitizing each channel independently and then timeinterleaving the channels.

Decimal notation input button that sets the measurement window for
counter measurement gating in units of seconds. Maximum time limit
is 2000*Sample Rate.
Edge Detect

oﬀ
Edge Detect
Drop down list button that sets the edge detector mode. Option ‘off’
deactivates edge detection. The ‘rising’ option sets the detector to
generate edges, trigger, or count on rising edge event types in the
data input. The ‘both’ option sets the detector to generate edges,
trigger, or count on both rising and falling edge event types in the data
input.
NOTE: This button must be set to either ‘rising’ or ‘both’ for event counting.

© Roos Instruments Inc.

378

Graphical Programming | RI8572: Waveform Generator & Measure

Cassini ATE System Reference Guide
Data Polarity

Clock Input

normal

oﬀ

Data Polarity

Clock Input

Drop down list button that sets the data input polarity for counter or
bit error rate measurements. The ‘normal’ option is positive or rising
edge count/trigger. The ‘inverted’ option is falling or negative edge
count/trigger.

Drop down list select button selects the clock input for bitt error rate
measurements. The ‘Wf6’ sets the signal available at the WF6 port
located at position C5 on the instrument head as the clock input. The
‘Wf7’ sets the signal available at the WF7 port located at position C1
on the instrument head as the clock input. The ‘off’ option uses the
instruments internal clock.

Data Input

Wf6
Wf7 Trigger Level

Data Input

1

Drop down list select button that selects the instrument resource port
for measurements. The option ‘Wf6‘ sets WF6, located at port
position C1 on the instrument head, as input to the digitizer. The
option ‘Wf7‘ sets WF7, located at port position C5 on the instrument
head, as input to the digitizer. The option ‘off‘ internally disconnects all
input ports or paths from the digitizer instrument.

Wf 7 Trigger Level
Decimal notation input button that sets the trigger comparator level
voltage for WF7. Valid range of inputs is ±0.4V
Wf6 Trigger Level

1
Clock Polarity

Wf 6 Trigger Level

normal

Clock Polarity

Decimal notation input button that sets the trigger comparator level
voltage for WF6. Valid range of inputs is ±0.4V

Drop down list button that sets the polarity of the clock. The ‘normal’
option is positive or rising edge count/trigger. The ‘inverted’ option is
falling or negative edge count/trigger.

© Roos Instruments Inc.
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Input Term

NOTE: A minimum of two edge/rise or fall time events is required for accurate
frequency count.

hiZ

Input Term
Drop down list button sets the input termination value to ‘hiZ’
representing a high impedance value of approximately 10kΩ or
‘50ohm’ for 50Ω.

MEAS
Period

Holdoff

A

Meas: Period

0

Holdoﬀ
Decimal notation input button that sets the time in seconds that the
edge/gate is disabled after sensing a trigger event. The range of
values is 150ns to 25µs.

Measurement block that computes the time between signal edges of
the selected input port set by Data Input button. The block uses the
Measure Time button to set the capture window time.
NOTE: A minimum of two edge/rise or fall time events is required for accurate period
measurement.

NOTE: Typically set to the rise time of the edge.

MEAS
MEAS
Bit Error Rate
Frequency

A

Meas: Frequency
Measurement block that computes signal frequency of the selected
input port set by Data Input button. The Measure Time button sets
the capture window time.
© Roos Instruments Inc.

A

Meas: Bit Error Rate
Measurement block computes the ratio of errors to bits (BER) in a
bitstream of the selected input port set by Data Input button. The
Measure Time button sets the capture window time.
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PANEL: DIGITIZER
Samples
Delay

0

Delay
Decimal notation input button that sets the delay in units of seconds
with a resolution of 1µs before a digitizer measurement or to offset the
start of a record. Maximum delay value is 2000*Sample Rate.

0

Samples
Decimal notation input button that sets the measurement record
length for the digitizer. Maximum value is 2000.
MEAS

Sample Rate

0

Sample Rate
Decimal notation input button that sets the digitizer sample rate in Hz.
The valid sample rate range is 1 Hz to 80 MHz.
Trigger

stop

Triggered Voltage A

Meas: Triggered Voltage
Measurement block computes a single voltage vector sample from an
I/Q input signal voltage vector using a pre-measure group trigger
button. The sample point is set by the system measure reference plus
any user specified delay using the Delay button. The block generates
a single RiComplexVoltage value.

Trigger
Drop down list button that is used within a pre-measure group to set
the start and stop times of signal captures or bit error rate
measurements. The ‘start’ option triggers an event collection. The
‘stop’ option ends the event collection.
NOTE: This button is used in conjunction with triggered measurements types.
© Roos Instruments Inc.
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MEAS

PANEL: TIME ANALYZER

Triggered Digitizer A

Trigger

Meas: Triggered Digitizer
Measurement block computes multiple samples of an I/Q input
signal’s voltage vector using a pre-measure group trigger button.
Sample points begin at the system measure ref plus any user
specified delay using the Delay button. The block computes and
time-interleaves the two signal channels into RiComplexVoltage
values.

stop

Trigger
Drop down list button that is used within a pre-measure group to set
the start and stop times of signal captures or bit error rate
measurements. The ‘start’ option triggers an event collection. The
‘stop’ option ends the event collection.
NOTE: This button is used in conjunction with triggered measurements types.

Measure Time

Measure Time

0

Decimal notation input button that sets the measurement window for
counter measurement gating in units of seconds. Maximum time limit
is 2000 samples*Sample Rate

© Roos Instruments Inc.
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MEAS
Triggered Time Stamps A

Meas: TriggeredTimeStamp
Measures events from the counter system. Generates an RiTimeD
data type with an entry for each edge. Measure is started and
stopped by the Trigger in the pre-measure. Use MeasureTime for the
length to examine. Samples must exceed the measure time such that
several samples occur after the time completes.

© Roos Instruments Inc.
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PANEL: STATE
Wf3 Amplitude

E DIT P ANELS 12 RI8572: WAVEFORM GENERATOR & MEASURE

0
Wf 3 Amplitude
Decimal notation input button that sets the amplitude of the open
circuit peak voltage of the in-phase (real) signal component. The
signal is available at WF3 located at position C6 on the instrument
head. Maximum value is 2.5 volts peak.
Wf3 Phase

0
Wf 3 Phase
Decimal notation input button that sets the waveform delay in units of
degrees of the in-phase (real) signal at WF3 located at position C6 on
the instrument head. The range of values is ±180.
Wf3 Offset

0
Waveform state panel provides basic state buttons for the waveform
instrument.

Wf 3 Oﬀset
Decimal notation button that sets the signal offset voltage for the
waveform at WF3 located at position C6 on the instrument head.
Available range is ±3V.
NOTE: The output waveform plus the offset cannot exceed ±3 volts.

© Roos Instruments Inc.
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Frequency

Wf2 Amplitude

100000

0
Wf 2 Amplitude

Frequency

Decimal notation input button that sets the amplitude of the open
circuit peak voltage of the quadrature (imaginary) signal component.
The signal is available at WF2 located at position C2 on the
instrument head. Maximum value is 2.5 volts peak.

Decimal notation input button that sets the waveform frequency in
units of Hz. When modulating the signal/s this button sets the center
frequency. The range of frequencies available are 1 kHz to 35 MHz
Translate

0

Wf2 Phase

0
Wf 2 Phase
Decimal notation input button that sets the waveform delay in units of
degrees of the quadrature (imaginary) signal at WF2 located at
position C2 on the instrument head. The range of values is ±180.
Wf2 Offset

0
Wf 2 Oﬀset
Decimal notation button that sets the signal offset voltage for the
waveform at WF2 located at position C2 on the instrument head.
Available range is ±3V.

Translate
Decimal notation input button that generates two sinusoidal tones on
WF2 and/or WF3 on either side of the Frequency button value by a
user-defined value in units of Hz. For example, a Frequency value of
1 MHz and a Translate value of 100 kHz generates tones at 900 kHz
and 1.1 MHz. Range of Frequency ± Translate values must remain
between 1 Hz - 20 MHz.
NOTE: The translate button provides direct control of the arbitrary waveform
generator’s DDS and can be used to generate a sinusoidal signal on WF2/WF3 up to
80 MHz by setting the Sample Rate button to ‘1.56 ns’, the Frequency button to 0 Hz,
and the Wf2/Wf3 Amplitude button to the desired level. This multi-purpose feature can
also be used to generate low frequency two-tone signals for intermodulation
measurements.

NOTE: The output waveform plus the offset cannot exceed ±3 volts.
© Roos Instruments Inc.
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Type

none
Type
A drop down list button that outputs a two-channel, baseband
waveform on WF2 (quadrature/imaginary) and WF3 (in-phase/real)
from built-in modulation waveform types:
‘Quad’ - Quadrature sinusoidal waveforms (WF3 leads WF2 in phase
by 90 degrees).
‘Fast Quad’ - This mode is no longer supported.
‘Sine’ - produces a sinusoidal waveforms on WF6 and/or WF7 with
parameters defined by the user.
‘Dual Sine’ - This mode is no longer supported.
‘SSB Dual Sine’ - Single sideband, dual sine waves on WF6/WF7.
This mode produces two sinusoidal waveforms on a single channel
specified by the user with Frequency 1= Frequency setting, and
Frequency 2=Frequency * Frequency Ratio.
‘SqWave’ - produces a square-wave signal on WF6 and/or WF7 with
parameters defined by the user.
‘modulation’ - produces a modulated waveform using the button
parameters found in the modulation pane of the waveform instrument.
‘file’ - This mode is no longer supported.
© Roos Instruments Inc.

‘internal file’ - enables a user-defined signal specified by the
Waveform File button in the edit panel. The list of waveforms in the
Waveform File button can be edited by adding or removing
waveform files to the TIM from Guru via the Edit Patterns button in
the Configuration Panel. ‘internal file’ - This mode is no longer
supported.
Waveform Ratio

1.25
Waveform Ratio
Decimal notation input button that used with the ‘SSB Dual Sine’
mode to generate two sinusoidal tones at frequency values that are a
ratio value of each other on a single channel for WF6 or WF7. For
example, a Frequency value of 2 MHz and Waveform Ratio of 1.25
produces a tone at 2 MHz and 2.5 MHz. Range of valid inputs is 1 to
2.
Sample Rate

50 ns
Sample Rate
A drop down list button that sets the time between the waveform
data’s next sample output. Sample rates options are ‘10 μs’ (100 kHz)
,‘1 μs’ (1 MHz), ‘100 ns’(10 MHz), ‘50 ns’(20 MHz), ‘25 ns’ (40 MHz),
and ‘12.5 ns’ (80 MHz), ‘6.25 ns‘ (160 MHz), ‘3.125 ns’(320 MHz),
and ‘1.56 ns’(640 MHz).
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For ‘sine’, ‘quad’, and ‘SSB Dual Sine’, the Sample Rate must be
typically Sample Rate ≥ 8*Frequency for accurate signal generation.
NOTE: For the “Pattern” type files the maximum sample rate is ’25 ns’

The ‘pmStop’ value is used to trigger the end of a waveform burst
with a precision stop time designated by the user within a test panel
using a post-measure sequence grouping.
The ‘trigger’ value is used to start a waveform burst with a pre-set
start time of 0 and is terminated by the user within a test panel using
a ‘pmStop’ in the post-measure sequence grouping.

Max Samples

1000
Max Samples

NOTE: ‘pmStart” and ‘pmStop’ must be used together within a test panel for the desired
result of syncing the waveform with an event or user start time.

Decimal notation input button that sets the number of samples in the
emitted waveform. Maximum value is 2000.

Waveform File

none

Mode

run
Mode
Drop down list button that enables or triggers a burst of an emitted
waveform.

Waveform File
Drop down list button chooses waveforms that have been preloaded
into the instrument.

The ‘run’ value is used in global or section defaults or within a test
panel to initiate a waveform.
The ‘stop’ value is used in global or section defaults or within a test
panel to cease a waveform.
The ‘pmStart’ value is used to trigger a burst of the waveform with a
precision start time designated by the user within a test panel using a
pre-measure sequence grouping.
© Roos Instruments Inc.
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PANEL: MODULATION

Mod Index

1.0
Filter

none
Filter
A drop down list button that selects a digital filter type to be applied to
the waveform. Built-in types include: “Raised Cosine”, “Gaussian”,
“GMSK”, or a user-defined filter type provided by the Filter File
button.
Filter Bw

1.0

Mod Index
A decimal notation input button that sets the ratio of the excursions of
the modulated signal to the level of the unmodulated carrier.
Data Bits

100
Data Bits
An integer value button that sets the number of data points per
record.
Data Rate

Filter Bw
A decimal notation input button that sets the ratio of the selected
filter’s bandwidth with the symbol bandwidth.
Filter Taps

0

1000000
Data Rate
An integer value button that sets the output data point rate in units of
Hz
Modulation Type

Filter Taps
Decimal notation input button that sets the total number of digital filter
coefficients.

none
Modulation Type
A drop down list button that selects a modulation from the built-in
standards: “Ran FSK” - Random Frequency Shift Keying, “8PSK” - 8

© Roos Instruments Inc.
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Symbol Phase Shift Keying, ‘Edge’, ‘QPSK’ Quadrature Phase Shift
Keying, ‘FM Tone’, and ‘AM Tone’.
Filter File

none
Filter File
A drop down list button that selects the file name of a user-defined
digital filter taps or coefficients file.
Prn Type

none
Prn Type
A drop down list button that selects the size of the pseudo random
number seed used in the sequence generator. i.e “PN5”, “PN7”,
“PN9”, etc.
Data Delay

0
Data Delay
A decimal notation input button that sets the data output delay in
units of seconds with a resolution of 1 µs.

© Roos Instruments Inc.
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SINEGEN
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PANEL: STATE
Frequency Wf 8

E DIT P ANELS 13 RI8572: WAVEFORM GENERATOR & MEASURE

1
Frequency Wf 8
Decimal notation button that sets the output sine wave’s frequency in
MHz. The range of frequencies are 1kHz to 90MHz.
Amplitude Wf 8

0
Amplitude Wf 8
Decimal notation input button that sets the amplitude of the opencircuit, peak-to-peak voltage of the in-phase (real) signal component.
The signal is available at WF8 located at position C4 on the
instrument head. Input value is peak-to-peak voltage (i.e - a value of 2
results in a +1 V to -1 V signal). Maximum value is 2.5 volts.
Offset Wf 8

0
SineGen sate panel provides basic state buttons for the simple sine
wave generator.

Oﬀset Wf 8
Decimal notation button that sets the signal DC offset voltage for the
waveform at WF8 located at position C4 on the instrument head.
Available range is ±3V.
NOTE: The output waveform plus the offset cannot exceed ±3 volts.

© Roos Instruments Inc.
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Frequency Wf 9

1
Frequency Wf 9

Decimal notation button that sets the output sine wave’s
frequency in MHz.
Amplitude Wf 9

0
Amplitude Wf 9
Decimal notation input button that sets the amplitude of the opencircuit, peak-to-peak voltage of the quadrature (imaginary) signal
component. The signal is available at WF9 located at position C8 on
the instrument head. Input value is peak-to-peak voltage (i.e a value of
2 results in a +1 V to -1 V signal). Maximum value is 2.5 volts.
Offset Wf 9

0
Oﬀset Wf 9
Decimal notation button that sets the signal DC offset voltage for the
waveform at WF9 located at position C8 on the instrument head.
Available range is ±3 V.
NOTE: The output waveform plus the offset cannot exceed ±3 volts.
© Roos Instruments Inc.
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CONTROL PANELS
Real-time control of the instruments in this TIM.

Graphical Programming | RI8572: Waveform Generator & Measure

OSCILLOSCOPE
SCOPE
MEAURE, RMS DFT, Y PARAMETER, Y FORMAT, /DIV

C ONTROL P ANELS 9

RI8572: WAVEFORM GENERATOR & MEASURE

Update the graph with measured values in real-time.

COUNTER CONTROL
Edge Period, COUNTER FREQ, COUNTER
Click to update measurement in real-time.

Oscilloscope Scope panel displays oscilloscope measurements
graphically.

© Roos Instruments Inc.
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TOPICS

Instruments Provided by this TIM
Edit Panel Button Descriptions
Temperature Control Buttons
Control Panel

Tap the links above to quickly access content

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instruments in this TIM appear as DataSim and System and the
Infrastructure provides a Tester instrument in the panel dialog
windows.
Model and Name as it appears in the Tester Configuration:
• System, System Resources 2
Infrastructure includes one of the following:
• Tester, Ri8568x Cassini 16 Slot Tester, Master
• Tester, Ri8549x Cassini 8 Slot Tester, Master
NOTE: The “x” in the model number denotes the revision of the Instrument. In this
case, the Infrastructure provides the hardware the Tester instrument displays.

Optional Instruments may include:
• TempControl, Temptronics TP04310A Temperature Controller (or
compatible)

© Roos Instruments Inc.
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EDIT PANELS

Graphical Programming | RI8574: System Controller (EPC)
NOTE: TempControl is an optional feature that requires a RIFL pod for instrument
control.

Automated control of the system level instrument in this TIM with use
by the Test Plan Editor.

E DIT P ANELS 14 RI8574: SYSTEM CONTROLLER

System data saves panel enables datalog and local variable control
in a test plan.

© Roos Instruments Inc.
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PANEL: DATA SAVES
Save Unspecified
A noName

Save Unspecified

Applying Measurement Limits to Data Save Values
Measurement limits can be applied to this data save type by rightclicking within the gray area of the block and selecting ‘Single-valued
Limit’ or ‘Multi-valued Limit’ if more than one measurement value is
saved.
NOTE: If a single numerical value is saved, the measurement limit will default to a
single-value limit. If multiple numerical values are saved, the measurement limit will
allow a multi-value limit option.

An input block used to save single datapoint or multiple numerical
data values from a test panel to the data log worksheet. This save
type enables measurement data to be offloaded as CSV, STDF, RITdB
or other standard data log format. The name of the data save is
defined by the user by right-clicking within the gray area of the block
and selecting ‘Data Name’ from the pop-up menu list.
Data Type Information
The data type of the stored value or values is inherited from the
connected measurement/calculation block. Accordingly, the data unit
choices are limited to the data type of the connected measurement/
calculation blocks. The unit options can be accessed by a right-click
and selection of ‘Data Format’ from the pop-up menu list.
Viewing Data Save Values in a Plot
Data saved to this block can be viewed in a data plot after the test
plan has been compiled and executed by left-clicking within the gray
area of the block and selecting the plot type from the pop-up window
list.

© Roos Instruments Inc.

Array
A

arrayX

Array
An input block that can store a single datapoint or multiple numerical
data values as a local variable with the associated instrument setting
values used in the panel or test section defaults to index the stored
values as a multi-dimensional array. The storage structure of an Array
block allows measurement data to be sorted and/or plotted relative to
an instrument state or multiple states (typically frequency or power
sweeps) in which the data was saved in a test panel by using the
same instrument setting blocks in the test panel. This allows cross
referencing measured values against multiple instrument state indices
such as signal power, frequency, voltage settings, etc. when
displaying in a plot or when accessed using an Array, Array Src, or
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Array Element output block in subsequent test panels or sections.
The name of the array can be defined by the user by right-clicking
within the gray area of the block and selecting ‘Var Name’ from the
pop-up menu list.
Data Type Information
The data type of the stored value or values is inherited from the
connected measurement/calculation blocks. There are no
measurement units associated with an Array.
Viewing Array Values in a Plot
Data saved to this block can be viewed in a data plot after the test
plan has been compiled and executed by left-clicking within the gray
area of the block and selecting the plot type from the pop-up window
list.
If multi-dimensional data is saved to an array, i.e - measurement data
with more than one independent variable(multiple instrument settings)
associated with a measured datapoint, the multi-variable plot window
will open when left-clicking within the gray area of the block. This
window allows the user to define the which instrument index will
define the independent variable on the x-axis, and color code the
plots based on a second instrument setting independent variable.

© Roos Instruments Inc.

Local Var
A

X

Local Var
An input block used to save single datapoint or multiple numerical
data values from the the test plan to a local variable. The name of the
local variable can be defined by the user by right-clicking within the
gray area of the block and selecting ‘Var Name’ from the pop-up
menu list.
Data Type Information
The data type of the stored value or values is inherited from the
upstream connected measurement/calculation block. There are no
measurement units associated with Local Var data.
Viewing Local Var Values in a Plot
Data saved to this block can be viewed in a data plot after the test
plan has been compiled and executed by left-clicking within the gray
area of the block and selecting the plot type from the pop-up window
list.
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Local Var Put
A

Sorted by data

X

A

X

Local Var Put

Sorted by data

An input block used to save a single numerical measurement value
from a test panel to a local variable. If multiple data values are input to
the Local Var Put input block, i.e - measurements from a sweep of
power or frequency for instance, every subsequent data point
overwrites the previous value. The name of the local variable can be
defined by the user by right-clicking within the gray area of the block
and selecting ‘Var Name’ from the pop-up menu list. The value stored
in this block can be called using a Local Var output block in separate
test panel or test section.

An input block that stores a single datapoint or multiple numerical
data values to a local variable that can be sorted in ascending order
by a parameter of the data such as power or phase. This block is
typically used to index data according to ascending measurement
value when calling the local variable with a Local Var output block or
when viewing data in a plot. The name of the Sorted by data local
variable can be defined by the user by right-clicking within the gray
area of the block and selecting ‘Var Name’ from the pop-up menu list.

Data Type Information
The data type of the stored value is inherited from the connected
measurement/calculation block. There are no measurement units
associated with Local Var data.

© Roos Instruments Inc.

Sort by Data
The data organization can be defined by the user by right-clicking
within the gray area of the block and selecting ‘Index by...’ from the
pop-up menu list. A list of available sort types are displayed in the
pop-up window based on the data type of the variable.
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Data Type Information
The data type of the stored value or values is inherited from the
connected measurement/calculation blocks. There are no
measurement units associated with Sorted by data variables.
Viewing Values in a Plot
Data saved to this block can be viewed in a data plot after the test
plan has been compiled and executed by left-clicking within the gray
area of the block and selecting the plot type from the pop-up window
list.

Indexing Data Values
To index measurement data by an instrument setting the input block
owner must be changed from the default setting of ‘System’ to the
desired instrument. To change the owner, right click anywhere within
the white space area contained by the ‘System’ box that surrounds
the gray block and select ‘Change Owner’ from the pop-up menu list.
A list of available instruments in the current tester configuration will
pop-up allowing the user to select the desired instrument. Once the
desired instrument owner has has been designated, the list of
available instrument settings associated with that instrument can be
accessed by right clicking within the gray area of the block and
selecting ‘State Name’ from the pop-up menu list.

Idx by nil
A

X

Idx by nil
The “Index by” input block stores a single datapoint or multiple
numerical data values in a local variable with each data point sorted
relative to an instrument state in which the data was saved in a test
panel. This controls the order in which the measured values are stored
relative to an instrument state setting such as signal power, frequency,
etc. when displaying in a plot or when accessed using an Local Var
output block in subsequent test panels or sections. The name of the
array can be defined by the user by right-clicking within the gray area
of the block and selecting ‘Var Name’ from the pop-up menu list.

© Roos Instruments Inc.

NOTE: In practical applications, the “Index by” block owner is typically set to an
instrument that is being swept across a range of values such as voltage, current, power,
or frequency in a test panel or test section. The “Index by” parameter is set to the
instrument setting that is being swept in a test panel or test section.

Data Type Information
The data type of the stored value or values is inherited from the
connected measurement/calculation blocks. There are no
measurement units associated with “Indexed by” local variables.
Viewing Values in a Plot
Data saved to this block can be viewed in a data plot after the test
plan has been compiled and executed by left-clicking within the gray
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area of the block and selecting the plot type from the pop-up window
list.

Cal Data
A

Cal Data
A specialized input block that stores a single datapoint or multiple
numerical data values (indexed by frequency or power) to a calibration
table for an instrument or fixture signal path. The data format saved
by the block is translated by the tester as signal path loss
compensation, phase reference, or mismatch correction. If calibration
data for the specified path or instrument exists, it is overwritten by the
measured data when the block is used in a test plan.
This button is typically used in conjunction with the Cal Reset button.
WARNING: Altering or otherwise amending instrument calibration
data can cause unwanted and/or erratic behavior that may result in
instrument or device damage and will void the performance
specifications of the Cassini test system.
Data Type Information
The data type of the stored value or values is inherited from the
connected measurement/calculation blocks. The Cal Data block
requires specific instrument owner and data parameters that allows
© Roos Instruments Inc.

the software to automatically apply the measured data as a calibration
correction or “error adapter” as it is often called.
Calibration Naming Conventions
To associate the calibration data to a fixture path, the block owner
must be changed from the default setting of ‘System’ to ‘Fixture’.
Right click anywhere within the white space area contained by the
‘System’ box that surrounds the gray block and select ‘Change
Owner’ from the pop-up menu list.
NOTE: A fixture must be physically connected and checked into the tester or a fixture
definition must be activated in the Configuration Window to access the ‘Fixture’ owner.

The name of the Cal Data block can be defined by the user by rightclicking within the gray area of the block and selecting ‘Cal Name...’
from the pop-up menu list. In order for the calibration data to be
applied, the ‘Cal Name’ of the block must match the path name
specified in the Device Connection editor for the associated fixture/
fixture definition.
CAUTION: Some restricted Cal Data names and instrument owner pairs are reserved
for instrument calibration parameters. Contact support@roos.com before creating and
executing test plans that may alter or overwrite instrument calibration data.

Viewing Values in a Plot
Data saved to this block can be viewed in a data plot after the test
plan has been compiled and executed by left-clicking within the gray
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area of the block and selecting the plot type from the pop-up window
list.

type when the data was captured in a Local Var or Local Var Put
Input block.

Saving & Applying Calibration Data
After a test plan using a Cal Data block is complete, the calibration
data will be temporarily active in the associated fixture path while the
fixture remains connected or the fixture definition remains active in the
Configuration Window. The calibration data can be saved
permanently to the fixture by

The local variable can be selected by right-clicking anywhere within
the gray area of the block and selecting ‘Var Name’ from the pop-up
menu list. A window list of available local variables will be displayed
from which a single variable can be selected.

Cal Data blocks used in a calibration or fixture calibration test plan
typically include measurement limits or validation test plans to verify
the quality/efficacy of the resulting calibration data. These test plan
types when executed by a Calibration Executive or Fixture Executive
program automatically save the associated path/instrument calibration
data from the Cal Data block permanently upon completion of a test
plan pass.
Local Var

X

Instr State Source

Delay

A

Instr State Source
A

Local Var

An output block that calls previously saved local variable data(single
or multiple values) generated by a Local Var or Local Var Put input
block. The data type of recalled values are set by the inherited data
© Roos Instruments Inc.

NOTE: The local variable data is not valid in the test panel in which the data was saved
to a Local Var or Local Var Put input block. A call to a local variable must occur in a
test section or test panel that occurs after the local variable save.

An output block that provides instrument settings as a numerical
value or multiple values from the current test panel. For example, if a
test panel swept the Source1 frequency from 1GHz to 10GHz in
100MHz steps, the 101 frequency setting points of Source1 could be
accessed by placing the Instr State Source button in the panel,
setting ‘Source1’ as the owner, and ‘Frequency’ as the instrument
state source parameter.
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To access an instrument’s available settings the owner must be
changed from the default setting of ‘System’ to the desired
instrument. To change the button owner, right click anywhere within
the white space area contained by the ‘System’ box that surrounds
the gray block and select ‘Change Owner’ from the pop-up menu list.
A list of available instruments in the current tester configuration will
pop-up allowing the user to select the desired instrument. Once the
desired instrument owner has has been designated, the list of
available instrument settings associated with that instrument can be
accessed by right clicking within the gray area of the block and
selecting ‘State Name’ from the pop-up menu list.

Name’ from the pop-up menu list. A window list of available local
variables will be displayed from which a single variable can be
selected.
The local variable data inherits the data type of upstream
measurement connected to the Local Var input block.
NOTE: The array variable data is not valid in the test panel in which the data was
saved to an Array input block. A call to a Array Src variable must occur in a test section
or test panel that occurs after the Array variable save.

NOTE: The instrument state source button incurs no test or measurement time impact
because there is no measurement associated with the instrument setting values. The
instrument values are available to the Instr State Source block at compile time.

Array Element

X

Array Element

Array Src

X

A

Array Src
An output block that emits all stored data of the selected array
variable as a RIData datatype without the need for indexing the array
with instrument buttons. The array variable can be selected by rightclicking anywhere within the gray area of the block and selecting ‘Var
© Roos Instruments Inc.

A

An output block that provides a single datapoint from the selected
array variable. The datapoint is extracted by placing an instrument
button state of the desired datapoint in the panel with the Array
Element block to index and extract the value.
NOTE: The instrument button type and value used to extract the datapoint must match
an instrument button type and value used when creating the array.
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Data Type Information
The data type of the stored value or values is inherited from the
connected measurement/calculation blocks of the Array input block.
There are no measurement units associated with Array local variables.
NOTE: The array variable data is not valid in the test panel in which the data was
saved to a Array input block. A call to an Array Element value must occur in a test
section or test panel that occurs after the Array variable save.

Array

X

A

An array local variable can be selected by right-clicking within the gray
area of the block and selecting ‘Var Name’ from the pop-up menu list.
A window list of available local variables will be displayed from which a
single variable can be selected.
Data Type Information
The data type of the stored value or values is inherited from the
connected measurement/calculation blocks of the Array input block.
There are no measurement units associated with Array local variables.
NOTE: The array variable data is not valid in the test panel in which the data was
saved to a Array input block. A call to an Array variable must occur in a test section or
test panel that occurs after the Array variable save.

Array
Cal Data

An output block that provides data values from an array variable by
using the same instrument panel button/s values used with the
associated Array input block to index the stored values.
If a group of test panels with arrays have common instrument button
sweeps/ranges then the array variables will align the stored values
based on that range index. If there is no shared ranges then the entire
variable is emitted as a vector.
NOTE: The instrument button sweep or range used to create the array input block
variable must be used to extract the values from the array output block. The button type,
values, and range dimension must match the indices used when the array was captured.
© Roos Instruments Inc.

A

Cal Data
An output block that recalls the measured data stored in the user
specified Cal Data input block. This button is typically used in
conjunction with the Cal Reset button.
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NOTE: The calibration data from a Cal Data output block is not valid in the test panel
in which the data was saved to a Cal Data input block. A call to the calibration data
must occur in a test section or test panel that occurs after the calibration data save.

Cal Point

X
Data Type Information
The data type of the stored value or values is inherited from the
connected measurement/calculation blocks of the Cal Data input
block. To recall the calibration data from a previous Cal Data input
block, the block owner must be changed from the default setting of
‘System’ to match the owner of the Cal Data save. To change the
owner, right click anywhere within the white space area contained by
the ‘System’ box that surrounds the gray block and select ‘Change
Owner’ from the pop-up menu list. Once the owner has been
changed, the calibration data can be recalled by changing the name
of the Cal Data output block to match the associated Cal Data input
block by right-clicking within the gray area of the block and selecting
‘Cal Name...’ from the pop-up menu list.
NOTE: To access fixture calibration data, the fixture must be physically connected and
checked into the tester or a fixture definition must be activated in the Configuration
Window to access the ‘Fixture’ owner.

© Roos Instruments Inc.

A

Cal Point
An output block that returns a single point cal factor from a specified
Cal Data input block based on an index determined by an associated
instrument’s state button (typically a frequency or power setting)
placed in the test panel or test section.This button is typically used in
conjunction with the Cal Reset button.
NOTE: The calibration data from a Cal Data output block is not valid in the test panel
in which the data was saved to a Cal Data input block. A call to the calibration data
must occur in a test section or test panel that occurs after the calibration data save.

Data Type Information
The data type of the stored value or values is inherited from the
connected measurement/calculation blocks of the Cal Data input
block. To recall the calibration data from a previous Cal Data input
block, the block owner must be changed from the default setting of
‘System’ to match the owner of the Cal Data save. To change the
owner, right click anywhere within the white space area contained by
the ‘System’ box that surrounds the gray block and select ‘Change
Owner’ from the pop-up menu list. Once the owner has been
changed, the calibration data can be recalled by changing the name
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of the Cal Data output block to match the associated Cal Data input
block by right-clicking within the gray area of the block and selecting
‘Cal Name...’ from the pop-up menu list.
NOTE: To access fixture calibration data, the fixture must be physically connected and
checked into the tester or a fixture definition must be activated in the Configuration
Window to access the ‘Fixture’ owner.

Cal Reset

select ‘Change Owner’ from the pop-up menu list. Once the owner
has been changed, the calibration data to be reset can be selected by
changing the name of the Cal Reset button to match the intended
fixture path or instrument resource name by right-clicking within the
Cal Reset parameter box of the button and selecting ‘Cal Name...’
from the pop-up menu list.
NOTE: To reset fixture calibration data, the fixture must be physically connected and
checked into the tester or a fixture definition must be activated in the Configuration
Window to access the ‘Fixture’ owner.

x

Cal Reset
A list selection button that that resets the calibration data of the userspecified entry to its default value when the test plan is compiled. This
button is typically used in conjunction with the Cal Data input and
output blocks.
WARNING: Overwriting or altering instrument calibration data
can cause unwanted instrument behavior that may result in
instrument or device damage and will void the performance
specifications of the Cassini test system.
To reset calibration data, the Cal Reset button owner must be
changed from the default setting of ‘System’ to match the owner of
the intended path(typically ‘Fixture’) or instrument. To change the
owner, right click anywhere within the white space area contained by
the ‘System’ box that surrounds the Cal Reset parameter box and
© Roos Instruments Inc.
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PANEL: FLOW CONTROL
Set Flag
A

NOTE: If a single numerical value is saved, the measurement limit will default to a
single-value limit. If multiple numerical values are saved, the measurement limit will
allow a multi-value limit option.

name

skipIfTrue

Set Flag
An input block that creates a conditional flag based on a single
datapoint or multiple data points provided to the block. When placed
in a test panel and executed, this block sets the true/false logic
conditions of the flag for the skipIfTrue, abortIfTrue, skipIfFalse,
and/or abortIfFalse buttons that execute conditional test program
actions. If multiple data points and limits are applied to a Set Flag
input block the results are logically OR'ed, i.e - all limit conditions
must be true for the flag to be true.
The name of the flag is defined by the user by right-clicking within the
gray area of the block and selecting ‘Flag Name’ from the pop-up
menu list.

name

skipIfTrue
A drop down list button placed in the Conditional Statement panel of
a test section that skips all test panels within the section if the
selected flag specified by a Set Flag input block is true. The flag
pointer is set by right clicking within the name field of the button and
selecting ‘Flag Name’ from the pop-up menu. A pop-up window then
provides the list of available conditional flags based on the Set Flag
input blocks used.
NOTE: The skipIfTrue button must be placed in the Conditional Statement panel of a
Test Section. If multiple skipIfTrue buttons are placed in the same Conditional
Statement panel, any true flag can cause a skip.

Conditional data limits are applied to the flag by right-clicking within
the gray area of the block and selecting ‘Flag Limits’ or ‘Limit File’ if
more than one measurement value is saved. Flag limits are displayed
on the Set Flag block above the name for reference.

© Roos Instruments Inc.
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abortIfTrue

name

abortIfTrue
A drop down list button placed in the Conditional Statement panel of
a test section that aborts the test program if the selected flag
specified by a Set Flag input block is true. The flag pointer of the
abortIfTrue button is set by right clicking within the name field of the
button and selecting ‘Flag Name’ from the pop-up menu. A pop-up
window then provides the list of available conditional flags based on
the Set Flag input blocks used.
NOTE: The abortIfTrue button must be placed in the Conditional Statement panel of a
Test Section. If multiple abortIfTrue buttons are placed in the same Conditional
Statement panel, any true flag can cause the test program to abort.

skipIfFalse

name

skipIfFalse
A drop down list button placed in the Conditional Statement panel of
a test section that skips all test panels within the section if the
selected flag specified by a Set Flag input block is false. The flag
pointer of the skipIfFalse button is set by right clicking within the
name field of the button and selecting ‘Flag Name’ from the pop-up

© Roos Instruments Inc.

menu. A pop-up window then provides the list of available conditional
flags based on the Set Flag input blocks used.
NOTE: The skipIfFalse button must be placed in the Conditional Statement panel of a
Test Section. If multiple skipIfFalse buttons are placed in the same Conditional
Statement panel, any false flag can cause a skip.

abortIfFalse

name

abortIfFalse
A drop down list button placed in the Conditional Statement panel of
a test section that aborts the test program if the selected flag
specified by a Set Flag input block is false. The flag pointer of the
abortIfFalse button is set by right clicking within the name field of the
button and selecting ‘Flag Name’ from the pop-up menu. A pop-up
window then provides the list of available conditional flags based on
the Set Flag input blocks used.
NOTE: The abortIfFalse button must be placed in the Conditional Statement panel of a
Test Section. If multiple abortIfFalse buttons are placed in the same Conditional
Statement panel, any true flag can cause the test program to abort.
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promptIfFalse

Prompt

name

Click OK to Continue

promptIfFalse

Prompt

A drop down list button placed in the Conditional Statement panel of
a test section that pauses the test program and opens a user prompt
window if the selected flag specified by a Set Flag input block is
false. The user prompt window provides two options for the operator:
‘Continue’ - proceeds with the test program

A text string input button placed in a Conditional Statement panel of a
test section that pauses the test program at the beginning of a test
section and opens a user prompt window and displays the text string
input by the user to the button. The prompt window displays the text
string and provides two options for the operator: “Continue” proceeds with the test program; “Abort” - terminates the test program
immediately.

‘Abort’ - terminates the test program immediately.
The flag pointer of the promptIfFalse button is set by right clicking
within the name field of the button and selecting ‘Flag Name’ from the
pop-up menu. A pop-up window then provides the list of available
conditional flags based on the Set Flag input blocks used.

NOTE: The Prompt button must be placed in the Conditional Statement panel of a Test
Section.

NOTE: The promptIfFalse button must be placed in the Conditional Statement panel of
a Test Section.

© Roos Instruments Inc.
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PANEL: STATE

Pause

0
Sequence Delay

0

Sequence Delay
An integer value input button used only in Pre Measure and Post
Measure groups that forces a test pause and hold of all instrument
settings in the sequence. The Sequence Delay button input value is
in units of microseconds with 100ns resolution.
NOTE: The Sequence Delay button is only valid in Pre Measure and Post Measure
groups. Within a Pre/Post Measure group, buttons are executed in a sequenced order
from left to right as they are placed in the panel.

Pause
An integer value input button that forces a test pause and hold of all
instrument settings in a test panel before a measurement is executed.
If a Pause button is placed in a test section or test panel, the pause
and hold is executed after all instrument button settings are set and
before any measurements are taken. If a Pause button is placed
within a Measure group, the pause and hold is executed after all
instrument button settings within the Measure group are set and
before the measurement within the Measure group is taken. If a
Pause button is placed in Global/Section default, the value is ignored.
The Pause button input value is in units of microseconds with 100ns
resolution.
Repeat

0

Averages

1

Averages
An integer value input button that sets the number of measurements
taken and used to compute a mean or average value. When placed in
a test panel or test section, the Averages button applies to all
measurements present in the same test panel or test section
accordingly. A value of 1 will take only one measurement.

© Roos Instruments Inc.

Repeat
An integer value input button that when placed in a test panel, sets
the number of times to repeat the measurements in that panel. When
the repeat value is greater than one, single data point saves or local
variable are represented as multi-point measurements with the repeat
number defining the index and the independent axis in plots. It is
typically used as a test program debug tool for determining
measurement stability.
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Index

0

Index
An integer value input button that is used as the numeric sorting
parameter for data measured using a lock step group. The index
button is placed within a lock step group, typically with a
measurement block and an instrument parameter such as frequency,
power, voltage, etc. When an instrument parameter is swept across a
range of values, the Index button must also be configured as a range
with the same number of values as the instrument sweep parameter.
This allows the measured data to be stored in ascending numeric
order of the index button values while still conducting the
measurement according to ascending instrument parameter values.
NOTE: When used with an instrument sweep/range, the index button only defines the
storage indexing of the sweep, not the execution order of the instrument sweep.

Trigger Spacing

0

Trigger Spacing
A decimal notation input button that sets a delay between the trigger
reference(represented by a Trigger Ref button placed to the left of
the Trigger Spacing button) and a measurement block. The Trigger
Spacing button does not incur any additional execution time during a
© Roos Instruments Inc.

pre measure sequence and is therefore used to provide precise timing
of DC or RF pulse widths. The input value is in units of seconds with a
resolution of 100ns.
This button is used with time-based measurements such as Voltage
vs Time, Current vs. Time and/or Delayed Voltage measurement
blocks.
NOTE: Only valid in a pre/post measure or measure sequence.
The input value to the Trigger Spacing button must be positive.

Outer Loop

1

Outer Loop
An integer value button that assigns a state change cost value for all
instrument state changes contained in a single test panel in which it is
placed. The Outer Loop button is a compiler directive that
incorporates the input value as an additional cost value associated
with changing to the instrument settings of a test panel or the
instrument state changes contained within a Lock Step group in
which it is also placed. A higher input value denotes an additional cost
value that raises the overall cost value compared to another Outer
Loop button with a smaller value. The cost value is used by the
compiler to prioritize the execution of multiple test panels within a test
section in order of the lowest cost values to the highest cost values.
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By default the Outer Loop button has a higher cost value than the
Inner Loop button. Outer Loop buttons can be used in conjunction
with Inner Loop buttons within a Lock Step group to control the
execution order of two or more instrument button parameter sweeps/
ranges within one test panel. State changes associated with Inner
Loop buttons with ascending input values are executed before Outer
Loop buttons with ascending values. The combination of the two
buttons enable nested instrument range sweeps across multiple
instrument parameters with a user-specified execution order.
NOTE: When used within a lock step group with an instrument range sweep, the Outer
Loop index size must match the sweep index size, i.e. the number of Outer Loop buttons
must match the number of points in the sweep.

Inner Loop

Loop button with a smaller value. The cost value is used by the
compiler to prioritize the execution of multiple test panels within a test
section in order of the lowest cost values to the highest cost values.
By default the Inner Loop button has a lower cost value than the
Outer Loop button. Inner Loop buttons can be used in conjunction
with Outer Loop buttons within a Lock Step group to control the
execution order of two or more instrument button parameter sweeps/
ranges within one test panel. State changes associated with Inner
Loop buttons with ascending input values are executed before Outer
Loop buttons with ascending values. The combination of the two
buttons enable nested instrument range sweeps across multiple
instrument parameters with a user-specified execution order.
NOTE: When used within a lock step group with an instrument range sweep, the Inner
Loop index size must match the sweep index size, i.e. the number of Inner Loop buttons
must match the number of points in the sweep.

1

Inner Loop
Meas Ref

An integer value button that assigns a state change cost value for all
instrument state changes contained in a single test panel in which it is
placed. The Inner Loop button is a compiler directive that
incorporates the input value as an additional cost value associated
with changing to the instrument settings of a test panel or the
instrument state changes contained within a Lock Step group in
which it is also placed. A higher input value denotes an additional cost
value that raises the overall cost value compared to another Inner
© Roos Instruments Inc.

0

Meas Ref
A decimal notation input button in units of seconds that marks the
preceding instrument state button in a pre measure as the start event
reference of the measurement block in the panel, offset by the value
entered. The input value is in units of seconds with 1 microsecond
resolution. A positive input value offsets the measurement time
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reference later in time from the start event reference by the input
value. A negative input value moves the measurement time reference
earlier than the start event reference by the input value. The
measurement reference defines the zero index or left-most edge of
data plots.
This button is used with time-based measurements such as Voltage
vs Time, Current vs. Time and/or Delayed Voltage measurement
blocks.

Delay Settling

0.01

Delay Settling

A decimal notation input button that sets the settling time(in units of
seconds) for the state of an entire test panel. This button is a compiler
directive that adds a user-defined delay after all of the instrument and
device state changes have been executed.

Delay Cost
Trigger Ref

0.01

Delay Cost
A decimal notation input button that sets a user-defined, time cost
value(in units of seconds) for the compiler’s test optimization function.
This button is a compiler directive that incorporates the input as the
expected time delay incurred when executing state changes typically
related to the device under test. When placed in a test panel, the time
cost information is added to the known instrument state change
timing information. This is used by the compiler to prioritize test order
and test execution of all test panels within the test section in order to
achieve optimum test speed. A larger Delay Cost input value
denotes a longer state change time and higher time cost associated
with all of the state changes in the panel. The optimizer will seek to
minimize changes to all of the states found within a panel with a large
time cost across all of the tests found in the same test section.

© Roos Instruments Inc.

0

Trigger Ref
A decimal notation input button that marks the preceding button in a
pre measure sequence as the time reference event for the Trigger
Spacing button, offset by the value entered. The input value is in
units of seconds with 1 microsecond resolution. A positive input value
offsets the trigger time reference later in time from the start event
reference by the input value. A negative input value moves the trigger
time reference earlier than the start event reference by the input value.
This button is used with time-based measurements such as Voltage
vs Time, Current vs. Time, Triggered Voltage, and Triggered
Digitizer measurement blocks.
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Test Type

standard

Test Type
A drop down list button that when placed in a test panel, defines the
order of priority of the test panel relative to other test panels in the
same test section. The Test Type button is a compiler directive that
informs the optimizer if or when the test panel measurements occur
within a test section:
The ‘standard’ option is the system default setting that allows the
compiler’s test optimizer to decide the order of test panels within the
test sections based on an time cost analysis of state changes.
The ‘first’ option designates that the measurements in the associated
test panel should be executed before all other test panels within the
same test section.
The ‘last’ option designates that the measurements in the associated
test panel should be executed after all other test panels within the
same test section.
The ‘calculation’ option designates that there are no measurements in
the associated test panel, and forces the test optimizer to execute the
panel as a calculation operation. Typically this is used in test panels
where mathematical, algorithmic, data type conversion, and/or data
save operations of local variables and data saves are executed. The
function of the ‘calculation’ option of the Test Type button is identical
to the Calculation Only block.
© Roos Instruments Inc.

NOTE: Instrument sweeps used as indices for extracting data values from variable
arrays or data saves within designated calculation panels do not act on the
instrumentation, i.e - instrument sweeps for indexing purposes do not incur any test time
impact.

Do If True

none

Do If True
A drop down list button that compiles and executes a test section,
test panel, or lock step group during test plan run time if the selected
symbol value is non zero (logical true). This button enables additional
tests and/or measurements to be compiled and executed depending
on the logic condition (value) of a user-defined symbol.
To select the symbol to be used for the logic argument, left-click
within the parameter field and select the desired symbol from the
pop-up list.
NOTE: A symbol can be created from the Set Symbol button or from creating/activating
a symbol table from the test plan menu options: ‘Options’>‘Edit Symbol’.

To execute a test section upon a true symbol condition with multiple
test panels, place the Do If True button in the Conditional Statement
of a test section.
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To execute a single test panel upon a true symbol condition the Do If
True button can be placed anywhere within the desired test panel.
To execute an additional lock step upon a true symbol condition with
multiple test panels, place the Do If True button within the Lock Step
group of buttons and measurement.

Self Cal

Precompile

Self Cal
The Self Cal button is hard coded to the Precompile condition as the
test system’s default and only setting. Before a compile is executed,
the test system performs a self calibration of instruments that contain
thermally sensitive components. This self calibration measures and
corrects any thermal drift offsets prior to test execution.

PANEL: INPUT OUTPUT STATE
Freq Reference

none

Freq Reference
A drop down list button that selects an Instrument as the frequency
index of measurements when using virtual instruments such as the
Vector Network Analyzer or Noise Figure Meter. By default, all
measured data is referenced/indexed by the instrument frequency
designated as the input with the Input button of the virtual instrument.
This button allows the user to select another instrument as the
frequency index reference. This button is typically used with the Input
Freq Oﬀset, Input Freq Scale, Output Freq Oﬀset, and Output
Freq Scale buttons.
NOTE: Only instruments active in the test system are available in the Freq Reference
drop down list.

Input Freq Offset

0

Input Freq Offset
A decimal notation input button that defines a constant shift or offset
of the index frequency that is designated by either the Freq
© Roos Instruments Inc.
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Reference or virtual instrument Input button. The frequency units are
defined by the instrument frequency parameter specified by the Freq
Reference button. The input index frequency value is defined by the
equation below:
IndexFrequency = FreqReference[ frequency] * InputFreqScale + InputFreqOf fset

to define a frequency index for measurements of a device under test
that performs frequency translation such as an RF mixer or divider/
multiplier. The Output index frequency value is defined by the equation
below:
IndexFrequency = FreqReference[ frequency] * OutputFreqScale + OutputFreqOf fset

Input Freq Scale
Out Freq Scale

1

1

Input Freq Scale
A decimal notation input button that defines a multiplier value applied
to the index frequency that is designated by either the Freq
Reference or virtual instrument Input button. The input index
frequency value is defined by the equation below:
IndexFrequency = FreqReference[ frequency] * InputFreqScale + InputFreqOf fset

Out Freq Offset

0

Out Freq Offset

Out Freq Scale
A decimal notation input button that defines a multiplier value applied
to the index frequency that is designated by either the Freq
Reference or virtual instrument Output button. The frequency units
are defined by the instrument frequency parameter specified by the
Freq Reference button. This button is typically used in applications
to define a frequency index for measurements of a device under test
that performs frequency translation such as an RF mixer or divider/
multiplier. The Output index frequency value is defined by the equation
below:
IndexFrequency = FreqReference[ frequency] * OutputFreqScale + OutputFreqOf fset

A decimal notation input button that defines a constant shift or offset
of the index frequency that is designated by either the Freq
Reference or virtual instrument Output button. The frequency units
are defined by the instrument frequency parameter specified by the
Freq Reference button. This button is typically used in applications
© Roos Instruments Inc.
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PANEL: GENERAL CALCULATIONS

Constant
0

MEAS
Calculation Only

A

Meas: Calculation Only
This block is a compiler directive that designates the panel as a
calculation only panel, i.e - there are no measurements in the
associated test panel. This block forces the test optimizer to execute
the panel as a calculation operation, using instrument button settings
or sweeps as index parameters only. Typically this block is used in test
panels where mathematical, algorithmic, data type conversion, and/or
data save operations of local variables and data saves are executed.
The function of the Calculation Only block is identical to the Test
Type button with the ‘calculation’ option selected.

A

Constant
A calculation block that outputs a user-defined, fixed numerical value.
It is typically used as an input to arithmetic functions and/or logic
arguments. The value of a constant is defined by right-clicking within
the gray area of the block and selecting ‘Default...’ from the pop-up
menu list.
Data Type Information
The data type of the constant value can be defined by right-clicking
within the gray area of the block and selecting ‘DataType...’ from the
pop-up menu list. The unit scaling options can be defined by rightclicking within the gray area of the block and selecting ‘Units Scale’
from the pop-up menu list.

NOTE: Instrument sweeps used as an index for extracting data values from variable
arrays or data saves within designated Calculation Only test panels do not act on the
instrumentation, i.e - instrument sweeps for indexing purposes do not incur any test time
impact.

Convert
A RiRealD A

Convert
A one-input calculation block that converts the data type of
measurements or calculation data that is supplied to the input of the
© Roos Instruments Inc.
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block (red A on left side). The converted data is supplied to
subsequent measurement, local variable, or data save blocks by
connecting the output of the block (black A on left side).

NOTE: The data type of the values supplied to the input of the Calc block is displayed at
the top of the calculation window.

To set the conversion data type, connect the input of the Convert
block to a measurement, local variable output block, or calculation
block. Right-click within the gray area of the block and select
‘DataType...’ from the pop-up menu list.

Calc
A

calc
Calc (Two Input)

Calc
A

calc

A

Calc
The one input calculation block performs arithmetic operations on
data provided by a single measurement or data output block. The
calculation options are defined by the measurement block that is
connected to the input of the block (red A on left side). The output
data from the Calc block can be connected to multiple downstream
operations or data/variable saves.
To select a calculation option for a given data type, connect the
measurement data or variable output block to the Calc input. Once
connected, right-click on the Calc block and select ‘Calculation’ from
the menu. The calculation operations available for the given data type
are provided in the calculation window list.
© Roos Instruments Inc.

A

B

The two-input calculation block performs arithmetic operations on
data provided by two measurement or data output blocks. The
calculation options are defined by the measurement or data output
block connected to the ‘A’ input of the block (red A on left side). The
output data from the Calc block can be connected to multiple
downstream operations or data/variable saves.
To select a calculation option for a given data type, connect the
measurement or data output blocks to the Calc buttons inputs. Once
connected, right-click on the Calc block and select ‘Calculation’ from
the menu. The calculation operations available for the given data type
are provided in the calculation window list.
NOTE: The datatype and by extension the calculation options of the two-input calc
block are defined by the data source connected to the ‘A’ input.
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Calc
A
B

calc

A

C

Calc (Three Input)

The three-input calculation block performs arithmetic operations on
data provided by three measurement or data output blocks. The
calculation options are defined by the measurement or data output
block connected to the ‘B’ input of the block (red B on left side). The
output data from the Calc block can be connected to multiple
downstream operations or data/variable saves.
To select a calculation option for a given data type, connect the
measurement or data output blocks to the Calc buttons inputs. Once
connected, right-click on the Calc block and select ‘Calculation’ from
the menu. The calculation operations available for the given data type
are provided in the calculation window list.
NOTE: The datatype and by extension the calculation options of the three-input calc
block are defined by the data source connected to the ‘B’ input.

Calc
A
B A shift B and C A
A Shift B and C
© Roos Instruments Inc.

A specialized three-input calculation block that performs a binary shift
operation followed by a logical AND operation. It is used to extract
individual or groups of bits from a larger bit string. Data bits from a
Serial Read measurement block connected to the ‘B’ input are
shifted by the number of bits specified by the ‘A’ input (typically a
Constant output block) and then logically AND’d with a bit mask
connected to the ‘C’ input (typically a Constant output block) to
truncate the bit string. The ‘A’ and ‘C’ inputs are expressed in decimal
form.
To create the A Shift B and C calculation block:
1. Place a three-input calculation block in a test panel.
2. Right click within the gray area of the block and select Edit
Block... from the menu options.
3. In the Block Edit window enter the following code:
[ :a | (RiRealD fromFloat: ((((a at:1)
asInteger) bitShift: (((a at:2) asFloat)
rounded negated)) bitAnd:(((a at:3) asFloat))
rounded asInteger))]
4. From the Block Edit menu option select Save > Save
5. In the Enter Button Text window, the user can input a block name,
i.e. ‘A shift B and C’ and click OK.

C
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6. In the Select Data Type window select ‘RiRealD’ from the list to
output the result as a decimal value and click OK to complete the
calculation block.
NOTE: The calculation block will change to a yellow color to indicate a custom
function.

The data type of the symbol value can be defined by right-clicking on
the button and selecting ‘DataType...’ from the pop-up menu list. The
unit scaling options can be defined by right-clicking within the gray
area of the block and selecting ‘Units Scale’ from the pop-up menu
list.

Var Prompt
Set Symbol X

0.0

X

Var Prompt

Set Symbol
A decimal notation input button that sets the value of a user-specified
symbol. This button can be used to create a symbol and set its value
within the global defaults, section defaults, or a test panel. Multiple
instances of the same Set Symbol button name can be used in a
test plan. A Set Symbol button in a test panel will override the
symbol value in the section defaults, global defaults, and/or symbol
table.
The Set Symbol button defaults to a symbol name of ‘X’. The symbol
name can be changed by right-clicking on the button and selecting
‘Symbol Name...’ from the pop-up menu list. From the name prompt,
a new symbol can be created by entering the name in the empty field.
A previously defined symbol value can be changed from by selecting
‘Cancel’ in the name prompt and selecting from the list of symbols.
Data Type Information
© Roos Instruments Inc.

A decimal notation input button that creates a user prompt with an
input field, and stores the user input value to the specified variable
during test plan execution. This button is used to create a new
variable and set its value within a test panel.
The variable name can be changed by right-clicking on the button
and selecting ‘Var Name...’ from the pop-up menu list.
The text visible in the user prompt can be defined by right-clicking on
the button and selecting ‘Prompt Text...’ from the pop-up menu list.
NOTE: During test plan execution, the operator must select ‘OK’ (press enter) in the
prompt for the test program to continue.

Data Type Information
The data type of the variable can be defined by right-clicking on the
button and selecting ‘DataType...’ from the pop-up menu list.
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TEMPTRONICS TP04310A TEMPERATURE
Vector Range

CONTROLLER
PANEL: TEMPERATURE

A

1 to: 2

A

Vector Range
A calculation block that outputs a subset of a single connected data
output block with indexed data values such as arrays, index by
variables, instrument state sources, and/or calibration data. The index
range can be specified by the user by setting the start and stop
indices of the vector range desired: Right-click within the gray area of
the block and select ‘Start Index’ to select the initial value and select
‘Stop Index’ to select the final value of the index range.

Test Plan Controlled

no

Test Plan Controlled
A drop down list button to set to ‘yes’ if used within the Test Plan.
Use to quickly disable all temperature operations, useful for
debugging.
Temperature

20

Temperature
A decimal notation input button with units in ℃ to set the
Temperature. Use the Soak and Max Error buttons to control the
time needed before testing continues.
Head

up

Head
A drop down list button to raise or lower the ThermoStream head.

© Roos Instruments Inc.
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Flow

Soak

oﬀ

0

Flow

Soak

A drop down list button to set air flow to on or off.

A decimal notation input button to set a wait time in units of seconds
once the temperature set by the Temperature button is reached.

MEAS
Temperature

Max Error

A

1

Max Error

Meas: Temperature
A measurement block that outputs the measured temperature in ℃.

A decimal notation input button to set the temperature error in ℃ at
which Soak time starts.

MEAS
TemperatureSettled

A

Meas: TemperatureSettled
A measurement block that sets the time in seconds to wait until the
temperature is within MaxError, then wait the number of seconds
specified by the Soak button.

© Roos Instruments Inc.
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RI8568X CASSINI 16 SLOT TESTER

setting of ‘off’ or removed from test plans if no fixture is installed
on the test head.

PANEL: STATE
The ‘Tester’ instrument provides power supplies for the fixtures. These
buttons are used to control the power supplies for fixture modules or
supply voltage to additional instrumentation internal to the fixture or
present on the device interface board PCB.

Fixture 28v

oﬀ

Fixture 28v

A drop down list button to control the 28 V supply to the fixture. This
supply provides voltages to drive additional RF switches, relays, etc.
added to the internal of the fixture or device interface board PCB. The
supply provides voltage through the fixture’s RIFL interface to the
fixture carrier board.
The ‘on’ setting provides ±5 volt and ±15 volt supplies to the fixture.
The ‘off’ setting provides sets the supplies to 0 volts.
WARNING: There is a risk of electrical shock if there is no fixture
installed on the test head when the Fixture 28v is set to ‘on’ in a
test plan. The Fixture 28v button should be left in the default
© Roos Instruments Inc.
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Fixture Power

oﬀ

Fixture Power

A drop down list button to control the ±5 V and ±15 V supplies to the
fixture. The fixture supply provides voltage through the fixture’s RIFL
interface to the fixture carrier board to power on fixture modules.
The ‘on’ setting provides ±5 volt and ±15 volt supplies to the fixture.
The ‘off’ setting provides sets the supplies to 0 volts.

E DIT P ANELS 15 RI8574: SYSTEM CONTROLLER

WARNING: There is a risk of electrical shock if there is no fixture
installed on the test head when the Fixture 28v is set to ‘on’ in a
test plan. The Fixture 28v button should be left in the default
setting of ‘off’ or removed from test plans if no fixture is installed
on the test head.

Tester state panel shows fixture power states.

© Roos Instruments Inc.
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CONTROL PANELS
Real-time control of the instruments in this TIM. Most buttons behave
exactly like described in the Edit Panel. Only controls that are not
included in the Edit panel are listed in this section.

C ONTROL P ANELS 10 RI8574: SYSTEM CONTROLLER
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SYSTEM
STATE PANEL
Averages
Many measurements support averaging. Use this button to set the
averaging factor.

TEMPCONTROL
CONTROL PANEL
Temperature
Measure the current temperature in ℃. (Read Only)

System state button provides real-time control over the number of
averages measurements take.

© Roos Instruments Inc.
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RI8575: PHASE NOISE
MEASURE

Graphical Programming | RI8575: Phase Noise Measure

TOPICS

Instruments Provided by this TIM
Instrument Diagram with Edit Buttons
Edit Panel Button Descriptions
Control Panel

Tap the links above to quickly access content

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as PhaseNoiseAnalyzer in the
panel dialog windows.
Model and Name as it appears in the Tester Configuration:
• PhaseNoiseAnalyzer, RI8575x 1 - 16 GHz Phase Noise Analyzer
NOTE: Multiple RI8575 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - PhaseNoiseAnalyzer,
PhaseNoiseAnalyzer2, PhaseNoiseAnalyzer3, etc). The “x” in RI8575x denotes the
model revision number.

© Roos Instruments Inc.
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I NSTRUMENT B UTTON D IAGRAM 2.9
Roos Instruments, Inc - Cassini

Block Diagram, Phase Noise Discriminator TIM
RI8575A
Tap for Zoom View

2012-03-21
Copyright Roos Instruments, Inc.
Subject to change without notice
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EDIT PANELS
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PANEL: STATE

Automated control of the instruments in this TIM with use by the Test
Plan Editor.

Pll Frequency

1000
Pll Frequency

E DIT P ANELS 16 RI8575: PHASE NOISE MEASURE

A floating-point input button with units of MHz that defines the lock
frequency of the DUT. If the frequency range is between 800 MHz to
4000 MHz, set the Input button to the ‘direct’ setting. If the frequency
range is between 2000 MHz to 4000 MHz, set the Input button to the
‘/4’ (divide by 4) setting. The Pll Ref Freq button (internal reference
oscillator frequency) must also be set to correspond with the
expected frequency from the DUT. The ratio of the Pll Frequency
value to the Pll Ref Freq value sets the N Counter. The value of the
Pll Ref Mod button defines the allowable fractional component of the
N Counter and thus the resolution of the lock frequency.
NOTE: The frequency resolution of an input to the Direct port is defined as: Pll Ref
Freq / Pll Ref Mod
The frequency resolution of an input to the ÷4 Port (C5) is defined as: (Pll Ref Freq / Pll
Ref Mod) × 4

PhaseNoiseAnalyzer state panel shows state and measurement
buttons for the instrument in this TIM.

© Roos Instruments Inc.
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Pll Ref Freq

Pll Loop Gain

25

400 u

Pll Ref Freq

Pll Loop Gain

A integer value input button that sets the reference frequency of the
phase detector for the internal reference PLL in units of MHz. This
reference value sets the R Counter parameter in the phase lock
circuitry of the internal reference PLL. The R counter provides 100
MHz signal. This R counter drives a frequency divider for adjusting the
locking value to match the DUT’s using the formula: 100 MHz ÷ R.
The range of R is 4 to 1023. This allows a maximum frequency value
of 25 MHz. When Pll Mode is set to ‘count’, the Pll Frequency and
Pll Ref Freq buttons are used to set the N Counter.

A floating-point input button that sets the phase detector current gain
with units of Amps. The maximum current value is 625uA and the
minimum value is 10uA. The loop gain is primarily a function of the
external loop filter and the DUT VCO’s kV. This button is used with the
Vtune Max button.

NOTE: It is recommended that the Pll Ref Freq button be set to 25 MHz when Pll
Mode is set to ‘count’ mode.

List select button that sets the function of the internal PLL and
measure instruments.

Pll Ref Mod

1000
Pll Ref Mod
An integer data input button with units of MHz that sets the fractional
modulus from 0 to 4095. This button is used with the Pll Frequency
and Pll Ref Freq buttons to define the frequency locking and phase
synchronization of the DUT with the internal reference PLL.

© Roos Instruments Inc.

Pll Mode

oﬀ
Pll Mode

The ‘off’ setting disconnects the RF input paths from the phase
detector and charge pump. This mode is useful when using the
parametric measure capability (DPVP Meas I/V) for leakage current
measurements.
The ‘lock’ setting activates the PLL’s phase detector and connects
the charge pump to the Charge Pump Out (C8) port to phase lock the
input source for measurements using the phase noise discriminator.
The ‘count’ setting activates the frequency counter/measure function
of the PLL. This setting is commonly used with the Measure Mode
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button to capture tuning voltages with the parametric measure (DPVP
Meas I/V) on the Charge Pump Out (C8) port.
The ‘Disc’ setting is the ‘discriminator only’ mode which disconnects
the charge pump from the Charge Pump Out (C8) port and disables
the phase detector to measures phase noise with the phase
discriminator without phase locking the DUT.
Input

direct

Freq Gate

100 u
Freq Gate
Integer value button that sets the frequency counter/measure
instruments capture time in seconds. The frequency counter depth is
16 bits. The frequency resolution in Hz is defined as:
(1 ÷ Freq Gate) × (Pll Frequency ÷ Pll Ref Freq)

Input

The maximum Freq Gate value is:

Drop-down list button that selects either the Direct In 1-4GHz (C1) or
÷ 4 4-20 GHz (C5) RF input ports to the phase detector and PLL
locking loop. The ‘direct’ value routes the Direct In 1-4 GHz Input (C1)
port to the phase lock loop.The ‘/4’ value routes the ÷ 4 4-20 GHz
(C5).

(Pll Frequency ÷ Input Frequency) × (1 ÷ Pll Ref Freq)
NOTE: If the input frequency and Pll Ref Freq button value are set to the recommended
25 MHz, the Maximum Freq Gate value is 2.6 msec.

This button is commonly used with the Pll Mode, Pll Ref Freq, Pll
Frequency, Pll Ref Mod, and Vtune Max buttons.
NOTE: The ‘Direct In’ port supports frequencies from 800 MHz to less than 4 GHz
and the ‘÷ 4’ port supports frequencies from 4 GHz to 20 GHz with -5 dBm to +10
dBm typical performance.

© Roos Instruments Inc.

Vtune Max

5
Vtune Max
Floating-point button that sets the upper limit or maximum value of
the drive voltage for tuning the DUT frequency. This setting provides a
voltage upper limit clamp to prevent the DPVP 0-25V ±2mA supply
from exceeding the DUT’s supply or rail voltage. The maximum
voltage value is 25 volts and minimum is 5 volts.
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This button is commonly used with the Pll Mode button in the ‘lock’
setting with the Input, Pll Ref Freq, Pll Frequency, Pll Ref Mod
buttons.

PANEL: VS TIME MEASUREMENTS
Samples

1
Samples

MEAS
InputFrequency

A

Meas: Input Frequency

Integer value button that sets the number of samples to use in a
phase measurement with the discriminator. The maximum value is
1024. Together with the Sample Rate button, this button defines the
total measurement time for Noise Vs Time and Tune Voltage Vs
Time measurement blocks.

Measurement block that calculates the input frequency in MHz. This
block is only valid with a PLLFrequency button set to the maximum
expected frequency.
The PllMode button can be set to count for unlocked measurements
or lock if the MeasureMode button is not set to ‘none.’

MEAS
Lock

A

Meas: Lock

Sample Rate

1M
Sample Rate
Decimal notation input button that sets the sample rate for phase
measurements with the discriminator in Hertz. The maximum sample
rate is 40 MHz. Together with the Sample Rate button, this button
defines the total measurement time for Noise Vs Time and Tune
Voltage Vs Time measurement blocks.

Measurement block where the result is a floating point value of 1.0 if
the loop is locked (true). This block is only valid in Pll lock mode
when the MeasureMode button is set to ‘none’.
© Roos Instruments Inc.
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PANEL: VCO MEASUREMENTS

MEAS
Disc Vs Time

A

MEAS

Meas: Disc Vs Time

Sideband

Measurement block that calculates the DC output of the discriminator.
Used to get carrier frequency information.

MEAS
Noise Vs Time

A

A

Meas: Sideband
The measurement block assumes a FM tone sideband and gives the
ratio of the sideband power to the carrier power. The measured value
is a one sided calculation of the carrier as seen on a spectrum
analyzer and is B/2.

Meas: Noise Vs Time

MEAS

Measurement block that computes the AC output of the discriminator.
It is used for raw FM measurements.

MEAS
Tune Voltage Vs Time A
Meas: Tune Voltage Vs Time

Phase Noise

A

Meas: Phase Noise
Discriminator power measurement adjusted for offset frequency in
dBc/hz. The result is a one sided calculation similar to the
measurement computed on a spectrum analyzer.

Measure block that computes the tune voltage. The Measure Mode
button must be set ‘Meas V’ to capture voltage values on the Charge
Pump Out (C8) tune line.
© Roos Instruments Inc.
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Freq Offset

PANEL: TUNE MEASURE

0
Freq Oﬀset

Measure Mode

Integer value button that sets the frequency offset in units of Hertz for
the DSP mixer.
Samples

100
Samples
Integer value button that sets the number of samples used in a
measurement. For DSP measurements this is the number of
averages. The maximum value for VCO measurements with the DSP
is 3000 samples.
Cal Set

0
Cal Set
Local variable input button used for RI internal purposes only.

© Roos Instruments Inc.

none
Measure Mode
Drop down list button that select the mode of the Charge Pump Out
(C8) port.
Drop down list button that sets the mode of the precision measure
instrument (DPVP Meas I/V).
The ‘none’ selection disconnects the precision measure resource from
the Charge Pump Out (C8) port.
The ‘Meas I’ selection forces a voltage defined by the Measure V
Force button and measures on the Charge Pump Out (C8) port. The
Measure I Limit button restricts the maximum amount of current
delivered by the supply(DPVP 0-25V, ±2 mA) during the measurement
to avoid damaging the device pin if there is a DUT failure.
The ‘Meas V’ selection forces a current defined by the Measure I
Force button and measures the resulting voltage on the Charge
Pump Out (C8) port. The Measure V Limit button restricts the
maximum voltage applied by DPVP 0-25V, ±2 mA during the
measurement. Typically the Measure V Limit button is set to the
DUT’s supply rail or ground depending on the polarity of the Measure
I Force button to avoid damaging the device pin.
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Measure I Force

NOTE: This mode is typically used for continuity tests or testing protection diodes on
DUT pins.

0
Measure I Force

The ‘Leakage’ selection measures the current on the Charge Pump
Out (C8) port. This mode sets the precision measure’s sense resistor
to it’s lowest current measurement range and incorporates a built-in,
recursive averaging method to measure DC leakage currents in the
pA range. Leakage forces voltage with a 50u max current.

Force current in iMeas mode. Max is 2 mA.

NOTE: This mode can be used in continuity tests for device pins with large in-rush
currents or long duration time constants during power up.

Force voltage in Force V mode. Range is -2 to +25 volts.

Measure V Force

0
Measure V Force

Measure V Limit

0
The ‘Leak Cal’ selection is the same mode as the ‘Meas I’ mode with
the exception that the voltage limit settings are deactivated. The value
set with the Measure V Limit is ignored, and the supply(DPVP 0-25V,
±2 mA) will provide as much available voltage as possible to force the
current condition defined by the Measure I Force button.
NOTE: Use caution with this mode, as pin voltages can exceed the rail voltages of the
device under test.

© Roos Instruments Inc.

Measure V Limit
Voltage limit in I Force mode. Range is 0 to 25 volts
Measure I Limit

0
Measure I Limit
Current limit in vMeas mode. Max is 2 mA.
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MEAS
Tune Current

A

Meas: Tune Current
Measure the current on the tune line.Range is ±2 mA or ± 50µA in
leakage mode. When not in leakage mode then setting Measure I
Limit to less than 500µA selects a finer resolution.

MEAS
Tune Voltage

A

Meas: Tune Voltage
Measure the voltage on the tune line. Range is -3v to + 25v

© Roos Instruments Inc.
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CONTROL PANELS
Real time control of the instruments in this TIM.

C ONTROL P ANELS 11 RI8575: PHASE NOISE MEASURE

CONTROL PANEL
InputFrequency
Displays the input frequency.

Lock Status
Displays the lock status.

TIME MEASURE
VOLTAGE
Displays the Voltage.

CURRENT
Displays the Current.

PhaseNoiseAnalyzer control panel shows state and connection
buttons for real-time control of the instrument in this TIM.

© Roos Instruments Inc.

436

SECTION 13

RI8577: SOURCE
COMBINER

Graphical Programming | RI8577: Source Combiner

TOPICS

Instruments Provided by this TIM
Configuration Panel
Instrument Diagram with Edit Buttons
Edit Panel Button Descriptions
Control Panel

Tap the links above to quickly access content.

© Roos Instruments Inc.

437

Cassini ATE System Reference Guide

Graphical Programming | RI8577: Source Combiner

INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as Src12Output in the panel dialog
windows. Additional TIMs appear as Src12Output# with # replaced by
the number of TIM.
Model and Name as it appears in the Tester Configuration:
• Src12Output, Ri8577x Src1/2 Output TIM
NOTE: Multiple RI8577 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - Src12Output,
Src12Output2, Src12Output3, etc). The “x” in RI8577x denotes the model revision
number.

© Roos Instruments Inc.
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CONFIGURATION PANELS

Graphical Programming | RI8577: Source Combiner

C ONFIGURATION P ANELS 5 RI8577: SOURCE COMBINER

All of the connection path buttons Source1 RF Input- pin:C1,
Source2 RF Input -pin:C5, Main RF Output -pinC7, Aux RF
Output1 -pin:C3, Aux RF Output2 -pinC8, and Source2 Output
-pinC4 are green because they provide connections to the Test
Fixture interface. This means they must be defined by the connections
that are listed in the Test Fixture definition, but are still displayed here.

Displays connection paths entering and leaving this TIM.

© Roos Instruments Inc.
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I NSTRUMENT B UTTON D IAGRAM 2.10
Roos Instruments, Inc
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Block Diagram, Src1/2 Output TIM
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EDIT PANELS

Graphical Programming | RI8577: Source Combiner

P ANEL : STATE

Automated control of the instruments in this TIM with use by the Test
Plan Editor.

Source 1 Attn

0db

Source 1 Attn

E DIT P ANELS 17 RI8577: SOURCE COMBINER

A drop down list button for path 1 that switches in the steps of the
110 dB mechanical attenuator offered in 10 dB steps.
NOTE: The “0” dB step is relative to the other steps.

Source 2 Attn

0db

Source 2 Attn
A drop down list button for path 2 that switches in the steps of the
110 dB mechanical attenuator offered in 10 dB steps.
NOTE: The “0” dB step is relative to the other steps.

Src12Output controls the signal paths going through this instrument.

© Roos Instruments Inc.
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Source 1 Amp

Intermod Freq Spacing

oﬀ

0

Source 1 Amp

Intermod Freq Spacing

A drop down list button that in the “on“ state connects a 20 dB gain
amp into the output path. (usable only 500 MHz to 6 GHz)

A floating-point input button with units of MHz that sets the spacing
between the two Sources to setup a Two tone measurement. Source
1 will be set above its requested frequency by 1/2 the intermod
frequency spacing and Source2 will be set below the requested
frequency of Source 1 was set to by the same amount. This is only
valid when the Source Output Mode is set to “intermod to Src 1”
mode.

Source 2 Amp

oﬀ

Source 2 Amp
A drop down list button that in the “on“ state connects a 20 dB gain
amp into the output path. (usable only 500 MHz to 6 GHz)
Intermod Tracking

oﬀ

Intermod Power Spacing

0

Intermod Power Spacing

Intermod Tracking
A drop down list button that in the “on“ state directs the compiler to
use the information in the “Intermod Frequency Spacing” button, and
“Intermod Power Spacing” buttons tracking and redirect the Source1
and Source 2 instruments-parameters.

© Roos Instruments Inc.

A floating-point input button with units of dB that sets the output
power difference between the two Sources. Source1 is set to its
requested power and Source2 is offset from that set in Source 1 by
the value of the Intermod Power Spacing button. This only has effect
when the Source Output Mode is set to “Intermod to src1”mode.
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Source 1 Output Mode

Source Output Mode

Combined to src 1

Source Output Mode

Main

Source 1 Output Mode

A drop down list button that sets the internal source routing to be
combined with a passive power combiner or still conditioned but as
separate outputs.
The “separate” mode routes the Source 1 output directly to the output
selected with the Source 1 Output Mode button. Source 2 is set to
the Src 2 out directly.

C ONTROL P ANELS 12 RI8577: SOURCE COMBINER

The “Combined to src1” mode routes the two sources into a passive
power combiner and then routes the combined signal to the output
selected with the Source 1 Output Mode button. The Src2 output is
disconnected.
The “Intermod to src1” mode again routes the two sources into a
passive power combiner and then routes the combined signal to the
output selected with the Source 1 Output Mode button. The Src2
output is again disconnected. In addition this mode directs the
compiler to alter the values of both Source1 and Source2‘s Frequency
and Power output settings to take into account the values listed in the
“Intermod Freq Spacing” and “Intermod Power Spacing buttons.

Src12Output control panel provides real-time control of signals
going through this TIM.

© Roos Instruments Inc.
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A drop down list button that sets the internal source routing to
connect the output of the Source 1 path to either the “Main”, “Aux”,
or “Aux2” output ports.

© Roos Instruments Inc.
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CONTROL PANELS
Real time control of the instruments in this TIM. Please refer to the
Edit Panels for help with buttons contained in both the “Edit” and
“Control” panels.
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SECTION 14

RI8580: 57GHZ TO
64GHZ TESTSET

Graphical Programming | RI8580: 57GHz to 64GHz TestSet

TOPICS

Instruments Provided by this TIM
Edit Panel Button Descriptions
Control Panel

Tap the links above to quickly access content

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as Test Head66 in the panel dialog
windows.
Model and Name as it appears in the Tester Configuration:
• Test Head66, Ri8580x 66 GHz Test Set
NOTE: Multiple RI8580 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - Test Head66, Test
Head662, Test Head663, etc). The “x” in RI8580x denotes the model revision number.

© Roos Instruments Inc.
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EDIT PANELS

PANEL: RF SETUP

Automated control of the instruments in this TIM with use by the Test
Plan Editor.

Parameter

none
Note: Screenshots show Test Head66 buttons, subject to change.

E DIT P ANELS 18 RI8580: 57 TO 64GHZ TEST SET

Parameter
Drop down list button that designates which of the coupler ports will
be routed to the switching network. It is typically used for routing
incident/reflected wave signals to the receiver for wave/s-parameter
measurements.
Choices: a1, b1, b2, Rf4
The ‘a1’, ‘b1’. and ‘b2’ selections uses the compiler’s expert system
to automatically select the correct switch routing. These selections
require an RF port to be set by Input Port and Output Port buttons
and corresponding Rf 2/Rf 3, Rf 6 or Rf 7 button selections.
Note:
a1 is the incident wave to the input port of the device under test.
b1 is the reflected wave from the input port of the device under test.
b2 is the reflected wave from the output port of the device under test.

Testhead66 RF Setup shows state configuration options.

© Roos Instruments Inc.
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Noise Source

PANEL: MEASUREMENTS

oﬀ
Noise Source

MEAS

Drop down list select button that sets Noise Source on or off

Input Wave

Power

0
Power
Decimal notation input button that sets power at the device to a dBm
value. Resolution is 0.1 dBm.

A

Meas: Input Wave
Measurement block that performs power corrected one port wave
parameters at the receive Frequency.

MEAS

Rec Frequency

20000
S11

Rec Frequency

A

Meas: Corrected S11
Decimal notation input button that sets the receiver frequency in MHz.
Rf State

Measurement block that performs a corrected S11 parameter
measurement.

oﬀ

Average Mode

Rf State
A drop down list button that sets the RF source output to the “on” or
“off” state.

© Roos Instruments Inc.

std
Average Mode
A drop down list button that is associated with the higher-level macro
measurement buttons that sets the method of averaging used.
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The “std” mode uses the number of Averages set by the System
Button when measuring and completes all the averages of each of the
parameters in a high-level macro button before moving to the next
parameter. For example, on an S11 measurement with 4 averages,
the tester would measure a1, a1, a1, a1, then b1, b1, b1, b1. This is the
fastest averaging mode, but if the signal drifts while the a1
measurements are being made, the measurement can be less
accurate.
The “adjacent” mode uses the number of Averages set by the
System Button as above, but when measuring to satisfy a high-level
macro button, it takes data from each of the parameters needed one
at a time, before completing another round of measurements for the
average. For example, on an S11 measurement with 4 averages, the
tester would measure a1, b1, a1, b1, a1, b1, a1, b1. This makes the a1
and b1 measurements virtually simultaneous. The “adjacent
averaging” mode is slightly slower than the “std” mode, but can
minimize the effects of any signal drift especially for large number of
averages.
NOTE: At higher frequencies and with averages greater than 8 to 16, some improvement
in accuracy and repeatability are often achieved using the adjacent averaging mode.

© Roos Instruments Inc.
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PANEL: MEASUREMENTS
MEAS
Thru Wave

A

Meas: Thru Wave
Measurement block that performs a11 and b21 measurement at the
input frequency. The result is corrected to be absolute voltage. note
that the phase is only defined within a test and not with any other
readings.

MEAS
Input Wave

A

Meas: Input Wave
Measurement block that performs a power corrected wave
measurement.
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PANEL: RECEIVER STATE

MEAS
S11

If Bw

A

200 kHz

Meas: Corrected S11

If Bw

Measurement block that performs a corrected S11 parameter
measurement.

Drop down list select button that sets the receiver’s analog detection
bandwidth within the “IF Board, 21.4 MHz” in the block diagram. The
‘5 MHz’ option is the full bandwidth of the receiver’s front-end.
The ‘7 KHz’ value is a bandpass filter applied before the IF signal is
converted to zero IF/baseband.
The ‘200 kHz’ is a low pass filter applied after IF conversion to zero IF.
The ‘TOI’ value activates a filtering/gain/attenuator mode that selects
the ‘7 kHz’ IF filter and optimizes the IF and baseband gain/attenuator
scheme for third order intercept measurements. In ‘TOI’ mode the If
Gain button is limited to values of ‘8’ and ‘14’.

© Roos Instruments Inc.
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If Gain

Rms Bw

20

Slow

If Gain

Rms Bw

Drop down list select button that sets the gain of an amplifier in units
of dB within the “IF Board, 21.4MHz” shown in the block diagram.
This value should be optimized for best dynamic range. The selection
options of ‘8’, ‘14’, ‘20’, ‘26’, ‘32’, ‘38’, ‘44’, ‘50’, ’56’, ’62’, and ’68’
are in units of dB.

Sets the post detection bandwidth. RMS uses a 10 MHz IF bandwidth
always.

NOTE: Optimal settings are achieved by increasing the value until an overflow messages
appears in the message window during test compile or run and then selecting the value
below the setting that causes an overflow warnings.

Rms Gain

High
Rms Gain
Drop down list button that sets the post-detection gain. ‘Low’ is
approximately -20dB.

Samples

1
Samples
A integer button that is the number of samples per waveform measure
points.
Meas Rate

80000
Meas Rate
Decimal notation data button that sets the measure rate. The fastest
is 200 KHz
© Roos Instruments Inc.
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PANEL: RECEIVER MEASUREMENTS

MEAS
Power

MEAS
Noise Power

A

Meas: Noise Power
Measurement block that performs a noise power measurement for the
current path.

Meas: Power
Measurement block that performs performs a corrected power
measurement for the current path. Converts voltage to power and
then averages the result

MEAS

MEAS

Phase Noise
Voltage

A

Meas: Voltage
Measurement block that performs a complex voltage measurement
for the current path.

© Roos Instruments Inc.

A

A

Meas: Phase Noise
Measurement block that performs the noise power measurement in a
1 Hz bandwidth using the current path. Uses the Noise Power
measurement as it base.
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MEAS
Voltage vs Time

MEAS
RMS Voltage

A

Meas: Voltage Vs Time

A

Meas: RMS Voltage
Measurement block that performs a RMS voltage measurement using
hardware RMS calculation.

Measurement block that creates a vector of complex voltage
measurements vs Time. The vector is a Complex data type.

Note: Fully error corrected Scalar data type.

Meas: RMS Power Vs Time
MEAS

RMS Power Vs Time

A

Measurement block that creates a vector of RMS Power
measurements vs. Time.

MEAS
RMS Power

A

Meas: RMS Power
Measurement block that performs RMS power measurement for
current path using the RMS/Noise detector.
© Roos Instruments Inc.
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The ‘power’ selection uses the RMS detector for triggered
measurements.

PANEL: DIGITIZER MEASUREMENTS
Trigger

oﬀ

The ‘V vs T’ selection uses the voltage detector for triggered Voltage
vs Time block measurements.

Trigger

Delay

Drop down list button that is used in a pre/post measure groups to
activate (‘on’) or deactivate (‘off’) triggered receiver measurements.
This button is commonly used with the Delay button in the pre/post
measure group and the Trigger Mode button in the test panel or
section default.
Trigger Mode

normal

0
Delay
Decimal notation input button used within pre/post measure groups
to delay the start of a triggered measurement with a user-defined
duration. The value is in units of seconds with a maximum value of
0.01 seconds and a resolution of 1µs. This button is commonly used
with the Trigger button.

Trigger Mode
Drop down list button that configures the receiver’s detector hardware
for different trigger/pulse type measurements. This button is
commonly used in test panels with the Trigger and Delay buttons
placed in pre/post measure groups.
The ‘normal’ selection uses the receiver’s voltage detector for
triggered measurements.

MEAS
Delayed Power

A

Meas: Delayed Power
Measurement block that performs a RMS power measurement after a
specified delay time set by the Delay button.

The ‘voltage’ selection performs the same function as the ‘normal’
mode.

© Roos Instruments Inc.
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MEAS
Delayed Voltage

A

Meas: Delayed Voltage
Measurement block that performs a complex voltage after a specified
delay time set by the Delay button.

MEAS
Triggered Digitizer A
Meas: Triggered Digitizer
Measurement block that performs a complex voltage measurement vs
time relative to a trigger in the premeasure group set by Trigger and
Trigger Mode buttons.

© Roos Instruments Inc.
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CONTROL PANELS
Real time control of the instruments in this TIM.

C ONTROL P ANELS 13 RI8564: 75 TO 81GHZ TEST SET

Graphical Programming | RI8580: 57GHz to 64GHz TestSet

RECEIVER CONTROL
POWER DBM, VOLTAGE DBM, NOISE DBM/HZ,
RMSDBM
The above values are refreshed when LMB clicked within the button.

Testhead66 RF Control panel provides real-time state controls for
this TIM.

© Roos Instruments Inc.
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RI8581: 100KHZ TO
20GHZ RECEIVER

Graphical Programming | RI8581: 100kHz to 20GHz Receiver

TOPICS

Instruments Provided by this TIM
Instrument Diagram with Edit Buttons
Edit Panel Button Descriptions
Control Panel

Tap the links above to quickly access content

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as Receiver in the panel dialog
windows.
Model and Name as it appears in the Tester Configuration:
• Receiver, RI8581x .01 to 20 GHz Complex Receiver TIM
NOTE: Multiple RI8581 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - Receiver, Receiver2,
Receiver3, etc). The “x” in RI8581x denotes the model revision number.

© Roos Instruments Inc.
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I NSTRUMENT B UTTON D IAGRAM 2.11
Roos Instruments, Inc - Cassini

Block Diagram, Receiver TIM
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Copyright Roos Instruments, Inc.
Subject to change without notice
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EDIT PANELS

Graphical Programming | RI8581: 100kHz to 20GHz Receiver

PANEL: STATE

Automated control of the instruments in this TIM with use by the Test
Plan Editor.

Frequency

1000

E DIT P ANELS 19 RI8581: 100MHZ TO 20GHZ RECEIVER

Frequency
Decimal notation input button that sets the tuned frequency of the
receiver in MHz. This frequency value is set by the system reference
button when using a virtual instrument such as: VNA, noise figure, or
other multi-TIM measurement.
NOTE: This button is only used for measurements defined by the receiver instrument
such as a power or vector voltage measurement.

Freq Offset

0

Freq Offset
Decimal notation input button that sets the receiver output offset
frequency in MHz. Typical offset range is ±5MHz.

Receiver state buttons for control of the receiver.

© Roos Instruments Inc.

NOTE: A maximum offset range of ±10MHz is possible within certain frequency ranges.
Consult the message window during compile to ensure offset compliance for a given
center frequency.
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Input

.1-2 (.1 - 20 input)

Mix Side

high

Mix Side
Drop down list select button that selects the ‘High’ (upper) or
‘Low’ (lower) sideband of the down-converted signal image to be
digitized by the receiver. ‘Default’ allows the compiler to select the
optimal value.
NOTE: Changing from the default setting can affect tester accuracy. The ‘high’ or ‘low’
button settings should only be used if there is spurious or undesirable spectral content
from the device under test in the default sideband which interferes with the measurement.
For best accuracy, the ‘default’ setting should be used.

Input
Drop down list select button that routes the selected physical input
port to the receiver’s downconversion/digitizer path or to another port
on the instrument test head.
‘.1-2 (.1-20 input)’ and 2-20 (.1-20 input)’ options connect input port
Hi In located at C13 on the instrument test head to the
downconverter/digitizer.
‘.1 - 20 to Aux out’ routes the input port Hi In located at C13 on the
instrument test head to the output port Aux Out A located at C14 on
the instrument test head.
‘.1 - 20 to Aux out 2’ routes the input port Hi In (C13) to the output
port Aux Out B (C15) on the instrument test head.

Im Spacing

1

Im Spacing
Set the spacing in MHz between the two signals used for an
intermodulation measurement.
NOTE: The receiver frequency must be set to the frequency value that
is center and equidistant between the two signals of interest.

© Roos Instruments Inc.

‘.005 - 2 Input’ connects the input port Low In (C16) to the
downconverter/digitizer.
‘off’ disconnects all input ports from the receiver’s downconverter/
digitizer.
‘Cal’ is used for RI internal purposes only.
‘LO Cal’ connects LO In (C16) to the receiver's downconverter/
digitizer.
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‘Ext-1’ routes IF In A (C10) as an input to the receiver and routes LO
In (C1) to LO Out A (C2) as an output.

The ‘7 KHz’ value is a bandpass filter applied before the IF signal is
converted to zero IF/baseband.

‘Ext-2’ routes IF In A (C10) as an input to the receiver and routes LO
In (C1) to LO Out A (C2) as an output.

The ‘200 kHz’ is a low pass filter applied after IF conversion to zero IF.

‘Ext-3’ routes IF In A (C10) as an input to the receiver and routes LO
In (C1) to LO Out A (C2) as an output.
NOTE: The ‘Ext-1’, ‘Ext-2’, and ‘Ext-3’ options are used to support the IF and LO
port routing requirements for frequency converting testsets (RI8560: 56GHz to 67GHz
TestSet, RI8563: 4GHz to 40.5GHz TestSet, RI8564: 71GHz to 83GHz TestSet) or
external mixer/frequency converters in the fixture.

The ‘TOI’ value activates a filtering/gain/attenuator mode that selects
the ‘7 kHz’ IF filter and optimizes the ratio of the gain scheme for the
amplifiers on the input and output sides of the IF filter to place all of
the gain on the output side for high-fidelity third order intercept
measurements. In ‘TOI’ mode the If Gain button is limited to values of
‘8’ and ‘14’.
NOTE: The If BW button value is ignored and a 10 MHz IF bandwidth is used when a
RMS Power, RMS Power vs. Time, or RMS Voltage measurement block is used in a
test panel.

Samples

1
Low Band Attn

Samples
Decimal notation input button that sets the total number of
measurement samples.
If Bw

200 KHz

If Bw

10

Low Band Attn
Drop down list select button that sets the baseband gain attenuator
found at the output of the “Mixer Board” in the block diagram to
optimize the receiver analog path for best dynamic range. The options
’10’, ’20’, ’30’, and ’40’ represent attenuation values in units of dB.

Drop down list select button that sets the receiver’s analog detection
bandwidth within the “IF Board, 21.4 MHz” in the block diagram. The
‘5 MHz’ option is the full bandwidth of the receiver’s front-end.
© Roos Instruments Inc.
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If Gain

Rms Bw

20

slow

If Gain

Rms Bw

Drop down list select button that sets the gain of an amplifier in units
of dB within the “IF Board, 21.4MHz” shown in the block diagram.
This value should be optimized for best dynamic range. The selection
options of ‘8’, ‘14’, ‘20’, ‘26’, ‘32’, ‘38’, ‘44’, ‘50’, ’56’, ’62’, and ’68’
are in units of dB.

Drop down list select button that sets the post-detection bandwidth
for Root Mean Squared (RMS) measurements. This button is used to
optimize the settling speed of the detectors lock and measure speed.
It is used with the RMS Power, RMS Voltage, and RMS
PowerVsTime measurement blocks.

NOTE: Optimal settings are achieved by increasing the value until an overflow messages
appears in the message window during test compile or run and then selecting the value
below the setting that causes an overflow warnings.

NOTE: The ‘Fast’ setting can be susceptible to increased measurement instability due to
DUT and fixture path dependent settling times.

When used with the If Bw button set to the ‘TOI’ option, the If Gain setting is a ratio
between the input and output amplifiers of the IF filters to place all of the gain on the
output side. In this mode, only the ‘8’ and ‘14’ values of the IF gain button are valid.

Meas Rate

An RMS measurement overrides the If Bw button and uses a 10 MHz
IF bandwidth setting.
NOTE: The RMS detector receive path is automatically selected when an RMS Power,
RMS Voltage, or RMS PowerVsTime measurement block is used.

80000

Meas Rate
Decimal notation input button that sets the sample rate of the
receiver’s digitizer in units of Hz. The maximum sample rate is 200
kHz.

© Roos Instruments Inc.
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Rms Gain

PANEL: MEASUREMENTS

High

Rms Gain
Drop down list button that sets the post-detection gain. This button is
commonly used with the RMS Power, RMS Voltage, and RMS
PowerVsTime measurement blocks.
The ‘High’ setting is approximately 0dB.

MEAS
Noise Power

A

Meas: Noise Power
Measures noise power for a selected port using the dedicated noise
detector in the receiver’s baseband subsystem.

The ‘Low’ setting is approximately -20dB.
MEAS

NOTE: The RMS detector receive path is automatically selected when an RMS Power,
RMS Voltage, or RMS PowerVsTime measurement block is used.

Voltage

A

Meas: Voltage
Measures an RF signals complex voltage amplitude for the selected
port. The input signal is mixed with the receiver’s orthogonal tuning
signals, providing input signal phase and amplitude represented as a
complex voltage value or voltage vector.
MEAS
Power

A

Meas: Power
Measures the corrected signal power for the selected port and path.
The block converts complex voltage to a scalar power value and then
averages the result.

© Roos Instruments Inc.
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MEAS

MEAS

Phase Noise A

RMS Power vs Time

A

Meas: Phase Noise

Meas: Rms Power Vs Time

Measure the noise power in units of Watts/Hz in a 1 Hz bandwidth
using the current setup. Uses the Noise Power measurement as its
base.

Measures RMS power for the selected port using the dedicated RMS/
Noise detector path and records the corresponding measurement
time.

MEAS
Intermod

A

NOTE: The If BW button value is ignored and a 10 MHz IF bandwidth is used when
this measurement block is used in a test panel.

Meas: Intermod

MEAS

Use this button to measure the intermod intercept point of an amplifier
in watts. The intermod signals are assumed to be above and below
the center frequency and both sidebands are used to compute the
intercept

RMS Power

A

Meas: RMS Power
Measure the RMS power for the selected port using the RMS/Noise
detector.

MEAS
Voltage vs Time

A

NOTE: The If BW button value is ignored and a 10 MHz IF bandwidth is used when
this measurement block is used in a test panel.

Meas: VoltageVsTime
Measures an RF signal complex voltage amplitude or voltage vector
and records the value with its corresponding measurement time.

© Roos Instruments Inc.
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MEAS

PANEL: PULSE

RMS Voltage A

Trigger

Meas: RMS Voltage
Measurement block measures RMS voltage by converting the
complex voltage vector into a scalar amplitude vector and and then
computes the root mean square value.
NOTE: The If BW button value is ignored and a 10 MHz IF bandwidth is used when
this measurement block is used in a test panel.

oﬀ

Trigger
Drop down list button that activates (‘on’) or deactivates (‘off’) the
trigger option on receiver measurements. Trigger on starts a
measurement series
Trigger Mode

normal

Trigger Mode
Drop down list button sets the trigger mode for the receiver's pulse/
trigger measurement functions. Option ‘normal’ triggers normally,
‘voltage’ triggers on voltage value, ‘power’ triggers on power value, ‘V
vs T’ triggers on Voltage vs Time value.
Delay

0

Delay
Decimal notation input button that sets the delay between
measurements in units of seconds for the pulse mode measurements.
Resolution is 1µs.

© Roos Instruments Inc.
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MEAS
Triggered Digitizer A

Meas: TriggeredDigitizer

CONTROL PANELS
Real time control of the instruments in this TIM.

Measures an RF signals complex voltage/voltage vector vs. time
relative to a specified trigger in the premeasure.

© Roos Instruments Inc.
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RECEIVER CONTROL

Graphical Programming | RI8581: 100kHz to 20GHz Receiver

POWER DBM, VOLTAGE DBM, NOISE DBM/HZ, RMS
DBM, Path Gain
The above values are live, refreshed when clicked.

C ONTROL P ANELS 14 RI8581: 100MHZ TO 20GHZ RECEIVER

Receiver control panel provides Power, Voltage, Noise and path
gain as well as receiver state.

© Roos Instruments Inc.
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RI8587: 100KHZ TO
20GHZ DSP RECEIVER
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TOPICS

Instruments Provided by this TIM
Instrument Diagram with Edit Buttons
Edit Panel Button Descriptions
Control Panel

Tap the links above to quickly access content

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as Receiver in the panel dialog
windows.
Model and Name as it appears in the Tester Configuration:
• Receiver, RI8587x .01 to 20GHz Complex Receiver TIM w DSP
NOTE: Multiple RI8587 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - Receiver, Receiver2,
Receiver3, etc). The “x” in RI8587x denotes the model revision number.

© Roos Instruments Inc.
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I NSTRUMENT B UTTON D IAGRAM 2.12
Roos Instruments, Inc - Cassini

Block Diagram, Receiver TIM
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EDIT PANELS
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PANEL: STATE

Automated control of the instruments in this TIM with use by the Test
Plan Editor.

Frequency

1000

E DIT P ANELS 20 RI8587: 100MHZ TO 20GHZ RECEIVER

Frequency
Decimal notation input button that sets the tuned frequency of the
receiver in MHz. This frequency value is set by the system reference
button when using a virtual instrument such as: VNA, noise figure, or
other multi-TIM measurement.
NOTE: This button is only used for measurements defined by the receiver instrument
such as a power or vector voltage measurement.

Freq Offset

0

Freq Offset
Decimal notation input button that sets the receiver output offset
frequency in MHz. Typical offset range is ±5MHz.
Receiver state panel shows state options for the receiver.

© Roos Instruments Inc.

NOTE: A maximum offset range of ±10MHz is possible within certain frequency ranges.
Consult the message window during compile to ensure offset compliance for a given
center frequency.

472

Graphical Programming | RI8587: 100kHz to 20GHz DSP Receiver

Cassini ATE System Reference Guide

Input

.1-2 (.1 - 20 input)

Mix Side

high

Mix Side
Drop down list select button that selects the ‘High’ (upper) or
‘Low’ (lower) sideband of the down-converted signal image to be
digitized by the receiver. ‘Default’ allows the compiler to select the
optimal value.
NOTE: Changing from the default setting can affect tester accuracy. The ‘high’ or ‘low’
button settings should only be used if there is spurious or undesirable spectral content
from the device under test in the default sideband which interferes with the measurement.
For best accuracy, the ‘default’ setting should be used.

Input
Drop down list select button that routes the selected physical input
port to the receiver’s downconversion/digitizer path or to another port
on the instrument test head.
‘.1-2 (.1-20 input)’ and 2-20 (.1-20 input)’ options connect input port
Hi In located at C13 on the instrument test head to the
downconverter/digitizer.
‘.1 - 20 to Aux out’ routes the input port Hi In located at C13 on the
instrument test head to the output port Aux Out A located at C14 on
the instrument test head.
‘.1 - 20 to Aux out 2’ routes the input port Hi In (C13) to the output
port Aux Out B (C15) on the instrument test head.

Im Spacing

1

Im Spacing
Set the spacing in MHz between the two signals used for an
intermodulation measurement.
NOTE: The receiver frequency must be set to the frequency value that
is center and equidistant between the two signals of interest.

© Roos Instruments Inc.

‘.005 - 2 Input’ connects the input port Low In (C16) to the
downconverter/digitizer.
‘off’ disconnects all input ports from the receiver’s downconverter/
digitizer.
‘Cal’ is used for RI internal purposes only.
‘LO Cal’ connects LO In (C16) to the receiver's downconverter/
digitizer.
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‘Ext-1’ routes IF In A (C10) as an input to the receiver and routes LO
In (C1) to LO Out A (C2) as an output.

The ‘7 KHz’ value is a bandpass filter applied before the IF signal is
converted to zero IF/baseband.

‘Ext-2’ routes IF In A (C10) as an input to the receiver and routes LO
In (C1) to LO Out A (C2) as an output.

The ‘200 kHz’ is a low pass filter applied after IF conversion to zero IF.

‘Ext-3’ routes IF In A (C10) as an input to the receiver and routes LO
In (C1) to LO Out A (C2) as an output.
NOTE: The ‘Ext-1’, ‘Ext-2’, and ‘Ext-3’ options are used to support the IF and LO
port routing requirements for frequency converting testsets (RI8560: 56GHz to 67GHz
TestSet, RI8563: 4GHz to 40.5GHz TestSet, RI8564: 71GHz to 83GHz TestSet) or
external mixer/frequency converters in the fixture.

The ‘TOI’ value activates a filtering/gain/attenuator mode that selects
the ‘7 kHz’ IF filter and optimizes the ratio of the gain scheme for the
amplifiers on the input and output sides of the IF filter to place all of
the gain on the output side for high-fidelity third order intercept
measurements. In ‘TOI’ mode the If Gain button is limited to values of
‘8’ and ‘14’.
NOTE: The If BW button value is ignored and a 10 MHz IF bandwidth is used when a
RMS Power, RMS Power vs. Time, or RMS Voltage measurement block is used in a
test panel.

Samples

1
Low Band Attn

Samples
Decimal notation input button that sets the total number of
measurement samples.
If Bw

200 KHz

If Bw

10

Low Band Attn
Drop down list select button that sets the baseband gain attenuator
found at the output of the “Mixer Board” in the block diagram to
optimize the receiver analog path for best dynamic range. The options
’10’, ’20’, ’30’, and ’40’ represent attenuation values in units of dB.

Drop down list select button that sets the receiver’s analog detection
bandwidth within the “IF Board, 21.4 MHz” in the block diagram. The
‘5 MHz’ option is the full bandwidth of the receiver’s front-end.
© Roos Instruments Inc.
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If Gain

Rms Bw

20

slow

If Gain

Rms Bw

Drop down list select button that sets the gain of an amplifier in units
of dB within the “IF Board, 21.4 MHz” shown in the block diagram.
This value should be optimized for best dynamic range. The selection
options of ‘8’, ‘14’, ‘20’, ‘26’, ‘32’, ‘38’, ‘44’, ‘50’, ’56’, ’62’, and ’68’
are in units of dB.

Drop down list select button that sets the post-detection bandwidth
for Root Mean Squared (RMS) measurements. This button is used to
optimize the settling speed of the detectors lock and measure speed.
It is commonly used with the RMS Power, RMS Voltage, and RMS
PowerVsTime measurement blocks.

NOTE: Optimal settings are achieved by increasing the value until an overflow messages
appears in the message window during test compile or run and then selecting the value
below the setting that causes an overflow warnings.

NOTE: The ‘Fast’ setting can be susceptible to increased measurement instability due to
DUT and fixture path dependent settling times.

When used with the If Bw button set to the ‘TOI’ option, the If Gain setting is the ratio
between the input and output amplifiers of the IF filters to place all of the gain on the
output side. In this mode, only the ‘8’ and ‘14’ values of the IF gain button are valid.

Meas Rate

An RMS measurement overrides the If Bw button and uses a 10 MHz
IF bandwidth.
NOTE: The RMS detector receive path is automatically selected when an RMS Power,
RMS Voltage, or RMS PowerVsTime measurement block is used.

80000

Meas Rate
Decimal notation input button that sets the sample rate of the
receiver’s digitizer in units of Hz. The maximum sample rate is 200
kHz.

© Roos Instruments Inc.
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Rms Gain

PANEL: MEASUREMENTS

High

Rms Gain
Drop down list button that sets the post-detection gain. This button is
commonly used with the RMS Power, RMS Voltage, and RMS
PowerVsTime measurement blocks.
The ‘High’ setting is approximately 0dB.

MEAS
Noise Power

A

Meas: Noise Power
Measurement block measures noise power for a selected port using
the dedicated noise detector in the receiver’s baseband subsystem.

The ‘Low’ setting is approximately -20dB.
MEAS

NOTE: The RMS detector receive path is automatically selected when an RMS Power,
RMS Voltage, or RMS PowerVsTime measurement block is used.

Voltage

A

Meas: Voltage
Measures an RF signals complex voltage amplitude for the selected
port. The input signal is mixed with the receiver’s orthogonal tuning
signals, providing input signal phase and amplitude represented as a
complex voltage value or voltage vector.
MEAS
Power

A

Meas: Power
Measures the corrected signal power for the selected port and path.
The block converts complex voltage to a scalar power value and then
averages the result.

© Roos Instruments Inc.
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MEAS

MEAS

Phase Noise A

RMS Power vs Time

A

Meas: Phase Noise

Meas: RMS Power Vs Time

Measure the noise power in units of Watts/Hz in a 1Hz bandwidth
using the current setup. Uses the Noise Power measurement block
as the base measurement.

Measures RMS power for the selected port using the dedicated RMS/
Noise detector path and records the corresponding measurement
time.

MEAS

Intermod

A

NOTE: The If BW button value is ignored and a 10 MHz IF bandwidth is used when
this measurement block is used in a test panel.

Meas: Intermod
Use this button to measure the intermod intercept point of an amplifier
in watts. The intermod signals are assumed to be above and below
the center frequency and both sidebands are used to compute the
intercept

RMS Power

A

Meas: RMS Power
Measure the RMS power for the selected port using the RMS/Noise
detector.

MEAS
Voltage vs Time

MEAS

A

Meas: Voltage Vs Time

NOTE: The If BW button value is ignored and a 10 MHz IF bandwidth is used when
this measurement block is used in a test panel.

Measures an RF signal complex voltage amplitude/voltage vector and
records the value with it’s corresponding measurement time.

© Roos Instruments Inc.

477

Graphical Programming | RI8587: 100kHz to 20GHz DSP Receiver

Cassini ATE System Reference Guide
MEAS

PANEL: PULSE

RMS Voltage A

Trigger

Meas: RMS Voltage
Measurement block measures RMS voltage by converting the
complex voltage vector into a scalar amplitude vector and then
computes the root mean square value.
NOTE: The If BW button value is ignored and a 10 MHz IF bandwidth is used when
this measurement block is used in a test panel.

oﬀ

Trigger
Drop down list button that is used in a pre/post measure groups to
activate (‘on’) or deactivate (‘off’) triggered receiver measurements.
This button is commonly used with the Delay button in the pre/post
measure group and the Trigger Mode button in the test panel or
section default.
Trigger Mode

normal

Trigger Mode
Drop down list button that configures the receiver’s detector hardware
for different trigger/pulse type measurements. This button is
commonly used in test panels with the Trigger and Delay buttons
placed in pre/post measure groups.
The ‘normal’ selection uses the receiver’s voltage detector for
triggered measurements.
The ‘voltage’ selection performs the same function as the ‘normal’
mode.

© Roos Instruments Inc.
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The ‘power’ selection uses the RMS detector for triggered
measurements.

PANEL: SPECTRUM MEASUREMENTS

The ‘V vs T’ selection uses the voltage detector for triggered Voltage
vs Time block measurements.
Delay

0

Delay
Decimal notation input button used within pre/post measure groups
to delay the start of a triggered measurement with a user-defined
duration. The value is in units of seconds with a maximum value of
0.01 seconds and a resolution of 1µs. This button is commonly used
with the Trigger button.
MEAS
Triggered Digitizer A

Meas: TriggeredDigitizer
Measurement block measures an RF signals complex voltage vector
vs. time relative to a specified trigger in the premeasure. This
measurement block is commonly used with the Trigger, Trigger
Mode, and/or Delay buttons.

© Roos Instruments Inc.

If Shift

0

If Shift
Decimal notation input button that sets the frequency offset for the
FPGA-based mixer within the digital signal processor subsystem.
Values are in units of Hz with a range of 0 to 100 kHz.
Det Bw

bypass

Det Bw
Drop down list button that configures the bandwidth of a postmeasure, low-pass digital filter in the receive detector’s FPGA-based
DSP chain. These provide selectable, narrow-band filters with typically
60dB of stop band attenuation. The ‘bypass’ selection is the default,
applying no digital filter. The other options are 200 kHz, 100 kHz, 50
kHz, 25 kHz, 10 kHz, 5 kHz, 2.5 kHz, and 1 kHz bandwidth filters.
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Meas: Spectrum Noise
MEAS
Spectrum Noise

A

Measurement block computes noise using the receiver’s FPGAbased, real-time DSP.
MEAS
Spectrum Power A

Meas: Spectrum Power
Measurement block computes power vectors (complex power) using
the receiver’s FPGA-based, real-time DSP.
MEAS
Spectrum Voltage A

Meas: Spectrum Voltage
Measurement block computes spectral voltage vectors (complex
voltage) versus time using the receiver’s receiver’s FPGA-based, realtime DSP.

© Roos Instruments Inc.
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CONTROL PANELS
Real time control of the instruments in this TIM.

Graphical Programming | RI8587: 100kHz to 20GHz DSP Receiver

CONTROL PANEL
POWER DBM, VOLTAGE DBM, NOISE DBM/HZ, RMS
DBM, Path Gain
Click to update these measurements in real-time.

C ONTROL P ANELS 15 RI8587: 100MHZ TO 20GHZ RECEIVER

Receiver control panel shows real-time states and Power, Voltage,
Noise measurements made by the receiver.

© Roos Instruments Inc.

481
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RI8589: HIGH POWER
SUPPLY/PULSER
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TOPICS

Instruments Provided by this TIM
Instrument Diagram
Edit Panel Button Descriptions
Control Panel
Example Test Panels

Tap the links above to quickly access content

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as FetPulser in the panel dialog
windows.
Model and Name as it appears in the Tester Configuration:
• FetPulser, RI8589x Fet Pulser
NOTE: Multiple RI8589 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - FetPulser, FetPulser 2,
FetPulser 3, etc). The “x” in RI8589x denotes the model revision number.

© Roos Instruments Inc.
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BLOCK DIAGRAM 2.1
POLARITY
SWITCHING

IdssN

Roos Instruments, Inc - Cassini16

Block Diagram, Bulk Power FET Test Functions
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Subject to change without notice
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EDIT PANELS

PANEL: PULSE CONTROL

Graphical programming buttons and blocks are placed in test panels
to define instrument control settings and measurements for this
instrument.

Voltage

0

Voltage

E DIT P ANELS 21 RI8589: HIGH POWER SUPPLY/PULSER

Decimal notation input button that sets the amplitude value of the
pulse on the High-I VDD resource. The value is in units of volts with an
input range of 8V to 52V with a resolution of 20mV.

Power Enable

oﬀ

Power Enable
Drop down list button that controls the internal power supply used in
the pulse driver circuit. This button is used in conjunction with the
Voltage, Pulse Enable, Pulse, and/or Idss N buttons.
‘on’ turns the internal supply on for normal operation.
‘off’ turns the internal supply off.

Pulse Control buttons configure the high-current voltage pulse start

‘<18V’ configures the internal supply for low-voltage accuracy to
support pulse values from 6V to 18V.

time, pulse length, and voltage of the High-I VDD/VSS resources.
© Roos Instruments Inc.
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Output Polarity

oﬀ

Output Polarity

‘zero’ connects the High-I VSS pins to ground (0V) and disconnects
the High-I VDD from all internal circuits, leaving the resource pins
floating.

Drop down list button that sets the state of the High-I VDD and High-I
VSS pins relative to the internal high power pulser and bulk power
supplies via the polarity switching relays. See Block Diagram 2.1.
‘pos’ routes the positive side of the internal power supplies to the
High-I VDD pins and the negative (ground) terminal of the internal
power supplies to the High-I VSS pins.
‘neg’ routes the positive side of the internal power supplies to the
High-I VSS pins and the negative (ground) terminal of the internal
power supplies to the High-I VDD pins.
‘off’ is the default mode and disconnects all internal resources from
the High-I VDD and High-I VSS pins, leaving the pins in an open state.
‘aux’ disconnects the internal pulse driver and supplies from the HighI VDD and High-I VSS pins and closes the relay between the Aux (B1)
input pin and the Aux (B2) output pin. This mode is used to route an
auxiliary resource connected to the Aux (B2) input to the Aux (B1)
output pin (that is typically connected in parallel to the High-I VDD
pins).

Pulse Enable

oﬀ

Pulse Enable
Drop down list button that controls the relays connecting the internal
pulse drive circuit to the High-I VDD/High-I VSS pins. It is used in
conjunction with the Voltage and Pulse buttons.
‘on’ closes the relay that connects the pulse driver circuit to the pin
resources.
‘off’ opens the relay that connects the pulse driver circuit to the pin
resources.
NOTE: This button is commonly used in measure sequence groups to disconnect the
pulse driver circuit load from the High-I-VDD/High-I VSS pins while concurrently
measuring voltage, current, or temperature of the DUT.

‘test’ is for RI internal use only.
‘short’ configures the polarity relays to short the High-I VDD and HighI VSS pins together.
© Roos Instruments Inc.
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Output Range

oﬀ

Output Range
Drop down list button that sets the maximum output voltage range of
the current pulser. This configures/connects the internal power
supplies that drive the internal pulse circuitry.
‘off’ disconnects the internal power supplies from the pulse driver.
‘40v’ connects the internal 40 volt power supply to the pulse driver.

NOTE: When the supplied current exceeds the Pulse Ocp value, the pulse driver circuit
goes into shutdown by disconnecting from the output pins to prevent damage to the
DUT. To recover from the pulse driver shutdown mode, the ‘Pulse’ button must set to
‘off’ or the Pre Pulse button must be set to ‘Clr OCP’ in the test panel.

WARNING: When the Pulse Range mode is set to ‘500mA’ or
‘50mA’, the Pulse Ocp button value should be set to a value less
than or equal to the Pulse Range button to prevent damage to the
sense resistors of the internal current measurement module.

‘53v’ connects the internal 53 volt power supply to the pulse driver.
‘hi current’ connects both the 40 and 53 volt supplies in parallel with
the added capacitor bank to supply the maximum current capacity.
The maximum output voltage is 40 volts.

Pulse Ocp

10

Pulse Ocp
Decimal notation input button that sets the peak current limit (Over
Current Protection) on the pulse output in Amps. The maximum
current is 26 Amps with a set resolution of ~100mA. This button is
commonly used with the Pulse, Pulse Enable, and Pulse Range
buttons.
© Roos Instruments Inc.

Pulse Sink

oﬀ

Pulse Sink
Drop down list button that sets the pre-pulse current conditions on
the High-I VDD/High-I VSS pins.
‘off’ is the default mode that disables any pre-pulse current.
‘on’ configures the High-I VDD pins to pull a constant 10mA from the
output pins down to a voltage limit of -10V.
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Pulse Range

26A

NOTE: Exceeding the current of the Pulse Range value will result in erroneous
computed values of measured current.

Pulse Range
Drop down list button that sets the maximum expected current
amplitude for pulsed measurements, optimizing the dynamic range of
the internal ADC’s input capture. This button is used with the Pulse,
Pulse Enable, and Pulse Ocp buttons in conjunction with Current
and Current vs. Time measurement blocks.

Pre Pulse

oﬀ

Pre Pulse

‘10A’ sets the dynamic range of the measurement with a maximum
value of 10A.

Drop down list button that connects in an internal load to the pulse
driver circuit to stabilize voltage regulation for pulses less than 12
volts. Placing this button in a test panel with a value of ‘on’ with a
Pulse button set to ‘on’ in a premeasure preloads the voltage source
for 15ms.

‘500mA’ sets the dynamic range of the measurement with a
maximum value of 500mA.

‘on’ connects the internal load to the pulse driver before a pulse
event.

WARNING: When the ‘500mA’ mode is selected, the Pulse OCP
button must be set to a value of 1A or less to prevent damage to the
sense resistor of the internal current measurement module.

‘off’ is the default mode that disconnects the internal load to the pulse
driver before a pulse event.

‘26A’ is the default mode and maximum absolute current range.

‘50mA’ sets the dynamic range of the measurement with a maximum
value of 50mA.
WARNING: When the ‘50mA’ mode is selected, the Pulse OCP
button must be set to a value of 50mA to prevent damage to the
sense resistor of the internal current measurement module.

‘Clr OCP’ re-initiates/reconnects the pulse driver circuit to the output
pins after a current event exceeds the Pulse OCP value.
NOTE: Without a load connected for voltage values less than 12V, typically the initial
pulse voltage will be higher than the set value.

‘cal’ for RI internal use only
© Roos Instruments Inc.
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Pulse

oﬀ

Pulse
Drop down list button that defines the start point of a pulse in a
premeasure grouping and the stop point in a post measure group,
effectively defining the pulse duration. It is used in conjunction with
the Voltage and Pulse Enable buttons.

current from the DUT’s diode into the High-I VDD resource pins. The
maximum current setting is 10A.
NOTE: The voltage value on the High-I VSS resource in this mode is set by the series
22Ω resistance of the polarity switching network and the current setting of the Idss N
button.

‘on’ initiates the pulse and is placed in a premeasure group with a
sequence delay button to define the length of the pulse on condition.
‘off’ terminates the pulse and is placed in a pre or post measure
group to define the endpoint of the pulse.
NOTE: The Pulse button is only valid in premeasure and post measure groups.

Idss N

0

Idss N
Decimal notation input button that sets the current value for a drain
diode test. This button overrides the voltage setting for the Voltage
button to allow for the current value specified. This button sets the
polarity switching relay network (see Block Diagram 2.1) to force
current out of the High-I VSS resource pins and to sink the resulting
© Roos Instruments Inc.
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PANEL: HIGH VOLTAGE CONTROL

Hv 1 Output

oﬀ

Hv 1 Output

Hv 1

0

Hv 1
Decimal notation input button that sets the HV_OUT (HV1) resource
pin voltage. The input value is in units of volts with a range of -10V to
+65V and resolution of 5mV. This button is used in conjunction with
the Hv 1 Output and Hv 1 Current Range buttons.
NOTE: The HV_OUT (HV1) [C1] and SENSE (HV1) [C3] pins must be connected on
the device interface board to provide accurate voltage regulation.

Drop down list button that controls the solid-state relay between the
HV1 supply and HV_Out (HV1) resource pin.
‘off’ disconnects the supply from the HV1 resource pin.
‘on’ connects the HV1 supply to its output pin.
NOTE: The INTRLK (HV1) [C4] and INTRLK (HV1) [C5] interlock pins must be
connected by a device interface board to enable voltage output on the HV_Out (HV1)
pin.

Hv 1 Current Range

Hv 1 Enable

on

Hv 1 Enable
Drop down list button that controls the HV1 high voltage generator.
‘on’ activates the high voltage generator.
‘off’ disables the high voltage generator.

© Roos Instruments Inc.

20 mA

Hv 1 Current Range
Drop down list button that selects the maximum expected current for
the HV1 power supply for optimum measurement dynamic range.
This is used to select an internal sense resistor for measuring current
on the supply resource.
’20 mA’ selects the sense resistor for a maximum expected current of
20mA.
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’10 mA’ selects the sense resistor for a maximum expected current of
10mA.
’1 mA’ selects the sense resistor for a maximum expected current of
1mA.
‘100 uA’ selects the sense resistor for a maximum expected current of
100µA.

Hv 2 Enable

on

Hv 2 Enable
Drop down list button that controls the HV2 high voltage generator.
‘on’ activates the high voltage generator.
‘off’ disables the high voltage generator.

‘cal’ is for RI internal use only.

Hv 2 Output

Hv 2

0

Hv 2
Decimal notation input button that sets the HV_OUT (HV2) resource
pin voltage. The input value is in units of volts with a range of -5V to
+185V and resolution of 20mV. This button is used in conjunction with
the Hv 2 Output and Hv 2 Current Range buttons.

oﬀ

Hv 2 Output
Drop down list button that controls the solid-state relay between the
HV2 supply and HV_Out (HV2) resource pin.
‘off’ disconnects the HV2 supply from the resource pin.
‘on’ connects the HV2 supply to the resource pin.

NOTE: The HV_OUT (HV2) [C6] and SENSE (HV2) [C8] pins must be connected
on the device interface board to provide accurate voltage regulation.

© Roos Instruments Inc.

NOTE: The INTRLK (HV2) [C9] and INTRLK (HV2) [C10] interlock pins must be
connected by a device interface board to enable voltage output on the HV_Out (HV1)
pin.
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Hv 2 Current Range

Hv 3

20 mA

0

Hv 2 Current Range

Hv 3

Drop down list button that selects the maximum expected current for
the HV2 power supply for optimum measurement dynamic range.
This is used to select an internal sense resistor for measuring current
on the supply resource.

Decimal notation input button that sets the HV_OUT (HV3) resource
pin voltage. The input value is in units of volts with a range of -10V to
+65V and resolution of 5mV. This button is used in conjunction with
the Hv 3 Output and Hv 3 Current Range buttons.

’20 mA’ selects the sense resistor for a maximum expected current of
20mA.

‘off’ disconnects the HV3 supply from the resource pin.

’10 mA’ selects the sense resistor for a maximum expected current of
10mA.

‘on’ connects the HV3 supply to the resource pin.
NOTE: The HV_OUT (HV3) [D1] and SENSE (HV3) [D3] pins must be connected
on the device interface board to provide accurate voltage regulation.

’1 mA’ selects the sense resistor for a maximum expected current of
1mA.
‘100 uA’ selects the sense resistor for a maximum expected current of
100µA.
Hv 3 Enable

‘cal’ is for internal RI use only.

on

Hv 3 Enable
Drop down list button that controls the HV3 high voltage generator.
‘on’ activates the high voltage generator.
‘off’ disables the high voltage generator.
© Roos Instruments Inc.
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’1 mA’ selects the sense resistor for a maximum expected current of
1mA.
Hv 3 Output

oﬀ

Hv 3 Output
Drop down list button that controls the solid-state relay between the
HV3 supply and HV_Out (HV3) resource pin.
NOTE: The INTRLK (HV3) [D4] and INTRLK (HV3) [D5] interlock pins must be
connected by a device interface board to enable voltage output on the HV_Out (HV1)
pin.

Hv 3 Current Range

20 mA

‘100 uA’ selects the sense resistor for a maximum expected current of
100µA.
‘cal’ is for internal RI use only.

Measure

Hv1 V

Measure
Drop down list button that selects the resource and measurement
type. See Example E measurement test panels.

Hv 3 Current Range

‘Hv1 V’ measures voltage of the HV1 supply and is commonly used
with the Voltage and Voltage vs Time measurement blocks.

Drop down list button that selects the maximum expected current for
the HV3 power supply for optimum measurement dynamic range.
This is used to select an internal sense resistor for measuring current
on the supply resource.

‘Hv1 Vlo’ measures voltage on the HV1 supply using the enhanced
sensitivity mode for improved accuracy of voltage values less than
10V. This setting is commonly used with the Voltage and Voltage vs
Time measurement blocks.

’20 mA’ selects the sense resistor for a maximum expected current of
20mA.

‘Hv1 I’ measures the current of the HV1 supply and is commonly used
with the Current and Current vs Time measurement blocks.

’10 mA’ selects the sense resistor for a maximum expected current of
10mA.

‘Hv2 V’ measures voltage of the HV2 supply and is commonly used
with the Voltage and Voltage vs Time measurement blocks.

© Roos Instruments Inc.
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‘Hv2 Vlo’ measures voltage on the HV2 supply using the enhanced
sensitivity mode for improved accuracy of voltage values less than
20V. This setting is commonly used with the Voltage and Voltage vs
Time measurement blocks.
‘Hv2 I’ measures the current of the HV2 supply and is commonly used
with the Current and Current vs Time measurement blocks.
‘Hv3 V’ measures voltage of the HV1 supply and is commonly used
with the Voltage or Voltage vs Time measurement blocks.
‘Hv3 Vlo’ measures voltage on the HV3 supply using the enhanced
sensitivity mode for improved accuracy of voltage values less than
10V. This setting is commonly used with the Voltage or Voltage vs
Time measurement blocks.
‘Hv3 I’ measures the current of the HV3 supply and is commonly used
with the Current or Current vs Time measurement blocks.
‘Pulse V’ measures the pulse voltage across the High-I VDD and
High-I VSS resource path via the internal pulse driver circuit. This
setting is commonly used with the Voltage or Voltage vs Time
measurement blocks.
‘Pulse V Low’ measures pulse voltage across the High-I VDD and
High-I VSS resources via the internal pulse driver circuit using the
enhanced sensitivity mode for improved accuracy of voltage values
less than 5V. This setting is commonly used with the Voltage or
Voltage vs Time measurement blocks.

© Roos Instruments Inc.
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‘Pulse I’ measures the pulse current flowing through the High-I VDD
and High-I VSS resource path via the internal pulse driver circuit. This
setting is commonly used with Pulse, Pulse Enable, and Pulse
OCP buttons in conjunction with Current or Current vs Time
measurement blocks.
‘VdssN’ measures the voltage across the High-I VDD and High-I VSS
resources. This setting is commonly used with the Voltage or
Voltage vs Time measurement blocks.
‘IdssN’ measures the pulsed current through the High-I VDD and
High-I VSS resource path with a DUT’s diode on.This setting is
commonly used with Current or Current vs Time measurement
blocks.
‘Temp’ returns the computed temperature using the DUT as a
temperature diode during a pulse event on the High-I VDD and High-I
VSS resource path. This setting is used with the Voltage or Voltage
vs Time measurement blocks which return a temperature value. A
Convert button from the ‘System > General Calculation’ instrument is
required to convert the datatype to an RiTemperature when saving to
the worksheet in units of degree C.
NOTE: Because the absolute temperature characteristics of different DUTs vary, the
‘Temp’ mode is used for computing relative temperature change (heating and cooling
effects) between successive measurements of the DUT.
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Delay

Meas Width

0

1000 u

Delay

Meas Width

A decimal notation input button that defines the duration of time
between the Trigger: start and the Voltage vs. Time measurement
capture start. The value of the Delay button therefore defines the MIN
X value of the plot window.

Decimal notation input button that defines the duration of the capture
window of Voltage vs. Time or Current vs. Time measurements in
units of seconds at a fixed capture rate of 1Msps.
NOTE: Feature only available on RI8589B models.

NOTE: Feature only available on RI8589B models.

MEAS
Voltage

Trigger

oﬀ

Trigger
Drop down list button that is used within a pre-measure group to
initiate a trigger for Voltage vs. Time or Current vs. Time
measurements. The ‘start’ option initiates the capture collection. The
‘off’ disables the trigger. This button is used in conjunction with the
Trigger Ref, Trigger Spacing, and Meas Ref buttons found in the
System instrument.

A

Meas: Voltage
Measurement block that returns the voltage from the resource
designated by the Measure button as a ‘RiVoltageD’ datatype. This
block is used in conjunction with the FETPulser instrument’s Meas
Rate button and the System instrument’s Averages button to define
the measurement capture parameters.

NOTE: Feature only available on RI8589B models.

© Roos Instruments Inc.
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MEAS

MEAS

Voltage vs Time

Current vs Time

A

A

Meas: Voltage vs Time

Meas: Current vs Time

Measurement block that returns a voltage value indexed by time from
the resource designated by the Measure button as a
‘RiVoltageVsTimeInt’ datatype. This block is used in conjunction with
the FETPulser instrument’s Meas Rate, Trigger and Delay buttons
to define the measurement capture parameters.

Measurement block that returns a current value indexed by time from
the resource designated by the Measure button as a
‘RiVoltageVsTimeInt’ datatype. This block is used in conjunction with
the FETPulser instrument’s Meas Rate, Trigger and Delay buttons
to define the measurement capture parameters.

NOTE: Feature only available on RI8589B models.

NOTE: Feature only available on RI8589B models.

MEAS
Current

A

Meas: Current
Measurement block that returns the current from the resource
designated by the Measure button as a ‘RiCurrentD’ datatype. This
block is used in conjunction with the FETPulser instrument’s Meas
Rate button and the System instrument’s Averages button to define
the measurement capture parameters.

© Roos Instruments Inc.
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PANEL: RELAY CONTROL
Relay 1

oﬀ

Relay 1
Drop down list button that provides a relay control voltage of +5V on the RLY1 CNTRL [I2] pin. The drive current capacity is 8mA.
NOTE: Relay GND pins must be connected to the external relay circuit to provide a return path. The 12V [I10] pin provides the supply for an external electromechanical relay.

Relay 2/3/4/5/6/7/8
See Relay 1 description as it applies to the corresponding relay.

© Roos Instruments Inc.
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EXAMPLE E RI8589 TESTPLAN EXAMPLES

The above example demonstrates how to set the HV1 supply to 50V and measure the current flowing
through HV1.

© Roos Instruments Inc.
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CONTROL PANELS
Real time control of the instruments in this TIM.

C ONTROL P ANELS 16 RI8589: HIGH POWER SUPPLY/PULSER

Pulse Control allows real-time control of the High-I VDD/VSS pulse
settings.
© Roos Instruments Inc.
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RI8594: HIGH PERF.
WAVEFORM GENERATOR &
MEASURE
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TOPICS

Instruments Provided by this TIM
Configuration Panel
Instrument Diagram with Edit Buttons
Edit Panel Button Descriptions
Control Panel

Tap the links above to quickly access content

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as LowNoiseClock,
Oscilloscope, SineGen, and Waveform in the panel dialog
windows.
Model and Name as it appears in the Tester Configuration:
• LowNoiseClock, Ri8585x Low Noise Source
• Oscilloscope, RI74105x Hi Spd scope/counter/BER
• SineGen, Ri7403x Dual Sine Source
• Waveform, Ri74211x Complex Waveform
NOTE: Multiple RI8594 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e Oscilloscope,SineGen,Waveform,LowNoiseClock;
Oscilloscope2,SineGen2,Waveform2,LowNoiseClock2;
Oscilloscope3,SineGen3,Waveform3,LowNoiseClock3, etc).
The “x” in RI8594x denotes the model revision number.

© Roos Instruments Inc.
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CONFIGURATION PANELS
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LOWNOISECLOCK

Configure the Instruments in this TIM.

The LowNoiseClock instrument provides one resource allocation in
the configuration panel: Low Noise out-pin:C3.

C ONFIGURATION P ANELS 6 RI8572: WAVEFORM GENERATOR &

NOTE: Green buttons can only be configured with a fixture definition.

MEASURE

OSCILLOSCOPE
The Oscilloscope instrument provides two resource allocations in the
configuration panel: Wf7 Scope Ch2 RE-pin:C5 and Wf6 Scope
Ch1 IM-pin:C1.
NOTE: Green buttons can only be configured with a fixture definition.

SINEGEN
The SineGen instrument provides two resource allocations in the
configuration panel: Wf9 Sine Out- pin:C8 and Wf8 Sine Outpin:C4.
NOTE: Green buttons can only be configured with a fixture definition.
LowNoiseClock shows connections from this instrument.

WAVEFORM
The Waveform instrument provides three resource allocations in the
configuration panel: Edit Patterns, Wf 3, Wf 2.
© Roos Instruments Inc.
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NOTE: Green buttons can only be configured with a fixture definition.

IMAGE 2.1 EDIT PATTERNS DIALOG
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Edit Waveforms
This button displays the current waveform/pattern loaded into the
Waveform’s arbitrary waveform generator. Clicking on the button
opens the Edit Patterns window (See Image 2.1). The left pane of the
Edit Patterns window displays a list of all waveforms that have been
loaded into the instruments on-board memory. Selecting any of these
waveforms displays more information in the right pane: start address
in memory, number of samples, sample clock rate, peak magnitude,
RMS magnitude indB, and more information about the original
waveform file from Guru. New waveforms can be added to the list
using the Pattern pull down menu at the top left of the window and
then selecting “add from Guru.” The user can specify a different
pattern name from the Guru version for test program purposes.
NOTE: Waveforms are programmed into memory sequentially. While waveforms can be
removed from the list view by selecting them and using the menu option “Pattern >
remove”, they are not erased from the memory. To make used memory available again,
all waveforms must be purged using the “Pattern > Erase > All Patterns” menu option.

© Roos Instruments Inc.
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EDIT PANELS
Automated control of the instruments in this TIM with use by the Test
Plan Editor.
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LOWNOISECLOCK
PANEL: STATE
Frequency

100

Frequency

E DIT P ANELS 22 RI8572: WAVEFORM GENERATOR & MEASURE

Decimal notation input button that sets the source output frequency in
MHz. The frequency range is 0 to 400 MHz.
NOTE: The button’s value is dependent on the Source button selected. For frequency
values between 0 to 100 MHz, for 100 MHz it is 100 MHz and with a the divider, it is
5, 6.25, 10, 12.5, 20, 25, 50 MHz.

Amplitude

0

Amplitude
Decimal notation input button that sets the low-noise clock signal
amplitude in units of dBm. The range of valid input values are -60 to
+10.

© Roos Instruments Inc.
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Rf State

oﬀ

Rf State
Drop down list button makes the clock signal active (‘on’) or inactive
(‘off’) at the clock output port located at position C3 of the instrument
test head.
Source

source

Source
Drop down list button that sets the reference source for the low-noise
clock.
The ‘source’ option selects the Direct Digital Synthesizer (DDS) that
sources frequency values between 200 Hz to 400 MHz.
The ‘100 MHz’ option selects the ultra-low phase noise 100 MHz
crystal oscillator.
The ‘divider’ option selects the 100 MHz crystal oscillator with
frequency division to provide the highest phase noise performance at
set frequency values of 5, 6.25, 10, 12.5, 20, 25, 50 and 100 MHz.
NOTE: The typical phase noise performance of the 100 MHz oscillator is approximately
148 dBc/Hz. The ‘divider’ option has typical noise performance of approximately 148
dBc/Hz + 20log (100 MHz/Frequency) dBc/Hz.

© Roos Instruments Inc.
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The ‘ber’ setting performs a bit error rate calculation. A predefined,
pseudo-random gray code bit stream is emitted from the userselected port. The digitizer captures the return signal after a userspecified wait or trigger time and then calculates the bit error rate.

OSCILLOSCOPE
PANEL: SCOPE
Measure Type

counter

Measure Type
Drop down list button that sets the operation type for the oscilloscope
instrument. This button is found in the ‘scope’, ‘counter/ber’, and
‘time analyzer’ subsystem panes of the oscilloscope. Buttons and
blocks found in these subsystem panes are settings or parameters
used by the corresponding function choice of this button. The
description of each function is as follows:
The ‘scope’ setting is an oscilloscope function optimized for signal
capture of sinusoidal waveforms from 1 Hz to 80 MHz.
The ‘digitizer’ setting is a digitizing oscilloscope function for arbitrary
signals from 1 Hz to 80 MHz.
The ‘counter’ setting performs frequency counting operation of
sinusoidal, square-wave, and pulse signals. This function requires a
voltage reference or trigger and several periods of the input signal to
accurately compute signal frequency.

The ‘reciprocal’ setting performs a signal frequency count using a
reciprocal count method optimized for faster computation of signals
below 1 MHz. The reciprocal counter uses the input signal as a trigger
and counts the internal clock edges across one period of the input
signal.
Input Freq

1M

Input Freq
Decimal notation input button that sets the frequency of the expected
input signal in units of Hz. The expected input frequency value
enables accurate signal reconstruction of input signals with frequency
values greater than the Nyquist sample rate of the oscilloscope.
NOTE: This button enables a Cassini system compiler directive to compensate for signal
path calibrations for a known frequency value.

The ‘time analyzer’ setting performs timing computations of signal
events using a trigger and a user-defined measurement timing
window.
© Roos Instruments Inc.
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Samples

MEAS

100

Samples

Complex vs Time A

Decimal notation input button that sets the total number of samples in
the oscilloscope capture window.
NOTE: Maximum number of samples is 2000.

Sample Rate

1M

Meas: Complex vs Time
Measurement block that computes an RiComplex Voltage vs Time
result as a ‘RiComplexVVsTimeInt’ datatype. Using port WF7 as the
real (in-phase) signal component and the WF6 port as the imaginary
(quadrature) signal component, the block computes a voltage vector
representation of an I/Q baseband signal by digitizing each channel
independently and then time-interleaving the channels.

Sample Rate
Decimal notation input button that sets the oscilloscope’s sample rate
in units of Hz.
NOTE: Maximum sample rate is 80 mS/s

© Roos Instruments Inc.
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PANEL: COUNTER/BER

Data Polarity

normal
Measure Time

0

Measure Time
Decimal notation input button that sets the measurement window for
counter measurement gating in units of seconds. Maximum time limit
is 2000*Sample Rate.

Data Polarity
Drop down list button that sets the data input polarity for counter or
bit error rate measurements. The ‘normal’ option is positive or rising
edge count/trigger. The ‘inverted’ option is falling or negative edge
count/trigger.
Data Input

Wf6

Edge Detect

oﬀ

Edge Detect
Drop down list button that sets the edge detector mode. Option ‘off’
deactivates edge detection. The ‘rising’ option sets the detector to
generate edges, trigger, or count on rising edge event types in the
data input. The ‘both’ option sets the detector to generate edges,
trigger, or count on both rising and falling edge event types in the data
input.
NOTE: This button must be set to either ‘rising’ or ‘both’ for event counting.

Data Input
Drop down list select button that selects the instrument resource port
for measurements. The option ‘Wf6‘ sets WF6, located at port
position C1 on the instrument head, as input to the digitizer. The
option ‘Wf7‘ sets WF7, located at port position C5 on the instrument
head, as input to the digitizer. The option ‘off‘ internally disconnects all
input ports/paths from the digitizer instrument.
Clock Polarity

normal

Clock Polarity
Drop down list button that sets the polarity of the clock. The ‘normal’
option is positive or rising edge count/trigger. The ‘inverted’ option is
falling or negative edge count/trigger.

© Roos Instruments Inc.
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Clock Input

Input Term

oﬀ

hiZ

Clock Input

Input Term

Drop down list select button selects the clock input for bitt error rate
measurements. The ‘Wf6’ sets the signal available at the WF6 port
located at position C5 on the instrument head as the clock input. The
‘Wf7’ sets the signal available at the WF7 port located at position C1
on the instrument head as the clock input. The ‘off’ option uses the
instruments internal clock.

Drop down list button sets the input termination value to ‘hiZ’
representing a high impedance value of 10 kΩ or ’50 ohm’ for 50 Ω.

Wf7 Trigger Level

1

Wf 7 Trigger Level
Decimal notation input button that sets the trigger comparator level
voltage for WF7. Valid range of values between ±0.4 V.

Holdoff

0

Holdoff
Decimal notation input button that sets the time in seconds that the
edge/gate is disabled after sensing a trigger event. The range of
values can be set between 25 µs and 150 ns.
NOTE: Typically set to the rise time of the edge.

Wf6 Trigger Level

MEAS

1

Wf 6 Trigger Level
Decimal notation input button that sets the trigger comparator level
voltage for WF6. Valid range of values between ±0.4 V

Frequency

A

Meas: Frequency
Measurement block that computes signal frequency of the selected
input port set by Data Input button as a 'RiFrequency' datatype. The
Measure Time button sets the capture window time.

© Roos Instruments Inc.
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PANEL: DIGITIZER

NOTE: A minimum of two edge/rise or fall time events is required for accurate
frequency count.

Delay

0

MEAS

Delay
Period

A

Decimal notation input button that sets the delay in units of seconds
with a resolution of 1 µs before a digitizer measurement or to offset
the start of a record. Maximum delay value is 2000*Sample Rate.

Meas: Period
Measurement block that computes the time between signal edges of
the selected input port set by Data Input button as a 'RiTimeD'
datatype. The block uses the Measure Time button to set the
capture window time.

Sample Rate

NOTE: A minimum of two edge/rise or fall time events is required for accurate period
measurement.

Decimal notation input button that sets the digitizer sample rate in Hz.
The valid sample rate range is 1Hz to 80MHz.

Sample Rate

0

Trigger

MEAS
Bit Error Rate

stop
A

Meas: Bit Error Rate
Measurement block computes the ratio of errors to bits in a bitstream
of the selected input port set by Data Input button as a
'RiFrequency' datatype. The Measure Time button sets the capture
window time.
© Roos Instruments Inc.

Trigger
Drop down list button that is used within a pre-measure group to set
the start and stop times of signal captures or bit error rate
measurements. The ‘start’ option triggers an event collection. The ‘off’
option ends the event collection.
NOTE: This button is used in conjunction with triggered measurements types.
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MEAS
Samples

Triggered Digitizer A

0

Samples

Meas: TriggeredDigitizer

Decimal notation input button that sets the measurement record
length for the digitizer.

Measurement block computes multiple samples of an I/Q input
signal’s voltage vector using a pre-measure group trigger button as a
'RiComplexVVsTimeInt' datatype. Sample points begin at the system
measure reference plus any user specified delay using the Delay
button. The block computes and time-interleaves the two signal
channels into RiComplexVoltage values.

NOTE: Maximum number of samples is 2000.

MEAS
Triggered Voltage A

Meas: Triggered Voltage
Measurement block computes a single voltage vector sample from an
I/Q input signal voltage vector using a pre-measure group trigger
button as a 'RiComplexVVsTimeInt' datatype. The sample point is set
by the system measure reference plus any user specified delay using
the Delay button. The block generates a single RiComplexVoltage
value.

© Roos Instruments Inc.
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PANEL: TIME ANALYZER

Measure Time

0

Measure Time
Trigger

stop

Trigger

Decimal notation input button that sets the measurement window for
counter measurement gating in units of seconds. Maximum time limit
is 2000 samples*Sample Rate

Drop down list button that is used within a pre-measure group to set
the start and stop times of signal captures or bit error rate
measurements.
The ‘start’ option triggers an event collection.
The ‘stop’ option ends the event collection.
The ‘berStart’ option triggers an event collection for bit error rate
measurements. This is used in conjunction with the Bit Error Rate
measurements block and Wf6 Trigger Level and/or Wf7 Trigger
Level button/s.

MEAS
Triggered Time Stamps A

Meas: Triggered Time Stamp
Measures events from the counter system. Generates as a 'RiTimeD'
datatype with an entry for each edge.Measure is started and stopped
by the Trigger in the pre-measure. Uses MeasureTime for the length to
examine. Samples must exceed the measure time such that several
samples occur after the time completes.

The ‘berStop’ option ends an event collection for bit error rate
measurements. This is used in conjunction with the Bit Error Rate
measurements block and Wf6 Trigger Level and/or Wf7 Trigger
Level button/s.
NOTE: This button is used in conjunction with triggered measurements types.

© Roos Instruments Inc.
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WAVEFORM

NOTE: The output waveform plus the offset cannot exceed ±3 volts.

PANEL: STATE
Wf2 Amplitude

Wf3 Amplitude

0

Wf 3 Amplitude
Decimal notation input button that sets the amplitude of the open
circuit peak voltage of the in-phase (real) signal component. The
signal is available at WF3 located at position C6 on the instrument
head. Maximum value is 2.5 volts peak.

0

Wf 2 Amplitude
Decimal notation input button that sets the amplitude of the open
circuit peak voltage of the quadrature (imaginary) signal component.
The signal is available at WF2 located at position C2 on the
instrument head. Maximum value is 2.5 volts peak.
Wf2 Phase

Wf3 Phase

0

Wf 3 Phase
Decimal notation input button that sets the waveform delay in units of
degrees of the in-phase (real) signal at WF3 located at position C6 on
the instrument head. The range of values is ±180.

0

Wf 2 Phase
Decimal notation input button that sets the waveform delay in units of
degrees of the quadrature (imaginary) signal at WF2 located at
position C2 on the instrument head. The range of values is between
±180 degrees.

Wf3 Offset

0

Wf 3 Offset
Decimal notation button that sets the signal offset voltage for the
waveform at WF3 located at position C6 on the instrument head.
Available range is ±3 V.
© Roos Instruments Inc.
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Wf2 Offset

0

Wf 2 Offset
Decimal notation button that sets the signal offset voltage for the
waveform at WF2 located at position C2 on the instrument head.
Available range is between ±3 V.
NOTE: The output waveform plus the offset cannot exceed ±3 volts.

1 MHz and a Translate value of 100 kHz generates tones at 900 kHz
and 1.1 MHz. Range of Frequency ± Translate values must remain
between 1 Hz - 20 MHz.
NOTE: The translate button provides direct control of the arbitrary waveform
generator’s DDS and can be used to generate a sinusoidal signal on WF2/WF3 up to
80 MHz by setting the Sample Rate button to ‘1.56 ns’, the Frequency button to 0 Hz,
and the Wf2/Wf3 Amplitude button to the desired level. This multipurpose feature can
also be used to generate low frequency, two-tone signals for intermodulation
measurements.

Frequency

Type

100000

none

Frequency

Type

Decimal notation input button that sets the waveform frequency in
units of Hz. When modulating the signal/s this button sets the center
frequency. The valid input values are 1000 to 35000000 (1 kHz to 35
MHz).

A drop down list button that outputs a two-channel, baseband
waveform on WF2 (quadrature/imaginary) and WF3 (in-phase/real)
from built-in modulation waveform types:

Translate

0

‘Quad’ - Quadrature sinusoidal waveforms (WF3 leads WF2 in phase
by 90 degrees).
‘Fast Quad’ - This mode is no longer supported.

Translate
Decimal notation input button that generates two sinusoidal tones on
WF2 and/or WF3 on either side of the Frequency button value by a
user-defined value in units of Hz. For example, a Frequency value of
© Roos Instruments Inc.

‘Sine’ - produces a sinusoidal waveforms on WF6 and/or WF7 with
parameters defined by the user.
‘Dual Sine’ - This mode is no longer supported.
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“SSB Dual Sine” - Single sideband, dual sine waves on WF6/WF7.
This mode produces two sinusoidal waveforms on a single channel
specified by the user with Frequency 1= Frequency setting, and
Frequency 2=Frequency * Frequency Ratio.
‘SqWave’ - produces a square-wave signal on WF6 and/or WF7 with
parameters defined by the user.
‘modulation’ - produces a modulated waveform using the button
parameters found in the modulation pane of the waveform instrument.
‘file’ - This mode is no longer supported.
‘internal file’ - enables a user-defined signal specified by the
Waveform File button in the edit panel. The list of waveforms in the
Waveform File button can be edited by adding or removing
waveform files to the TIM from Guru via the Edit Patterns button in
the Configuration Panel.

produces a tone at 2 MHz and 2.5 MHz. Range of valid inputs is 1 to
2.
Sample Rate

50 ns

Sample Rate
A drop down list button that sets the time between the waveform
data’s next sample output. Sample rates options are “10 μs”(100 kHz)
,“1 μs” (1 MHz), “100 ns” (10 MHz), ’50 ns’ (20 MHz), ’25 ns’ (40
MHz), ‘12.5 ns’ (80 MHz), ‘6.25 ns‘ (160 MHz), ‘3.125’ (320 MHz),
and ‘1.56 ns’ (640 MHz).
For ‘sine’, ‘quad’, and ‘SSB Dual Sine’, the Sample Rate must be
typically Sample Rate ≥ 8*Frequency for accurate signal generation.
NOTE: For the “Pattern” type files the maximum sample rate is ‘25 ns’.

Max Samples

Waveform Ratio

1000

1.25

Waveform Ratio

Max Samples

Decimal notation input button that used with the ‘SSB Dual Sine’
mode to generate two sinusoidal tones at frequency values that are a
ratio value of each other on a single channel for WF6 or WF7. For
example, a Frequency value of 2 MHz and Waveform Ratio of 1.25

Decimal notation input button that sets the number of samples in the
emitted waveform. The maximum number of samples is 2000.

© Roos Instruments Inc.
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Mode

Waveform File

run

none

Mode

Waveform File

Drop down list button that enables and/or triggers a burst of an
emitted waveform.

Drop down list button that selects a waveform from the preloaded
user-defined waveforms on the instrument.

The ‘run’ value is used in global defaults or section defaults or within a
test panel to initiate a waveform.
The ‘stop’ value is used in global defaults or section defaults or within
a test panel to cease a waveform.
The ‘pmStart’ value is used to trigger a burst of the waveform with a
precision start time designated by the user within a test panel using a
pre-measure sequence grouping.
The ‘pmStop’ value is used to trigger the end of a waveform burst
with a precision stop time designated by the user within a test panel
using a post-measure sequence grouping.
The ‘trigger’ value is used to start a waveform burst with a pre-set
start time of 0 and is terminated by the user within a test panel using
a ‘pmStop’ in the post-measure sequence grouping.
NOTE: ‘pmStart” and ‘pmStop’ must be used together within a test panel for the desired
result of syncing the waveform with an event or user start time.

© Roos Instruments Inc.
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PANEL: MODULATION

Mod Index

1.0
Filter

none

Filter
A drop down list button that selects a digital filter type to be applied to
the waveform. Built-in types include: “Raised Cosine”, “Gaussian”,
“GMSK”, or a user-defined filter type provided by the Filter File
button.
Filter Bw

1.0

Mod Index
A decimal notation input button that sets the ratio of the excursions of
the modulated signal to the signal level of the unmodulated carrier in
the time domain.
Data Bits

100

Data Bits
An integer value button that sets the number of data points per
record.

Filter Bw
Data Rate

A decimal notation input button that sets the ratio of the selected
filter’s bandwidth with the symbol bandwidth.
Filter Taps

0

1000000

Data Rate
An integer value button that sets the output data point rate in units of
Hz

Filter Taps
Modulation Type

Decimal notation input button that sets the total number of digital filter
coefficients.

none

Modulation Type
A drop down list button that selects a modulation from the built-in
standards: “Ran FSK” - Random Frequency Shift Keying, “8PSK” - 8

© Roos Instruments Inc.
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Symbol Phase Shift Keying, “Edge”, “QPSK” Quadrature Phase Shift
Keying, “FM Tone”, and “AM Tone”

SINEGEN
PANEL: STATE

Filter File

none

Frequency Wf 8

Filter File

1

A drop down list button that selects the file name of a user-defined
digital filter taps or coefficients file. The maximum number of
coefficients is 200.

Frequency Wf 8
Decimal notation button that sets the output sine wave’s frequency in
MHz. The range of values are 1kHz to 100MHz.

Prn Type

Amplitude Wf 8

none

Prn Type

0

Amplitude Wf 8

A drop down list button that selects the size of the pseudo random
number seed used in the sequence generator. i.e “PN5”, “PN7”,
“PN9”, etc.
Data Delay

0

Decimal notation input button that sets the amplitude of the opencircuit, peak-to-peak voltage of the in-phase (real) signal component.
The signal is available at WF8 located at position C4 on the
instrument head. Input value is peak-to-peak voltage (i.e - a value of 2
results in a +1V to -1V signal). Maximum value is 2.5 volts.
Offset Wf 8

Data Delay
A decimal notation input button that sets the data output delay in
units of seconds with a resolution of 1 µs.

0

Offset Wf 8
Decimal notation button that sets the signal DC offset voltage for the
waveform at WF8 located at position C4 on the instrument head.

© Roos Instruments Inc.
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NOTE: The output waveform plus the offset cannot exceed ±3 volts.

NOTE: The output waveform plus the offset cannot exceed ±3 volts.

Frequency Wf 9

1

Frequency Wf 9
Decimal notation button that sets the output sine wave’s frequency in
MHz. The range of values are 1kHz to 100MHz.
Amplitude Wf 9

0

Amplitude Wf 9
Decimal notation input button that sets the amplitude of the opencircuit, peak-to-peak voltage of the quadrature (imaginary) signal
component. The signal is available at WF9 located at position C8 on
the instrument head. Input value is peak-to-peak voltage (i.e - a value
of 2 results in a -1 V to +1 V signal). Maximum value is 2.5 volts.
Offset Wf 9

0

Offset Wf 9
Decimal notation button that sets the signal DC offset voltage for the
waveform at WF9 located at position C8 on the instrument head.

© Roos Instruments Inc.
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CONTROL PANELS
Real time control of the instruments in this TIM.
See Control buttons.

Graphical Programming | RI8594: High Perf. Waveform Generator &

OSCILLOSCOPE
SCOPE
MEAURE, RMS DFT, Y PARAMETER, Y FORMAT, /DIV
Update the graph with measured values in real-time.

COUNTER CONTROL
C ONTROL P ANELS 17 RI8594: HIGH PERF. WAVEFORM
Edge Period, COUNTER FREQ, COUNTER
Click to update measurement in real-time.

© Roos Instruments Inc.
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SECTION 19

RI8595: 700MHZ TO
6GHZ POWER AMPLIFIER

Graphical Programming | RI8595: 700MHz to 6GHz Power Amplifier

TOPICS

Instruments Provided by this TIM
Configuration Panel
Setup & Operation
Software Control

Tap the links above to quickly access content

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument is this TIM appears as PowerAmp in panel dialog
windows.
Model and Name as it appears in the Tester Configuration:
• PowerAmp, Ri8595B Pwr Amp 20W 6GHz
NOTE: Multiple RI8595 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in configuration panels (i.e - PowerAmp, PowerAmp2, PowerAmp3, etc).

Graphical Programming | RI8595: 700MHz to 6GHz Power

CONFIGURATION PANELS
The configuration panel displays the resource port mapping of the
PowerAmp instrument. Reference the Device Connection Editor
tutorial in Chapter 1 | Section 10 - Software: Environment & Tools for
more information about resource port mapping.

C ONFIGURATION P ANELS 7 RI8595: 700MHZ TO 6GHZ POWER
AMPLIFIER

The input and output port connections to/from the Power Amplifier TIM
(shown in green) must be defined by a fixture definition.

© Roos Instruments Inc.
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SETUP & OPERATION

SOFTWARE CONTROL

The RI8595 power amplifier is designed to operate as a constant gain
amplifier for the RI8508 RF Source. The RF Input (C1) port of the
RI8595 must be connected to either the Output1 (C5) or Output2 (C1)
port of the RI8508 RF Source. The RF Output (C5) port of the RI8595
can be connected to standard RF interconnect within the fixture to
either a DIB interface signal launch or bulkhead type connector.

The PowerAmp instrument has no graphical buttons in the Editor or
Control panels; It functions as constant gain amplification for the
RI8508 RF Source. A Fixture Definition with connections from the
RI8508’s output to the RI8595 input port and the signal path from the
output port of the RI8595 through the fixture to the DIB interface is
required to use this TIM. This allows the software to define a
calibration path between the instruments that includes the signal loss
through the cabling and the gain of the amplifier. The signal path
definition allows the software to automatically adjust the RI8508’s set
power to achieve a user-specified signal power at the output of the
amplifier/DIB interface using the RFSource instrument Power button.
The path definition also enables the software to automatically limit the
maximum allowable power from the RF Source to not exceed the
maximum input power ratings of the power amplifier.

CAUTION: Exceeding the power amplifier’s maximum allowable input signal will cause
an over current condition in the TIM slot and the test system will deactivate the 48V
supply to the TIM slot.
A system startup must be performed to recover the disabled slot.

WARNING: The output port must be connected to a load or
termination, when an input signal is supplied to the power
amplifier TIM. An output port VSWR condition of 4:1 or greater
during operation will result in permanent damage to the internal
circuitry of the power amplifier.

NOTE: This instrument requires software patch 287 (GF10RC2A.287).
View Figure 1.56 and Figure 1.57 for more information on software shortcuts, updates,
and patches.

CAUTION: Without an active fixture definition (that includes an input port connection
to the PowerAmp instrument) in the System Configuration, the input signal to the power
amplifier can exceed the maximum allowable power causing the test system to deactivate
the 48V supply to the TIM slot the RI8595 occupies.
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SECTION 20

RI8604: 71GHZ TO
86GHZ TESTSET

Graphical Programming | RI8604: 71GHz to 86GHz TestSet

TOPICS

Instruments provided by this TIM
Instrument Diagram with Edit Buttons
Edit Panel Button Descriptions
Control Panel

Tap the links above to quickly access content

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as Test Head77 in the panel dialog
windows. Model and Name as it appears in the Tester Configuration:
• Test Head77, Ri8604x 81 GHz Test Set
NOTE: Multiple RI8604 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - Test Head77, Test
Head772, Test Head773, etc). The “x” in RI8604x denotes the model revision number.

© Roos Instruments Inc.
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I NSTRUMENT B UTTON D IAGRAM 2.14: RI8604A
Roos Instruments, Inc - Cassini

The WF1 and WF2 frequency/power settings are
controlled by the driving source. For example, if the
Source1 TIM is driving the W1 port, then the
Frequency and Power buttons for Source1 will
define the settings.

Block Diagram
RI8604A
71-86 GHz 2-Port-1-Path TIM
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EDIT PANELS
Automated control of the instruments in this TIM with use by the Test
Plan Editor.

Graphical Programming | RI8604: 71GHz to 86GHz TestSet

PANEL: RF SETUP
The measure frequency of the RI8604 is set by the RI8581/RI8587
Receiver TIM’s Frequency button in conjunction with a fixture
definition defining a connection between one of the Receiver’s IF
In and LO Out ports and the RI8604’s LO In [C3] and IF Out [C6]
ports.

E DIT P ANELS 23 RI8604: 71-86GHZ TEST SET

Parameter

none

Parameter
Drop down list button that designates a coupler port that will be
routed to the IF switching network for measuring incident/reflected
waves and/or computing s-parameters.
The ‘none’ selection disconnects all IF resources from the
downstream receiver chain.
The ‘a1‘ selection routes the down-converted IF signal from the
incident signal (a1 denoted as the ‘a’ port of the coupler in Instrument
Button Diagram 2.14) of the W1 71-86GHz port to the downstream
receiver chain.

Testhead77 RF Setup panel provides instrument setup states.

© Roos Instruments Inc.

The ‘b1’ selection routes the down-converted IF signal from the
reflected signal (b1 denoted as the ‘b’ port of the coupler in
Instrument Button Diagram 2.14) of the W1 71-86GHz port to the
downstream receiver chain.
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The ‘b2’ selection routes the IF signal from the down-converted W2
71-86GHz port (b2 signal ) to the downstream receiver chain.

Rf State

oﬀ

Rf State

NOTE:
a1 is the incident wave to the input port of the device under test.
b1 is the reflected wave from the input port of the device under test.
b2 is the reflected wave from the output port of the device under test.

A drop down list button that sets the state of the 8x frequency
multiplier in the source path from the Drive in (C1) input port.
The ‘on’ selection connects the source path from the Drive in (C1)
port to the microwave multiplier and out of the W1 71-86GHz output
port.

Power

0

Power
Decimal notation input button that controls the step attenuator in the
Drive In (C1) path to set the signal power at the W1 71-86GHz output
port. The valid input range is -90 to 5 (-90 dBm to +5 dBm) with a
resolution of 0.1dB.
The source frequency of the RI8604 is set by the Frequency button
of the source connected to the Drive in (C1) input port in
conjunction with a fixture definition with a connection between the
source’s output port and the RI8604‘s Drive In (C1) ports.

The ‘off’ selection disconnects the Drive In (C1) port source from the
8x frequency multiplier chain.
If Output

If Output

If Output
A drop down list button that controls the IF Switch network for routing
down-converted IF signals to the selected output port.
The ‘IF Output’ selection routes the down-converted IF signal to the IF
Out (C6) port.
The ‘IF Output 2’ selection routes the down-converted IF signal to the
IF Out 2 (C8) port.

© Roos Instruments Inc.
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Im State

Intermod Power

0

oﬀ

Intermod Power

Im State

Decimal notation input button that controls the step attenuator in the
Intermod In (C5) path to set the signal power of the source supplying
the intermodulation signal at the W1 71-86GHz output port. The valid
input range is -90 to 5 (-90 dBm to +5 dBm) with a resolution of
0.1dB.

A drop down list button that sets the state of the 8x frequency
multiplier in the source path from the Intermod In (C5) input port.

Output Attn

The ‘on’ selection connects the source path from the Intermod In (C5)
port to the microwave multiplier and out of the W1 71-86GHz output
port.
The ‘off’ selection disconnects the the Intermod In (C5) port source
from the 8x frequency multiplier chain.

oﬀ

Output Attn
A drop down list button that controls a fixed attenuator step in the W1
71-86GHz output port path. It is used to extend the low-end dynamic
range of the source connected to the Drive In (C1) for DUTs with high
gain.
The ‘off’ selection sets the source path from the Drive in (C1) port into
“pass through mode” to the microwave multiplier and out of the W1
71-86GHz output port.
The ‘off’ selection disconnects the RF source from the multiplier
chain.

© Roos Instruments Inc.
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PANEL: MEASUREMENTS

MEAS

Input Wave

A

Meas: Input Wave
MEAS

Thru Measurement at Input Freq

A

Meas: Thru Measurement at Input Freq
Measurement block that computes the error correction factors for the
signal path connecting the W1 71-86GHz port and W2 71-86GHz
port to generate a ‘perfect’ thru reference from a non-perfect thru
standard. The computed error correction factors emulate a perfect
thru(lossless) with S11 and S22 terms equal to zero (negative infinity
approximated by -180dB), and S21 and S12 equal to one (0dB).
NOTE: This measurement block is typically used as a calibration method to create a
perfect thru standard from a generic, non-perfect thru path for relative measurement
comparisons.

© Roos Instruments Inc.

Measurement block that captures the incident and reflected waves as
a11 (signal out of W1 71-86GHz output, measured on the ‘a’ port of
the coupler in Instrument Button Diagram 2.14) and b11 (signal into
W1 71-86GHz port, measured on the ‘b’ port of the coupler in
Instrument Button Diagram 2.14). The output data type is two
complex voltages for a11 and b11.

MEAS

S11

A

Meas: S11
Measurement block which performs a series of a1 and b1 wave
parameter measurements to calculate a vector error-corrected S11
(b1 / a1) measurement. The output data type is a ratio expressed as a
complex voltage.
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Average Mode

std

Average Mode
A drop down list button that sets the method of averaging used for sparameter measurements. It is commonly used with the S11, Thru
Measure at Input Freq, and S Parameter measurement blocks.

instability from the DUT during large measurement captures or
averages.
NOTE: At higher frequencies and with averages greater than 8 to 16, some improvement
in accuracy and repeatability are often achieved using the adjacent averaging mode.

The ‘std’ (standard) mode measures and averages each individual
wave parameter during an s-parameter measurement. The Averages
button value (found in the System > state panel of the Editor) sets
the number of samples for the average. For example, a test panel with
an S11 measurement block and Averages button value of ‘4’, would
measure a1, a1, a1, a1, then b1, b1, b1, b1.
NOTE: The ‘std’ is the fastest averaging mode.

The ‘adjacent’ mode interleaves the measure of wave parameters
during an s-parameter measurement. The Averages button value
(found in the System > state panel of the Editor) sets the number of
samples for the average. For example, a test panel with an S11
measurement block and Averages button value of ‘4’, would capture
the measurements as a1, b1, a1, b1, a1, b1, a1, b1.and then average
the individual wave parameters. The ‘adjacent’ averaging mode is
slower than the ‘std’ mode due to additional signal switching between
wave captures, but can minimize memory, temperature and/or signal
© Roos Instruments Inc.
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CONTROL PANELS
Real-time control of the instruments in this TIM.

C ONTROL P ANELS 18 RI8604 71-86GHZ TEST SET

Testhead77 RF control panel provides real-time control of the
instruments in this TIM.

© Roos Instruments Inc.
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CARE &
MAINTENANCE

3

Provides General Care &
Maintenance Information
for:
•ESD Control
•Maintenance Schedule
•Daily
•Periodic
•Fixture Care
•RF Connector Care

SECTION 1

ELECTROSTATIC DISCHARGE
(ESD) CONTROL
Electrostatic Discharge (ESD) often damages or reduces the life of the
test system or its components. The following steps should minimize
ESD damage.

CREATE AN ANTISTATIC WORK AREA BY:
• Spraying all surfaces (floors as well as tables) with an antistatic
solution.

Care & Maintenance | Electrostatic Discharge (ESD) Control

• Service or work on electronic assemblies only in areas which are
static-controlled.
• Remove the following materials from the test/work areas:
• Food containers and wrappers (plastic, cellophane, paper
and Styrofoam)
• Clothing and shoes fabricated from man-made materials
(rubber-soled shoes)
• Paper
• Tapes
• Maintain humidity levels between 40 and 60%.

• Handling all electronic parts and assemblies in antistatic
containers.

• In severe static-inducing conditions, for example in automated
work areas or where the humidity levels are very low, use air
ionizers.

• Using static conductive floor mats and grounded antistatic
service mats.

• Consult an ESD Control Specialist for additional
recommendations.

• Using grounded wrist straps (with 1-Megohm resistors).
• Discharge static from personnel before handling electronic
components or printed circuit boards by using wrist ground
straps and antistatic outer clothing.
• Discharge static from tools before they are used to service
electronic assemblies.

© Roos Instruments Inc.
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SECTION 2

MAINTENANCE SCHEDULE

Care & Maintenance | Maintenance Schedule

Calibration Kit is either contained onsite or provided by RI during a
scheduled visit.

Cassini test systems are designed for high-volume use in a production
environment. If properly maintained, the test system should only
require a minimum amount of scheduled downtime to maintain
performance. The provided maintenance schedule summary is a
recommended guideline based on the requirements of a standard,
high-volume production test floor. The planned maintenance timelines
can be extended when used in a lab setting, very low volume
production, or a thermally stable (±5°C) and "Class 3+ Cleanroom"
test floor. The frequency and details of the procedures listed in the
Preventive Maintenance Schedule can be adapted by the end-user’s
discretion. For example, calibrations can be safely postponed up to 6
months time if the system is in a thermally stable environment where
the ambient temperature does not vary by more than 5°C.
*As Needed: Maintenance should be completed either within the
recommended time period or as needed; whichever occurs first.
**Required Tools: Standard Tools include Clean Dry Air (CDA) or
Pressurized Air, Cotton Swabs, Tweezers, Alcohol and SMA torque
wrench. Diagnostic/Calibration Plate is provided with the system. Full

© Roos Instruments Inc.
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PREVENTIVE MAINTENANCE SCHEDULE
Maintenance Daily Monthly Quarterly Yearly *As Needed
Socket

MFG
Suggestion

✓

DIB

>10% Yield
Change

✓

Test Head
TIM Ports

✓

1000 Fixture
Docks

Fixture Inserts
at DIB

✓

1000 DIB
Installs

Docking
Hardware

1000 Docks

✓

Handler Pod Test Head
RIFL Cable

✓

Diagnose/
Verify

Yield Drops

✓

TIM System
Calibration

✓

Auxiliary Rack
RF Cables
Fixture
Calibrations

Frequent
Handler
Changes

✓
Never Calibrate Fixture Unless
Modified
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TIM Swap
TIM Swap
Modification/
Damage
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PREVENTIVE MAINTENANCE DETAILS
Maintena

Time to

Role/

nce

Complete

Login

Socket

1-2 min

Operator

Standard Tools

DIB

10 min

Maintena
nce

Standard Tools.
Voltmeter, Magnifier

Test Head
TIM Ports

2 min

Operator

Standard Tools

Fixture
Inserts at
DIB

1 min

Operator

Standard Tools

Docking
Hardware

30 sec

Operator

Handler
Pod - Test
Head RIFL
Cable

1 min

Operator

Diagnose/
Verify

1-5 min
(selective) 1
hour
(complete)

Maintena
nce
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**Required Tools

Notify RI
Support

If wear is found

Diagnostic/
Calibration Plate,
Power Meter

✓
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SECTION 3

DAILY MAINTENANCE

Care & Maintenance | Daily Maintenance

CAUTION: Small pieces of metal or conductive debris can cause an electrical short
between components or to ground resulting in damage to the test system components.
• Inspect the docking hardware for signs of mechanical wear.
WARNING: Worn components can cause improper alignment
resulting in intermittent measurements.

Daily maintenance typically includes the cleaning and repairing of
sensitive electronic connectors. Isopropyl alcohol (at least 90%
concentration) is the Roos Instrument’s approved solvent to clean
connectors. Connector and component surfaces should be dried
using de-ionized, compressed air to remove residual debris. If the
contamination is not removed, test operations should cease and
affected components should be shutdown and removed for
maintenance. If the severity of the contamination or damage to a
component is such that it cannot be repaired onsite, contact Roos
Instruments for repair and/or service support.

DAILY MAINTENANCE PROCEDURE

• Inspect RIFL cables attached to Handler Pods for signs of any
damage or loose connections.
• Verify that the grounding wire and alligator clips between the
handler and test system and/or auxiliary rack and test system are
properly attached to an electrically grounded metal on both
ends. Alligator clips are provided as a convenience and can be
changed to a more permanent solution with spade clips.
• If there is physical damage to any of these components or
cables, the system should be serviced immediately. If the
components cannot be repaired onsite, contact Roos
Instruments for repair and/or service support.

Carefully inspect socket and load board connections. Look for any
physical damage, bent pins or fingers, and contamination such as
dirt, dust, or metal flakes.
Check microwave and DC connectors between the fixture and test
head for signs of wear or damage. Look for any physical damage,
bent pins or fingers, and contamination such as dirt, dust, or metal
flakes.
© Roos Instruments Inc.
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SECTION 4

PERIODIC MAINTENANCE

Care & Maintenance | Periodic Maintenance

name from the list that matches the current arrangement of
TIMs and press Select.
• Choose Run > All to perform a full system check.

• Visually inspect all connectors between the test head and fixture.
Look for any signs of physical damage: bent pins or fingers in
the PKZ #12 connector, and contamination such as dirt, metal
flakes, etc.

• Follow any on-screen instructions, making sure connectors
are properly seated in the diagnostic fixture. This will verify
that the system meets calibrated performance
specifications.
• If there are any failures, follow the Diagnose Procedure,
document the failure, and request service from Roos Instruments
support.

• Check the physical interface between the fixture and handler for
signs of wear or damage.
• Connect the Calibration/Diagnostic plate to the test head.
NOTE: For proper alignment, the RI Logo Arrow should point towards the
infrastructure chassis.

PERFORM FULL SYSTEM DIAGNOSTICS:
• From the Cassini window, choose System > Tester to open
the Configuration Window.
• From the Configuration window, choose Tester > Diagnose.
If multiple TIM configurations exist, choose the appropriate

© Roos Instruments Inc.
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SECTION 5

FIXTURE CARE AND
MAINTENANCE
FIXTURE STORAGE
RI Fixtures use robust mechanical and electrical connections to
survive the rigors of high volume semiconductor production. Regular
repeated use without proper maintenance, however, can reduce the
functional lifetime of the fixture.

Care & Maintenance | Fixture Care and Maintenance

FIXTURE CLEANING
The Cassini family of testers use a combination of blind mate adapters
between the test head and fixture that include: gold pins for DC, PKZ
#12 connectors for the RF and waveguide for mmWave. These
connectors can become contaminated and will need to be cleaned.
PKZ #12 connectors have especially small physical dimensions
needed for good RF performance, and therefore are very delicate.

FIGURE 3.1 TESTHEAD-TO-FIXTURE INTERFACE

Store the fixture in a protected place when not in use such as a metal
cabinet or book shelf. Make sure that the shelf the fixture sits on is
clean. The fixture feet will allow the fixture to sit without damaging the
connectors. Check DC and RF connections periodically to ensure
good contact and that damage has not occurred. Don’t store the
fixture in such a way as to allow objects to contact the bottom
surface. Anti-static Styrofoam is OK. Doing otherwise may contribute
to pin breakage or RF connector damage. Do not store on wire shelf
racks.

Gold pins in fixture connector block shown on left, PKZ male and
waveguide shown on center fixture block, and the mating TIM
© Roos Instruments Inc.

Waveguide block with female PKZ shown on right.
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CAUTION: Standard cleaning methods, such as a cotton swab, can damage the PKZ
#12 connector.

Care & Maintenance | Fixture Care and Maintenance
Cassini Maintenance Manual - 3 - Routine Care & Maintenance

FIGURE 3.3 CLEANER INGREDIENTS

This document shows how to clean PKZ #12 connectors using spray
cleaner and spray duster. This technique works for both the male and
female connectors.
To clean the connector, use a static-safe chemical cleaner such as
TF-Cleaner shown in Figure 3.2. If TF-Cleaner is not available, use an
Cassini Maintenance Manual - 3 - Routine Care & Maintenance

FIGURE 3.2 EXAMPLE CLEANER

Using this, or an equivalent cleaner, spray a small amount into the connector. This will flush any debris or

contaminants out for
of thethe
connector.
Ingredients
TF Cleaner used by Roos Instruments

CAUTION! Be sure to use a cleaner that is not harmful to skin. Do not allow the cleaner to get into your

equivalent
cleaner.
eyes or other sensitive
areas.Alcohol-based cleaners can also be acceptable,
however cleaners that contain oils such as tuner cleaner, are NOT
acceptable.
Using this, or an equivalent cleaner, spray a small amount into the
connector as shown in Figure 3.4. This should flush out any debris or
contaminants.

Recommended solution for cleaning connectors

© Roos Instruments Inc.

CAUTION: Adhere to all safety use and warning labels on the cleaning solution
container.
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FIGURE 3.4 CLEANING THE CONNECTORS

Care & Maintenance | Fixture Care and Maintenance

FIGURE 3.5 DIRTY PKZ #12 CONNECTOR EXAMPLE

Magnified view of contamination possibly shorting the center
conductor to the outer shell

FIGURE 3.6 CLEAN PKZ #12 CONNECTOR EXAMPLE

Spray a small amount of cleaner into each connector as shown in the
figure.

Magnified view of a clean connector

© Roos Instruments Inc.
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After flushing the connector with cleaner, use a 'duster', such as
shown in Figure 3.7 to dry the connector. Clean, dry air or stable
gas such as CO2 are acceptable. Spray the duster into the
connector to thoroughly flush any cleaner and dry the connector.
Cassini Maintenance Manual - 3 - Routine Care & Maintenance

After flushing the connector with cleaner, use a 'duster', such as shown to dry the connector. Clean, dry air
or stable gas such as CO2 are acceptable. Spray the duster into the connector to thoroughly flush any
cleaner and dry the connector.
AIR DUSTER

FIGURE 3.7

Care & Maintenance | Fixture Care and Maintenance

DIB CLEANING
1. Using isopropyl alcohol (strength at least 98%) and a low-lint Q-tip
or optical grade cleaning wipe, clean the contact side of the RF
and DC interfaces carefully. Also wipe the tips of the pogo pins
themselves.
2. Repeat step 1 for the contact pads of the socket.
3. Use compressed air to remove any residual alcohol or lint fibers.

SOCKET CLEANING
1. Inspect the socket for any broken or misaligned contacts.
2. Replace bad contacts using the manufacturers prescribed
replacement procedures.
3. Use a mild stream of air and/or a soft artists brush to remove
loose debris from the socket when needed.
4. Follow the manufacturers prescribed cleaning process for debris
that is not easily removed.

With this process, PKZ#12 connectors can be thoroughly cleaned without harm to the connector.

Type of compressed air duster used at Roos Instruments

DIB Cleaning:
1. Using Isopropyl alcohol (strength at least 98%) and a clean Q-tip or Kim-wipe, wipe the contact
side of the RF and DC interfaces carefully (see picture 2). Also wipe the tips of the pogo pins
themselves.
© 2.Roos
Instruments Inc.
Repeat step 1 for the contact pads of the socket (see picture 3).
3. Use dry air to blow off any left over fibers left behind by the Q-tip and/or Kim-wipe.
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SECTION 6

RF CONNECTOR CARE

Care & Maintenance | RF Connector Care

FIGURE 3.8 MATING MICROWAVE CONNECTORS

HANDLING SMA CABLES
When working with RF SMA cables, use the proper technique when
adding or removing connections (See Figure 3.8). The key to safely
connecting any coax connector is to remember that the center
conductor should not spin. The center conductors usually have a thin
gold plate on them, and if the connector is spun excessively the gold
plating can be damaged. The damaged plating would then oxidize
and cause degraded RF performance and by extension repeatability
and calibration issues. Some key rules for working with SMA type
connectors on Cassini test systems are:
• Always turn the coupling nut, do not spin the center conductor.
• Do not twist or bend RF cables.
• Do not put a wrench on the gold trim cap on the Auxiliary rack
RF cables (see Figure 3.9).
• Always use a 5/16 inch(8mm) SMA torque wrench set to 7–
10 in·lb (0.8 to 1.1 N·m).
Procedure for mating microwave connectors
© Roos Instruments Inc.
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FIGURE 3.9 AUXILIARY RACK GOLD CAP

Do not use a wrench on gold trim cap.

© Roos Instruments Inc.
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SERVICE

4

Contains General Service
Information for:
•Exchanging New or
Repaired TIMs
•Guru Network Setup
•RF Relay & Attenuator
Wear Levels
•Getting Assistance from
Roos Instruments

SECTION 1

EXCHANGING A NEW OR
REPAIRED TIM
This section describes how to add a new, temporary replacement, or
repaired Test Instrument Module. These instructions are the factoryspecified guidelines for any new, factory-serviced, or factoryupgraded TIM to insure proper software and firmware compatibility.

BEFORE THE TIM IS INSERTED INTO THE TEST
SYSTEM:
A Guru zip file (.gzp) containing instrument definitions, software
drivers, and calibration data must be installed in the test system’s
local or networked Guru. This file is provided by a Roos
Instruments support engineer and must be imported before
installing the TIM.

Service | Exchanging a New or Repaired TIM

IMPORTING SOFTWARE RESOURCES:
1. Open the Guru Browser application from the Apps button on the
Guru control bar.
2. Import the definitions from the .gzp file into Guru using the Import
function of the Guru browser. If the definitions in the .gzp were
installed by a networked Cassini or simulator, the resources will
sync to the test system’s local Guru automatically when
requested.
3. Remove the failed TIM if it is still installed. (See Removing a TIM)
4. Once the software resources are installed, insert the TIM into the
appropriate test head slot. (See Installing a TIM)
5. Choose System > Check from the Cassini main system window.
NOTE: The TIM’s information and calibration data is automatically loaded from Guru
when the instrument is powered up. As such, calibration of the TIM is not necessary.
If a testset TIM (RI8545, RI8563, RI8564, RI8567, RI8580) has been replaced or recalibrated, then a full system calibration of RF TIMs connected to the testset/s may be
required.

6. Verify that the TIM has been added to system’s configuration by
checking the Equipment Pool or Configuration Window.

© Roos Instruments Inc.
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7. Verify that the TIM has valid calibration data by RMB clicking the
TIM’s instrument or instruments in the Configuration Window and
selecting Calibration > Inspect menu. If the cal data values are
all zero, then the Calibration data has NOT been loaded properly.
If the TIM installation is intended to be permanent and did not replace
an existing TIM with the same model and location, the new tester
definition should be saved. (See Saving the Tester’s Configuration)
Also, the test system’s calibration list may have to be modified to
include calibrations for the new TIM.

Service | Exchanging a New or Repaired TIM
If the TIM locations change, be sure to relocate or add the appropriate
calibration block and/or interconnect cables to the Diagnostic/
Calibration Interface plate. Also use the Change the Calibration List to
set the default list of service test plans used to Diagnose or
Calibration the system.
NOTE: The Calibration List guru object is created at the Factory and affects both
Diagnostics and Calibration. Contact support@roos.com to coordinate any TIM
reconfiguration.

If a duplicate TIM is being added to the test system, the software will
automatically assign the instrument name and the TIM instruments a
number enumeration to the end of the instrument’s name in the
Equipment Pool and Configuration Window. For example, if a second
RI8546C is added, containing the DutControl, PowerVI, and
StaticDigital instruments, the new instruments will be assigned as
DutControl2, PowerVI2, and StaticDigital2.
AUX Rack sources may require renaming to match the configuration
as wired. Rename a TIM by selecting it from the Configuration
window, RMB click and select Rename. Since two instruments can’t
be named the same, select a temporary name and continue renaming
until all the Sources are named properly. A RecLO instrument must
always be renamed manually.

© Roos Instruments Inc.
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Service | Exchanging a New or Repaired TIM

SAVING THE TESTER’S CONFIGURATION:
1. Open the Configuration Window by choosing System > Tester
from the Cassini main system window.
2. If one or more TIMs where added or removed, the default
Calibration List must also be changed. Follow the Change the
Calibration List procedure.
3. From the menu options along the top of the window, select
Tester > Save.
NOTE: The saved tester definition controls two main functions:
1. When multiple TIMs of the same type exist in the configuration, the definition sets the
enumeration of the TIMs and the instruments within i.e. - defines which is
instrument1 and which is instrument2, etc. as well as their corresponding location on
the test head.
2. It enables simulated testers to use the same TIM and instrument layout configuration.

It is important that the tester definition be saved after this type of
installation. If the tester image is closed and re-started, the test
system will need the updated tester definition to correctly and
consistently identify the enumeration value of duplicate TIMs in the
configuration.

© Roos Instruments Inc.
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SECTION 2

GURU NETWORKING SETUP
(TCP/IP AND FTP)
NETWORK SETTINGS
The network settings are managed by the embedded operating
system (eCS). For Guru to operate properly, the network must be
properly configured. The system controller is pre-configured to use
DHCP to automatically assign appropriate network settings. If the
network has a dedicated Guru Server, use the Guru Address Book to
configure the connection to that server.
NOTE: Before contacting RI Support for assistance in setting up Guru networking,
have the following information available: IP address, TCP/IP Net mask, Default Route,
and DNS Server or static host names.

Service | Guru Networking Setup (TCP/IP and FTP)

TCP/IP CONFIGURATION
If the system controller needs to use a static IP address, follow the
instructions below:
1. Access the TCP/IP Configuration workbook from the System
Configuration toolbox > Network > TCP/IP > TCP/IP
Configuration. (Figure 4.1)
2. From the Network tab, change to Manually, Using and enter the
IP Address and Subnet mask.
3. From the Routing tab, click Add button and enter the Router
address change type to default and press OK.
4. On Host Names tab, enter the system controller’s Host Name and
click Add to add DNS server IP address.
5. If the Guru Server’s host name is not properly resolved by DNS,
enter it into the Hosts tab (along the bottom). Test this by typing
host <Guru hostname> into a command window. If the result
fails, then a Host Name is required.

View the current IP address by entering ifconfig lan0 into a
command window prompt.

© Roos Instruments Inc.
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TCP/IP: IP Address, Netmask

FIGURE 4.1 TCP/IP CONFIGURATION NOTEBOOK, NETWORK

Service | Guru Networking Setup (TCP/IP and FTP)

FTP CAPABILITY
• Use the FTP applications provided by eCS (GUI or CLI) to FTP
out from the system
• FTP Daemon must be set to Autostart to accept FTP connections
• TCP/IP Security must be set for at least 1 user
• User must have a Password (min 5 characters)
• Available drives or files for FTP need to be set
(use Negative logic to share all files and drives)
• Must have FTP enabled

BINARY FTP TRANSFER MODE
This FTP capability is primarily for administrative activities. The
preferred way to transfer test data is with the Guru Agent.
WARNING: Always use binary mode when transferring files via
FTP.
ASCII mode will corrupt .gzp (and .zip) files because of the line feed
conversion (ln -> ln+rf). To put the standard FTP client into binary
mode, always enter the command binary before starting the file
transfer.
IP Address, Netmask setup screen.

Typical TCP/IP: IP Address, Netmask setup screen.
To see the current IP address, use command "ifconfig lan0"
© Roos Instruments Inc.
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Service | Guru Networking Setup (TCP/IP and FTP)

Enable FTP Server with TCP/IP: Services

FIGURE 4.2 FTP SERVER WITH TCP/IP

Servers setup screen enabling the FTP Daemon to run in the
background
and handle
FTPsetup
requests.
Typical TCP/IP:
Servers
screen enabling the FTP Daemon to run in the

background and handle FTP requests.

© Roos Instruments Inc.
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Checking Wear Levels of RF Relays and Attenu
Open this topic online @ http://roos.com/docs/RBEH-8EG56J

SECTION 3

CHECKING WEAR LEVELS
OF RF RELAYS AND
ATTENUATORS

Service | Checking Wear Levels of RF Relays and Attenuators

Some instruments in Cassini TIMs have mechanical RF relays and step attenuators that wea
switched millions of times. The available life left is based on the specified lifetime for each co
usually
10 million
switches.
Each
component
FIGURE
4.3
SWITCH
WEAR
LEVELS has it's own life expectancy built into the system

WEAR LEVELS
Some TIMs contain mechanical RF relays and step attenuators that
have a finite mechanical switching life cycle. The available life is based
on the manufacturer’s specified lifetime for each component (typically
10 million switches). As each component has a particular life
expectancy, the software tracks and logs this information throughout
TIMs duration in the system.
The wear levels are displayed in the Messages Window upon startup
as shown in Figure 4.3. When the wear level of a particular
component reaches 70% of available life, a preventive maintenance
and calibration procedure should be scheduled. When the wear level
reaches 95% of available life the performance of the component can
begin to degrade. The TIM containing the relay or step attenuator
should be returned to Roos Instruments for servicing.
NOTE: Switches or relays above 95% wear levels can degrade in performance causing
poor impedance match conditions, signal leakage, power loss, and/or unresponsive
switch control.

© Roos Instruments Inc.

wear levels
are displayed
in tester
the Messages
TheSwitch
wear levels
are displayed
when the
is started.Window. To display the mes-

sages window select the System > Messages buttons from the main window.
When the wear level reaches 70% of the available life, a full Preventative Maintenance and C
procedure should be scheduled. When the wear level reaches 95% of the available life, or if t
degrades, the TIM containing the Relay or Step Attenuator should be serviced.
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SECTION 4

RESTORE, SYNC & LOG
SYSTEM CONTROLLER
Guru provides tools to perform some administration tasks in the
System window. A user must log in to Guru and have administration
rights prior to performing any of the administration tasks.
Once logged in to Guru successfully, the Logon button changes to
System button. Click the System button to bring up the System
window.

Service | Restore, Sync & Log System Controller

Guru. This feature will only work if the user has a Guru Server properly
configured.
NOTE: The Guru objects automatically sync every time it is loaded. This button is
helpful for speeding up this process after the system has been disconnected for a very long
time.

Click the Message button to see messages between Guru and Guru
based applications. This is useful for debugging purposes. When the
user clicks this button, a Logged Events Window will be displayed.
Click the Cancel button to dismiss the System window.

Click the Logoﬀ button to log out of Guru. You must log out of Guru
to log in as a different user.
Click the Shutdown button to shutdown the Guru. Guru will restart
automatically.
Click the Restore button to restore local Guru. This restores local
Guru objects from a backup Guru. This feature will only work if the
user has an Update Guru Server properly configured with the Guru
Address Book application.
Click the Synchronize button to synchronize Local and Update
Gurus. This feature checks the Local and Update Gurus and updates
all objects on the Local Guru with the latest version from Update
© Roos Instruments Inc.
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When you click the System > Message menu, a Logged Events window will be displayed. The Logged
Events window displays L
messages
being
sent between
Guru and Guru based applications.
OGGING
EVENTS
WINDOW

FIGURE 4.4

Selecting System > Message results in a Logged Events window
being displayed. Figure 4.4 The Logged Events window displays
messages being sent between Guru and Guru based applications.
Severity (S) is either 1, 3, or 5. When a different severity level is
selected and the Refresh button is clicked, the list will be updated
with all messages with the selected severity and lower. For example, if
severity of 1 is selected, it will only display messages with severity of
1; if severity of 5 is selected, it will display messages with severity of 5
and lower.
Level (L) is between 0 and 9. This is a measurement of the detail
available in the message. First select a specific Level, click the Refresh
button, and the list will be updated with all messages with selected
level and lower. For example, if a level of 0 is selected, it will only
display messages with level of 0; if level of 7 is selected, it will display
messages with level of 7 and lower.
To change the order of the display, select Newest first or Oldest first,
and click the Refresh button. To clear all the messages being
displayed, click the Clear button. To close the Logged Events
Window, click the Close button.

Severity is either 1, 3, or 5. When a different severity level is selected and the Refresh button is clicked, the
Events
window
displays
messages
being
sent between
listThe
will beLogging
updated with
all messages
with the
selected severity
and lower.
For example,
if severity of 1 is
selected, it will only display messages with severity of 1; if severity of 5 is selected, it will display messages
Guru
and
Guru
based applications
with
severity
of 5 and
lower.
Level is between 0 and 9. First select a specific Level, click the Refresh button, and the list will be updated
with all messages with selected level and lower. For example, if level of 0 is selected, it will only display
messages with level of 0; if level of 7 is selected, it will display messages with level of 7 and lower.
To change the order of the display, select Newest first or Oldest first, and click the Refresh button.
To clear all the messages being displayed, click the Clear button.
To close the Logged Events Window, click the Close button.

© Roos Instruments Inc.
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TRANSFERRING TEST DATA

Guru Agent Editor is used to create Guru Agent configuration files.
Guru Agents are used to perform automated transfers to local or
network storage destinations at regularly programmed intervals or
manually executed. This document describes, primarily, the ‘Copy’
and the ‘STDF Copy’ Guru Agents.
The Copy type is used to perform automatic copying of files. It can
perform automated copy functions from one Guru to another, from a
Guru to a local or network mounted file system, or from a Guru to
designated FTP locations.
It can operate on multiple Guru sources as well as multiple
destinations of any type. FTP destinations can use standard SOCKS
proxies to connect to FTP destinations outside of the local network.

FILE COPY GURU AGENT
Open Guru Agent by selecting Apps > GuruAgent from the Guru
control bar. The left half of the window displays the data sources in a
set of tabbed panes, the right contains data destination. In addition,
there are pull down menus, found at the top of the program that allow

© Roos Instruments Inc.
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for configuring a Guru Agent, loading and saving of settings as well as
adding and removing of data sources and destinations.
Loading a file for editing is accomplished by selecting the pull down
menu File > Open. This presents a dialog box with a list of available
Guru Agent setting files for editing. Select a file, and then select the
OK button. Clicking the “Select Type” button allows for the selection
of different types of files to be displayed, this can be useful if a
GuruAgent settings file has been saved as a different type (or object
class).
Similarly, selecting File > Save or File > SaveAs causes a file to be
saved back to Guru. Save overwrites the previous file; SaveAs causes
the creation of a new file, thus preserving the old one.
NOTE: Previous versions are always retrievable using the Guru “History” feature.

The Settings pull down menu has three categories of settings:
Execution, Appearance and Messages/Errors. These are settings that
control how the Guru Agent will run, when it will run, and how often it
will run.
The pull down menu Settings > Execution displays a dialog window.
The Execution settings control what type of copying will occur, how
often the agent will run as well as whether it runs automatically at the
specified rate (auto type), only at Guru startup (startup type), or only
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when manually executed, such as from the Guru App selection button
(Manual type).

select the types of errors that will be logged by the agent as it runs.
There are four choices available:

NOTE: The selections “Regular Copy Agent” versus “STDF Copy Agent” refer to the
manner in which source files are selected for copying. The primary difference is that
selecting “STDF Copy Agent” causes the pieces of the STDF file to be assembled prior
to being copied. For non-STDF file, the “Regular Copy Agent” selection should be used.

0: No Logging of any sort
1: Logging only errors. For example: Couldn’t find destination
directory
2: Log Non-Errors as well as Errors. This includes lists of files that
were successfully copied, and so on.

The Appearance dialog box is displayed by selecting the Settings >
Appearance pull down menu.
It allows setting parameters such as whether a visible window is
displayed while the agent is running (normally this is de-selected). In
addition, this provides the option to allow the window to automatically
close after the agent finishes running (this is the default case).
Sometimes it can be useful to allow the agent to keep running, after it
has finished its task, for debugging purposes. Note that if “Auto
Close” is not selected, the agent will not automatically terminate after
it completes it’s task. As a result, the agent will not automatically run
again until after the agent has been manually terminated.
The settings for “Screen Location” and “Screen Size” rarely need to
be modified but are provided as a convenience to the user.
The Messages/Errors dialog box can be displayed by selecting the
pull down menu: Settings > Messages/Errors. It allows the user to

© Roos Instruments Inc.

3: Debug Mode Logging. This enables logging of internal program
events that are not normally of interest to most users.

SOURCE SETTINGS
The left area of the main application window represents the ‘Source’
information. This defines what needs to be copied and where it can
be found. There can be as many sources as necessary. In order to
add more sources, select Edit > Add Source; this causes a new
data source being displayed (for example, 'source1', 'source2', etc.).
You can add as many sources as desired. Delete a source by first
selecting it (so that it is displayed) and then select Edit > Del Source.
The field Match On defines the Guru keys that are used to fetch
pertinent data. What is entered here is a comma separated list of
keys, or key=value pairs, that uniquely identify the data that is to be
fetched. For example: ‘ri.sys.ObjClass=RiAdminLog’. This would
cause any file in the source location, that had that particular key/value
pair, to be included in the group of files to be copied.
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NOTE: When using the agent to assemble STDF or ATDF data logs, the Match On
selection string should include "ri.sys.ObjClass=RiTestData, ri.sys.Type=summary"

The Type selection: currently only Guru Sources are allowed,
therefore the selection box only allows for source selection of type
‘Guru’.
The Location field specifies where the source is located. Legal
entries here are either the word ‘local’ which implies that the ‘Local
Guru’ is to be the source for the data. Otherwise any IP address or
URL can be specified. An example would be ‘www.roos.com’.
Additionally, the IP address or URL, a colon and port number is
optional for situations where a non-standard Guru port is being
accessed. For example: 192.168.1.123:5000 0.
Proxy Info allows for a proxy to be used as a means of accessing the
source location. A proxy can be defined as an HTTP proxy, a
SOCKS4 proxy, or a SOCKS5 proxy. Clicking on the ‘Proxy Info’ field
will bring up a dialog that allows selection of the type of proxy as well
as the relevant required information e.g. hostname, proxy port
address, proxy username and password (if needed).
Copied Files Tag defines a key that will be set after the copy
operation is successfully completed. This is used in conjunction with
the check box: ‘Ignore Copied Files’, to avoid recopying files that have
already been copied.

© Roos Instruments Inc.
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Ignore Copied Files: This check box works in conjunction with the
“Copied Files” entry. The default state for this is to be selected. If
selected, any files that have already been copied, will not be copied
again. De-selecting this will result in files being copied even if they
have already been previously copied.
Ignore Invalid Files: Occasionally a corrupt or invalid file may find it’s
way into the file system. If a file is determined to be corrupt,
incomplete or otherwise invalid, it automatically gets tagged as such.
The default setting for this check box is that it be selected; this results
in invalid files being ignored. De-selecting this check box will result in
the agent re-attempting to gather and copy those invalid files. Note
that this is primarily related to the STDF files option as they are pieced
together from separate files.

DESTINATION SETTINGS
The area on the right hand side of the main application window
represents the ‘Destinations’. This defines where files will be copied
as well as their final names. There can be as many destinations as
necessary. To add more destinations, select Edit > Add Destination.
This causes a new Data Destination to appear in the right hand area
of the application, as a tabbed pane. Delete a destination by first
selecting it and then select Edit > Del Destination.
The Type field can be any of three possible values: ‘Guru’, ‘ftp’, or
‘file’. This identifies the type of destination being defined.
• ‘Guru’ causes source files to be copied to the specified
destination Guru.
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• ‘ftp’ causes an FTP connection to be opened using the specified
values for Connect info, Location, Rename Template and Proxy
Info.
• ‘file’ type will cause the data to be copied to a file system
location using the specified values for Connect info, Location,
Rename Template and Proxy Info.
The remaining fields will display if needed for the different destination
type as described below.
The Location field describes either the IP address, ftp location or file
system location that will be connected to when copying files to this
destination. Valid entries here are IP addresses or URLs followed by
an optional port number, or else a valid file path name.
The Rename Template is used to automatically create filenames from
Guru keys. Within Guru, files are specified by sets of key=value pairs.
Often these files have no useful filename that can be used to
distinguish one file from another once copied to an ftp or file system
location. This field allows a name to be automatically created from
Guru keys. Any desired text can be entered here. In addition any value
in angle brackets ‘< >’ is treated as the name of a Guru key. For
example:
Date1<ri.dlog.StartTime>_<ri.dlog.Lot>_<inx.dlog.TestMode>_<inx.dl
og.TestType>_<ri.dlog.Tester>_<ri.dlog.Testplan>.std

© Roos Instruments Inc.
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‘walkback.log’ or ‘vterror.log’ file. The file is saved in the program
directory, d:\RiApps\GuruApps\########(App number).
• To send information related to test applications or resources
such as calibration information, software definitions, test plans or
test data, use the Export Simulation feature found in the
Troubleshooting chapter.

This section provides general information for generating and exporting
relevant data to Roos Instruments support. Reference the
troubleshooting section for helpful tips and guides for debugging and
diagnosing test issues.

CREATE .ZIP FILE

Contact information and support hours can be found in the Additional
Help section of the About this Manual chapter.

To create a zip file:

Files that are not exported as .gzp files from Guru Browser should be
contained in a zip a file before sending it to RI support.

1. Open a command terminal.

SENDING DATA TO ROOS INSTRUMENTS
Support can be typically be expedited by including software objects
related to the problem in the service request as well as the version of
the software application(if applicable):

2. Enter the commands:
cd d:/folder/name/
zip ‘zip file name’ ‘name of file(s) to be zipped’
Example: zip guru.zip d:/RiGuru/

• The name and version number of a software application can
usually be found in its’ Help > About menu options.
• If a software ‘Walkback’ error is encountered, select SAVE from
the error dialog window to save the error message as a

© Roos Instruments Inc.
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5

General Diagnostic
Information for:
• Theory and Planning
• Operator Interface
• Diagnostic Kit
• Diagnose Procedure
• Preparation
• Full or Targeted
• EPC
Use Diagnostics to prepare
for Calibration or while
Troubleshooting.

SECTION 1

OVERVIEW

This chapter provides an introduction to diagnostics and the
automated fault detection of instruments on Cassini test systems. The
information provided is the recommended practices and procedures
for performing instrument diagnostics to help develop corporate
policies for releasing a test system to production. A detailed
explanation of the software interface is provided with a description of
the standard Diagnostic Kit and its software resource definitions. The
Diagnostic Procedure section provides step-by-step instructions for
conducting diagnostics on Cassini instruments and the EPC
Controller.

PRINCIPLES OF DIAGNOSTICS
Cassini diagnostics are used to test an instrument’s operational
capability. The instrument’s internal components are exercised to
detect hardware faults in a controlled test environment, performing
various measurements to verify operation, consistency, and
repeatability. These tests provide a simple pass or fail results based
on factory defined parameters of acceptance. Two modes of
© Roos Instruments Inc.
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evaluation are expressed in the diagnostic tests list available to the
user as either ‘diagnose’ or ‘verify’ in the test names. Collectively,
both types of tests in the test list are referred to as ‘diagnostics’ on
the Cassini test system with the descriptions of each as follows:
1. Diagnose tests check fundamental hardware functionality of an
instrument’s internal components. A damaged or malfunctioning
component will cause the diagnose tests to fail.
2. Verify tests check the measurement capability of an instrument to
insure that it is compliant with performance specifications of a
calibrated instrument. This includes conducting tests to gauge the
repeatability of measurements using fixed instrument and I/O port
setup conditions in a controlled test environment. In the case of
RF instruments, the diagnostics can involve several
interconnected instruments.
NOTE: For some RF instruments, verify tests are inherently dependent on the
instrument’s calibration. An improperly executed or invalid instrument calibration can
also cause verify tests to fail.
An aspect unique to diagnostics on Cassini ATE are the variable
instrument configurations of the test system. Because of this,
diagnostic tests available to the user are designated specifically for
the configuration of TIMs installed. The instrument arrangement on the
test head is addressed by matching a corresponding Diagnostic/
Calibration Interface Plate and diagnostic/calibration test list to each
unique test head instrument configuration. This Diagnostic/Calibration
Interface Plate provides the specialized TIM interface blocks and
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cross-instrument connections specific to the test system that is
required to conduct diagnostics, see Figure 5.7 for an example.

• Before a system or instrument calibration.

NOTE: Changes to the TIM layout or TIM upgrades may require physical changes to
the diagnostic plate and/or changes to the diagnostic test list.

• Before releasing a Cassini test system to production.

• During a Cassini test system acceptance process.

• When a TIM is exchanged or replaced, prior to its first use.

SOFTWARE INTERFACE
In software, the diagnostics for a Cassini test system are managed by
a specialized user interface called the Diagnostic Executive. The
interface provides the list of all instrument diagnostics for the test
system and a console for executing, viewing, and saving diagnostic
results. Access to the diagnostic executive is enforced by the user
login permissions to limit viewing and execution to authorized
personnel only. Reference the User Interface section in this Chapter
for more information.

• When troubleshooting a TIM that is suspected of damage or
malfunction.

TIM-SPECIFIC DIAGNOSTICS
Some instruments require unique and/or supplemental procedures in
addition to those outlined in this chapter. The below hyperlinks
provide instructions and procedures for these TIMs:
RI8589 FetPulser Supplemental Diagnostic Hardware
RI8589 FetPulser Diagnostic Instructions

SUPPLEMENTAL DIAGNOSTICS
WHEN TO PERFORM DIAGNOSTICS
Diagnostics are an essential tool to confirm that the instruments in a
Cassini test system are operational. As such, diagnostics are
satisfactory for use in the acceptance process or to confirm that a
Cassini system configuration is ready for production use. Listed below
are the recommended instances for performing diagnostics on an
instrument or Cassini test system:

Additional diagnostic tools are available on Cassini test systems.
These include diagnostic tools for the RIFL communication hub and
the disk drives in the EPC Controller. While the supplemental
diagnostic tests provide additional system and instrument information,
they are not required for validating the performance or operational
capability of a Cassini TIM. The supplemental diagnostics are
described in more detail in the Diagnostic Procedure section.

• To verify operation of a test system instrument
© Roos Instruments Inc.
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TOPICS

Opening the Diagnostic Executive
Diagnostic Executive Window
Menu Options Details
Running Diagnostics

© Roos Instruments Inc.
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FIGURE 5.1 OPENING DIAGNOSTIC EXECUTIVE

Diagnostics for Test Instrument Modules (TIMs) on Cassini test
systems are accessed using the Diagnostic Executive. In the following
section, this UI and its features are described.
Access to the Diagnostic Executive is restricted to users with the
“Maintenance” permission enabled. Check with the system
administrator for more information on user access.
The Diagnostic Executive window is accessible from the Tester
Configuration Window. It can be accessed two different ways, giving
the user access to different set of diagnostic test plans.
To access the default system diagnostics for all TIMs in the test
system (recommended method):
1. Open a Tester Configuration Window.
2. From the menu options select Tester > Diagnose, as shown in
Figure 5.1.
This option populates the diagnostic executive (example shown in
Figure 5.3) with an ordered list of factory supplied Diagnose and Verify
test plans for the specific TIM configuration of the Cassini test system.
The test plans are organized in the list to be executed sequentially
from top to bottom to perform a complete diagnostic of the test
system.

© Roos Instruments Inc.

The Diagnostic tests are accessed from the Tester > Diagnose menu
from the Configuration Window.

In addition to the standard diagnostic list, users can select alternative
diagnostic lists to populate the Diagnostic Executive. These alternative
diagnostic test lists are typically used when updating the system
diagnostics to add support for upgraded or newly added TIMs.
To access an alternate diagnostic list:
1. Open a Tester Configuration Window.
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2. Right mouse button click on the System instrument in the Tester
Configuration window.
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FIGURE 5.2 OPENING ALTERNATIVE DIAGNOSTIC TEST PLAN LIST

3. Select Calibration > Diagnose... from the menu as shown in
Figure 5.2.

To save an alternate diagnostic list as the default:
1. Access the alternate diagnostic list using the steps above.
2. From the Configuration Window, select Tester > Save from the
menu options.
3. Select OK from the ‘Tester name, OK to save’ pop-up window.

Alternate Diagnostic tests are accessed from Right Mouse Button (RMB)
click the System > Calibration > Diagnose menu from the
Configuration window.

© Roos Instruments Inc.

568

Cassini ATE System Reference Guide

DIAGNOSTIC EXECUTIVE WINDOW
The specialized user interface provides a console for executing RI
diagnostic test plans with factory set limits and displaying the pass/fail
results. This section describes the various options in the UI that are
available to the user.

USER INTERFACE LAYOUT
The Diagnostic Executive window, shown in Figure 5.3, is divided into
two panes - Test Plans, and Results. The Test Plans section displays
diagnostic tests in a scrollable list. This test list is populated based on
the user’s selection of either an individual TIM, or the factory default
diagnostics for all TIMs in the test system, see Diagnostics Procedure
for information on diagnostic list selection. Diagnostic tests can be
selected (highlighted with a blue background) by Left Mouse Button
(LMB) clicking on the desired test. A selected test can be unselected
by LMB clicking on the highlighted test.
The Results section is a text display that provides user feedback of
executed diagnostic tests, diagnostic pass/fail results, and
measurement data. When diagnostics are executed, the name of the
test that is currently running is displayed in the Results. Once
completed, the pass or fail result is appended to the end of the
corresponding test plan name, i.e - “RI7421b-RI7421B_Diagnose
Vmeas CF2...Pass.” The default result settings display a passing
diagnostic test with the word ‘Pass’ appended. A failed results
appends “FAILED!”, followed by measurement data in the associated
diagnostic test that failed.
© Roos Instruments Inc.
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MENU OPTIONS
Results Menu
The results menu is used for exporting diagnostic information and/or
measurement data from the Diagnostic Executive. The Save to File...
menu option allows the user to export all information displayed in the
Results pane to a text file. This command opens an OS2 file directory
window to save the diagnostic text file to the local file system.

FIGURE 5.3 DIAGNOSTIC EXECUTIVE WINDOW

The Diagnostic Executive is divided into two panes: The Test Plans (top
pane) provides the list of diagnostic tests for the selected TIM or TIMs.
The Results (bottom pane) is a text console that displays diagnostic
results.
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NOTE: The ‘Save to File...’ menu option is the recommended procedure for exporting
and sharing diagnostic information with RI support. The ‘Save to Guru’ menu option is
reserved for RI internal purposes only.

CAUTION: Save to an USB flash drive (Max 2/4 GB Fat16 (32Kib, NOT NTFS),
networked drive, or to the D:/ drive (as a temporary option).

Run Menu
The run menu provides the different options available to the user for
executing diagnostic tests:
Unselect All Tests - this menu option will remove the selection
(highlight) for all currently selected diagnostic tests in the Test Plan
pane. By default, all test plans are unselected when the Diagnostic
Executive is launched.
Selected - this menu option will execute all diagnostic tests that have
been selected (highlighted) in the Test Plan pane. Selected tests will
be executed as a batch in descending order starting from the top of
the diagnostic list.
All - this menu option will execute a self test (if available) and all
diagnostic tests in the Test Plan list.

Diagnostics | User Interface

Self Test - this menu option will execute low-level diagnostic checks
of source TIMs mounted in an Aux Rack. See the Diagnose Procedure
for more information on self tests.
Options Menu
The options menu provides diagnostic settings available to the user in
the diagnostic executive:
Select Cal Kit - this menu option will allow the user to add a
calibration kit software definition to the tester configuration.
Add Power Mtr - this menu option allows the user to add an RF
power meter instrument to the tester configuration. A GPIB
Instrument Pod must also be attached. When prompted, enter the
same GPIB address as set on the Power Meter.
Inspect Symbols - this menu option is for RI internal purposes only.
Show All Results - this menu option will display all measurement
data from executed diagnostics tests in the Results pane for both
passing and failing tests.
Show Fails Only - this menu option will display measurement data
associated with executed diagnostics tests in the Results pane for
only for tests that fail. This is the default result display setting when
the Diagnostic Executive is launched.

NOTE: When this option is executed, all diagnostic tests in the list will be executed
regardless of what test plans are selected.
© Roos Instruments Inc.
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Open Test Plan - this menu option will open the test plan of a
selected (highlighted) diagnostic test from the Test Plan pane. If
multiple test plans are selected, the first test plan listed will be
opened.
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FIGURE 5.4 DIAGNOSTICS RESULTS EXAMPLE

WARNING: Altering or modifying diagnostic test plans will void
the performance specifications of the Cassini test system. Do not
open diagnostic tests without supervision from or prior approval of
RI support.

In the example above, fail results are shown for the RI7421B
Instrument. The diagnostic test results are listed from left to right:
measurement name, measurement result, and all values of the
measurement.

© Roos Instruments Inc.
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RUNNING DIAGNOSTICS
The function of the Diagnostic Executive’s role is to provide a UI to
streamline the diagnostic process on Cassini. Along with providing a
dedicated console for running diagnostics, the Diagnostic Executive
automates and runs several features in the background that a user
should be aware of when using this interface:
• Test plans are automatically compiled and executed.
• Diagnostic test and measurement limits are selected by the
executive.

Diagnostics | User Interface
prompt will appear with specific instructions, and the test system will
pause until the user selects the OK button in the prompt.
The results of diagnostic tests are automatically generated and
provided in the Results pane. While a diagnostic test is executing, the
name of the test is displayed in the text field with an ellipsis (for
example “RI7421b-RI7421B_Diagnose Vmeas CF2...”), signifying that
the diagnostic test is currently being conducted. Upon completion,
the words “Pass” or “FAILED!” will be appended to the end of the
ellipsis to denote the final status of the diagnostic test, i.e - “RI7421b-

FIGURE 5.5 COMPILE PROGRESS BAR

• Operating system memory is minimized for test plan compiles.
• Test plan debug mode is disabled.
The diagnostic test list is populated when the Diagnostic Executive is
first launched as described in the previous section. To run all tests as
a batch process by selecting Run > All. Alternatively, the user
highlights the test or tests to execute by left-clicking on them to
select. With the desired tests highlighted, the user can choose to run
them by selecting Run > Selected from the menu options as shown
in Figure 5.6.
Once the diagnostics have been initiated by either one of the
described methods, the executive automates diagnostic test compile
and execution. The test compile progress bar is displayed to the user
(an example is provided in Figure 5.5), and then executed
uninterrupted. If user input or intervention is required, an operator
© Roos Instruments Inc.

The Diagnostic Executive automates test plan compiles and displays a
progress bar prior to test execution as show above.
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RI7421B_Diagnose Vmeas CF2...Pass.” The default Result settings
display passing tests in this manner, with failing test displaying
“FAILED!” followed by the results of all measurements in the
associated diagnostic test including the pass/fail status of individual
measurements. See Figure 5.4 for an example of a failed diagnostic
test. The result settings can be changed to display all measurements
regardless of the test status by the user (see the Menu Options in the
previous pages of this section for more information). The Diagnostic
Executive will continue on to subsequent diagnostic tests until all
selected test are completed.

Select a few tests for the instruments that are suspected to be invalid, and choose Run
| Selected5.6
from
the Verification
window. Monitor the results for Pass and Fail.
FIGURE
RUNNING
DIAGNOSTICS

Selected diagnostic test plans can be executed using the menu options
shown.

© Roos Instruments Inc.
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SUMMARY
1. Diagnostic Hardware
2. Adding the Diagnostic/Calibration Interface Plate
3. Initializing a Diagnostic/Calibration Interface Plate
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HARDWARE
Diagnostic Kit provides all of the components needed to perform
diagnostics and/or calibration of the Cassini test system. Included in
every kit is a specialized bottom plate called a Diagnostic/Calibration
Interface Plate. The interface plate contains an 8-slot or 16-slot
bottom plate with diagnostic TIM interface blocks that provide all the
RF cross-instrument interconnect for performing both individual and
RF system-level diagnostics of the instruments. Reference Figure 5.7
and Interactive 5.1 for examples of Diagnostic Kits and interface
plates.
Diagnostic/Calibration Interface Plates are customized to match the
Cassini configuration and specific instrument test head layout. To help
manage the different possible configurations of the tester, every
Diagnostic/Calibration Plate contains a unique serial number chip and
label. These provide unique identifiers for the hardware for both the
system software and service personnel to manage the administration
of multiple interface plates and/or test system configurations. The ID
chip is an Electronic Serial Number (ESN) that the Cassini software
uses to automatically associate any calibration data (RiFixtureCal
object) and add the fixture definition (RiFixtureDef object) that defines
the instrument interconnect paths and default calibration values. On
the Diagnostic/Calibration Plate are TIM interface blocks that provide
access to ports and interconnect for exercising internal instrument
functionality as well as multi-instrument functionality.
In addition to the Diagnostic/Calibration Plate, the diagnostic kit
provides a protective transit case and contains additional cables and

© Roos Instruments Inc.
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RF adapters that are customized to the test system’s diagnostic
requirements. Examples of typical Diagnostic Kits are provided in
Figure 5.11 and Figure 5.12. The transit case is marked with the
interface plate’s serial number and model number to uniquely identify
its contents for service personnel.
NOTE: A single Calibration/Diagnostic Interface Plate can only be shared between
multiple Cassini systems with identical TIM configurations.

Diagnostics | Diagnostic Kit

INTERACTIVE 5.1 CASSINI 16 DIAGNOSTIC/CALIBRATION PLATE

DC Interface Block

RF Interface Block

Serial ID Chip (ESN)
40GHz Interface
Block

FIGURE 5.7 DIAGNOSTIC KIT EXAMPLE

Interconnect Cable

TIM Label
Serial Number Label

The above example shows a typical Diagnostic/Calibration Interface
plate with all the necessary interface blocks and RF interconnections of
The Diagnostic Kit above shows a Cassini 16 Diagnostic/Calibration

a test head configuration for 40GHz applications.

Interface Plate (Diagnostic/Calibration Plate) in its protective transit
case.
© Roos Instruments Inc.
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SUPPLEMENTAL DIAGNOSTIC HARDWARE
The RI8589 FetPulser TIM requires the use of a diagnostics block
shown in Figure 5.8. The block is not integrated into the diagnostic
plate and is intended for use on an as-needed basis. The diagnostic
block activates the interlock and provides interconnect between
instrument resources to perform diagnostics.
WARNING: Do not connect the FetPulser diagnostic block to the
TIM until the RI8589 has been powered up and checked-in to the
test system configuration.

FIGURE 5.8 RI8589 DIAGNOSTIC BLOCK

The FetPulser diagnostic interface block
© Roos Instruments Inc.
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ADDING THE DIAGNOSTIC/CALIBRATION PLATE

Diagnostics | Diagnostic Kit

FIGURE 5.9 DIAGNOSTIC/CALIBRATION INTERFACE PLATE

The Diagnostic/Calibration Interface plate must be docked to the test
head and its’ associated software definition, i.e - ‘Fixture’ instrument
must be loaded in the Configuration window in order to run
diagnostics. To add the Diagnostic/Calibration Plate to the Cassini
configuration:
1. Place the Diagnostic/Calibration Plate on the test head and verify
that the physical TIM layout the matches the location of the TIM
interface block locations on the Diagnostic/Calibration Plate.
2. Verify that the instrument names and test head slot locations in
the Configuration Window match the corresponding TIM Label on
the interface block locations of the Diagnostic/Calibration Plate.
NOTE: In the Configuration window, the test head slot of an instrument is designated
at the end of the instrument name by the suffix ‘-T’ and then a number. For example ‘T11’ designates test head slot 11.

The Diagnostic/Calibration Interface Plate (highlighted above) appears
in the system’s configuration window as a “Fixture” instrument.

3. Dock the Calibration/Diagnostic Interface Plate to the test head
and perform a System Check to add the software definition to the
system configuration.
4. The diagnostic plate will appear in the configuration window as a
‘Fixture’ instrument followed by a descriptive title of the diagnostic
plate, see Figure 5.9. The message window will report, “Fixture
Added ” followed by the Diagnostic/Calibration plate name.
© Roos Instruments Inc.
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INITIALIZING A DIAGNOSTIC/CALIBRATION PLATE

Diagnostics | Diagnostic Kit

FIGURE 5.10 INITIALIZING A DIAGNOSTIC/CALIBRATION PLATE

Initializing a diagnostic/calibration plate is the process of linking the
electronic serial number (ESN) chip on the Diagnostic/Calibration
Interface Plate with the software Fixture Definition (ObjectClass =
RiFixtureDef). The Fixture Definition is created/edited with the Device
Connection Editor application. Initialization is required when:
• A new diagnostic plate is assembled that has never been used
on a Cassini test system.
• The serial ID chip on the diagnostic plate has been replaced.
• The diagnostic plate needs to be associated with a new or
different fixture definition.
The initialization process only has to be performed one time for a
diagnostic plate. All subsequent System Checks and System Startups
will automatically load the software definition for the diagnostic plate.
NOTE: Insure that the most up to date fixture definition for the diagnostic plate is
imported in the Cassini’s local Guru using Guru Browser before initialization. If the
Cassini ATE is connected to a Guru Server, insure that the definition for the diagnostic
plate was imported on any of the networked Cassini test systems.

The fixture definition for the Calibration/Diagnostic Interface plate is
linked to the ID chip on the plate by saving the active definition as a
calibration as shown above.

To initialize a diagnostic/calibration plate:

2. Open a Tester Configuration Window.

1. If not already completed, Login to the test system with user
permission to start the latest/appropriate shortcut and access the
Main System window.

3. Open a Messages Window.

© Roos Instruments Inc.
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FIGURE 5.11 STANDARD CASSINI 16 DIAGNOSTIC KIT

Description

QTY

16-Slot Interface Plate (Custom)

1

8” #12 PKZ Special Cable

RI Part

FIGURE 5.12 DIAGNOSTIC KIT EXAMPLE 2
RI Part

Label

Description

QTY

W1MFEGHG

D1

Adapter, SMA(f)-SMA(f)

1-2

M6GVJT1B

D9

2

W1MFEJXE

D2

SMA 30dB, 50W Attenuator

1

MPG9M41A

D10

SMA 20dB Attenuator

1

M6GSFV1A

D3

16” #12 PKZ(f) Cable

1

MRT4ZF1A

D11

8” SMA to #12 PKZ Special

2

W1MFEJWB

D4

RI8546 DC Cal/Diag Block

1

RIK0249A

-

50Ω Termination

1

M5R1BE1A

D5

RF 16 Port Cal/Diag Block

3-12

RIK0168A

-

Adapter, custom #12 PKZ(f)-SMA(f)

4

MBH0VH1B

D6

RF 40GHz AUX Block

1-2

RIK0167A

-

Serial Number (SN) Harness

1

MJUMNF4B

-

RF Waveguide W12 Block

1-2

RIK0198B

-

Cal/Diag Fixture Block

1

MMXT225A

-

Number

These standard items are included with all Diagnostic Kits as standard
items.

4. Dock the Calibration/Diagnostic Plate to the test head and
perform a System Check.
NOTE: If the ID chip has never been associated with a software definition and a
System Check is performed, the message “No RIFixtureCal found for this esn:” followed
by the unique serial number of the chip will be displayed in the Messages window. The

© Roos Instruments Inc.

Number

Label

The items above are examples of items included for custom applications
/TIM configurations.

fixture will not appear in the Configuration window until the serial number is associated
to a software definition.

5. From the Configuration Window menu options, select Instrument
> Add Fixture Def… to open a list of fixture software definitions.
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6. From the Select Fixture Def window, select the Title of the Fixture
definition that will be linked to the Diagnostic/Calibration Interface
plate’s ESN and choose select to activate it.
7. Once added, a ‘Fixture’ instrument will appear in the Configuration
window as shown in the example in Figure 5.9.
8. In the Configuration window, left click on the Fixture to select it
from the list.
9. Right click on the Fixture instrument and select Calibration >
Save from the menu. (See Figure 5.10) This will link the fixture
definition with the ID chip on the diagnostic plate by creating a
RiFixtureCal object in guru with the “ri.test.Fixture=Fixture Family”
attribute.
If the process has been completed correctly, the fixture instrument will
be automatically added to the configuration window list when the
diagnostic plate is docked and a System Check or System Startup is
performed.

© Roos Instruments Inc.
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DIAGNOSTIC PROCEDURE
Read all instructions and procedures in this section before running
diagnostics on a Cassini ATE system.

OVERVIEW
SUMMARY
1. Overview
2. Before Running Diagnostics
3. Test Instrument Module Diagnostics
4. TIM-Specific Diagnostic Instructions
5. System Controller (EPC) Diagnostics

This section outlines the methods and procedures for conducting
diagnostics on a Cassini ATE system in accordance with factory
recommended practices. Diagnostics can be performed on demand
to validate the operation of the instruments for acceptance or to
identify a problem or issue with a TIM that is not operating within
specifications or suspected of damage. Typically, diagnostics of the
complete test system are performed before a calibration to insure that
all TIMs are functionally operational and can produce repeatable
results. A comprehensive diagnostic test of the Cassini ATE system
includes:
• A test and verification of the RIFL communication link between
the test system’s test head and installed TIMs
• Low-level tests of instruments with reference oscillators to verify
drive levels and frequency lock.
• Diagnostic test plans that exercise the internal components of
the instruments and perform various measurements to validate
that the TIMs are functionally operational and produce
repeatable results.

© Roos Instruments Inc.

581

Cassini ATE System Reference Guide

BEFORE RUNNING DIAGNOSTICS
Before running diagnostics the following procedures should be
followed:
The test system and all TIMs must be powered on and allowed to
warm-up at least 20 minutes before running diagnostics to allow
instruments to reach a stable operating temperature. Diagnostic test
results are not valid within the warm-up period.
1. Login to the test system with user credentials that have a
“Maintenance” user role and are authorized to perform
diagnostics.
NOTE: The user account can be logged out and logged in while the active shortcut and
applications continue to run. Open applications will adapt their menu access controls to
the user account that is activated.

2. Verify that the latest shortcut for performing diagnostics is active.
Reference Shortcuts & Software Patches in Chapter 1 for more
information.

Diagnostics | Diagnostic Procedure
Mouse Button (RMB) click the fixture and/or DIB definition in the
Configuration Window, and select Remove from the pop-up
menu, and then select OK to confirm as shown in Figure 5.13.
6. Inspect TIM interface surfaces and connectors to insure they are
free of damage, wear, and/or debris. Reference Figure 3.4, Figure
3.5, and Figure 3.6 for more information on inspecting and
cleaning RF connectors.
7. Place the Diagnostic/Calibration Plate on the test head and verify
that the physical TIM layout the matches the location of the TIM
interface block locations on the Diagnostic/Calibration Plate.
8. Verify that the instrument names and test head slot locations in
the Configuration Window match the corresponding interface
block locations on the Diagnostic/Calibration Plate.
NOTE: In the Configuration window, the test head slot of an instrument is designated
at the end of the instrument name by the suffix ‘-T’ and then a number. For example ‘T11’ designates test head slot 11.

4. Remove any physical fixtures and/or device interfaces from the
test head.

9. Dock the Calibration/Diagnostic Plate to the test head and
perform a System Check to add the fixture software definition to
the system configuration. Confirm that the fixture was added to
the Tester Configuration window.

5. Remove any fixture and/or DIB software definitions from the
system configuration list by performing a System Check or Right

10. Open the Message Window and clear the console field by
selecting the Clear button at the bottom of the window.

3. Open the Configuration Window.

© Roos Instruments Inc.
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11. Perform a RIFL Test to verify communication between the test
head and installed TIMs (reference the Equipment Pool section of
Chapter 1 for more information on the RIFL Test):
From the equipment pool, RMB click on ‘Master’ at the top of the
node list and select ‘RIFL test’ from the menu. In the pop-up
window select OK to confirm a value of 1 in the repeat for a single
run.

Diagnostics | Diagnostic Procedure

FIGURE 5.13 REMOVING A FIXTURE SOFTWARE DEFINITION

12. Confirm that all communication and loopback tests between the
TIMs and test head hubs pass, i.e. - no failures in the Message
Window console.

A fixture’s software definition can be removed from the system
configuration by right-clicking on it to highlight it, and selecting
‘Remove’ from the menu.

© Roos Instruments Inc.
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TEST INSTRUMENT MODULE DIAGNOSTICS

Execute All Diagnostics (Complete System Diagnostics)

If all checks and tests from the previous section are satisfied,
diagnostics can be performed on the test system’s TIMs. The test
system’s primary instrument diagnostics can be accessed from the
Configuration Window by selecting Tester > Diagnose from the
menu options as shown in Figure 5.2 of the User Interface section.
This launches the Diagnostic Executive and loads the factory-installed
diagnostic test plans for the test system (see Figure 5.14). The
diagnostic tests are listed in order of ascending instrument number
and grouped by TIM.

This is the recommended method for performing diagnostics prior to an annual
calibration of the test system or when releasing a test system to production.

NOTE: This diagnostic list may vary between Cassini ATE systems with different TIM
configurations. Diagnostic test plans for TIMs not currently installed in the test system
can be viewed in the diagnostic list, but attempting to execute them can cause system
errors.

Execute Self Test
The Self Test is a low-level diagnostic check for TIMs that contain
reference oscillators. The self test measures and checks the reference
drive levels and corresponding frequency values of these instruments.
1. From the Diagnostic Exec’s menu options select Run > Self Test

This option automatically compiles and executes every TIM diagnostic
test sequentially, in the order they are listed in the executive window.
1. From the Diagnostic Exec’s menu options select Run > All.
Reference Figure 5.14.
2. Diagnostic tests will be individually compiled and executed
sequentially until all diagnostic tests are completed.
3. During compile of a diagnostic test, a pop-up status bar window
will display progress and then close when the test program
executes.
4. Diagnostic results will be displayed in the ‘Results’ pane of the
Diagnostic Executive. See the Viewing Diagnostic Results for
more information.
NOTE: In this execution mode, all diagnostic tests in the list will be executed
uninterrupted until completion. To abort the system diagnostics hold down the CTRL
key and press the Pause|Break key to force an abort. An ‘Error:Control Break’ window
will pop-up. Select ‘Abort’ to stop the diagnostics.

2. Diagnostic results and measured data will be displayed in the
Messages Window.

© Roos Instruments Inc.
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Execute Individual Diagnostic Test (User Selection)
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FIGURE 5.14 RUNNING DIAGNOSTIC TESTS

This is the recommended method for evaluating the operation of an individual TIM.
Individual diagnostic tests can be selected from the list of all test
system diagnostics as follows:
1. LMB click the desired diagnostic test from the list to highlight it.
This can be repeated to select multiple tests simultaneously.
To unselect a highlighted test, LMB click on the highlighted
diagnostic test.
To unselect all highlighted tests, select Run > Unselect All
Tests.
2. To execute the highlighted tests, from the menu options select
Run > Selected. Reference Figure 5.14.
3. During compile of a diagnostic test, a pop-up status bar window
will display progress and then close when the test program
executes.
4. Diagnostic results will be displayed in the ‘Results’ field in the
lower pane of the executive window. See the Viewing Diagnostic
Results section for more information.

© Roos Instruments Inc.

Diagnostic tests are executed from the Run menu option as shown
above. All tests can be run by selecting the ‘All’ option or userhighlighted tests can be executed by choosing the ‘Selected’ option. As
well, all highlighted tests can be unselected by choosing ‘Unselect All
Tests’.
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Viewing Diagnostic Results
Once a diagnostic test is complete, the text field in the Results section
of the Diagnostic Exec will display a pass or fail result for the
corresponding test as shown in Figure 5.16. The default result
settings will display ‘pass’ at the end of a passing test. If the test fails,
the results will display ‘FAILED!’ and then provide all measurement
data associated with the failed test.

Diagnostics | Diagnostic Procedure
1. From the Diagnostic Exec menu options select Options > Show
Fails Only.
2. Subsequent diagnostic tests that are executed will display
measured data in the results window for failing diagnostic tests
only.

FIGURE 5.15 RESULTS DISPLAY OPTIONS

NOTE: The text field in the ‘Results’ section of the Diagnostic Exec is cleared before
Diagnostic are executed, i.e - when the ‘Run’ > ‘All’ or ‘Run’ > ‘Selected’ menu options
are executed.

To view all measurement results, i.e. - results from pass and fail
diagnostic tests:
1. From the Diagnostic Exec menu options select Options > Show
All Results.
2. Subsequent diagnostic tests that are executed will display all
measured data in the results window for both passing and failing
diagnostic tests.
Pass/Fail information from diagnostic tests are displayed as text in the

To only view measurement results for failing diagnostic tests (default
setting):

Results field of the Diagnostic Exec. Options for displaying all
measured data or only failed data (default) can be selected from the
‘Options’ menu.

© Roos Instruments Inc.
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Saving Diagnostic Results
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FIGURE 5.16 SAVING/EXPORTING DIAGNOSTIC RESULTS

The text field data in the Results can be captured for support or
documentation purposes from the Diagnostic Exec. To save the
results to a text file(.txt):
1. From the Diagnostic Exec menu options select Results > Save
to File... as shown in Figure 5.16.
2. A Save File window will pop-up, allowing the user to enter a file
name and select a file directory in which to store the text file.
CAUTION: Do not save files to the C:/ drive. Save to an RI approved USB drive,
networked drive, or to the D:/ drive (temporary option).

Alternatively, the text in the Results field can be selected manually:
1. In the Results field, LMB hold and drag the mouse to select the
text of interest.

Results and measurement data from diagnostic tests can be saved to
a .txt file from the Results menu.

2. RMB click within the highlighted text or hold the CTRL key and
press C to copy the text to the clipboard.
3. The text can be pasted into a text file or other program from the
clipboard by holding the CTRL key and pressing V to paste.

© Roos Instruments Inc.
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TIM-SPECIFIC DIAGNOSTICS
Some Test Instrument Modules require unique and/or supplemental
procedures in addition to those listed in this section. Below are
instructions for the specified TIMs:
RI8589 FetPulser Diagnostic Procedure
The RI8589 requires the use of a diagnostic interface block in order to
perform the diagnostics.
WARNING: Do not connect the FetPulser diagnostic block to the
TIM until the RI8589 has been powered up and checked-in to the
test system configuration.

Diagnostics | Diagnostic Procedure
4. During compile of a diagnostic test, a pop-up status bar window
will display progress and then close when the test program
executes.
5. Diagnostic results will be displayed in the ‘Results’ field in the
lower pane of the executive window. See the Viewing Diagnostic
Results section for more information.

FIGURE 5.17 FETPULSER DIAGNOSTIC BLOCK CONNECTED

To run the RI8589 FetPulser Diagnostics:
1. Once the FetPulser has been powered up and checked into the
test system, connected the diagnostic block to the TIMs blindmate interface. See Figure 5.17.
The interface block must be connected to the TIM prior to
compiling/running the diagnostic test plan to insure a Self
Calibration occurs with a ground reference provided by the
diagnostic block.
2. LMB click on the FetPulser diagnostic test from the list to highlight
it.
3. Select Run > Selected to execute the highlighted tests, from the
menu options. Reference Figure 5.14.
© Roos Instruments Inc.

Press the diagnostic block down firmly onto the TIMs blind-mate
interface to engage all hypertronics pins.
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SYSTEM CONTROLLER(EPC) DIAGNOSTICS
The RI8574 System Controller TIM contains a disk drive, either solidstate or a hard-disk, which hosts the Cassini’s operating system and
test software. The system controller diagnostics use the Operating
System’s S.M.A.R.T. (Self-Monitoring, Analysis and Reporting
Technology) monitoring system to detect and report on various
indicators of reliability of the installed computer disk drives. This
diagnostic test can be performed independently from the instrument
diagnostics.

Diagnostics | Diagnostic Procedure
If a failure or warning is reported by the S.M.A.R.T. monitor, the
disk drive should be replaced to avoid system outage and/or data
loss. Contact Roos Instruments support for assistance in replacing
the EPC disk drive.

FIGURE 5.18 ACCESSING DISK DRIVE DIAGNOSTICS

NOTE: System Controller (EPC) Diagnostic is not a prerequisite for Calibration.

To run the system controller diagnostics:
1. From the eCS Start button select Desktop > Programs >
Utilities > Problem Determination Tools > Hard File Monitor
to launch the utility as shown in Figure 5.18.
2. The Disk File Monitor application shows all connected drives with
a disk icon containing a red or green indicator to designate the
drive status, reference Figure 5.19:
Green - indicates that the disk drive is OK.
Red - indicates that the drive has an issue.
3. Select the drive icon with a LMB click or from the menu options
select Options > Drive Info for more information such as the
Drive Status, Model, and Serial Number.
© Roos Instruments Inc.

The system controller’s disk drive diagnostics can be accessed from the
eCS start button menu.
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FIGURE 5.19 SYSTEM CONTROLLER (EPC) DRIVE INFORMATION

The Hard File Monitor utility displays the status of disk drive in the
System Controller(EPC). To advance to additional drives select ‘Next
Drive’. To close the Drive Information window select ‘Cancel’.

© Roos Instruments Inc.
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CALIBRATION

6

General Reference
Information for Calibrating
Cassini Test Systems using
the Calibration Kit and
Diagnostic/Calibration
Interface Plate.

SECTION 1

CASSINI SYSTEM
CALIBRATION
PLAN FOR CALIBRATION
Calibrations should be scheduled yearly following the Preventive
Maintenance Schedule. The frequency can be adapted by the enduser’s discretion. Calibrations can be safely postponed up to 6
months time if the system is in a thermally stable environment where
the ambient temperature does not vary by more than 5° C.

Calibration | Cassini System Calibration

NOTE: Performing a Calibration on a TIM that is failing may cause the Diagnostics to
pass even though a component is not functioning up to specifications. ALWAYS Run All
Diagnostics prior to following the Calibration procedure.

The Calibration Procedure can take about 4 to 6 hours for a typical
system configuration to complete. Calibrations are interactive so the
total time is dependent on the responsiveness of the operator and the
model and configuration of TIMs.
Calibration should not be performed on a “cold” system, TIMs require
at least 2 hours to stabilize enough to calibrate.

Months or weeks before a scheduled calibration, check that all the
equipment used to calibrate the system are calibrated themselves to
the global NIST electromagnetic standard.
Make sure that all calibration standards and instruments in a Cal Kit
are in good working order. Look for straight pins, inspect center
conductors for wear and clean connectors to remove any debris.
Inspect the Cal Kit definition to assure the item’s serial numbers and
calibration data are accurate by following the procedure to Inspect
and Modify Cal Standards.
Verify that all TIMs are functioning properly before starting the
Calibration Procedure by following the Run All Diagnostics procedure.
© Roos Instruments Inc.
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PREPARE FOR CALIBRATION
Use the following procedure to prepare the system for calibration:

Calibration | Cassini System Calibration
6. Choose System > Tester from the Cassini main system window
to open the configuration window.

1. If the Cassini main system window is not already open, turn on
the system's main power and monitor.
CAUTION: The system must be running for a minimum of 2 hours before starting this
Calibration procedure. This warm-up time is required for the instruments’ internal
temperature to stabilize and minimize the affects on the Calibration data.
2. If another user is already logged in, choose System > Logout
from the Guru bar to change privileges. Select Login from the
Guru control bar and log in as a user with “Maintenance”
permissions.
Note: The user can safely log out and log on while Guru Apps continue to run.

3. If the Cassini main system window is not already open, select the
appropriate shortcut from the Short Cuts button on the Guru
control bar to open the Cassini main system window. If the RI
Message Window displays an Error or Warning message, please
correct the problem before continuing.
4. If a Fixture is attached, unlatch and remove from the test head.
5. If not already completed, follow the Run All Diagnostics procedure
to verify that all TIMs are functioning properly. DO NOT continue
with calibration if any TIMs fail diagnostics.
© Roos Instruments Inc.
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ACTIVATE THE CALIBRATION COMPONENTS
The Diagnostic/Calibration (Diagnostic/Calibration) interface plate,
Calibration Kit (Cal Kit), and Power Meter must be loaded into the
configuration before the Calibration Procedure can be followed.
Dock and activate the Diagnostic/Calibration interface plate:
1. Before connecting the Diagnostic/Calibration interface plate to the
testhead, visually inspect the fixture and test head connectors. Do
not attach if any damaged pins are found.
2. Use the orientation arrow and four guide pins in the testhead to
align the Diagnostic/Calibration interface plate with the testhead.
Place the Diagnostic/Calibration interface plate downward onto
the test head.
3. When the “Align” light turns from red to green, ensure all fingers
are clear of the fixture and rotate the fixture switch to “Latch”.
4. Choose System > Check from the Cassini main system window
to have the system load the Diagnostic/Calibration Interface plate
into the system configuration. The item will appear as “Fixture,
<Cal Kit Name> Transient, Fixture Pwr” in the configuration
window.
Attach GPIB Instrument Pod and activate the Power meter:
1. Attach the GPIB Instrument Pod to the RIFL AUX ports on the
back of the Testhead. Connect GPIB cable to power meter.
© Roos Instruments Inc.
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Choose System > Check from the Cassini main system window
to activate the GPIB Instrument Pod.
NOTE: If an AUX rack is used with a GPIB Instrument Pod, do NOT attach another
GPIB Instrument Pod. Connect the GPIB cable from the power meter to the end of the
GPIB cable bus attached to the Pod in the AUX rack.

2. Select Instrument > Add Power Mtr from the configuration
window. Alternatively, the Power Meter can be loaded after
launching the Cal Exec by choosing Options > Add Power Mtr.
3. Accept the default instrument name of 'Pmeter' by pressing OK,
then accept the GPIB address of 13 by pressing OK again. On
the power meter, the remote light should flash on, then off. The
Pmeter instrument should now be visible in the configuration
window.
NOTE: Roos Instruments always sets the power meter to use GPIB address 13. The
facility may have a power meter used for calibrations set to a different GPIB address.

4. Attach the Power Sensor to the Power Meter and connect to the
Power Sensor calibration port. Press Zero/Cal button on the
Power meter and wait for the calibration to finish.
Add the Calibration Kit (Standards) to the configuration:
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1. In the Configuration window, select Instrument > Add cal Kit.
Alternatively, the Cal Kit can be loaded after launching the Cal
Exec window by choosing Options > Select Cal Kit.
2. Select the appropriate calibration kit and choose OK.
NOTE: For a valid calibration, the calibration kit definition must match the Calibration
Standards used in the Cal Kit. See the Inspect and Modify Cal Standards topic.

3. The Calibration Kit contains the coefficients for the open/short/
load and noise standard calibration components. Contact
support@roos.com for an updated calibration kit definition.
4. The calibration kit should now be in the Configuration window.
Once the Diagnostic/Calibration (Diagnostic/Calibration) interface
plate, Calibration Kit (Cal Kit), and Power Meter are visible in the
configuration window, continue on to the Calibration Procedure.

Calibration | Cassini System Calibration

CALIBRATION PROCEDURE
After the Calibration components are loaded, the Calibration
Executive window should be opened to begin calibrating the tester.
The Calibration Executive window enables the user to run multiple
calibration and verification test plans unique to the configuration and
layout of TIMs. The Calibration Executive automatically saves the
calibration data only if the verification test plan passes. Calibration and
Validation plans should ALWAYS be run as a pair. The calibration data
is reset (lost) when a Calibration service plan is compiled and the
calibration data is only saved after the Validation plan passes.
WARNING: Do not exit the Calibration Executive window after
running a Calibration service plan and Validation plan pair.
Invalid Cal data may be saved and cause measurements to fail.
1. Open the Calibration Executive window by choosing Tester >
Calibrate from the configuration window.
Alternatively, from the configuration window, highlight the 'System'
instrument and choose Instrument > Calibration > Calibrate.
Highlight the appropriate Cal List and press OK to open
Calibration Executive window.
2. Select and run calibration and validate service plans in the order
listed in the Calibration executive.

© Roos Instruments Inc.
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NOTE: The system only saves the Calibration factors after all selected plans have been
run, so run only a few plans at a time. With this method, if an operator error occurs and
a validate plan fails, then only the selected Calibration plans will have to be run again.

Run the Calibration and Validation plans in groups of 4 to 6 at a time:
1. Highlight the test plans in groups identified by their instrument
name by clicking on the test plan name to select it. Don’t
select more than 6 plans and don’t select a Calibration plan
without it’s Validation pair.

Calibration | Cassini System Calibration

CALIBRATION DOCUMENTATION
If Roos Instruments performs the calibration, a "Calibration Certificate"
that provides NIST traceable Model and Serial Numbers and
"Calibration Sticker" will be sent via standard mail in 3-6 weeks after
the calibration is completed. The “Calibration Sticker” should be
attached to the system that was calibrated.
Schedule a calibration according to the Preventive Maintenance
Schedule, or appropriate frequency.

2. To run the selected tests, select Run > Selected from the
menu bar.
NOTE: If the Cal Kit or Power Meter is not active, the Cal Exec will prompt the user
to load them. Choose Options > Add Cal Kit and/or Options > Add Pwr Meter to add
them to the configuration.

3. Follow the operator prompts provided by the test system while
it runs the calibration plan.
4. Repeat steps 1 through 4 until all of the test plans have been
performed. If the validation test plan fails, run the Diagnostic
tests for the Instrument that failed.
5. After all instruments have been calibrated, the System
Calibration is considered complete.
© Roos Instruments Inc.
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CALIBRATION KIT

CALIBRATION KIT
To calibrate a Cassini system two components are required
appropriate for your Infrastructure (8-port or 16-port) and specific
configuration of TIMs:
1. An 8-Slot or 16-slot Diagnostic/Calibration Interface (Diagnostic/
Calibration) Plate (See Figure 6.1)
2. A Calibration Standards Kit (Cal Kit) rated up to 20 GHz, 40 GHz,
or 80 GHz. (See Figure 6.2)
The Diagnostic/Calibration Interface Plate is included with delivery of a
new Cassini system and includes the required fixed RF interconnect
cables and blind mate blocks for the specific arrangement of TIMs as
well as PKZ #12 cables needed to perform the calibration. The Cal/
Diag plate can be used on any similarly configured Cassini system.
The Cal Kit includes a Power Meter and Sensor, Digital Volt meter, S
Parameter Standards, Noise standard, Cables, RF Adapters, and RF
Attenuators appropriate for either 20 GHz, 40 GHz or 80 GHz
calibration.
© Roos Instruments Inc.

Calibration | Calibration Kit

The instruments and standards in the Cal Kit need to be calibrated
regularly to NIST standards for Electromagnetic Measurements. The
customer is responsible for setting the duration of the calibration
interval and maintaining documentation. The power meter, power
sensor, and DMM are typically calibrated annually. The noise standard
and OSL standards can be calibrated bi-annually. If available, use a
calibration lab (Cal Lab) at your facility or one in your local area. If a
Cal Lab is not available or can not calibrate a specific instrument or
standard, it may have to be sent to the manufacturer for calibration. RI
offers Cal Kit service as RIK0082A for 20 GHz cal kits. RI usually
issues a NIST traceable calibration certificate only when a preventive
maintenance and calibration (PMC) is performed. A calibration is
performed when a major physical instrument is repaired or replaced,
but a certificate is not always issued. For many types of TIMs, a full
system calibration is not necessary when exchanged, factory Cal is
sufficient.
The RI Cal Kit comes with a USB stick with a '.gzp' file containing the
Cal Kit definition. The calibration factors (a.k.a. coefficients) are stored
in Guru as an "RiCalibrationKit" object class. If the Cal Kit is shipped
to other locations, be sure to update the ‘.gzp’ file on the USB stick
whenever the Cal standard coefficients change.
NOTE: Be sure the correct coefficients are imported with Guru Browser prior to using a
new Cal Kit.
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FIGURE 6.1 DIAGNOSTIC/CALIBRATION INTERFACE PLATE

Calibration | Calibration Kit

FIGURE 6.2 CALIBRATION KIT, 20 GHZ

Diagnostic/Calibration Interface Plate kit is stored in a black
transportable container and includes all required Cal Blocks and

Calibration kit is stored in a black transportable container and

interconnections.

includes all required instruments, adapters, and cables.

© Roos Instruments Inc.
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ADD CAL KIT TO CONFIGURATION

Calibration | Calibration Kit

FIGURE 6.3 CAL KIT ADDED TO CONFIGURATION

A Cal Kit must be added to the configuration before being used in the
Calibration Procedure or before the calibration factors/coefficients can
be updated. (See Figure 6.3)
1. If it is not already running, login as a user that belongs to a group
with Maintenance permission and launch Cassini with the latest
available Short Cut.
2. When preparing for Cal or inspecting Cal Kit, open the System
Configuration window by selecting System > Tester from the
Cassini main system window. Choose Instrument > Add CalKit,
then select the appropriate Cal Kit name from the list.

CalKit entry appears as a Transient instrument in the Configuration
window.

3. Alternatively, when performing a calibration, choose System >
Tester > Calibrate. From the Calibration Exec window, chose
Options > Select Cal Kit.

© Roos Instruments Inc.
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INSPECT AND MODIFY CAL STANDARDS

Calibration | Calibration Kit

FIGURE 6.4 INSPECT CAL DATA FROM CONFIGURATION WINDOW

Periodically, the cal kit coefficients may need to be changed after the
Cal Kit Open, Short and Load standards and the Noise Source return
from the scheduled calibration at a local Cal Lab.
To change the coefficients of a cal kit, use the following procedure:
1. Select the Cal Kit listed in the Configuration window.
2. In the Configuration window select Instrument > Calibration >
Inspect. Double-click the appropriate element. Entries default to
linear values. For logarithmic values, click the lin button.
NOTE: The lin/log button shows the current format, not the desired format. When
displaying in linear format, the button shows 'lin'. Clicking on the button changes to log
format, and the button changes to 'log.'

3. To change the coefficients for the Open, double click “open”. You
will see coefficient values for 'C0', 'C1', 'C2', and 'C3' in "e"
notation. Verify that these match the corresponding coefficients
from Open standard. If not, change them directly in the text entry
field on the right. Verify that the serial number in 'sn' matches the
file's serial number and matches the serial number of the actual
open. If not, change it.
4. For the Load and Short standards, the only thing to change is the
serial number. Double-click on 'load'. Highlight 'sn'. Verify that it
matches the serial number of the actual load. If not, change it so it
© Roos Instruments Inc.

Changing the Cal Kit coefficients

matches. Repeat this for the Short. After making any changes
right click on the CalKit instrument and choose Calibration >
Save.
5. Changing the Noise Source coefficients, Double-click on
'enrTable', then double-click on 'enr'.
There are normally 20 coefficients, corresponding to the 20 values
on the noise source's label. Highlight '1'. Verify that the frequency
is '10' (corresponding to the 10 MHz coefficient on the noise
source's label).
Select 'Power'. Note that the power displayed is a log number.
600

Cassini ATE System Reference Guide

Calibration | Calibration Kit
Cassini Maintenance Manual - 4 - Calibration

Change it to linear by selecting 'lin'. Confirm that this number
FIGURE 6.5 INSPECT/MODIFY NOISE SOURCE COEFFICIENTS
exactly matches the coefficient on the noise source's label. If not,
Get the 'Noise Source' coefficients
change it and select 'OK'.
from the printed label on the side of
Repeat this process for ALL the other coefficients,
thenSource.
close this
the Noise
ATTENTION!
panel.
The power displayed is a log
it to linear by
Verify that the serial number in 'sn' matches number.
the serial Change
number of
selecting 'lin'.
the noise source. If not, change it.
6. Close the panels. If the user has changed anything, right click on
the CalKit instrument, select Calibration > Save.
7. If the Cal Kit is shipped to other locations, export the Cal Kit with
Guru Browser. Set ri.sys.ObjectClass to “RiCalibrationKit”, then
select and export (Right click, export Guru format) the most
recently updated entry. Copy this .gzp to the USB stick included
with the Cal Kit and/or email it to the other location.

Window sequence for changing the cal kit coefficients.

© Roos Instruments Inc.

1. From the Configuration window, right mouse button click (RMBC), select 'Calibration
Inspect'. Double-click on 'enr Table', then double-click on 'enr'.
2. There are normally 20 coefficients, corresponding to the 20 values on the noise
source's label. Highlight '1'. Verify that the frequency is '10' (corresponding to the 10
MHz coefficient on the noise source's label).
3. Select 'Power'.
ATTENTION! The power displayed is a log number. Change it to linear by
selecting 'lin'.
Confirm that this number exactly matches the coefficient on the noise source's label.
If not, change it and select 'OK'.
4. Repeat this process for ALL the other coefficients, then close this panel.
5. Verify that the serial number in 'sn' matches the serial number of the noise source. If
not, change it.
6. Close the panels. If you have changed anything, RMBC on the CalKit instrument,
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Procedures for resolving
problems with Cassini:
• System Debug Procedure
• Breakpoint and Control
• System Error Log
• Software Error Recovery
• EPC Errors and Recovery
• Guru Errors and Recovery
• Infrastructure Issues
• Test Head Issues
• Handler/Prober Issues

SECTION 1

SYSTEM DEBUG
PROCEDURE

Troubleshooting | System Debug Procedure

Problems with the DUT and Socket should be reported internally and
provided to RI upon request. Please report all problems beyond the
DIB layer (including Fixture) to Roos Instruments support
(support@roos.com), even if they are resolved in the field.

DEBUG PROCEDURE OVERVIEW
1. Confirm DUT FAIL with known good part (a.k.a. “Silver DUT”).
This general procedure is to be used to diagnose and communicate
system problems. Always carefully inspect each connection layer to
rule out physical debris or missed connection. The 9 layers include:
DUT, Socket, DIB, Fixture, TIM, Test Head, Infrastructure, Handler/
Prober, Facility.
Most common problems are often related to improper docking. These
can be quickly solved by inspecting Equipment Pool and removing
then re-attaching a missing component. Always choose System >
Check from the Cassini main system window when removing or
adding each piece of equipment. This causes the system to inspect
all components, identify them and load their software definitions and
calibration data. Choose System > Equip > Nodes to view the
Equipment Pool that shows the TIMs connected to the test head (Tports) and AUX RIFL ports (H-ports).
To reduce production down time, RI recommends having at least one
spare DIB (Quick-Lock™), Fixture and each model TIM on site to
exchange. If a failure is identified, swap the DIB, Fixture or TIM to
quickly return to production testing with minimal downtime.

© Roos Instruments Inc.

2. Collect information: Test Exec name (DUT), ShortCut name and
version, Serial Number of System (Guru ID).
3. Inspect each of the 8 layers, fixing common issues:
DUT, Socket, DIB, Fixture, Test Head, TIM, Infrastructure, Handler.
If an issue is not identified, continue on to step 3.
4. Follow Diagnose Procedure to identify faulty TIM(s) with
Diagnostic/Calibration interface plate. (See Interactive 5.1) If not
faults are found, repeat step 2.
5. If TIM failure is identified, return to Roos Instruments for repair.
Contact RI Support for a RMA, include problem description, all
Diagnostic data, and serial numbers of the system (GuruID) and
TIM.
6. Replace failed TIM, perform Targeted Diagnostic Procedure.
7. If Diagnostic Procedure fails, RF System Calibration is required.
8. After Calibration, after Diagnostic Procedure completes without a
FAIL, release to production.
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FIGURE 7.1 DEBUG PROCEDURE DIAGRAM

Troubleshooting | System Debug Procedure
System failures are normally suspected when DUT Yields drop below
a normal failure rate (i.e. 5% failure). If 100% of the DUTs are failing,
the problem could be with the DUT (unlikely) or with the System.
Before removing the Fixture and preparing for the Diagnostic
Procedure, visually inspecting the DUT, Socket, DIB and Fixture can
solve many problems not associated with a TIM Failure. The
Diagnostic Procedure should then be followed to identify and replace
failed TIMs.

DUT INSPECTION
• Confirm ShortCut, Exec, DIB and Fixture appropriate for DUT
• DUT Issue, Use “Known Good” DUT (Silver or Gold part)
Confirm that the proper ShortCut and Test Exec is chosen for the
active DUT, DIB and Fixture. ShortCut label is displayed in the title
of Cassini’s main system window. Test Exec is chosen by the
operator. DIB and Fixture are designed to work with a specific DUT
or family of DUTs. If the model DIB is designed for another DUT,
swap out the Quick-Lock™ system with the correct DIB model. If all
appears correct, continue with Socket Inspection.

This procedural diagram should be followed to Debug problems on
Cassini. Inspect or replace each of the 9 layers: DUT, Socket, DIB,
Fixture, TIM, Test Head, Infrastructure, Handler/Prober, Facility.

© Roos Instruments Inc.

Manufacturing defects could cause the DUT to fail in such a way
that it appears that the Socket or Fixture is failing. Always verify
with a known good DUT that the problem is isolated to the tester,
and not a problem with the DUT or Socket. Replace the DUT with a
known good DUT and run the Test Exec again. If the part passes,
then continue testing. If the part fails, continue with DUT
inspection.
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SOCKET INSPECTION

DUT INTERFACE BOARD (DIB) INSPECTION

• Visually Inspect for Contamination, Clean Socket

• Quick-Lock™ system: DUT Clamp, Pedestal Support & Pedestal

• Sockets Have a Limited Lifetime, Repair Socket Pins

• Serialized DIB Identification, Test Exec Warning

• Follow Manufacturer’s Guidelines

• Swap with Spare DIB (if available)

Aways visually inspect the DUT socket(s) connectors before docking
the Fixture to the Handler, looking for damaged pins or contamination
(dust or debris).

The Quick-Lock™ system is used to quickly swap DIB boards to
repair socket pins or change parts. Issues may be caused by using
the wrong DIB for the DUT, improper DIB orientation, connection
contamination, or a misidentified DIB serial number. Always visually
inspect the DIB pads used for RF and DC connections before loading
the DIB on the Fixture, looking for damaged pins or contamination
(dust or debris).

Each socket has a limited number of insertions and pins may be
damaged by debris or Handler failures. Repair socket pins according
to manufacturer’s procedure.
CAUTION: Always follow the socket manufacturer’s recommended guidelines for
cleaning sockets and repairing pins.

A Test Exec Warning will appear if a DUT definition is not found. Either
the serial number chip has been disconnected or damaged or it has
not yet been associated with the DIB Calibration data. The DIB has a
serialized chip connected to the “S/N” and “Ground” pins of the FIX
block that is used to locate DIB Calibration data that matches the ID.
Carefully inspect the DIB serial number chip for damage or follow the
procedure for Calibrating a DIB. If available, swap with a spare DIB. If
the DUT still fails, inspect the Fixture.
When changing DIBs, from the Cassini main system window, select
System > Check to automatically identify devices that have been
removed and devices that are now available. When properly loaded,
the DIB will appear in the System > Tester configuration view.

© Roos Instruments Inc.
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FIXTURE INSPECTION

TIM INSPECTION

• Serialized Fixture Identification, Test Exec Warning

• Unidentified TIMs, Latching Issues

• Blind-mate Interface Connections (FIX, RF, DC, and Digital)

• Damaged Blocks, Fixture Plate Compatibility

• Swap with Spare Fixture (If available)

• Diagnostic Failures

WARNING: Never latch a Fixture with damaged or contaminated
(dust or debris) blind-mate interface blocks. It can damage the TIM
or Test Head and propagate damaged pins to other Fixtures.
Like DIBs, Fixtures also have a unique serial ID chip on the carrier
board or attached directly to the “S/N” and “Ground” pins on the FIX
block. The RI System Software reads this ID on system Startup and
will attempt to locate Fixture Calibration data and definition that
matches that ID.
A Test Exec Warning will appear if the proper Fixture and DIB are not
identified. Either the ID chip is not connected properly or it is not yet
associated with Fixture Calibration data. Carefully inspect the DIB
serial number chip for damage or follow the procedure for Calibrating
a DIB.
If available, swap with a spare Fixture. If the DUT still fails, continue by
inspecting the TIMs.
When changing Fixtures, from the Cassini main system window,
select System > Check to scan the devices. When properly loaded,
the Fixture will appear in the System > Tester configuration view.
© Roos Instruments Inc.

When properly loaded, all TIMs will appear in the Equipment Pool
window (System > Equip > Nodes) in the appropriate T-location (i.e.
T8). Confirm that the TIM is properly latched and fan is on. If TIM is
not loaded, follow the procedure to Install & Remove TIM. When
changing TIMs, from the Cassini main system window, select System
> Check to scan the devices. If all TIMs are present in the Equipment
pool, continue with a visual inspection of the TIM blocks.
Visually inspect the TIM’s blind-mate interface blocks, looking for
damaged pins or contamination (dust or debris). If a TIM has a
damaged blind-mate interface block, remove the TIM immediately and
contact Roos Instruments support for a replacement and identify all
Fixtures and inspect and replace any damaged blocks. If all TIM
blocks look correct, continue on Test Head Inspection.
After inspecting the previous 4 layers and ruling out common
problems, follow the Diagnose Procedure to identify a failing TIM.
Continue on with Test Head inspection if TIMs are not loaded properly
or another issue (like Handler communications) is affecting production.
NOTE: Use the correct Diagnostic/Calibration interface plate appropriate for the
current configuration of TIMs when following the Diagnose Procedure.
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TEST HEAD INSPECTION

INFRASTRUCTURE INSPECTION

• RIFL Communications (Hub)

• Air or Power Supplies

• Fixture Latching (Pressurized Air)

• System Controller EPC

If TIMs still do not appear in the Equipment Pool (System > Equip >
Nodes), a RIFL top board may have failed. Test Head issues are often
misdiagnosed as a TIM RIFL communication issue. Use the RIFL
Troubleshooting topic to validate RIFL communications between the
internal hub and the TIM. All TIMs should be installed in proper
location. If a RIFL self test fails, contact Roos Instruments support and
follow the procedure to replace the appropriate Test Head top board.

• Touchscreen UI

If a Test Head TIM slot is suspected as failing, move the TIM to
another location and choose System > Check, then confirm the TIM
is visible in the newly configured location. If the TIM appears in the
new location but not the original location, the problem is with the Test
Head top board, contact Roos Instruments support and replace. If the
TIM still does not appear, the TIM should be replaced.
If the Fixture latch mechanism is slow or can not successfully latch a
Fixture, inspect both the Infrastructure air connection and Facility’s Air
pressure. If not a facility problem, notify Roos Instruments support
and work around issue by manually latching Fixture by pushing on the
black Fixture latch plate.
Continue on to inspect the Infrastructure for issues before following
the Diagnostic Procedure.

© Roos Instruments Inc.

Infrastructure supplies Air and Power to the Test Head and holds the
System Controller EPC. The compressed air source should not be
leaking. Replace facility compressed air NTP connector if a leak is
detected. The redundant power supplies are accessed from the
Power Supply Access panel. Each power supply has a green light
when functioning properly. Contact Roos Instruments support if a
power supply failure is detected.
The System Controller EPC failures may be more subtle. The System
Controller includes the RIFL Master that sets the system’s 10 MHz
reference clock. See System Errors and Recovery for more details. If a
System Controller has failed, follow the System Controller Install
instructions.
Touchscreen UI (Ergotron adjustable arm, ELO Touchscreen,
Keyboard) can be replaced when any UI component fails. Contact
Roos Instruments support for RMA and instructions for repair.
Continue on to the Handler/Prober inspection to rule out problems
with the handler.

607

Cassini ATE System Reference Guide

Troubleshooting | System Debug Procedure

HANDLER/PROBER INSPECTION

FACILITY INSPECTION

• RIFL III to RIFL II Cable (Handler Pod)

• AC Power, Ground

• Handler Pod programming

• Pressurized Air (Cassini 16 only)

• Grounding cable

The facility is required to provide a stable 120/220 AC power with
reliable ground. Try to use the same breaker panel as the Handler/
Prober to reduce grounding issues that may affect communication.

Once configured, handler Pod and cables should not need to be
replaced. The most common failure is a damaged RIFL III (H-port) to
RIFL II (RJ45) cable. Visually inspect the cable for damage caused by
rolling equipment, kinks, or broken insulation. The RIFL cable requires
a shielded ground connection. Contact Roos Instruments support for
a replacement cable and RMA number.

Pressurized air should meet minimum requirements according to Site
Preparation guidelines.
Now that all easily identifiable problems are ruled out, continue on the
Diagnose Procedure to isolate the failed TIM.

CAUTION: Proper ground is important for reliable communications with the connected
handler or prober. A grounding cable should be securely fastened to the Hander/Prober.
Handler Pods are programmed once for a particular model and
configuration of handler. All communication is handled by the Test
Exec settings and are not intended for user modification. If a handler
Pod is suspected of failing, contact Roos Instruments support for a
replacement. Some Pods are opto-isolated and require a solid ground
connection on the handler side to function properly.
Continue on to the Facility inspection process to rule out grounding,
AC power or air pressure issues.

© Roos Instruments Inc.
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SECTION 2

EXPORT SIMULATION

Troubleshooting | Export Simulation

Note: The ShortCut is not included in the manifest. Please include the Title of the Short
cut with the description of the problem.
To export a simulation of an active test system or simulator:
1. From the Main System Window select System > Equip > Save
Sim as shown in Figure 7.2.

The export simulation feature is a useful tool to capture multiple
software elements of an active test system configuration or Cassini
simulation environment when troubleshooting an issue. Often times
when running a test plan or measurement on the test system, the
user has multiple software objects active:
• Fixture, DIB, and Device Control Definitions
• Instrument configuration
• Calibration layers
• Test plan
The export simulation feature allows the user to capture all of these
software objects into a single object called an RiSimulationDef. The
RiSimulationDef can be exported and emailed to Roos Instruments
support to re-create the exact test system configuration and software
environment settings when assisting with application support and/or
troubleshooting.

© Roos Instruments Inc.

2. To access the SimulationDef Object, open a Guru Browser
window. Reference Figure 1.68 for accessing and launching Guru
Browser.
3. Leave the ‘Key1’ field set to ‘ri.sys.ObjClass’ and choose
‘RiSimulationDef’ from drop down list.
4. In the search list of objects, select the RiSimulationDef with the
most recent creation date, i.e. the one created by the Save Sim
action, to highlight/select it.
5. From the Guru Browser menu options, select Export > Send to
Export List as shown in Figure 7.3.
6. The RiSimulationDef can then be exported to a .GZP and sent to
RI support.
CAUTION: Do not export files to the C:/ drive. Save to an RI approved USB drive,
networked drive, or to the D:/ drive.
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FIGURE 7.2 EXPORT SIMULATION

Troubleshooting | Export Simulation

FIGURE 7.3 EXPORTING THE RISIMULATIONDEF

The screenshot above shows how to search Guru for a
RiSimulationDef, organize the search results by creation date, and
send the RiSimulationDef object to the export list.
The screenshot above shows how to create a RiSimulationDef object of
the current Cassini test system software configuration.

© Roos Instruments Inc.
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Never edit Calibration data unless specifically Instructed by RI . You can get the test
system into a state where it won’t even start up .

SECTION 3

BREAKPOINT & CONTROL

Set Break Points

Troubleshooting | Breakpoint & Control

‘Options’ ‘Set Break Point’
Changes color at the break point
Can only break on a test, not on defaults etc.
Test plan will stop after setting up the hardware and taking the measurements
Only 1 break point per test plan
FIGURE
7.4 SETTING BREAKPOINT
You can continue, single-step, abort, or open the control panel

!
!
!
!
!
!

SET BREAK POINTS
• Options > Set Break Point
• Changes color at the break point
• Can only break on a test, not on Section or Global Defaults.
• Test Plan will stop after setting up the hardware and taking the
measurements
• Only 1 break point per test plan
• Can continue, single-step, abort, or open the control panel
CAUTION: Do not perform a system startup while at a break point.

When setting a breakpoint, the line turns yellow indicating a breakpoint is
present.
Page 118

CONTROL PANEL
The control panel can be accessed by selecting Options > Control
menu selections from the Main System Window or from selecting the
Control button from a breakpoint pop-up window. If reached from a
breakpoint, the control panel will reflect the settings at the breakpoint.

© Roos Instruments Inc.
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WARNING: The TIM settings are live and active at this point. The
control panel allows for manual control of system instruments

Troubleshooting | Breakpoint & Control

ABORTING A TEST PLAN
• Validate, Verify, or Diagnose can be aborted if necessary
• Perform by pressing Ctrl + Break

DISABLING PARTS OF TEST SECTIONS
Disabling parts of test plans can increase speed or decrease
confusion. The programmer message window will always say ‘Fail’ if
any test or test section is disabled. To disable a section select Edit >
Disable/Enable ‘Selected’ or ‘Disable All’ then re-enable selected
sections.
There are a couple of reasons for disabling parts of a test during
debug. One is to increase the speed of a test plan. This is particularly
useful when doing a ‘rattle’ test. Another reason is to decrease
confusion. If troubleshooting a problem, disabling a test or test
section, will decrease the amount of data that needs to be processed
while searching for a solution.
To disable a test, first click on the test the user wants disabled. Then,
at the top of the test plan window, select Edit > Disable/Enable
selected. This will disable the selected test. If the user wants to
disable more than one test in a section, select Edit > Disable All.
This will disable all the tests in that section. Then select the disabled
tests the user wants enabled and select Edit > Disable/Enable
selected to enable those selected tests.
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• System will show a walk-back error. Select ‘Abort’.
• From Main System Window, select System > Reset
• Always do a system reset after aborting a test plan
• Cals can be aborted, but only if absolutely necessary. Cal
data will be invalid.
Sometimes it may be necessary to abort a test plan. The reasons can
vary, from missing a step specified in a condition statement, cal
standards put in the wrong port, etc. All test plans can be aborted.
Cal plans should only be aborted if absolutely necessary.
To abort a test plan, press Ctrl + Break. A walk-back error will appear.
Select ‘abort’. Then, in the ‘Programmer Message Window’, select
System > Reset. It is important to ALWAYS reset the system after
aborting a test plan to clear any Cal factors from memory. Most
calibration plans reset the cal data when they compile, then insert
new cal data when they run. If a cal plan is aborted, compiled but not
yet ran, the old cal data has probably been lost.
When a group of calibrations/validates are executed successfully, a
message will display ‘Saving Cal Data’ within the executive window
upon completion. If the ‘Validate’ fails, the cal data is not saved.
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If either of the above has occurred and the cal data has not been
saved, the old cal data can be retrieved by selecting System > Equip
> Startup. This restarts the system, loading the latest version of any
object (including the valid calibration data) from Guru, but does not
reapply patches.

© Roos Instruments Inc.
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SECTION 4

VIEWING DATA

In the Cassini graphical programming environment, captured data in
Data Saves, Arrays, and Local Variables can be displayed with plot
viewers to provide a visual representation of the data.

Troubleshooting | Viewing Data

The Smith viewer, shown in Figure 7.8, displays impedances,
admittances, reflection coefficients, and/ scattering parameter data on
the complex reflection coefficient plane in two dimensions with a
normalized impedance of 50 ohms.
The Strip Chart viewer shown in Figure 7.9, displays successive
single measurement data points in time along the center line of the xaxis.
To access the available data viewers:

TYPES OF VIEWERS
The Moving Strip Chart viewer, shown in Figure 7.5, displays
successive single measurement data points in time from left to right in
the viewer. As a measurement/save is repeated, the most recent
datapoint is appended to the plot to provide a running display over
time.
The Polar viewer, shown in Figure 7.6, displays data points in a polar
coordinate system - where each point is determined by the distance
from a reference point and an angle from a reference direction.
The Rectangular viewer, shown in Figure 7.7, displays data points in
a cartesian coordinate system with the measured data displayed on
the y-axis and the dependent variable along the x-axis.

© Roos Instruments Inc.

1. Compile the test plan and execute a Run to populate data saves,
or local variables with measurement values.
NOTE: The test plan must be compiled in order to access the plot viewer. Plot view
fields are populated after data is captured.

2. Left click within the gray area of the measurement block, or data
save/variable button to open the Select Viewer Window as shown
in Figure 7.10.
3. Left click on the desired plot view and click Select to open the
viewer.
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FIGURE 7.5 MOVING STRIP CHART PLOT EXAMPLE
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FIGURE 7.6 POLAR PLOT EXAMPLE
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FIGURE 7.7 RECTANGULAR PLOT EXAMPLE
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FIGURE 7.8 SMITH CHART PLOT EXAMPLE
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FIGURE 7.9 STRIP CHART PLOT EXAMPLE

Troubleshooting | Viewing Data

FIGURE 7.10 ACCESSING DATA PLOTS VIEWERS

The Strip Chart is typically used with the Overpaint and Line Type >
Points menu options as shown above.
With a compiled test program, left click on any Data Save, Array, or
Local Var button to open the Select Viewer window to access data
plots.

© Roos Instruments Inc.

617

Cassini ATE System Reference Guide

Troubleshooting | Viewing Data

PLOT VIEW FIELDS
Within the plot viewer window are several display fields and plot view
options described in the following text.
NOTE: The viewer fields are populated after a Run of the test plan.

USER

Y PARAMETER

Y PARAMETER

power

The Y Parameter field displays the data type of the y-axis values in the
plot. This field is populated once the test panel is executed and data
is available in the viewer. If there are multiple data types stored in a
displayed array, the data type can be selected by left clicking on the
field and selected the desired type.

on a RiTestSystem at 2017-01-02-03.04.05

USER

NORMALIZE

The User option is a text field that is auto-filled with a time stamp to
reflect the time of capture. The text field can be edited by left clicking
within the field to open a text edit window.

OFF

MEMO

save

NORMALIZE
MEMO
Memo is a text field for optional documentation/commentary that can
be edited by left clicking within the field to open a text edit window.

© Roos Instruments Inc.

The Normalize fields allow the user to view the difference between a
user-specified reference plot and subsequent data in the plot viewer.
The reference data/plot is selected by left clicking on the save field for
the desired plot. To then plot the difference between the saved
reference data and subsequent data runs in the plot viewer, left click
on the OFF button to change its’ value to ON. On a repeated run of
the test program, the plot viewer will display the difference between
the saved reference and the current run of data in the plot viewer. The
ON/OFF button can be selected at anytime to switch between the
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standard and normalize display in the plot viewer when a saved
reference has been selected.

MAX X

MAX X
Y FORMAT
log

Y FORMAT

The Y Format field sets the unit of measure of the y-axis in the plot
viewer. It can be changed by left clicking on the field and selecting
from the list of options.

The Max X field displays the maximum value of the x-axis of the plot
viewer. The default value is set by the highest value of the
independent variable or index such as a frequency sweep or power
range of an instrument during a measurement. It can be set manually
by the user by left clicking on the field and inputting a value within the
range of available indices or index values.

NOTE: The Y Format options are set by the Y Parameter field/data type of the
displayed measurement, Data Save or variable.

PARAMETER

PARAMETER
MIN X

MIN X

1

The Min X field displays the minimum value of the x-axis of the plot
viewer. The default value is set by the lowest value of the independent
variable or index such as a frequency sweep or power range of an
instrument during a measurement. It can be set manually by the user
by left clicking on the field and inputting a value within the range of
available indices or index values.

© Roos Instruments Inc.
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frequency

The Parameter field displays the data type of the x-axis values in the
plot. This field is populated once the test panel is executed and data
is available in the viewer. The field defaults to the data type of the
independent variable after the test plan has been executed, i.e ‘frequency’ for a frequency sweep or ‘power’ for a power range of an
instrument during a measurement.
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FORMAT

FORMAT

MHz

scale value by left clicking within the field and inputting the desired
value in the pop-up window.
Y CENTER

The Format field sets the unit of measure of the x-axis in the plot
viewer. It can be changed by left clicking on the field and selecting
from the list of options. The field can be changed to display the
indices of the independent variable by left clicking on the field and
selecting ‘index’ from the options list.
NOTE: The Format options are set by the Parameter field. When plotting from a Data
Save, the Format field defaults to selected Data Save format.

Y SCALE
Auto

Auto
0

Y CENTER
The Y Center options control the value of the centerline of the y-axis in
the plot viewer display. The Auto field sets the y-axis center line value
based on the average value of the data by left clicking within Auto
field box once data has been captured. The numerical field displays
the y-axis center line value and allows the user to set a value by left
clicking within the field and inputting the desired value in the pop-up
window.

/DIV
1

Y SCALE
The Y Scale options control the step size of the y-axis in the plot
viewer display. The Auto field allows the user to set the y-axis scale to
fit all values of the data within the plot viewer display by left clicking
within Auto field box after data has been captured. The numerical field
displays the y-axis scale/step size value and allows the user to set the

© Roos Instruments Inc.
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MULTI-PARAMETER PLOTS

Troubleshooting | Viewing Data

FIGURE 7.11 SELECT PLOTTING AXES WINDOW

Measurements or data save/variables with multiple dependent
variables such as measurements with frequency and power range
sweeps can be viewed with multi-parameter plots as shown in Figure
7.12. This mode is activated automatically when measurement data is
created with multiple independent variables in a test panel. Multiparameter plots allow the user to view plots with two independent
variables. Once the plot type is selected, the user is prompted to
select the plot axes from the available independent variables in the
Select Plotting Axes window as shown in Figure 7.11 and described
below:
1. Select the x-axis variable by left clicking on the desired parameter
to highlight it.
2. The remain variables become available as selections in the color
parameter. Left clicking on the desired parameter to highlight it.
3. If more than two independent variables are available for the data,
the remaining unselected variables must be held constant by
selecting them and setting them to an available value in the Fixed
Variables section.

Multi-parameter plots allow the user to select(highlighted) an X-Axis
and Color independent variable. Any remaining independent variables
must be set to a value in the Fixed Variable lists.

© Roos Instruments Inc.
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FIGURE 7.12 MULTI-PARAMETER PLOT EXAMPLE

Troubleshooting | Viewing Data

PLOT MENU OPTIONS
The plot menu options provide additional plot and display features of
the viewers. It can be accessed by right clicking within the plot viewer
graph as shown in Figure 7.13. The following text describes the menu
options and their functions.

FIGURE 7.13 ACCESSING THE PLOT MENU OPTIONS

The multi-parameter plot is typically used with the Overpaint feature as
shown above.

Right click on the graph display to access the pop-up menu options.

© Roos Instruments Inc.
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The Clear Traces option removes all plots from the viewer display.
The Redraw option refreshes the display view with the last data plot
only.
NOTE: Only the last run of data can be re-rendered with the Redraw’ feature.

The Trace 1 Color option sets the color all subsequent plots of the
data in the viewer from a list of colors.
NOTE: This option can be used in conjunction with the ‘Redraw’ option to update the
current plot with the selected ‘Trace 1 Color’ option.

Troubleshooting | Viewing Data
The Marker menu provides options for indicators that display the
corresponding x-axis and x-axis values in the plot graph:
The Marker > Clear option removes all markers from the plot.
The Marker > Max places a marker on the maximum y-axis value of
the last trace in the display.
The Marker > Min places a marker on the minimum y-axis value of
the last trace in the display.
The Marker > X places a marker on the last trace in the display at the
corresponding x-axis value input by the user. See Figure -.- for an
example.
NOTE: Generic markers can be placed anywhere within the display graph by left
clicking on the desired location. Left-click and drag performs a set of delta markers
between the first left-click location and the location where the left mouse button is
released.

The Grid Color option sets the color of the display grid from a list of
colors for all subsequent plots of the data in the viewer.
The Overpaint option provides plot persistence, allowing repeated
runs of the data to be retained in the plot display. This option is often
used in conjunction with the Trace 1 Color option to differentiate data
runs.
NOTE: Only the last run of data can be re-rendered with the Redraw option or changes
to the Y Scale, Y center, Min X, and Max X plot view fields.

© Roos Instruments Inc.

The LineType menu provides options for the display of data points
and data curves in the plot viewer:
The LineType > Normal option is the default mode of the data plot
viewer and displays a linearly interpolated curve between data points
in the graph display.
The LineType > Smooth option displays a third-order polynomial
spline curve between data points in the graph display.
The LineType > Points option displays each data point with an X and
no curve between data points.
The LineType > Histogram, LineType > CDF, LineType > Peaks,
and LineType > Binary are no longer supported.
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INSPECTING CALIBRATION
DATA
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FIGURE 7.14 ACCESSING CAL DATA

Calibration data is stored as path names tied to an Instrument’s
unique internal identifier and the TIM’s serial number. A TIM may
contain multiple Instruments. Calibrations are saved only after every
Validate PASS and may affect multiple instruments and TIMs.
Most problems are diagnosed by inspecting calibration data, setting
breakpoints, and directly controlling the system for the suspected
instrument.
1. Choose System > Tester, to open the configuration window.
2. Left mouse click the instrument to highlight it.
3. From the menu options, select Instrument > Calibration >
Inspect to open a Calibration Data viewer as shown in Figure 7.
14.
4. Left mouse click on a calibration name to select it in the list and
view the data in the right pane.

Inspect Calibration data for each instrument using the Variable
Inspection Window

graphing plot as described in the Diagnostics Chapter’s “Viewing
Data” section.

WARNING: Do not edit calibration data. Altered calibration data
can cause erroneous signal outputs, measurements, and/or
unexpected software errors.

5. Right mouse click on the highlighted calibration data and select
‘View’ from the pop-up menu to open the calibration data in a
© Roos Instruments Inc.

624

Cassini ATE System Reference Guide

Troubleshooting | Inspecting Calibration Data

FIGURE 7.15 ACCESSING CAL VARIABLES DATA

RMB click on any Calibration variable allows for viewing of that data for
each instrument using the data viewers.

VIEWING DATA WITH GRAPHS
For more information about Graphs, see Viewing Data section of the Diagnostics Chapter.

© Roos Instruments Inc.
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CHECKING FOR VALID
CALIBRATION DATA

Troubleshooting | Checking For Valid Calibration Data

2. Select any Instrument, RMB click and choose Calibration >
Restore. Confirm by pressing OK button, even though we will
NOT be changing the Cal Data. The Date and Time at the bottom
of the list represents the currently loaded Cal data.
3. Choose cancel to close the window without affecting the Cal
Data. If select was pressed, a new Cal Data entry will appear with

OVERVIEW
Invalid calibration data can cause a fully functioning TIM to report a
failure result when performing Diagnostics. Use the Configuration
window to confirm that the Date and Time of the Cal Data is valid.
(See Calibration and Diagnostic Information)

FIGURE 7.16 INSPECTING CAL DATA FOR INSTRUMENT

If the TIM was recently installed from a factory repair, the Date and
Time should be less than a week. If the TIM participates in the RF
System, all TIM instruments should have the similar Date and Time
that is not earlier than the system’s last Calibration date.
CAUTION: Using the Calibration > Restore function can replace the calibration data of
the selected TIM. Always “cancel” the restore when only inspecting the TIM’s
calibration date and time.
To inspect the Instrument’s Calibration Date and Time:
1. Open the Tester Configuration window by choosing System >
Tester from the Cassini main system window.

The last Date and Time listed is the current Cal Data that is loaded. If
that date is before the last know system Cal Date or before the date it
was sent to RI for repair, try loading the Cal Data from RI or follow the
Calibration Procedure for the stand alone TIM or all the RF System
TIMs.

© Roos Instruments Inc.
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the current date and time. Data is never deleted, only saved as
the most recent.

© Roos Instruments Inc.
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SECTION 7

ERROR AND WARNING
MESSAGES

Troubleshooting | Error and Warning Messages

FIGURE 7.17 LOG FILE WINDOW

MESSAGES WINDOW
The System Software displays warning and error messages in the
Messages Window or Log File that acts as the console for the system
software. The message window will appear automatically when
messages are first displayed. New messages appear at the bottom
and will scroll old messages up.
This window can be opened by selecting System > Messages from
the Cassini main system window.
Choose the Cancel button to close the Log File menu.
Use the Less button to scroll down to the most recent message,
More button to scroll up to the oldest message and Clear button to
erase all messages.

This window displays warning and error messages as well as
standard console messages.

Choose Text button to convert the current log into a text file that can
be saved or edited.
NOTE: Important error and warning messages appear in red.

© Roos Instruments Inc.
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SECTION 8

SOFTWARE ERRORS AND
RECOVERY
RI SOFTWARE EXECUTION ERROR HALT
1. When an Error Dialog box appears select “Save”. A vRtError.log
file is automatically created and is located in the D:
\RiApps\GuruApps\GF10RC2A directory. This will assist RI
Support in recreating the conditions of the issue.
2. If developing Test Plans using the Test Plan editor, select File >
Clear Compile. This will clear out the memory allocated to the
Test Plan and reset the pointers so the Test Plan will be ready to
compile again. It the error persists check your Test Panels for
errors and then move to step 3.
3. In the Cassini application window, select System > Reset. This
will reset all the system variables, including reloading calibration
data, and terminates multithreaded processes. If a hardware error
exists, it must first be cleared and the reset process repeated.
4. Attempt your task again, if the issue persists, contact RI Support.

© Roos Instruments Inc.
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SOFTWARE RECOVERY - FIRST ATTEMPT
If a hardware issue cannot be resolved by closing the offending
program, it may be necessary to interrupt the operating system to
remedy the issue. Follow the instructions below for terminating
unresponsive programs.
1. Press and hold Ctrl+Break. This will halt any running RI
Application program and display an error dialog box.
2. Select “Save” to close the Failure dialog box.
3. From the Cassini main system window, select System > Reset.
This will reset all the system variables and terminates
multithreaded processes. If a hardware error exists, it must first be
cleared and the reset process repeated starting at step 1.
4. If the issue persists, Contact Roos Instruments support
(support@roos.com) including the vRtError.log file located in the
Guru application directory as well as the procedure to recreate the
issue. This will assist RI in recreating the conditions of the issue.
5. Select the Cassini application window then select System > Quit.
A dialog box will appear that asks, "Are you sure?", select ‘YES’.
6. Restart the Cassini application and follow the standard startup
procedure.
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SOFTWARE RECOVERY - SECOND ATTEMPT
In the event that a hardware or RI system software issue is not
resolved, it may become necessary to interrupt the frozen RI system
software and have the eCS operating system terminate its operation.
1. Press and hold Ctrl + ESC. This will display a Window List (system
process) dialog box will be displayed.
2. Right click on the Cassini application, then select Close from the
pop-up menu. Click ‘Yes’ to terminate the RI System software.
3. Once the system CPU monitor goes to zero, restart the RI System
Software.

SOFTWARE RECOVERY - FINAL OPTION
If a hard operation system crash occurs, it becomes necessary to
interrupt the frozen User Interface and have the BIOS terminate the
operating system.
1. Press and hold Ctrl+Alt+Delete keys. A blue recovery screen will
appear.
2. Use “Top” (Press “T”) to identify and kill any processes that are
consuming CPU resources. Press “K” and enter a process
number. After killing any processes, press ESC twice to return to
the User Interface.

Troubleshooting | Software Errors and Recovery
4. If the UI is still not responding, Press CTRL + ALT + DELETE Key
once to get the blue recovery screen and then CTRL+ALT+DEL
keys again to reboot.
5. Once the system controller restarts, start the RI System Software
again.
NOTE: The RI System saves each part's test data after all of that part's tests have been
performed. Lot data is saved to Guru periodically (every 100 parts), so that most test
data for a lot can often be recovered using the STDF Recovery agent.

DOCUMENTING SOFTWARE ISSUES
If a user reports a software anomaly, please help us make the product
better by e-mailing support@roos.com with the following information:
• ShortCut used.
• Description of the issue found.
• Procedure to duplicate the issue.
• Text copies of any error messages and the error save file,
vRtError.log from the D:\RiApps\GuruApps\GF10RC2A directory.
NOTE: Error logs are saved in the program’s directory organized by Guru ID, use the
Guru App table on the next page to identify common product IDs.

3. If problem persists, press Ctrl + Alt + Delete Key and try to Reset
WPS (Press “W”), then press ESC to return to the User Interface.
© Roos Instruments Inc.
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SECTION 9

SYSTEM CONTROLLER
(EPC) ISSUES
SYSTEM CONTROLLER (EPC) ISSUES
• Startup Failure? Access Recovery Menu (ALT + F1 to enter
recovery menu)

Troubleshooting | System Controller (EPC) Issues

There are two function key combinations that can be activated while
the white blob appears on the screen followed by the word OS/2.
These are Alt+F1 which will interrupt the boot process and take the
user to a recovery menu, and Alt+F2 which will continue the boot
while displaying the name of each device driver as it is loaded to help
identify the driver causing problems.
The recovery menu that comes up when the user presses Alt+F1
contains options to help star the system, although in some cases the
system may still not be recoverable. Options contained in this menu
include:

• Press "1" to restore desktop (restore factory UI, all Guru Apps
settings preserved)

• ESC to continue with the normal boot process

• Press "F2" to enter command prompt

• 1, 2, or 3 to restart from one of the last three archives that the
user created.

• TIM swap for hardware failure (including HDD)

NOTE: The restored archive does not affect any Guru settings.

WARNING: Always contact Roos Instruments support prior to
attempting any of the following troubleshooting steps.
Roos Instruments support may instruct the user to enter the
command line and be given specific instructions on what to change. If
the system controller (EPC) fails to load, press ALT + F1, then press
"1" to restart from the factory configured Archive.

• F2 to boot to a command line without starting the graphical
interface. From here “MAKEINI” can be ran to rebuild the
desktop or use “TEDIT” (a small command line editor) to fix
corrupted configuration files.
• F3 to reset the video mode back to VGA, bypassing the installed
graphics driver. A useful option if the video driver gets corrupted
or is set up incorrectly.

© Roos Instruments Inc.

631

Cassini ATE System Reference Guide
• F4 to restart the system with a maintenance desktop. From here
selective reinstall options can be used to rebuild the corrupted
part of the system.
• F5 enables FULL hardware detection.
• F6 disables hardware detection. This is useful if there are
problems with plug and play adapters.
• 0 recovers from the original archive of the system setup that was
taken when the system was first installed.

Troubleshooting | System Controller (EPC) Issues

GURU SERVER (VM OR LINUX) ISSUES
• Reload Guru: From "Guru bar" select System > Shutdown
• Guru Server ("startApp.sh" and "es" processes)
• Kill process: "ps -A > grep es" to see PID, "kill -p <PID>" for
each PID
WARNING: Always contact Roos Instruments support prior to
attempting any of the following troubleshooting steps.
The Guru Server runs on a Virtual Machine or native Linux server. A
dedicated user "riguru" should be created on the host OS. The
program is installed in the "$HOME/RiApps" directory or "~/RiApps/"
folder and data stored in "~/RiGuru/" folder.
The process is launched by a "startApp.sh" that should be added to
the GUI's desktop (KDE or Gnome) standard auto-start location.
NOTE: A GUI is required because Guru Server cannot launch without a GUI.

When Guru starts, the program files are always copied fresh from the
"guruServer.zip" container and then launched. This step assures
consistency and prevents any random HDD read or write errors
related to aging from interfering with the program launch. If the script
fails to properly unpack the program from the guruServer.zip file, the
script launches the version that remains on the disk.
© Roos Instruments Inc.
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To prevent Guru from restarting, kill the "startApp.sh" process.
Normally the Guru Server application automatically restarts when the
user selects System > Shutdown. This prevents the service from
being inadvertently shutdown.

GURU CLIENT (SYSTEM CONTROLLER) ISSUES

If the Guru server is unresponsive or needs to be stopped for any
reason, the user can open a command window as root and issue "ps
-A > grep es" command to see the process ID (PID) of the Guru
server. Force the process to stop with "kill -p <PID>" for each
process identified. If the problem persists after a restart, copy
"guruServer.zip" from a known working backup. If the problem
continues, try restarting the host OS. Some OS upgrades may
remove or relocate critical system files and may require a symlink ("ln
-s /path/to/file") to be created to maintain backward compatibility.

• Still not responding? CTRL + ALT + DEL, TOP, "guruServer"
process

If a walkback occurs, select "SAVE" from the dialog box and send the
error log (~/RiApps/vterror.log) to support@roos.com.

• Reload Guru: From "Guru bar" select System > Shutdown
• If Guru Client hangs: Ctrl + ESC, select "Guru" window, hit DEL

WARNING: Always contact Roos Instruments support prior to
attempting any of the following troubleshooting steps.
The Guru client runs on the RI System Controller powered by an
embedded OS/2 based operating system. No user accounts are
required on the host OS. The program is installed on "D:\RiApps" and
the data directory is "D:\RiGuru".
The process is launched by the Local System > Startup folder as
"RI Guru Startup" (or similar).
When Guru starts, the program files are always copied fresh from the
"guruServer.zip" container and then launched. This step assures
consistency and prevents any random HDD read or write errors
related to aging from interfering with the program launch. If
guruServer.zip is corrupted, the program will eventually attempt to
launch the previous unpacked version.

© Roos Instruments Inc.
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To prevent Guru from restarting, kill the "Guru Server Startup"
process. The Guru Server application automatically restarts when
"Shutdown", this is how Guru is automatically upgraded and prevents
the service from being inadvertently shutdown. The Guru Client
application will automatically restart when Shutdown, this is to prevent
users from accidentally closing Guru.

© Roos Instruments Inc.
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SECTION 10

RECOVER FILES WITH GURU
BROWSER
Cassini Maintenance Manual - 5 - Using the System Controller

Troubleshooting | Recover Files with Guru Browser

BROWSING GURU OBJECTS
Upon opening the Guru Browser, the user should specify a search
parameter or 'Key 1' to identify which Guru object attribute the user
would like to browse, by default this is set to ri.sys.ObjClass.
Cassini Maintenance Manual - 5 - Using the System Controller

Import, Export, & Recover Files with Guru
Open this topic online @ http://roos.com/docs/RBEH-8FWVC4

The Guru Browser application allows the user to browse, recover,
import, and export files from the Guru database as Guru objects.

For example, if the user wants to browse the RiPatch objects, choose
Browser
the RiPatch from the list and all available RI Patches are displayed to
Browsing
Objects
the right
side of theGuru
window.

Once the Guru Browser application comes up, you first must specify a searc
identify which Guru object attribute you would like to browse , by default this
FIGURE
7.19
GURU
BROWSER
list of
object
classes,
please refer to RI Guru Object Classes document.
The Guru
Browser
allows you
to browse
, recover, import, and export files from theaGuru
After logging
on to
Guru,application
select Apps
> Guru
Browser.
database as Guru objects.

After logging on to Guru, click the Apps then select Guru Browser.
Browser

FIGURE 7.18 SELECTING GURU BROWSER

By default the Guru Browser is set to ri.sys.ObjClass
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For example, you want to browse the RiPatch objects, therefore you'd choos
635 as
and all available RI Patches are displayed to the right side of the window

Cassini Maintenance
Manual - 5Reference
- Using the System
Controller
Cassini
ATE System
Guide

Browsing Guru Objects
To specify what information is displayed select Options > Config
Once the Guru Browser application comes up, you first must specify a search parameter or 'key1' to
Table
View.
default
displays
ri.sys.Name
and
ri.sys.ObjClass .
identify which
GuruThe
object
attribute window
you would like
to browsethe
, by default
this is set to
a list of object classes, please refer to RI Guru Object Classes document.
ri.sys.CreationDate information. The information can be sorted by
selecting Ascent or Descent. Select Refresh Table below the
object list to refresh the table and apply the sorting selection. The user
can also choose to display all of the available objects by choosing All,
or only display the last object by choosing Last, or specify how many
objects are displayed by choosing SelectNumber and entering the
maximum number of objects to display.

Troubleshooting | Recover Files with Guru Browser

For

FIGURE 7.20 BROWSING RIPATCH GURU OBJECTS

Cassini Maintenance Manual - 5 - Using the System Controller

This will display 7.21
the following
window.TABLE VIEW
FIGURE
CONFIG

For example, you want to browse the RiPatch objects, therefore you'd choose the RiPatch from the list
and all available RI Patches are displayed to the right side of the window as shown below .

You can specify what information you want to be displayed. The above window, displays the ri.sys.Name
and ri.sys.CreationDate information. You can configure what to be displayed by selecting the Options >
Config Table View menu.

The right side of the window shows the Guru Objects

© Roos Instruments Inc.

You can
select theKeys
keys from
the Available
Keys
and information
click the right arrow
to add to theSelecting
Viewed Keysan
. To
The
Available
column
displays
what
is available.
remove any specific keys from the Viewed Keys , select the key you want to remove, then click the left
Available
Key and
clicking
the arrow
pointing
right
addat the
key toof the
arrow. To change
the order
of the keys,
use the up
and down
arrowwill
buttons
the bottom
the Viewed
Keys
display.
When
done,
click
the
Save
button.
Viewed Keys. To remove select the key in the Viewed Keys column and click the
arrow pointing left. To reorder the keys in the Viewed Keys column click the up

and down arrows. When done, select Save.
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EXPORTING A GURU OBJECT

RECOVER A GURU OBJECT

To export a Guru object using the Guru Browser application, select
the object to be exported. Right click the object, and select Export >
send to Export List. At the bottom of the RI Guru Browser window,
select the Guru Export List tab. It is possible to export more than
one Guru objects at a time. When finished adding all of the Guru
objects to be exported, select Export. Enter any comment the user
would like to add to the export objects.

To recover a Guru object using the Guru Browser application, select
the object the user wants to recover and make it the last revision. The
following window displays an example of recovering RiTest Plan
object
with title
of test
plan01.
First,
'key1' is set to ri.sys.ObjClass
Cassini Maintenance
Manual
- 5 - Using
the System
Controller
and select RiTest Plan as the object class. Then, select test plan01
from
the list. Once
a Guru
object has been selected, click the Revision
RECOVERING
a GURU
OBJECT
History
the bottom
of the
window.
To recover page
a Guru object
using the Guru
Browser
application, select the object you want to recover and

Select a directory the user wants to save the exported file at by
selecting the ‘Look in:’ field; and enter a filename in the ‘File name:’
field. Typically, the user would leave the file type as default (.gzp).
When done making your selections, click Export. This will create a
Guru Zip file that includes all the objects that were selected and can
now be saved, stored or transported to another Guru. This is very
useful for sending files or objects to RI for support questions etc.

make it the last revision. The following window displays an example of recovering RiTestplan object with
title of testplan01. First, 'key1' is set to ri.sys.ObjClass and select RiTestplan as the object class. Then,
select testplan01 from the list.

FIGURE
7.22
RECOVER
A GaURU
BJECT
Note: Each Guru
Application
may have
moreO
direct
method for accessing previous versions, like the
Show Test Objects. menu in the Test Plan Editor.

IMPORTING A GURU OBJECT
To import a Guru zip file that includes Guru objects, use the Guru
Browser application. Select the Guru Import List tab of the Guru
Browser window. Click on the Get Import File(s) button to select
which Guru objects to import to the local Guru. Select the directory
and filename for the imported file, then click on the Import button.
Press the "Import" button in the Guru Browser to add the selected
files to the local Guru.

Once you've selected a Guru object, click the Revision History page the bottom of the window.

© Roos Instruments Inc.

Select the desired object and select the Revision History tab
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The window now displays the list of the available versions of the
selected Guru object. Select the one to recover from, right click, and
select Make Last RevisionOf. This step makes the selected object
the latest version in Guru. DO NOT use this to revise application
objects (i.e. use a previous version of the Device Connection Editor)
without specific instructions from RI Support.

Cassini Maintenance Manual - 5 - Using the System Controller

FIGURE 7.23 RECOVER A GURU OBJECT

The above window displays the list of the available versions of the selected Guru object. Select the one
Right
click the desired version and select Make Las RevisionOf to make that
which you want to recover from and right click mouse button and select Make Last RevisionOf. This

step makes
selected
object to be the latest version in Guru. DO NOT use this to revise application
version
thethe
latest
in Guru.

objects
(i.e. Instruments
use a previous version
©
Roos
Inc. of the Device Connection Editor) without specific instructions from RI
Support.

638

SECTION 11

GURU NETWORK ISSUES

The Guru Address Book Admin application allows the user to create
and update Guru Server network addresses which are used to
connect Guru Clients (the Cassini System Controller or Virtual
Workstation) to a Guru server. After logging on to Guru, select Apps >
Guru Address Book Admin. The user must belong to a group with
"Admin" permission to see the Address Book application.

CREATING A NEW GURU ADDRESS
Select New Remote Address. Enter the Name for this Guru
address, for example, 'Update01'. Enter the host name or static IP
Address of the Guru which the user wants to connect to in the
Address field. The Port field should be specified as 50000. The
server should be located on your local network. The Address Type
field can be specified as “backup”, “update”, or “general”. The
"backup" type stores all of the local objects for later retrieval. The
"update" type is reserved for servers that are to be checked regularly
for updates. Standard configurations use the same server for both
“update” and “backup” types to function properly. The “datalog” type
is for transferring data logs. The “clone” type is used exclusively for
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Guru Servers. The “general” and “admin” types are used for
temporary connections with some Guru Apps.
When done specifying all the fields, click the Save button. When done
adding the Guru address (es), the Guru process will need to
shutdown and restarted. To shutdown the RI Guru process, select
System > Shutdown to shutdown the RI Guru process. The RI Guru
will restart automatically.

UPDATE AN EXISTING GURU ADDRESS
Select the Guru address which the user wants to update. Select Edit
Selected. Update all the necessary fields, then click Save. When
finished adding the Guru address (es), the Guru process will need to
be shutdown and restarted.

REMOVING AN EXISTING GURU ADDRESS
Select the Guru address which the user wants to remove, then click
Delete Selected. Click OK if the user really wants to remove the
selected Guru address (es). The Cancel button will abort the deletion
process. When finished removing the unwanted Guru address (es),
the Guru process will need to shutdown the RI Guru process and
restart it.
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20 GHZ SOURCE SELF TEST

Viewing Self Test Results

OVERVIEW

If the 10 MHz clock and internal phase lock components are
functioning properly, the Message window will display “<Tester
Name> self test Passed” at the end of a long list of instrument names
passing their self tests. If the Message window displays “<Tester

Subtle problems with the RI7725 20 GHz Source TIMs can be
identified with Self Test.
Execute Self Test

The results of the Self Test appears in the Message window (see
Figure 1.61) instead of the Results pane. Although all instruments may
include an embedded “self test”, only the RI7725 model sources have
nontrivial results.

FIGURE 7.24 SELF TEST FAILED RESULT

The test system’s primary instrument diagnostics can be accessed
from the Configuration Window by selecting Tester > Diagnose from
the menu options as shown in Figure 5.1. This launches the
Diagnostic Executive (Exec.) and loads the factory-installed diagnostic
test plans for the test system (see Figure 5.14). The diagnostic tests
are listed in order of ascending instrument number and grouped by
TIM.
NOTE: Self Test is not a prerequisite for Calibration.

Choose Run > Self Test menu selection from the Diagnostic Exec
window. The Self Test does not need to be run unless the 20 GHz
Sources are suspected.
If any failure was detected, the last line displays a message with the
© Roos Instruments Inc.
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Name> self test FAILED!” in red, then press Text button to see the
instrument name that has an issue.
Use File > Save to create a file to send to RI Support to assist in
resolving the issue.

FIGURE 7.25 20 GHZ SOURCE SELF TEST FAILURE DETAILS

Choose the UP button to see the details of the Self Test failure.

© Roos Instruments Inc.
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• Lock the test head manipulator arm in the ‘Maintenance
Position.’

BEFORE SERVICING THE INFRASTRUCTURE
CHASSIS:
• Exercise proper ESD procedures with the Cassini test system,
fixtures, TIMs, and auxiliary equipment.

The Cassini 16 Infrastructure provides three access panels to service
various parts of the Cassini infrastructure.
Contact Roos Instruments support at support@roos.com for specific
instructions for diagnosing or replacing damaged or suspected
malfunction of infrastructure components. For servicing the Small
Cassini or Large Cassini infrastructures, contact Roos Instruments
support at support@roos.com for instructions for diagnosing or
replacing damaged or suspected malfunction of infrastructure
components.

BEFORE SERVICING ANY PART OF THE
INFRASTRUCTURE:
• Exercise proper ESD procedures with the Cassini test system,
fixtures, TIMs, and auxiliary equipment.

• Remove any TIMs, fixture or diagnostic/calibration plate, and
auxiliary equipment from the test head.
• Lock the test head manipulator arm in the ‘Maintenance
Position.’
• Rotate and lock the test head into the upright position.
• Follow the shutdown procedures outlined in the Operator &
Safety Information section.
• Verify that the ‘Main Breaker’ is switched to the OFF position
before performing any infrastructure maintenance.
WARNING: Failure to power down the test system and set all
circuit breakers to their OFF position before servicing can result in
damage to components and possible injury to service personnel.

• Undock the test system from handlers or probers and disconnect
any Handler/Prober or GPIB pods.
• Remove any fixtures or diagnostic/calibration plates from the test
head.
© Roos Instruments Inc.
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Power Supply Module Service Panel

IMPORTANT Switch the "Main Breaker" to OFF before opening the Power Supply
Module service panel.

POWER SUPPLY ACCESS PANEL
The power supply access panel, shown in Figure 7.26, provides
access to the AC/DC switching power supply modules. To access the
supplies, remove the two 4-40 retaining screws of the panel with a #1
Philips screwdriver.

FIGURE 7.26
EMOVING
THE Pcan
OWER
SUPPLY ACCESS
PANEL
The 2 R
power
supply blocks
be independently
replaced
when needed .
single retaining screw with a #3 Philips Screw.

Remove t

Tap for Zoom View

Every Cassini 16 system is configured with two power modules to
provide a primary 48V supply and secondary 48V supply as a backup
as shown in Figure 7.27. The modules have two green status
indicator lights. The upper light(closest to the mounting screw)
indicates that the module is connected to AC power. The second light
indicates that module is functional and producing 48V supply. These
supply modules can be independently replaced as needed and
should be checked in accordance with the recommended
preventative maintenance schedule.
To replace a module:
1. Power down the test system in accordance with the Shutdown
procedures.
2. Unscrew the module’s mounting screw with a #2 Phillips head
screwdriver.

Screw locations for removing the power supply access panel are
shown above. Use a #1 Philips screwdriver to remove the screws.

3. Insert the new module (Figure 7.28) in the corresponding
location and tighten the mounting screw.
4. Replace the access panel and secure it with the two 4-40
screws.
Page 141
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FIGURE 7.27 SWITCHING POWER SUPPLY MODULES LOCATION

Troubleshooting | Infrastructure Power Distribution

FIGURE 7.28 SWITCHING POWER SUPPLY MODULE

The above pictures shows the location of the redundant switching
power supply modules of the Cassini 16 test system. The two green LED
lights on the top modules indicates normal operation. The lower
module with only one green LED light active indicates a failed or
malfunctioning module.

© Roos Instruments Inc.
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FIGURE 7.29 REMOVING THE MAINFRAME ACCESS PANEL
Cassini Maintenance Manual - 6 - Troubleshooting

The mainframe access panel, shown in Figure 7.29, provides access
to the AC/DC switching power supply unit, RIFL bus, pneumatic
fixture docking system’s air ducts, and control boards for the
manipulator’s elevator lift, EMO switch, and infrastructure.
Tap for Zoom View

WARNING: Never tamper with or attempt to service components in
the infrastructure without support or assistance from Roos
Instruments engineers or technicians.
To access the main frame components:
1. Unscrew the six 4-40 Philips head screws, two Allen head
screws, and Auxiliary Rack mount plate from the front of the
panel.
2. Slide the panel away from the chassis by pulling outward as
shown in Figure 7.29.

Screw locations for removing the mainframe access panel are shown
above. Use a #1 screwdriver for removing and inserting the panel
screws. Use a 5/32 in Allen wrench to remove and reinsert the
Page 143

auxiliary rack mount plate screws.
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FIGURE 7.30 INFRASTRUCTURE CHASSIS INTERNAL VIEW

EMO Relay
AC/DC Power Unit

Infrastructure
Control Board

The above pictures shows the internal components of the infrastructure
chassis with the mainframe access panel removed.

© Roos Instruments Inc.
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TEST HEAD ISSUES

Troubleshooting | Test Head Issues

• Remove any fixtures or diagnostic/calibration plates from the test
head.
• Lock the test head manipulator arm in the ‘Maintenance
Position.’

BEFORE SERVICING THE TEST HEAD:
The Cassini 16 test head contains the external RIFL hub, front and
rear test head RIFL hubs, 48V supply distribution, and the pneumatic/
mechanical components of the fixture docking system. This section
provides steps and guides for accessing and servicing the test head
resources. Reference the Block Diagram 8.11 for the test head wiring
block diagram.
Contact Roos Instruments support at support@roos.com for specific
instructions for diagnosing or replacing damaged or suspected
malfunction of test head components. For instructions on diagnosing,
servicing, and replacing damaged or suspected malfunction of
components of the Small Cassini or Large Cassini test head, contact
Roos Instruments support at support@roos.com.

• Remove all TIMs from the test head.
• Rotate and lock the test head into the horizontal position to
access the service panel and/or RIFL test head hubs as shown
in Figure 7.31.
• Power down the test head 48V by switching the secondary
breakers to their OFF positions (Reference Figure 1.17 for
locations).
NOTE: For early model Cassini, switch the TIM FRONT, TIM REAR, and Test
Head breakers to their OFF positions to disconnect 48V from the front test head RIFL
hub, rear test head RIFl hub and external test head RIFL hub located inside the test
head. For late model Cassini, switch the HEAD breaker to the OFF positions to
disconnect 48V from the front test head RIFL hub, rear test head RIFL hub and
external test head RIFL hub located inside the test head.

BEFORE SERVICING ANY PART OF THE TEST HEAD:
• Exercise proper ESD procedures with the Cassini test system,
fixtures, TIMs, and auxiliary equipment.
• Undock the test system from handlers or probers and disconnect
any Handler/Prober or GPIB pods.

© Roos Instruments Inc.

• Verify that power has been removed from the test head by
checking that the ALIGN and DOCK indicator lights on the side
of the test head are both off. If the indicators lights are still ON,
power down the entire test system as described in the Operator
& Safety Information section.
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Test Head Service Panel
IMPORTANT Switch the "TIM Front" & "TIM Rear" (RevA) or "Head" (RevB) side
breakers to OFF before opening the Test Head service panel .
The Test Head service panel can be opened to access the RIFL board , Test Head fans,
control board, power distribution and other components in the Test Head .
The diagram below shows the 16 screw locations needed to remove the access panels
FIGURE 7.31
REMOVING THE TEST HEAD ACCESS PANEL
for either the Test Head or Front panel , 3 on the back, 12 on the top, and 3 on the front.
Remove ALL TIMs and rotate the top of the Test Head away (as pictured).

Troubleshooting | Test Head Issues

TEST HEAD SERVICE PANEL
The test head service panel, shown in Figure 7.31, provides access to
the test head internals: external RIFL hub, 48V power supply
distribution, front and rear test head RIFL hubs, pneumatic fixture
docking components, test head fans, and manipulator arm
mechanical components. The diagram shows the location of the
sixteen 4-40 type screws that must be removed from the panel to
access the test head.
Figure 7.32 shows the inside of the Cassini 16 test head. The swivel
joint assembly connects the test head to the manipulator arm to
provide pivotal movement for handler/prober docking alignment and
mechanical compliance. The External RIFL hub stack distributes the
RIFL bus to the front and rear RIFL test head hubs, and to the fixture
power supply board to route out to the fixture RIFL interface block.
The Fixture Power Supply is connected to the Fixture RIFL interface
block to provide the +28V, ±15V, ±5V power supplies and RIFL
communication bus. The pressurized air supply routes from the
infrastructure to the air manifold for distribution to the fixture docking
system. Restrictor

Tap for Zoom View

Screw locations for removing the test head access panel. Use a #1
Page 140

Philips screwdriver to remove the screws.

© Roos Instruments Inc.

648

Cassini ATE System Reference Guide

Troubleshooting | Test Head Issues

FIGURE 7.32 CASSINI 16 TEST HEAD INTERIOR
U-Bar

Rotational Lock
Assembly

Restrictor Plates

Air Manifold

Swivel Joint Assembly
External RIFL Hub
Stack
Fixture Power
Supply

The above pictures shows the Cassini 16 test head components and
their functions.

© Roos Instruments Inc.
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RIFL ISSUES

Troubleshooting | RIFL Issues

3. Highlight the “Master” element (usually the top of the list), RMB
click and select Rifl Test from the menu. (See Figure)
4. Enter “1” in the Times to Repeat dialog and choose OK. Increase
this number if a failure is not identified or is suspected to be
intermittent.

OVERVIEW
Each RIFL node is checked by performing simple I/O and loopback
tests. The test head contains RIFL Hubs that distribute RIFL packets
between the RIFL Master in the System Controller (EPC) and any
installed TIMs, Fixture Modules, and Handler/Prober/GPIB Instrument
Pods. Diagnosing RIFL communication issues are done from the
Equipment Pool.

5. The Message window displays a black “passed” message or a
red “failed” message each tested node as seen in Figure 7.34.
Use Less to scroll up to see any failures that may have scrolled
off the top of the Message window. If a “failed” message is
displayed, choose Text then File > Save to send to Roos

FIGURE 7.33 DIAGNOSE RIFL MASTER

NOTE: RIFL Diagnostic is not a prerequisite for Calibration. RIFL communications
can be tested for all nodes or a specific node.

To diagnose RIFL Master and all RIFL nodes:
1. Open the Messages window by choosing System > Messages
from the main Cassini window. Press the Clear button to remove
any previous messages.
2. Open the Equipment Pool by choosing System > Equip >
Nodes from the main Cassini window.
© Roos Instruments Inc.

Choose RIFL Test from the RMB click menu from Master entry in the
Equipment Pool window.
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Support to resolve the issue. See Example A to help identify a
failed instrument by node number.
To Diagnose a specific RIFL node:
1. Highlight the desired node from the Equipment Pool window,
RMB click and select Rifl Test. If a Hub is selected, each
attached TIM, Pod, or Fixture Module is tested.

Troubleshooting | RIFL Issues
To identify which TIM corresponds to a failed node, highlight an
instrument in the Equipment Pool and identify the Address in the
lower pane. See Example A) showing the “Testhead Inst T5
RfMeasure1” instrument that corresponds to the failed node number
“6”. Nodes are assigned based on how quickly they respond to the
RIFL Master and may change any time the system is started or when
a System > Start Up is run.

2. Enter “1” (or more) in the Times to Repeat dialog and choose OK.

EXAMPLE A RIFL TEST NODE IDENTIFICATION

FIGURE 7.34 RIFL TEST RESULTS

Failures are identified by red text in the Message window.
The failure at node 6 corresponds to the Equipment Pool Address => 6

© Roos Instruments Inc.

entry which is the 'RFMeasure1' instrument in test head location T5
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Troubleshooting | Handler Issues

connect a 16 gauge or higher ground wire from the Handler Chassis
to the System's rack.
To test a Handler Interface Pod, connect the pod, using the supplied
RIFL III cable, to the connector on the test head and the handler to
the pod with the custom handler cable.

The Hander Pod is configured at the factory and has it’s configuration
stored on the device itself. Hander Pods are available with different
interface options: Parallel (RI8517A), Serial (RI8516A), or GPIB
(RI8552A). Handler issues are generally resolved by checking the
connection between the handler and the RI ATE System or by
reconfiguring the handler. A ground wire may be necessary between
the test system and the handler to prevent power spikes.
In the case of irregular handler operation, first check the RIFL cable
that goes from the Handler Pod to the Handler's tester interface port
for kinks or damages. Make sure that the cable is NOT a standard
RJ-45 ethernet cable; it must have shielding. Most handlers have an
opto-isolator built into the tester interface that needs to be connected
to the tester power through the interface cable. Use a Voltmeter to
verify that the required voltages are present and that all the
connections are made.
Make sure the Handler and Tester are grounded to the same earth
ground (same AC outlet) so that no ground potential exists between
the Handler and Tester. If there is a possibility of ground potential,

From Cassini select System > Equip to open the Equipment Pool
window.
From Equipment Pool window, select Nodes > Pool > Control
Modules to open the Module Browser window.
In the Module Browser window find and highlight the Handler
Interface Module. It should look like, “RiXXXX Name” (Name would be
the name of the handler e.g. "Delta"). In the middle section highlight
“Handler”. In the lower section there are 3 boxes in the lower left.
These will be used to control the Handler pod signals and provide a
way to test the control logic with the Handler attached.

HANDLER POD TROUBLESHOOTING
If the user does not have a RI Monitor Handler Interface (M6XHRF1A),
the user can check bins 1 and 2:
1. Send a Bin and EOT signal to the handler by selecting the box
marked “PULSE BIN”.
2. In the “Choose” window, select a Bin (1 or 2).
3. The Bin and EOT lights should flash.

© Roos Instruments Inc.
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If the user does have a RI Monitor Handler Interface (M6XHRF1A), it’s
possible to check the bins:

CONNECTIONS FOR RI 8503A0 HANDLER

1. Connect the Monitor Handler Interface.

25 Pin Female D Sub type

2. Send a Bin and EOT signal to the handler by selecting the box
marked “PULSE BIN”.

INTERFACE

Pin

Function

Circuit Type

1

Bin1

Open Collector Output

2

Bin2

Open Collector Output

4. Watch for the Bin and EOT lights flash on the Monitor Handler
Interface (and on the handler pod for bins 1 and 2).

3

Bin3

Open Collector Output

4

Bin4

Open Collector Output

If a start signal can be sent to the handler pod, it’s possible to test if
the handler is sending a start test signal to the Roos system using the
box marked “WAITFORSTART”. To use this feature click on the box.
In the “Choose” window, select a Bin. This Bin number will be sent
from the tester to the handler after the handler pod receives a ‘start
test’ signal from the handler. Enter 1 for “How many to run”. The
tester will now display in the main message window “waiting for start”
and wait for a ‘start of test’ signal from the handler. When tester
receives a ‘start of test’ signal it will send the selected Bin and EOT to
the handler.

5

Bin5

Open Collector Output

6

Bin6

Open Collector Output

7

Bin7

Open Collector Output

8

Bin8

Open Collector Output

10

Start Test

TTL Input

11

+V(H)

Handler +V for Pull Up1

12

GND

Ground

13

+5V

System +5V

14

RI8503A0 is +5V

System +5V

15

Input2

Misc TTL Input, Not Used

16

Input3

Misc TTL Input, Not Used

17

Input4

Misc TTL Input, Not Used

22

Bin9

Open Collector Output

23

Bin10

Open Collector Output

3. In the “Choose” window, select a Bin.

© Roos Instruments Inc.
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Hander
Pod
Interface Troubleshooting
FIGURE 7.35 HANDLER
POD
TROUBLESHOOTING

If there are any non-RI instruments that have been added to the RI
ATE System that are controlled through the general purpose GPIB
bus, an inspection of the connections should be routinely made.
These types of instruments have a tendency to be a shared resource
and therefore the probability of an error being introduced is greater
every time the instrument is reconnected. When a GPIB instrument is
selected to be available to the system, a system startup should be
executed to check if the instrument is connected correctly and it's
GPIB address is correct. If there is any issue with the GPIB
programming of the instrument, it will be marked "Inactive" and a
warning message will be placed in the Message Window.
If there is a GPIB issue always check:
• The GPIB Address

If you do not have a RI Monitor Handler Interface
NOTE: Pin 11 must be connected
to the +V from the handler, Pin13, Pin 14.
and 2:

GPIB ISSUES

(M6XHRF1A), you can check bins 1

• That there is no "Daisy Chain" of the GPIB Cables

1. Send a Bin and EOT signal to the handler by selecting the box marked “PULSE
BIN”.
• The correct
2. In the “Choose” window, select a Bin (1 or 2).
3. The Bin and EOT lights should flash .

driver was selected

The
following
If you have a RI Monitor Handler Interface (M6XHRF1A ), you can check
bins:

list shows the basic thoughts to always keep in mind
when “PULSE
troubleshooting the Cassini Test System.
Send a Bin and EOT signal to the handler by selecting the box marked

Meters)
• GPIB cable length limit 1.(4 Connect
the Monitor Handler Interface .
2.

BIN”.
to make a longer run
• Don't extend GPIB cables
3. In the “Choose” window, select a Bin.

• Instrument made
•
•

1. Is the problem in the source path or receive path?

4. Watch for the Bin and EOT lights flash on the Monitor Handler Interface (and on
for bins 1 and 2).
"inactive"theif handler
it failspod
at Startup

2. Does
the problem:
If you have a means of sending a start signal to the handler pod , you can
test if the
handler is sending a start test signal to the ROOS system use the box marked
GPIB instruments must
have a unique address
“WAITFORSTART”. To use this feature click on the box . In the “Choose” window,
• Change with respect
select a Bin. This Bin number will be sent from the ROOS tester to the handler after the
handler pod
receives
a start test
the handler
. Enter 1 for “How many to run”. The
GPIB address must match
stored
address
in from
Tester
software
ROOS system will now display in the main message window “waiting for start”• and
wait
Change
with respect
for a start of test signal from the handler . When the ROOS receives a start of test signal
object
it will send the selected Bin and EOT to the handler .

to frequency?
to power?

3. Problems are commonly compounded

© Roos Instruments Inc.
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• One problem can cause multiple failures
• Be sure to look for the right problem

Troubleshooting | Handler Issues
ports. Using this process of elimination, it is possible to diagnose the
problem to a couple of possibilities before connecting any test
equipment.

4. When troubleshooting, the following steps should be taken.
• Run Diagnostics (all of them)
• Review failed data
• Look for patterns (only 1 port, direct receive path, etc.)
• Pull up test plan
• Rename to ‘Junk’
• Set breakpoint
• Run to breakpoint
• Open Controller
• Manipulate settings through controller
• Begin ‘halving’ signal path
• Isolate bad component
To diagnose RF problems, it is necessary to run all the tests, then look
for the patterns in the failures. For example, if a problem occurs at
RF3, but not RF2, 6, or 7, then the problem must be in some area
that’s unique to RF3. If the problem occurs at RF2, 3, 6, and 7, then
the problem must be with something that is common to all those
© Roos Instruments Inc.

655

SECTION 17
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Troubleshooting | Module Repair Tools

FIGURE 7.36 EXAMPLE TOOLS REQUIRED AT FACILITY

EXAMPLE TOOLS REQUIRED AT FACILITY
The following standard tools may be required to clean connectors or
repair TIM modules and are not included with Diagnostic Kit or
Calibration kit. (See Figure 7.36)
• 5/16 inch SMA Torque Wrench set to 7–10 in·lb (0.8 to 1.1 N·m)
(See Figure 7.37)
• Crescent Wrench Set (ISO Metric and/or ANSI Imperial)
• Allen Wrench sets (ISO Metric and/or ANSI Imperial)
• Phillips head Screwdrivers (ISO Metric and/or ANSI Imperial)
• Flat head Screwdriver
• Pliers (needle nose)
• Wire Cutters
• Flashlight
• Sharp Pointed tool (pick)

Example of tools that should be available at the facility and not
provided by Roos Instruments. These tools may be required to clean
connectors or field repair TIMs.

© Roos Instruments Inc.
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SMA TORQUE WRENCH
A SMA Torque Wrench is required to attach SMA and K (2.9mm)
type RF cables to various instruments during calibration. The
torque wrench should be set to 0.8-1.1 N∙m or 7-10 in∙lb. See
Identifying SMA and K (2.9mm) Connections for more information
about the similar connection types.
WARNING: Over-tightening a SMA or K connection could
permanently damage the connector. Under-tightening a SMA or K
connection can affect performance.

FIGURE 7.37 5/16 INCH SMA TORQUE WRENCH

SMA Torque Wrench should be set to 0.8-1.1 N:m or 7-10 in∙lb

© Roos Instruments Inc.
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APPENDIX
This section provides TIM:
• Descriptions
• Dimensions and
Locations
• Block Diagrams
• Software Instruments
• Performance
Specifications
• Endnotes

SECTION 1

RI7725: 0.01 TO 20GHZ
MICROWAVE SOURCE

Appendix | RI7725: 0.01 to 20GHz Microwave Source

DESCRIPTION
The RI7725 Microwave Source is a signal generator that produces
sinusoidal signals from 10 MHz to 20 GHz. The RI7725 provides
microsecond switching speed, high output power, low phase noise,
and excellent spectral purity sine wave signals. The source provides
+23 dBm at 20 GHz with -86 dBc/Hz phase noise at 10 kHz offset.
The RI7725 requires the use of a remote TIM to route signal resources
from the auxiliary rack to the Test Head.

KEY FEATURES
• 100 dB Dynamic Signal Range
• Microsecond Frequency Hopping & Settling

INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as “Source1”,“Source2”, “Source3”
in the panel dialog windows. This instrument can also be used as the
Local Oscillator (L.O.) for the system’s Receiver, identified as “RecLO”
Model and Name as it appears in the Tester Configuration:
• Source1, RI7725x .01 - 20 GHz Rf source
NOTE: The “1” in Source1 represents the enumeration of the RI7725 in the system
configuration. Multiple RI7725 instruments are enumerated incrementally by the system
as “1”,“2”,“3”, etc., in the configuration, edit, and control panels (i.e - Source1, Source2,
Source3, etc.). The “x” in RI7725x denotes the model revision number.

© Roos Instruments Inc.
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TIM LOCATION
The RI7725 is located in the Auxiliary Rack and uses an auxiliary rack
TIM, also referred to as a Remote TIM, to route resources to the test
head. Remote TIMs are typically placed closest to the Auxiliary Rack
(slots T1, T2, T15, T16). In a typical application, the source resources
are routed via RF semi-rigid interconnect cables on the fixture bottom
plate or interface plate to Test Set and/or Receiver TIMs.
NOTE: Always calibrate the named paths after modifying the layout (bends) in the cable
to maintain maximum signal fidelity.

TIM OPERATIONS
Reference the RI7725 section of the Graphical Programming chapter
for configuration, edit and control panels.

© Roos Instruments Inc.
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BLOCK DIAGRAM 8.1
Roos Instruments, Inc.

Block Diagram, 20 GHz Source TIM
RI7725C
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PERFORMANCE SPECIFICATIONS

Source
Frequency Range

10 MHz to 20 GHz

Frequency Resolution
Power Range2

1 Hz
-25 dBm to +3 dBm

Power Accuracy2

± 0.1 dB

___________________________________________________________________________________________
This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
2

Typical performance with an RI8587 Receiver

© Roos Instruments Inc.
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RI8508: RF MODULATED
SOURCE

Appendix | RI8508: RF Modulated Source

DESCRIPTION
The RI8508 RF Source provides two dedicated signal ports of
modulated signal generation for applications in the 100 kHz to 6 GHz
band. The instrument features a precision Quadrature Digital
Upconverter (QDUC) that delivers over 100 dB of dynamic range for
high-performance, complex baseband modulation from 100 kHz 400 MHz. The 140 MHz to 6 GHz RF source supports Continuous
Wave (CW) tone generation, frequency hopping, and complex carrier
modulation up to 80 million samples per second with 14 bits of
precision. With built-in RF switching and calibrated signal paths, the
RI8508 delivers power-corrected signals and seamless modulation
capability across the entire 100 kHz to 6 GHz band for maximum
application flexibility.

KEY FEATURES
• 100 dB Dynamic Signal Range
• 10 Million Sample/Symbol Modulation Rate
• Microsecond Frequency Hopping & Settling
• Modulation Pattern Import Tools

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The subset instruments in this TIM appear as QamSource1 and
RFSource1 in the panel dialog windows.
Model and Name as it appears in the Tester Configuration:
• QAMSource1, Ri74212x QAM Generator
• RFSource1, RI8508x .1 - 6GHz Rf Source
NOTE: Multiple RI8508 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - RFsource1,
QAMSource1; RFsource2, QAMSource2 ; RFSource3, QAMSource3 ; etc). The “x” in
RI8508x denotes the model revision number.

TIM OPERATIONS
Reference the RI8508 section of the Graphical Programming chapter
for configuration, edit and control panels.

© Roos Instruments Inc.
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BLOCK DIAGRAM 8.2
Roos Instruments, Inc - Cassini16

Block Diagram, 6 GHz Source TIM
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PERFORMANCE SPECIFICATIONS
RF Source
Frequency Range
Power Range

140 MHz to 6 GHz
-100 dBm to +14 dBm / +20 dBm (CW)

QAM Source
Frequency Range
Power Range

100 kHz to 400 MHz
-100 dBm to +10 dBm

Clock Rate

80 MHz

IQ Modulator
Modulation Rate
Analog Bandwidth

80 Msps
5 MHz

___________________________________________________________________________________________
This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
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SECTION 3

RI8535: UNIVERSAL
DIGITAL

Appendix | RI8535: Universal Digital

DESCRIPTION
The RI8535 Universal Digital instrument provides a complete digital
subsystem with configuration options of 40, 80, or 120 synchronous
pins. The instrument architecture uses dedicated digital cores for
native Vector, Scan, I2C, SPI and JTAG protocols. Every pin also
incorporates parametric test capability for fundamental voltage and
current measurement, continuity, and frequency counter.
Comprehensive integration with Cassini’s test development software
brings protocol-aware programming and device interaction with
register and data format support for WGL, CSV, TP, and Verilog files.

KEY FEATURES
• Device Control with Digital Protocol Engines
• Pattern Import and Logic Analysis Tools
• Pattern Generation on the Fly
• Native JTAG Support

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
This TIM provides digital pins in banks of 20 up to a possible 120
depending on the model. The instruments in this TIM appear as
DPins1, DPins2, ... DPins6 in the panel dialog windows. A 16 slot
Cassini can hold up to 16, 120 pin RI8535 Universal Digital TIMs,
providing up to 1,920 digital pins.
Additional TIMs appear as DPins1_#, where the “_#” represents the
2nd, 3rd, etc... TIM. The Owner Names will be referred to a DPins2_1,
... DPins6_16
Model and Name as it appears in the Tester Configuration:
• Dpins1, Ri8535x Cassini Digital D1
• Dpins2, Ri8535x Cassini Digital D2
• etc...
NOTE: The “1” is replaced with a “2” or “3”... depending on how many pin cards (40,
80, 120) are loaded in each TIM. If there are more than one Dpins TIM in the
configuration, then an underscore followed by the TIMs (2-16) number is appended to
the Owner Name. (DPins1_2, DPins2_2, etc.) The “x” in the model number denotes the
revision of the Instrument.

TIM OPERATIONS
Reference the RI8535 section of the Graphical Programming chapter
for configuration, edit and control panels.
© Roos Instruments Inc.
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BLOCK DIAGRAM 8.3 1 OF 2
Roos Instruments, Inc - Cassini
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Block Diagram, Pin Card, 100MHz
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BLOCK DIAGRAM 8.4 2 OF 2
CONNECTOR A

Roos Instruments, Inc - Cassini
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D IAGRAM 1 SCAN CLOCK TIMING REFERENCE
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PERFORMANCE SPECIFICATIONS
Digital
Clock Rate
Rise/Fall Times
Drive/Compare

1 kHz to 100 MHz ±0.1 Hz
2 ns
0 V to +30 mV (50 Ω) ± 0.25 %
0.03 V to +4.0 V (50Ω), ±1 mV

Memory
Depth
Fail Memory

128 Mb / 16 Mb (optional / standard)
32k Vectors

Parametric
Continuity Mode: -1.5 V to +3.0 V ±0.25%
V Force | Measure

Leakage Mode: -1.0 V to +4.0 V ±0.25%
±3.0 to +5 V ±0.1%

I Force | Measure

± 20 mA ± 0.25%
20 mA to 20 µA ±0.4%

This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
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SECTION 4

RI8545: 0.1 TO 20 GHZ
TESTSET

Appendix | RI8545: 0.1 to 20 GHz TestSet

DESCRIPTION
The RI8545 Test Set is a microwave instrument used for precision
power, phase, and vector RF measurements across 0.1 to 20 GHz.
The multichannel architecture interfaces with a Cassini microwave
source and receiver instrument to create a 4-port, vector analyzer with
enhanced dynamic range and pin resource switching capability. The
instrument enables calibrated and error-corrected 2 or 4 port sparameters, signal power and harmonic measurement, noise figure,
and distortion test.

KEY FEATURES
• 4 Vector Microwave Source & Receive Channels
• NIST Calibrated Noise Source & Vector Error Correction
• Measure Noise Figure, P1dB, Abs. Power & Phase Noise
• Bilateral 2 & 4 Port S-Parameters

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as Test Head in the panel dialog
windows.
Model and Name as it appears in the Tester Configuration:
• Test Head, RI8545x 4 port Testset
NOTE: Multiple RI8545 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - Test Head, Test Head2,
Test Head3, etc). The “x” in RI8564x denotes the model revision number.

TIM OPERATIONS
Reference the RI8545 section of the Graphical Programming chapter
for configuration, edit and control panels.

© Roos Instruments Inc.
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BLOCK DIAGRAM 8.5
Roos Instruments, Inc - Cassini

Block Diagram, Test Set
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PERFORMANCE SPECIFICATIONS
Frequency Range
Signal Power Range1
Noise Source ENR

0.1 GHz to 20 GHz
-120dBm to +30dBm
+18dB @ 2 GHz

Power Accuracy

± 0.1dB

___________________________________________________________________________________________
This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
1

Typical performance with an RI8587 Receiver
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SECTION 5

RI8546: DEVICE POWER/
MEASURE

Appendix | RI8546: Device Power/Measure

DESCRIPTION
The RI8546 Device Power Instrument provides precision voltage and
current supply, digital pin control, and parametric DC measurement in
a single instrument. Two high-current power supplies, eight mid-range
power supplies, and four low current power supplies provide fast
settling voltage and sense feedback for optimal performance in test
applications. Eight voltage measure inputs can be configured for
differential device applications or ground-referenced multimeter
measurements. The internal digital subsystem supports native SPI
and I2C protocols along with static pin voltage, continuity and current
monitoring.

KEY FEATURES
• 2 x 3A High Power Supplies, 8 x 200 mA Supplies, 16 Static
Digital with Parametric Measure
• Protocol-Aware Digital Pin Programming
• 8 Precision Voltage Measure Inputs

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as DutControl, PowerVI, and
StaticDigital instruments in the panel dialog windows.
Model and Name as it appears in the Tester Configuration:
• DutControl, Ri7421x Dut Control
• PowerVI, RI7431x High Current Supplies
• StaticDigital, RI74311x 16-bit Device Digital Controller
NOTE: Multiple RI8546 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e DutControl,PowerVI,StaticDigital ; DutControl2,PowerVI2,StaticDigital2;
DutControl3,PowerVI3,StaticDigital3 ; etc.).
The “x” in the instrument names denotes the model revision number.

The DUTControl instrument provides essentially three independent
voltage supply and measure resources behind various switching
schemes to provide a flexible resource routing network within the TIM:
• 16 device power pins (DP1..DP16) capable of sourcing and
measuring DC voltage and current. These pins are subdivided
into two banks of eight, with each bank being driven by two
independent DC supplies: DP9..DP16 by VCC1 ±10 V, 200 mA
and VCC2 ±10 V, 200 mA; DP1..DP8 by VCC3 ±10 V, 200 mA;
VCC4 ±10 V, 200 mA). Each pin in the bank of eight can use one
of the two supplies with different voltage values, or both can be
© Roos Instruments Inc.

Appendix | RI8546: Device Power/Measure
used in parallel with the same voltage value for increased current
capacity. Each of the four independent supplies has an internal
current or voltage measurement resource (Meas I/V 1/2/3/4),
allowing for current or voltage measurement. An additional
Monitor line on the device power pins allows a precision
measurement resource (DPVP Meas I/V) to be switched in to the
pin resource to measure voltage, current, or perform continuity
type measurements (force current, measure voltage; force
voltage, measure current)
• 4 dedicated DC supplies (VCC5 ±10 V, 200 mA; VCC6 ±10 V,
200 mA; VCC7 ±10 V, 200 mA; VCC8 ±10 V, 200 mA) that drive
supply pins VCC5F, VCC6F, VCC7F, VCC8F with an external
sense line pin for each: VCC5S, VCC6S, VCC7S, VCC8S. These
four independent force and sense pin resources can provide
additional, high-precision DC voltage at a DUT pin using voltagesense feedback to compensate for any ohmic losses through the
device interface.
• 8 voltage measure pins provide single-ended (groundreferenced) or differential voltage measurement. A switching
network between the measure pins and Meas V ±10 V resource
allows for flexible resource routing.
The PowerVI instrument provides two independent, high-current
voltage supply and measure resources:
• Voltage or Current supply from VI1 0-10 V, 3 A and VI2 0-10 V, 3
A are available on the TIM’s output pins via VI1F(H-3), VI1F(H-5),
VI2F(H-8), and VI2F(H-10). Sense pin resources VI1S (H-4) and
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VI1S (H-9) compensate for any ohmic losses through the device
interface.
The StaticDigital instrument provides a basic digital communication
subsystem and digital pin resources for low-level DUT control,
communication, and measurement:
• 16 device bit pins (DB1..DB16) provide static-voltage supply,
measure, and can be configured as data, clock, and strobe lines
for I2C and serial communications. These pins are subdivided
into two banks of eight, with each bank being driven by two
independent DC supplies (VON ±10 V, 2 mA; VOFF ±10 V, 2 mA) to
define the ‘on’ and ‘off’ voltage states for each bank of 8 pins
(high and low bits). A Monitor line on the device bits allows a
precision measurement resource (DPVP Meas I/V) to be
switched in to the pin resource to measure voltage, current, or
perform continuity type measurements (force current, measure
voltage; force voltage, measure current).
• The subset of DB pins listed support higher speed
communication up to 1 MHz clock speeds on their respective
supply banks: DB1 and DB9 - High-speed Read Pins; DB2 and
DB10 - High-speed Write Pins; DB3 and DB11 - High-speed
Clock Pins

TIM OPERATIONS
Reference the RI8546 section of the Graphical Programming chapter
for configuration, edit and control panels.

© Roos Instruments Inc.
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Revisions:
3/27/08 - Changed VCC current to 200 ma. Added voltage numbers. - RB
8/25/11 - Changed GREF designations to match the colored block. - RB
9/2/11 - Fixed A10 to day ‘RTN’. - RB
8/24/12 - Added model numbers to the instruments. - RB

BLOCK DIAGRAM 8.6
Roos Instruments, Inc - Cassini

Device Power
RI8546A/B/C

Notes:
1) GS, VCC5-8GS and VI*GS are the ground references. They should be grounded at the DUT.
2) VI RTN are the high current return for VIs. They should be grounded at the DUT with heavy wire.
3) Values are for reference only.
Refer to specifications for complete performance values.
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PERFORMANCE SPECIFICATIONS
Supply1

Device Power

Measure1

Range

Precision

Range

Resolution

±10 V

0.3 mV

±10 V

0.3 mV

±200 mA

10 μA

0.250 mA to 250 mA

36 nA

0 V to 10 V

10 mV

30 mA to 3 A

44 μA

0 V to 10 V
High Power

2.5 A (max)

10 mV

3 A (pulsed)
V Measure

±10 V

5 mV

±10 V

1.5 mV

±2 mA

1 μA

±2 μA to ±2 mA1

12 pA to 290 μA1
Protocol

Static Digital

±10 V
±2 mA (max)

± 0.1dB

SPI

60 kbits / 2.5 Mbits

I2C

60 kbits / 2.5 Mbits

_________________________________________________________________________________________________
_

This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
limits set by instrument mode.
©Range/Resolution
Roos Instruments
Inc.
1
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SECTION 6

RI8556: SMALL CASSINI
INFRASTRUCTURE

Appendix | RI8556: Small Cassini Infrastructure

DESCRIPTION
The RI8556A model infrastructure is commonly referred to as the
Small Cassini or Cassini 8. It includes a test head with 8 slots and
manipulator arm with 4 degrees of freedom: vertical lift, rotation,
horizontal extension, and pivotal movement. The integrated
instrument rack houses AC/DC power supply, the system controller,
and supports Cassini 8 instrumentation.

RI8556A INFRASTRUCTURE DIMENSIONS
• Height: 1590 mm (62.6 in)
• Table Surface Height: 925 mm (36.4 in)
• Depth: 733 mm (28.9 in)
• Width: 853 mm (33.6 in)
• Max Shipping Weight: 250 Kg (550 lbs)

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM

INSTRUMENT OPERATIONS

The instrument in this TIM appears as Tester in the panel dialog
windows.

Reference the Tester instrument in the RI8574 System Controller
section of the Graphical Programming chapter for configuration, edit
and control panels.

Model and Name as it appears in the Tester Configuration:
• Tester, Ri8549x Cassini 8 Slot Tester

TESTER VOLTAGE SPECIFICATIONS
Tester instrument provides power to the Fixture, Fixture Modules and
any active components installed on the DIB.
Voltage (V)

Max Current (A)

+5

1.51

+15

0.5

+28

0.5

-15

0.5

-5

1.5

INSTRUMENT LOCATION
The FIX block is located in the center of the Test Head . A Harness
Block or Pin Block is used to access resources provided by the Tester
instrument.

© Roos Instruments Inc.
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FIGURE 8.1 RI8556A INFRASTRUCTURE DIMENSIONS

Tap for Zoom View

© Roos Instruments Inc.
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FIGURE 8.2 RI8556A TEST HEAD TRAVEL

Tap for Zoom View

© Roos Instruments Inc.
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FIGURE 8.3 RI8556A TEST HEAD ROTATION

Tap for Zoom View

© Roos Instruments Inc.
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SECTION 7

RI8557: LARGE CASSINI
INFRASTRUCTURE

Appendix | RI8557: Large Cassini Infrastructure

DESCRIPTION
The RI8557A model infrastructure is commonly referred to as the
Large Cassini, Big Cassini, Tall Cassini or RI7100C. It includes a test
head with 8 slots and manipulator arm with 4 degrees of freedom:
vertical lift, rotation, horizontal extension, and pivotal movement. The
auxiliary rack houses AC/DC power supply, the system controller, and
Test Head holds 8 Cassini TIMs.

RI8557A INFRASTRUCTURE DIMENSIONS
• Height: 1698 mm (66.9 in)
• Depth: 900 mm (35.4 in)
• Width: 838 mm (33.0 in)
• Max Shipping Weight: 300 Kg (660 lbs)

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM

INSTRUMENT OPERATIONS

The instrument in this TIM appears as Tester in the panel dialog
windows.

Reference the Tester instrument in the RI8574 System Controller
section of the Graphical Programming chapter for configuration, edit
and control panels.

Model and Name as it appears in the Tester Configuration:
• Tester, Ri8549x Cassini 8 Slot Tester

TESTER VOLTAGE SPECIFICATIONS
Tester instrument provides power to the Fixture, Fixture Modules and
any active components installed on the DIB.
Voltage (V)

Max Current (A)

+5

1.51

+15

0.5

+28

0.5

-15

0.5

-5

1.5

INSTRUMENT LOCATION
The FIX block is located in the center of the Test Head . A Harness
Block or Pin Block is used to access resources provided by the Tester
instrument.

© Roos Instruments Inc.
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FIGURE 8.4 RI8557A INFRASTRUCTURE FOOTPRINT

Tap for Zoom View

© Roos Instruments Inc.
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FIGURE 8.5 RI8557A TEST HEAD ROTATION COMPLIANCE

Tap for Zoom View

© Roos Instruments Inc.
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FIGURE 8.6 RI8557A TEST HEAD PIVOTAL COMPLIANCE

Tap for Zoom View

© Roos Instruments Inc.
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FIGURE 8.7 RI8557A OPTIONAL COMPUTER CART DIMENSIONS

Tap for Zoom View

© Roos Instruments Inc.
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SECTION 8

RI8563: 4GHZ TO
40.5GHZ TESTSET

Appendix | RI8563: 4GHz to 40.5GHz TestSet

DESCRIPTION
The RI8563 Test Set extends the frequency and application capability
of Cassini’s 2-port vector measurements to the 4 GHz - 40.5 GHz
range. Calibrated RF paths deliver precision source and measure of
signal power, distortion test, s-parameters, and harmonic
measurement. Designed to interface with a Cassini receiver and
source instrument, the RI8563 can be shared across multiple
microwave I/O for fast, precision measurements and maximum
channel utilization.

KEY FEATURES
• S-Parameters from 4 GHz to 40.5 GHz
• NIST Calibrated Noise Source & Vector Error Correction
• Measure Noise Figure, P1dB, Abs. Power & Phase Noise
• Bilateral 2 & 4 Port S-Parameters

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as Test Head40 in the panel dialog
windows.
Model and Name as it appears in the Tester Configuration:
• Test Head40, Ri8563x 4-40.5 GHz Test Set
NOTE: Multiple RI8563 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - Test Head40, Test
Head402, Test Head403, etc). The “x” in RI8563x denotes the model revision number.

TIM OPERATIONS
Reference the RI8563 section of the Graphical Programming chapter
for configuration, edit and control panels.

© Roos Instruments Inc.
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BLOCK DIAGRAM 8.7
Roos Instruments, Inc - Cassini

C13
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C1
Drive
Drive
Out
In

Block Diagram, RI8563C
40.5 GHz, 2-Port-1-Path TIM
2011-08-15
Copyright Roos Instruments, Inc.
Subject to change without notice

C8
In/Out
20-40 GHz
PKZ

C4
In
20-40 GHz
PKZ

IF In

LO Out

LO In

RF1
In/Out

RF2
In

C16

C8

C4

C12

Tap for Zoom View

6 dB
RF

b

IF Out

C9

LO

LO

IF

RF
IF

6 dB

a

RF

LO

3

IF
2

C7
LO Aux Out

1

LO 4
Switch

x2

2

10 dB

J9

3

J2

4

J1

1

RF
Switch

J10

C1
RF In

C6
IF Out

IF
Switch

6 dB
C3
LO In

C5
RF Out

C2
IF Aux In

© Roos Instruments Inc.

695

Cassini ATE System Reference Guide

Appendix | RI8563: 4GHz to 40.5GHz TestSet

PERFORMANCE SPECIFICATIONS
Source
Frequency Range

4 GHz to 40.5 GHz

Frequency Resolution
Power Range2

2 Hz
-25 dBm to +3 dBm

Power Accuracy

± 0.1 dB

Measure
Frequency Range
Power Range

4 GHz to 40.5 GHz
-115 dBm to +20 dBm

___________________________________________________________________________________________
This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
2

Typical performance with an RI8587 Receiver

© Roos Instruments Inc.
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SECTION 9

RI8564: 71GHZ TO
86GHZ TESTSET

Appendix | RI8564: 71GHz to 86GHz TestSet

DESCRIPTION
The RI8564 mmWave test port TIM extends the frequency and
application capability of Cassini’s vector measurements to the 71 GHz
to 86 GHz range. Calibrated RF paths deliver precision source and
measure of signal power, distortion test, s-parameters, and harmonic
measurement. Designed to interface with a Cassini receiver and
source instrument, the RI8564 can be shared across multiple
microwave I/O for fast, precision measurements and maximum
channel utilization.

KEY FEATURES
• S-Parameters from 71 GHz to 86 GHz
• NIST Calibrated Noise Source & Vector Error Correction
• Measure Noise Figure, P1dB, Abs. Power & Phase Noise
• Waveguide S-Parameter Port

RI8564B frequency range is 75GHz to 81GHz.
RI8564C frequency range is 71GHz to 86GHz.

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as Test Head77 in the panel dialog
windows. (See Graphical Programming chapter)
Model and Name as it appears in the Tester Configuration:
• Test Head77, Ri8564x 81 GHz Test Set
NOTE: Multiple RI8564 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - Test Head77, Test
Head772, Test Head773, etc). The “x” in RI8564x denotes the model revision number.

© Roos Instruments Inc.
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BLOCK DIAGRAM 8.8 (RI8564B VERSION)
Roos Instruments, Inc - Cassini
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Copyright Roos Instruments, Inc.
Subject to change without notice
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PERFORMANCE SPECIFICATIONS (RI8564B VERSION)
Source
Frequency Range

75 GHz to 81 GHz

Frequency Resolution
Power Range1

8 Hz
-20 dBm to +5 dBm

Power Accuracy

± 0.2 dB

Measure
Frequency Range
Power Range

75 GHz to 81 GHz
-110 dBm to +10 dBm

___________________________________________________________________________________________
This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
1

Typical performance with an RI8587 Receiver.

© Roos Instruments Inc.
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BLOCK DIAGRAM 8.9 (RI8564C VERSION)
Roos Instruments, Inc - Cassini

C1

Block Diagram
RI8564C
71-86 GHz 1-Port TIM

RF1
71-86 GHz
WR12

2016-08-19
Copyright Roos Instruments, Inc.
Subject to change without notice
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PERFORMANCE SPECIFICATIONS (RI8564C VERSION)
Source
Frequency Range

71 GHz to 86 GHz

Frequency Resolution
Power Range1

8 Hz
-45 dBm to +5 dBm

Measure
Frequency Range
Power Range

71 GHz to 86 GHz
-110 dBm to +10 dBm

___________________________________________________________________________________________
This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
1

Typical performance with an RI8587 Receiver.

© Roos Instruments Inc.
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SECTION 10

RI8567: 0.01 TO 12GHZ
TESTSET

Appendix | RI8567: 0.01 to 12GHz TestSet

DESCRIPTION
The RI8567 instruments combines a 2-port RF vector Testset and a
complex RF Receiver in a single TIM. The front-end includes a
versatile, solid-state RF switch network for hot-swappable, adaptive
transmit and receive topologies. The built-in receiver uses a
synchrodyne back-end that provides precision RF vector
measurements and fast settling times. High-linearity mixers and a
selectable analog filter bank in the receiver provide the user with up to
7 MHz of instantaneous detection bandwidth and signal measurement
sensitivity down to -100 dBm.

KEY FEATURES
• 2 S-Parameter ports that cover 100 MHz to 12 GHz range
• Base-band vector receiver with SyRF Core DSP capability
• Integrated LO with Microsecond Frequency Locking
• Dual Measurement Engines, True RMS & Vector I & Q
• Production-Speed RF Resource Switching Capability

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as RFMeasure1 in the panel dialog
windows.
Model and Name as it appears in the Tester Configuration:
• RfMeasure1, RI8567x 2 port Testset+Receiver
NOTE: Multiple RI8567 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - RFMeasure1,
RFMeasure2, RFMeasure3, etc). The “x” in RI8567x denotes the model revision
number.

TIM OPERATIONS
Reference the RI8567 section of the Graphical Programming chapter
for configuration, edit and control panels.

© Roos Instruments Inc.
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BLOCK DIAGRAM 8.10
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Subject to change without notice
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PERFORMANCE SPECIFICATIONS
Vector Analyzer
Frequency Range

100 MHz to 12 GHz

Frequency Resolution
Power Range2

0.1 Hz
-100 dBm to +30 dBm

Power Accuracy

± 0.1 dB

Receiver Measure
Frequency Range
Power Range
Analog Bandwidths

100 kHz to 12 GHz
-115 dBm to +20 dBm
7 kHz, 200 kHz, 5 MHz (user Selectable)

__________________________________________________________________________________________
This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
2

Typical performance with an RI8587 Receiver.

© Roos Instruments Inc.
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SECTION 11

RI8568: CASSINI 16
INFRASTRUCTURE

Appendix | RI8568: Cassini 16 Infrastructure

DESCRIPTION
The RI8568B model infrastructure is commonly referred to as Cassini
16. It includes a 16 slot test head with pneumatic device interface
docking and manipulator arm with 6 degrees of freedom: vertical lift,
test head rotation, 2-axis planar movement, and 2-axis pitch
movement. The infrastructure provides a minimal test floor footprint
and compliance with multiple handler and prober setups. The chassis
includes standard pneumatic hook ups and attachment options
auxiliary rack instruments. Desktop or TouchUI Production options
can be selected depending on the primary use. Values are subject
to change without notice.

RI8556A INFRASTRUCTURE DIMENSIONS
• Height: 1,740 mm (68.5 in)
• Depth: 1,208 mm (47.6 in)
• Width: 844 mm (33.2 in)
• System Weight: 105 Kg (230 lbs)
• Typical/MAX Shipping Weight: 250 Kg (550 lbs)/385 Kg (850 lbs)

© Roos Instruments Inc.

707

Cassini ATE System Reference Guide

Appendix | RI8568: Cassini 16 Infrastructure

INSTRUMENTS PROVIDED BY THIS TIM

INSTRUMENT OPERATIONS

The instrument in this TIM appears as Tester in the panel dialog
windows.

Reference the Tester instrument in the RI8574 System Controller
section of the Graphical Programming chapter for configuration, edit
and control panels.

Model and Name as it appears in the Tester Configuration:
• Tester, Ri8568x Cassini 16 Slot Tester

TESTER VOLTAGE SPECIFICATIONS
Tester instrument provides power to the Fixture, Fixture Modules and
any active components installed on the DIB.
Voltage (V)

Max Current (A)

+5

1.51

+15

0.5

+28

0.5

-15

0.5

-5

1.5

INSTRUMENT LOCATION
The FIX block is located in the center of the Test Head . A Harness
Block or Pin Block is used to access resources provided by the Tester
instrument.

© Roos Instruments Inc.
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FIGURE 8.8 RI8568B (CASSINI 16) FOOTPRINT

Tap for Zoom View

© Roos Instruments Inc.

709

Cassini ATE System Reference Guide

Appendix | RI8568: Cassini 16 Infrastructure

FIGURE 8.9 RI8568B UPPER AND LOWER LIFT LIMIT
Tap for Zoom View

© Roos Instruments Inc.
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FIGURE 8.10 RI8568B TOTAL HEAD ROTATION

Tap for Zoom View

© Roos Instruments Inc.
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FIGURE 8.11 RI8568B TOP-VIEW WITH AUXILIARY CART (CONFIGURATION 1)

Tap for Zoom View

© Roos Instruments Inc.
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FIGURE 8.12 RI8568B TOP-VIEW WITH AUXILIARY CART (CONFIGURATION 2)

Tap for Zoom View

© Roos Instruments Inc.
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FIGURE 8.13 CIRCUIT BREAKERS AND FIXTURE DOCKING LATCH

Tap for Zoom View
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BLOCK DIAGRAM 8.11 TEST HEAD WIRING DIAGRAM
Roos Instruments, Inc - Cassini16

Block Diagram, Power Distribution

Tap for Zoom View

Infrastructure, Rev 1
2014-06-22
Richard Doporto
Copyright Roos Instruments, Inc.
Subject to change without notice
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SECTION 12

RI8572: WAVEFORM
GENERATOR & MEASURE

Appendix | RI8572: Waveform Generator & Measure

DESCRIPTION
The RI8572 combines two dedicated waveform generators and a
dual-channel digitizer in a single instrument for general purpose time
domain measurements. A built-in PLL and direct digital synthesizer
generates two channels of orthogonal CW signals with phase,
amplitude and DC offset controls for single tone applications. An
arbitrary waveform generator with an embedded FPGA supplies two,
DC coupled outputs with sinusoidal, square-wave, and userprogrammable, complex modulated signals for baseband
applications. A separate DDS and lookup table engine drives two, AC
coupled ports for dedicated sinusoidal signal generation. A dualchannel digitizer provides oscilloscope functionality with two highspeed ADCs and a dedicated FPGA for real-time signal analysis.

KEY FEATURES
• M-ary QAM, M-PSK, & Custom Baseband Signals
• Continuous & Reciprocal Frequency Counter
• Measure S/N, SINAD, Rise / Fall Times

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as Oscilloscope, SineGen and
Waveform in the panel dialog windows.
Model and Name as it appears in the Tester Configuration:
• Oscilloscope, RI74105x Hi Spd scope/counter/BER
• SineGen, Ri7403x Dual Sine Source
• Waveform, Ri74211x Complex Waveform
NOTE: Multiple RI8594 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - Oscilloscope, SineGen,
Waveform; Oscilloscope2, SineGen2, Waveform2; Oscilloscope2, SineGen2, Waveform2;
etc).
The “x” in RI8594x denotes the model revision number.

TIM OPERATIONS
Reference the RI8572 section of the Graphical Programming chapter
for configuration, edit and control panels.
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BLOCK DIAGRAM 8.12
Roos Instruments, Inc - Cassini16
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PERFORMANCE SPECIFICATIONS
Sine Wave Generator
Frequency Range
Voltage Range

1 kHz to 90 MHz
0.1 Vp-p to 3 Vp-p

Arbitrary Wave Generator
Frequency Range
Voltage Range

1 Hz to 100 MHz
640 MHz (Max)

Digitizer
Measurement Bandwidth
Signal/Bit Resolution

100 MHz
±0.4V / 14Bits

Sample Rate

80 Msps

___________________________________________________________________________________________
This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.

© Roos Instruments Inc.

719

SECTION 13

RI8574: SYSTEM
CONTROLLER

Appendix | RI8574: System Controller

DESCRIPTION
The System Controller TIM provides the embedded user interface,
multi-instrument control, and graphical test programming environment
for the Cassini ATE system. Instrument control and management are
provided via the RIFL (Roos Instruments Fast Link) bus. RIFL provides
the communication bus as well as distributing 48V instrument power
and a shared 10 MHz reference clock across the instrument test
head. The controller provides networked data storage and
communication capabilities (Guru™) through a standard CAT-5
connections with local storage for online and offline development and
USB ports for non-network data transfer. Guru™ provides tools for
organizing files, data, and software test resources along with built-in
file versioning, automated backups, data and test distribution control,
access control and more.

KEY FEATURES
• Embedded OS/2 based Operating System
• Cassini Operator Interface
• Graphical Test Plan Development Environment
• Guru™ - Networked Database System
• Support for Temptronics® TP04310A Temperature Controller

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM

RIFL MASTER

The instruments in this TIM appear as an DataSim and System in
the panel dialog windows.

Roos Instruments Fast Link (RIFL) is a star topology communication
bus that requires a single RIFL Master connected to RIFL Hubs and
RIFL Nodes. RIFL Hubs are located in the Infrastructure and distribute
power. Every TIM, Fixture Module, and Hander Pod is a RIFL Node.

Model and Name as it appears in the Tester Configuration:
• DataSim, Data Simulator
• System, System Resources 2
NOTE: The “x” in the model number denotes the revision of the Instrument.

The RIFL Master used for TIM communication, power and 10 MHz
reference clock is contained in this TIM but does not appear in the
Tester Configuration. The 10 MHz crystal oscillator is calibrated with
an integer offset once at the factory and is expected to remain within
tolerances for 25 years.

Optional Instruments may include:
• (Optional) TempControl, Temptronics TP04310A Temperature
Controller (or compatible)

TIM OPERATIONS
Reference the RI8574 section of the Graphical Programming chapter
for configuration, edit and control panels.
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PERFORMANCE SPECIFICATIONS
Hardware
CPU

Intel Core2 Duo

RAM

2 GB DDR2 667 MHz

HDD

SSD 120 GB

Operating System
ArcaOS or eComStation

Embedded OS, Graphical User Interface, Human Interface Controls

Interface Ports
General IO
Handler/Prober/Temp Controller
Graphical User Interface
Networking
Network Standards

4 - USB, 1 - VGA (monitor), 2 - PS/2 (mouse & keyboard),
1- Serial, 1-Parallel
Serial, Parallel, or GPIB
Touchscreen and/or Monitor
10/100/1000 Ethernet, RJ45 Cat 5+
FTP, NSF, SMB, VNC, RSYNC, Telnet, NTP, LPD, SMB Printers, PDF

___________________________________________________________________________________________
This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
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RI8575: PHASE NOISE
MEASURE

Appendix | RI8575: Phase Noise Measure

DESCRIPTION
The RI8575 Phase Noise measurement TIM provides Cassini with a
direct Phase Noise test capability to handle microwave VCO’s and
Oscillators at production speeds. It includes two RF Measure ports
and a multipurpose I/O port for biasing and phase locking the device
under test, evaluating Kv, Linearity, FM side-band performance, and
Phase Noise for devices operating from 100 kHz to 12 GHz.

KEY FEATURES
• Phase Detector with built in Reference Oscillator
• Parametric Supply / Measure for Tune Voltage & Current
• Linearity & Kv Measure with 16-Bit Frequency Counter
• FM Sideband Measure

INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as PhaseNoiseAnalyzer in the
panel dialog windows. (See Graphical Programming chapter)
Model and Name as it appears in the Tester Configuration:
• PhaseNoiseAnalyzer, RI8575x 1 - 16 GHz Phase Noise Analyzer
NOTE: Multiple RI8575 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - PhaseNoiseAnalyzer,
PhaseNoiseAnalyzer2, PhaseNoiseAnalyzer3, etc). The “x” in RI8575x denotes the
model revision number.
© Roos Instruments Inc.
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BLOCK DIAGRAM 8.13
Roos Instruments, Inc - Cassini

Block Diagram, Phase Noise Discriminator TIM
RI8575A
2012-03-21
Copyright Roos Instruments, Inc.
Subject to change without notice
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PERFORMANCE SPECIFICATIONS

Phase Noise Measure
Frequency Range

1 GHz to 16 GHz

Frequency Resolution
Frequency Offset
Direct Noise Floor

Divide-By-4 Noise Floor

0.1 Hz
50 kHz to 2 MHz
-129 dBc/Hz @ 50 kHz
-161 dBc/Hz @ 2 MHz
-117 dBc/Hz @ 50 kHz
-146 dBc/Hz @ 2 MHz

Parametric Measure
Current Range

±2 mA;±2 μA

Voltage Range

-3 V to +25 V

___________________________________________________________________________________________
This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
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RI8577: SOURCE
COMBINER

Appendix | RI8577: Source Combiner

DESCRIPTION
The RI8577 Source Combiner TIM provides add-in capability for
microwave mixing of two independent microwave sources for the
200MHz to 20GHz frequency band. Built-in signal amplification of up
to 1 Watt and variable attenuation to 110dB provide signal
conditioning along with enhanced impedance matching and
calibrated signal paths. Internal low-loss RF relays provide two-tone
and independent source distribution to support multi-site schemes
and multi-port resource sharing applications.

KEY FEATURES
• 200 MHz to 20GHz Frequency Range
• Optimized for 2-tone Signal Measurements: IP3, IMD,
• Microwave Signal Mixing of Two Independent Sources
• Multi-path Signal Switching & Distribution
• Signal Conditioning: Gain, Attenuation, and Enhanced
Impedance Matching
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as Src12Output in the panel dialog
windows. Additional TIMs appear as Src12Output# with # replaced by
the number of TIM.
Model and Name as it appears in the Tester Configuration:
• Src12Output, Ri8577x Src1/2 Output TIM
NOTE: Multiple RI8577 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - Src12Output,
Src12Output2, Src12Output3, etc). The “x” in RI8577x denotes the model revision
number.

TIM OPERATIONS
Reference the RI8577 section of the Graphical Programming chapter
for configuration, edit and control panels.
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BLOCK DIAGRAM 8.14
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PERFORMANCE SPECIFICATIONS
Source
Frequency Range
Amplifier Gain
Power Range

10 MHz to 20 GHz
20 dB (500 MHz to 6 GHz)
-110 dBm to +30dBm

Power Accuracy

± 0.5 dB

___________________________________________________________________________________________
This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
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SECTION 16

RI8580: 57GHZ TO
64GHZ TESTSET

Appendix | RI8580: 57GHz to 64GHz TestSet

DESCRIPTION
The RI8580 mmWave test port TIM extends the frequency and
application capability of Cassini’s vector measurements to the 57 GHz
- 64 GHz range. Calibrated RF paths deliver precision source and
measure of signal power, distortion test, s-parameters, and harmonic
measurement. Designed to interface with a Cassini receiver and
source instrument, the RI8580 can be shared across multiple
mmWave I/O for fast, precision measurements and maximum channel
utilization.

KEY FEATURES
• S-Parameters from 57 GHz to 64 GHz
• NIST Calibrated Noise Source & Vector Error Correction
• Measure Noise Figure, P1dB, Abs. Power & Phase Noise
• Waveguide S-Parameter Port

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as Test Head66 in the panel dialog
windows.
Model and Name as it appears in the Tester Configuration:
• Test Head66, Ri8580x 66 GHz Test Set
NOTE: Multiple RI8580 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - Test Head66, Test
Head662, Test Head663, etc). The “x” in RI8580x denotes the model revision number.

TIM OPERATIONS
Reference the RI8580 section of the Graphical Programming chapter
for configuration, edit and control panels.

© Roos Instruments Inc.

731

Cassini ATE System Reference Guide

Appendix | RI8580: 57GHz to 64GHz TestSet

BLOCK DIAGRAM 8.15
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PERFORMANCE SPECIFICATIONS

Source
Frequency Range

57 GHz to 64 GHz

Frequency Resolution
Power Range2

6 Hz
-20 dBm to +5 dBm

Power Accuracy

± 0.2 dB

Measure
Frequency Range
Power Range

57 GHz to 64 GHz
-110 dBm to +10 dBm

___________________________________________________________________________________________
This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
2 Typical performance with an RI8587 Receiver
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SECTION 17

RI8581: 100KHZ TO
20GHZ RECEIVER

Appendix | RI8581: 100kHz to 20GHz Receiver

DESCRIPTION
The RI8581 Receiver TIM provides a scalable RF front-end and
frequency downconverter, along with a vector baseband digitizer that
covers the 100 kHz to 20 GHz frequency range. The RI8581 features
multiple RF ports that interface with the Cassini’s Testset Instruments
to extend the frequency range of the front-end to 81 GHz and
beyond. The synchrodyne (frequency domain, phase and magnitude)
back-end provides precision vector measurements while the highlinearity mixers and selectable analog filter bank with 7 kHz to 5 MHz
of instantaneous detection bandwidth at signal sensitivities down to
-100 dBm. The TIM provides 3 IF input ports, dedicated low and high
frequency input ports, LO distribution, 2 auxiliary bypass ports, and a
dedicated 21.4 MHz IF output port for bench analysis, engineering,
and debugging.

KEY FEATURES
• Absolute Power, Phase, Noise Figure and S-Parameters
• >100 dB of Dynamic Range from 100 kHz to 20 GHz
• Dual Measurement Engines, True RMS & Vector I & Q
• 2 RF Input ports, 3 baseband inputs, and Receiver LO input

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as Receiver in the panel dialog
windows.
Model and Name as it appears in the Tester Configuration:
• Receiver, RI8581x .01 to 20 GHz Complex Receiver TIM
NOTE: Multiple RI8581 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - Receiver, Receiver2,
Receiver3, etc). The “x” in RI8581x denotes the model revision number.

TIM OPERATIONS
Reference the RI8581 section of the Graphical Programming chapter
for configuration, edit and control panels.
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BLOCK DIAGRAM 8.16
Roos Instruments, Inc - Cassini

Block Diagram, Receiver TIM
RI8581A2
2011-10-25
Copyright Roos Instruments, Inc.
Subject to change without notice
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PERFORMANCE SPECIFICATIONS
Front-End
Frequency Range

100 kHz to 20 GHz

Frequency Resolution
Power Range2
Frequency Lock

1 Hz
-100 dBm to +10 dBm
<100 μsec

Receiver
Analog Bandwidths
Noise Floor

7 kHz, 200 kHz, 5 MHz (user Selectable)
-155 dBm/ Hz @ 1 GHz (typical)

ADC Sample Rate

80 MSps

___________________________________________________________________________________________2
Typical performance with an RI8587 Receiver
This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
2

Typical performance with an RI8587 Receiver
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SECTION 18

RI8587: 100KHZ TO 20GHZ
RECEIVER WITH DSP

Appendix | RI8587: 100 kHz to 20 GHz Receiver with DSP

DESCRIPTION
The RI8587 Receiver TIM provides a scalable RF front-end and
frequency downconverter, along with a vector baseband digitizer that
has a local DSP for customized applications in the 100 kHz to 20 GHz
frequency range. Incorporating our SyRF Core technology, the RI8587
features multiple RF ports that interface with the Cassini’s Testset
Instruments to extend the frequency range of the front-end to 81 GHz
and beyond. The complex synchrodyne back-end provides highlinearity mixers, selectable analog filter bank with up a range of 1 kHz
to 7 MHz of instantaneous detection bandwidth, and dual highprecision ADC’s with an embedded FPGA for real-time spectrum
analysis, digital filtering, demodulation and user-defined signal
processing. The TIM provides 3 IF input ports, dedicated low and high
frequency input ports, LO distribution, 2 auxiliary bypass ports, and a
dedicated 21.4 MHz IF output port for bench analysis, engineering,
and debugging.

KEY FEATURES
• Absolute Power, Phase, Noise Figure and S-Parameters
• >100 dB of Dynamic Range from 100 kHz to 20 GHz
• Real-time DSP for Custom, PAR, ACPR, EVM, and FFTs
• 2 RF Input ports, 3 baseband Inputs, and Reference LO Input
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as Receiver in the panel dialog
windows.
Model and Name as it appears in the Tester Configuration:
• Receiver, RI8587x .01 to 20GHz Complex Receiver TIM w DSP
NOTE: Multiple RI8587 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - Receiver, Receiver2,
Receiver3, etc). The “x” in RI8587x denotes the model revision number.

TIM OPERATIONS
Reference the RI8587 section of the Graphical Programming chapter
for configuration, edit and control panels.
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BLOCK DIAGRAM 8.17
Roos Instruments, Inc - Cassini

Block Diagram, Receiver TIM
RI8587A
2014-01-13
Copyright Roos Instruments, Inc.
Subject to change without notice
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PERFORMANCE SPECIFICATIONS

Front-End
Frequency Range

100 kHz to 20 GHz

Frequency Resolution
Power Range
Frequency Lock

1 Hz
-100 dBm to +10 dBm
<100 μsec

Receiver
Analog Bandwidths
Noise Floor

7 kHz, 200 kHz, 5 MHz (user Selectable)
-155 dBm/Hz @ 1 GHz (typical)

ADC Sample Rate

80 Msps

___________________________________________________________________________________________
This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
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SECTION 19

RI8589: HIGH POWER
SUPPLY/PULSER

Appendix | RI8589: High Power Supply/Pulser

DESCRIPTION
The RI8589 FET Pulser provides power device parametric
measurement, characterization, and high power drive supply. With a
measurement range from sub-μA to 200V/20A, this instrument allows
evaluation of power FETs, BJTs, and IGBT devices as well as wide
band-gap materials such as GaN and SiC. The RI8589 enables
precise, small on-resistance measurements and 10μs fast pulse
capability for complete power device characterization, temperature
stress, and failure analysis.

KEY FEATURES
• DC Parametric Measure & High-Power Supply in One Instrument
• High-Power Polarity Switching without Recabling
• 10μs, 500W High Power Pulse Capability
• 8 Control Pins for External Relays
• Built-in Fixture Safety Interlock Pins
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as FetPulser in the panel dialog
windows.
Model and Name as it appears in the Tester Configuration:

HAZARDOUS VOLTAGES

• FetPulser, RI8589x Fet Pulser

The RI8589 High Power Supply/Pulser instrument can produce DC
and pulse voltages in excess of 170V. It is equipped with safety
interlock pins that require a fixture Device Interface Board connection
to enable high-power voltages at the output pins of the instrument.
Always use certified Roos Instrument’s interfaces and interconnect
with this instrument.

NOTE: Multiple RI8589 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - FetPulser, FetPulser2,
FetPulser3, etc). The “x” in RI8589x denotes the model revision number.

WARNING: Always power down and remove this instrument before
performing any service to the instrument, fixture, DIB, or test
system. Never remove or service the device interface board or Quick
Lock DIB system while the instrument is powered on.

DIAGNOSTIC REQUIREMENTS

© Roos Instruments Inc.
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BLOCK DIAGRAM 8.18
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VSS
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PERFORMANCE SPECIFICATIONS

Gate Bias

Drain Bias

Drain Pulsing

Drain Reverse

(HV1 | HV3)

(HV2)

(High-I VDD/High-I VSS)

Diode Test

+60 V | -10 V

175 V | -10V

50 V | 8 V

-5 V | -50 V

5 mV

20 mV

20 mV

-

IMAX

10 mA

10 mA

20 A

10 A

Settling Time

10 μs

10 μs

10 μs to 100 ms (pulse)

10 μs

1 μA to 100 mA

1 μA to 10 mA

10 mA to 20 A

-10 mA to +10 mA

0.1%

0.2%

0.3%

0.1%

80 ksps

80 ksps

80 ksps

80 ksps

100 Ω | 1 kΩ1

100 Ω | 1 kΩ1

0.04 Ω

2.5 Ω

Supply
VMAX | VMIN
VSET Resolution

Measure
Range
Accuracy
Meas. Rate
ROUT

___________________________________________________________________________________________
This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
1 Current

measurements below 100 μA use 1 kΩ

© Roos Instruments Inc.
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SECTION 20

RI8594: HIGH PERF.
WAVEFORM GENERATOR &
MEASURE

Appendix | RI8594: High Perf. Waveform Generator & Measure

DESCRIPTION
The RI8594 delivers enhanced waveform and oscilloscope
performance over the RI8572 Waveform/Measure instrument and
includes an additional, low-noise clock source. The high-performance
PLL supplies an optimal local oscillator reference signal for devices
requiring high-fidelity phase noise qualification. The TIM includes a
complex sine and arbitrary baseband waveform generator for
modulated signal applications with two, DC coupled ports. A sine
wave generator that uses a dedicated DDS and lookup table engine
with two, AC coupled ports, as well as a dual-channel digitizer with an
embedded FPGA for real-time oscilloscope measurements.

KEY FEATURES
• M-ary QAM, M-PSK, & Custom Baseband Generation
• Continuous & Reciprocal Frequency Counter
• Measure S/N, SINAD, Rise/Fall Times
• Ultra Low-Noise Reference LO

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instruments in this TIM appear as LowNoiseClock,
Oscilloscope, SineGen, and Waveform in the panel dialog
windows.
Model and Name as it appears in the Tester Configuration:
• LowNoiseClock, Ri8585x Low Noise Source
• Oscilloscope, RI74105x Hi Spd scope/counter/BER
• SineGen, Ri7403x Dual Sine Source
• Waveform, Ri74211x Complex Waveform
NOTE: Multiple RI8594 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e Oscilloscope,SineGen,Waveform,LowNoiseClock;
Oscilloscope2,SineGen2,Waveform2,LowNoiseClock2;
Oscilloscope2,SineGen2,Waveform2,LowNoiseClock2, etc).
The “x” in RI8594x denotes the model revision number.

TIM OPERATIONS
Reference the RI8594 section of the Graphical Programming chapter
for configuration, edit and control panels.

© Roos Instruments Inc.
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BLOCK DIAGRAM 8.19
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Output 2
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Block Diagram, Waveform+LoNoiseClock
RI8594A2
2013-12-1 dwg Rev B
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Subject to change without notice
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Digitizer 2
Input
(C5)

490MHZ
LPF

GAIN

ATTEN

J2

J1

M30

3”

Ultra-Arb

M14

80MSPS Scope

J1

J2

J3

J4

M9

J1

J2

Divider

J4
490MHZ
LPF
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J1
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PERFORMANCE SPECIFICATIONS

Low Noise Clock
Frequency Options
Phase Noise1

100 MHz ÷ 2,4,5,8,10,16,20 | 100 MHz | 200 Hz - 400 MHz
170 dBc/Hz | 148 dBc/Hz | 120 dBc/Hz

Sine & Arbitrary Wave Generator
Frequency Range
Clock Rate
Bit Resolution

1 kHz to 100 MHz (Sine) | 1 Hz to 80 MHz (Arb.)
640 MHz (Max)
16 Bits/Channel

Digitizer
Analog Bandwidth
Voltage/Bit Resolution

100 MHz
±0.4 V / 14 Bits

Sample Rate

80 Msps

___________________________________________________________________________________________
This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
1

Typical performance at 20 kHz offset

© Roos Instruments Inc.
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SECTION 21

RI8595: 700MHZ TO
6GHZ POWER AMPLIFIER

Appendix | RI8595: 700MHz to 6GHz Power Amplifier

DESCRIPTION
The RI8595 RF Power Amplifier provides high-power signal output
from 700 MHz to 6 GHz. Designed as a drop-in signal amplifier for the
RI8508 RF Signal Generator, the unit provides up to 20 W of output
power with calibrated signal paths and enhanced air cooling channels
for stable thermal performance. The amplifier provides excellent gain
linearity and flatness that is ideal for LDMOS, GaN cellular repeater
ICs and other high-power RF applications.

KEY FEATURES
• 700 MHz to 6000 MHz Frequency Range
• 20 W Maximum Output Power
• +50 dBm Typical IP3 Performance
• +42 dB In-band Signal Amplification

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument is this TIM appears as PowerAmp in panel dialog
windows.
Model and Name as it appears in the Tester Configuration:
• PowerAmp, Ri8595B Pwr Amp 20W 6GHz
NOTE: Multiple RI8595 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration panels (i.e - PowerAmp, PowerAmp2, PowerAmp3,
etc).

© Roos Instruments Inc.
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BLOCK DIAGRAM 8.20
Roos Instruments, Inc - Cassini

Block Diagram, Pwr Amp 20W 6GHz
RI8595B
2017-10-25 Rev A
Copyright Roos Instruments, Inc.
Subject to change without notice
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PERFORMANCE SPECIFICATIONS
Frequency Range
Output Power
Gain

700 MHz to 6000 MHz
20 W (+43 dBm) Typical Maximum | 10 W (+40dBm) at P1dB
42 dB (nominal)

Gain Flatness1
VSWR Input | Output

±1 dB
2:1 | 2:1

___________________________________________________________________________________________
This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
1

Typical performance with a calibrated RI8508 RF Source.

© Roos Instruments Inc.
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SECTION 22

RI8604: 71GHZ TO
86GHZ TESTSET

Appendix | RI8604: 71GHz to 86GHz TestSet

DESCRIPTION
The RI8604 Test Set extends the frequency and application capability
with a 2-port vector analyzer supporting the 71 - 86 GHz band. With
both a bilateral and unilateral waveguide port, the instrument provides
2-tone source capability and measure of signal power, phase, return
loss and forward gain s-parameters. Designed to integrate with a 20
GHz Cassini source and receiver, the test set instrument enables
error-corrected calibration and vector measurements as well as
providing auxiliary IF and LO ports to support external millimeter wave
mixers for precision, thru-type measurements and extended test
application flexibility.

KEY FEATURES
• 2-Tone Source and Measure from 71 GHz to 86 GHz
• NIST-Traceable Vector Error Calibration
• Measures Power, Phase, Return Loss and Forward Gain
• Blind-Mate, Micro Flange Waveguide Interface

© Roos Instruments Inc.
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INSTRUMENTS PROVIDED BY THIS TIM
The instrument in this TIM appear as Test Head77 in the panel dialog
windows. Model and Name as it appears in the Tester Configuration:
• Test Head77, Ri8604x 81 GHz Test Set
NOTE: Multiple RI8604 instruments are enumerated incrementally by the system as
“2”,“3”, etc. in the configuration, edit, and control panels (i.e - Test Head77, Test
Head772, Test Head773, etc). The “x” in RI8604x denotes the model revision number.

© Roos Instruments Inc.
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BLOCK DIAGRAM 8.21
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Block Diagram
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PERFORMANCE SPECIFICATIONS

Source
Frequency Range

71 GHz to 86 GHz

Frequency Resolution

8 Hz

Power Range (Main)

-85 dBm to +5 dBm

Power Range (IM)

-55 dBm to +5 dBm

Measure
Frequency Range
Power Range1

71 GHz to 86 GHz
-110 dBm to +10 dBm

Sensitivity (W1)

-110 dBm

Sensitivity (W2)

-130 dBm

___________________________________________________________________________________________
This is an abbreviated list of instrument capability and is subject to change without notice. For comprehensive and up-to-date instruments specifications consult the TIM Specification document.
1

Typical performance with an RI8587 Receiver.
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Appendix | Copyright

© 2017 Roos Instruments Inc.
All rights reserved. Designed and published by Roos Instruments in Santa Clara, CA.
PDF editions of this book are available upon request. Contact support@roos.com for
more information.
All product, product specifications, and data are subject to change without notice to
improve performance, function, design, or otherwise.
The information in this document is to the best of our knowledge, accurate at the time
of publication.
To the fullest extent of the law, neither the publisher nor the authors, contributors, or
editors assume any liability for any injury and/or damage to persons or property as a
matter of products liability, negligence or otherwise, or from any use or operation of any
methods, products, instructions, or ideas contained in the material herein.
It is strictly prohibited to copy, redistribute, republish, or modify any materials contained
herein or in subsequent support of this content without the prior written consent of
Roos Instruments Inc.
Product names, logos, brands and other trademarks referred to within this book are the
property of their respective trademark holders.
These trademark holders are not affiliated with Roos Instruments, Inc., our products, or
our website. They do not sponsor or endorse our materials.
Below is a listing of these trademarks and their owners. This list is subject to change
without notice.
iPad® - iPad is a trademark of Apple Inc., registered in the U.S. and other countries.
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ANSI (IMPERIAL)
The American National Standards Institute (ANSI, /ˈænsiː/ an-see) is a private non-profit
organization that oversees the development of voluntary consensus standards for products,
services, processes, systems, and personnel in the United States. The organization also
coordinates U.S. standards with international standards so that American products can be
used worldwide. For example, standards ensure that people who own cameras can find the
film they need for that camera anywhere around the globe.
ANSI accredits standards that are developed by representatives of other standards
organizations, government agencies, consumer groups, companies, and others. These
standards ensure that the characteristics and performance of products are consistent, that
people use the same definitions and terms, and that products are tested the same way. ANSI
also accredits organizations that carry out product or personnel certification in accordance with
requirements defined in international standards.

Related Glossary Terms
ISO (Metric)

Index

Find Term

Chapter 7 - Module Repair Tools

CALIBRATION PLATE
Fixture bottom plate with a TIM interface insert layout designed to match a specific Cassini test
head configuration for calibrating individual TIMs, custom or application-specific resource
configurations, and the overall test system.

Related Glossary Terms
Diagnostic Plate, Fixture

Index

Find Term

DIAGNOSTIC PLATE
Fixture bottom plate with a TIM interface insert layout designed to match a specific Cassini test
head configuration for conducting diagnostics on individual TIMs, custom or applicationspecific resource configurations, and/or the overall test system.

Related Glossary Terms
Calibration Plate

Index

Find Term

FIXTURE
Cassini fixtures carry the modular architecture of Cassini into the device interface environment.
Housed in a rugged aluminum enclosure is a completely configurable test resource
environment. The form factor and discrete design layers support an application range from DC
to 90 GHz. Integration with Cassini's software allow fixtures to extend and enhance the
capabilities of test instruments with an integrated calibration layer that carries signal accuracy
right to the device pin. All the functionality and capability of traditional load boards have been
reengineered to take advantage of the configurable instrument framework of Cassini. The
discrete device interface layers enable design and development flexibility for high-performance
RF devices that can be optimized independently to suite application needs.

Related Glossary Terms
Calibration Plate, TIM

Index

Find Term

INFRASTRUCTURE
The Cassini test system infrastructure is designed to deliver a low-cost, high-throughput ATE
solution platforms to support mixed-signal, RF and microwave ICs. The three main elements to
the Cassini architecture are:
An RF-based architecture designed for high accuracy, precisions, and test performance
A modular test head that supports a high-speed data bus and precision power bus
Small footprint, energy-efficient, system infrastructure and instruments

Related Glossary Terms
TIM

Index

Find Term

ISO (METRIC)
ISO, the International Organization for Standardization, is an independent, non-governmental
organization, the members of which are the standards organization of the 163 member
countries. It is the world's largest developer of voluntary international standards and facilitates
world trade by providing common standards between nations. Nearly twenty thousand
standards have been set covering everything from manufactured products and technology to
food safety, agriculture and healthcare.
Use of the standards ensures that products and services are safe, reliable and of good quality.
The standards help businesses increase productivity while minimizing errors and waste. By
enabling products from different markets to be directly compared, they facilitate companies in
entering new markets and assist in the development of global trade on a fair basis. The
standards also serve to safeguard consumers and the end-users of products and services,
ensuring that certified products conform to the minimum standards set internationally.

Related Glossary Terms
ANSI (Imperial)

Index

Find Term

Chapter 7 - Module Repair Tools

TIM
Stands for Test Instrument Module. Test instrument modules provide an application-specific
instrument or instruments designed for the Cassini ATE system. They include a two latch, quick
release latching system for docking and undocking to the test head. Each TIM provides
resources through a blind-mate interface system designed to comply with Cassini fixtures and
diagnostic/calibration interface plates. These self-contained, swappable instruments provide all
the source, receive, measure, and signal processing capability for a broad range of DC, digital,
mixed-signal, RF, and millimeter-wave applications.

Related Glossary Terms
Fixture, Infrastructure

Index

Find Term

